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Welcome!
Welcome to PlanMaker! You have purchased an extremely powerful spreadsheet application that is also easy to
use.

In developing this program, we have made every effort to integrate and coordinate PlanMaker's functions in
such a manner that you will obtain the maximum benefit with the minimum amount of work.

PlanMaker gives you enough freedom to meet your individual needs. You can avail of the numerous setting
options to set up PlanMaker exactly to your liking.

Note: This manual was written in order to describe how to use the program via the new ribbon user
interface. A description of its use via classic menus with toolbars can only be found in older manuals.

Tip: A table in the appendix shows you which ribbon command corresponds to which menu command:
Ribbon commands and corresponding menu commands

Some features have been disabled in SoftMaker FreeOffice (the free version of SoftMaker Office). These
features are indicated by a red box like this one in the manual.

Some features of PlanMaker

§ Available for Windows, Mac, Linux, Android and iOS 

§ Well-designed, ergonomic user interface – either with a modern "ribbon" or classic menus with toolbars

§ PlanMaker knows more than 400 computational functions – from simply calculating totals to numerous
financial and statistical functions.

§ The creation of attractive worksheets is facilitated by the various design options. Simple columns of
numbers can be transformed into clear and appealing worksheets at the touch of a button using the "Tables
in worksheets" feature. You can use cell styles and character styles to apply frequently needed formatting
at the touch of a button.

§ The integrated chart module lets you present numbers clearly in charts.

§ ... and so much more!

PlanMaker is being developed continually. If, when working, you discover the need for a feature that is not yet
available, or if you have any other suggestions, please contact us as we want PlanMaker to meet the needs of
users!
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Additional features in SoftMaker Office Professional and NX Universal

The even more powerful SoftMaker Office Professional and SoftMaker Office NX Universal include an
advanced version of PlanMaker which offers the following additional features:

§ Read aloud – have your document content read aloud to you 

§ Compress pictures compresses inserted pictures to reduce the size of the file

§ QR code/Barcode – generate your own QR codes or linear barcodes

Android version and iOS version: Unlock locked commands

PlanMaker is also available for Android and iOS devices and contains virtually all features of the Windows
version.

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the features via Google Play/Apple App Store
(subject to a fee).

Technical support
If you have any questions, our technical support team will be happy to assist you. You can reach us as follows:

Website

Our website provides the latest program updates, tips and tricks, free downloads and much more.

For more information, see: www.softmaker.com

Support forums

In our support forums, you can ask our technical support team any technical questions you may have, while also
communicating with other users.

These forums can be found at: forum.softmaker.com

Inquiries to our support team

If you have any problems with our software, we will happily assist you.

You can post your questions here: www.softmaker.com/en/support/customer-support

https://www.softmaker.com/
https://forum.softmaker.com
https://www.softmaker.com/en/support/customer-support
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About this manual
PlanMaker has a wide variety of features – but don't worry: you don't have to master all of them! While you're
getting started, just use those you need. If you would like to make use of PlanMaker's more advanced features at
a later stage, you can then read the relevant pages of the manual.

This manual is structured as follows:

§ The chapter Installation and program startup deals with the installation of PlanMaker. You also learn
how to start the program. 

§ The chapter Application window describes the individual components of PlanMaker's main window.

§ The chapter Basics provides information on PlanMaker's most important functions and explains basic
spreadsheet terminology.

§ The chapter The PlanMaker tour deals with the spreadsheet application in tutorial form and shows you
how to use PlanMaker by means of some practical examples.

§ The chapter Editing worksheets marks the start of the reference section of this manual. These chapters are
organized by subject and provide a detailed description of all functions of PlanMaker.

System requirements
In order to run this software, you require the following hardware and software:

Windows version

§ Windows 11, 10, 8 or 7 (32-bit or 64-bit) 

Mac version

§ macOS as of version 10.14 (Mojave) 
§ Intel or ARM-based CPU

Linux version

§ Any x86 Linux (64-bit) 

Android version

§ Android 9.0 or higher 
§ ARM-compatible CPU (32-bit or 64-bit)
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iOS version

§ iOS 14.0 or higher 
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Installation and program startup
This chapter provides information on installing and starting PlanMaker.

It is divided by operating system into the following sections:

§ Installing on Windows 

§ Installing on macOS

§ Installing on Linux

§ Installing on Android devices

§ Installing on iOS devices

Please read the section for your operating system.

Installing on Windows

Download

If you obtained the software by downloading it from our website, you will find installation instructions in the e-
mail that you automatically received after purchasing the software.

CD-ROM

If you obtained the software on a CD-ROM, please start the installation program provided in the root folder of
the CD. Then follow the installation program's instructions to install the software.

Starting the programs

To start the installed programs, use the Start menu (the button with the Windows logo) in the lower left corner
of the screen. You will find your SoftMaker Office applications in a sub-folder called SoftMaker Office.

Entering address upon initial start: When you start PlanMaker for the first time, you will be asked to enter your name, address, etc. This information is
not used for registering the program. In fact, it allows you to insert your name, address, etc., in documents or document templates using the USERFIELD
function. You can always change this information at a later stage (see Settings, General tab).
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Installing on macOS
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Is an error message displayed when you start the installation program?

Depending on your system settings, the following error message may be displayed when you try to start the
installation program:

This occurs when your system's security settings specify that only programs that have been downloaded from
the App Store may be run.

Clicking on the question mark in the upper right corner of the message reveals how you can still run the
installation program. You then see a help window in which the following procedure is recommended:

1. Close the error message.

2. Hold down the Ctrl key and click on the installation program.

3. A context menu is displayed. Choose the command Open.

4. You then see a message which asks you if you really want to open the program. Confirm this by clicking on
the Open button.

The installation program will now start.

Starting the programs

After the installation is complete, icons for each of the installed programs will be displayed in both the
Launchpad and the Dock at the bottom of the screen. To start one of the programs, simply click on its icon.
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Installing on Linux
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Starting the programs

In most Linux distributions, the installation program automatically creates shortcut icons for all SoftMaker
Office applications in the menu. To start any of the applications, click on the corresponding icon.

Alternatively, the following scripts are available for starting the programs:

§ textmaker24free starts TextMaker. 

§ planmaker24free starts PlanMaker.

§ presentations24free starts Presentations.

You can execute these scripts in a shell, for example.

Entering address upon initial start: When you start PlanMaker for the first time, you will be asked to enter your name, address, etc. This information is
not used for registering the program. In fact, it allows you to insert your name, address, etc., in documents or document templates using the USERFIELD
function. You can always change this information at a later stage (see Settings, General tab).

Installing on Android devices
If you download an application to your Android device via the Google Play Store, you don't need to do
anything, as the application will be automatically installed immediately after downloading it.

Installing on iOS devices
If you download an application to your iOS device via the Apple App Store, you don't need to do anything, as
the application will be automatically installed immediately after downloading it.
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Application window
The following pages contain an introduction to the individual components of the PlanMaker user interface, both
for the ribbon interface and for the classic menu interface.

In all other chapters, this manual is designed for the user interface with the ribbon.

If you would like to continue working with the classic menu interface, a table in the appendix shows you
which ribbon command corresponds to which menu command: Ribbon commands and corresponding menu
commands.

Tip: You can switch the user interface between Ribbon and Classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu). On the Appearance
tab, click on the User interface button.

Alternatively: Right-click on a free space in the ribbon or toolbar, and choose User interface.

Program window with the "Ribbon" user interface

PlanMaker with the "Ribbon" user interface (Windows version)
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Tip: Even when using the ribbon user interface, the classic menu commands are always accessible in the

ribbon view. To access them, use the "hamburger menu" (the icon  to the left of the Quick access toolbar,
highlighted in red). There, you will find all familiar menu commands from the classic menu user interface.

Program window with the "Classic menus" user interface

PlanMaker with the "Classic menus" user interface (Windows version)

Note: Most of the illustrations in this manual were produced with the Windows version of PlanMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Title bar
In the top line of the program, you will find the title bar.

This displays the program name and the name of the document that you are currently editing.

If the document contains changes that have not yet been saved, an asterisk is displayed after its name.
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User interface: Ribbon
If, in the settings, you have selected that you would prefer to use the Ribbon interface instead of Classic menus,
the upper area of the program window will look like this on your device:

The "Ribbon" and the Quick access toolbar (below)

The ribbon

Ribbons are a modern type of user interface that combines menus and toolbars to simplify the use of the
software.

As you can see, the ribbon has several tabs whose tab headers are displayed at the top: File, Home, Insert, etc.
Each of these "ribbon tabs" contains logically combined groups (for example, on the ribbon tab Home: Edit,
Character, Alignment, etc.) with related commands for a certain task area.

To switch to another ribbon tab, click on its tab header.

Tip: You can also switch between the ribbon tabs with a shortcut key: Use Ctrl+F12 to move to the next tab
and Ctrl+Shift+F12 to move to the previous tab. You can also scroll with the middle mouse wheel while
pointing to the top bar with the tabs.

Each icon represents a specific command. If you click on it, the corresponding command is chosen. In the group
Character on the ribbon tab Home, for example, you will find commands for formatting. You can use them to
both read and change the most common text formatting (font, bold, italics, etc.) for table contents.

If you select a section of text or a cell beforehand, formatting changes will affect only the selected part.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons are switches that you can enable or disable by clicking on them – for example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a text box called
a "tooltip", which describes the icon's function. This requires Show tooltips to have been enabled in the
settings.
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The group arrows  in the bottom right corner of each command group indicate that there are other options and
commands available for that group. Simply click on this arrow to open the dialog box belonging to the group,
where you can make further settings.

The Quick access toolbar

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

§ Touch mode 

If you enable this button, all icons in the ribbon will be slightly enlarged. This is useful when operating the
software with your finger (for example, on a tablet).

§ Create a new file 

This button opens a new document. For more information, see Starting a new document.

§ Open a file 

This button opens an existing document. For more information, see Opening a document.

§ Save file 

This button saves the document that is open in the current window. For more information, see Saving a
document.

§ Undo 

This button undoes the last change made to the current document. You can also choose this command
several times in succession, see Undoing changes.

§ Redo 

This button restores the last undone change(s). For more information, see Undoing changes.

§ Repeat last command 

This button repeats the execution of the last command chosen with exactly the same settings. For more
information, see Repeating commands.

§ Object mode 

Switch between edit and object mode to make it easier to edit either cells or objects. For more information,
see Object mode.

To the right of the Quick access toolbar, there is a double arrow . You can use its menu to add/remove
common buttons directly from the Quick access toolbar. You can also change the position of the Quick access
toolbar here and add additional icons via the command Customize (for Quick access toolbar and ribbon, see
below).

To the left of the Quick access toolbar, you will find the "hamburger-menu" . Even if you have selected
the "Ribbon" as the user interface, the "hamburger menu" is still available in the Quick access toolbar in case
you would like to access the menu commands of the classic menu interface.
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Creating your own ribbon and Quick access toolbar

You can change the ribbon and the Quick access toolbar at will and add additional icons. To do so, either
choose File | Customize in the ribbon or right-click on a free space in the ribbon. In the following menu, you
will find the entries Customize ribbon or Customize Quick access toolbar to open a corresponding dialog box.

You can also hide the ribbon display completely (Minimize ribbon) or change the position of the Quick access
toolbar.

For more information, see Customizing the ribbon.

User interface: Classic menus
If, in the settings, you have selected that you would prefer to use Classic menus instead of the Ribbon interface,
the upper area of the program window will look like this on your device:

Classic menus with toolbars

The menu bar

The Menu bar is found directly under the title bar.

It contains all of PlanMaker's commands in the form of clearly arranged menus. Click on a menu item to open a
menu and choose a command.

The Standard toolbar

The Standard toolbar is displayed below the menu bar. It contains icons for PlanMaker's most frequently used
commands.

Toolbars such as the Standard toolbar enable quick access to the functions of a program. Each icon represents a
specific command. If you click on it, the corresponding command is chosen.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a tooltip that
describes the icon's function. This requires Show tooltips to have been enabled in the settings.
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The Formatting toolbar

The Formatting toolbar can be found below the toolbar. You can use it to both read and change the most
common text formatting (font, bold, italics, etc.) for table contents.

If you select a section of text or a cell beforehand, formatting changes will affect only the selected part.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons in the Formatting toolbar are switches that you can enable and disable by clicking on them – for
example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.

Additional toolbars

There are additional toolbars in PlanMaker that you can enable and disable as you choose. To do so, either
choose the menu command View > Toolbars or right-click on one of the displayed toolbars. You then see a
menu in which you can select toolbars that you would like to have displayed.

Customizing toolbars

You can customize the default toolbars to your liking and even create your own toolbars. For more information,
see Customizing toolbars.

User interface on Android/iOS
In addition to the Ribbon and Classic menus user interfaces, the Android/iOS version provides another option:
the Toolbars user interface.

The toolbars interface is designed in a manner that makes it easier to use PlanMaker on smartphones and
tablets. It constitutes a mixed form of the functionalities of ribbon and classic menus. On smartphones,
PlanMaker is started by default with this toolbars interface the first time you open it, while it is opened by
default with the ribbon interface on tablets.

To switch the interface, choose the command File | Options  in the ribbon interface or choose Tools >
Options in the classic menu interface. In the following dialog box, the Appearance tab contains the dropdown
list User interface. Here, you can choose between toolbars, ribbon or classic menus with different colors.

Tip 1: In the toolbars interface, you reach this dialog box by opening the "hamburger menu"  to the left of
the toolbar and choosing the command Tools > Options.
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Tip 2: The hamburger menu also contains all other menu commands of the classic menu interface.

Using the "toolbars" user interface

The toolbars user interface contains a bar with icons at the bottom of the program window, and each icon
represents a group of commands. If you click on a group icon, another bar opens with the corresponding group
commands.

Behind the File group icon , for example, you will find the commands Open document, Save document,
Print document, etc. To hide the displayed bar with the commands, simply click on the group icon again.

By default, the toolbar contains the following groups:

Group Commands (among others)

File Open document, Save document, Print document, etc.

Edit Undo, Format painter, Copy & Paste, Search, etc.

Worksheet Filter and sort, Cells (insert, delete, hide), Manage worksheets

Character Font, Font size, Font color, Text styles (bold, italics, etc.)

Formatting Number formats, Cell formatting, Cell styles, Conditional formatting, etc.

Insert Table style, Objects (picture, chart, AutoShape, etc.), Comments, Hyperlinks

Layout Page setup, Headers and footers, Align objects, etc.

View Object mode, Zoom, Freeze top row/first column, etc.

"Keyboard" button

In Options , the System tab contains an option Show/hide keyboard automatically. Once this setting is
enabled, it automatically opens the on-screen keyboard when you type something into the document.

If you disable the option, this behavior is suppressed and a freely movable Keyboard button  is displayed
instead on the document. If you click on the button, the keyboard is shown. By clicking on the button again, you
hide the keyboard.

Note: This setting is possible in any user interface for smartphones and tablets. For tablets, the Keyboard button
is only freely movable on the document in the toolbars interface if you disable the above option. In the Ribbon
and Classic menus interfaces, the Keyboard button is displayed instead in a fixed manner in the upper left area
of the command bar.

Changing input mode

PlanMaker supports the use of certain input modes of Android/iOS devices.

§ Android 

The command Input method enables you to switch to a different keyboard mode on an Android device.
PlanMaker accesses the on-screen keyboard settings of your Android device for this purpose.
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In the classic menus interface, you change the mode with the menu command View > Input method. In the

ribbon or toolbars user interfaces, you can choose this command via the hamburger menu .

§ iOS

If Scribble mode is enabled in PlanMaker, you can write directly in a document on an iOS tablet using the
Apple Pencil. Your handwritten entries will then be converted directly into text. For other edits – for
example, those of objects – you have to disable the mode again.

In the classic menus interface, you enable or disable the mode with the menu command View > Scribble. In

the ribbon or toolbars user interfaces, you can choose this command via the hamburger menu .

Note: The command View > Scribble is only available for iOS tablets, but not for smartphones. Please also
ensure that you have enabled the option Apple Pencil > Scribble in the system settings of your iOS tablet.

Unlocking locked commands

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the features via Google Play/Apple App Store
(subject to a fee).

Customizing command groups

You can customize the default groups as desired by adding/removing commands. Note: However, you cannot
add or delete an entire group in the toolbars user interface.

In the hamburger menu , choose the command Tools > Customize. This opens the dialog box Customize
user interface, which is structured as follows:

§ On the left side, you will find all of the commands that are available in PlanMaker. On the right side, the
dropdown list Customize contains the groups that are in the toolbar. The list below it displays the
commands that are currently in the selected group. 

§ You can add new commands to each group (or remove them, change their position or insert separators). This
works in a similar manner to that described for the Classic menus with toolbars user interface in the
Customizing toolbar icons section. Difference: Instead of "toolbar icons", you customize "group icons".

Context menu
Regardless of the user interface in which you work, there is also another way to choose commands: via the
context menu.

This menu contains different commands depending on the current situation. If, for example, you select some
text and then right-click to open the context menu, it offers commands for cutting, copying or formatting that
text.
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Depending on what you have previously selected (text, objects, tables, etc.), you will be offered a variable –
contextual – selection of commands when opening the context menu. This makes it much easier for you to
quickly navigate to situational commands without a long search.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen and
hold your finger there for about a second.

Edit toolbar
In the ribbon interface as well as in the classic menus you will find the Edit toolbar below the ribbon (or below
the standard toolbar and formatting toolbar in the classic menu interface).

The Edit toolbar contains the following options:

Cell address

The address of the currently active cell is displayed on the far left.

Icons and input field for editing cell contents

Three icons and an input field can be found to the right of the cell address.

Click in the input field to edit the content of the current cell. Alternatively, you can edit the cell content directly
by simply clicking in the cell and starting to type. The latter option is usually faster.

For more information on entering and editing data in cells, see Entering data in cells.

The buttons next to the cell address have the following functions:

Icon Function

This button corresponds to choosing the ribbon command Formula | Function (menu command Insert >
Function)

This button accepts the entry in the input field (corresponds to pressing the Enter key¿)
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This button rejects the entry in the input field (corresponds to pressing the Esc key)

For more information on entering formulas, see Formulas and functions.

Expanding the input field

The input field of the Edit toolbar is usually displayed as one line. For longer formulas, however, it is helpful if
the input field expands so that you can see the entire formula.

You can set the behaviour of the input field as desired. To do so, click on the button  to the right of the
input field to open a menu in which you can choose from the following options:

§ Automatic 

The input field is displayed as one line by default. If the space is no longer sufficient to display the formula
in one line, the input field is automatically expanded to four lines.

§ One line

The input field is always displayed as one line, even if the formula exceeds one line.

§ Four lines

The input field is always displayed as four lines, even if the formula fits in one line.

Tip: These options can also be found in the dialog box that opens upon choosing the command File | Options

 and clicking on the Edit tab.

Note: If the aforementioned button is not available, click on the  icon on the far right of the Edit toolbar.
Select Add/remove buttons and enable Input field height.

Document tabs

FreeOffice: The feature for working with document tabs is not included in SoftMaker FreeOffice. However,
you can open several documents in different program windows.

Android/iOS: This function is not available for smartphones. For tablets, actions are possible with the tabs
within the same program window.

A bar with document tabs can be seen above the document. It displays one tab for each open document.

The document tabs bar

The tabs can be used to perform the following actions:
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§ To make a document become the active document, left-click its tab. This enables you to rapidly switch
between the open documents. 

§ To close a document, click on its tab with the middle mouse button.

Alternatively, left-click on the x icon displayed on the far right of each tab.

§ You can change the order of the tabs by dragging a tab to the desired position on the tab bar while holding
down the left mouse button. 

§ To release a tab and display it in a separate program window, drag it to a position outside the current
program window while holding down the left mouse button.

Of course, this can also be done in reverse: A separately opened program window can be dragged into the
tab bar of an existing PlanMaker program window.

By the way, documents can also be started in a new program window when they are opened. For more
information on working with multiple documents, see Working with multiple documents.

Worksheet register
The worksheet register is displayed below the document.

A PlanMaker document can consist of multiple worksheets which are stacked on top of each other like a stack
of paper. They are called worksheets. You can use the worksheet register to switch between the individual
worksheets of a document, create new sheets, and delete sheets.

For more information, see Working with multiple worksheets.

The above figure shows the worksheet register for a workbook with three worksheets. The currently active
sheet "Sheet1" is highlighted.

Status bar
The Status bar is found at the bottom of the program window.

Note: If you do not see the status bar, you will have to change the settings for it as described in Settings,
Appearance tab (for the ribbon interface) or as described in Showing and hiding toolbars (for the classic
menu interface).

You can read the following information in the status bar:
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Example Explanation

Font color,
Chart1,
etc.

Different information is displayed on the far left. If you hover the mouse cursor over a command icon, the
function of this command is displayed here. If you select an object, its name is displayed here. If you move
or resize an object, the current position/size is displayed, etc.

Sum=6 The online calculation is displayed next to it. If you select several cells, the calculation of the cell contents,
for example, the sum, is automatically displayed here. Various calculation functions are possible and can be
opened by just clicking on the display. (See also the option Calculation in status bar in the Settings, Edit
tab.)

This icon lights up if the worksheet contains a circular reference. This usually indicates an incorrectly
formulated formula – for example, a formula in cell A1 that refers to cell A1 itself.

If you click on this icon, the cell frame jumps to the cell with the circular reference. If you click on it again,
it jumps to the next cell with such a reference (if more of them exist).

Ins This option shows whether Insert mode (Ins) or Overwrite mode (Ovr) is enabled. This allows you to
determine what should happen to the existing cell contents when editing a cell:

Ins: Insert mode is enabled – newly entered text will be inserted in front of existing text.

Ovr: Overwrite mode is enabled – newly entered text will be written over existing text.

The default setting is Ins. You can use the Ins key on your keyboard to switch between these two modes (or
by clicking on the Ins/Ovr display).

The Ins key can also be disabled. For more information, see Settings, General tab.

AUTO This indicates PlanMaker's current input mode:

AUTO: Normal input mode is enabled – numbers are automatically recognized as numbers, and formulas
are automatically recognized as formulas. This is the default setting.

TEXT: Text input mode is enabled – all entries are converted into text (including numbers and formulas).

To switch between these two modes, either click on the text "AUTO" in the status bar or press the key
combination Ctrl+Shift+F4.

Important: If you switch to TEXT input mode, all numbers and formulas you enter will be automatically
preceded by a single quotation mark ('). This converts them into text, and they can no longer be used for
calculations. (In order to turn converted numbers/formulas back to normal numbers/formulas, switch back to
AUTO mode and remove the leading quotation mark.)

The status bar also contains a zoom slider that allows you to change the zoom level for the document:

To do so, either drag the slider with your mouse or click on the plus or minus icon (see Zoom level).

Tip: Configuring the status bar

If you click on the double arrow  on the far right of the status bar, you will find the following options:

§ You can use the option Add/remove buttons to show or hide the individual preset elements of the status
bar. 
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§ The option Customize opens the dialog box Customize user interface, where you can freely configure the
status bar from all commands available in PlanMaker.

In the dialog box, select the item "Status bar" in the list Customize (top right). You can then add or remove
buttons from the status bar and change their order. For more information, see Customizing icons and groups
in the ribbon.

§ Reset this toolbar restores all changes made to the status bar back to their original state.
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Basics
This chapter provides information on PlanMaker's most important basics and explains basic spreadsheet
terminology.

This chapter covers the following topics:

§ The structure of a worksheet 

First, you will learn how worksheets are actually structured.

§ Moving within a worksheet 

You will then learn how to navigate within a worksheet.

§ Entering data and Deleting data 

In the next two sections, you will learn methods for entering and deleting data.

§ Undoing changes 

Here, you will learn how to undo changes to the document.

§ Starting a new document 

This section will show you how to create a new document.

§ Opening a document, Printing a document and Saving a document 

These three sections deal with opening, printing and saving documents.

For more information, see the following pages.
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The structure of a worksheet
In order to use PlanMaker directly while working through this chapter, you should launch it now.

As you can see from the figure, worksheets are divided into rows and columns. Each worksheet can contain up
to 1 million rows and 16384 columns. They are labeled as follows:

§ The rows are numbered consecutively. 

§ Conversely, the columns are labeled with letters: A to Z, then AA to AZ, then BA to BZ, etc.

The matrix of rows and columns results in a grid composed of "boxes". These boxes are called the cells of the
worksheet.

Each of the cells has its individual coordinates: "B5", for example, denotes the cell in the fifth row of column B
(the second column). "A3" is the cell in the third row of column A (the first column) and so on. These
coordinates are referred to as the cell address.

The cell address is very important because calculations often refer to other cells: If, for example, you want to
have twice the value of cell A1 in cell A2, you would enter =A1*2 in cell A2.

Twice the value of A1 is now displayed in A2. If you change the value in A1, the resulting calculation in cell
A2 is automatically updated.
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Moving within a worksheet
If you enter data in PlanMaker, it is always inserted into the active cell. A thin dark frame known as the cell
frame indicates the active cell:

You can move the cell frame to another cell as follows:

Mouse: Click on the desired cell.

Keyboard: You can use the arrow keys of the keyboard to move the cell frame.

Moving via the keyboard is also possible: Press the Tab key to move to the next cell on the right and
Shift+Tab to the next cell on the left. Press the Enter key¿ to move down and Shift+Enter to move up.

For a list of all keys available for this purpose, see Shortcut keys.

Entering data
In order to enter data in a cell, move to the desired cell using the arrow keys or the mouse, and start typing.

To complete your input, press the Enter key¿.

If you made an error during input, press the Esc key instead of the Enter key¿. PlanMaker will discard what
you just typed and restore the original cell content.

Alternatively, you can enter data via the following buttons of the Edit toolbar:

§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To subsequently edit the contents of a cell, navigate to the cell and press the F2 key. Alternatively, you can
simply double-click on the cell.

For more information on this topic, see Entering data in cells.

Deleting data
There are several ways to delete data from a document:
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§ Deleting the content of a cell 

To delete the entire content of a cell, navigate to that cell and then press the Del key on the keyboard (or
choose the ribbon command Home | group Edit | Cut).

§ Deleting parts of the cell content 

To delete only part of the cell content, double-click on the cell. Alternatively, you can select the cell and
press the F2 key. You can now edit the cell content, for example, delete parts of it using the Del key or the
Backspace keyÕ.

§ Deleting the contents of multiple cells 

To delete the contents of multiple cells at once, select them before pressing the Del key. For information on
selecting cells, see Selecting cells and cell content.

For more information on "Deleting cells", see Deleting cells and cell content.

Undoing changes

In the Quick access toolbar, you can use the Undo button  on the Quick access toolbar. This restores the last
action you undid. You can thus undo the cancellation of changes.

For more information on this topic, see Undoing changes.
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Starting a new document

To start a new document, choose the command File | New . (Click directly on the icon itself.) Incidentally,
this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see the templates you previously used. For more
information, see "List of document templates used" below.)

Tip: Use the key combination Ctrl+N to quickly open a new document with the current default template,
while skipping the dialog box shown below.

After you click on the File | New icon , the following dialog box appears:

The dialog box of the command File | New

If you just want to create a normal worksheet without any additional formatting, choose the default template
Normal.pmvx.

Tip: If you hover over a template (without clicking on it), more information about the template will be
displayed. This requires Show tooltips to have been enabled in the settings.

As soon as you confirm with OK, the new document will be created.
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Using document templates

The above dialog box contains the following options:

Template: In addition to the default template Normal.pmvx, you will also see some predefined document
templates that you only have to fill in after opening them.

The Favorites folder always contains the default template as well as all "pinned" templates. They are

permanently displayed at the top in the list of the command File | New  for quick access. (For more
information, see the paragraph below "List of document templates used".)

Pinned templates are recognizable by the vertical pin icon . By clicking on the pin icon, you can pin or unpin
a template.

View: The templates can be displayed in the dialog box as small, medium or large preview images in the tile
view. Alternatively, a list view in text form is also possible.

Sort by: You can view the templates sorted by name or by date.

Available languages: Here, you can select the language(s) in which document templates are to be displayed.

Set as default: Change the default template by clicking on a template and then pressing this button. In future, a
new document will always be opened with this template.

For more information on creating your own document templates, see Document templates.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in
its own program window. If the option is disabled, the new document will be created with a new tab in the
existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

List of document templates used

If you click on the small arrow of the File | New button , the program opens a list of previously used
document templates, which you can apply directly:

Default template: The current default template is displayed here. If you just want to select the default
template, you can also click on it here in the list and skip the dialog box.

Unpinned templates: This is displayed if you have already used templates other than the default template. You
can thus use these templates directly from the list for a new document without performing a long search.

If you click on the pin icon  of a template, the status changes to Pinned templates: These are permanently
displayed at the top of the list (and in the Favorites folder of the dialog box, see above). You can unpin the

template by clicking on the pin icon  again.

If you click on the cross icon , you remove an entry completely from the list. The command Delete all
unpinned items deletes all entries from the list – except the pinned templates and the default template.
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The command More will take you again to the dialog box described above.

Opening a document
To open an existing document, choose the command File | Open  by clicking directly on the icon itself.
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see a list of recently used files. See explanations in the
paragraph "List of recently opened files" below.)

After you have clicked directly on the Open icon , the program will display a dialog box which may look as
follows:

The dialog box of the command File | Open

This dialog box may look slightly different depending on the operating system, but its function always remains
the same. Use this dialog box to tell PlanMaker which document to open.

To do so, you could simply type in the name of the file you want to open manually. However, the dropdown list
with the files is more convenient because all files are listed here in the current folder and can be easily selected.
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Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in its
own program window. If it is disabled, the document will be opened with a new tab in the existing program
window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

Previewing a document

When the option Preview is enabled, a little box displaying a preview of the currently selected document is
displayed to the right of the dialog box.

Opening other file formats

In addition to opening documents created in PlanMaker's default file format, you can also open files created
with other software. All you have to do is select the desired format from the list of file types.

For more information, see Working with other file formats.

Using Quick paths

You can use the Quick path button to create and choose quick paths in order to quickly switch to a specified
folder when opening or saving files.

For more information, see Quick paths.

File manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

The File manager button opens the integrated file manager. This displays a list of your documents and allows
you to open, print, view or delete them, as well as perform searches.

For more information, see File manager.

List of recently opened files

If you click on the small arrow below the File | Open  button, you will see a list of recently opened files.
Simply click on one of these files to open it again.

In this file list, you can also select the following options:

If you click on the pin icon  of a file, it will appear in the list as a pinned file and will be displayed
permanently at the top of the list. Unpinned files will eventually be removed from the list of recently opened
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files if the number of entries exceeds the limit that was set. For more information, see "Recently used files in
the File menu" in Settings, Files tab.

Click on the pin icon  again to unpin the file or click on the cross icon  to remove an entry from the list.
The command Delete all unpinned items deletes all entries from the list – except the pinned files.

The command Browse documents will take you again to the dialog box described above.

Printing a document
To print the current document, choose the ribbon command File | Print.

The program will display a dialog box in which you can specify the parts of the document to be printed.

For more information on outputting documents, see Outputting documents.

Saving a document
When you have completed a document, you should save it to retain it permanently. To do so, click on the
ribbon command File | Save .

Tip: This command can also be found by default in the Quick access toolbar below the ribbon.

If the document does not yet have a name, PlanMaker automatically prompts you to assign a file name to it
before saving it.

Saving under a different name or in a different location

PlanMaker also has a ribbon command called File | Save as. This also saves your document, but you can first
assign it another name or select another folder in which to save it.

Saving in a different file format

You can use the ribbon command File | Save as to also save a document in the file format of another program.
To do so, select the desired format in the list Save as type. For more information, see Working with other file
formats.

Saving all open documents

If you have multiple documents open at the same time, you can use the ribbon command File | Save all to save
all of them at once. PlanMaker checks whether the documents have been changed since they were last saved
and saves only those that have been changed.
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Exiting the application

To exit PlanMaker, choose the command File | Close  and then File | Exit . Alternatively, just click on
the X icon on the far right of the title bar or tab.

If one of the open documents has been changed since it was last saved, PlanMaker automatically asks you
whether you want to save it before closing it.
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The PlanMaker tour
Welcome to the PlanMaker Tour!

On the following pages, you will obtain more in-depth information on PlanMaker than in the Basics chapter.
Users who are unfamiliar with spreadsheets should read the next section thoroughly.

More advanced users are encouraged to browse through this section as needed. It contains some useful tips that
will make it easier for you to use PlanMaker.

Note: Most of the illustrations in this manual were produced with the Windows version of PlanMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Some theory to begin with
The topic "Calculating and computers" is best explained by means of a brief review. It was precisely through
the field of "computing" that computer technology originally found its way into homes and offices. The first
tentative advance was made by pocket calculators. They are definitely a great help, but their disadvantages are a
good indicator of the usefulness of a spreadsheet:

If, for example, you're planning on buying a computer, you'll need to compare various systems based on their
hardware components, as you'll need a PC, a monitor and a printer. One vendor may offer a competitively
priced computer, another vendor might offer an inexpensive monitor, etc. Which is the best option?

To determine this fact, you have to add up the various prices. To do so, you pull out your pocket calculator, add
number by number, write down the result – and become frustrated: With every new offer, the game starts all
over again with new values, even though the method of calculation never changes.

Such calculations can be performed more conveniently by means of a spreadsheet.

The first technique you will encounter when working with PlanMaker is the use of "variables". Variables help
you to generate abstract formulas without the use of actual number (or dollar) values. For example:

Computer + monitor + printer = total price

Thus, your formula would look as follows:

a + b + c = d

Such a formula is only of practical use in calculating without a spreadsheet if, for example, you have a
programmable calculator – you can enter the formula in it once, and then execute it many times. The calculator
asks for the values one by one, and then automatically calculates the total value. However, this is not much of
an improvement over repeated individual calculations...
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First steps with PlanMaker
With these preliminary considerations in mind, let's look at how such tasks can be performed with PlanMaker.

To do so, start PlanMaker now.

On Windows, PlanMaker looks as follows:

The worksheet takes up most of the program window. The top of the worksheet is bordered by a bar with letters
and by a bar with numbers on the left.

Let's take a closer look at the worksheet:

The structure of a spreadsheet

As you already know from the Basics chapter, a worksheet is divided into rows and columns. They are also
indicated by the gray lines that are displayed in the worksheet.

The cell in the top left corner is surrounded by a dark border. This is called a cell frame. It indicates which cell
is currently active.
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When you type something, it is always entered in the active cell.

You can use the arrow keys on your keyboard, e.g., â and à, to move the cell frame from one cell to another.

When doing so, take a look at the display panel on the left above the worksheet: PlanMaker displays the
address of the currently active cell. The address always consists of one or two letters and a number:

"A1" means "column 1, row 1".

"A5" means "column 1, row 5".

"D5" means "column 4, row 5", etc.

The fact that each cell has a unique address is the key to all functions of a spreadsheet: This allows you to enter
calculations in any cell that relate to other cells – for example, to form the sum of cells. You don't even need to
deal with variables like a, b, c, as you just use the coordinates of the cells.

This is like handing someone a worksheet and asking them, for example, "Please add the numbers in the
second, third and fourth rows of the second column".

Entering values and formulas
That's enough theory for now! Let's now perform our first calculation.

First, we enter the price of the computer; under that, the price of the monitor; and under that, the price of the
printer.

Thus, navigate to cell B2 and type the value 799 there. The value will appear both in the selected cell and in the
Edit toolbar above the worksheet.

Note: When entering numbers, do not make the mistake of typing the letter "O" or "o" instead of the number
"0". PlanMaker makes a clear distinction between letters and numbers. The letter "O" is not a number for the
program. PlanMaker would accept the input but interpret it as text, and thus could not perform calculations
with it.

Then press the Enter key¿ to complete your input. The cell frame automatically moves down one row to cell
B3. Type the value 425 here and the value 199 in the row below.

Tip: If you entered an incorrect value and have already pressed the Enter key¿, you can still correct your
mistake. Use the arrow keys to move the cell frame to the cell with the error, and enter the correct value.
Then press the Enter key again, and the old cell content will be overwritten by the new input. You can also
edit the content of already filled cells by pressing the F2 key.

Entering formulas

Let's enter our first formula.

In order to calculate the total cost of our computer equipment, we have to add up the unit prices that we just
typed. This is very easy:
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Go to cell B5 and type an equal sign = at first. The equal sign shows PlanMaker that you would like to start
entering a formula in this cell.

Then enter the formula. For this purpose, you use the cell addresses as "variables". Enter the following:

=B2+B3+B4

Note: Cell addresses are not case-sensitive, i.e., you can enter them in either uppercase or lowercase.

When you press the Enter key¿, you will immediately see the result of your first formula in the cell:

Let's see what happens if you change the numbers in the cells. For example, navigate to the cell that contains
425 and enter 259 or some other value instead. As soon as you press the Enter key¿ again after replacing the
cell content, the result of the calculation will be updated immediately.

Regardless of what cells B2, B3 and B4 contain, PlanMaker will always add them up. If you get a quote for a
computer system in which only the price of the printer has changed, for example, you only need to change that
particular value, and the new total price will be displayed in cell B5.

The "SUM" function

The above example is one method of adding up several numbers. Although the method is adequate for a few
numbers, it is clearly too cumbersome for adding 50 numbers - that would be a very long formula! Fortunately,
there are alternative methods: the computational functions of PlanMaker.

In order to find out more about them, make cell B5 the current cell; it contains the formula you entered
previously.

First, delete the old formula by pressing the Del key on the keyboard or by simply overwriting the existing cell
content. Then enter the following formula:

=SUM(B2:B4)

After pressing the Enter key¿, you will see the result in the cell: the sum of the cells B2 to B4.

PlanMaker has a whole range of computational functions – and one of them is SUM. As its name suggests, the
SUM function calculates the sum of the relevant values. The expression in parentheses after the function name
tells PlanMaker where to start and stop summing.

You have directed PlanMaker to start adding in cell B2 and stop in cell B4. In this case, only the number in B3
is in between, but the SUM function would also work with a larger range, such as B2:B123.

The notation Start cell:End cell also works across rows and columns. If, for example, you enter B2 as the start
cell and C4 as the end cell, these two coordinates in the worksheet form the corners of a rectangle. The formula
=SUM(B2:C4) would thus sum all numbers included within this rectangle.
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Variety of formulas

To get an idea of the multitude of computational functions available in PlanMaker, you can now choose the
command Function.

You will find the command on the ribbon tab Formula | Function  or as Insert function with an identical
icon in the Edit toolbar. Even faster: Simply press F7.

The program will now display a dialog box with a list of all functions that PlanMaker supports.

Tip: You can open a help page for each arithmetic function. Click on the desired function in the above
dialog box, and then press the F1key.

Let's try another function. We'll calculate the average value of our three numbers in the worksheet:

To do so, exit the dialog box and delete the contents of B5 again.

Then choose the command Function (Insert function) . Select the "All functions" category in the list on the
left side of the subsequent dialog box. Then scroll down through the list on the right to the "Average" function.
Double-click on the "Average" function.

In the input field Formula of the dialog box, PlanMaker has now automatically inserted the Average() row. To
complete the formula, enter B2:B4 again between the parentheses.

Alternatively, you can simply select the desired cell range directly in the worksheet by left-clicking on cell B2
and then dragging the mouse down to cell B4. If the dialog box is covering the cells that you want to select,
simply drag it out of the way while holding down the mouse button.

The completed formula should look as follows:
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=Average(B2:B4)

If you click on Insert, this formula will be transferred to cell B5 and calculated immediately.

You have now learned about two of the more than 400 computational functions of PlanMaker. For a
comprehensive list of all functions, see Functions from A to Z.

Going three-dimensional
PlanMaker spreadsheets do not necessarily have to consist of a single worksheet. You can also stack several
worksheets on top of each other – just like a stack of papers. Thus, PlanMaker documents are also called
workbooks. Each workbook can contain up to 2048 worksheets.

The main advantage of this is that calculations in one worksheet can also refer to cells in other worksheets of a
workbook, thus enabling you to perform "three-dimensional" calculations as such.

For example: You record the balance sheets of several branches of your company on three worksheets. You
could now create a fourth worksheet and use it to calculate, for example, the sum of the results of the other
three sheets.

To add a new worksheet, choose the ribbon command Insert | group Tables | Sheet . The program opens a
dropdown menu in which you can choose the command Insert.

Tip: You can create a new worksheet faster with the  icon in the worksheet tab.

The worksheet tab at the bottom of the document

To switch between the existing sheets, simply click on the desired worksheet in the worksheet tab with the
mouse.

For more information on this topic, see Working with multiple worksheets.

Changing the appearance of worksheets
Let's go back to our first sample worksheet. Although the worksheet is very useful for performing calculations,
it is not very appealing in terms of its design. At the same time, PlanMaker has extremely powerful options for
preparing worksheets in visual terms.

Let's try some of them out:

Adding a heading

What our worksheet definitely lacks is a heading. Thus, let's simply enter a relevant text in a cell above the
numbers and increase its font size.
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To do so, click on cell B1 to make it the active cell. Then enter the following text:

My first worksheet¿

Changing character formatting

Let's now choose a different font for the heading and make it a lot bigger.

For this purpose, move the cell frame back to cell B1 with the heading. Then expand the font list on the ribbon
tab Home | group Character by clicking on the small arrow to the right of the font name.

PlanMaker now displays a list of all fonts installed on your computer. Select the Tahoma font, for example.

Then open the font size list  to the right of (or below) the font list, and select the 24 point size.

You can also set the font color  if you want, and this command group also contains three buttons labeled
B, I and U for enabling/disabling bold, italics and underlining.

Changing number formatting

PlanMaker provides extensive options for formatting numbers. It not only enables you to change the character
format of cell content (font, font size, etc.), but you can also modify their number format.

Let's try this out: To display the values in cells B2 to B5 with a currency symbol, proceed as follows:

First, select cells B2 to B5. To do so, click on cell B2 and then – with the mouse button still held down – move
the mouse cursor to cell B5.

Android/iOS: If you are using these versions, please note that selecting cells works slightly differently there.
For more information, see Selecting cells and cell content.

When the desired cells are selected, choose the ribbon tab Home and then go to the command group Number
and click on the group arrow  in the bottom right corner. The program opens a dialog box with numerous
settings options. We are only interested in the Number format tab: On this tab, select the entry "Currency" in
the list and confirm with OK.

Result: PlanMaker now adds a currency symbol to the numbers in the selected cells and displays them with two
decimal places, as is usual with monetary amounts.

There are many other number format options that you can use to change the appearance of numbers. For
example, the number of displayed decimal places can be set, numbers can be displayed as percentages, etc.
Important: Applying a different number format to a value only changes how it is displayed and does not change
the value itself.

You have now become familiar with a small part of PlanMaker's options for improving the visual display of
worksheets. As you can imagine, there are many other options for visually enhancing worksheets and making
them clearer. For more information, see Formatting worksheets.
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Charts
Before we end this PlanMaker tour, let's take a quick look at charts.

It is often difficult to interpret the meaning of spreadsheets consisting of long columns of numbers. PlanMaker
thus has its own chart module for the optical preparation of data from your worksheets.

To insert a chart, first select the values to be displayed.

Then choose the ribbon command Insert | Chart frame  (click directly on the icon itself). A dialog box
appears in which you only have to select the desired chart type and the completed chart appears in the
document.

For more information on this topic, see Charts.

Outlook
This is where our brief introduction to PlanMaker ends. You now know many of the program's most important
basics, and everything else you will learn in the reference section of the manual, starting with the next chapter.

This part of the manual provides detailed descriptions of all of PlanMaker's features by subject matter. Of
course, you don't have to read it chapter by chapter to learn all the capabilities of PlanMaker at once. Just read
the chapters that you really need, and gradually explore PlanMaker's features.
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Have fun with PlanMaker!
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Editing worksheets
This chapter marks the beginning of the reference section of the manual. This part of the manual provides
detailed descriptions of all of PlanMaker's features organized into chapters by subject matter.

In this first chapter, you will learn how to enter data and edit worksheets. This chapter covers the following
topics:

§ Entering data in cells 

The first section describes what you have to consider when entering text, numbers, calculations, etc., in
worksheet cells.

§ Undoing changes 

The Undo button  in the Quick access toolbar can be used to undo the last changes.

The Redo command  in the Quick access toolbar is its counterpart and reverses the Undo command.

§ Repeating commands 

The command Repeat  in the Quick access toolbar repeats the last command that you used with exactly
the same settings.

§ Selecting cells and cell content 

This section describes how to select cells – for example, by using the mouse or the keyboard.

§ Deleting cells and cell content 

You can either use the Del key on the keyboard to delete only the cell content or choose the ribbon
command Home | group Cells | Delete to remove cells completely from the worksheet (the rest of the
worksheet moves up accordingly).

§ Inserting new cells 

The ribbon command Home | group Cells | Insert inserts new cells into your worksheet and automatically
moves the existing cells down (or right).

§ Moving and copying 

Selected worksheet areas can be copied or moved with the commands of the ribbon tab Home | group Edit
or simply by dragging them via the mouse. Formulas are automatically adjusted when you move or copy
cells.

§ Paste (special) 

The ribbon command Home | group Edit | Paste  | Paste special is a more powerful variant of the
command Paste. You can specify exactly what is to be pasted, for example, just the values or just the
formatting.

§ Filling cells automatically 

You can choose the ribbon command Home | group Contents | Fill to easily fill cells with consistent values
or ranges of values.
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§ Working with multiple worksheets 

You can create multiple worksheets in a single document and stack them like a pile of paper, thus enabling
you to perform "three-dimensional" calculations.

§ Naming cell ranges 

If you assign a name to a range of cells using the ribbon tab Formula | group Named areas | Edit names,
you can use this name in formulas, for example, =SUM(sales) instead of =SUM(A1:A5).

§ Transposing cells 

The ribbon command Data | group Edit | Transpose reverses the row and column orientation of a selected
cell range.

§ Splitting text into multiple columns 

Choose the ribbon command Data | group Edit | Text to columns to split text that is in one worksheet cell
into multiple worksheet columns.

§ Sorting cells 

Choose the ribbon command Data | group Filter | Sort to sort ranges of cells according to one or more
criteria.

§ Filtering cells by their content 

Choose the ribbon command Data | group Filter | AutoFilter or Special filter to filter a cell range
according to one or more criteria. All rows in this range that do not match the filter conditions will then be
hidden.

§ Analyzing sheets 

This section introduces some tools that can be very useful for analyzing worksheets and troubleshooting.
These tools include a command for displaying formulas, syntax highlighting, a watch window for cell
content, and various functions for analyzing the formulas in a worksheet.

§ Updating sheets 

The calculations in all worksheets are kept up to date automatically. Whenever you change the content of a
cell, PlanMaker recalculates the worksheets. If required, you can disable this behavior and use the ribbon
command Formula | group Update | Recalculate to update worksheets manually.

§ Using comments 

Choose the ribbon command Insert | Comment to add comments to cells. The comment is displayed when
you hover over such a cell with the mouse cursor.

§ Goal seek 

Choose the ribbon command Data | group Analyze | Goal seek so that an approximation method is used to
determine the value which a particular component of a calculation must assume in order to produce the
desired result.

§ Scenarios 

The ribbon command Data | group Analyze | Scenario manager allows you to create and display different
scenarios. You can use them to observe how the calculations in a worksheet change when the values in
specific cells are altered. This enables you to perform all kinds of "what-if" analyses.
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§ Consolidating data 

The ribbon command Data | group Analyze | Data consolidation can be used to evaluate data from one or
more cell ranges, for example, to calculate their total sums.

§ Tables in worksheets 

This function is a particularly useful option, as it formats an entire worksheet area in one of numerous
predefined formats at the touch of a button. Select a cell range and choose the ribbon command Insert |
Table to create a "table in a worksheet".

This has the following effects:

The cell range is automatically formatted with a table style. You can switch to a different table style at any
time, and thus change the appearance of the entire cell range at once. In addition, an AutoFilter is applied to
the "table" automatically. Furthermore, other useful features such as a total row are available.

§ Pivot tables 

Large amounts of complex data can be summarized very clearly according to certain criteria using pivot
tables. Select an existing data area and use the ribbon command Insert | Pivot table to create meaningful
presentations of your data with minimal effort. The section includes exercises for illustration purposes.

§ Freezing rows and columns 

Choose the ribbon command View | group Windows | Freeze cells to freeze the first rows or columns of a
worksheet on the screen. This will make them stay in place when you scroll through the worksheet. This is
ideal for row or column headings.

§ Inserting special characters 

The ribbon command Insert | group Text | Symbol opens a dialog box with all available characters of a
font. It can be used to insert special characters that are not readily accessible via the keyboard.

For more information on these topics in the above order, see the following pages.

Entering data in cells
In order to enter data in a cell, navigate to the desired cell with the arrow keys or mouse, and simply start
typing.

To complete your entry, press the Enter key¿.

If you made an error during input, press the Esc key instead of the Enter key¿. PlanMaker will discard what
you just typed and restore the original cell content.

Alternatively, you can enter data via the following buttons of the Edit toolbar:

§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To subsequently edit the contents of a cell, navigate to the cell and press the F2 key. Alternatively, simply
double-click on the cell.
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Notes on entering numbers

§ Always enter numbers with the decimal separator specified in your computer's regional settings, for
example, either the decimal comma usually used in Europe (0,7) or the decimal point used in the USA, UK
and Ireland (0.7). 

§ Numbers can also be entered in scientific (exponential) notation. For example, 4E03 corresponds to 4 *
10^3, which equals 4000. Alternatively: 4E-03 corresponds to 4 * 10^-3, which equals 0.004.

§ Numbers can also be entered as fractions. For example, 2 1/2 corresponds to 2.5.

§ Numbers can also be entered as percentages. For example, 70% corresponds to 0.7.

On the ribbon tab Home, you can change the format of numbers in worksheet cells at any time using the
command group Number. For example, you can set PlanMaker to display numbers as percentages or as a
currency with a currency symbol. For more information, see Number format.

Notes on entering dates and times:

§ Dates can be entered in various formats, for example, 09/25/18 or 9/25/2018, etc. 

§ You can enter dates between January 1st, 1900 and December 31st, 2500.

§ If you enter a date with the year represented by only its last two digits, it is interpreted as follows:

00 to 29 -> 2000 to 2029

30 to 99 -> 1930 to 1999

PlanMaker treats 1/1/29 as 1/1/2029 and 1/1/30 as 1/1/1930.

§ Times can be entered in numerous formats. For example, you can enter 09:30 as follows: 

9:30

09:30

09:30:00

09:30:00 AM

etc.

§ You can combine a date and a time in a single cell by entering the date, a space, and the time. For example,
when you enter 9/25/18 6:00, PlanMaker knows that you mean September 25, 2018 at 6:00 am. 

Note: Dates and times are always stored as numbers in spreadsheets so that calculations can be performed with
them. The number 0 represents 1/1/1900, the number 1 stands for 1/2/1900, etc. The time is stored in the
decimal places of the number.

However, you don't have to worry about this fact. Simply enter dates and times in your preferred manner.
PlanMaker automatically converts your input into a number and displays it formatted in a date/time format. To
learn more about changing the format of dates and times, see Number format.

Tip: Use the key combination Ctrl+. (colon) to enter the current date in a flash and Ctrl+Shift+. to enter the
current time.
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Notes on entering logical values (Boolean values):

§ To enter a logical value in a cell, type either TRUE or FALSE there. 

Notes on entering calculations:

§ Formulas must always begin with the equal sign, e.g., =2+5. 

§ The command Insert function  in the Edit toolbar can be used to easily insert arithmetic functions. Of
course, you can also input formulas manually, for example, =SUM(2, 5).

§ For more information on performing calculations, see Formulas and functions.

§ For descriptions of all computational functions, see Functions from A to Z.

Notes on entering text:

§ Text can be easily typed into a cell.  

§ In some rare cases, you may want to "force" PlanMaker to consider a number as text. This can be achieved
by putting a single quotation mark in front of the number. If, for example, you enter '42 (including the single
quotation mark), PlanMaker will treat this as text and not as a number.

§ Tip: If you have entered some text entries directly below each other in a column, you can open a dropdown
list of these entries by pressing the key combination Alt+Shift+â in a cell directly above or below the
entries. 

The program then displays a list of all text entries directly above or below this cell. If you select one of these
entries and press the Enter key¿, it will be copied to the cell. This can save you a lot of time when you have
to enter a large number of identical text entries.

Note: This feature works only with text entries – not with numbers, dates or formulas.

§ Another tip: Furthermore, when you type text into a cell, PlanMaker automatically makes suggestions from
the existing text entries found in the cells above and below this cell.  

Example: You have entered the values "New York", "Rio", and "Tokyo" in a column. If you now go to the
cell below these entries and type the letter "N", the program will automatically suggest "New York". If you
type the letter "T", "Tokyo" will be suggested, etc.

To accept the suggestion, press the Enter key¿. To reject it, simply continue typing or press the Del key.

Note: If you do not want PlanMaker to make suggestions while you are typing, you can always disable this
feature.

Choose the ribbon command File | Options , switch to the Edit tab and disable the option Autocomplete
cells.
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Undoing changes

In the Quick access toolbar, you can use the Undo button  to undo the last changes made to a document. If,
for example, you format cells in a different font, all you have to do is choose the command Undo and it will be
undone again.

This not only works for formatting, but for virtually all changes – for example, you can undo typing or the
deletion of text.

The command Undo can be applied repeatedly if necessary. For example, you can choose it five times to
reverse the last five changes. (Tip: You can set the maximum number of actions that can be reversed in the
Settings, General tab.)

If you click on the small arrow next to the Undo button, you will see a list of recent changes to which you can
revert. If you click on an entry in the list, several steps can be undone at the same time.

Redoing undone actions

There is also a counterpart to the command Undo: the Redo button  on the Quick access toolbar. This
restores the last action you undid. You can thus undo the cancellation of changes.

This command can also be chosen several times in succession. If, for example, you choose the command Undo
five times, the last five changes will be undone. If you then choose the command Redo five times, you will
restore the initial state.

Again, you can use the small arrow next to the Redo button to select entries from the list of recent actions to
restore multiple steps at the same time.

Repeating commands

The command Repeat  in the Quick access toolbar repeats the last command that you used with exactly the
same settings.

This is especially useful when applying formatting. If, for example, you have assigned a different font to a cell
via the ribbon tab Home | group Character, you can then navigate to other cells and simply use the command
Repeat there. These cells are then formatted in the same font – as if you had chosen the last command once
again with the same settings.

There are many other commands that can be repeated in this manner as often as desired.
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Selecting cells and cell content
For some PlanMaker commands, you can first select a range of cells before you execute them. The command
will then be applied to all cells within the selection.

If, for example, you select some cells and then press the Del key on the keyboard, all selected cells will be
deleted at once.

You can even select non-contiguous cell ranges (using the Ctrl key and the mouse).

The selection procedure differs depending on the operating system in use. Thus, this section is split into two
parts:

§ Selecting in the Windows, Mac or Linux version 

§ Selecting in the Android/iOS version

Selecting in the Windows, Mac or Linux version

In the Windows, Mac or Linux version of PlanMaker, you can select cells and cell content as follows:

Selecting via the mouse

To select something via the mouse, proceed as follows:

§ Selecting cell ranges 

You can select arbitrary cell ranges by pressing and holding down the left mouse button while you drag the
mouse cursor over the cells to be selected.
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§ Selecting whole rows and columns 

An entire column can be selected by clicking on its column header. Column headers are buttons displayed
above the worksheet (labeled A, B, C, etc.).

There are also row headers for each row, which are located to the left of the worksheet and are labeled 1, 2,
3, etc. If you click on a row header, the entire row will be selected.

If you left-click and drag the mouse cursor over several column or row headers, you can select multiple
columns or rows at the same time.

§ Selecting the entire worksheet 

The button in the upper left corner of the worksheet window (above 1 and to the left of A) has a special
function: clicking on it will select the entire worksheet.

Alternatively, you can do the same via the ribbon command Home | Select all .

§ Selecting a single cell 

To select a single cell, click on it, drag the mouse cursor to an adjacent cell, and drag it back again (while
holding down the left mouse button).

§ Selecting non-contiguous cell ranges 

You can also select non-contiguous cell ranges. To do so, hold down the Ctrl key and and then select the
desired cell ranges with the mouse button. (Mac users: Cmd key)

§ Selecting only part of the cell content 

To select only part of the content of a cell, proceed as follows:

First, double-click on the cell to edit its content. Then, drag the mouse cursor over the characters that you
want to select (while holding down the left mouse button).

§ Selecting objects 

To select an object (for example, a picture, a drawing, etc.), simply click on it with the mouse. A frame will
then appear around the object to indicate that it is now selected.

To select multiple objects, switch to object mode (see Object mode).

Selecting via the keyboard

Alternatively, you can use the keyboard for selecting. To do so, proceed as follows:

§ Selecting cell ranges 

To select a range of cells, hold down the Shiftñ key, and select the cells by navigating with the arrow keys.

If, for example, you navigate to cell B5, hold down the Shiftñ key and press â five times, cells B5 to B10
will be selected. For a list of all key combinations for moving and selecting within a worksheet, see Shortcut
keys.

§ Selecting a single cell 

To select a single cell, navigate to that cell, hold down the Shiftñ key, use any arrow key to select an
adjacent cell and then return to the original cell.
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From the cell to be selected and while holding down the Shift keyñ, first press the à key and then the ß
key.

§ Selecting non-contiguous cell ranges 

Non-contiguous cell ranges can only be selected with the mouse (see above).

§ Selecting only part of the cell content 

To select only part of the content of a cell, proceed as follows:

Navigate to the cell and press the F2 key to edit its content. Then, use the arrow keys together with the
Shiftñ key to select text in the usual manner.

§ Selecting objects 

Objects can only be selected with the mouse (see above).

Selecting in the Android/iOS version

Selecting works a little differently on Android/iOS devices. You can use either your finger or a mouse. Proceed
as follows:

§ Selecting cells 

On Android/iOS devices, you can select worksheet cells as follows:

Tap on the start cell once (you should not see a blinking text cursor in the cell now). After a short pause, tap
on this cell again, and keep your finger pressed down while you drag it to the desired end cell.

Tip: Use the ribbon command Home | Select all  to select the entire worksheet.

§ Selecting only part of the cell content 

To select only part of the content of a cell, proceed as follows:

First, double-tap on the cell to edit its content. Then double-tap the word in the cell with which you want to
start the selection. The word should now be selected. This is indicated by the large "handles" that appear in
front of and behind the word:

These two handles represent the beginning and end of the selection. To extend the selection to additional
text, simply drag the two handles to the desired positions.

§ Selecting objects 

To select an object (for example, a picture or drawing, etc.), simply click on it. A frame will then appear
around the object to indicate that it is now selected.

To select all objects, switch to object mode (see Object mode).
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Deleting cells and cell content
There are two methods for deleting data from a worksheet:

§ Deleting the content of cells 

If you use the Del key on the keyboard, only the contents of the selected cells will be deleted.

§ Deleting whole cells 

If you use the ribbon command Home | group Cells | Delete, however, the selected cells will be completely
deleted from the worksheet. The other cells in the worksheet will move up accordingly.

In addition, PlanMaker provides two commands specifically for deleting empty rows and duplicate rows:

FreeOffice: These two commands are not included in SoftMaker FreeOffice.

  

§ Deleting empty rows 

To delete all empty rows within a certain range of rows, select these rows, and then choose the ribbon
command Data | group Edit | Remove empty rows.

§ Deleting duplicate rows 

To delete all duplicate rows within a certain range of rows, select these rows, and then choose the ribbon

command Data | group Edit | Remove empty rows  | Remove duplicate rows.

For more information, see the following pages.

Deleting the content of cells

To delete the content of cells, proceed as follows:

1. Select the relevant cells.
For more information on how to select cells, see Selecting cells and cell content.

2. Press the Del key on the keyboard (or the ribbon command Home | Cut  ).

Only the contents of the cells are removed and not the cells themselves (see next section Deleting whole cells).

Selective deletion

If you use the ribbon command Home | group Contents | Delete  (Delete special) instead, you can
determine exactly what will be deleted.

The program displays a dropdown menu with the following options:
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§ All 

This option deletes everything – cell contents as well as formatting, comments, conditional formatting and
input validation of selected cells.

§ Formatting 

This option deletes only the formatting (number format, character format, borders, etc.).

§ Contents 

This option deletes only the contents of the selected cells. Everything else (formatting, comments, etc.) is
retained.

§ Comments 

This option only removes comments that have been added to the selected cells, leaving both content and
formatting intact (see Using comments).

§ Conditional formatting 

This option removes all conditional formatting of the selected cells (see Conditional formatting).

§ Input validation 

This option removes all input validation of the selected cells (see Input validation).

§ Reset character formatting 

This option removes all character formatting that you have applied to the selected cells (see also Resetting
the character formatting).

§ Remove link 

This option removes the hyperlink, but the cell or text passage to which it is assigned remains intact (see
also Using hyperlinks).

Deleting whole cells

The ribbon command Home | group Cells | Delete  not only deletes the content of the selected cells but also
removes them completely from the worksheet.

If you click on this command, the program displays a dropdown menu in which you can determine how the
other cells should be moved up after the deletion process.

The following options are available:

§ Delete cell, move cells up 

If you select this option, the selected range of cells will be deleted and the cells below will move up.

§ Delete cell, move cells to the left 

If you select this option, the selected range of cells will be deleted and the cells to the right of it will move to
the left.

§ Remove complete rows 

This option deletes the complete rows within the selected range of cells and not just the selected cells. The
rows below move up accordingly.
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§ Remove complete columns 

This option deletes the complete columns within the selected range of cells and not just the selected cells.
The columns to the right of them move to the left accordingly.

§ Delete worksheet 

This option removes the worksheet (including its content). For more information, see Managing worksheets.

Deleting empty rows

FreeOffice: The command Remove empty rows is not included in SoftMaker FreeOffice.

To delete all empty rows within a certain range of rows, select the range from which you want to remove empty
rows.

Then choose the ribbon command Data | group Edit | Remove empty rows  .

PlanMaker scans this range for rows that are completely empty (i.e. where none of their cells contain a value).
All corresponding rows are deleted.

Note

Normally, you select a range of complete rows before using this command. However, you can also select a cell
range that doesn't consist of complete rows. PlanMaker will then ask you if you want it to delete the
corresponding rows completely:

§ If your answer is Yes, all corresponding rows will be deleted completely. 

§ If your answer is No, only cells within the selection will be deleted. The cells to the left and right of the
selection will remain unchanged.

Deleting duplicate rows

FreeOffice: The command Remove duplicate rows is not included in SoftMaker FreeOffice.

To delete all duplicate rows within a certain range of rows, select the range from which you want to remove
these rows.

Then choose the ribbon command Data | group Edit | Remove empty rows  | Remove duplicate rows.

PlanMaker scans this range for rows that are completely identical (i.e., where the contents of all cells in one
row are identical to the corresponding contents in another row). It then deletes these duplicate rows.
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Note

Normally, you select a range of complete rows before using this command. However, you can also select a cell
range that doesn't consist of complete rows. PlanMaker will then ask you if you want it to delete the
corresponding rows completely:

§ If your answer is Yes, all corresponding rows will be deleted completely. 

§ If your answer is No, only cells within the selection will be deleted. The cells to the left and right of the
selection will remain unchanged.
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Inserting new cells

The ribbon command Home | group Cells | Insert  inserts new cells, rows or columns in a worksheet.

If you choose this command, the program displays a dropdown menu in which you can select how to insert the
cells.

The following options are available:

§ Insert cell, move cells down 

The program inserts the exact number of cells as were selected before choosing this command. If nothing
was previously selected, only one cell will be inserted.

The cells below the insertion will be moved down.

§ Insert cell, move cells to the right 

The program inserts the exact number of cells as were selected before choosing this command. If nothing
was previously selected, only one cell will be inserted.

The cells to the right of the insertion will be moved further to the right.

§ Insert complete rows 

PlanMaker will insert as many complete rows as were included within the selection. If nothing was
previously selected, only one row will be inserted.

The rows below the insertion will be moved down.

§ Insert complete columns 

PlanMaker will insert as many complete columns as were included within the selection. If nothing was
previously selected, only one column will be inserted.

The columns to the right of the insertion will be moved further to the right.

The dropdown menu of the command Insert  also contains the following options:

§ Insert copied cells, see next section 

§ Insert worksheet, see Creating new worksheets
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Inserting copied cells
You sometimes want to insert copied cells in a place that already contains values. If you only want to move
these values rather than overwrite them when pasting something from the clipboard, you have the following
option:

The ribbon command Home | group Cells | Insert  | Insert copied cells inserts cells, rows or columns from
the clipboard into the worksheet.

The program opens a dialog box in which you can select how the cells should be inserted:

§ Move cells down 

The copied cells from the clipboard are pasted into the selected place.

The cells below the insertion will be moved down.

§ Move cells to the right 

The copied cells from the clipboard are pasted into the selected place.

The cells to the right of the insertion will be moved further to the right.

§ Insert complete rows 

The copied rows from the clipboard are pasted into the selected place.

The rows below the insertion will be moved down.

§ Insert complete columns 

The copied columns from the clipboard are pasted into the selected place.

The columns to the right of the insertion will be moved further to the right.
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Moving and copying
All operating systems supported by PlanMaker have an extremely useful feature: the clipboard.

The clipboard works as follows: You select something in the worksheet and then cut or copy the selected
content to the clipboard. You can then reinsert the selected content elsewhere in the worksheet. The clipboard
thus enables cells (as well as objects) to be deleted, copied or moved.

All necessary commands can be found on the ribbon tab Home | group Edit:

Command Explanation

Cut The ribbon command Home | Cut deletes the content of a selection – but not permanently. This
content is moved to the clipboard and can be pasted from there at any time.

Copy The ribbon command Home | Copy copies the content of the selection to the clipboard.

Paste* To paste the contents of the clipboard, choose the command Home | Paste. Position the cursor in
the desired place, and then choose this command (click directly on the icon itself). You can also
insert the content of the clipboard multiple times in this manner.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a
dropdown menu opens with additional options for pasting the content. For more information, see
Paste special.

* For information on how to paste from the clipboard without overwriting the existing values in the selected place, see Inserting copied cells.

This works in the same manner for objects such as pictures, charts and drawings.

Pasting into a selected cell range

If you copy cells to the clipboard and then select a range of cells before choosing the ribbon command Home |
Paste, PlanMaker will fit the pasted cells into this selection.

This is shown as follows:

§ If the selected cell range is smaller than the cell range to be pasted, all cells that do not fit will be omitted. 

§ If the selection is larger than the cell range to be pasted, the cells will be repeated until the selected range is
completely filled.

§ There's one exception:

If the selected cell range consists of just one row, PlanMaker will still paste all columns of the copied cells.

The same applies when the selected cell range consists of just one column.

Moving and copying with the mouse ("drag and drop")

Android/iOS: This feature is not available in the Android or iOS version.
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You can also move or copy cells by simply selecting them, dragging them with the mouse to a different place
and dropping them there. This "drag and drop" technique enables you to move or copy cell contents very
quickly.

To do so, proceed as follows:

1. Select the relevant cells.

2. Press the selected cells with the left mouse button and wait about one second until a small dashed rectangle
appears on the mouse cursor.

3. While still holding the mouse button down, drag the selected cells to the target position.

4. When you release the mouse button, the cells will be moved to the target position.

If you hold down the Ctrl key while releasing the mouse button, the cells will instead be copied to the new
position.

If you hold down the Alt key while releasing the mouse button, the program displays a dialog box in which
you can choose whether the cells are to be copied or moved. When you choose "Copy", you can also specify
whether only the contents of the cells or also their formatting should be copied.

Copying and moving formulas with relative coordinates

If you copy or move cells that contain formulas, the cell addresses in those formulas are automatically updated
to the new place in the worksheet.

An example:

Let's suppose that cell A7 contains a formula that adds up the values from the four cells above:

=SUM(A3:A6)

You now copy this formula to position B7. PlanMaker will automatically update the formula so that it will work
again with the four cells above the total row. Cell B7 will thus contain the following formula:

=SUM(B3:B6)

If you do not want this to happen, use absolute cell addressing instead of the usual relative cell addressing. For
more information, see Relative versus absolute cell references.
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Paste (special)

There is a more powerful variant for the ribbon command Home | group Edit | Paste .

If, for example, you have copied text or complete cells and click on the small arrow below the Paste icon, you
can use the dropdown menu to specify in which form the content from the clipboard should be pasted.

In detail:

When you use the commands Cut or Copy to save information to the clipboard, it is saved in multiple formats
simultaneously. If, for example, you have copied text, it will appear in the clipboard in both formatted and
unformatted form.

Normally, you don't need to worry about this because PlanMaker automatically selects the most appropriate
format when you paste the content of the clipboard into the document by clicking directly on the icon Paste.

Alternatively, you can select the format yourself by clicking on the arrow of the icon Paste .

The following options are available here:

Pasting content via the dropdown menu of the command

If you click on the small arrow of the ribbon command Home | group Edit | Paste , you will get a dropdown
menu with various entries for direct selection:

§ Paste : The original formatting of the copied content is retained. This results in the same program
behavior as when you click directly on the Paste icon above the small arrow. 

§ Paste unformatted text : This option appears contextually if you have copied text. If you select this
entry, the original formatting of the copied text will be removed, and it will adopt the formatting of the
passage where it is pasted. This option can also be found in the dialog box Paste special (see below).

§ Paste picture : This option appears contextually if you have copied a picture. Use this entry to paste the
picture from the clipboard.

§ Paste formats, Paste values, Other paste options: appear contextually if you have copied complete
worksheet cells. You will be offered some common paste options that you will also find in the dialog box
Paste special (see below).

§ Paste special: This option opens a dialog box with differentiated options for pasting contents from the
clipboard (see below). 

Pasting content via the dialog box with additional options

If you select the Paste special entry from Home | group Edit | Paste , the program displays a dialog box in
which you can specify exactly how the content from the clipboard is to be pasted.

The dialog box displays a list of all formats in which the information currently on the clipboard is stored. If you
select the desired format from the Paste as list and then confirm with OK, the content of the clipboard will be
pasted in the selected format.
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Furthermore, this dialog box offers several additional options, but they are only available if worksheet cells
have been copied to the clipboard:

The following additional options are available:

"Paste content" section

Here, you can specify how the content of the cells in the clipboard should be pasted:

§ Paste cell contents 

If this option is enabled, the content of the copied cells will also be pasted. If it is disabled, only their
formatting will be pasted.
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§ Convert formulas to values 

If this option is enabled, PlanMaker will paste the results of formulas in the copied cells rather than the
formulas themselves. So if you copy a cell containing the calculation "=A1*2" to the clipboard, PlanMaker
will calculate its current value and paste the result as a numeric value.

§ Ignore comments 

If this option is enabled, comments that have been added to the copied cells will be omitted when pasting.

"Paste formatting" section

These options determine whether the formatting of the copied cells is to be retained when pasting:

§ All 

The cells retain their entire formatting when they are pasted. (Selecting this option enables all the other
options listed below.)

§ Number format 

The cells retain their number format when they are pasted.

§ Cell format 

The cells retain their cell format when they are pasted.

§ Input validation 

The cells retain their input validation settings when they are pasted.

§ Conditional formatting 

The cells retain their conditional formatting settings when they are pasted.

§ Borders, Shading 

The cells retain their borders/shading when they are pasted.

"Paste cell dimensions" section

These options determine whether the cell sizes of the copied cells should also be transferred to the target cells
when pasting:

§ Column width 

The cells retain their column width when they are pasted.

§ Row height 

The cells retain their row height when they are pasted.

"Options" section

This section contains the following additional options:
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§ Transpose 

If this option is enabled, the row and column order of the cells will be reversed when they are pasted. Thus,
rows will become columns and columns will become rows.

§ Skip empty cells 

If this option is enabled, all empty cells will be skipped when the copied cells are pasted. Thus, an existing
cell will keep its current content and formatting if you paste an empty cell over the existing cell.

§ Operation 

This option can be useful when you paste cells over existing cells. It determines whether the existing values
should be combined with the copied values. For this purpose, the four basic arithmetic operations are
available:

None: Do not combine the copied values and the existing values. Just overwrite the existing values. This is
the default setting.

Add to destination: Add the values in the clipboard to the existing values.

Subtract from destination: Subtract the values in the clipboard from the existing values.

Multiply with destination: Multiply the existing values by the values in the clipboard.

Divide the destination: Divide the existing values by the values in the clipboard.

Example: Copy a cell that contains the value 2 to the clipboard. Then select a cell that contains the value 8,

and choose the command Home | Paste  | Paste special. If you choose the option Add to destination in
the dialog box, the cell will then contain the value 10 (8+2=10).

"Paste reference" button

The Paste reference button ignores any settings made in this dialog box, as it has the following special
function:

When you copy cells to the clipboard, choose the command Home | Paste  | Paste special and then click on
the Paste reference button, cell references to the addresses of these cells will be pasted instead of the cell
contents.

If you copy cell B15 to the clipboard, this button will insert the cell reference =B15.

Tip: This works even if cells have been copied to the clipboard from another document. In this case,
PlanMaker will automatically insert an external cell reference. For more information, see External cell
references.
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Filling cells automatically
You can use the Fill function to copy the contents of one cell to other cells in an instant or to create an
increasing or decreasing number series across several cells based on this cell content.

There are two ways to use this function:

Filling with the mouse

The easiest way to fill cells automatically is via the mouse. Proceed as follows:

1. Enter the initial value in a cell.

2. Click on that cell (to make it the currently selected cell).

3. Hover over the small square in the bottom right corner of the cell frame that surrounds the current cell
(outlined in red in the figure):

4. Drag this square in the desired direction while holding down the mouse button. Release the mouse button
when the target position has been reached.

All cells in the selected area have now been filled automatically.

What the cells are filled with depends on the content of the initial cell:

§ If the initial cell contains text, PlanMaker will fill all cells with this text. 

§ If the initial cell contains a number (e.g., 42), PlanMaker will fill successive cells with incrementing values
(in this case, 43, 44, 45, etc.).

Tip 1: If you do not want PlanMaker to fill the cells with a series of numbers but just want to have all cells
filled with 42, press and hold down the Ctrl key while dragging with the mouse.

Tip 2: By clicking on the small square, you can also fill a series if there are values in the column to the left
of it. The series then expands to the end of the values in the column to the left of it. In this case, too, you can
use the Ctrl key to fill the series with the same values.

If you press and hold down the Alt key while dragging, the program will display the following dialog box in
which you can specify exactly how the cells should be filled.

Filling via buttons/dialog box

To fill cells automatically via buttons/dialog box, proceed as follows:

1. Enter the initial value in a cell.



83Editing worksheets

2. Select the cell with this initial value and all cells that you want to fill.

3. Choose the ribbon command Home | group Contents | Fill .

4. In the dropdown menu, specify the fill direction (starting from the cell with the initial value and moving in
the direction of the selected cells): Down, Right, Up or Left.

As soon as you have selected a direction, the corresponding cells are filled with the initial value (copied as
value and format but not incremented).

5. If you want to make further settings (for example, increment values instead of copying them), select the
entry Series in the dropdown menu to open the dialog box. Here, you can specify exactly how the cells
should be filled (see below).

As soon as you confirm with OK in the dialog box, the selected cells are filled according to your settings.

In the dialog box, you can make the following settings:

§ Series in 

Here, select whether to fill in the direction of the rows (to the right) or in the direction of the columns
(downwards).

Note: If you have selected only one row or only one column, this option is omitted and PlanMaker automatically presets rows or
columns.

§ Source 

Enable the option Contents if you want the cells to be filled with values.

Enable the option Format if you also want the formatting of the source cell to be applied to the new cells.

Both options are enabled by default.

§ Action 

This option corresponds to pressing the Ctrl key when filling cells with the mouse. It lets you determine
whether to copy values or to increment them from cell to cell:

If, for example, the initial cell contains 42 and you select Copy, all cells will be filled with 42.
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If you select Increment, successive cells will be filled with a series of numbers (in this case, 43, 44, 45,
etc.).

The numeric increment can be specified using the other options in this dialog box:

§ Series type 

Here, you specify how the number series is to continue:

Auto:

This option corresponds to an arithmetic series: Each additional value will be increased by the increment.
However, PlanMaker determines the increment automatically.

If, for example, you continue two cells with the values 10 and 20, the next cells will be filled with 30, 40,
50, etc. For more information, see Tips and tricks in the next section.

Arithmetic:

Here, each additional value will be increased by the increment.

If, for example, the initial cell contains 1 and you specify an increment of 2, the following cells will be filled
with 3, 5, 7, 9, 11, etc.

Geometric:

Here, each additional value will be multiplied by the increment.

If, for example, the initial cell contains 1 and you specify an increment of 2, the following cells will be filled
with 2, 4, 8, 16, 32, etc.

Date:

Here, each additional value in the selected Date unit (see below) will be increased by the specified
increment. This type of series is only useful if the initial cell contains a date.

If, for example, the initial cell contains the date 1/1/2018, the Increment is set to 1 and the Date unit is set
to "Months", the new cells will be filled with 2/1/2018, 3/1/2018, 4/1/2018, etc.

§ Date unit 

This option is only available if the Series type is set to "Date".

It allows you to specify the date unit of the increment:

Days: increment by days

Workdays: increment by days, excluding Saturdays and Sundays. If, for example, the initial value is a
Friday, the next value would be the Monday (not Saturday).

Months: increment by months

Years: increment by years

§ Increment 

Here, you specify the amount by which each value will increase from cell to cell. See above for examples.

Positive or negative increment values can be used.

This option is not available if the Series type is set to "Auto", as PlanMaker automatically determines the
increment in this case.
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§ Increment each cell separately 

When this option is enabled, the specified increment will be added to each of the currently selected cells
individually.

Example:

You select three cells containing the values 1, 2, 3, and try to fill the cells below them.

If this option is disabled, this sequence is simply continued and the cells are filled as follows: 4, 5, 6, 7, 8, 9,
10, 11, 12, etc.

If you enable this option, the cells are filled as follows: 2, 3, 4, then 3, 4, 5, then 4, 5, 6, etc.

§ Edit lists button 

You can also create your own lists for the Fill function.

If, for example, you create a list with the content "Red", "Green" and "Blue", and then subsequently start a
fill operation from a cell that contains the text "Red", PlanMaker will continue the series and fill with Green,
Blue, Red, Green, Blue, etc.

For more information on how to create such lists, see Editing lists for automatic filling.

Tips and tricks for automatic filling

The many options that are available for the Fill function make its application seem more difficult than is
actually the case. This section offers some tips and tricks on how to use this extremely useful feature most
effectively.

Tip: The quickest way to fill a range of cells is to use the mouse to drag the small rectangle in the bottom
right corner of a cell in the appropriate direction. PlanMaker then sets the series type to "Auto". This means
it will automatically determine which values to use to fill the cells (see following examples).

§ Filling with text 

When filling with text, you do not need to worry about any options, as text can only be copied anyway.

If you want to fill multiple cells with the same text, simply enter it into a cell, click on that cell, and then
drag the small rectangle in the bottom right corner of the cell frame over the cells you want to fill with it.

§ Filling with numbers 

If you use the mouse to fill cells with numbers, PlanMaker will automatically determine the increment.

If, for example, you drag the small rectangle from a cell with 42, the other cells will be filled with the values
43, 44, 45, etc.

If the initial cell value is 10 and the cell value below it is 20, and you select both cells and drag the small
rectangle downwards, PlanMaker automatically recognizes how to continue this series and fills the other
cells with 30, 40, 50, etc.

§ Filling with formulas 

If you use the mouse to fill cells with formulas, PlanMaker automatically attempts to update the formulas in
the new cells with incremented cell addresses.

For example, the formula =A1*2 in the initial cell will be updated to =A2*2, =A3*2, etc., in the other cells.
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§ Filling with dates 

Filling with dates is identical to filling with numbers:

Enter the start date in the initial cell and drag the small rectangle over the desired cells. PlanMaker will add
one day to each additional cell.

If necessary, you can use the ribbon command Home | group Contents | Fill | Series to specify via the
dialog box whether to increment by days, months or years.

§ Filling with structures 

As you have already learned, you can also select multiple cells and continue them. What if the selected cells
have no automatically recognizable increment or completely different values?

In this case, PlanMaker will attempt to find a pattern within these values. If, for example, you enter the
values 1, 2, text, PlanMaker will continue the series with 3, 4, text, 5, 6, text, 7, 8, text, etc.

If the values are solely strings, they will be simply repeated. If the initial cells are filled with Red, Green,
Blue, the following cells will be filled with Red, Green, Blue, Red, Green, Blue, etc.

§ Filling with custom lists 

If you choose the ribbon command Home | group Contents | Fill | Series, you can create your own lists for
the Fill function using the Edit lists button in the dialog box that opens.

If, for example, you create a list with the content "Red", "Green" and "Blue", and then subsequently start a
fill operation from a cell that contains the text "Red", PlanMaker will continue the series and fill with Green,
Blue, Red, Green, Blue, etc.

Note: If necessary, you can also add a separate Edit lists button for direct access to a ribbon tab. For more
information on this topic and all other information on creating your own lists, see Editing lists for automatic
filling.

Working with multiple worksheets
PlanMaker worksheets do not necessarily have to consist of a single worksheet. You can also stack several
worksheets on top of each other – just like a stack of papers. Thus, PlanMaker documents are also called
workbooks. Each workbook can contain up to 2048 worksheets.

The main advantage of this is that calculations in one worksheet can also refer to cells in other worksheets of a
workbook, thus letting you create "three-dimensional" calculations as such. For more information, see
Calculating in three dimensions.

In this section, you will learn everything you need to know about working with multiple worksheets in a
document. The following topics are covered:

§ Creating new worksheets 

To create a new worksheet, choose the ribbon command Insert | Sheet | Insert.
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§ Working with the worksheet register 

The worksheet register displayed at the bottom of the document window allows you to switch between the
worksheets of a document with a single mouse click. You can also use it to create, move and manage
worksheets.

§ Managing worksheets 

The context menu of the worksheet register and the ribbon command Insert | Sheet both contain commands
for managing worksheets (Rename, Copy, Move, etc.).

§ Calculating in three dimensions 

In the last section, you will learn how to perform calculations across multiple worksheets.

The following pages provide detailed information on these topics.

Creating new worksheets

To add a new worksheet, choose the ribbon command Insert | group Tables | Sheet . The program opens a
dropdown menu in which you can choose the command Insert.

Tip: You can create a new worksheet faster with the  icon in the worksheet tab.

PlanMaker creates the worksheet and makes it the active worksheet.

Working with the worksheet register

The worksheet register at the bottom of the document window displays tabs for each worksheet in the current
document.

The active worksheet is highlighted.

You can use the worksheet register to perform the following actions:

§ Switching between worksheets 

To switch to a different worksheet, simply click on its tab in the worksheet register.

Note: If there are more worksheet tabs than can be displayed at the same time, you can scroll through the list
using the arrows displayed to the left of the register.

Tip: You can also switch between the worksheets via the keyboard: Use Ctrl+Tab to move to the next
worksheet and Ctrl+Shift+Tab to move to the previous worksheet.
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§ Changing the order of worksheets 

The worksheet register can also be used to move worksheets, thus allowing you to change their order.

To do so, left-click for about one second on the tab of the sheet that you want to move and, while still
holding down the mouse button, drag the tab to the desired position in the worksheet register.

§ Editing multiple worksheets at the same time 

You can select multiple worksheets in the worksheet tab and edit them simultaneously. To select multiple
worksheets, press and hold the Ctrl key while you click on their tabs in the register. (Mac users: Cmd key)

If multiple worksheets are selected, changes made to one of the worksheets will affect all of the other
selected worksheets in exactly the same way.

Examples:

If you change the formatting of cells, your changes will also be applied to the same cells in the other selected worksheets.

When you edit or delete the content of a cell, the same cell in the other selected worksheets will be changed in the same manner.

Changes to the cell size (ribbon tab Layout | group Cells) also affect all selected worksheets.

Tip: To select multiple worksheets at the same time, use the Shift key instead of Ctrl. To deselect, click
again with the mouse and Ctrl or Shift on the tab(s).

§ Managing worksheets 

When you right-click on one of the tabs in the worksheet register, the program will display a context menu
that contains all commands for creating and managing worksheets. For more information, see the next
section Managing worksheets.

§ Creating a new worksheet 

The tab to the right of the worksheet register with the  icon serves as a "shortcut" for creating new
worksheets: When you click on it, PlanMaker immediately creates a new worksheet.

Managing worksheets

If you choose the ribbon command Insert | group Tables | Sheet , a dropdown menu opens with commands
for managing worksheets.

Tip: These commands (and a few more) also appear in the context menu by right-clicking on the desired tab
in the worksheet register at the bottom.

The menu contains the following commands:

§ The command Insert creates a new worksheet. 

§ The command Copy creates a copy of the current worksheet. To do so, the program displays a submenu in
which you can choose where the copy should be placed (within the other worksheets).

If you want to place the copy in a different (currently open) document or in a new document, choose the
option To another document.
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§ The command Move moves the worksheet to a different location. As with the command Copy, the program
opens a submenu in which you can choose the location. 

§ The command Delete removes a worksheet along with its contents.

Alternatively, you will find the command under Home | group Cells | Delete | Delete worksheet.

§ The command Rename lets you change the name of a worksheet.

Tip: You can also simply double-click on the worksheet in the worksheet register at the bottom.

§ The command Hide ensures that the worksheet is hidden. 

Alternatively, you can use the command Home | group Cells | Visibility | Hide sheet.

Hidden worksheets are invisible. They cannot be displayed or edited, and they do not even appear in the
worksheet register. However, PlanMaker continues to use them for calculations.

§ The command Show makes hidden worksheets (see command Hide) visible again.

Alternatively, you can use the command Home | group Cells | Visibility | Show sheet.

This opens a dialog box that shows all hidden worksheets. In the list, click on the sheet that you want to
show again. Use the Select all button to select all hidden sheets from the list. Press OK to make the selected
worksheets visible again.

§ The commands Select all sheets and Deselect sheets (in the context menu of the worksheet register) select
or deselect all worksheet tabs in the worksheet register. 

§ You can choose the command Page Setup (in the context menu of the worksheet register) to make settings
such as page size, page margins, etc., for a worksheet. The dialog box corresponds to the ribbon tab Layout |
command group Page Setup . For more information, see Page setup.

§ The command Copy page setup (in the context menu of the worksheet register) allows you to copy the page
setup of a worksheet – i.e., all settings made with Page setup – to another worksheet. The program opens a
submenu with the following commands:

To all sheets: Copies the page setup from the current worksheet to all other sheets.

From...: Copies the page setup from any other worksheet to the current worksheet.

§ You can choose the command Properties to make general settings for a worksheet. For more information,
see Changing worksheet properties. 

Tip: As previously described in Working with the worksheet register, you can select multiple worksheets in the
worksheet register. Some of the aforementioned commands (for example, Hide) can then be applied to all
selected sheets at the same time.

Note: If you enable workbook protection for a document, you can no longer make any changes to the
worksheet register in it. The ribbon commands under Insert | Sheet are no longer available. For more
information, see Workbook protection.
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Calculating in three dimensions

The specific advantage of documents with multiple worksheets is that you can also perform calculations across
multiple worksheets.

To do so, specify the name of the desired worksheet before the cell address (separated by an exclamation point).
For example, "Sheet1!A1" refers to cell A1 on worksheet "Sheet1".

An example

Let's assume that you want to create a profit and loss statement. For this purpose, you have created three
worksheets named "Sales", "Costs" and "Profit".

You now want the value in cell D2 of the "Costs" worksheet to be deducted from the value in cell A8 of the
"Sales" worksheet and to appear in cell C9 of the "Profit" worksheet.

To do so, switch to the "Profit" worksheet. Navigate to cell C9 in this worksheet and enter the following
formula:

=Sales!A8-Costs!D2

After pressing the Enter key¿, cell C9 in the "Profit" worksheet will contain the result of your calculation.

Naming cell ranges

Choose the ribbon command Edit names  to assign names to cell ranges.

If, for example, your worksheet has four columns with the sales figures for spring, summer, autumn and winter,
then just name these columns accordingly. You can now perform the following calculation:

=SUM(Spring)

The ribbon tab Formula | group Named areas contains all commands that you need for defined cell ranges.

For more information on working with cell ranges, see the following pages. The following topics are covered:

§ Assigning and editing names for cell ranges 

§ Defining names automatically from the selection

§ Creating a list of all named ranges

§ Using named ranges

§ Applying names to existing formulas
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Assigning and editing names for cell ranges

Assigning names

To assign a name to a cell range, proceed as follows:

1. Select the cell range that you want to name.

2. Choose the ribbon command Formula | group Named areas | Edit names .

3. In the dialog box, enter the desired name in the Name field.

4. Click on the Add button.

You have now assigned the specified name to the selected cell range.

This name can now be used in formulas to represent the cells in the specified range. If you assign the name
"January" to the cell range from A2 to A10, the formula =SUM(January) is equivalent to =SUM(A2:A10).

Note: Names for cell ranges may only consist of letters, numbers, underscores and periods. The first
character must be a letter or an underscore.
Furthermore, names must not be structured like cell references. For example, the name "A2" is not allowed
because PlanMaker would not be able to distinguish it from the cell address A2.

Tip: A faster method

To assign names even faster, proceed as follows:

In the top left corner of the worksheet, there is an editable dropdown list that normally displays the current cell
address.

Use this dropdown list to quickly assign a name to a cell range as follows:

1. Select the cell range that you want to name.

2. Use the mouse to click into this editable dropdown list.

3. Enter the new name for the selected cell range.

4. Press the Enter key¿.

You have now assigned the specified name to the selected cell range.
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Note: In this dropdown list, you can also display the existing named ranges at any time.

Renaming or deleting names

To rename or delete a named cell range, proceed as follows:

1. Choose the ribbon command Formula | group Named areas | Edit names .

2. In the list of names, select the desired name.

3. To change the name, click on the Rename button. To delete it, click on the Delete button.

The name has now been changed or deleted.

Note: If you delete a name, all formulas that use this name will now return a #NAME? error value instead of
a result. If, for example, a cell range was named "January", all references to this named range, such as
=SUM(January), will display a #NAME? error value.

Defining names automatically from the selection

If you select cells that contain values as well as row or column headings, you can let PlanMaker generate named
ranges automatically from these cells. PlanMaker automatically retrieves the names from the headings.

Proceed as follows:

1. Select the desired cell range. It must contain both the values and the headings to be used for naming.

2. Choose the ribbon command Formula | group Named areas | Create names .

3. PlanMaker displays a dialog box in which you specify the row and/or column containing the headings to be
used for naming (see example).

4. Confirm with OK.

The names will now be created from the selected headings.

An example

You have created the following table:

Now select all values and all headings, and choose the ribbon command Formula | Create names. Then
specify the row and/or column from which names are to be created:
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§ If you select Top row, PlanMaker will assign the names "January", "February" and "March" to the cells
below them. 

§ If you select Left column, PlanMaker names the cells to the right of "London", "Paris" and "Madrid" with
the corresponding name.

§ If both options are selected, PlanMaker will create all six names listed above.

Creating a list of all named ranges

You can instruct PlanMaker to insert a list of all named cell ranges into the worksheet. This is useful if you
want an overview of all named cell ranges in the worksheet and the corresponding cell addresses.

Proceed as follows:

1. Select the cell where the list is to be inserted.

2. Choose the ribbon command Formula | group Named areas | Export names .

A list of all named ranges will now be inserted into the worksheet.

Using named ranges

If you have named cell ranges using the ribbon command Formula | group Named areas | Edit names , you
can perform various operations much more efficiently.

You use named ranges in practice as follows:

Quickly selecting a named range

In the top left corner of the worksheet window, you will see a dropdown list that displays the address of the
currently selected cell.

If you open this dropdown list, a list of all named ranges will be displayed. If you click on a name, the
corresponding cell range will be immediately selected.
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Using names in formulas

In formulas, range names can be used instead of the cell addresses they represent. This not only saves time, but
it also makes formulas clearer.

An example:

You have entered sales figures for January in cells A2 to A10. You have also assigned the name "January" to
this cell range.

To sum up the sales for January, you simply type:

=SUM(January)

This method is also more easily comprehensible than the default naming convention of =SUM(A2:A10).

Of course, you can now also name the sales for February, March, etc., accordingly.

Tip: The dialog box of the ribbon command Formula | Function  also contains an entry called "Named
ranges" in the Category list. If you select this category, all named ranges will be listed in the Function list
so that you can easily insert them into formulas.

Applying names to existing formulas

The ribbon command Apply names on the ribbon tab Formula | group Named areas is a useful option for
using named ranges: It scans all formulas in the selected range. If it finds a cell reference within a formula for
which a name has already been defined, it replaces it with the name.

You use this command as follows:

1. Select the range of cells whose formulas you want to update. If you do not select anything, the entire
worksheet will be affected.

2. Choose the ribbon command Formulas | group Named areas | Apply names .

3. In the Names list, select all names that you want to apply. Alternatively, click Select all to select all names.

4. Confirm with OK.

PlanMaker now scans all cell references within the selected range. Any cell reference that has a name assigned
to it will be replaced by the corresponding name.

An example:

The name "January" is assigned to cells A2 to A10. One of the cells in the worksheet contains the formula
=SUM(A2:A10). If you now use the ribbon command Formula | group Named areas | Apply names, the
formula in this cell will be converted to =SUM(January).
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The option "Also apply to relative references"

The aforementioned dialog box contains the option Also apply to relative references. This option should
normally remain enabled.

This option means the following:

In PlanMaker, names always refer to cell ranges with absolute addressing (like $A$1:$A$10). However,
relative addressing is usually used in calculations (for example, A1:A10).

If this option is enabled, PlanMaker will also convert relative cell references.

If the option is disabled, PlanMaker will only convert absolute cell references.

An example:

Let's assume that the range from A1 to A10 (more precisely: $A$1:$A$10) was named "January". If you apply
the Apply names function to the formula =SUM($A$1:$A$10), this formula will always be converted to
=SUM(January). If you apply it to the formula =SUM(A1:A10), however, the formula will be converted only if
the option Also apply to relative references is enabled.

For more information on this topic, see Relative versus absolute cell references.

Transposing cells

FreeOffice: The command Transpose is not included in SoftMaker FreeOffice.

The ribbon command Data | group Edit | Transpose  reverses the row and column order of the selected
cells. Thus, rows will become columns and columns will become rows.

Select the desired cell range before you use this command.

Important: Please note that transposing does not adapt any formulas or range names to the changes made to
cell addresses by transposing, neither inside nor outside the transposed range!

Splitting text into multiple columns

FreeOffice: The command Text to columns is not included in SoftMaker FreeOffice.

By choosing the ribbon command Data | group Edit | Text to columns, you can split text that is in one
worksheet cell into multiple worksheet columns. If, for example, a cell contains a sentence, this command will
move each single word into its own column.
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You apply this command as follows:

1. Navigate to the cell that contains the text to be distributed across columns.

(You can also select multiple cells or even an entire column.)

2. Choose the ribbon command Data | group Edit | Text to columns .

3. The program displays a dialog box with several options (see below).

PlanMaker usually makes all the settings in it automatically, and you don't have to change anything.

4. Confirm with OK.

The text in the cell will then be distributed across multiple columns.

Options of the dialog box

Tip: The best settings for this dialog box are determined automatically upon analysis of the cell contents and
usually do not need to be changed.

The dialog box for this command has the following options:

§ Target range 

If desired, you can enter a different target range here. If you do so, the distributed text will then be placed in
the specified target position rather than in its original position.

You only have to specify the address of the cell in the top left corner of the target position.

§ Separator 

If required, you can specify which character PlanMaker should consider as a text separator here. If, for
example, the cell contains the sentence "This is a test", PlanMaker automatically selects a space as a
separator and thus distributes each word to a column.

§ Text marker 

If the text in the cell contains text markers, use this option to specify which character has been used (for
example, quotation marks).

Background info:

The text export feature of some programs surrounds each data field with such a text marker in order to make
it easy to determine where each field begins and ends.

Sorting cells
You can use the sort commands on the ribbon tab Data | group Filter to sort a cell range.

Tip: You will also find the commands on the ribbon tab Home| group Contents | Sort and filter.
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Simple sorts: Quickly via the direct commands

If you only want to apply the sort to a certain column, you can do this directly via the commands Sort
ascending and Sort descending.

You can also select a cell range across multiple columns; in this case, the left column of the selected range is
sorted. The selected values to the right of it follow their left value in the same row.

Select the cell range you want to sort, and then on the ribbon tab Data | group Filter, choose one of the
following commands:

§ Ascending  

The data of the selected column is sorted in ascending order (A-Z).

§ Descending 

The data of the selected column is sorted in descending order (Z-A).

If, on the other hand, you want to apply different sort criteria to the columns of a selected cell range or select
other user-defined options, choose the command Sort to open the dialog box (see below).

Sort with different criteria: Via the dialog box

You can choose the ribbon command Sort to open a dialog box with additional sort options.

Proceed as follows:

1. Select the cell range to be sorted.

2. Choose the ribbon command Data| group Filter | Sort .

3. PlanMaker opens the following dialog box:
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4. For 1:, select the Column by which you want to sort.

5. To the right of it, you can also change the Order of the sort: You can sort the cell values in Ascending (A to
Z) or Descending order (Z to A).

Note: If different shades or font colors have been applied to cells, they can also be sorted. See "Sorting cells
by shading or font color" below.

6. If required, you can select additional columns by which to sort for 2: and 3:.

If, for example, you select a column containing family names for 1: and a column with first names for 2:, the
cell range will be sorted by the family name and then, in groups of identical family names, by the first name.

7. Make any further settings as required, see below.

As soon as you confirm with OK, the cell range will be sorted accordingly.

Options of the dialog box

The dialog box offers the following options:

§ Column and Order 

Here, select the desired Column(s) by which to sort. You can also specify the order for each column:
Ascending goes from A to Z, and Descending goes from Z to A for the cell values.

Note: If different shades or font colors have been applied to cells, they can also be sorted. See "Sorting cells
by shading or font color" below.

Up to 3 columns can be specified by default. You can even add additional columns if you need more than 3
sort criteria. Up to 64 columns are possible. Proceed as follows:



99Editing worksheets

Add a column: Click on the Plus icon to insert another column.

Append a column: Click on the Append button (below the list) to append a column at the bottom.

Remove a column: Click on the Minus icon to remove the respective column. (This only works if there
are more than 3 columns.)

§ Sort row by row or Sort column by column 

These options determine whether PlanMaker sorts by row or by column.

§ First row contains headings 

If the first row or column of the selected cell range contains a heading, you should enable this option.
PlanMaker then omits it from the sorting.

Example:

You have selected a list of addresses that you want to sort by row. The first row of your selection contains
headings such as "Name", "Street", "City", etc. The actual addresses are in the rows below. You should
enable this option so that this row is not sorted and remains the first row.

§ Case-sensitive 

If you enable this option, sorting distinguishes between uppercase and lowercase letters. For example, all
words that begin with a lowercase letter end up in front of the words that begin with a capital letter:

Disabled: Apples, bananas, Cherries. Enabled: bananas, Apples, Cherries.

§ Sort including borders/shading 

If this option is enabled, cells retain their assigned borders and shading when moved by the sorting
operation.

If disabled, the selected cell range keeps its original formatting as far as borders and shading are concerned.

§ Include hidden cells 

If the selected range contains cells that have been hidden (see Showing and hiding rows/columns), these are
usually not sorted. Enable this option if you want hidden cells to be included in the sort.

Sorting cells by shading or font color

Not only can you sort a cell range by cell values in ascending/descending order, but you can also sort a range by
cell colors (Shades) or text colors (Font colors), provided they have been applied to cells.

Note: The colors do not have their own defined order according to which they can be sorted automatically.
Thus, you can decide for yourself which of the available colored cells you would like to move up or down
within the cell range.

Proceed as follows:

1. Select the cell range and use the ribbon command Data | group Filter | Sort to open the dialog box as
described above.

2. For 1:, select the Column that you want to sort by color (for example, column A).
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3. Under Order to the right, you can select whether you want to reorder cells according to their cell color or
text color, and whether these cells should be sorted to the top or to the bottom.

4. Then click on the button with the black arrow (to the left of the plus and minus signs) and select the desired
color there. Cells of this color are sorted to the very top/to the very bottom.

Note: The button with the black arrow appears only if you have specified sorting by cell color/text color in
Order. In addition, there must actually be cells in the selected Column that have the relevant colors.

5. If you specify the same column again for Column 2, Column 3, etc. (for example, column A), you can
determine the next color to follow in that column. Make sure that the same sort criterion is set for Order.

Otherwise, you can also select other columns for Column 2, Column 3, etc., to which you want to apply
further sort criteria.

As soon as you confirm with OK, the cell range will be sorted accordingly.
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Filtering cells by their content
You can select a cell range and then "filter" the data in it using a filter condition. PlanMaker will hide all rows
that do not meet this condition.

To filter data, you can choose the ribbon tab Data | group Filter to access the following four commands:

§ The command AutoFilter  offers you different options for filtering rows: If you select a cell range and
then choose this command, an arrow will be displayed from now on above each column of this cell range. If
you click on one of these arrows, a menu will open with all the cell contents of this column – and various
conditions by which you can filter. 

§ The command Special filter  opens a dialog box in which you can formulate one or more filter
conditions. After clicking on OK, the filter is enabled: All rows in the selected range that do not meet the
filter condition are hidden. 

§ The command Show all  makes all hidden rows visible again, thus eliminating the effect of both the
AutoFilter and the Special filter.

§ You can use the command Reapply AutoFilter  to also update subsequently added values in the cell
range of an active AutoFilter (not possible for Special filter).

Tip: You will also find these commands on the ribbon tab Home | group Contents | Sort and filter.

For more information on AutoFilter and Special filter, see the following pages.

AutoFilter

Use the command AutoFilter to filter the rows of a cell range:

If you select a cell range and choose the command Data | group Sort and filter | AutoFilter, an arrow will be
displayed from now on above each column of this cell range. If you click on one of these arrows, a menu will
open with all the cell contents of this column – and various conditions by which you can filter.

Note 1: The AutoFilter can only be inserted once per worksheet; two separate filters cannot be set on one
worksheet. Otherwise, you cancel the previously applied filter by executing the AutoFilter command again.
If you have created Tables in worksheets, they have their own AutoFilters – even on the same worksheet.

Note 2: Newly added or updated values are not automatically sorted by the previously set filter conditions.
To integrate changed data into existing AutoFilters, use the command Reapply filter.

To apply the AutoFilter, proceed as follows:
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1. Select the desired cell range. Important: The first row of this range must contain headings for the data
below.

2. Choose the command Data | group Filter | AutoFilter .

The AutoFilter function is now enabled. You can tell by the fact that a downward arrow is displayed in the first
row of each column in the selected range.

Clicking on one of these arrows  will open a menu which includes a list of all cell contents that occur in the
corresponding column. By default, all values are selected in this list, thus there is no filtering.

To filter the data in the cell range, use this menu as follows:

§ Sort ascending : This option sorts the filter results of the applied AutoFilter range in ascending order. 

§ Sort descending : This option sorts the filter results of the applied AutoFilter range in descending order.

§ Sort by color:  : This option sorts the filter results of the applied AutoFilter range by cell color or text
color, if these were used in cells. In the submenu, select the cell color/text color of the cells to be sorted
upwards. The last selected color appears at the top. Clicking on More opens a dialog box with differentiated
settings for sorting. For more information, see Sorting cells.

§ Filter by color: This option lets you filter a cell range by visual criteria (cell color/text color), if applied to
cells.

§ More filters (contextual): Text filters, Number filters and Date filters open a submenu with additional
filters (see below).

§ (All): This menu entry is a useful placeholder: It allows you to add/remove all values the column contains
with just one click.

The check mark in front of the entry indicates that all cell contents are currently included in the filter.

If you now click on the entry (All), all cell contents will be immediately removed from the filter (and the
check mark will disappear).If you click on it again, all cell contents will be added to the filter again (and the
check mark will reappear).

If the filter does not contain the contents of all cells but contains those of at least one cell, a gray area will be
displayed instead of the check mark.

§ (Blank): If you have empty cell contents in your column, you can use this selection to show/hide all empty
rows.

§ List of cell contents: The most important part: All cell contents included in the column are listed here. By
clicking on a value, you can add it to the filter (a check mark will appear in front of it) or remove it again by
clicking on it again (the check mark will disappear).
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Note: For the last three aforementioned options (All), (Blank) and List of cell contents, please always note
the following: To confirm your selection, you have to press OK.

Example

If, for example, you want to filter a cell range in such a manner that only those rows that contain the name
"Smith" are shown in a column, proceed as follows:

Select the cell range (including the column headings) and choose the ribbon command Data | group Filter |
AutoFilter to enable the AutoFilter.

An arrow  now appears next to each column heading. Click on the arrow of the column heading "Name" to
open the AutoFilter menu for this column.

First, click on the entry (All) in this menu in order to remove the check mark. This deselects all cell contents
from the filter. Then, select the menu entry "Smith" and confirm with OK. You have now created a filter
condition "Name equals Smith" using the AutoFilter function. PlanMaker will hide all other rows that do not
match this condition.

The red color of the arrow indicates that an AutoFilter is applied.

Filter result after the name "Smith" has been selected in the AutoFilter list

If you would also like to see all Millers listed, simply select the menu entry "Miller". To remove the Millers
again, click on the entry "Miller" once more to deselect it. Press OK to confirm in each case.

If necessary, apply additional filter conditions in the other columns also (e.g., "Ms" for all female matches of a
given name) to narrow down the results even further.

As you can see, the values displayed in a column can be included or removed from the filter in any desired
combination.
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More filters: Text filters, Number filters, Date filters

Depending on the format category of the filtered columns, PlanMaker automatically sets additional filter
options for Text filter, Number filter or Date filter in the AutoFilter menu. The Text filter is offered for text-
only values and the Date filter for date-only values. If the formats are mixed, the Number filter is applied.

Use the offered filter in each case to obtain specialized filter conditions, for example:

Text filter

§ Equals... Show only rows with exact matches. 

§ Does not equal... Hide rows with exact matches.

§ Greater than... You will see the rows with the text values that are alphabetically after the filter value you
entered.

§ Greater than or equal to... See above, but including the entered value.

§ Less than... You will see the rows with the text values that are alphabetically before the filter value you
entered.

§ Less than or equal to... See above, but including the entered value.

§ Starts with... Show only rows with specific word beginnings.

§ Doesn't start with... Hide rows with specific word beginnings.

§ Ends with... Show only rows with specific word endings.

§ Doesn't end with... Hide rows with specific word endings.

§ Contains... Show only rows that contain specific strings as part of the text.

§ Doesn't contain... Hide rows that contain specific strings as part of the text.

Number filter

§ Greater than... This works like the operator > . You will see the rows with values that are greater than the
filter value entered.

§ Greater than or equal to... 
greater than or equal to the filter value entered.

§ Less than... This works like the operator < . You will see the rows with values that are less than the filter
value you entered.

§ Less than or equal to... 
equal to the filter value you entered.

§ Between... Here, define the range of numbers which contains the values of the rows that are to be displayed.

§ Not between... Here, define the range of numbers which contains the values of the rows that are to be
hidden.

§ Top 10... Show only those rows where, for example, one of the 10 highest (or 10 lowest) values is in this
column. You can customize this selection when the dialog box Top 10... has opened: In the left field, choose
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between Top or Bottom values. In the middle field, you have the option of setting the number of top/bottom
values. In the right field, you can choose between absolute values (Items) and relative values (Percent).

An example:

If you want to obtain 50% of the lowest values from 60 specified values, then set the following:

Left field: Lowest          Middle field: 50         Right field: Percent

§ Only empty: This option only displays rows where the value in this column is empty.

§ Non-empty: This option only displays rows where the value in this column is not empty.

§ Above average: This option only displays rows where the value is above the average of the values in this
column.

§ Below average: This option only displays rows where the value is below the average of the values in this
column.

Date filter

§ Equals... This displays only rows with exact date matches. 

§ Does not equal... This hides rows with exact date matches. 

§ Before... This displays only rows in which the date values are earlier than the entered date value.

§ Before or equal... See above, but including the entered value.

§ After... This displays only rows in which the date values are later than the entered date value.

§ After or equal... See above, but including the entered value.

§ Between... This displays rows where the date values are within a defined date range.

§ Not between... This hides rows where the date values are within a defined date range.

§ Day, Week, Month, Quarter, Year: Here, you can make further selections to quickly narrow down the
desired date ranges.

Note: If the AutoFilter has been applied to date values, you will notice in the arrow menu of the AutoFilter that the single days have
already been sorted there at year and month level. Click on the plus sign in front of a year/month level to expand the level and view
the single values grouped within it. If only single values are selected in a date level, a gray area is displayed in front of this date level
(month/year) instead of a check mark. It is only when all existing values of a date level are selected that a check mark appears in front
of this level. If no value of a date level is selected, you will see a white area in front of it. This allows you to always quickly see
whether all, none or single values of a date level have been selected.

There are also the following options for each of the offered filter methods Text filters, Number filters or Date
filters:

§ Custom filter: This opens a dialog box in which you can define individual filter conditions. 

§ Delete filter: This option is only available if criteria have been set via the Text filter, Number filter or Date
filter selection. Press Delete filter to remove only the criteria applied via these filters.

Showing all hidden rows again

If you want all rows that were hidden by AutoFilter to become visible again, choose the ribbon command Data |
group Filter | Show all.
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Reapplying AutoFilter

If values in the cell range set by AutoFilter have changed, you can use the ribbon command Data | group Filter
| Reapply AutoFilter to update the selection you have already defined.

For example, you have specified that all rows with the name "Smith" should not be displayed and further entries
with this name have been subsequently added. You can choose the command Reapply AutoFilter to filter out
such subsequently created entries again without having to redefine the conditions of the filter.

Of course, this function is particularly useful for dynamic formula values and dynamic date values.

Disabling the AutoFilter

To completely disable the AutoFilter function, choose the ribbon command Data | group Filter | AutoFilter
once again. The downward arrows displayed at the top of the cell range will disappear, and all cells will be
displayed again.

Special filter

In addition to the AutoFilter introduced in the previous section, there are further options for filtering the data
in a cell range in a much more complex manner based on one or more combinable conditions: with the ribbon
command Data | group Filter | Special filter.

Proceed as follows:

1. Select the desired cell range.

2. Choose the command Data | group Filter | Special filter .

3. In the following dialog box, define one or more filter conditions (see below).

4. Confirm with OK.

All rows that do not match the filter conditions will now be hidden.

Formulating filter conditions

To specify one or more filter conditions in the dialog box of the command Special filter, proceed as follows:
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In the 1st condition section, first select the column on the left to which a condition is to be applied. In the
middle, select the arithmetic operator. On the far right, enter the value against which you want to compare.

Some examples:

§ The condition "Column D equals Chicago" only shows entries where column D contains the text "Chicago". 

§ The condition "Column E greater than or equal to 100000" filters out all entries for which column E
contains a value less than 100000.

If one condition is not sufficient for formulating your filters, you have the option of linking up to three
conditions together by also filling in the sections 2nd condition and 3rd condition.

Using "wildcard characters": In conditions, the characters * and ? can be used as "wildcards" where * represents
any number of arbitrary characters, and ? represents a single arbitrary character. For example, "M*er" would
return "Mister", "Miller", "Mary's mother", etc., whereas "?ouse" would return "mouse", "house", "louse", etc.

Options of the dialog box

The dialog box for the special filter offers the following options:

§ Range contains headings 

If the first row and/or column of the selected cell range contains headings, enable this option. PlanMaker
will then ignore this row or column when filtering.
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§ Case-sensitive 

If this option is enabled, PlanMaker will distinguish between uppercase and lowercase letters in conditions.
For a condition such as "COLUMN A equals Smith", the condition will match only if the cell contains the
text "Smith". Rows with "SMITH" and "smith" will not be included in the filtering results.

§ Mode 

This determines whether rows or columns will be filtered.

If you select the option Filter row by row, PlanMaker will filter out all rows that do not match the filter
condition.

If, on the other hand, you select the option Filter column by column, PlanMaker will filter out all columns
that do not match the filter condition.

§ Results 

This determines whether the filter will be applied to the original data or a copy of it:

Filter at current position – Select this option and the original data will be filtered. Rows/columns that do
not satisfy the filter condition will be hidden at the exact point where you set the filter.

Copy to position – If you select this option instead, PlanMaker will create a copy of the original data at a
cell address that you specify. This copy contains only the filtered data, and the original data remains
unchanged in its place.

In the input field under this option, enter where the copy should be inserted. You can either specify a single
cell address (which will be the starting point of the output range) or the exact range of cells in which the
copy should be placed. Copying to other worksheets is also possible. Caution: If the copy does not fit into
this area, it will be truncated accordingly (exception: you specify a single cell address as the starting point).

Showing all hidden rows again

If you want all rows hidden by the filter to become visible again, choose the ribbon command Data | group
Filter | Show all.
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Analyzing sheets
PlanMaker provides several tools for analyzing cell contents and formulas in a worksheet. They can be very
useful for troubleshooting.

For this purpose, the following tools are available:

§ Showing formulas instead of results 

If you choose the ribbon command View | Show formulas, cells containing a calculation will display the
formula rather than the result.

§ Syntax highlighting 

If you choose the ribbon command View | Syntax highlighting, cells will be color-coded according to their
content. For example, cells containing an error are displayed in red; cells containing a formula are displayed
in green, etc.

§ Watch window for cell content 

FreeOffice: The command Show watch list is not included in SoftMaker FreeOffice.

If you choose the ribbon command Formula | Show watch list, you can display a watch window for cell
contents at any time. It allows you to observe the current values in the specified cells.

§ Formula auditing 

FreeOffice: Formula auditing is not included in SoftMaker FreeOffice.

The commands of the ribbon tab Formula | group Traces provide tools for graphically representing the
relationships between cells. If, for example, the current cell contains a formula that refers to other cells, you
can let PlanMaker display arrows pointing to these cells.

Furthermore, errors can be detected in the worksheet or invalid data can be marked with red circles.

For more information on these functions, see the following pages.

Showing formulas instead of results

If you enable Show formulas, cells containing a calculation will display the formula rather than the result. This
can be useful when analyzing the formulas in a worksheet and for troubleshooting.
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Enabling and disabling "Show formulas"

To enable the "Show formulas" tool, choose the ribbon command View | Show formulas  (in the group
View).

If you choose this command again, the "Show formulas" tool will be disabled.

Syntax highlighting

If Syntax highlighting is enabled, all cell contents will be color-coded according to their content. For example,
cells containing an error are displayed in red; cells containing a formula are displayed in green, etc.

This allows you to see at a glance where formulas are located and where fixed values are entered, where errors
occur, etc.

Enabling and disabling syntax highlighting

To enable syntax highlighting, choose the ribbon command View | Syntax highlighting  (in the group
View).

If you choose this command again, it will be disabled.

Meaning of foreground color

When syntax highlighting is enabled, cell contents are displayed in the following foreground colors:

Cell content Foreground color

Error value Red

Formula Green

Fixed positive number Navy

Fixed negative number Light blue

Fixed logical value Brown

Fixed text string Black

Meaning of background color

Cells that contain an error are thus displayed in a red foreground color. In the event of serious errors, the cell is
also given a colored background. The background color indicates the error type:

Background color Error type
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White The formula returns an error value. The calculation in this cell returns an error value because, for
example, it contains a division by zero.

Tip: If you click on the cell, an error message will be displayed in the status bar. For more
information, see Error values. Correct the formula accordingly. 

Cyan Syntax error in the formula. The formula in this cell is incorrectly formulated because, for
example, a closing parenthesis is missing or a function was not called with the correct arguments.

Tip: If you click on the cell, an error message will be displayed in the status bar. Correct the formula
accordingly. If you don't correct the formula, it will be replaced by the text string #NULL! when the
document is saved!

Light gray Non-exportable function. The formula in this cell uses an arithmetic function that cannot be saved
in the file format in which you saved the document.

Tip: Replace the function with another function that is compatible with the desired file format. For
more information, see the corresponding function description in this manual.

Magenta Function possibly imported incorrectly. The formula in this cell uses an older PlanMaker
arithmetic function whose syntax or function might be incompatible with recent versions of
PlanMaker. This error only occurs when importing PlanMaker documents with time functions.

Tip: See the corresponding function description in this manual.

Yellow Unknown function. The formula in this cell uses an arithmetic function unknown to PlanMaker.
This error might occur when importing documents created with other applications (e.g. Microsoft
Excel).

Tip: Replace the function with a corresponding PlanMaker function. For a list of all PlanMaker
functions, see Functions from A to Z.

Watch window for cell content

FreeOffice: The command Show watch list is not included in SoftMaker FreeOffice.

You can display a watch window for cells at any time. It allows you to observe the current values in the
specified cells.
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Enabling and disabling the watch window

To display the watch window, choose the command Show watch list  on the ribbon tab Formula | group
Watch.

If you choose this command again, the window will disappear.

Adding cells to the watch window

To keep track of the value in a cell, add it to the watch window as follows:

1. In the watch window, click on the Add cell button.

2. Enter the address of the desired cell and confirm with OK.

Tip: You can also enter an entire cell range here. If, for example, you enter A1:A3, the cells A1, A2 and A3 will be added.

The contents of the specified cells are now displayed in the watch window. Whenever the worksheet is
recalculated, the watch window will also be updated.

Removing cells from the watch window

To remove a cell from the watch window, select it in the watch window and click on the Remove cell button.

To remove all cells at once, use the Remove all button.

Formula auditing

FreeOffice: Formula auditing is not included in SoftMaker FreeOffice.

The command group Formula | Traces and the command group Review | Input validation provide tools for
graphically representing the relationships between cells.

If, for example, the current cell contains a formula that refers to other cells, you can let PlanMaker display
arrows pointing to these cells. Furthermore, errors can be detected in the worksheet or invalid data can be
displayed with red circles.

The command group Formula | Traces contains functions for the following topics:

§ Displaying the relationships between cells 

PlanMaker has commands that can be used to graphically represent the relationships between cells. For
example, PlanMaker can display arrows for all cells to which the formula in the current cell refers. Thus, if a
cell contains the formula =A1*A2, arrows to the cells A1 and A2 will appear.
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Furthermore, there are commands for selecting all cells to which the formula in the current cell refers, and
vice versa, i.e., for selecting all cells that refer to the current cell.

§ Detecting errors in calculations 

You can also jump to the previous or next cell that contains an error value and display arrows to the source
of the error.

You can choose the command group Review | Input validation to use the following functions:

§ Detecting invalid data in cells 

Here, you will find all cells whose content violates the input validation settings for the cell.

The following pages provide detailed information on these topics.

Displaying the relationships between cells

FreeOffice: Formula auditing is not included in SoftMaker FreeOffice.

The command group Formula | Traces provides commands with which the relationships between cells can be
graphically represented.

To do so, select the cell that you want to analyze, and then choose one of the following commands in the
command group Formula | Traces:

Note: The commands Trace to error, Previous error, Next error are described in the next section Detecting errors in calculations.
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§  Trace predecessors 

This command displays arrows for all cells to which the formula in the current cell refers.

Example: If the current cell contains the formula =A1*A2, this command will display arrows from cells A1
and A2 to the current cell (see figure above).

§  Trace predecessors  | Select predecessors 

This command selects all cells to which the formula in the current cell refers.

Example: If the current cell contains the formula =A1*A2, this command will select cells A1 and A2.

§  Remove all traces  | Remove traces to predecessors 

This hides all arrows that were added with the command Trace predecessors for the current cell.

§  Trace successors 

This displays an arrow to each cell that refers to the current cell.

Example: If a cell contains the formula =B5*2, this command will display an arrow pointing to this cell
when you choose the command in cell B5.

§  Trace successors  | Select successors 

This selects all cells that refer to the current cell.

Example: If any cell contains the formula =B5*2, this cell will be selected when you choose the command in
cell B5.

§  Remove all traces  | Remove traces to successors 

This hides all arrows that were added with the command Trace successors for the current cell.

§  Remove all traces 

This removes all arrows added with the commands Trace predecessors or Trace successors for the entire
workbook.

Click directly on the icon itself or use the icon's arrow and select Remove all traces in the dropdown menu.

Notes and tips

§ If desired, you can choose the commands Trace predecessors and Trace successors several times in
succession in a cell. Each call displays another level of relationships. 

§ The arrows that can be displayed with the above commands are clickable. If you click on such an arrow,
PlanMaker will jump to the cell at the other end of the arrow.

§ If the current cell refers to a cell that is in another worksheet, only a small arrow will be displayed in the top
left corner of the cell. You can also click on this arrow to quickly jump to the corresponding cell.

§ When you edit, delete or move the contents of a cell, all arrows to that cell are automatically removed.

§ All displayed arrows also appear in the printout.
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§ However, the arrows are not saved in the document. Thus, when you save a document and then reopen it, all
arrows are removed. 

Detecting errors in calculations

FreeOffice: Formula auditing is not included in SoftMaker FreeOffice.

The command group Formula | Traces provides commands for finding and analyzing cells that return an error
value.

Note: A cell returns an error value when an error occurs in the calculation it performs. If, for example, a cell
tries to perform a division by zero, the error value #DIV/0 will be displayed in the cell. For more information
on error values, see Error values.

To find and analyze such errors, choose the command group Formula | Traces, and then use one of the
following commands:

Note: The commands Trace predecessors, Trace successors and Remove all traces are described in the previous section Displaying the
relationships between cells.

§  Trace to error 

If the current cell contains an error value, this command will display arrows to the cells that cause the error
value (if applicable).

Example: If a cell returns a #DIV/0 error value and you choose this command in this cell, arrows will appear
on the cells that perform this division by zero.

§  Previous error 

This jumps to the previous cell that contains an error value.

§  Next error 

This jumps to the next cell that contains an error value.

Detecting invalid data in cells

FreeOffice: Formula auditing is not included in SoftMaker FreeOffice.
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The command group Review | Input validation provides commands that can be used to detect cells that
contain an invalid value.

Note: A cell contains an invalid value if the command Input validation  has been used to specify that the
cell can only contain certain values, and the current cell content does not match this check. For more
information, see Input validation.

To search for invalid data, choose the command group Review | Input validation and then use the following
commands:

§  Mark invalid data 

This command inserts a red circle around each cell (in the current worksheet) that contains an invalid value.

§  Remove (invalid data) marks 

This command removes all red circles (from the current worksheet) that were added with the above
command.

§  Previous invalid cell 

This command jumps to the previous cell that contains an invalid value.

§  Next invalid cell 

This command jumps to the next cell that contains an invalid value.

Notes

§ The marks for invalid data also appear in the printout. 

§ However, the marks are not saved in the document. Thus, when you save a document and then reopen it, all
marks are removed. 

Updating sheets
All calculations of all worksheets are automatically kept up to date. Whenever you change the content of a cell,
PlanMaker recalculates the entire workbook.

Thus, you usually don't have to concern yourself with this issue at all.
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Disabling automatic updating

If necessary, you can also disable the automatic updating of all worksheets. This can be useful if, for example,
you want to edit a complex workbook on a slow device.

For this purpose, change the setting of the Recalc automatically option for the document properties
accordingly.

1. Choose the ribbon tab Formula | group Update | Recalculate  and click on the arrow of the icon to open
its menu.

Alternatively: On the ribbon tab File | group File management | Recalculate or also in the Document properties, Calculate tab.

2. Remove the check mark in front of Recalc automatically to disable it.

From now on, the Recalc only before ... setting is enabled:

There will be an automatic recalculation of the worksheets only when saving or printing the document, or
when copying (or cutting) cells – depending on which option(s) you choose here. If all three options are
disabled, calculations will no longer be updated automatically.

Starting recalculation manually

Even if you have disabled the automatic recalculation, you can still update the worksheets manually at any time.
For this purpose, you can use the following keys or ribbon commands:

§ If you press the F9 key or choose the ribbon command Recalculate  | Recalculate workbook,
PlanMaker updates the calculations on all worksheets. 

Tip: This is also triggered if you simply click on the Recalculate icon directly.

§ On the other hand, if you press Shift+F9 or choose the ribbon command Recalculate  | Recalculate
sheet, PlanMaker only updates the calculations on the current worksheet.

Note: The latter can return outdated results if the current worksheet performs calculations with cells in
other worksheets.

Updating external cell references

Note that external cell references are not updated every time you recalculate the workbook.

(External cell references are cell references that refer to cells in another workbook – for example ='C:\My
Folder\[My Workbook.pmdx]Sheet1'!A1.)

Such cell references are automatically updated only when you open the document that contains the external
references. You can also manually update external references at any time.

For more information on working with external references, see External cell references.

Additional notes

For information on updating charts or pivot tables, please see the relevant sections Updating charts and
Updating pivot tables and changing data area.
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Using comments
If you choose the command group Comments on the ribbon tab Review, you can add a comment to the current
cell – for example: "The data from the previous year still has to be entered here!".

To work with comments, proceed as follows:

Adding comments to cells

1. Click on the desired cell to which you want to add a comment.

2. Then choose the ribbon command Review | group Comments | Add .

Alternatively: Insert | Comment, or even faster with the key combination Shift+F2.

Note: Comments appear with your name if you have specified it in the "Name" field for the User info
(see Settings, General tab). If nothing is entered here, PlanMaker will now prompt you once for the
current document.

Tip: You can edit the displayed name in the comment window just like any other content in this window.

3. The program will display a yellow box in which you can type the comment. When you have finished typing,
click outside the yellow box or press the Esc key.

Comments are saved in the document, thus they are available again when you reopen the document.

Viewing comments

Cells with an attached comment have a red triangle  in their top right corner. If you hover your mouse over
such a cell, the comment will be displayed. It will disappear if you move the mouse out of the cell.

Editing comments

To change a comment, select the cell that contains the comment.

Then choose the ribbon command Review | group Comments | Edit  and make the desired changes in the
yellow comment window.

Tip: Alternatively, double-click on the red triangle in the cell or press the key combination Shift+F2 to edit
a comment.

When you have finished making changes, click anywhere outside the comment or press the Esc key.



119Editing worksheets

Deleting comments

To remove comments from cells, select the relevant cells (you can also select several cells at the same time).

Then choose the ribbon command Review | group Comments | Delete . The comments will then be deleted.

Alternatively, you can also choose the command Home | group Contents | Delete  | Comments.

Finding comments

The command group Review | Comments contains two commands that you can use to jump back and forth
between all comments in the document:

§ Previous comment  jumps to the previous comment 

§ Next comment  jumps to the next comment

Visually customizing the comment window

§ Resize: Use the round "handles" on the frame of the comment window in order to resize it. When you drag
one of these handles with the mouse, the size of the object is changed accordingly. 

§ Change position: Move the comment window by clicking with the mouse on its frame and dragging it to the
desired position while holding down the mouse button.

Tip: The comment window can be customized like any other object with different colors, shades, etc. If you
click on the frame of the comment window, you can edit it similar to a text frame using the contextual ribbon
tab Object or the dialog box Object properties. For more information, see Text frames.

Comment visibility

You usually only see the comment window when you point to the relevant cell.

Thus, use the Comment visibility  button on the ribbon tab Review | group Comments if you want to
display comments permanently.

Note: Comment visibility also affects whether comments appear in the printout. Only the permanently
displayed comments are printed if the option "Print: Comments" is selected. This option can be found in the
dialog box of the command File | group Print | Page setup on the Options tab. For more information, see
Setting page format options.

The following commands are available in the dropdown menu of the Comment visibility button:

§ Show all comments 

If you have added comments to several cells, all comment windows will be displayed (including on other
worksheets in the document). If you click on the command again, they will be hidden again.

This option can also be found in the Document properties, Options tab as Always show comments.

§ Show this comment 

Only the comment of the selected cell will be shown or hidden.
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The Comment visibility button also has the following command:

§ Restore comment positions 

If the position of one or more comment windows has been moved (by moving them with the mouse or by
rearranging the cells), you can use this command to reset the comment windows to their original position. To
do so, select the cells whose comment windows you want to move back to their original position.

Goal seek

The ribbon command Data | group Analyze | Goal seek  can help you to determine what value a certain
component of a calculation must assume in order to obtain a predefined result from the calculation.

Note: This is done by mathematical approximation, and as with all approximation methods, the result does
not necessarily have to be exact.

Before you choose this command, navigate to the cell that contains the calculation.

Upon choosing the command, a dialog box appears. This is used as follows:

§ In Formula cell, enter the address of the cell that contains the formula. This is generally preset by
PlanMaker. 

§ In Target value, enter the desired result of the calculation.

§ In Variable cell, enter the cell address of the cell in which PlanMaker will test different values until the
formula cell returns the desired result.

§ In Accuracy, you can set the accuracy of the approximation. PlanMaker will attempt to approximate values
until the difference to the target value is less than the parameter Accuracy. 

If PlanMaker is unable to find a sufficiently close result after a few seconds, it will determine that the value
cannot be calculated through approximation and will abort the search.
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An example

In the worksheet shown below, the SUM function has been used in cell A5 to add the numbers 1, 2 and 3 in the
cells A2, A3 and A4. The result in cell A5 is 6. We now want to know to what value cell A3 must be changed
so that the result of the addition is 7.

For this purpose, move the cell frame to the cell with the calculation whose result is to be changed – in this
case, cell A5 with the SUM formula – and apply the goal seek.

The figure illustrates how to fill in the values in the dialog box. When you click on OK, PlanMaker starts the
approximation process and displays result 3 in a dialog box.

This means that the content of cell A3 must be changed from 2 to 3 so that the calculation has the result 7. If
you click on Use in the dialog box, the value found will be applied to cell A3.
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Scenarios

FreeOffice: The Scenarios feature is not included in SoftMaker FreeOffice.

The ribbon command Data | group Analyze | Scenario manager allows you to create and display "scenarios".

Scenarios can be used to observe how changing the values in specific cells affects the calculations in a
worksheet. This enables you to perform all kinds of "what-if" analyses.

Example: How does the total cost of a loan change if the term is 24, 36 or 96 months?

In this section, you will learn everything you need to know about scenarios. The following topics are covered:

§ Creating scenarios 

§ Showing scenarios

§ Managing scenarios

§ Merging scenarios

§ Creating a scenario summary

For more information, see the following pages.

Creating scenarios

To create scenarios, first complete a worksheet with the desired values and calculations.

Then proceed as follows:

1. Choose the ribbon command Data | group Analyze | Scenario manager .

2. Click on Add in the dialog box that opens.

3. Under Scenario name, enter a name that describes the purpose of the scenario.

4. Under Changing cells, enter the address of the cell whose content is to be changed in the scenario.

You can also specify multiple cells. Separate the cell addresses with a comma – for example: A2,A4,A10.
Cell ranges (like B5:B10) are also allowed.

5. Click on the Next button to continue.

6. Another dialog box appears. There, enter the value that is to be inserted into the "changing cell" in this
scenario.

If you have defined multiple changing cells in the scenario, this dialog box displays a list of all these cells.
Click on each list entry and enter the desired value next to it.

7. Click on Finish to complete the creation of this scenario.
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8. Repeat steps 2. to 7. for all other scenarios that you want to create.

9. When you have finished, exit the dialog box with the Close button.

The desired scenarios have now been created. For information on how to display them, see the next section.

Options of the dialog box

The dialog box for adding scenarios offers the following additional options:

§ Comment 

Here, you can enter a descriptive comment for the scenario.

§ Prevent changes 

If this option is enabled, the scenario cannot be edited or deleted if you enable sheet protection.

§ Hide 

If this option is enabled, the scenario is no longer displayed in the list of scenarios when you enable sheet
protection.

For more information on using sheet protection, see Sheet protection.

Showing scenarios

If you have created scenarios as described in the previous section, you can display them at any time:

Proceed as follows:

1. Choose the ribbon command Data | group Analyze | Scenario manager .

2. In the dialog box, select the scenario to be displayed from the Scenarios list.

3. Click on the Show button.

Tip: You can do so even quicker if you simply double-click on the scenario in the list.

The selected scenario will then be displayed.

By switching between different scenarios, you can now compare how changing the cells specified in the
scenario affects the calculations that refer to those cells.

Note: When you display a scenario, the values in the specified "changing cells" are physically replaced by the
values set in the scenario. The old cell contents will thus be lost.
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Managing scenarios

The command Data | group Analyze | Scenario manager  can also be used to manage the scenarios defined
in the current worksheet.

To do so, use the following buttons in the dialog box for this command:

§ Add 

This adds a new scenario.

For more information, see Creating scenarios.

§ Delete 

This deletes the scenario currently selected in the list.

§ Edit 

This opens a dialog box in which you can edit the selected scenario. If you click on Next, the program will
display another dialog box in which you can change the values for the changeable cells.

§ Merge 

This merges scenarios that have been defined in other worksheets (or workbooks) into the current
worksheet.

For more information, see Merging scenarios.

§ Summary 

This creates a scenario summary that directly compares the values in the changeable cells and the values in
any "result cells" for all scenarios.

For more information, see Creating a scenario summary.

Merging scenarios

The command Data | group Analyze | Scenario manager can also be used to merge scenarios that have been
defined in other worksheets (or even other workbooks) into the current worksheet.

Note: When using this function, ensure that all workbooks whose scenarios are to be merged have exactly
the same structure and use the same changing cells in their scenarios.

To merge scenarios, proceed as follows:

1. Open the workbooks that contain the scenarios to be merged.

2. Switch to the workbook and worksheet into which you want to merge the scenarios.
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3. Choose the ribbon command Data | group Analyze | Scenario manager .

4. Click on Merge in the dialog box.

5. Select the workbook and worksheet that contain the scenario(s) to be merged.

6. Confirm with OK.

7. Repeat steps 4. to 6. for all other scenarios that you want to merge.

The selected scenarios are now available in the current worksheet.

Creating a scenario summary

The command Data | group Analyze | Scenario manager can also be used to create a scenario summary for all
scenarios defined in the current worksheet.

A scenario summary lists all scenarios clearly next to each other. For each scenario, both the changing cells and
any "result cells" (containing the calculations to be observed) are displayed.

Scenario summaries are useful for comparing the changing values and the results of scenarios at a glance.

To create a scenario summary, proceed as follows:

1. Create the desired scenarios (as described in Creating scenarios).

2. Choose the ribbon command Data | group Analyze | Scenario manager .

3. Click on Summary.

4. Enter the address of the desired result cell. This is the cell which contains the calculation that you want to
observe in your scenarios.

You can also specify multiple cells. Separate the cell addresses with a comma – for example: A2,A4,A10.
Cell ranges (like B5:B10) are also allowed.

5. Confirm with OK.

PlanMaker will now create a new worksheet and generate the scenario summary in it.

Note: Scenario summaries are not automatically updated when you change cell contents or scenario settings.
To manually update a scenario summary, delete the worksheet containing the summary and then generate the
summary again.
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Consolidating data

FreeOffice: The Data consolidation feature is not included in SoftMaker FreeOffice.

You can use the ribbon command Data | group Analyze | Data consolidation  to evaluate data from one or
more cell ranges, for example, in order to calculate their total sums.

To do so, you first define the "source ranges" for consolidation. They can be any cell ranges with the data to be
evaluated. They can all be in the current worksheet or spread across multiple worksheets or even multiple files.
For the evaluation, you can choose from among several statistical functions, such as sum, minimum, average,
etc.

The result of the evaluation is inserted – as fixed values – into the specified "target range". Note: The results
will not be updated if you change the values in any of the source ranges. This command is thus primarily useful
if you want to evaluate the current state of data and no longer want to take changes into account (useful, for
example, for monthly reports).

In this section, you will learn everything you need to know about working with consolidations. The following
topics are covered:

§ Consolidating data by position 

In the simplest case, data is consolidated by its position. This works as follows:

You have entered the data into, for example, three source ranges which should be identical in size and
structure. In each of the ranges, the individual data is thus in the same (relative) position.
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When consolidating, the first cell (top left) in the first range is then added to the first cell in the second and
third ranges. The result appears as the first cell in the target range. The same is then done with all other cells
in the source ranges.

§ Consolidating data by labels 

Furthermore, this function can also consolidate by labels. This works as follows:

There may be one or more source ranges that have one thing in common: Each individual value has a label –
for example, in the cell to the left of it.

When you start a consolidation with such source ranges and enable the option Labels in left column,
PlanMaker calculates the sum of all values that have the same label on their left.

The same label may occur as often as desired. The size of the source ranges and the order of data are also
irrelevant. PlanMaker only uses the labels to determine which values are to be added.

§ Editing and updating consolidations 

Whenever you perform a consolidation using the ribbon command Data | group Analyze | Data
consolidation, PlanMaker remembers each setting that you made in the dialog box
"Consolidate" (separately for each worksheet).

This enables you to choose this command again at any time, change some settings if required, and then
perform the consolidation again.

For more information on these topics in the above order, see the following pages.

Consolidating data by position

FreeOffice: The Data consolidation feature is not included in SoftMaker FreeOffice.

As mentioned in the introduction of the section Consolidating data, the command Data consolidation allows
you to consolidate data from one or more cell ranges, for example, in order to calculate their total sums.

In the simplest case, data is consolidated by its position. This works as follows:

You have entered the data into, for example, three "source ranges" which should be identical in size and
structure. In each of the ranges, the individual data is thus in the same (relative) position.

When consolidating, the first cell (top left) in the first range is then added to the first cell in the second and
third ranges. The result appears as the first cell in the "target range". The same is then done with all other cells
in the source ranges.

Example

The daily revenues of two fruit shops are to be consolidated by means of a sum function, divided according to
fruit varieties.
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For this purpose, the revenues of the two shops were entered into a worksheet. In the figure, this data is shown
in the cell ranges C3:C5 and C8:C10.

The command Data consolidation was then chosen and these two ranges were added as source ranges. The
target range was set to C13:C15 (selected in the figure) and consolidation was started.

Result: In the target range, the sums of the daily revenues appear (again per fruit variety, just as in the source
ranges).

Performing a consolidation by position

To consolidate data by position, proceed as follows:

1. Enter the data to be consolidated into individual cell ranges of exactly the same size and structure. The order
of the individual pieces of data must be identical in each range.

The individual cell ranges can all be in the same worksheet, in multiple worksheets or even in several
different documents.

2. Choose the ribbon command Data | group Analyze | Data consolidation .

3. Click into the Source ranges input field. There, enter the address of the first cell range with the data to be
consolidated. (See also notes below.)

Tip: Alternatively, you can also click directly into the worksheet while the dialog box is open and simply
select the cell range in the worksheet with the mouse to transfer it to the dialog box.

4. Click on the Add button.

5. To add additional source ranges, repeat steps 3. and 4.
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6. For Target range, enter the address of the cell range in which you want the result of the consolidation to be
inserted.

Tip: It is sufficient to specify the address of the cell in the top left corner of the target range. PlanMaker will
then determine its size automatically.

Tip: You can also simply click on the desired cell directly in the worksheet to transfer its address to the
dialog box.

7. For Function, select the arithmetic function to be used for the consolidation.

8. The options Labels in ... must be disabled for this type of consolidation. For more information, see
Consolidating data by labels.

9. Click on Apply to start the consolidation.

The data from the source ranges is now consolidated using the selected arithmetic function, and the result is
inserted in the target range.

Note: The result of a consolidation is inserted into the worksheet as fixed numbers. These numbers will not
be updated if you change the values in any of the source ranges.

This command is thus primarily useful if you want to evaluate the current state of data and no longer want to
take changes into account (useful, for example, for monthly reports). For more information, see also Editing
and updating consolidations.

Notes on specifying the source ranges

If you click in the Source ranges input field in the dialog box described above, a source range can be added
using the following options:

§ Source range from the current worksheet 

To add a cell range that is located in the current worksheet to the source ranges, simply enter its address or
name.

Example: D2:G5

Tip: Alternatively, you can also click directly into the worksheet while the dialog box is open and simply
select the cell range in the worksheet with the mouse.

§ Source range from a different worksheet 

To add a cell range that is located in a different worksheet, enter its address preceded as usual by the other
worksheet's name and an exclamation mark.

Example: Sheet3!D2:G5

Tip: You can also simply select the cell range with your mouse. First, click on the desired worksheet in the
worksheet register.

§ Source range from a different document 

To add a cell range that is located in a different document, enter its address as described in External cell
references).

Example: 'C:\My Folder\[My Workbook.pmdx]Sheet3'!D2:G5
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Tip: You don't have to manually enter the first part of the address (folder and file name). Simply click on the
Browse button in the dialog box, and the program will then display a file dialog box in which you can select
the desired file.

Don't forget to click on the Add button after entering the address for each source range.

Consolidating data by labels

FreeOffice: The Data consolidation feature is not included in SoftMaker FreeOffice.

As mentioned in the introduction of the section Consolidating data, the command Data consolidation allows
you to consolidate data from one or more cell ranges, for example, in order to calculate their total sums.

In addition to consolidating data by its position (see previous section), data can also be consolidated by its
labels. This works as follows:

The data to be evaluated can be stored in any number of "source ranges" – all of which should have one thing in
common: a label has been added to each value (for example, in the cell to the left of the value).

When you start a consolidation with such source ranges and enable the option Labels in left column,
PlanMaker calculates the sum of all values that have the same label on their left.

The same label may occur as often as desired. The size of the individual source ranges and the order of the data
within them are irrelevant. PlanMaker only uses the labels to determine which data is to be consolidated.

Example

A fruit shop offers different types of fruit. Each individual sale during the course of a day is recorded in a
worksheet. You now want to calculate how much of each type of fruit was sold in total.
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Of course, the individual types of fruit occur in a completely random order, but this is irrelevant to the
consolidate command:

Simply choose the command Data consolidation. Add the cell range with the individual sales as the source
range (B3:C11 in this case). Note: This must contain the numbers and their labels! Then select any target range
for the result (B14:C16 in the figure) and confirm.

Result: The totals of the sales of the individual types of fruit appear in the target range.

Performing a consolidation by labels

To consolidate data by its labels, proceed as follows:

1. Enter the data to be consolidated into one or more cell ranges. The size and structure of these cell ranges
don't matter. However, the values to be consolidated should all have a label – either in the column to the left
of them and/or in the row above them.

The individual cell ranges can all be in the same worksheet, in multiple worksheets or even in several
different documents.

2. Choose the ribbon command Data | group Analyze | Data consolidation .

3. Click into the Source ranges input field. There, enter the address of the cell range with the data to be
consolidated. See also notes at the end of the previous section.

Tip: Alternatively, you can also click directly into the worksheet while the dialog box is open and simply
select the cell range in the worksheet with the mouse to transfer it to the dialog box.

Important: Each source range must contain both the values themselves and their labels. The labels must
be in the far left column or in the top row of the range.
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4. Click on the Add button.

5. To add additional source ranges, repeat steps 3. and 4.

6. For Target range, enter the address of the cell range in which you want the result of the consolidation to be
inserted.

Tip: It is sufficient to specify the address of the cell in the top left corner of the target range. PlanMaker will
then determine its size automatically.

Tip: You can also simply click on the desired cell directly in the worksheet to transfer its address to the
dialog box.

7. For Function, select the arithmetic function to be used for the consolidation.

8. For Options, specify the position of the labels in the source ranges:

Labels in left column: The labels are stored in the far left column of each source range. (The associated
data must then be entered directly to the right of it.)

Labels in top row: The labels are stored in the top row of each source range. (The associated data must then
be entered directly below.)

You can also enable both options if you want to evaluate source ranges where labels are in their far left
column and in their top row.

If you enable the option Sort labels, the results of the consolidation in the target range will be sorted
according to the labels.

9. Click on Apply to start the consolidation.

The data from the source ranges is now consolidated using the selected arithmetic function, and the result is
inserted in the target range.

Note: The result of a consolidation is inserted into the worksheet as fixed numbers. These numbers will not
be updated if you change the values in any of the source ranges.

This command is thus primarily useful if you want to evaluate the current state of data and no longer want to
take changes into account (useful, for example, for monthly reports). For more information, see also Editing
and updating consolidations.

Editing and updating consolidations

FreeOffice: The Data consolidation feature is not included in SoftMaker FreeOffice.

Whenever you perform a consolidation using the command Data consolidation, PlanMaker remembers each
setting that you made in the dialog box "Consolidate" (separately for each worksheet).

This enables you to choose this command again at any time, change some settings if required, and then perform
the consolidation again.
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Tip: The settings are even saved in the document, so PlanMaker will remember them the next time you open
the document. (Small restriction: The Target range is not saved in xls files because this file format does not
support it. However, it works for xlsx files, pmd files and pmdx files.)

Changing settings and performing the consolidation again

To change the settings of a consolidation and then reinsert its updated result, proceed as follows:

1. Choose the ribbon command Data | group Analyze | Data consolidation .

2. Make the desired changes to the consolidation settings. You can even add new source ranges or remove
existing ones.

3. Click on Apply to apply the changes.

The consolidation in the current worksheet will then be performed again, and its updated result will be inserted
into the target range. Existing data will be overwritten.

Updating the results of a consolidation

If you just want to update the result of a consolidation (without changing any settings), proceed as follows:

1. Choose the ribbon command Data | group Analyze | Data consolidation .

2. Click on Apply.

The consolidation in the current worksheet will then be performed again with exactly the same settings as the
last time.
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Tables in worksheets

FreeOffice: Creating tables in worksheets is not included in SoftMaker FreeOffice.

The ribbon command Insert | Table  allows you to create "tables" in a worksheet.

Note: The fact that this feature is named "table" may be a bit confusing, since the term "table" is often used
to represent the content of a worksheet in general. However, since Microsoft has called this feature a "table"
in Excel, we decided to keep this term in PlanMaker for compatibility reasons.

How exactly does this feature work?

When you select a cell range and choose the ribbon command Insert | Table, PlanMaker will create a "table"
from it.

This has the following effects on the cell range:

§ Automatic formatting with a "table style" 

The selected cell range is formatted automatically with a table style. The default table style alternately
applies blue and white shading to the cells. However, you can also use a different style or subsequently
change the style and thus change the formatting of the entire "table" at the touch of a button.

§ AutoFilter applied automatically 

In addition, an AutoFilter is applied to the cell range that was used to create the "table". The AutoFilter adds
little arrows to the right of each of the column headings in the table. If you click on one of these arrows, the
program will open a menu in which you can set a filter on the cell contents of the corresponding column.

§ Total row 

In "tables", you can easily activate a total row that is displayed below the table. The total row can display
calculations that sum up the values contained in the table (for example, the sum of each column).

§ Special cell references 

When you have created a "table" in a worksheet, you can also use special cell references. For example, the
cell contents in a column of a table can be addressed via its column heading – as in:
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=SUM(Table3[Spring])

The following pages contain everything you need to know about the "table" feature. The following topics are
covered:

§ Creating tables in worksheets 

§ Ribbon tab "Table" 

§ Removing tables from worksheets

§ Editing tables in worksheets

§ Formatting tables in worksheets

§ Using the total row of tables in worksheets

§ Tables in worksheets and cell references

Creating tables in worksheets

FreeOffice: Creating tables in worksheets is not included in SoftMaker FreeOffice.

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to have "tables in worksheets". Here, you will learn how to create such a table:

To create a "table in a worksheet", proceed as follows:

1. Optional: In a range of adjacent cells, enter the data from which you want to create a table.

Tip: It is useful if you have provided this cell range with a column heading in the first row of each
column. (If there are no column headings, PlanMaker will generate automatic headings named Column1,
Column2, etc.)

2. Select the cell range (including the column headings).

3. Choose the ribbon command Insert | Table  by clicking directly on the icon itself.

Tip: If you click on the icon's arrow rather than directly on the icon itself, PlanMaker will open a list of
predefined styles which can be applied directly.

4. The program displays a dialog box with the following options:

Source range: This is the cell range from which the table is to be created. The currently selected range is
suggested by default. As a rule, you only have to confirm this default range.

Source range contains titles: Here, you can specify whether the first row of the source range consists of
column headings, as recommended above. When you disable this option, PlanMaker will generate automatic
column headings named Column1, Column2, etc., and indents these headings with an additional row above
the source range.

As soon as you confirm your selection in the dialog box, a "table" is created for the source range. More
specifically, the following happens:
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§ No changes are made to the table cells and their contents 

The cells in the source range remain normal table cells even after a table has been created. Thus, you can
still edit them, format them, etc.

§ Automatic formatting with a "table style" 

However, it is immediately noticeable that the cells in the source range have been automatically reformatted:
By default, the first row (containing the column headings) is shaded in a medium blue, the rows below are
shaded alternately in light blue and white (unless you have selected a different style). For more information,
see tip from step 3.

This automatic formatting is performed via a table style. Whenever you create a table, it is automatically
reformatted with the default table style. Alternatively, numerous other table styles with different colors and
styles are available. On the contextual ribbon tab Table, you can switch to another style at any time using
the commands Table styles or Properties.

§ AutoFilter applied automatically 

There is a small arrow  to the right of each column heading in the first table row. These arrows indicate
the presence of an AutoFilter that has been automatically applied to the source range of your table.

By default, the filter is disabled and all data in the table is displayed. If you click on one of the arrows, the
menu of the AutoFilter opens for the corresponding column. In this menu, you can apply different types of
filters or even sort the table data.

For more information on AutoFilters, see AutoFilter.

Ribbon tab "Table"

As soon as you have created a "table in worksheets" using the ribbon command Insert | Table, you can switch
to the contextual ribbon tab Table for editing.

This ribbon tab always appears automatically when you place the cursor in the created table.

The contextual ribbon tab "Table"

The ribbon tab has the following buttons, from left to right:

§ Range: Here, you can change the cell range that the table contains. For more information, see Editing tables
in worksheets. 

§ Properties: This command opens a dialog box in which you can format inserted tables and change other
properties of the table. For more information, see Formatting tables in worksheets.

§ Summarize as a pivot table: Use this command to create a pivot table directly from your table data. For more
information, see Pivot tables.
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§ Convert to range: This converts the table back to a "normal" cell range. For more information, see Removing
tables from worksheets.

§ Delete table: This completely deletes the table and all its contents. For more information, see Removing
tables from worksheets.

§ Select rows, columns, table: These commands can be used to select complete rows, columns or all cells of an
inserted table. For more information, see Editing tables in worksheets.

§ Insert above, below, left, right These commands can be used to insert a new row or column into a table (and
only into this table). For more information, see Editing tables in worksheets.

§ Delete rows, columns: These commands can be used to delete rows or columns within a table (and only within
this table). For more information, see Editing tables in worksheets.

§ Table styles (and all other commands in the "Style" group): This command can be used to apply formatting
options to inserted tables. For more information, see Formatting tables in worksheets.

On the following pages, you will find detailed descriptions of the commands of the ribbon tab Table.

Removing tables from worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to create "tables in worksheets". Here, you will learn how to remove such tables:

In this case, you have the following options:

A) Converting a table back to a normal cell range

To convert a table back to an "ordinary" cell range, move the cell frame to any cell within the table.

Then choose the command Convert to range  on the contextual ribbon tab Table | group Table.
(Alternatively, use the context menu by right-clicking in the table.)

In the following dialog box, select the checkbox Remove all formatting from the cells.

This will remove the "magic" of the table feature from all cells that were part of the table – including the
automatic formatting and the AutoFilter.

B) Deleting a table and its entire content

To completely delete a table and all its contents, move the cell frame to any cell within the table.

Then choose the command Delete table  on the contextual ribbon tab Table | group Table. (Alternatively,
use the context menu by right-clicking in the table.)

This will delete the entire table – including all cell contents.
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Editing tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to create "tables in worksheets". Here, you will learn how to edit such tables:

In this case, you have the following options:

Adding another row or column

An additional row or column can be easily added to "tables in worksheets" as follows:

§ If you enter a value in a cell that is immediately to the right of the table, the table automatically expands to
include the column with this value. 

§ When you enter a value in a cell that is just below the table, the table automatically expands to include the
row with this value.

(Note: This only works if the Total row for the table is disabled.)

Tip: The above two methods for expanding tables can be disabled if you do not want them. To do so,

open the dialog box of the ribbon command File | Options , choose the Edit tab and disable the option
Expand tables automatically.

§ When you press the Tab key in the last cell of a table (the bottom right cell), another row is added to the
table automatically. This works here even if the "Total row" is enabled, as it is then automatically moved by
one row. 

Changing the size of a table

You can also change the size of a table at any time as follows:

§ A little arrow is displayed in the bottom right corner of a table. When you drag this arrow around with your
mouse, the table is resized accordingly. 

§ If you choose the command Range  on the contextual ribbon tab Table, PlanMaker opens a dialog box in
which you can edit the cell range covered by the table.

§ You can also use the context menu by right-clicking in the table and selecting the entry Modify table range
to edit the cell range.

Inserting rows or columns

To insert a new row in a table (and only in this table), proceed as follows:

1. Move the cell frame to the desired row in the table.

2. Then choose Insert above  or Insert below  on the contextual ribbon tab Table | group Edit.

Alternatively: Right-click in the table to open the context menu and choose the command via Insert here.
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This will add a new row above or below the current row in the table.

Note: These two commands will insert the new row only into the table itself and not into the cells that
surround this table.

Inserting new columns works accordingly with the commands Insert left  or Insert right .

Deleting rows or columns

To delete a row from a table (and only this table), proceed as follows:

1. Move the cell frame to the row in the table that you want to delete.

2. On the contextual ribbon tab Table, choose the command Delete rows .

Alternatively: Right-click in the table to open the context menu and choose the command via Delete here.

This will delete the row (including its content) from the table.

Note: This command removes the row only from the table itself and not from the cells that surround this
table.

Deleting columns works accordingly with the command Delete columns .

Selecting cells in a table

Cells in a table can be selected as usual with a mouse or keyboard, of course.

The commands on the contextual ribbon Table | group Selection are available as additional options for
selecting within tables. Here, you can choose from the following commands:

§  Select rows: This selects the current table row. 

§  Select columns: This selects the current table column.

§  Select table: This selects the entire table.

There is another command which is not available on the ribbon by default, but you can easily access it by right-
clicking on the table via the context menu:

§ Select  Select column data: This selects only those cells in the current column that contain data. Column
headings or cells in the total row will not be included in the selection. 

Alternatively, you will also find the command by default in the classic menu interface at:
Worksheet > Table > Select > Select column data

Tip: If necessary, you can add this command as a separate button to a ribbon tab (ideally to the ribbon tab "Table"). To do so, choose
the ribbon command File | Customize | Customize ribbon to open the dialog box for customizing the user interface, and search there
for the command "Select data". Then proceed as described in Customizing icons and groups in the ribbon.
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Formatting tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to create "tables in worksheets". Here, you will learn how to format such tables and change other
properties of the table:

First of all, the cells in a table can be formatted just like any other cell, using the entire palette of commands
and options that PlanMaker provides for this purpose.

There is also the ribbon command Table | Properties especially for tables. This provides formatting options
that are only applicable to tables.

You can use this command as follows:

1. Move the cell frame to any cell within the table that you want to format.

2. Choose the command Properties  on the contextual ribbon tab Table.

Alternatively, right-click on the table to open the context menu and select the entry Table properties.

3. A dialog box appears with the options described below. Make the desired changes and then confirm with
OK.

In this dialog box, you can make the following settings:

Applying a different table style

Tip: You can also apply this option directly via the Table styles  icon on the ribbon tab Table | group
Style.

The first tab of the dialog box contains the Style list. Here, you can apply a different table style to the table.

Applying a different table style changes the entire appearance of a table. First and foremost, this concerns the
coloring of the table (via shades). The small thumbnails in the list show which colors are included in each style.

Showing/hiding header row and total row

Tip: You can also apply these options directly using the commands on the ribbon tab Table | group Style.

Below the Style list, there are more options for customizing the appearance of a table. The first two options
have the following function:

§ Header row 

This option enables/disables the header row (displayed above the table). The header row displays a column
title for each of the columns.

In the header row, you can also see a small arrow displayed to the right of each of the column titles. These
arrows indicate the AutoFilter that is applied automatically to each table. To filter data, click on one of
these little arrows. The program opens a menu in which you can set different types of filters for the values in
the corresponding column.
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For more information on using AutoFilters, see AutoFilter.

§ Total row 

This option enables/disables the total row (displayed below the table). The total row displays calculations
that sum up the values contained in the table columns.

By default, only the sum of the values in the last column is displayed. If, however, you click on one of the
cells in the total row, a small arrow will appear to the right of it. Clicking on this arrow opens a menu in
which you can choose what kind of calculation the cell should perform. For example, you can display the
sum, average, or other calculations for any columns in the table.

For more information, see Using the total row of tables in worksheets.

Additional formatting options for table styles

Tip: You can also apply these options directly using the commands on the ribbon tab Table | group Style.

The other options on the Style tab have the following purpose:

§ Banded rows and Banded columns 

This option enables/disables alternating colored shading for the rows or columns of the table. Their color is
defined in the table style, which you can also set in this dialog box (as described above).

§ First column and Last column 

If you enable this option, the first and/or the last column in the table will be highlighted.

For most table styles, this is done by using boldface for the text in the respective column. However, some
table styles also change the background color – this depends on the respective table style.

Extended properties on the "Properties" tab

On the Properties tab of the same dialog box, you will find the following advanced properties for the table:

§ Name 

Here, you can change the name of the table, which was automatically generated when the table was created
and also included in the list of named ranges at the same time. The name can also be changed there. For
more information, see Naming cell ranges.

The name of a table can be used in cell references (see Tables in worksheets and cell references).

Please note that the following rules apply to table names:

1. Table names must be unique.

2. Table names must always begin with a letter or an underscore.

3. Table names must not contain blank spaces or other invalid characters. (For maximum compatibility with
other programs, only use letters, numbers, and underscores.)

4. Table names must not be structured like cell references (for example, A1).

§ Title and Description 

Here, you can enter a title for the table and a short description for its contents.
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This is useful for people who, due to impaired vision, use special tools such as a screen reader to have the
individual components of the worksheet read to them.

Using the total row of tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to create "tables in worksheets". Here, you will learn about the "total row" of such tables and how
you can adjust it:

Another advantage of "tables in worksheets" is the possibility of displaying a total row with summary
calculations if desired. You can enable or disable the total row at any time. When it is enabled, it appears in the
form of an additional row below the table.

By default, the total row displays only the "Total" text on the left and the sum of the values of the column on
the far right of the table. However, you can also perform other calculations in it by editing the total row (see
below).

Enabling/disabling the total row

Tip: The total row can also be enabled directly on the ribbon tab Table | group Style.

To enable the total row for a table via the dialog box, proceed as follows:

1. Move the cell frame to any cell within the table.

2. Choose the command Properties  on the contextual ribbon tab Table.

Alternatively, right-click on the table to open the context menu and select the entry Table properties.

3. Enable the option Total row on the Style tab and confirm with OK.

The total row will now be displayed below the table.

If you do not want the total row to be displayed, disable this option again.

Editing total rows

By default, the total row displays only the "Total" text and the sum of the values of the column on the far right
of the table.

However, you can adjust this as desired. The cells in the total row can be edited – just like any other cell – so
you can enter your own formulas or text here at any time.
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A little tool is available for adding calculations that total the values in a column: When you move the cell frame

to any cell in the total row, a little arrow  appears to its right. If you click on this arrow, PlanMaker opens a
menu offering different types of statistical functions (sum, average, etc.). If, for example, you select the "Sum"
function here, PlanMaker inserts a formula into the cell that calculates the sum of the corresponding column.
For information on the formula used, see SUBTOTAL.

Tables in worksheets and cell references

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table
enables you to create "tables in worksheets". Here, you will learn more about the specifics of using cell
references to the cells in such a table.

Apart from the usual cell references, tables and their contents can also be addressed using names and special
identifiers:

Using names

Names in cell references to table contents can be used as follows:

§ Addressing tables by their name 

When you use the name of a table in a cell reference, it represents the entire table (with all of its cells,
except the column headings and the total row).

Example:

=SUM(Table3) returns the sum of all cells in the table named "Table3".

Tip: The name of a table can be changed via the dialog box of the command Properties  on the
contextual ribbon tab Table.

§ Addressing table columns by their column heading 

To address a single column of a table in a cell reference, enter the name of the table, followed by the column
heading of the desired column enclosed in square brackets.

Example:

=SUM(Table3[Spring]) returns the sum of all cells in the column with the column heading "Spring" in the
table named "Table3".

§ Addressing multiple adjacent table columns 

You can also address multiple adjacent table columns. To do so, use the notation [[FirstColumn]:
[LastColumn]].

Example:

=SUM(Table3[[Spring]:[Autumn]]) returns the sum of all cells in the columns "Spring" to "Autumn" in
the table.
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§ Addressing multiple non-adjacent table columns 

To address multiple non-adjacent table columns, separate them with a comma instead of a colon.

Example:

=SUM(Table3[Summer],Table3[Winter]) returns the sum of the columns "Summer" and "Winter".

Note that the name of the table must be specified before each column.

Using special identifiers

In addition to names, cell references to table contents can also use special identifiers that represent a certain
component of this table.

The identifier must be enclosed within square brackets when entered after the table name:

For example, Table3[#Totals] is a cell reference to all cells in the total row of the table named "Table3".

The following identifiers are available:

§ #All: 

This represents the entire table including column headings and total row, for example, Table3[#All].

§ #Data: 

This represents all cells in the table that contain the actual data. These are all cells except the column
headings and the total row.

§ #Headers: 

This represents the cells in the header row of the table (the row containing the column headings).

§ #Totals:

This represents the cells in the total row of the table. (Note: If the total row is disabled, the cell reference
will return a #REF! error value.)

§ @[ColumnName]:

This represents the cell that is in the same row of the specified column. This is especially useful for
calculations within a table.

If, for example, you use a cell reference like [@Spring] in a cell in a table, it represents the cell that is in the
same row of the column with the column heading "Spring".

Example:

=SUM([@[Spring]:[Winter]]) returns the sum of those values in the columns "Spring" to "Winter" that are
in the same row as the cell in which this calculation was entered.

Note: PlanMaker does not distinguish between uppercase and lowercase letters in identifiers.
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Pivot tables
In addition to the normal tables (see chapter Tables in worksheets), there are also Pivot tables. You can use the
ribbon command Insert | Pivot table to create a pivot table based on your existing source data.

What exactly is a pivot table?

A pivot table is an optimal tool for providing large amounts of data in a meaningful form. The generated pivot
data can be structured, summarized, filtered and analyzed according to different perspectives. The source data
remains unaffected.

Reports using pivot tables are particularly suitable for data sets with many different elements and criteria,
which are predominantly similar and interdependent, such as sales reporting.

What is the advantage of pivot tables compared to "normal" tables?
In addition to clarity, pivot tables are much better suited to data analysis than "normal" tables. If you would like
to ask complex questions about extensive data, for example, "How many sales did an employee make for which
articles at what time?", it would be quite laborious if you had to extract this information directly from a normal
table. You would have to sort the data records first, then filter them, use commands and finally prepare them.
Pivot tables reduce the number of work steps and enable a much better presentation of the desired information.

Data resources can be edited directly within your PlanMaker worksheet and also by importing data from
external PlanMaker and Microsoft Excel files.

Pivot tables illustrated by an example

The functionality of pivot tables is illustrated here with a simplified example, which is used throughout the
chapter for description purposes.

Here, you can see sample data records in PlanMaker from which a pivot table is to be created. The company
employees had various expenses for their break room supplies throughout the year. Some employees and some
articles appear several times in the relevant columns.

Source data for the pivot table
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Note: Number formatting of the source data is not applied to pivot tables. For more information on
formatting values in the created pivot table, see Value settings (Values area).

As an evaluation, the following pivot table could be created: Here, the employees are clearly listed with the
sums of their purchased articles and the grand total of all expenses.

Variant 1 of a pivot table (view of the employees)

However, this pivot table can also be created: Here, the purchased articles are arranged in a totaled overview.

Variant 2 of a pivot table (view of the articles)

Above all, the possibility of grouped arrangement shows the major advantages of pivot tables: Here, employees
and articles are displayed together and nested in one overview.

Variant 3 of a pivot table (view of employees with grouped articles)

It can be seen from these examples that, depending on the question addressed to the existing data, different
statements can be made with pivot tables.

The following sections clarify how to obtain different perspectives on pivot data and what settings you can
make to obtain a suitable presentation of your results:

§ Creating a new pivot table 

§ Starting with the pivot table field list
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§ Configuring pivot tables with the field list

§ Sorting and filtering pivot tables

§ Grouping pivot tables

§ Updating pivot tables and changing data area

§ Deleting, copying, moving pivot tables

Creating a new pivot table

To create a pivot table, you must first have source data records to which a pivot table can be applied.

Choose the ribbon command Insert | group Tables | Pivot table  to create a pivot table from existing source
data.

Please note a few important rules for the existing source data. Some of the requirements are not mandatory, but
they are still helpful for practical use:

Requirements for source data

§ The source data must have a separate heading for each column in the top row. 

§ Headings must appear in this single row, not one below the other.

§ Headings must be unique, and duplicate names for the headings must not occur.

§ There must be no empty rows or columns and no merged cells in the source data.

§ The data in the respective columns must be of the same data type (number, text or date – not mixed).

§ If possible, the data should be available in its raw form; no formulas, summarizations, subtotals or other
prepared data should have been applied to it previously.

You can either use existing records in the current workbook as source data or import data records from another
file (possible formats: PlanMaker and Excel).

Please read the next two sections:

§ Creating a pivot table with existing data 

§ Creating a pivot table with imported data 

Tip: Pivot tables can also be generated from Tables in worksheets. To do so, select a cell in the table and
choose the command Summarize as pivot (in the group Table) on the contextual ribbon tab Table.
Alternatively, you will also find this command in the context menu by right-clicking in the table. Then
proceed with the next steps to create a pivot table as described in the next section.
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Creating a pivot table with existing data

If the source data is already in the open workbook, proceed as follows:

1. Select the entire data area. You can also select just one cell from the source data. PlanMaker will then
automatically extend the selection to the entire contiguous area.

2. Choose the ribbon command Insert | group Tables | Pivot table .

PlanMaker opens the following dialog box:

3. Source range: This is the cell range with the existing data from which the pivot table is to be generated.
Here, the source range is already defined by your previous selection and can thus be applied. If you still
want to change the source range, you can enter the correct cell range in the input field or simply select the
correct cell range directly in the worksheet with the mouse.

Tip: If you have previously given the data area a name (see Naming cell ranges), you can simply enter this
name in the input field. An advantage of this procedure is that you only have to adjust the named range if
the source data changes.
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You can also import external data using the Browse... button. For more information, see Creating a Pivot
table with imported data.

4. Target range: Here, you can decide where the pivot table should be created. Now choose between the
following options:

New worksheet: The pivot table will be created in a new worksheet that is automatically generated by
PlanMaker. You can adjust the proposed target in the lower input field.

Existing worksheet: The pivot table will be created in an existing worksheet. This can be the worksheet
containing the source data or another worksheet that has already been created. Please make sure that you
first select the option Existing worksheet and only then click on a cell in a free area in the desired
worksheet. Alternatively, type the target range into the lower input field.

Tip: For pivot tables with large amounts of data, we recommend that you use a new worksheet rather than
the worksheet with the source data, as it can quickly lead to a lack of space otherwise. If there is only a
small amount of data – as in our example – it is useful and illustrative to display the pivot table next to or
below the source data in the same worksheet.

5. Confirm with the Insert button to create the pivot table.

If you created the pivot table in the same worksheet as the source data, the result should look as follows:

On the left, you can still see the Source data, and the (still blank) Pivot table report next to it. If you click in
this report, the Pivot table field list – or just Field list – appears in the right sidebar. It is the central control of
the pivot table. By selecting the fields from the field list, you fill the blank pivot table report with content
according to your requirements.

For more information about its structure and working with the field list, see Starting with the pivot table field
list.
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Creating a pivot table with imported data

You can also import data records from other PlanMaker files or Microsoft Excel files to create a pivot table. To
do so, proceed as follows:

1. Choose the ribbon command Insert | group Tables | Pivot table .

PlanMaker opens the following dialog box:

2. Source range

In the file browser, locate the file with your source data and confirm with Open.

The input field below Source range displays the file path with the file name and a proposed worksheet with
a cell range. Here, you have to adjust the desired cell range precisely. PlanMaker does not automatically
extend the cell range to contiguous data records when importing from external files.

Example: Your source data is in the file Pivot.pmdx in the worksheet Sheet1, and the cell range of your
source data records is from A1 to D11.

The syntax in the input field is then: 'filepath\[Pivot.pmdx]Sheet1'!$A$1:$D$11

Tip: If you have previously named the range of source data in your external file (see Naming cell ranges),
you can avoid entering the cell range exactly. A further advantage of this procedure is that you only have
to adjust the named range when making changes to the data records. Choose the name of the named range
in the input field using the following syntax: 'filepath\[filename]'!name

3. Target range: Here, you can decide where the pivot table should be created:

New worksheet: The pivot table will be created in a new worksheet that is automatically generated by
PlanMaker. You can adjust the proposed target in the lower input field.

Existing worksheet: The pivot table will be created in an existing worksheet. This can be the current
worksheet or another worksheet that has already been created. Please make sure that you first select the
option Existing worksheet and only then click with the mouse on a cell in a free area in the desired
worksheet. Alternatively, type the target range into the lower input field.

4. Confirm with the Insert button to create the pivot table.
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You should now see a (still blank) Pivot table report in the worksheet and the Pivot table field list or just
Field list on the right in the sidebar. It is the central control of the pivot table. By selecting the fields from the
field list, you fill the blank pivot table with content according to your requirements.

The following sections explain its structure and working with the pivot table field list.

Starting with the pivot table field list

Once you have created a pivot table, the Field list appears in the sidebar on the right with the upper Fields
section and the lower Areas section. It is the central element of a pivot table because it is where you control
which data is displayed in the target range of the pivot table (the Pivot table report) and how the data is
arranged.

Note: The field list appears whenever you click on the pivot table report.

Structure of the field list

On the left, you have the pivot table report that is still blank; on the right, you have the field list with the "Fields section" above and the "Areas section"
below.
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Fields section: In the upper part of the field list, the headings from the columns of the source data are grouped
in their original sort order. The order of the columns from left to right in the source data corresponds to the
order from top to bottom in the fields section. These elements are called "Fields" here and not "Columns".

Areas section: You can drag the fields from the upper fields section into the lower part of the field list, and
thus design the structure of the pivot table depending on the arrangement of these fields. Once you have placed
at least one field in one of the 4 areas of the areas section, results appear in the pivot table report.

The areas section is divided into the following 4 individual areas:

§ Row labels 

If you drag a field into this area, the data from this field is grouped by rows in the pivot table report. In this
context, grouping means that identical items from a column of the source table appear once only and are
totaled. You can also drag several fields into this area; the added fields then also form further subgroups by
row. The field that appears in the row labels at the top is the higher-level primary sort criterion. The fields
below are treated as lower-level sort criterion and are displayed in the pivot table report according to this
structure.

§ Column labels 

The same procedure applies here as for row labels, but grouping is by columns.

§ Values 

This is the most important area: The records of the field that was dragged here are totaled in the pivot table
report, for example, amounts are added up. This is why fields with numbers usually appear here.

§ Report filter 

This allows you to show and hide selected records in the pivot table report based on the field that is inserted
into the report filter. For more information, see also Sorting and filtering pivot tables.

Tips for displaying the field list in the sidebar:

Ø Adjust the Field list width as needed by dragging the mouse along the inner edge of the sidebar. 

Ø To show or hide the field list, click on the narrow vertical button at the edge of the sidebar.

Ø Use the ribbon command View | group Windows | Pivot table sidebar | Show at left or Show at right to choose at which side of the
document the field list should be displayed.

In the next sections, you will find practical information on how to use the field list.

Exercises for structuring the field list

You have already created a pivot table using the ribbon command Insert | group Tables | Pivot table . The
field list with the fields section and the areas section is on the right-hand side, but the target range of the pivot
table (the pivot table report) is still blank.

This section explains how to drag elements step-by-step from the fields section to the areas section in the field
list in order to display meaningful results with different characteristics in the pivot table report.

If you are already familiar with the structure of a pivot table, you can skip this section.
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Tip 1: You can drag the fields to the desired area with the mouse. You can also set a check mark in front of
the relevant field in the fields section. PlanMaker then automatically assigns the field to an area in the areas
section. Fields with numbers are placed in the values area; all other formats, such as text and date, are placed
in the row labels area.

Tip 2: Fields can be dragged back and forth not only between the fields section and the areas section, but
also between the individual areas of the areas section and within the areas themselves, so you can easily
swap the position of the fields.

Exercise 1: Adding a field to the "Values" area

In the fields section, set a check mark in front of the Amount field or use the left mouse button to drag the field
down directly to the Values area of the areas section.

The unchanged source data (left), the result of the pivot table (middle) and the field list with the selected fields for Exercise 1 (right)

§ The field element "Sum of amount" will appear in the Values area of the field list. 

§ In the pivot table report, the value field with the header "Sum of amount" will now be displayed instead of
the blank report.

§ All values from the Amount field are summed up to a grand total in the pivot table report.

Exercise 2: Adding a field to the "Row labels" area

Now set an additional check mark in front of the Employee field in the fields section or use the left mouse
button to drag the field down directly to the Row labels area.
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The result of the pivot table (left) and the field list with the selected fields for Exercise 2 (right)

§ The field element "Employee" appears in the Row labels area of the field list. 

§ In the pivot table report, there is now a row field with the header "Row labels". Below the row field, the
employees are arranged by row and each name only appears once.

§ The value field with the header "Sum of amount" in the pivot table report displays the expenses totaled and
broken down by employee.

Exercise 3: Adding a field to the "Column labels" area

You can also display the result by columns instead of by rows. To do so, drag the same Employee field to the
Column labels area.

The result of the pivot table (left) and the field list with the selected fields for Exercise 3 (right)

§ The field element "Employee" appears in the Column labels area of the field list. 
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§ In the pivot table report, a column field with the header "Column labels" is displayed and the employees are
arranged by column. Each name only appears once here.

§ The expenses are summed in the value field "Sum of amount" of the pivot table report and are broken down
by employee.

Exercise 4: Adding a second field to the "Row labels" area

Drag the Employee field back into the Row labels area, and set an additional check mark in front of the Article
field.

The result of the pivot table (left) and the field list with the selected fields for Exercise 4 (right)

§ In the pivot table report, employees are grouped with their totaled article types under "Row labels". Since
the Employee field is at the top of the row labels area, it is the primary criterion and is thus displayed as the
higher-level field in the pivot table report.

§ The amounts for purchased article items are broken down by employee in the "Sum of amount" value field
in the pivot table report, and partial results are displayed as subtotals per employee.

Note: You may have the article items in the pivot table report grouped as an indented column to the right
of the employees. The structure of the results shown here is based on PlanMaker's default settings. For
information on customizing the form, see Configuring pivot tables: Field settings.

Exercise 5: Using "Column labels" and "Row labels" together

Drag the Article field to the Column labels area, while the Employee field remains in the Row labels area.
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The result of the pivot table (left) and the field list with the selected fields for Exercise 5 (right)

§ You will see the same results as in Exercise 4 but presented as a cross-classified table. The intersecting
fields without existing values (for example, Anna did not buy sweetener) are displayed as empty cells.

Exercise 6: Using "Column labels" and "Row labels" together with multiple fields

Finally, drag the Date field to the Row labels area below the Employee field.

The result of the pivot table (left) and the field list with the selected fields for Exercise 6 (right)

§ The date of the article purchased by employees is also displayed in the pivot table report, grouped directly
below the employees in this example. A grouping of the items as an indented column to the right of the
employees could also appear, depending on the settings in PlanMaker. 

Note 1: You can drag multiple fields into the row and/or column labels for evaluation purposes, but your
pivot table will also quickly become increasingly unclear as a result.

Note 2: If there are multiple fields in an area, the order of the fields determines the structure of the outline
levels displayed in the pivot table report. You can change this order at any time by dragging the field up or
down within the area.
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Exercise 7: Adding a field to the "Report filter" area

Drag the Date field from the Row labels area to the Report filter area and the Article field back to the Row
labels area.

The result of the pivot table (left) and the field list with the selected fields for Exercise 7 (right)

§ A Report filter has been added for the Date field, which is integrated as a new row above the pivot report.

§ Above the pivot report, you can open a dropdown menu to the right of (All items)  and filter by date values
displayed in the list. First, all date values are selected, indicated by the check mark in front of them. You can
filter out the undesired date items from the pivot report by removing the check marks.

Working with the field list: Fields section

The fields section at the top of the field list displays the headings of the columns of your source data. You can
make the following changes to the fields section:

§ Display field names alphabetically in the fields section 

The field names are first automatically sorted according to the order of the columns from your source data.
You can also display the fields in alphabetical order to find specific field names more quickly. To do so,
click on the Pivot table settings button below the areas section. On the Filter tab, go to the Field list
section, select the option Sort A to Z and confirm with OK.

Note: The alphabetical order that you enter here does not affect the display in the pivot table report. For
information on the alphabetical sorting of elements directly in the pivot table report, see Sorting and
filtering pivot tables.
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§ Rename field names in the fields section

Open the dropdown menu  to the right of the field name and select Field settings there. In the dialog box
that opens, you can assign a Custom name.

You can also rename a field if it is in the values area or row labels/column labels area of the areas section.
For more information, see Working with the field list: Areas section.

§ Move fields from the fields section to the areas section

To move a field from the fields section to the areas section, you have the following options:

A. Enable the checkbox to the left of the field name in the fields section. PlanMaker automatically assigns
the field to an area of the areas section according to its format: Numbers are placed in the Values area,
while text and date formats end up in the Row labels area.

B. You can also drag the field with the left mouse button to the desired area below.

C. Alternatively, click on the dropdown menu  to the right of the field name. Here, you can select the
area in which you want to move the field directly.

Working with the field list: Areas section

After creating a pivot table, you will first see a blank pivot table report in your worksheet and the field list in
the sidebar on the right. By adding the fields from the upper fields section to the 4 individual areas of the lower
areas section, you can observe how the assignments in the field list affect the previously blank pivot report.

Tip: If possible, first drag the field with the amounts into the values area of the areas section. This is the best
way to follow the next steps for structuring the pivot table.

Adding, moving, removing fields

Adding fields to the areas section

To move a field from the fields section to the areas section, you have the following options:

A.Enable the checkbox to the left of the field name in the fields section. PlanMaker automatically assigns the
field to an area of the areas section according to its format: Numbers are placed in the values area, while text
and date formats end up in the row labels area.

B. You can also drag the field with the left mouse button to the desired area below.

C. Alternatively, click on the dropdown menu  to the right of the field name. Here, you can select the area in
which you want to move the field directly.

Moving fields within the areas section

To move fields from one area to another area within the areas section, you have the following options:

A.Drag the field from one area to another with the left mouse button.
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B. Click on the dropdown menu  to the right of the field name (either in the fields section above or in the
areas section below). Here, you can select in which area you want to move the field directly.

C. Use the left mouse button to drag the field again from the upper fields section to the desired new area of the
areas section. This will automatically remove it from the previous area (except for the values area, where
copies of a field are possible).

Removing fields from the areas section

To remove fields from the areas section at any time, you have the following options:

A.Use the left mouse button to drag the field back up to the fields section.

B. Disable the checkbox to the left of the field name in the fields section.

C. Click on the dropdown menu  to the right of the field name (either in the fields section above or in the
areas section below) and select Remove field.

Note: Removing fields from the areas section or moving fields between the areas will undo any changes
made to the field (exception: renaming in the row labels/column labels area).

Tips and rules for using the areas section

Using fields multiple times in the areas section

§ For the Row labels, Column labels and Report filter areas, the following applies: A field can only be
dragged into one of these areas once. If you also want to insert it into another area, it will be removed from
the area where it was previously. 

§ This does not apply to the Values area: You can insert a field again here, even if it already exists in another
area. The same field can even be inserted several times as a copy. What would be the advantage of doing so?
You could display a field element first as a sum and then in a different format (for example, average). An
additional element  Values appears automatically in the column labels, which you can also move to the row
labels area (the format is retained) but not to the report filter area.

Note: If you drag the field  Values back into the fields section, all fields in the values area will be
automatically removed and all changes made to these fields will be discarded.

Changing the order of the fields within an area of the areas section

§ The order of the fields within an area can be changed by using the mouse to drag the field to the correct
position within the area.

§ Alternatively, click on the dropdown menu  to the right of the field name. Here, you can select where you
want to move the field (up, down, to the start or to the end).

Renaming a field name in the areas section

A field name can be renamed in the areas section so that it appears in the pivot table with a different name.

§ Custom name in the Row labels or Column labels area: 

If the field is in the row labels or column labels area, click on the dropdown menu  to the right of the field
name and select Field settings. In the Field tab, enter a custom name.
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§ Custom name in the Values area:

If the field is in the values area, select Value settings from the dropdown menu  to the right of the field,
and enter a custom name in the Summarize values tab.

Note: For renaming in the Values area, the following applies: The new name is discarded when the field
is removed from this area. However, you can also rename the field in the fields section above (see
Working with the field list: Fields section); the renaming done there remains. In the Values area,
however, the addition "Sum/Count of..." is still displayed.

§ In the Report filter area, you cannot rename fields. However, you can also rename the field in the fields
section above. 

Further options in the field list

The field list includes other operating options that have not yet been described but are explained in more detail
in the following sections:

§ Pivot table settings button: 
Section Pivot table settings

§ Refresh data button: 
Section Updating pivot tables and changing data area

§ Defer layout update along with the Update button:
Section Defer layout update

§ Field settings (via dropdown menu  of fields in the row labels/column labels area):
Section Field settings (Row/Column labels area)

§ Filter labels (via dropdown menu  of fields in the row labels/column labels area):
Section Sorting and filtering pivot tables

§ Filter values (via dropdown menu  of fields in the report filter area):
Section Sorting and filtering pivot tables

§ Value settings (via dropdown menu  of fields in the value area):
Section Value settings (Values area)
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Configuring pivot tables with the field list

In the field list, you have various options for changing the structure and appearance of your pivot table, which
are explained in this section:

§ Field settings 

The Field settings can be found in the Row labels or Column labels areas in the areas section of the field

list. For this purpose, click on the dropdown menu  to the right of each field. In the field settings, you can
define if and how partial results are displayed and in which form the layout appears (outline form or tabular
form); you can also change the field name here.

§ Value settings 

Fields in the Values area have different setting components from the field settings in the row/column labels.

They can also be opened in the Values area via the dropdown menu  of the respective field and are called
Value settings here. In the value settings, you will find a selection of evaluation functions and calculations
as well as the desired number format for the displayed results. The field name can also be renamed here.

§ Pivot table settings 

In the Pivot table settings, you can make advanced layout adjustments, define filter methods, select styles,
set data usage and assign a name to the pivot table. You will find the pivot table settings located as a button
below the areas section.

§ Defer layout update 

You will find the option Defer layout update along with the Update button at the bottom of the field list. It
allows you to "freeze" the continuous recalculation, and you can rearrange the fields between the areas
without time-consuming calculations.

Please note: Changes to Field settings and Value settings are discarded when a field is removed from its
area (back to the fields section or to another area of the areas section). Changes to Pivot table settings are
retained.
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Field settings (Row/Column labels area)

If you open the dropdown menu  to the right of a field in the Row labels or Column labels areas in the lower
areas section of the field list, you will find the option Field settings. Alternatively, you can select this option in
the context menu by right-clicking directly in the Pivot table report (select a cell of the desired field below the
header Row labels/Column labels).

This section describes the adjustments you can make with the field settings.

This is illustrated by the familiar sample data shown in the figure below: The Amount field is dragged into the
Values area of the areas section, and the Employee and Article fields are dragged into the Row labels area.

The pivot table report with default values for field settings. Highlighted in blue: selecting the field settings for the "Employee" field

Note: For the purposes of simplicity, the descriptions in this section refer to the arrangement of the fields in
the Row labels area. If you drag the fields to the Column labels area instead, the results will be basically the
same. However, they will be displayed transposed (that is, from left to right instead of from top to bottom).

Field settings, "Subtotals" tab

If you have arranged several fields in a row labels or column labels area, you will obtain partial results for the
higher-level field element (Employee) in the pivot table report, as shown in the figure above (for Anna, Maria,
Toni). These subtotals will be automatically calculated as sums if a number field has been identified in the
values area. In the Subtotals tab, you can also change the display of the subtotals to other evaluation functions
(for example, count, average, etc., instead of sums) or hide the display of subtotals completely.

Important: The field settings affect only the selected field of the row/column labels area in the pivot table.

Click on the dropdown menu  to the right of the field (Employee) in the Row labels area (areas section of the
field list), and select the Field settings. In the open dialog box, select the Subtotals tab.

Here, you have the following options:
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§ Auto (default): Sums are displayed for the subtotals (Employee, as in the figure above). If the value field
(Amount) contains values with other formats rather than numbers, the Count function is automatically used
for the subtotals. 

§ None: The subtotals (Employee) are not displayed. 

The Pivot table report without subtotals

§ Custom

You can choose from various evaluation functions for displaying subtotals by clicking on the option
Custom:

Sum: The subtotals are displayed as the sum of the individual values.

Count: This displays the number of individual values that occur. This works in the same manner as the
COUNTA function.

Average: This displays the average value of the individual values that occur.

Maximum: This displays the highest individual value that occurs.

Minimum: This displays the lowest individual value that occurs.

Product: This displays the multiplied value of the individual values that occur.

Count numbers: This displays the number of values that are numbers. This works in the same manner as
the COUNT function.

Standard deviation (sample): This provides an estimate of the standard deviation of a population based on
a sample. This works in the same manner as the STDEV.S function.

Standard deviation (population): This returns the standard deviation of a population. This works in the
same manner as the STDEV.P function.

Variance (sample): This provides an estimate of the variance of a population based on a sample. This
works in the same manner as the VAR.S function.

Variance (population): This provides the variance of a population. This works in the same manner as the
VAR.P function.

Tip 1: You can also combine several custom functions. Each function is then displayed as a separate row
for the subtotal.
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Tip 2: If you want to change both the subtotals and also the other values to a certain display, you can
make the required changes in the Values area with the option Value settings. For more information, see
Value settings (Values area).

Tip 3: If you want to show or hide the grand total for columns/rows, you will find the options available
under Pivot table settings.

Field settings, "Form" tab

In the example figure at the beginning of the section, you can see the pivot table report displayed in the outline
view. You can use the Form options to customize this view.

Note: The Form can only be customized for fields in the Row labels area. For fields in the Column labels
area, the outline forms cannot be set.

In the Row labels area (in the areas section of the field list), click on the dropdown menu  to the right of the
Employee field and select Field settings. In the open dialog box, select the Form tab.

The Field settings dialog box with the default values in the "Form" tab

Form section

Here, you can select between the view in Outline form or in Tabular form:
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§ In the Outline form – with Compact form also enabled – several fields are displayed together in one
column, and the items of the lower-level element are indented in the column. Here, you can also select
whether the subtotals should appear above or below the grouping.

The following figures illustrate the different display variants, depending on the enabled options:

Outline form: Compact form enabled; Subtotals at top enabled

Outline form: Compact form disabled; Subtotals at top enabled
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Outline form: Compact form disabled; Subtotals at top disabled

§ The Tabular form always displays a separate column for each field, with the corresponding field heading:

Further options in the "Form" tab

There are three other options in the lower section of the Form tab that you can use to give the pivot table report
a more structured look as needed.

Please note: The options Repeat item labels and Insert blank lines after subtotals only affect higher-level
field elements (Employee). The option Show items without data, however, only affects lower-level field
elements (Article).

§ Repeat item labels 

The item labels are displayed repeatedly in each row. This option only works for the Tabular form or in the
Outline form if you disable the compact form.
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Enabled option "Repeat item labels" for Tabular form

§ Insert blank lines after subtotals 

The clarity of the pivot table report is improved if a blank row appears after each group of subtotals. Enable
the option for this purpose (not available for fields in the column labels area).

§ Show items without data 

Enable this option to also display those items that did not contain associated data.

Example: Toni did not buy any Coffee. If the option is enabled, this article will still be displayed with an
empty cell in "Sum of Amount".

Field settings, "Field" tab

You can assign a Custom name to the field here so that it appears in the pivot table with a custom name.
Enable the checkbox and type the new name into the input field. For more information, see also Working with
the field list: Areas section.

Value settings (Values area)

If you open the dropdown menu  to the right of a field in the Values area in the lower areas section of the
field list, you will find the option Value settings. Alternatively, you will find this option via the context menu
by right-clicking directly in the Pivot table report (select a cell below the header title Sum of...).

The value settings dialog box contains the tabs Summarize values and Show values as, which provide you
with various summary functions and calculation options.

Value settings, "Summarize values" tab

The results in the pivot table report are automatically displayed as a sum if a number field was identified in the
Values area. If the field has values other than numbers, the results are calculated as a count.

You can customize the display of the results. The specified selection applies to the subtotals of the higher-level
field and also to the subgrouped fields.
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To do so, click on the dropdown menu  to the right of the desired field in the Values area (in the areas
section) and select the option Value settings. In the dialog box that opens, choose the Summarize values tab.

In the upper section of the tab, you will find "Summarize values by" with the following options for displaying
the values:

§ Sum: The results of the individual values are displayed as a sum. 

§ Count: This displays the number of individual values that occur. This works in the same manner as the
COUNTA function.

§ Average: This displays the average value of the individual values that occur.

§ Maximum: This displays the highest individual value that occurs.

§ Minimum: This displays the lowest individual value that occurs.

§ Product: This displays the multiplied value of the individual values that occur.

§ Count numbers: This displays the number of values that are numbers. This works in the same manner as
the COUNT function.

§ Standard deviation (sample): This provides an estimate of the standard deviation of a population based on
a sample. This works in the same manner as the STDEV.S function.

§ Standard deviation (population): This returns the standard deviation of a population. This works in the
same manner as the STDEV.P function.

§ Variance (sample): This provides an estimate of the variance of a population based on a sample. This
works in the same manner as the VAR.S function.

§ Variance (population): This provides the variance of a population. This works in the same manner as the
VAR.P function.

Tip 1: If you only want to change the subtotals to a specific display, you can make the required changes in
the Row/Column labels area with the option Field settings. For more information, see Field settings
(Row/Column labels area). 

Tip 2: If you want to show or hide the grand total for columns/rows, you will find the options available
under Pivot table settings.

Furthermore, you will find the option Custom name in the tab. Here, you can rename the field so that it
appears in the pivot table with a different name. For more information, see also Working with the field list:
Areas section.

Value settings, "Show values as" tab

In the Show values as tab, you will find several options for displaying the results of the pivot table, such as
percentage values.
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Tip: You can also drag the same field several times into the Values area. If you then apply different output
settings to the copy of the field using Show values as (for example, standard values for one field and
percentage values for the other field), you can clearly compare the different output values in the pivot table
report.

In the upper section of the tab, you will find the section Show values as with options for calculating the values.
Depending on the calculation type, additional selectable entries appear in the Base field and Base item lists
below.

§ Standard (no calculation): This displays the value as usual. 

§ % of grand total: Each item is displayed as a percentage of the grand total.

§ % of column total: For each column, the total is set as a 100% reference, and each item in the column is
shown as a percentage of that total.

§ % of row total: For each row, the total is set as a 100% reference, and each item in the row is shown as a
percentage of that total.

§ % of: A column or row field is set as a 100% reference, and all other values are shown as a percentage of
this reference value. The desired entries must be selected from the Base field list and Base item list.

§ % of parent row total: This displays the percentage of an item relative to the higher-level item (parent) in
the row structure.

§ % of parent column total: This displays the percentage of an item relative to the higher-level item (parent)
in the column structure.

§ % of parent total: This displays the percentage of an item relative to any (selectable) higher-level item in
the structure. The desired entry must be selected from the Base field list.

§ Difference from: This displays the absolute difference of the values from the selected reference value. The
desired entries must be selected from the Base field list and Base item list.

§ % difference from: This displays the percentage difference of the values from the selected reference value.
The desired entries must be selected from the Base field list and Base item list.

§ Running total in: This displays the cumulative absolute values of the successive items. The desired entry
must be selected from the Base field list.

§ % running total in: This displays the cumulative percentage values of the successive items. The desired
entry must be selected from the Base field list.

§ Rank smallest to largest: This displays the rank of selected values in a specific field. The smallest item in
the field is ranked 1. The desired entry must be selected from the Base field list.

§ Rank largest to smallest: As above, but the largest item in the field is ranked 1.

§ Index: This displays the weighting of the values in relation to the grand row total and grand column total.
The higher the index value, the greater the weighting of the value on the grand row/column total. The
following formula applies to the index value:

value in cell x grand total of the pivot table
 grand row total x grand column total
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You can use the Number format button on this tab to permanently adjust the display of your desired number
format. For information on the various number formats, see List of number formats.

Note: Changes to the Number format will only be permanently retained if you do so here. If you change the
number format using the cell formatting only, the changes are discarded when the data is refreshed. The
number formatting of the source range is also not adopted in the pivot table.

Pivot table settings

In the field list below the areas section with the 4 areas, you will find the Pivot table settings button. You can
also access the command via the context menu by right-clicking directly in the pivot table report.

You can make further adjustments to the structure of your pivot table here, which you cannot find in the field
settings or value settings, since pivot table settings are of a general nature. Unlike the field settings and value
settings, the changed options in the pivot table settings will remain in effect when you remove the fields from
the areas section.

Layout tab

§ Show totals for rows/columns: This shows or hides grand totals for rows/columns. 

§ Indent row labels...character(s): If you have arranged several fields in the Row labels area and the outline
form with compact format is set in the Field settings, the lower-level field is displayed indented below it.
Here, you can now specify the extent of the indentation from the left edge of the column (default is 1
character).

§ Autofit column width: If this option is enabled, the column width of the pivot table automatically adjusts to
the text of the columns so that the text is not truncated by the next column. This has its advantages, but the
disadvantage is that manual adjustments to the column width may be discarded when changes are made to
the fields. Disable this option to retain the column width that you set manually.

§ Preserve cell formatting: If this option is enabled, the formatting you made manually in the pivot table (for
example, using a different font, shading, border) will be retained. If the option is disabled, such formatting
changes will be discarded as soon as you update the pivot table or reopen the workbook.

Note: Number formatting must be set using the Number format button (in the Value settings on the
Show values as tab) in order to be permanently retained.

§ Classic pivot table format: If you are confused by the headers "Row labels" and "Column labels" in the
pivot table report and would prefer to display the real names of the fields instead, enable this option for a
classic representation (known from older versions of Microsoft Excel up to 2003).

§ Show the values row: Enable the checkbox to insert an additional row with the heading "Values" above the
pivot table report. Note: The values row is displayed only if there are at least two fields in the Values area
(at the bottom of the field list) and cannot be enabled for the classic pivot table format.
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Filter tab

§ Report filter section: You can combine the following options Display fields and Fields per row to rearrange
the placement of report filters in the pivot table report.

Display fields – If there are at least two fields in the report filter area, you use this option to specify how the
fields in the report filter area are arranged in the pivot table report. You can choose between First down,
then right or First right, then down.

Fields per row – Here, you can also specify for the report filters of the pivot table report how many fields
are displayed per column before a new column starts.

§ Field list section:

Sort A-Z/Sort in data source order – The field names in the field list are sorted according to the order of
the columns from your source data. You can also display the fields in alphabetical order to find specific field
names in the fields section more quickly.

Note: The order specified here does not affect the display in the pivot table report. For information on the
alphabetical sorting of elements directly in the pivot table report, see Sorting and filtering pivot tables.

§ Display section

Show field captions and filter dropdowns – The field names and filter symbols for row labels and column
labels are displayed/hidden in the pivot table report.

§ Use fill lists when sorting:

If this option is enabled, the field items of the pivot table are sorted using the lists defined for automatic
filling. On the one hand, these are the lists predefined in PlanMaker (for example Mon;Tue;Wed;... for the
sequence of weekdays) and, on the other hand, lists you create yourself. For more information on how to
create such lists, see Editing lists for automatic filling.

If, based on our example table, you would like the items of the Article field to always be displayed sorted in
a certain order Tea;Cream;Snacks;Coffee;Sweetener, first create a corresponding custom fill list. Then click
on the Refresh data button located below the areas section of the field list.

Note: You can only use text for fill lists but not numbers.

If the option is disabled, the lists will not be used for automatic filling and the data will be sorted
alphabetically (thus, Coffee;Cream;Snacks;Sweetener;Tea in this example). 

Style tab

You can customize the visual appearance of the pivot table report in various ways, just as you do with normal
table styles. Select a style source (Excel 2007, Excel 2003, Excel 97) from the upper left list in the Style
section, and choose one of the pivot styles with different formatting from the list below. For the Excel 2007
style templates, the selection light/dark/medium is also available in the upper right list.

The options Banded rows, Banded columns, Row headers and Column headers are displayed automatically
adapted to the style template. For the Excel 2007 style templates, you can manually modify these options to
your liking.

Enabling the option Banded rows/Banded columns causes alternating background colors of the rows/columns,
while enabling the option Row headers/Column headers highlights the first row/column of the pivot table.
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The change of the design is displayed directly in the pivot table report as a preview and has to be confirmed
with OK in order to be finally adopted.

Data tab

§ Special values section:

Show for error values – Cells with incorrect calculations return the known error values also in the pivot
table report (for example, #N/A). For more information, see Error values). Enable this option and enter an
individual text in the right input field to display self-defined output values that represent the error values.

Show for empty cells – If no data can be assigned to an item (this usually occurs with combinations of row
and column labels for cross-classified tables), an empty cell is displayed in the pivot table report. If you
disable the checkbox, a 0 is displayed instead of empty cells. If the checkbox is enabled, you can also enter
an individual text in the input field next to it to display a self-defined output value instead of an empty cell
or 0.

§ Pivot table data section:

Save source data with file – If this option is enabled, the source data is stored in an internal cache and is
available from the cache for the pivot table independently of your source data. In a way, a copy of the source
table is created. This is particularly useful for external source data: If it no longer exists, you can still work
on your pivot table with the data from the pivot cache.

If you disable this option, your data will not be stored in the pivot cache. When you re-open the file, you
have to click on the Refresh data button (see Updating pivot tables and changing data area) to initialize the
pivot cache for the pivot table with the source data. In the case of external source data, the following
applies: If it no longer exists, your pivot table cannot be updated either.

Refresh when opening the file – If this option is enabled, the pivot table data is automatically updated to
current source data when you open the file. If you disable this option, you can continue working with your
old pivot data until you trigger the Refresh data button. For more information, see Updating pivot tables and
changing data area.

Please note: Updating the data with the option Refresh when opening the file or with the Refresh data
button will replace the pivot cache with updated source data, thus overwriting the previous data in your
pivot table.

Text tab

On the Text tab, you can enter a custom Name, a Title and a Description for your pivot table. The name is
automatically generated by PlanMaker in sequence when a pivot table is created (Pivot table 1, Pivot table 2,
etc.) and is shown as a title in the blank pivot table report. An entry is also created in Named ranges, but it
cannot be renamed there. Furthermore, the assigned Name cannot be used to identify the pivot table from the
GETPIVOTDATA function; thus, you must explicitly create a new entry for the pivot table in the Named
ranges.

Apart from that, the entries from the Text tab do not appear anywhere in the pivot table. Title and Description
can be useful as internal information. To rename the fields that actually appear in the pivot table, see Working
with the field list: Fields section.
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Defer layout update

At the bottom of the field list, you will find the option Defer layout update. It is combined with the Update
button on the right, but is not related to the option Refresh data. For more information, see Updating pivot
tables and changing data area.

When you reposition fields in the field list, for example, add/remove/move fields in the areas section, the pivot
table report is recalculated each time. This can take quite some time with large reports. Thus, if you want to
temporarily disable continuous recalculation, please proceed as follows:

1. Place a check mark in the Defer layout update checkbox. You can then reorder the fields of your pivot
table, but you will not initially see the resulting changes in the pivot table report. In addition, all other
editing options for this state are disabled.

2. Once you have finished repositioning the fields, click on the Update button to see the result of the change.

3. Remove the check mark from the Defer layout update checkbox.

Note: If you disable the option Defer layout update again without clicking on Update, all arrangements of
the fields that you have made since the option was enabled will be discarded.
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Sorting and filtering pivot tables

Too much data makes it difficult to see the relevant content. Thus, there are various options for sorting and
filtering table fields in pivot tables:

§ Sorting field items alphabetically in the pivot table report via the dropdown menu  

§ Sorting field items in the pivot table report by fill lists

§ Filtering in the areas section with the option Filter labels (Filter values)

§ Filtering by adding Report filters

§ Setting additional special filters directly in the pivot table report via the dropdown menu 

Please note: For all presented options of sorting and filtering, the changes will be discarded as soon as you
have removed the field from the areas section or moved it to another area.

Sorting field items alphabetically in the pivot table report

You can sort the field items of a pivot table report alphabetically by opening the dropdown menu  in the
report itself at the header Row labels/Column labels and choosing from the list:

§ Sort from A to Z (alphabetical order) 

§ Sort from Z-A (reverse alphabetical order)

If there are several fields in the row/column labels area (as in the figure above), you can sort each field
separately. If you move the mouse in the dropdown menu  to the desired field, the program will open a
submenu with the sorting options of this field.
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Note: For the alphabetical display of the fields only in the field list, see Working with the field list: Fields
section.

Sorting field items in the pivot table report by fill lists

You can have the field items of the pivot table sorted according to the lists defined for automatic filling. To do
so, first create the relevant custom fill lists as described in Editing lists for automatic filling.

To use these fill lists for sorting the field items, enable the option Use fill lists when sorting in the Pivot table
settings, Filter tab. If this option is not enabled, the field items will be sorted alphabetically, as described above.

Filtering in the areas section with the option Filter labels (Filter values)

In the Row labels/Column labels areas of the field list, go to the desired field whose items you want to filter.

Open the dropdown menu  to the right of the field and select the option Filter labels (do the same for fields
in the Report filter area, but the option is called Filter values here). You can also select the option directly
from the pivot table report by right-clicking on the desired field and opening the context menu.

In the Filter dialog box that opens, you can select the following:

§ Select individual list items that you want to show/hide by placing/removing a check mark in front of them. 

§ The Show all button selects all items. 

§ The Hide all button deselects all items.

Confirm your selection by pressing OK.

In the pivot table report, the black dropdown arrow  next to the header changes to a red arrow, indicating that
a filter is active. The filtered out values are no longer displayed in the pivot table report.

Filtering by adding report filters

The Report filter is located in the lower areas section of the field list and offers you a particularly simple and
clear option for filtering data.

Drag the fields by which you want to filter to the report filter area. A cell with the field name is then inserted
above the pivot table report and another cell (All items) with a dropdown arrow  is integrated to the right of it.
The items of the field can be filtered via this dropdown menu. You can select individual list items here or
select/deselect the complete list of items with Show all/Hide all.

The red dropdown arrow to the right of the cell indicates that a filter is active. The filtered out values are no
longer displayed in the pivot table report.

You can drag several fields from the field list to the Report filter area and filter any combination of individual
items from the various fields for the pivot table report.

Tip: The positioning of the report filter fields in the pivot table report can be changed using the Pivot table
settings, Filter tab.
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Setting additional special filters directly in the pivot table report

In the pivot table report, open the dropdown menu  to the right of the header Row labels/Column labels. If
there is only one field in the Row labels/Column labels area, the choice of filter will be displayed directly for
the selected field.

If there are multiple fields in the Row/Column labels area, you can apply separate filters to each field in the
pivot table report. If you move the mouse to the desired field in the dropdown menu  of the header, the
program will open a submenu with the filter selection of the field.

§ You can select individual list items or select/deselect the entire list of items with the options Show
all/Hide all. 

Note: If the list has too many entries, the entry More appears at the end of the list. Clicking on this entry
will take you to the dialog box Filter with the complete list of all items.

Furthermore, additional special filter conditions are available in the dropdown list. For detailed descriptions of
the individual filter conditions, see AutoFilter):

§ Label filter or Date filter: Depending on whether you have selected a field with numbers/text or date
values, one of the two filters is automatically offered. Depending on the filter, you can filter numbers/text or
date values according to specific conditions. 

§ Result filter: The result filter has special filter conditions that you can use to narrow down the amounts in
the value fields.

Note: When applying filters to multiple fields, please note the order in which you set the filters. The next
filter that is applied refers only to the remaining results of the previously set filter.

§ Multiple filters: The filters in pivot table reports can be applied additively, that is, you can set another filter
on the currently effective filter of the same field. To do so, however, you must enable the option Multiple
filters to combine filters for individual list items, label/date filters and result filters for the same field. If this
option Multiple filters is not enabled, a newly applied filter replaces the old one. 

§ Clear filter: If you want to remove the applied filters from the label filter/date filter or result filter, select
Clear filter from the dropdown list of the relevant filter.

Tip: If you want to remove all filters at once, disable the entry Multiple filters. In the following dialog
box Reset all filters?, confirm with OK to remove all filters.

In the pivot table report, the red dropdown arrow next to the header indicates that a filter is set. The filtered out
values are no longer displayed in the pivot table report.

Grouping pivot tables

You can use the Group function to display data even more clearly. For example, group the dates in your pivot
table report by years, quarters or months to make time periods more meaningful.
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You will find the command for this as the Group... button at the bottom of the pivot table sidebar.

An example:

You have created a pivot table from the familiar sample data (see Creating a new pivot table).

Then, proceed as follows:

1. In the pivot table sidebar, drag the Date field to the Row labels area and the Amount field to the Values
area.

2. In the pivot table report, select a cell with a date value.

Note: Only one cell may be selected at a time.

3. Click on the Group... button in the pivot table sidebar.

4. In the dialog box that now appears, select the entry Quarters from the list, for example.

5. In the dialog box, confirm with Group.

The pivot table report then shows the following result: The amounts are summed quarterly.

The "Group..." function in detail:

Depending on the contents of a selected cell, you group date values, numeric values or text. Multiple groupings
in the same pivot table are possible, both for Row labels and Column labels.

After you have selected a cell in the pivot table and clicked on the Group... button, one of the following dialog
boxes opens, each with different options:

§ The dialog box Group by dates appears if the selected cell contains date values: 

With the Auto options enabled, the date values are preset to a range with the first and last date of all records
and are thus grouped for this period. If you want to customize the time period, disable the Auto checkbox in
front of the input fields Starting at or Ending at and enter the desired values there.

In the list below, select the time unit (Months, Quarters, etc.) by which you want to group. Click with the
mouse on the corresponding entry from the list, which is then highlighted in blue and is thus selected. To
deselect, click again on the entry highlighted in blue. Tip: You can also select multiple time units by just
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clicking on another entry. For example, it may make sense to select Days as well as Quarters. The days are
then shown in the pivot table for the relevant quarter.

Once you have made your choice, press Group in the dialog box.

Note: The input field Number of days is only available if you have selected Days as the only unit of time in the list above. This
option causes the pivot table to display the specified number of days as a time interval from...to and is especially useful for displaying
the results of calendar weeks. To do so, enter the number 7 and disable the two Automatic options above. For Starting at, select the
Monday before the oldest date of your source data (this would be 01/08/2018 in the example above) and, for Ending at, the Sunday
after the most recent date (1/18/2018 in the example).

§ The dialog box Group by numbers appears if the selected cell contains numeric values: 

With the Auto check boxes enabled, the numeric values are preset to a range with the smallest and largest
numeric value of all records. The numeric values in this range are thus grouped. If you want to customize the
range, disable the Auto checkbox in front of the input fields Starting at or Ending at and enter the desired
values there.

You use the option By below to determine at which intervals the numeric values are to be grouped. You thus
receive a summarization to value classes. If, for example, you enter 0 for Starting at, 40 for Ending at, and
10 for By, you will obtain the classes 0-19, 10-19, 20-29, 30-39 by which your records will be grouped.

Finally, press Group in the dialog box.

§ The dialog box Group text appears if the selected cell contains text: 

In the Labels list on the left, select the items that you want to group by clicking on them with the mouse. The
entry now appears highlighted in blue. To deselect an item, simply click on it again.

Important: In the input field Group name, first type a name. It is only then that you can then use the New
group button to create a grouping for the selected items. You can then add more groups in the same way by
selecting items from the left list again and entering a group name (ensure that you confirm with New
group).

In the Groups list on the right, you will see the result of the created group(s): The group name at the top and
the items it contains below.

If you want to rename a group, select the corresponding group in the Groups list on the right. Important: In
the Group name field, type the new name first, and then click on the Rename group button.

Use the buttons  and  to add or remove items from the groups. To do so, select the desired group in
the Groups list on the right, and then select the item that you want to add (from the list on the left) or
remove (from the list on the right).

Finally, click on OK in the dialog box.

Ungrouping

To reset grouped data, select a cell of the grouping in your pivot table report. Click on the Ungroup button in
the pivot table sidebar. Only the grouping of the field to which the selected cell belongs is reset.

Alternatively, you can click on the Group... button to open the dialog box again and click on the Ungroup
button there.

Only for cells with text: If you have created several groups for a field with text, you can remove a single group
via the dialog box by selecting a group in the dropdown list on the right and using the Ungroup button. The
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Ungroup all button, on the other hand, ungroups all groupings for this field (corresponds to the Ungroup
button in the sidebar).
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Updating pivot tables and changing data area

The following generally applies to pivot tables: If you subsequently add new data to the source table, this
initially has no effect on the pivot table. Due to PlanMaker's default values for pivot table settings (see Pivot
table settings, Data tab), the data of the original source table is stored in an internal pivot cache after creating
the initial pivot table. The pivot table accesses the data from this cache.

It is only when you Refresh data that the pivot cache will be overwritten and the pivot table will be updated.

In the Pivot table settings, Data tab, you will find the option Refresh when opening the file. If you enable
this option, the pivot cache is regularly overwritten with the current data of the source range when you open the
file. If you want to continue working with your old pivot data after opening the file, leave this option disabled.

You can manually update your pivot table at any time by clicking on the Refresh data button.

Please note: By updating the data with the Refresh data button or with the option Refresh when opening the
file, the pivot cache will be replaced by updated source data, thus overwriting the previous data in your pivot
table.

"Refresh data" button

You will find the Refresh data button below the areas section in the field list.

Depending on how you added new data in the source data area, this affects the pivot table differently when it is
refreshed:

§ If you overwrite data within the source data area, the changed data will be used in the refreshed pivot table. 

§ If you insert a new row or column within the source data area, the data area will not be automatically
extended. Thus, the refreshed pivot table only takes into account the data that is in the previous source data
area. You thus must adjust the source data area again (see "Changing the source data area" below). 

The same applies if you add a new row or column at the end of the source data area.

Refresh all pivot tables

If you want to update all existing pivot tables – even with different source ranges – use the ribbon command
Formula | group Update | Update data | Update pivot tables.

Changing the source data area

iOS: In this version, the command to change the source data area is not freely available.

If your source data has changed to such an extent that it no longer corresponds to the original source range of
the pivot table (new records have been inserted/appended or the file with imported data has been moved), the
referenced data area for the source data must be changed.

To do so, proceed as follows:
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1. Place the mouse cursor in the pivot table report.

2. Choose the ribbon command Insert | group Tables | Pivot table  again.

Alternatively: On the ribbon tab Data | group Analyze | Pivot table or simply by right-clicking in the Pivot
table report with the command Modify pivot table areas from the context menu.

3. The program opens a dialog box that is similar to the one for creating a new pivot table but with one
difference: The Insert button is called Change here. In addition, the originally referenced source range is
highlighted with a blue border directly in the worksheet with the source data.

4. In the dialog box, enter the new data area in the input field (source range); the previous source range is
offered by default. Alternatively, you can drag the desired source range with the mouse if you have the
worksheet with the source data in front of you. To do so, grab the blue selection at the bottom right with the
left mouse button.

Note: For external data, the adjustment is only possible in the input field (source range).

5. Confirm with the Change button. Before you do so, you can enter in the lower input field whether you also
want to move the target range to another position; the previous target range is offered by default.

Deleting, copying, moving pivot tables

You can also delete, copy and move your created pivot tables. You will find out how to do this in the following
paragraphs.

Tip: To delete, copy or move, it is always necessary to select the entire area of the pivot table report exactly.
The easiest way to do this is to place the mouse in a cell of the report and use the key combination Ctrl+A to
select it. Alternatively, choose the ribbon command Home | group Selection | Select all.

Deleting pivot tables

Deleting pivot tables works in a similar manner to the standard procedures for deleting. Note, however, that the
pivot table report must be selected as a whole; individual cells cannot be deleted separately.

Thus, select the entire pivot table report and delete it using one of the following methods:

§ Press the Del key on the keyboard 

§ Use the ribbon command Home | group Contents | Delete  or open the context menu by right-clicking
with the mouse on the pivot table report and selecting Delete special.

In the submenu of these commands, you can use All or Contents to completely delete the pivot table. Select
the entry Formats if you only want to remove the applied formats from the pivot table.

Copying pivot tables

You can copy pivot tables at any time and duplicate them in the same worksheet in a different place or in a new
worksheet. The copied pivot table will have the same values as the original. Even after you click on the Refresh
data button, the copied pivot table adopts changed data from the source table.
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In the copied pivot table, however, you still have the option of configuring it independently of the copied
original with regard to field arrangement, formatting, etc. This gives you different views of the reports for the
same source data.

Select the entire pivot table report to copy it and proceed according to one of the following methods:

§ Use the ribbon command Home | Copy  and then Home | Paste 

§ Right-click on the pivot table report to open the context menu and select Copy and then Paste

§ Drag the pivot table report with the mouse to the desired position and press the Ctrl key to drop it before
releasing the mouse.

§ Alternatively, simply use the key combination Ctrl+C and Ctrl+V

You can now decide which report you want to work on by clicking in the respective pivot table report. The
program displays the relevant field list that corresponds to the selected report.

Moving pivot tables

Select the entire pivot table report and use the left mouse button to drag the selected range to a free position in
the worksheet. Ensure that the report does not overlap the source data area.

If you want to move the pivot table report to another worksheet, proceed as follows:

§ Choose the ribbon command Insert | group Tables | Pivot table . Alternatively, right click in the pivot
table to open the context menu and choose the command Modify pivot table areas. In the dialog box, enter
the target range and the desired worksheet (see Updating pivot tables and changing data area). 

§ Alternatively, copy the pivot table report as described above, switch to a free space in the desired worksheet
and paste the copy from the clipboard. Then remove the remaining pivot table report from its former
location.

Some restrictive notes on copying and moving source/target range

Copying and moving data ranges – both the source range and the target range (the pivot table report) – is not
fully possible in the same way as is usual when working with normal tables. You should note the following
rules:

§ Copy & paste the source range/target range: Although you can first copy the source range of your data and
paste it to another position, the pivot table is still referenced to the position of the original source range and
not to the new position. This means that the former cell range is still addressed when the data is refreshed,
and if it has been removed, an error message appears. This restriction also applies if you copy and paste the
source range together with the target range. Copying and pasting only the target range to another position
can be easily done.

§ Drag & drop the source range/target range: If you drag the selected source range to another position with
the mouse, the aforementioned restriction does not apply. The pivot data will be referenced to the new cell
range and will be correctly addressed when the data is refreshed. Dragging and dropping only the target
range or together with the source range can also be easily done.

§ Cut & paste the source range/target range: Cutting is neither possible for the source range nor for the target
range. An error message appears when you use this command.
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In the following table, you can see the options once again clearly summarized:

Action Source range Target range

Copy & paste û ü

Drag & drop ü ü

Cut & paste û û
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Freezing rows and columns

You can choose the ribbon command View | group Windows | Freeze cells  to fix the first rows and/or
columns of a table on the screen. This means that they no longer move when scrolling through the table, but
permanently stay in place.

If, for example, you have entered labels for rows or columns of a worksheet, you can freeze those labels so that
they are always visible.

Enabling freezing

To freeze rows or columns, you can use the following options:

§ Only freeze the top row: Use the small arrow of the icon Freeze cells, and select the entry Freeze top row. It
does not matter which cell you have previously selected. 

§ Only freeze the first column: Use the small arrow of the icon Freeze cells, and select the entry Freeze first
column. It does not matter which cell you have previously selected.

§ Freeze the top row and first column: Select the aforementioned two commands in succession to combine
freezing the top row and the first column.

§ Freeze any number of lines: If you want to freeze the first rows (without freezing columns), proceed as
follows:

In the row header on the far left, select the row directly below the rows that you want to freeze. Then click
directly on the Freeze cells icon.

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

§ Freeze any number of columns: If you want to freeze the first columns (without freezing rows), proceed as
follows: 

In the column header at the top, select the column to the right of the columns that you want to freeze. Then
click directly on the Freeze cells icon.

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

§ Freeze any number of rows and columns: If you want to freeze several first rows and columns, place the cell
frame in the cell right below the range that you want to freeze. Then click directly on the Freeze cells icon. 

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

The rows and/or columns are now frozen. They remain in their original location when you scroll through the
worksheet.

Tip: You can also use the  icon in the bottom right corner of the document window to freeze rows or
columns. Simply click on this icon and then drag it to the desired location.
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Disabling freezing

If you have frozen rows or columns, the Freeze cells  icon is darker in order to indicate that freezing is
enabled. To disable it, click directly on the icon itself – the rows/columns will no longer be frozen.

Alternatively: Use the icon's small arrow and select the entry Unfreeze cells.

Tip: A single mouse click on the  icon in the bottom right corner of the document window will also
disable freezing.

An example

Assume you have the following worksheet:

Note that both the columns and the rows are labeled. To freeze the labels, proceed as follows:

§ The column labels (High, Low, etc.) are in the first row of the table. 

To freeze them, select the second row by clicking on its row header (the button labeled "2" to the left of the
row).

Then choose the ribbon command View | Freeze cells.

§ The row labels (10/23, 10/24, etc.) are in the first column of the worksheet. 

To freeze them, select the second column (column B) by clicking on its column header (the button labeled
"B" above the column).

Then choose the ribbon command View | Freeze cells.

§ To freeze both rows and columns, click on cell B2 and choose the ribbon command View | Freeze cells. 

Tip: Since the top row and first column are involved in this example, you might as well use the commands
Freeze top row and Freeze first column by clicking on the arrow of the icon Freeze cells.

If you want to unfreeze, click on the Freeze cells icon again.
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Inserting special characters
Some characters, such as the copyright sign, the degree sign and the accented characters used in some
languages, cannot be entered into text directly with the keyboard. With PlanMaker, you can easily insert these
special characters via the built-in character table.

To do so, proceed as follows:

1. Open the dialog box via the ribbon command Insert | Symbol  (in the group Text) by clicking directly
on the icon.
Tip: If you click on the icon's arrow rather than directly on the icon itself, a small selection of the last used special characters will open for quick use.
If you click on More here, you will open the dialog box again.

2. The dialog box displays all characters available in the currently selected font. You can select a different font
from the dropdown list Font if necessary.

3. You can use the dropdown list Set to jump to a specific section of the character set. For example, you can
select Cyrillic to view the Cyrillic characters (provided the selected font contains such characters).
Note: Many fonts contain only a few of the available character sets. A particularly large reservoir of characters is available in the standard fonts
supplied with your operating system. In Windows, for example, these include such fonts as Arial, Tahoma and Times New Roman.

4. Select the character to insert with the arrow keys and press Enter¿ or double-click on the character to insert
it into the text.
Tip: If you know the Unicode of the character you want to insert (for example, 20AC for the Euro sign €), you can enter it in the Code field. The
program will then jump directly to the corresponding character.

5. You can now insert more characters in the same way or exit the dialog box with the Close button.

Tip for Windows users: Most versions of Windows include two icon fonts named Symbol and Wingdings.
These fonts contain numerous useful symbols (phone symbols, bullets, etc.).

Using shortcut keys

If you need to insert a special character frequently, you can always give it a shortcut key. The advantage of
doing so is that you can then apply the character very quickly with one press of a key.

To assign a shortcut key to a special character, proceed as follows:

1. Choose the ribbon command Insert | Symbol  to open the dialog box.

2. Select the special character to which you want to assign a shortcut key.

3. Click on the Change button next to the option Shortcut key.

4. Another dialog box appears. In the Press new shortcut key input field, press the desired key combination
(starting with Ctrl or Alt).

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned. If you press a key combination that is already assigned, its current assignment will be
displayed just below the Press new shortcut key input field. You should then press the Backspace keyÕ
to delete your shortcut key and use a different key combination. Otherwise, you will overwrite the key
combination of another PlanMaker command.
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5. Don't forget: Click on Add to assign this shortcut to the character.

6. Confirm with OK and exit the main dialog box with Close.

From now on, you can insert this special character by pressing the relevant key combination.

Note: The shortcut key only remembers the selected character but not the selected font.

Inserting special characters via their character code

There is another method for inserting special characters: by typing in its hexadecimal character code (Unicode)
and then pressing the key combination Ctrl+Alt+Shift+X.

If, for example, you type 20AC and then press this key combination, you will get a euro sign € because it has
the character code 20AC in the Unicode character table.

Tip: The Unicode value will be displayed in the aforementioned dialog box when you click on a special character.

Inserting special characters via Alt + numeric keypad

Here is yet another method for inserting a special character, via its ASCII code: Press and hold down the Alt
key and enter the respective sequence of numbers (only possible via the numeric keypad!). Please also ensure
that the numeric keypad is enabled by pressing the Num key.

If, for example, you type Alt+0128, you will obtain a euro sign € as soon as you release the Alt key.

Tip: You can display the ASCII code of a special character in Windows via the search term "Character map".

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work.

Applying selected formatting and special characters via the "Character" icon

The ribbon command Insert | Character  (in the group Text) opens a dropdown menu with some special
formatting and special characters, such as:

§ Soft hyphen / non-breaking hyphen 

§ Non-breaking space

§ Dashes and spaces of different widths

§ Ellipsis and some other useful special characters.

Tip: If you click on the icon  on the far right of the character in the dropdown menu, you can assign your
own shortcut key to the character.

For more information on changing the keyboard mapping, see Customizing shortcut keys. You can edit the
shortcut keys for special characters described in this section by selecting the "Characters" entry in the upper left
list Categories in the dialog box.
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Formatting worksheets
You can use charts, colors, borders, and other design options to enhance the appearance of your worksheets and
increase their legibility.

In this chapter, you will learn everything about designing appealing worksheets. It covers the following topics:

§ Cell size 

To change the cell size, use the commands of the ribbon tab Layout | group Cells. Alternatively, simply
drag the row header (or column header) using the mouse.

§ Number format 

PlanMaker can display numbers in many different number formats: from simple numbers with or without
decimal places via currency, percentage and date formats to freely definable formats. Use the commands of
the ribbon tab Home | group Number to select the appropriate number format.

§ Borders 

You can use the ribbon command Home | group Format | Borders to add a border or individual lines to
cells.

§ Shading 

The background of cells can be shaded. The ribbon command Home | group Format | Shading lets you
apply a variety of colors, shading and patterns to the background of cells.

§ Alignment 

You can use the commands of the ribbon tab Home | group Alignment to align cell contents (left-aligned,
right-aligned, etc.) and rotate them.

§ Protection 

Furthermore, you can use the dialog box of the ribbon tab Home | group Alignment  (Protection tab) to
protect cells so that they cannot be overwritten or changed, for example. For more information, see also
Sheet protection.

§ Character format 

The commands of the ribbon tab Home | group Character let you specify the character format of cells or
individual characters. This includes settings such as the font, font styles (bold, italics, etc.) and the font
color.

§ Paragraph format (text frames only) 

If you have inserted text frames into the worksheet, you can change the paragraph formatting (line spacing,
indents, etc.) of the included text at any time. This can be done using the dialog box Paragraph of the ribbon
tab Home | group Alignment  (only available in text frames).
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§ Character styles 

Character formats that you use very frequently can be stored in a character style, which can then be applied
as often as you like.

§ Cell styles 

FreeOffice: Creating and managing your own cell styles is not included in SoftMaker FreeOffice.

You can also create cell styles. Both the character format (font, font size, etc.) and the cell format (number
format, borders, shading, alignment and cell protection) can be saved in these cell styles.

§ Document templates 

PlanMaker even lets you create your own document templates. Document templates can include your own
character styles, your own cell styles and any kind of content.

§ AutoFormat 

The command AutoFormat enables you to format a range of cells by applying predefined formats.

Note: The command Insert | Table is even more powerful for applying different table styles. For more
information, see Tables in worksheets.

§ Conditional formatting 

You can also apply conditional formatting to cells. This will only be applied if a certain condition is met.
Thus, for example, you can specify that a cell should be colored red whenever it contains a value greater
than 1000.

§ Input validation 

FreeOffice: Input validation is not included in SoftMaker FreeOffice.

When you add input validation to cells, only the specified types of values (for example, only numbers)
within the specified limits (for example, only values between 10 and 20) will be considered valid in these
cells.

§ Format painter 

With the ribbon command Home | group Edit | Format painter, you can quickly transfer the formatting of
one cell to other cells using a "brush".

§ Page setup 

The page setup command allows the user to determine the appearance of the document when it is printed. It
includes settings such as paper size, page margins, headers and footers, and much more. Use the ribbon
command File | group Print | Page setup to change these settings.

For more information on these topics in the above order, see the following pages.
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Cell size
On the following pages, you will learn how to change the size of cells.

Important: If a cell displays hashes (for example, ########) instead of the cell content, the column is too
narrow to display the cell content. If this occurs, simply widen the column accordingly.

Changing cell sizes via the mouse

Across the top of the table, there are buttons labeled A, B, C, etc. To the left of the table, there are buttons
labeled 1, 2, 3, etc.

These column headers and row headers allow you to change the column width or row height using the mouse:

§ To change the column width, move the mouse cursor to the right border of the corresponding column header.
The mouse cursor will change to a double arrow. If you now press and hold down the left mouse button, you
can change the column width by dragging with the mouse. 

§ To change the row height, use the row headers in the same manner.

Changing cell sizes via commands

On the ribbon tab Layout | group Cells, you can change the column widths and row heights of your worksheet
via commands.

The command group Cells contains the following entries:

Cell size (width and height)

Use the lower field to specify the exact width of the column. To do so, enter the desired value in the input field.
Alternatively you can use the small arrow keys to increase or decrease the value.

With the field above you can set the height of the row accordingly.
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Optimum width (or optimum height)

The Optimum width button automatically adjusts the width of a table column to fit its contents.

You can use this command as follows:

§ If you select an entire column and choose this command, the width of the column will be adjusted to the cell
that needs the most space. 

Tip: The same can be achieved much faster by simply double-clicking on the column header.

§ If you select some cells within a row and then choose this command, only these cells will be used for the
calculation of the optimum column width. 

§ If you select some cells within a column and then choose this command, only these cells will be used for the
calculation of the optimum column width.

§ If an individual cell is selected and you choose this command, the column width will be adjusted to the
contents of that current cell.

The same applies to the Optimum height button, which allows you to automatically adjust the height of a row.

Showing and hiding rows/columns

You can hide rows/columns, thus they become invisible. This is useful if their content is not required at the
moment or should remain hidden.

Tip: If you enable sheet protection for the current worksheet, users will not be able to unhide hidden
row/columns in the worksheet. For more information, see also Sheet protection.

You can hide rows/columns as follows:

Using the row header to hide rows

The quickest way to hide rows is via their row header. Row headers are the buttons labeled with the row
number to the left of the worksheet.

For example, to hide row 14, drag the bottom border of its row header upwards with the mouse until the row
disappears completely.

The row is now hidden. Instead of its row header, a small triangle is displayed:

To show row 14 again, click on this triangle.
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Alternatively: Right-click on the row header to open the context menu. Here, you will find the commands Hide
and Show.

Hiding rows using the "Home | Visibility" button

You can also show and hide rows using the following ribbon commands:

Select the rows to be hidden, and choose the ribbon command Home | group Cells | Visibility | Hide rows.

The selected rows will be hidden.

To show them again, select the cell range that contains the hidden rows and choose Home | group Cells |
Visibility | Show rows.

Hiding columns

Hiding and showing columns works in the same manner. Here, you select the column headers and use the
ribbon commands Home | group Cells | Visibility | Hide columns and Show columns.

Number format
On the ribbon tab Home | group Number, you can change the number format of cells.

The number format determines how numbers are represented in these cells. If, for example, you enter the
number 12.3456 in a cell and then apply one of the "Currency" number formats to it, the number will be
displayed with the selected currency symbol and rounded to two decimal places (e.g. as €12.35).

Note: Numbers will only be displayed rounded, but they are actually not rounded. However, they still retain
all of their decimal places. To actually round numbers, use arithmetic functions like the ROUND function.

To change number formats of cells, you can either simply use the buttons of the command group Number
directly or open the dialog box of the command group Number  for additional options.

Applying common number formats directly via the buttons of the command group "Number"

Common number formats can be used via the buttons of the ribbon tab Home | group Number.

Here, you have the following options:
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§ In the top dropdown list, you will find different categories of number formats such as Default, Currency,
Accounting, etc. You can apply these directly via a mouse click. For detailed descriptions of the individual
formats, see List of number formats. 

If you would like to change additional settings, select More in this dropdown list to open the dialog box
with additional options (see below).

§ You can use the icon  to display a number directly as a percentage (multiplied by 100). Click on this icon
again to return to the default value. 

§ You can use the icon  to quickly convert a number into a currency value, for example, Dollar. Click on
this icon again to return to the default value.

§ With the two icons  and , you can easily increase or decrease the number of decimal places (the
numbers will only be displayed rounded, but they actually retain all of their decimal places).

Additional options: Via the dialog box of the command group "Number"

For advanced options (for example, custom number formats), use the dialog box. To do so, click on the group
arrow  in the bottom right corner of the ribbon tab Home | group Number.

Alternatively: Right-click to open the context menu and select the entry Cell.

In the following dialog box, switch to the Number format tab.

The following settings are available in the dialog box:
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§ Category 

Here, you can select the desired type of number format. For more information on the individual formats, see
List of number formats.

§ Format 

Some number formats also have several subtypes from which to choose. Select the desired subtype in this
list.

§ Decimal places 

Some formats allow you to specify the number of decimal places to be displayed.

Note: Numbers will only be displayed rounded, but they are actually not rounded. However, they still retain
all of their decimal places.

§ Thousands separator 

Some formats allow you to specify if numbers should be displayed with thousands separators (for example,
5,000,000) or without (for example, 5000000).

§ Negative numbers in red 

Some formats allow you to specify if negative numbers should be displayed in red.

§ Suppress minus sign 

Some formats allow you to specify if the minus sign of negative numbers should be suppressed.

§ Don't show zero 

Some formats allow you to specify if the content of cells containing the number zero should be suppressed.

When you confirm with OK, the numbers in the selected cells will be formatted accordingly.

List of all number formats

As described in the previous section, you can use the direct commands of the command group Number on the
ribbon tab Home to set the number format of a cell in order to determine how numbers should be displayed in
this cell. For advanced options, you can also open the dialog box by clicking on the group arrow  in the bottom
right corner of the command group Number.

The following number formats are available:

Default

This displays the number as it was entered.

More precisely: The number is displayed right-aligned; otherwise, no changes will be made to its formatting. It
is displayed with its actual number of decimal places (but with a maximum of five decimal places).

Example: 42



195Formatting worksheets

Number

This is the same as the Default number format, except that you can specify several formatting options (see
previous section, options of the dialog box). For example, you can set the number of decimal places to be
displayed.

Example: 42.00

Note: The number will only be displayed rounded, but it is actually not rounded. Thus, it still retains all of
its decimal places. To actually round the number, use arithmetic functions like the ROUND function.

Currency

This displays the number with a currency symbol and two decimal places.

Only available via the dialog box: You can select the desired currency from the dropdown list Currency.

Example: €42.00

Note: Depending on the country settings of your system, the display may differ.

Accounting

This is the same as the Currency number format (see above), except that numbers are displayed in accounting
format.

The difference to the currency format is that negative amounts have the minus sign in the left edge of the cell,
separated from the number. Currency symbols are also aligned flush with each other.

Example: -      €42.00

Note: Depending on the country settings of your system, the display may differ.

Date/Time

This displays the number as a date and/or time.

Only available via the dialog box: The dropdown list Format offers numerous different date and time formats,
depending on your system's regional settings.

Directly via the dropdown list of the command group Number:

§ Short date: The date is displayed in the 11/22/2018 format 

§ Long date: The date is displayed in the Thursday, November 22, 2018 format

§ Time: The time is displayed in the 22:30:00 format

Percentage

This displays the number as a percentage.
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Apart from adding a percent sign (%) to the number, the number will also be multiplied by 100 when displayed.
For example, 0.5 will be displayed as 50%.

Example: 4200%

Scientific

This displays the number in scientific notation.

Examples: 5E+03 (equals 5 * 10^3, which is 5000)

4.2E-01 (equals 4.2 * 10^-1, which is 0.42)

Fraction

This displays the number as a fraction.

Only available via the dialog box: The format of the fraction can be selected in the dropdown list Format.

Note: The number will be displayed as a rounded value if necessary. If, for example, you select the format
As halves and then enter the number 2.3, it will be displayed as 2 1/2.

Examples: 2 1/2

5 9/10

Boolean

This displays the number as a Boolean value (logical value).

If the number is zero, FALSE will be displayed. If it is any other value, TRUE will be displayed.

Examples: TRUE

FALSE

Text

This number format presents a special case: It forces PlanMaker to treat a number as text – not as a number.

The number will be left-aligned and displayed exactly the way it was entered. Unlike all other number formats,
numbers will not be automatically reformatted after they are entered. Leading zeros will not be removed; dates
will not be reformatted automatically, etc.

This can be useful, for example, when entering numbers with leading zeros (for example, phone area codes or
zip codes). If you enter a number like "00043682" into a cell, PlanMaker will usually remove the three leading
zeros automatically. If you first apply the Text number format to the cell, the leading zeros will not be removed.
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Caution: For compatibility reasons, this number format has been implemented in the same way as in
Microsoft Excel. Thus, it will lead to the same unexpected results in calculations:
If you apply this format, for example, to cells A1 and A2, the result of the calculation A1+A2 will be the sum
of these two cells. However, the calculation SUM (A1:A2) will return zero. The reason for this is that text
generally has the "value" zero for most calculation functions!

Custom

Only via the dialog box: This displays the number in a custom number format.

For more information, see the next section.

Working with custom number formats

If required, you can also define and apply your own number formats in the dialog box of the command group
Number on the ribbon tab Home.

Defining and applying a new number format

To create a new custom number format, proceed as follows:

1. Select the table cells to which you want to apply the new number format.

2. On the ribbon tab Home | group Number, click on the group arrow  in the bottom right corner to open the
dialog box, and switch to the Number format tab.

3. In the Category list, select Custom.

4. Click into the input field below Format.

5. Enter a text string that specifies the desired number format.

For a list of available format codes, see Structure of a custom number format.

6. Confirm with OK.

The number format is created (and also applied to the currently selected cells).

Tip: If you want to create a new number format that is similar to one of the predefined number formats, the
following tip can save you a lot of work: After opening the dialog box, first click on the desired predefined
number format in the Category list. This will transfer the corresponding format codes into the input field for
the format codes (step 5.). All you have to do now is make your desired changes, and that's it.

Applying a custom number format

Once created, a custom number format can be applied to as many other cells as you like. Proceed as follows:

1. Select the desired table cells.

2. Open the dialog box on the ribbon tab Home | group Number  and switch to the Number format tab.
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3. In the Category list, select Custom.

4. In the Format list, all custom number formats for the current document are displayed. Select the desired
format.

5. Confirm with OK.

The number format will now be applied to the selected cells.

Deleting a custom number format

If you no longer need a specific custom number format, you can delete it at any time. Proceed as follows:

1. Open the dialog box on the ribbon tab Home | group Number  and switch to the Number format tab.

2. In the Category list, select Custom.

3. In the Format list, select the format to be deleted.

4. Click on the Delete button.

5. Close the dialog box (preferably using the Cancel button, since clicking on OK would apply the currently
selected format to the current cell).

Note: The Delete button is only available for custom number formats. You cannot delete any of the predefined
number formats.

Structure of a custom number format

When you create a new number format (as described in the previous section), you have to enter a text string
containing format codes. These codes specify how numbers are displayed.

An example:

#.00

These codes will cause numbers to be displayed as follows: All digits to the left of the decimal point, then a
decimal point, then exactly two digits to the right of the decimal point.

The following format codes are available:

Format codes for numbers and text

To format numbers and text, you can use the following format codes:

Code Result

# Display a single digit of the number. Display nothing if there is no digit at this position of the number.

Example: #.## applied to the number 1.2 returns 1.2.

0 Display a single digit of the number. Display a zero if there is no digit at this position.

Example: #.00 applied to the number 1.2 returns 1.20.
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? Display a single digit of the number. Display a space if there is no digit at this position.

Example: #.?? applied to the number 1.2 returns 1.2  (with a space behind the 2).

Important: If at least one of the above three codes is located to the left of the decimal point, all digits
to the left of the decimal point will be displayed. Example: 0.00 applied to the number 123.456 will
not return 3.46, but 123.46.

. (period) Display a decimal separator at this position.

Note: If your system uses a different character (for example, a comma) as a decimal separator instead
of a period, please use this character instead of a period.

, (comma) Display the number with a thousands separator. This code can be placed at an arbitrary position in the
format string: ,0.00 applied to the number 5000000 returns 5,000,000.00.

Note: If your system uses a thousands separator other than a comma, use the corresponding character
instead of a comma.

% Display a percent sign at this position and multiply the number by 100.

Example: 0% applied to the number 0.5 returns 50%.

E+ or e+ Display the number in scientific notation.

Example: 0E+00 applied to the number 50000 returns 5E+04.

Tip: Engineering notation (using only exponents that can be divided by 3) is also available. For
example, #00E+00 applied to the number 50000 returns 50E+03 rather than 5E+04.

E- or e- Same as E+, except that the exponent's sign is only displayed if it is negative. (It is always displayed
for E+.)

Example 1: 0E-00 applied to the number 50000 returns 5E04.

Example 2: 0E-00 applied to the number 0.0005 returns 5E-04.

General Wildcard for the entire cell content (formatted with the "Default" number format)

@ Wildcard for the entire cell content as text

\ Do not try to interpret the following character, just display it.

Example: To output a # character, use the code \# (since the # sign is a valid format code).

"Text" Do not interpret the text between the quotation marks as format code, just display it.

Example: "MyText"

* (asterisk) Repeat the following character. For example, *x fills the entire cell with the character "x".

Example: The format code "Total:"* 0.00 displays the text "Total:" at the left of the cell and the
number (with two decimal places) at the right. The space in between is filled with blanks.

_ (underscore) Display a space that is as wide as the following character.

Example: _- returns a blank space that is exactly as wide as a minus sign.

[Red] Display the cell content in red. Other color codes which are available:

[Black] [White] [Red] [Green] [Blue] [Cyan] [Magenta] [Yellow]
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Format codes for dates and times

For dates/times, only the following format codes are valid:

Note: The format codes listed below are case-sensitive!

Code Result

D Day (1-31)

DD Day, with 2 digits (01-31)

DDD Name of day, abbreviated ("Sun" to "Mon")

DDDD Name of day ("Sunday" to "Monday")

M Month (1-12)

MM Month, with 2 digits (01-12)

MMM Name of month, abbreviated ("Jan" to "Dec")

MMMM Name of month ("January" to "December")

MMMMM Name of month, first letter only ("J" for January to "D" for December)

YY Year, with 2 digits (e.g., 18)

YYYY Year, with 4 digits (e.g., 2018)

Q Quarter (1-4)

QQ The word "quarter" in the language that is set in the system’s regional settings 

h Hour (0-23)

hh Hour, with 2 digits (00-23)

m Minute (0-59)

mm Minute, with 2 digits (00-59)

s Second (0-59)

ss Second, with 2 digits (00-59)

0 Tenths of a second (for example, hh:mm:ss.0)

00 Hundredths of a second (for example, hh:mm:ss.00)

000 Thousandths of a second (for example, hh:mm:ss.000)
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AM/PM Display times in 12-hour format (with AM or PM). This has to be placed at the end of the format
codes!

Example: h:mm:ss AM/PM

am/pm Same as AM/PM, but with am or pm (lowercase)

a/p Same as AM/PM, but with a or p

[h] Number of hours in "endless" time format*

[m] Number of minutes in "endless" time format*

[mm] Same as [m], but with 2 digits*

[s] Number of seconds in "endless" time format*

[ss] Same as [m], but with 2 digits*

[$-n] Optional: This lets you specify the country code of the language to be used for day and month names.
If you do not specify a country code, PlanMaker automatically uses the system's default language.
Example: [$-409] represents English (US).

* The "endless" time format is characterized by the fact that it does not reset times to 0:00 after 24 hours. This is particularly useful for calculations with
times. For example, when you add 20:00 and 5:00, the result would normally be 1:00. If you format this calculation as [h]:mm, however, the result will
be 25:00.

The endless time format also supports negative time values. For example, 7:00 - 10:00 does not result in 21:00, but in -3:00.

The same applies to minutes and seconds, which are also not reset after 60 minutes/seconds. Thus, you can even use the endless time format to convert
times to minutes or seconds. For example, when you format 02:00:00 as [mm]:ss, 120:00 will be displayed, as there are 120 minutes in 2 hours. When
you format it as [s], 7200 (the number of seconds) will be displayed.

Defining separate sections for positive numbers, negative numbers, zero and text

If required, you can split the text string with the format codes into up to four sections (separated by
semicolons). This allows you to define your own number formats for positive numbers, negative numbers, the
number zero and text – as follows:

Positive; Negative; Zero; Text

The number of sections that you include has the following effect:

Number of sections Effect

Only 1 section: The format codes apply to all values.

2 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

3 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

The codes in the 3rd section apply to the number zero.
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4 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

The codes in the 3rd section apply to the number zero.

The codes in the 4th section apply to text.

Example (with two sections):

0.00; -0.00[Red]

This number format has the following effect:

1st section: 0.00 causes positive numbers to be displayed with two decimal places.

2nd section: -0.00[Red] causes negative numbers to also be displayed with two decimal places. A minus sign is
displayed in front of the number (see note!). The number is also colored in red.

Note: If you define a number format with two (or more) sections and you want negative values to be
displayed with a minus sign, you must include a minus sign in the section for negative numbers.

For number formats with only one section, the minus signs are automatically displayed for negative numbers,
even without explicitly defining them in the number format.

Defining separate sections using conditions

Alternatively, you can split the text string with the format codes into multiple sections by specifying a condition
for each section.

The individual sections must by separated by semicolons. To define the conditions, simply add the desired
comparison operation enclosed within square brackets to each section – for example, conditions such as [>0] or
[>=100] or [=42].

You can define up to two sections with conditions. After these sections, you should add an additional section
without a condition, which will then define the number format for those values that do not meet any of the
conditions.

An example:

[<=0][Blue]0.00; [>30][Red]0.00; 0.00

These format codes display all values smaller than or equal to zero in blue – and values larger than 30 are
displayed in red. If neither of the two conditions applies, the value is displayed in black.

Tip: "Conditional formatting" provides a much more convenient and powerful method for performing such
tasks. For more information, see Conditional formatting.
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Borders
You can use the ribbon command Home | group Format | Borders to completely surround cells with borders
or add individual lines to cells. Gridlines (the lines between the cells) can also be applied here.

Common border lines: Via the icon of the command group "Format"

A selection of common border lines can be found via the icon Borders  under Home | group Format.

Proceed as follows:

1. Select the desired cells.

2. Click on the icon's arrow for the dropdown menu and select an entry with the desired properties by clicking
on it.

Note: You can also combine individual lines to your liking by reopening the dropdown menu of the Borders
icon and adding another attribute, for example, first positioning a line at the top and then an additional line
at the bottom.

The table cells are now provided with the relevant lines.

Tip: If you then want to add exactly the same type of border to other cells, simply select them and click on the icon itself (not the arrow).
PlanMaker will then reapply the most recently selected type of border.

Removing border lines: Click on None in the dropdown menu. All border lines will then be completely
removed.

If you want to edit/remove individual border lines or define additional properties for borders and lines, click on
Borders in the dropdown menu. A dialog box opens with other options (see below).

Other options: Via the dialog box

For additional options, such as the color or different thickness of lines, there are various options available in the
dialog box.

You open the dialog box by clicking on the arrow of the icon  and selecting Borders in the dropdown
menu.

Alternatively: On the ribbon tab Home | group Alignment, click on the group arrow  and switch to the
Borders tab.
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Essentially, you use this dialog box as follows:

1. First, you specify what type of border line you want to apply (line style, thickness, color).

2. Then specify where this type of border line should be placed. To do so, simply click on the desired lines (or
their buttons) in the right half of the dialog box.

Let's take a closer look at the individual steps:

To add border lines to cells, for example, proceed as follows:

1. Select the desired cells.

2. On the ribbon tab Home | group Alignment, click on the group arrow  for the dialog box and switch to the
Borders tab.

3. First, specify what type of border line you want to apply. You have the following options:

Line style (single, double or dashed lines)

Thickness of the line

Color of the line

Note: In addition to the colors offered here, you can define new colors at any time. For more information, see Document properties,
Colors tab.

4. Then specify where you want to apply this type of border line (top, bottom, left, right, etc.).
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For this purpose, a preview box surrounded by a set of buttons is available in the right half of the dialog box.
Use it as follows:

A. In the preview in the right half of the dialog box, simply click directly on all lines to which a border line
is to be applied. 

B. Alternatively, you can use the buttons that are displayed to the left and below the preview for this
purpose. Each button represents a specific line (see icon on the button).

C. The buttons above the preview are useful shortcuts:

The Outline button applies the currently set border line to all outer borders.

The Inside button does the same for all inner lines (the "gridlines" between the cells).

The None button removes all lines at once.

5. If required, you can add as many lines as you like by simply repeating step 4.

Of course, you can always change the line style, thickness or color (step 3) before applying it (step 4).

6. When everything is as required, confirm with OK.

The table cells are now provided with the relevant lines.

Editing or removing existing border lines in the dialog box

You can change the style, thickness or color of existing border lines or also remove them at any time. To do so,
open the dialog box again and proceed as follows:

§ Changing: To change the appearance of a line, first select the desired settings (style, thickness, color). Then,
in the preview, click on the line (or its button) to which you want to apply these settings. 

§ Removing: To remove a border line, click on that line (or its button) twice in the preview. Clicking once
applies the border line, while clicking it again removes it. 

Tip: The None button displayed above the preview removes all lines at once.

Shading
You can use the ribbon command Home | group Format | Shading to apply a colored shade or pattern to cells.

Applying directly via the icon of the command group "Format"

If you click on the small arrow next to the icon  Shading, the program will open a dropdown menu with
Standard colors and Color variations. You can apply these directly to the selected cells by hovering over the
colors with the mouse cursor (you can see the effect on the cell in the preview) and then clicking on the desired
color.

Tip: The last selected color is displayed in the icon as a small horizontal bar. If you want to apply the same color to other cells, simply
select them and click on the icon itself (not the arrow). PlanMaker will then reapply the last selected color.
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This also applies to other shading settings, such as Patterns or Shades, which you can only find in the dialog box. You open the dialog
box by clicking on the icon's arrow and choosing More. Detailed information on the options of the dialog box can be found below.

Removing shading: Click on Transparent in the dropdown menu to remove existing shading.

Other options: Via the dialog box

The dialog box contains additional shading options. The option Shades allows you to mix colors individually,
and you can also apply different Patterns in the dialog box.

You open the dialog box by clicking on the arrow of the icon  and choosing More in the dropdown menu.

Alternatively: On the ribbon tab Home | group Alignment, click on the group arrow  and switch to the
Shading tab.

In the dialog box, proceed as follows:

1. Select the desired cells.

2. On the ribbon tab Home | group Alignment, click on the group arrow  for the dialog box and switch to the
Shading tab.

3. Apply the desired shading (see below).

4. Confirm with OK.

You can choose between the following types of shading:
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§ Adding a shade 

A shade is a color shading that is mixed from the selected foreground color and background color.

To add a shade, set the Type to Shading and then make the desired settings:

First, set the desired Foreground and Background colors. (The background color is set to white by
default.)

In the section Shades, different mixtures of these two colors are now offered. Select one of these
suggestions. Alternatively, you can enter an exact percentage for the shade in the input field under Shading.
Values between 0 (100% background color) and 100 (100% foreground color) are allowed.

§ Adding a pattern 

To add a pattern, click on one of the patterns in the section Patterns.

You can also select a different Foreground and Background color for the pattern.

§ Removing a shade or pattern 

If you want to remove existing shades or patterns, select None for Type.

Then confirm with OK.

Alignment
On the ribbon tab Home | group Alignment, you can specify the alignment of the cell contents within the cell.

Before you execute the commands, you must first select the desired cells. To change a single cell, simply
navigate to it.

Then proceed as follows:

Aligning directly via the icons of the command group "Alignment"

Most of the options for aligning cell contents can be applied directly via the icons on the ribbon tab Home |
group Alignment.

The following functions are available here:

Icon   Function

Top vertical alignment: Align the cell content with the top edge of the cell.
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Centered vertical alignment: Align the cell content vertically with the center.

Bottom vertical alignment: Align the cell content with the bottom edge of the cell.

Justified vertical alignment: The cell content is evenly distributed between the top and bottom cell border (only
affects cells that contain multiple lines of content and have the option Wrap text enabled).

Rotate: Here, you can rotate the entire cell (including its contents) around the selected angle. The command
Stacked corresponds to the option Vertical text in the dialog box (see below): The cell content is not read from left
to right, but from top to bottom. To disable it, click on Stacked again.

Wrap text: The cell content will be automatically wrapped to the next line (inside the cell) if the cell width is
insufficient to display it in a single line.

Merge cells: This option lets you merge a cell with its neighboring cells. PlanMaker treats merged cells as if they
were one single cell. To do so, select the cell and any number of directly adjacent cells, and click on the icon itself
to merge the cells.

Note: Whenever you merge cells, the content of all selected cells is automatically deleted – except for the cell in
the upper left corner of the selected range.

To split merged cells, click on the icon again.

If you click on the icon's arrow, you can choose from various options for merging cells:

Merge cells: This corresponds to clicking on the icon itself, and all selected cells are merged normally.

Merge and center: The selected cells are merged and the cell content is centered horizontally over several
columns (vertically at the bottom).

Merge and turn on line wrap: Cells are merged while wrapping the cell contents in the created merged cell.

If you selected cells across multiple columns and rows, you can choose between the commands Merge by row or
Merge by column to merge the selected cells to only one column or only one row.

Here in the menu also, you can use the entry Split cells to separate merged cells.

Default horizontal alignment: Text is left-aligned, numbers are right-aligned. Logical values and error values are
centered.

Left horizontal alignment: Align the cell content with the left edge of the cell

Centered horizontal alignment: Align the cell content centered

Right horizontal alignment: Align the cell content with the right edge of the cell

Justified horizontal alignment: The cell content is evenly distributed between the left and right cell border (only
affects cells that contain multiple lines of content and have the option Wrap text enabled)

Most of these options can also be found in the dialog box of the command group Alignment (see below). In
addition, the options enabled via the direct ribbon commands are displayed as enabled in the dialog box. If, for
example, the ribbon command Wrap text is enabled for a cell, a check mark also appears in the dialog box in
front of the option Wrap text.
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Shortcut keys

There are also shortcut keys for horizontal alignment:

Command Windows/Linux Mac

Left align Ctrl+L Cmd+L

Center Ctrl+E Cmd+E

Right align Ctrl+R Cmd+R

Justify Ctrl+J Cmd+J

Aligning via the dialog box of the command group "Alignment"

You open the dialog box on the ribbon tab Home by clicking on the group arrow  in the bottom right corner of
the command group Alignment. In the dialog box, you will find additional options that cannot be set directly
via the icons of the command group Alignment as described above (for example, Inner margins).

The dialog box contains the following options on the "Alignment" tab:
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Horizontal alignment

This determines the horizontal alignment of the cell content within the cell boundaries:

Default: Text left-aligned, numbers right-aligned, and logical values and error values centered

Left: Align the cell content with the left edge of the cell

Centered: Align the cell content horizontally with the center

Right: Align the cell content with the right edge of the cell

Justified: The cell content is evenly distributed between the left and right cell border (only affects cells that
contain multiple lines of content and have the option Wrap text enabled)

Center across columns: The content of one cell is centered across multiple columns. For this purpose, select
the cell and any number of adjacent cells to the right of it (these cells have to be empty!). Then select the
Center across columns alignment.

Vertical alignment

This determines the vertical alignment of the cell content within the cell boundaries:

Bottom: Align the cell content with the bottom edge of the cell

Centered: Align the cell content vertically with the center

Top: Align the cell content with the top edge of the cell

Justified: The cell content is evenly distributed between the top and bottom cell border (only affects cells that
contain multiple lines of content and have the option Wrap text enabled).

Rotate by ...

Here, you can rotate the entire cell (including its contents) around the selected angle.

Text direction

For text in Arabic script, you can change the text direction of the cell to right-to-left here. If you select the
default setting Context-sensitive, PlanMaker sets the correct writing direction automatically.

For more information, see also Working with Arabic text.

Inner margins

Here, you set the inner margins of cells.

Line break

If this option is enabled, the cell content will be automatically wrapped to the next line if the cell width is
insufficient to display it in a single line.

By default, this option is disabled.
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Tip 1: You will also find this option via the context menu by right-clicking on a selected cell.

Tip 2: You can use the key combination Ctrl+¿ to wrap to the next line manually.

Vertical text

If this option is enabled, the cell content will be displayed vertically (top to bottom instead of left to right).

Merge cells

This option lets you merge a cell with adjacent cells. To do so, select the cell and any number of directly
adjacent cells and enable this option.

PlanMaker treats merged cells as if they were one single cell.

Note: Whenever you merge cells, all cells except the upper left cell lose their contents.

To split merged cells, select them again and disable this option.

Protection
On the Protection tab of the dialog box Cell, you can provide cells with cell protection, hide cell contents or
formulas or disable printing.

Open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Home | group
Alignment (or group Number). Switch to the Protection tab.

Alternatively, open the dialog box by right-clicking on the selected cells for the context menu and select the
entry Cell.

For more information, see Sheet protection.

Character format
You can use the commands on the ribbon tab Home | group Character to change the character format (such as
font, font size, font color, text styles, etc.).

The effect of this command depends on what you selected before you chose it:

§ If you do not select anything specifically, the command will affect the cell on which the cell frame is
currently located. 

§ If you select multiple cells, all selected cells will be affected by the change.
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§ You can also press the F2 key in a cell and then select characters within the cell content, which will only
change the selected characters.

Common commands: Via the icons of the command group "Character"

Frequently used settings can be made directly via the icons of the command group:

§ Font and font size 

§ Text styles (bold, italic, underlined)

§ Font color

Additional options: In the dialog box of the command group "Character"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character, the
program opens a dialog box in which you will find additional options for character formatting.

The displayed dialog box has several tabs that you can switch between by clicking on one of the tab headers.
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The individual tabs contain the following formatting options:

§ Font tab 

For selecting properties like Font and font size, Text styles (bold, italic, underlined, etc.), Font color (and
background color)

§ Spacing tab 

For changing properties like Superscripts and subscripts, Letter spacing and character pitch, and
enabling/disabling Kerning

§ Hyperlink tab 

For inserting and editing hyperlinks (for example, to web pages). For more information, see Using
hyperlinks.

For more information on formatting, see the following pages.

Font and font size

To change the font or font size, see the commands on the ribbon tab Home | group Character. Proceed as
follows:
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Via the buttons of the command group "Character"

1. Select the desired cells or text.

Android/iOS: If you are using these versions, please note that selecting cell contents works slightly
differently there. For more information, see Selecting cells and cell content.

2. Click on the small arrow to the right of Font or Font size.

3. Set the desired font and font size:

Font: Select the desired font from the dropdown list via a mouse click.

Font size: The dropdown list offers the most common font sizes, which you can select via a mouse click.
However, you can enter a different size manually at any time. Font sizes can be entered with a precision of a
tenth of a point – thus font sizes such as 12.7 are also allowed.

Tip: The icons  in the group Character can be used to increase or decrease the font size by one
level.

In the dialog box of the command group "Character"

If you only want to change the font and font size, these options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to use other character
formatting options that are not available as buttons.

On the ribbon tab Home | group Character, you open the dialog box via the group arrow  in the lower right
corner and select the Font tab in the dialog box.

Text styles

Text styles are character formatting options such as bold, italics, etc.

PlanMaker offers the following text styles:

§ Italic: A slanted variant of the font. 

§ Bold: A stronger ("more pronounced") variant of the font.

§ Underline: The text is underlined (single, double, words only single, words only double, etc.).
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§ SMALL CAPS: Smaller uppercase letters are used instead of lowercase letters.

§ ALL CAPS: All letters are output as uppercase letters.

§ Strikethrough: The text is struck through.

§ Superscripts and subscripts: for example, r2 and H2O. For more information, see Superscripts and

subscripts.

Note: The 4 latter options are only available via the dialog box of the command group "Character" and not directly via the icons of
the command group.

Common commands: Via the icons of the command group "Character"

The most common text styles can be applied on the ribbon tab Home | group Character directly via the icons
of the group.

To apply text styles, proceed as follows:

1. Select the desired text.

2. Click on the icon for the text style you would like to enable or disable: B stands for bold, I for italics and U
for simple underlining.

Text styles can be combined (almost) as desired.

Other options: Via the dialog box of the command group "Character"

For additional text styles that you cannot find via the buttons (e.g. SMALL CAPS), open the dialog box.

On the ribbon tab Home | group Character, click on the group arrow  in the bottom right corner and switch to
the Font tab in the dialog box.

§ In the area Styles, you will find small caps, all caps and strikethroughs. These can be enabled or disabled
there via a simple mouse click. 

§ In the area Underline, you can use the dropdown list to choose between different options for underlined
text.

§ To enable bold and/or italics, open the dropdown list Style (to the right of font size) and select the desired
entry: Regular, Italic, Bold or Bold Italic. 

Shortcut keys

There are also shortcut keys for some text styles:
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Command Windows/Linux Mac

Bold Ctrl+B Cmd+B

Italic Ctrl+I Cmd+I

Underline Ctrl+U Cmd+U

Font color

You can color both text and its background.

The commands for this can be found on the ribbon tab Home | group Character.

Font color: Via the icon of the command group "Paragraph"

For the Font color , proceed as follows:

1. Select the desired cells or text, and click on the small arrow to the right of the icon (thus, not on the icon
itself).

2. Select the desired color from the dropdown menu.

Tip: To format more text in the same color, select the text and then click on the icon itself because the last
color used will be applied again.

The Font color can be found both as a direct button in the command group and in the dialog box. The
Background color, however, can only be changed via the dialog box (see below).

Background color: In the dialog box of the command group "Character"

Insofar as only the font color is concerned, the selection in the dialog box corresponds exactly to the button
described above. However, in addition to the font color, you can also change the background color in the
dialog box.

Proceed as follows:

1. Select the desired cells or text.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character. In the
dialog box, switch to the Font tab.

3. Open the dropdown list Background color and select a different color instead of the default Transparent.
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The text is highlighted with this color.

Tip: If you change the background color in this manner, it will only affect the individual characters within
the cell. If you want to color the entire cell, however, you should use the ribbon command Home | group
Format | Shading instead.

Notes

Color lists only offer a few standard colors, but you can always compose your own colors. To do so, click on
the entry Define color... at the end of the dropdown list. (For more information, see also Document properties,
Colors tab.)

Superscripts and subscripts

You can also add a superscript to characters (for example, r2) or a subscript to characters (for example, H2O).

The commands for this can be found in the dialog box of the ribbon tab Home | group Character.

Proceed as follows:

1. Select the desired cells or text.

If you only want to change individual characters within a cell, first press the F2 key to select individual
characters.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character.

3. In the dialog box, switch to the Spacing tab.

You can now enable the options Superscript or Subscript.

If required, also enter the percentage of the superscript or subscript text for Position. You can also use a
percentage in the field Size to determine how much the font size should be reduced. For example, enter 100
percent if you do not want the font to be reduced.

Shortcut keys

You can apply superscript/subscript even faster via the following shortcut keys:

Command Windows/Linux Mac

Superscript Ctrl+Shift+(Num+) Cmd+Shift+(Num+)

Subscript Ctrl+Shift+(Num-) Cmd+Shift+(Num-)

Remove superscript or subscript Ctrl+Shift+(Num*) Cmd+Shift+(Num*)

Note: (Num+) (Num-) (Num*) represent the keys on the numeric keypad, usually located on the right side of the keyboard.
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Tip for Windows users: If you simply want to insert a superscript square number (m2) or cubic number (m3)
directly, the key combination AltGr+2 or AltGr+3 is also available. Use the number bar above the letters
rather than the numbers on the numeric keypad.

Letter spacing and character pitch

You can even change the letter spacing and character pitch in PlanMaker.

Letter spacing is the horizontal distance between characters. If values are less than 100%, the characters are
closer together. For values greater than 100%, the characters are further apart.

Changing the character pitch changes the width of the characters themselves rather than the distance between
them, thus the characters are distorted.

To change these settings, click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enter the required values for Letter spacing or
Character pitch.

Note: Some printers do not support changing the character pitch for internal printer fonts. The font then
appears wider or narrower on the screen, but not on the printout.

Kerning

Certain pairs of letters look better when the spacing between these letters is reduced or increased a bit. Such
adjusting is known as kerning.

The following figure illustrates what is meant by kerning:

Above: without kerning. Below: with kerning

The upper text (without kerning) shows that the letters "V" and "A" are usually too far apart. This was
corrected for the lower text (with kerning).

This adjusting occurs fully automatically. All you have to do is enable kerning:

1. Select the desired cells (or the desired text).

2. On the ribbon tab Home | group Character, click on the group arrow  to open the dialog box and switch to
the Spacing tab.
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3. Enable the option the Use kerning.

PlanMaker now automatically adjusts the spacing between all letters where this would improve the text
appearance.

Note: Not all fonts provide kerning information in their font data. This information is required to determine
which letter pairs to adjust and how. Almost all font collections published by SoftMaker include extensive
kerning information.

Resetting the character formatting

PlanMaker allows you to remove character formatting at any time. Proceed as follows:

1. Select the desired cells or text.

2. On the ribbon tab Home | group Contents | Delete , choose the command Reset character formatting.

PlanMaker now removes any character formatting that you have applied via the dialog box or the buttons on the
ribbon tab Home | group Character.

Note: In the dialog box of the ribbon tab Home | group Character , you will also find a Reset button on each
tab. However, the use of this button differs from the above function: You can only use it to undo all changes
made in the open dialog box provided that you have not yet confirmed them with OK.

If the changes have already been confirmed with OK, they can only be undone via the Reset character
formatting icon described above.

Paragraph format (text frames only)
If you have inserted text frames into your worksheet, you can change the paragraph formatting (line spacing,
indents, etc.) of the included text at any time. For this purpose, use the commands of the ribbon tab Home |
group Alignment.

Note: The "Paragraph" dialog box, which appears by clicking on the group arrow  on the ribbon tab Home |
group Alignment, is only available in text frames. For more information on working with text frames, see
Text frames.

Paragraph formatting includes the following options:

§ Paragraph indents 

§ Line spacing

§ Paragraph alignment
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§ Spacing above/below a paragraph

§ Hyphenation frequency (see Hyphenation)

For more information on these topics in the above order, see the following pages.

Paragraph indents (text frames only)

Note: Paragraph indents can only be applied to text inserted into a text frame. To indent text in table cells,
you can use the option Inner margins on the Alignment tab when you open the dialog box of the ribbon tab
Home | group Alignment . Please note: A different dialog box will open depending on whether you are in a
text frame or in a table cell.

You can use indents to change the left and right margins of paragraphs in text frames to move text in or out.
The indent for the first line of a paragraph can be specified separately.

To use indents, select the desired paragraphs in the text frame. Then open the dialog box by clicking on the
group arrow  of the ribbon tab Home | group Alignment.

Alternatively, open the dialog box by right-clicking on the selected text and selecting the entry Paragraph.

In the Indents section, you can set the Left indent, the Right indent and the First line indent of a paragraph.
Enter the desired values here. Negative values are also possible for the First line indent.

Line spacing (text frames only)

Note: Line spacing can only be changed for text inserted into a text frame.

Line spacing determines the spacing between the individual lines of a paragraph in a text frame.

To change the line spacing, proceed as follows:

1. Place the text cursor in the desired paragraph of the text frame (or select several paragraphs).

2. Open the dialog box by clicking on the group arrow  of the ribbon tab Home | group Alignment.

You will find the options for changing the line spacing in the section Line spacing:

3. First, use the dropdown list to select the method you want to use to specify the line spacing (see below).

4. Then enter the spacing in the edit box to its right.

When you confirm with OK, the line spacing will be changed according to your settings.

Methods of specifying the line spacing

In the dropdown list Line spacing, you can choose which method to use to define the line spacing.
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The list has the following entries:

§ Single: Automatic single line spacing 

Here, the optimum line spacing is determined automatically:

If you increase the font size in the paragraph, the line spacing will be increased accordingly.

If you decrease the font size, however, the line spacing will be decreased automatically.

§ Multiple: Multiple automatic line spacing 

This corresponds to the option Single and thus also provides automatic line spacing. However, you can
simply increase or decrease line spacing if necessary by specifying the desired number of lines in the input
field to the right of this option.

Some examples:

Enter "1.5" for lines to obtain one and a half times the automatic line spacing.

Enter "2" to get twice the automatic line spacing.

Enter "1" to get automatic single line spacing (corresponds to selecting the option Single).

§ Exactly: Exact line spacing 

Here, you can set the line spacing to an exact value in points. Here, the line spacing will not be
automatically adjusted to the font size.

§ At least: Automatic line spacing with a given minimum 

This setting corresponds to the option Single, but prevents any reduction below the specified minimum
value.

Thus if you enter 12 points as the minimum value, the program uses automatic single line spacing by default.
If the automatic line spacing is less than 12 points (because you are using a very small font size), an exact
line spacing of 12 points is used instead.

By default, the line spacing is set to Single.

Paragraph alignment (text frames only)

On the ribbon tab Home | group  Alignment, you can also change the alignment of text paragraphs that were
inserted into a text frame.

The following types of paragraph alignment are available:

§ Left align 
§ Center
§ Right align
§ Justify (distribute words evenly between the left and right margins)

You can adjust the paragraph alignment directly using the icons under Home | group Alignment:
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Alternatively, you can use the path via the dialog box by clicking on the group arrow  under Home | group
Alignment. In the open dialog box, you will find the corresponding commands in the Alignment list.

Changing the text direction (for Arabic script)

For text in Arabic script, there is an additional option called Text direction, which allows you to change the
text direction of the paragraph to right-to-left. For more information, see also Working with Arabic text.

Spacing above/below a paragraph (text frames only)

Note: The spacing above/below a paragraph can only be set for text that was inserted into a text frame. To
set the spacing between cells, you can change their row height at any time.

In addition to line spacing, you can also define how much space should be kept above the first line and below
the last line of a paragraph for text in a text frame.

To do so, open the dialog box by clicking on the group arrow  of the ribbon tab Home | group Alignment. The
following options are available in the Paragraph spacing section:

Option Result

Before Here, specify how much spacing should be maintained from the end of the previous paragraph.

After Here, you can enter the spacing that PlanMaker should maintain up to the start of the next paragraph.

Note: These values do not affect the amount of space between lines within a paragraph (see Line spacing).
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Character styles
You can use the command Character style, which can be accessed via the context menu, to create and modify
"character styles".

In a character style, you can save a frequently used character format (font, font size, text styles, etc.) and then
apply it repeatedly to any characters or entire cells.

If, for example, you want to regularly print small print sections in a different font and smaller size, simply
create an appropriate character style – lets call it "Small print" – and apply it to the desired text passages.

Note: In PlanMaker you can also apply cell styles (see Cell styles). The difference to character styles is that
character styles only store the character format, whereas cell styles store both character format and cell format
(number format, alignment, borders, etc.). Furthermore, character styles are also applicable to individual
characters within a cell, while cell styles are applicable only to entire cells.

For more information, see the following pages.

Creating character styles

To create a new character style, proceed as follows:

1. Double-click on a cell (alternatively: press F2).

2. Right-click to open the context menu and select the entry Character style.

3. A dialog box opens. In the list on the left side of the dialog box, select the style on which you want your new
character style to be based. In the event of doubt, use the "Normal" style.

Note: The style of the character in which the text cursor was located before choosing the command Character style is always
preselected here in the dialog box. For more information, see "Based on" character styles.

4. Then click on the New button.

5. Give the character style any name you like and confirm with OK.

6. The program will display a dialog box, which is very similar to the dialog box for the ribbon tab Home |
group Character . Here, you can specify the desired character format for this style (see Character format).

7. Once all the desired settings have been made, click on OK to define the style.

8. Exit the dialog box "Character style" with Close.

The new character style is now defined and ready for use. To learn how to apply character styles, see the next
section.
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Using shortcut keys

If you need a style frequently, you can assign it a shortcut key at any time. The advantage of this is that you can
then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, proceed as follows:

Perform steps 1. to 5. as described above. In the dialog box on the Style tab, position the text cursor in the
Shortcut key input field and press the desired key combination (starting with Ctrl or Alt).

Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even one
of PlanMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since these are not
usually assigned.

Applying character styles

To apply a character style, proceed as follows:

1. Double-click on the cell and select the desired characters within the cell.

2. Right-click to open the context menu and select the entry Character style.

3. In the dialog box, select the desired style.

4. Click on Apply.

The formatting of the selected characters immediately changes to that which you specified in the character
style.

Tip: If you have assigned a shortcut key to the style, you can apply the style even faster: Select the desired
cell contents and press the assigned key combination.

Changing character styles

Of course, you can change character styles again at any time.

Important: When you change the formats stored in a character style, all cells using this style are changed
accordingly. However, this automatic reformatting applies in a limited way to characters where you manually
changed the formatting after you assigned the style (see next section).
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To change a character style, proceed as follows:

1. Double-click on a cell.

2. Right-click to open the context menu and select the entry Character style.

3. Click on the Edit button in the dialog box.

4. Make the desired changes to the style.

5. Click on OK.

6. Exit the dialog box with Close.

Deleting or renaming character styles

The Delete button in the dialog box of the command Character style deletes the selected style in the current
document. To give a style a new name, click on Rename and type the new name. This also only affects the
current document.

Note: After you delete a character style, the formatted characters retain their formatting. These characters are now directly assigned the
character style on which the deleted style was based. For more information, see "Based on" character styles. Those formatting options
that were explicitly set in the deleted style and now remain with the characters of the document are treated as if the characters were
formatted manually – and are thus retained even if you change formatting later in the style.

Deleting or renaming character styles in a document template

To delete or rename the styles in a document template, open the document template, make the changes there
and save the template.

Scope of character styles

Did you change a character style and nothing happened in some places that were assigned this style? This
happens because these sections of text were subsequently reformatted manually.

An example:

Let's assume that you define a style with the Arial font and apply it. If, for example, you now change the style's
font to Times New Roman, all characters that are formatted in this style will change accordingly.

However: If you subsequently selected a completely different font for some of these characters via the
command group Home | Character, the change to the character style no longer affects these characters. That is
to say, manually applied character formatting takes precedence over styles.

If you want the affected characters to be "freed" from their manual formatting, choose the command Reset
character formatting on the ribbon tab Home | group Contents | Delete. The characters now have the
formatting specified in the character style again.
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"Normal" character style

The character style called "Normal" is present by default in every document and has a special significance: it is
the default style for all cell contents. When you start typing something in a new document, the "Normal"
character style is automatically used for it.

If you change the "Normal" character style – for example, the font – the font for all cells will be changed
(except for cells that you have formatted manually in a different font via the ribbon tab Home | Character).
Furthermore, subsequent entries will appear in this default font which you have redefined as the "Normal"
character style for the document.

"Based on" character styles

When you create a new character style, as described at the beginning of this chapter, it is usually based on the
"Normal" character style. This means that the new character style is based on the formatting of the "Normal"
style. Changes to the formatting of the "Normal" style thus affect all other styles.

If you have already created character styles and used them in the document, the following happens when you
choose the command Character style: In the list on the left side of the dialog box, the style of the currently
selected character is selected – this may be the "Normal" character style or another one – and is thus also preset
as the basis for a new style. In the list, change the style that you want to use as the basis for a new character
style, if necessary, before clicking the New button.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

If, for example, you select a new font for the "Normal" style, the font will also change in all other character
styles – unless a different font was explicitly selected there.

In addition, you can reassign the style basis to a character style at any time with the option Based on.

To have a character style based on a style other than the one you previously selected, proceed as follows:

1. Double-click on a cell.

2. Right-click to open the context menu and select the entry Character style.

3. In the list on the left side of the dialog box, select the character style whose basis you want to change and
click on the Edit button.

4. In the following dialog box, switch to the Style tab.

5. Important: In the dropdown list Based on, select the style basis to which the selected character style is to be
linked.

6. You can now also change the desired formatting of the character style, etc.
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Relative font size

If you have one style based on another, you can even specify the relative font size if you want. For example,
you can specify that the font size of style X should always be 80% of the font size of style Y.

To do so, proceed as follows:

Perform steps 1. to 4. as described above and enable the option Scale on the Style tab. Enter the desired factor
as a percentage – for example, 80 – and confirm with OK.

The font size of a style edited in this manner will always be 80% of the size specified for the style on which it is
based.
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Cell styles

FreeOffice: Creating and managing your own cell styles is not included in SoftMaker FreeOffice.

You can use the ribbon command Home | group Format | Cell styles  to apply "Cell styles".

Cell styles are a combination of cell attributes (number format, orientation, borders, etc.) and a character format
(font, font size, etc.) that you can save. Once saved, you can repeatedly apply this cell style to any cell.

If, for example, you want to frequently format cells with the number format "Percent", red background and bold
font, simply create a corresponding cell style and apply it to the desired cells.

Note: In PlanMaker, you can also apply character styles (see Character styles). The difference to cell styles is
that character styles only store the character format (font, font size, etc.), whereas cell styles store both
character format and cell format. Furthermore, character styles are also applicable to individual characters
within a cell, while cell styles are applicable only to entire cells.

For more information, see the following pages.

Applying cell styles

To apply a cell style, navigate to the cell that you want to format. Alternatively, you can select multiple cells to
change their formatting together.

Then proceed as follows:

Applying directly via the dropdown menu of the icon

If you click on the Cell styles  icon on the ribbon tab Home | group Format, the program opens a dropdown
menu with various predefined styles (and custom styles if created). Here, you can directly select and apply a
suitable cell style.

Further down in this dropdown menu, you can use the option Styles in use to display the styles already used in
the current document by enabling the checkbox.

For advanced options, click on the entry Manage cell styles in this dropdown menu to open the dialog box (see
below and the following pages).

Advanced options: Via the dialog box

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and select Manage cell styles  in
the dropdown menu.

The program displays a dialog box with a list of all cell styles.

Tip: You can use the option Show to determine whether all available styles should be displayed in the list –
or only those already used in the current document.
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3. Select the desired cell style in the Styles list.

4. Click on Apply.

The formatting of the selected cells immediately changes to that which you specified in the cell style.

To clarify, a cell style can include the following formatting options:

§ Number format 

§ Font (font and font size, text styles, etc.)

§ Cell alignment

§ Shading

§ Borders

§ Cell protection

In the section Format includes of the above dialog box, you can (optionally) specify exactly which of these
formatting options should be used when you apply the selected cell style (see also next section).

Creating cell styles

FreeOffice: Creating and managing your own cell styles is not included in SoftMaker FreeOffice.

To create a custom cell style, proceed as follows:

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and select Manage cell styles  in
the dropdown menu.

The dialog box Cell style opens.

2. Optional: In the Styles list in this dialog box, select the cell style on which your new style should be based
(see also "Based on" below). Alternatively, simply select the default style "Normal".

Tip: You can use the option Show to determine whether all available styles should be displayed in the list –
or only those already used in the current document.

3. Click on the New button.

4. Give the cell style any name you like and confirm with OK.

5. The new cell style has now been created, and you can edit it individually as follows:

To change the character format, click on the Character button. The program will display a dialog box,
which is very similar to the dialog box for the ribbon tab Home | group Character  (see Character format).

To change the cell format, click on the Cell button. The program will display a dialog box, which is very
similar to the dialog box for the ribbon tab Home | group Number  (see Number format and the following
section).

6. Click on Close to exit the dialog box (or on Apply first if you want to see the result of the cell style directly
for the selected cells).
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The style is now defined and ready for use via the ribbon command Home | Cell styles .

You can create a different set of cell styles for each document; the styles are stored in the document.

The selection "Based on"

When you create a new cell style, it is usually based on the "Normal" cell style. This means that the new cell
style is based on the formatting of the "Normal" style. Changes to the formatting of the "Normal" style thus
affect all other styles.

If you have already created cell styles and used them in the document, the following happens when you choose
the command Manage cell styles: In the list on the left side of the dialog box, the style of the currently selected
cell is selected as the basis. This may be the "Normal" cell style or another one. In the list on the left, change
the style that you want to use as the basis for a new cell style, if necessary, before clicking on the New button.

You can use the selection Based on to subsequently change the assignment of the style basis for the created cell
styles:

In the list on the left of the dialog box, first select the style to which you want to assign another style base. The
Based on list shows you the basis on which the selected style is currently based. Here, you can change the style
basis.

Note: If you want to change the Based on assignment for a cell style and you have not yet created a custom cell style, then this option
cannot be selected yet because only the default styles are available so far. They have the "Normal" style as their basis, and this is a fixed
assignment.
 The option Based on will only be freely available to you once you have defined your custom new style and then selected it from the
Styles list on the left.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

The "Format includes" section

In the Format includes section of the dialog box, you can specify exactly which of the formatting options to
include when you apply the cell style.

For example, cell styles such as "Currency" should only provide the cells with the number format "Currency" –
and not change anything else. That's why all options except "Number format" are disabled in this style.

The settings in this section can be made individually for each style.

Note: For the default style "Normal", these options cannot be changed.

Using shortcut keys

If you need a cell style particularly frequently, you can assign it a shortcut key at any time. The advantage of
this is that you can then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, use the Cell styles  icon to access the entry Manage cell styles. In the
opened dialog box, select the desired style in the list. Then click in the Shortcut key input field and press the
desired key combination (starting with Ctrl or Alt).
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Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even one
of PlanMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since these are not
usually assigned.

Editing cell styles

FreeOffice: Creating and managing your own cell styles is not included in SoftMaker FreeOffice.

Of course, you can change cell styles again at any time.

Important: When you change the formatting options stored in a cell style, all cells using this style are
changed accordingly.

To change a cell style, proceed as follows:

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and select Manage cell styles in
the dropdown menu.

2. The dialog box Cell style opens. Select the style that you want to change.

3. Click on Character to change its character format or on Cell to change its cell format.

4. When you have finished, exit the dialog box with the Close button.

Deleting or renaming cell styles

The Delete button in the dialog box of the command Manage cell styles deletes the selected style in the current
document.

To give a style a new name, click on Rename and type the new name. This also only affects the current
document.

Note: Some of the cell styles are predefined and cannot be deleted or renamed.

"Normal" cell style

The cell style called "Normal" is present by default in every document and has a special significance: it is the
default style for all cells. As long as you do not apply other cell styles, every cell in a document is always
formatted in the "Normal" cell style.
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If you change the "Normal" cell style – for example, the number format – the number format for all cells will be
changed (except for cells that you have formatted manually in a different number format via the ribbon tab
Home | Number). Furthermore, subsequent entries will appear in this number format, which you have defined
as the new default format in the "Normal" cell style for the document.

If you want to apply a different cell style to certain cells instead of the default "Normal" style, select the cells
and follow the instructions in Applying cell styles.
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Document templates
As you learned in the previous two sections, character styles and cell styles are always saved in the document in
which they were created. If you want to use such styles in other documents also, you should save them in a
document template.

Each time you choose the ribbon command File | New , PlanMaker allows you to select a document template
as the basis for the new document. If, at this point, you select a document template that you have created, the
new document will have the same character and cell styles that you saved in the template.

Note: Document templates may also contain text, values, calculations, etc., in addition to your favorite
character and cell styles. This enables you to create a set of templates for invoices, annual reports, balance
sheets or other frequently used documents.

Simply choose the command File | New, select the template and complete the worksheet.

For more information, see the following pages.

Creating document templates

To create a new document template, proceed as follows:

1. Start a new document or open a document or document template that you want to use as the basis for the
new template.

2. Create the desired character and cell styles and/or enter text, values, etc., to create the template.

3. Choose the ribbon command File | Save as.

4. Select the entry PlanMaker template from the dropdown list Save as type.

5. At this point, PlanMaker switches automatically to the folder where the document templates are located.
Android/iOS: This step is not supported here. Navigate manually to the folder "SoftMaker/PlanMaker NX templates".

6. Type a name for the template in the File name input field.

7. Confirm that you want to save it.

The new template will now be saved.

Using document templates

To use a document template, simply start a new document with the ribbon command File | New. You can
specify on which document template this is to be based.
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Proceed as follows:

1. Choose the ribbon command File | New  to open the dialog box. (Click directly on the icon itself.)

2. You can select the required document template in the dialog box.

3. Confirm with OK.

The system now creates a new document for which all character and cell styles saved in the document template
become available. If the document template also contains filled cells, they are displayed accordingly and can be
edited normally.

Editing document templates

Changing a document template is no different from editing a normal document. You open the template, make
your changes and save the document template.

Important: Of course, changing a document template will affect all documents that are subsequently created
on the basis of this template.

To change a document template, proceed as follows:

1. Choose the ribbon command File | Open (click directly on the icon itself).

2. Select PlanMaker templates from the dropdown list of file types.

3. Select the template to be changed and confirm that it has been opened.

4. Make the desired changes to the cells and/or styles of this document template.

5. Choose the ribbon command File | Save to save the changed template.

Of course, you could also save the template under a different name via the ribbon command File | Save as if
you did not want to overwrite the original template.

"Normal.pmvx" document template

The Normal.pmvx document template is the default template for new documents. If you choose the command
File | New, this template will always be set. It is completely empty and contains only the default "Normal"
character style as well as the default "Normal" cell style.

Accordingly, the Normal.pmvx template is a suitable basis for creating a completely new template from
scratch.

Important: You should not usually change the Normal.pmvx default template. If you want to do this
anyway, you should be aware that these changes will affect all documents that are subsequently created
based on this template.
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If, for example, you want to change the page format for all documents that will be subsequently created based
on the Normal.pmvx template, open this template, change the page format and save the template.

You can also choose a different default template for new files:

To do so, choose the ribbon command File | New  (click directly on the icon itself), select the desired
template in the dialog box and click on Set as default. From now on, PlanMaker will always offer this template
as the default template when you create a new document.

AutoFormat
You can use the command AutoFormat to change the layout of entire table areas at once.

Tip: By inserting "Tables in worksheets" using the ribbon command Insert | Table, you can apply different
table styles even better. You will find a wider range of styles, additional features and better handling via this
function. You can then further customize the table style on the ribbon tab Table | group Style. For more
information, see Tables in worksheets.

Note: The command AutoFormat is not available on the ribbon by default. However, you can add this command as a separate button on a
ribbon tab. To do so, choose the ribbon command File | Customize | Customize ribbon and then proceed as described in Customizing
icons and groups in the ribbon.

The menu command is still to be found in the classic menu interface: Format > AutoFormat:

The dialog box for this command shows a list of predefined "AutoFormat styles" whose appearance can be
previewed in the Sample field. To apply an AutoFormat style, simply select a table area in the worksheet,
choose the above command, select the desired style and click on OK.
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The options in the Apply section of the dialog box let you choose which formatting options to apply. If, for
example, you disable all options except Borders, only the borders of the AutoFormat style will be applied; all
other formatting of the table will remain unchanged.

Conditional formatting
You can use the ribbon command Home | group Format | Conditional formatting  to apply conditional
formatting to cells. This will only be applied if a certain condition is met. Thus, for example, you can specify
that a cell should be colored red whenever it contains a value greater than 1000.

You will find out everything you need to know about it on the following pages. The following topics are
covered:

§ Creating new formatting rules 

To apply conditional formatting to cells, you select the relevant cells and create a formatting rule for them –
for example: "If the cell content is greater than 1000, display the cell in red."

You can apply any number of formatting rules to a cell – for example, you can create a second rule that
formats the cell in boldface if it contains a value below zero, etc.

§ Types of conditional formatting 

This section deals with the different types of conditional formatting.

§ Managing formatting rules 

You can use the command Manage rules to centrally manage all conditional formatting in the document,
including editing and deleting it.

§ Removing conditional formatting 

The last section covers the removal of conditional formatting.

Creating new formatting rules

To apply conditional formatting to cells, you select the relevant cells and then create a formatting rule for them.
Formatting rules always consist of two parts:

§ a condition 

§ ... and the formatting to be applied if this condition is met.

Example: "If the cell content is greater than 1000, display the cell in red."

Application example

To define (and also apply) such a rule, proceed as follows:

1. Navigate to the desired cell. Of course, you can also select multiple cells to apply conditional formatting to
them all at once.
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2. Choose the ribbon command Home| group Format | Conditional formatting  and select New rule from
the dropdown menu to open the dialog box.

Tip: For quick use of common formatting rules, you can also apply certain options directly from the
dropdown menu of the command Conditional formatting (see "Tip: Applying formatting rules directly
from the dropdown menu" below).

3. In the dialog box, first select the type of condition to be used for Type.

In our example, you would select the option Format only cells that contain. (For more information on all
available options, see Types of conditional formatting).

4. You can now specify the desired condition.

In our example, this would be the condition "cell value is larger than 1000". Thus, select the options Cell
value and greater than. Then enter 1000 on the right.

5. Finally, click on the Format button, and specify the formatting options to be applied if this condition is met.

In our example, switch to the Font tab, set the font color to Red and confirm with OK.

6. All necessary settings are now made. Click on OK to confirm and create the new rule.

The new formatting rule is now created – and is applied immediately to the selected cells. This has the
following effect:

§ If the cell content is smaller than or equal to 1000, the cell will be displayed in its original format. 

§ If, on the other hand, the value is greater than 1000, the conditional formatting will be applied, thus the cell
contents will be displayed in red.

Note: You can create as many formatting rules for a cell (or cell range) as you like. For example, you can
add a second rule that formats the cell in boldface if it contains a value less than zero.

Tip: Applying formatting rules directly from the dropdown menu

If you choose the ribbon command Home | group Format | Conditional formatting , you can apply some
frequently used formatting rules directly from the dropdown menu.
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The following types of formatting rules are available at the top of this dropdown menu:

§ Highlight cells: see description in the next section "Types of conditional formatting", paragraph Format only
cells that contain ...

§ Highest/lowest values: see description in next section "Types of conditional formatting", paragraph Format
only upper or lower values

§ Data bars, Color scales, Icon sets: see description in next section "Types of conditional formatting", paragraph
Format all cells based on their values

In the submenus, click on the entry More rules to open the dialog box with even more differentiable setting
options if required.

Types of conditional formatting

The previous section described how to apply conditional formatting to cells. In the dialog box that appears, you
can choose between the following types of formatting rules:

Format all cells based on their values

This type of conditional formatting does not actually use a condition at all. In fact, it reformats all of the
previously selected cells – based on the values they contain.

If, for example, you choose a 2-color scale from red to green, the lowest value will be highlighted in red and
the highest value in green. The colors for the values in-between will be calculated automatically. The result will
be a color gradient as follows:



239Formatting worksheets

There are several different subtypes for this type of formatting rule. They can be selected via the option Format
style. This contains the following entries:

§ 2-color scale 

This is described in the example above.

§ 3-color scale 

This is the same as the 2-color scale, but it also lets you set the color for the midpoint.

§ Data bars 

Here, bars that correspond to the relative size of the value are displayed in the background of the cells –
similar to a bar chart:

§ Icon sets 

This displays an icon in each cell, indicating the size of the respective value – for example, a red signal light
for the lower third of the values, a yellow one for the middle third and a green light for the upper third:
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Format only cells that contain ...

This type of rule reformats only those cells within the current selection that meet the specified condition.

Proceed as follows: First, specify the desired condition, using the controls and input fields in the dialog box.

Then, click on the Format button and specify the formatting options to be applied for all cells that meet the
condition.

An example can be found in the previous section – where we created a formatting rule "If the cell content is
greater than 1000, display the cell in red".

Format only upper or lower values

This type of rule reformats only those cells that contain the highest or lowest values within the current
selection.

First, specify which values to reformat – for example, the top 3 values or the top 10% of the values.

Then click on the Format button and specify the formatting options to be applied to the corresponding cells.

Format values above or below average

This type of rule reformats only those cells that contain values above or below the average of the current
selection.

First, specify which values to reformat – for example, all values above the average.

Then click on the Format button and specify the formatting options to be applied to the corresponding cells.

Format unique or duplicate values

This type of rule reformats all unique values (or duplicate values) within the currently selected cells.

First, specify which values to reformat:

§ all unique values (values that occur only once) 

§ or all duplicate values (values that occur at least twice)

Then click on the Format button and specify the formatting options to be applied to the corresponding cells.

Use a formula to determine which cells to format

Here, only those cells are reformatted for which the specified formula returns TRUE.

To do so, enter the desired formula in the dialog box. Note that only formulas that return a logical value (thus,
TRUE or FALSE) are permitted. See also notes below.

Then click on the Format button and specify the formatting options to be applied to the corresponding cells.

Some notes:
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§ Creating suitable formulas 

You can use any kind of formula for the condition. You only have to ensure that the result of the formula is
a logical value (thus, TRUE or FALSE).

Examples:

If you enter the formula "SUM($A$1:$C$3) > 42", the conditional formatting will be applied if the sum of
the cell range A1:C3 is greater than 42.

If you enter the formula "ISEVEN(ROW())", the conditional formatting will be applied if the current cell is
located in a row with an even row number.

§ Using absolute and relative cell addresses 

Note that the formula can also use relative cell references in addition to absolute cell references (as in the
above example). These are treated as follows:

An absolute cell reference – for example, $A$1 – always refers to cell A1.

On the other hand, a relative cell reference – for example, A1 – refers to the cell in the upper left corner of
the selection. That means:

If you apply conditional formatting to an individual cell, A1 refers to the relevant cell.

If you previously selected a cell range, A1 refers to the cell in the upper left corner of the selection, A2 to
the cell below it, etc.

Managing formatting rules

On the ribbon tab Home | group Format | Conditional formatting , you can choose the command Manage
rules to manage the conditional formatting in a document, including editing and deleting it.

Use this command as follows:

1. Navigate to the cell whose formatting rules you want to edit. Of course, you can also select multiple cells.

2. Choose the ribbon command Home | group Format | Conditional formatting | Manage rules.

3. A dialog box appears.

Note: By default, this dialog box displays only the rules for the current cell (or selection). If you want to see
all rules created in the entire worksheet instead, set the option Source to Current worksheet. For more
information, see below.

4. Make the desired changes to the formatting rules (see below).

5. Close the dialog box by clicking on OK.

Using the dialog box

The dialog box for this command has the following options:

§ Source 

Here, you can determine which formatting rules should be displayed in the dialog box:
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Only selected cells: This shows only rules that affect the currently selected cells (or the current cell if no
cells are currently selected)

Current worksheet: This shows all rules for the current worksheet

Sheet <name>: This shows all rules for a different worksheet (if available)

§ Rules list 

The Rules list displays all rules for the current selection or the entire worksheet (depending on what you
selected for Source).

Rules that affect the currently selected cells are displayed in boldface.

Stop: You usually don't have to concern yourself with the checkboxes in the Stop column. They are only
necessary for compatibility reasons with older documents. (Background info: In older versions of PlanMaker
and Excel, conditional formatting for a cell that had multiple formatting rules was "stopped" as soon as one
of these rules applied. All further rules for this cell were then ignored. This is no longer the case in current
versions of PlanMaker and Excel: Here, all rules defined for a cell are always observed.)

§ Arrow buttons next to the Rules list 

The arrow buttons next to the Rules list enable you to change the ranking order of the formatting rules.

To change the ranking of a rule, select it in the list and then click on the up button (increase ranking) or
down button (decrease ranking).

This may be necessary if a cell range has been assigned competing formatting rules. Simple example: A rule
wants to color the cell green, but another rule wants to color it red.

The higher a rule is in the list, the higher its ranking.

Note: Please note that the list does not reflect the order in which the rules are processed – on the contrary:
The list is processed from bottom to top, so that the rules with the highest ranking are applied last.

§ Apply to 

Here, you can change the cell range to which you want to apply a rule.

To do so, select the rule in the Rules list and enter the desired cell range in this input field.

§ New button 

This creates a new conditional formatting rule for the cells currently selected in the worksheet, just like the
ribbon command Home | group Format | Conditional formatting | New rule.

PlanMaker displays again the dialog box for creating rules, which was described in Creating new formatting
rules.

§ Edit button 

This lets you edit the conditional formatting rule currently selected in the Rules list.

Note: The rule is then changed in all cells to which it has been applied, regardless of which cells are
currently selected in the worksheet.

PlanMaker displays again the dialog box for creating rules, which was described in Creating new formatting
rules.
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§ Delete button 

This deletes the rule currently selected in the Rules list.

Note: This will remove the rule from all cells to which it has been applied, regardless of which cells are
currently selected in the worksheet.

For more information on Removing conditional formatting, see the next section.

§ Go to button 

This closes the dialog box and jumps to the cell range for the rule that is currently selected in the Rules list.

Removing conditional formatting

Conditional formatting can be removed in two ways:

A) Deleting formatting rules

When you delete a formatting rule, it will be removed from all cells to which it has been applied, regardless of
which cells are currently selected in the worksheet.

Proceed as follows:

1. Choose the ribbon command Home | group Format | Conditional formatting | Manage rules.

2. A dialog box appears.

Note: By default, this dialog box displays only the rules for the current cell (or selection). If you want to see
all rules created in the entire worksheet instead, set the option Source to Current worksheet.

3. Select the rule to be deleted in the Rules list.

4. Click on the Delete button.

The selected rule will now be deleted – and thus removed from all cells it affected.

B) Removing all conditional formatting from a cell range

There's another method for removing conditional formatting, which removes all conditional formatting from the
selected cells.

Proceed as follows:

1. Select the cells from which you want to remove all conditional formatting.

2. Choose the ribbon command Home | group Format | Conditional formatting | Delete rules in selected
cells.

(Alternatively, choose Home | group Contents | Delete  and select Conditional formatting, which does
exactly the same thing.)

This will "free" the selected cells from any conditional formatting rules applied to them.
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All formatting rules that are no longer in use will be deleted automatically.

Input validation

FreeOffice: Input validation is not included in SoftMaker FreeOffice.

When you apply input validation to a cell, you can achieve the following:

§ Ensure that only certain types of values (for example, numbers) within certain limits (for example, only
values between 10 and 20) are considered valid in this cell. 

§ Display an info text whenever the user goes to this cell (for example, "Please enter only numbers between 10
and 20.").

§ Display an error, warning or information message if the user nevertheless enters values that do not match the
input validation.

This is useful when you are creating tables that will be filled in by other people and you want to prevent invalid
values from being entered.

Applying input validation (example)

If, for example, you would like to limit the input of a certain cell to numeric values between 10 and 20, you
would proceed as follows:

1. Select the desired cells.

2. Choose the ribbon command Review | Input validation .

3. On the Settings tab, you can specify which types of values are permitted and set limits for the allowed
values.

In our example, you would set the following:

Allow: "Decimal numbers"

with values: "between"

Minimum: 10

Maximum: 20

4. On the Input message tab, you have the option of entering an info text that will be displayed whenever the
user goes to the cell.

For example, you could add the message, "Please only enter numbers between 10 and 20." Of course, you
can also refrain from entering an input message.

5. On the Error message tab, you can specify the message that should appear when the user types invalid
values into the cells.
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The icons in the Type area allow you to choose the type of error message that is displayed. (See explanation
below.)

Important: The type of message also determines whether the user is actually allowed to enter invalid
values. PlanMaker strictly rejects invalid entries only when the type Error message (first icon) is
selected!

Furthermore, you can enter the actual text of the message. If you do not enter anything, a default message
will be issued.

For our example, set the type to Error message by clicking on the first icon and enter the desired message
(for example, the title "Invalid entry" and the text "Only numbers between 10 and 20 are allowed here.")

6. Confirm with OK.

Only values between 10 and 20 will now be permitted in the selected cells. If the user enters something else, an
error message will appear.

Note: Input validation only becomes active when the user types in values. If the user pastes invalid values
into the cell through a copy and paste operation (for example, with the ribbon command File | Paste),
however, input validation will not intervene!

For more information on the options of the dialog box Input validation, see the next section Settings for input
validation.

Disabling input validation again

If you want to disable the input validation again, select the relevant cells and proceed as follows:

On the ribbon tab Home | group Contents | Delete , choose the command Input validation in the dropdown
menu.

Alternatively, you can use the ribbon command Review | Input validation  again. In the dialog box on the
Settings tab, select "All values" again under Allow:.

Settings for input validation

FreeOffice: Input validation is not included in SoftMaker FreeOffice.

As described in the previous section, you can limit the allowed values using the dialog box of the ribbon
command Review | Input validation. The following options are available here:
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"Settings" tab

§ Allow: 

You use these options to define which types of values are allowed:

Option Explanation

All values Allow all types of values (thus disable the input validation)

Integer numbers Allow only integer numbers

Decimal numbers Allow only decimal numbers

List entries Allow only values from a predefined list of permitted values.

Method 1: Enter a comma-separated list of the allowed values in the Source field –
for example, dog,cat,mouse or 1,2,3,4,5,6.

Method 2: Alternatively, you can enter an equal sign followed by a cell range that
contains all valid entries. If, for example, cells C1 to C3 contain the values "dog",
"cat" and "mouse" and you enter =C1:C3 in Source, only those three values will be
allowed.

The Options button can be used to set additional options (related to Method 2).

Date Allow only date values

Time Allow only time values

Text length Allow only entries (including numbers) with the specified text length

User-defined Allow only entries which satisfy the specified condition Enter the condition in the
Formula field. (For more information on this, see the end of this section.)

§ with values 

Here, you can further limit the allowed values. If, for example, you select the option between, you can
specify minimum and maximum values between which the values must lie.

§ Minimum, Maximum, etc. 

Here, you define the limits of the entries. If you enter 10 as the Minimum and 20 as the Maximum, only
values between 10 and 20 will be accepted.

You can also use formulas here. If you enter C1 as the Minimum, the contents of the cell must be greater
than or equal to the cell contents of cell C1. If you enter SUM(D2:D8), the contents of the cell must be
greater than or equal to the sum of cells D2 to D8.

§ Use dropdown 

This option is only available when List entries is selected under Allow. If this option is enabled, an arrow
will appear on the right edge of the cell when the user goes to it. If you click on this arrow, the program will
display a dropdown list of all permitted values from which the user can select.
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§ Ignore empty cells 

If this option is enabled, input validation is ignored for empty cells. If the user deletes the contents of a cell,
no input validation occurs in the cell until the user enters another value.

"Input message" tab

On this tab, you can enter an info text for filling in the cells (for example, "Please only enter numbers between
10 and 20."). This information will be displayed when the user goes to the cell.

This tab has the following options:

§ Show input message when cell is selected 

This option determines whether the input message should be shown or not.

§ Title 

Here, you can specify the title of the message.

§ Message 

Here, you can enter the text of the message.

"Error message" tab

On this tab, you can specify the error, warning or information message which should appear when the user
enters data that does not match the input validation.

This tab has the following options:

§ Show error message after invalid data is entered 

This option determines whether the error message should be shown or not.

Note: Normally, you should leave this option enabled, since input validation is of little use if the user is not
informed that he is entering invalid data.

§ Type 

Here, you can specify the type of message. Simply click on the desired icon.

Important: The type of message also determines whether the user is actually allowed to enter invalid
values. PlanMaker strictly rejects invalid entries only when the type Error message (first icon) is
selected!

The following types of messages are available:

Error message (first icon): PlanMaker displays an error message. The user is forced to enter a valid value;
invalid values will not be accepted.

Warning message (second icon): PlanMaker displays a warning message. The user can decide whether to
still proceed with the invalid entry.

Information message (third icon): PlanMaker only displays an information message. The user must only
acknowledge this message and the invalid data will be accepted (as long as the user does not click on
Cancel).
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§ Title 

Here, you can specify the title of the message.

If you do not enter anything here, a default text will be used.

§ Message 

Here, you can enter the text of the message.

If you do not enter anything here, a default text will be used.

Tip: If you would like to have the specified minimum and maximum values displayed in the message,
simply use the wildcards %min and %max. Example: "Error – Only values between %min and %max are
allowed here."

Examples

Finally, some examples of how to use this feature:

§ Allow only values within the specified range 

On the Settings tab, first select the desired type of values. If only dates are to be allowed, set the option
Allow to "Date". If only numbers are to be allowed, set the option to "Decimal numbers" – and so on.

You can then use the option With values to set the allowed limits. If, for example, only values greater than
1 are to be allowed, select the "greater than" option and enter 1 as the Minimum.

§ Allow only values of a certain length 

If you would like to prevent the user from entering values with lengths greater than 40 characters, select the
following settings:

Allow: "Text length"

with values: "smaller than or equal to"

Maximum: 40

Note: Numbers, periods, commas, signs, etc., are considered to be just as much a character as letters.

§ Using your own formulas for input validation 

Advanced users can also select "User-defined" under Allow and then specify any formula for input
validation.

To do so, use a formula that returns a logical value (thus, TRUE or FALSE). If the result of the formula is
TRUE, PlanMaker will consider the entry to be valid; otherwise it will be considered invalid.

Example: If you enter the formula SUM($A$1:$C$3) > 42, the input will be considered valid only if the sum
of the A1:C3 cell range is greater than 42.

Note: Notice that relative cell references can also be used in such formulas in addition to absolute cell
references (as in the example above):

Absolute cell references such as $A$1 always refer to cell A1.

Relative cell references such as A1, on the other hand, refer to the cell in the upper left corner of the selected
cells. If you apply input validation to only one cell, A1 refers to this cell. If you previously selected a cell
range, A1 refers to the cell in the upper left corner, A2 refers to the cell below, etc.
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Detect invalid data

FreeOffice: Input validation is not included in SoftMaker FreeOffice.

On the ribbon tab Review | group Input validation, you will find commands which can be used to detect cells
that contain an invalid value.

Note: A cell contains an invalid value if the command Input validation  has been used to specify that the
cell can only contain certain values, and the current cell content does not match this check.

To find and analyze such errors, use the following commands in the command group:

§  Input validation 

This command opens the dialog box Input validation for defining allowed values. For more information, see
previous sections.

§  Mark invalid data 

This command inserts a red circle around each cell (in the current worksheet) that contains an invalid value.

§  Remove (invalid data) marks 

This removes all red circles (from the current worksheet) that were added with the above command.

§  Previous invalid cell 

This command jumps to the previous cell that contains an invalid value.

§  Next invalid cell 

This command jumps to the next cell that contains an invalid value.

Notes

§ The marks for invalid data also appear in the printout. 

§ However, the marks are not saved in the document. Thus, when you save a document and then reopen it, all
marks are removed. 
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Format painter
You can use the command Home | Format painter to instantly transfer the cell format from one cell to other
cells.

To do so, proceed as follows:

1. First, click on the cell whose format you want to transfer to other cells.

2. Click on the Format painter icon  on the ribbon tab Home| group Edit.

The mouse cursor will now change into crosshairs with a little brush: 

3. Drag the mouse (with the mouse button held down) over the cell ranges to which the format is to be
transferred. You can apply this function to any number of cell ranges or individual cells (simply click on
individual cells).

4. When you are finished, click on the Format painter icon again or simply press the Esc key.

Both the character format (font, text styles, etc.) and the cell format (number format, alignment, etc.) will be
applied to the selected cells.

Transferring the format of entire cell ranges

You can also transfer the format of entire cell ranges to other cells. To do so, proceed as described above, but
in step 1., select the cell range whose format you want to transfer.

If, for example, you select three cells that are formatted with red, green and blue backgrounds and transfer their
formatting to another cell range, that range will be formatted alternately with red, green, and blue backgrounds.

Shortcut keys

You can also use the keyboard to perform the Format painter function:

Command Windows/Linux Mac

Format painter (copying step) Ctrl+Shift+C Cmd+Shift+C

Format painter (pasting step) Ctrl+Shift+V Cmd+Shift+V
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Page setup
In this section, you will learn about the options available for formatting a worksheet for printing.

The following topics are covered:

§ Setting page format 

On the ribbon tab Layout | group Page setup, you can set the page format for the current worksheet. This
includes settings such as page size, page orientation (portrait or landscape) and page margins.

§ Setting page format options 

In the dialog box of the ribbon tab Layout | group Page setup , you will find various settings on the
Options tab for page numbers, print order, etc., and you can specify which parts of the worksheet should be
printed.

§ Setting up header and footer 

You can use the command Header and footer on the ribbon tab Layout | group Page setup to add a header
and/or footer to the document, which will be printed at the start or end of each printed page of the
worksheet.

§ Adjusting page breaks manually 

Page formatting also includes the option of manually controlling the automatic page break if necessary. This
can be done with the command Page break on the ribbon tab Layout | group Page setup.

See the following pages for more information.

Setting page format

On the ribbon tab Layout | group Page setup, you can define the page format of a worksheet. This includes
settings such as page size and orientation (portrait or landscape).

Note: You can set up a different page format for each worksheet in a document. For example, you can
choose portrait for one worksheet and landscape for another.

Applying via the dialog box of the command group "Page setup"

On the ribbon tab Layout | group Page setup, click on the group arrow  in the lower right corner to open the
dialog box and switch to the Page format tab.

Alternatively, you can open the dialog box with the ribbon command File | group Print | Page setup.
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Then make the desired settings:

§ Orientation 

Here, you can specify the Orientation of the document on the printed page: Portrait or Landscape.

§ Paper size 

You can specify the paper size for the printed pages here. The dropdown list Paper size contains all paper
sizes that are supported by the current printer. If you want to specify a size that is not listed, you can do so
by manually specifying values in the fields Width and Height.

§ Margins 

You can set the page margins here

§ Distance to edge 

Here, you can determine how much space should be left between headers and footers and the upper or lower
edge of the sheet.

Note: Headers and footers are always printed at the top and bottom of the page, respectively. If they do not
appear on the printout, check whether a) the Distance to edge is too large or b) the top/bottom margin is too
small.
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§ Paper trays 

Only available in Windows version: If your printer has multiple paper trays, you can set the tray which the
printer should use. If you have selected the default setting Use printer setting, PlanMaker does not affect
the paper feed. If, for example, you want the first page of your document to be printed on paper from tray 1
and the remaining pages on page from tray 2, you should change this setting accordingly.

Tip: If you right-click on a worksheet tab at the bottom, you can choose the context menu command Copy
page setup to copy all configured page setups from one worksheet to another. See also Managing
worksheets.

Applying via the icons of the command group "Page setup"

Common settings of the dialog box can also be found via the icons on the ribbon tab Layout | group Page
setup. Click on the black arrow of the respective icon to open the corresponding dropdown menu.

Margins (corresponds to the options for Margins in the above dialog box):
You will find a selection of predefined values here. If required, select More in the dropdown menu to access the
dialog box for customizations.

Page orientation (corresponds to the options for Orientation in the above dialog box):
portrait or landscape

Page size (corresponds to the options for Paper size in the above dialog):
Here you will find a selection of predefined values. If required, select More at the bottom of the dropdown menu or
click on the icon itself to perform customizations via the dialog box.

Setting page format options

On the Options tab of the dialog box "Page setup", you can make settings that affect the printout of the current
worksheet.

Note: These options must be set separately for each worksheet.

You open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Layout |
group Page setup. Switch to the Options tab.

Alternatively, you can open the dialog box with the ribbon command File | group Print | Page setup.
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Here, you will find the following settings:

Repeated rows/Repeated columns

If the worksheet contains row labels or column labels, and you want them to be repeated on all printed pages,
enter them here.

Use the following notation: FirstRow:LastRow (or FirstColumn:LastColumn, respectively)

If, for example, the first row of a long list of data contains a label to be repeated on all pages, enter 1:1 in the
Repeated rows field to ensure this row is repeated on every page of the printout.

If, on the other hand, you want columns A to C to be repeated on each page, enter A:C in Repeated columns.

Print

Select any of these options to include the following worksheet components in the printout:

§ Row and column headers: Print the row headers located to the left of the worksheet and labeled 1, 2, 3, etc.
or the column headers located above the worksheet and labeled A, B, C, etc. 

§ Grid: Print the gray gridlines between the cells.

§ Comments: Print the comments added with the ribbon command Insert | Comment.
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Note: Only comments that you have enabled for permanent display via the Comment visibility button will be printed. For more
information, see Using comments.

In addition, you can use the option Colors to specify if the printout should be rendered in color:

§ Original colors: The printout is rendered in its original colors. 

§ Grayscale: Colored text is rendered in black and white, while colored objects (pictures, charts, etc.) are
converted to shades of gray.

§ Outlines only: Colored text is rendered in black and white, while colored objects are reduced to their
outline in black and white.

Centering options

If the option Center horizontally is enabled, the worksheet's content will be horizontally centered on the page
when printed.

If the option Center vertically is enabled, the worksheet's content will be vertically centered on the page when
printed.

Page number

This option lets you define the starting number for page numbers:

Auto: Pages are numbered starting with 1.

Value: Pages are numbered starting with the specified value.

Tip: To add page numbers to a worksheet, insert a Page number field into the header or footer (see next
section).

Print order

Here, you define the order in which PlanMaker should output worksheets that are wider than a printed page.

§ Left to right 

Print from left to right, and then from top to bottom.

§ Top to bottom 

Print from top to bottom, and then from left to right.

Print range

Here, you can define a print range for the current worksheet.

When a print range is defined, only those cells that are within this cell range will appear when the worksheet is
printed. The rest of the worksheet will be omitted.

By default, this input field is empty, thus no print range is defined and the entire worksheet will be printed. If
you type in a cell range (or the name of a named range) here, however, only this range will be generally output
when the worksheet is printed.
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A print range can be defined individually for each worksheet of the document.

Important: When you save a document, this setting will be permanently stored in the document. Thus, if
you subsequently open and print this document again, the printout will still contain only those cells within
the print range. If you want the entire worksheet to be printed again, simply clear the Print range input field
in this dialog box to remove the print range.

Tip for working with print ranges:

Alternatively, there is a slightly more convenient method: You can also define a print range for a worksheet by
selecting the desired cell range and then choosing the command Define print range directly from the ribbon
tab Layout | group Page setup.

To do so, either click on the icon itself – or click on the icon's small arrow and select the command Define
print range in the dropdown menu. If you select Remove print range here, you can remove the print range
again.

Note: To ensure that only the defined print range is printed, the option Ignore print range must be disabled
in the dialog box of the command File | Print. This is the default setting. For more information, see Printing
a document.

Tip for checking the print range:

To visually check the selected print range, you can use the option Page break preview (not available in
SoftMaker FreeOffice) on the ribbon tab View. The selected print range is indicated by the white area and can
be further adjusted by dragging the wrap lines with the mouse. For more information, see Adjusting page breaks
manually.

Scaling options

These options enable you to scale printouts of the document up or down.

By default, a fixed scaling factor of 100% is set (which means that the original size is used).

To change the scaling, first select a Scaling mode, and then set the desired value as follows:

§ Use fixed scaling factor: Here, you can set the scaling factor manually (in percent). Only values between 20
and 200 percent are permitted. If, for example, you set the scaling factor to 50%, the printout will be scaled
down to half its original size. If you set it to 200%, the printout will be doubled in size. 

For the other 4 scaling modes, the scaling factor is calculated automatically according to your settings:

§ Specify height in pages: Here, you specify the desired height of the printout in pages. PlanMaker will
determine the corresponding scaling factor automatically. 

§ Specify width in pages: Here, you specify the desired width of the printout.

§ Specify height and width in pages: Here, you specify the desired maximum height and width of the
printout.

§ Specify number of pages in total: Here, you specify how many pages the printout should have in total. 
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Note: PlanMaker does not allow the automatically determined scaling factor to be less than 20%. If this
value is not reached, PlanMaker automatically uses the minimum allowed value of 20%. The same applies
to the maximum value of 200%.

Setting up header and footer

If desired, you can add headers and/or footers to a worksheet. Headers/footers are repeated on the top/bottom of
each printed page of a worksheet. You can also insert useful fields here, such as page number, file name, print
date, etc.

Note: Each worksheet of a document can have its own headers/footers.

To edit the header of the current worksheet, for example, proceed as follows:

1. On the ribbon tab Layout | group Page setup, choose the command Header and footer.

Alternatively, you will find the command on the ribbon tab Insert | group Text.

PlanMaker opens the following dialog box:
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2. To apply one of the predefined headers, select it from the dropdown list box at the top of the dialog box.

To customize the header to your liking, click on the Edit button (see "Editing headers and footers" below).

To change the format of the header, click on the Format button (see "Formatting headers and footers"
below).

3. Confirm with OK.

The header has now been changed accordingly.

Editing footers can be performed in the same manner as headers (using the dialog controls at the bottom of the
dialog box).

Tip: Headers/footers are not displayed in the worksheet on the screen – they appear in the printout only.
However, you can view the appearance of the header and footer with the Preview button or also at any time
with the ribbon command File | group Print | Print Preview.

Editing headers and footers

When you click on the Edit button in the aforementioned dialog box, you can edit the worksheet's headers and
footers as desired.
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Some notes:

§ Headers/footers can contain up to three sections 

The input fields in this dialog box are split into three parts. This is due to the fact that headers/footers can
consist of up to three sections: a left section (left-aligned), a middle section (centered) and a right section
(right-aligned). This allows you to display, for example, the date on the left, the file name in the middle and
the page number in the right section of the header/footer.

Of course, you can also fill in only one of the three sections, for example, if you only want to have the file
name displayed on the left.

§ Using fields for page numbers, file name, etc. 

To insert fields into headers/footers, click on the Fields button.

Fields are wildcards that symbolize a specific piece of information. If, for example, you insert a field for the
page number, the wildcard {\PAGE NUMBER} is in the input field. When printing, this symbolic
information is then automatically replaced by the page number.

The following fields are available:

Field name Output

Document name File name of the document (for example, "My Table.pmdx")

Document path File path of the document (for example, "C:\Tables")

Document name and path File name and path of the document (for example, "C:\Tables\My
Table.pmdx")

Worksheet name Name of the current worksheet

Page number Page number

Number of pages Total number of pages
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Print date Current date (date of printing)

Print time Current time (time of printing)

Date last changed Date the document was last changed (and saved)

Creation date Date the document was created

To insert one of these fields, click on the Fields button and then click on the desired field.

§ Changing the character format 

To change the character format (font, font size, etc.) of text in the header/footer, use the controls located at
the top of the dialog box.

Note: First, select the text to be formatted (in one of the three input fields).

Formatting headers and footers

In addition to changing the character format of headers/footers (see above) you can also apply borders and
shades or change the alignment and margins. To do so, click on the Format button in the main dialog box of
the ribbon command Layout | Header and footer.

The program displays another dialog box containing the following tabs:

§ Shading tab 

Here, you can add a colored shade or a pattern to the headers/footers. The controls in this dialog box are
identical to those described in Shading.

§ Borders tab 

Here, you can add a border or individual border lines to the headers/footers. The controls in this dialog box
are identical to those described in Borders.

§ Alignment tab 

Here, you can change the inner margins and the vertical alignment of the headers/footers.

Tip: The distance between headers/footers and the top/bottom edge of the page cannot be changed here, as
they must be changed in the main dialog box "Page setup" on the Page format tab.

Disabling headers/footers temporarily

If you want to print a document occasionally without its headers or footers, choose the command Layout |
Header and footer and disable the option Print in the dialog box. The headers or footers will then be retained
but will no longer appear in printouts.

If you want the headers/footers to be printed again, simply enable the option Print again.
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Adjusting page breaks manually

Page formatting also includes the possibility of manually controlling the automatic page break if required.

Normally, PlanMaker includes the page break without your intervention: It automatically inserts a page break at
the end of a printed page (depending on the page format you have set, see Setting page format). If you take a
closer look at a worksheet, you will notice that some of the gridlines between cells are darker. These lines
indicate where PlanMaker has inserted automatic page breaks. 

Note: On the ribbon tab View | group View, enable the option Show page breaks if the dark gridlines for
page breaks are not displayed.

Inserting a manual page break

If necessary, you have the option of manually inserting "hard" page breaks which override PlanMaker's
automatic page breaks. To do so, choose the ribbon command Layout | group Page setup | Page break. In the
dropdown menu of this command, you will find the following options:

For horizontal page break

§ Insert before row inserts a horizontal page break above the current row. 

§ Delete before row deletes such a page break. Navigate to a cell located directly below the page break before
selecting this command.

§ With the options Move break one row up/down, you can change the position of the page break by one row
at a time. Navigate to a cell located directly below the page break before selecting this option.

Note: The latter options are only enabled after you have inserted a horizontal page break.

For vertical page break

§ Insert before column inserts a vertical page break to the left of the current column.

§ Delete before column deletes such a page break. Navigate to a cell located directly to the right of the page
break before selecting this option.

§ With the options Move break one column left/right, you can change the position of the page break by one
column at a time. Navigate to a cell located directly to the right of the page break before selecting this
option.

Note: The latter options are only enabled after you have inserted a horizontal page break.

The command Delete all page breaks removes all manually inserted page breaks again.

Tip: Using the "Page break preview"

FreeOffice: The Page break preview feature is not included in SoftMaker FreeOffice.

To visually check the page breaks, you can enable the option Page break preview on the ribbon tab View |
group View. You will then see printout pages with their page numbers (displayed as "watermarks" which are
not printed) clearly arranged with page breaks.
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The area that is filled with data is automatically marked in white by PlanMaker and thus – without further
adjustments – leads to the displayed printout pages.

Adjusting manual page break with the mouse

You can manually adjust the vertical/horizontal page breaks in the Page break view by dragging a page break
(recognizable by the green dashed line) while holding down the left mouse button. The page break line will
change to a red line, indicating that the automatic page break will become a manual one. The page numbers are
recalculated in the process.

The manual page break adjusted in this manner does the following:

§ By moving a page break with the mouse, for example, you can now enlarge the range that will be on a page
when printing. 

§ In the dialog box Page setup (see Setting page format options), the Scaling mode is automatically set to the
option Use fixed scaling factor and the value for Scaling (%) is adjusted to the changed page ranges.

Explanation: The value for Scaling (%) is never scaled up by moving the page breaks with the mouse. However, you can enter a
higher scaling value here so that a small page range is enlarged when displayed on a printed page.

§ Above this (in the same dialog box), a Print range is defined automatically if you have moved the outer
edges of the white shaded area with the mouse. 

Resetting manual page breaks

To reset the page breaks (that you have changed with the mouse) to their original state, you can proceed as
follows:

Open the dialog box Page setup (see Setting page format options). Here, set the value for Scaling (%) back to
100% and, if necessary, remove the newly created Print range in the input field above.
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Searching and replacing
This chapter covers information on searching (and replacing) in tables:

§ Search and replace 

Use PlanMaker's search options to search a table for a specific search term – and replace the occurrences of
the search term with something else if necessary.

§ Jumping to specific cell addresses 

Use the command Go to … to jump to specific cells, cell ranges, or named ranges.

§ Jumping to specific elements of a table 

Use the three buttons in the lower right corner of the document window to jump to specific parts of a table
(for example, to the next cell with an error value or comment).

See the following pages for more information.

Search

You can search a document for a specific term using the ribbon command Home | Search .
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Proceed as follows:

1. If you want to limit the search to a specific cell range, select the cell range first. If nothing is selected, the
search is performed on the entire worksheet.

2. Choose the ribbon command Home | Search .

3. Under Search for:, enter the search term.

4. Enable the desired search options (see Advanced search options) if required.

5. Click on the Search button to start the search.

PlanMaker scans the document for the search term and highlights the first cell that contains it.

You now have the following options:

A.You can click on Search again to proceed to the next occurrence of the search text.

B. You can close the dialog box by choosing Close.

Replace
Sometimes, you not only want to find a search term, but you also want to replace it with another term. The
ribbon command Home | Replace (in the Search group) is used for this purpose.

Proceed as follows:

1. If you want to limit the search to a specific cell range, select the cell range first. If nothing is selected, the
search is performed on the entire worksheet.

2. Choose the ribbon command Home | Replace .

3. Under Search for:, enter the search term.

4. Under Replace with:, enter the term that is to replace the search term.

5. Enable the desired search options (see Advanced search options) if required.

6. Click on the Search button to start the search.

PlanMaker scans the document for the search term and highlights the first cell that contains it.

You now have the following options:

A.You can click on Replace, whereupon the search term is replaced with the replacement term and PlanMaker
jumps to the next occurrence of the search term.

B. You can click on Search again, whereupon PlanMaker jumps to the next occurrence of the search term –
without replacing the term.

C. You can click on Replace all, whereupon PlanMaker replaces all occurrences of the search term.

D.You can close the dialog box by choosing Close.
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Repeating a search/replace
To repeat a search or replace operation or to continue it after canceling, choose the ribbon command Home |

Search again  or simply press the F3 key.

PlanMaker continues the search and displays the next occurrence of the search term.

Advanced search options

In the dialog box of the ribbon command Home | Search  or Home | Replace , you can click on the
Enlarge button, which expands the dialog box and offers additional options.

Clicking on Reduce makes the dialog box smaller again. This allows you to decide for yourself whether you
would prefer to have many settings options or whether you would rather see as much of the worksheet as
possible when searching.

The enlarged Search and replace dialog box offers the following additional options:

"Search in" section

Here, you can specify how to scan the document:

§ Search in 

Use this dropdown list to select which parts of the worksheet to scan: Cells, Comments or Frames (text
frames and drawings containing text).

§ Formulas 

If this option is enabled, all formulas in cells will be scanned.

For example, you can search for "Sum" to find all cells that use the SUM function.

§ Results 

If this option is enabled, all results of formulas will also be scanned.

For example, when you search for "4", cells containing the calculation =2+2 will also be found.

(This option is only available for the search command but not for the replace command.)

§ Values 

If this option is enabled, all fixed values will be scanned (thus, manually entered numbers, strings, etc.).
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§ Whole document 

If this option is enabled, all worksheets in the document will be scanned.

If it is disabled, only the current worksheet will be scanned (or all worksheets that are currently selected in
the worksheet register).

§ Search by column 

If this option is enabled, the worksheet will be scanned column by column.

If it is disabled, the worksheet will be scanned row by row.

"Options" section

Here, you can specify the following options for searching:

§ Case-sensitive 

The case of letters in the search term is ignored by default. Thus, if you search for "house", not only
"house", but also "House", "HOUSE", "HouSe", etc. will be found.

If you enable this option, however, the program will only find those occurrences of the search term where
the cases of the letters correspond exactly to the cases of the letters in the search term. Thus, if you search
for "house", only "house" will be found.

§ Whole cell match 

By default, PlanMaker finds all cells that contain the search text in any position. If you enter "win" in the
Search for field, PlanMaker will also find cells containing "windows" or "sales, winter 2018".

If you enable this option, however, the entire cell content must match the search term. When searching for
"win", only cells with the exact content "win" will be found.

"Special" button

The Special button allows you to use the following wildcard characters in your search terms:

§ Single arbitrary character (^?) – this placeholder represents a single arbitrary character. For example,
when you search for "fo^?d", PlanMaker finds occurrences of "fold", "fond", "food", etc. 

§ Multiple arbitrary characters (^*) – this placeholder represents any number of arbitrary characters. For
example, when you search for "f^*r", PlanMaker finds occurrences of "fair", "flyer", "freighter", etc. 

§ Caret (^^) – searches for the character "^" (caret). 

§ Line break (^a) – searches for manual line breaks (inserted with Ctrl+¿).

To insert such a wildcard into the search term, click on the Special button and then select the desired wildcard
by clicking on it.

You can repeat and combine these wildcards as desired within your search term. Furthermore, you can use them
in combination with normal text.
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"Search all" button

You can click on the Search all button to obtain a list of all occurrences of the search term. When you click on
one of its entries, PlanMaker jumps to the corresponding occurrence in the document.

Note: This button is only available when the option Search in is set to Cells.

Jumping to specific cell addresses

The command Home | Go to  (in the group Search) is used to set the cell frame to a specific cell in the table.

The program displays a dialog box in which you can enter the desired cell address. Both an individual cell
address (for example, D2) and a cell range (for example, D2:D4) are permitted.

In the list below the input field, all areas of the table named with the ribbon command Formula | Named area |
Edit names are still listed so that they can also be accessed immediately.

If you confirm with OK, PlanMaker will immediately select the corresponding cell or cell range.

Tip: A faster method

There is also a faster method: In the Edit toolbar (above the table window), there is a dropdown list on the left,
which usually shows in which cell the cell frame is currently located.

Here, you can enter the address of a cell or cell range – just like in the dialog box of the command Home | Go
to. When you press the Enter key¿, PlanMaker highlights the corresponding cell(s).

In addition: If you click on the small arrow to the right of the list, it will open and display all named ranges for
selection. If you click on a name, the corresponding cell range will be immediately selected.

Jumping to specific elements of a table
Use the three buttons in the lower right corner of the document window to jump to specific parts of a table (for
example, to the next cell with an error value or a comment).
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You use these buttons as follows:

§ If you click on the button with the red dot, a small menu will appear. Then select the type of Go to operation
you want to perform from the menu (see below). 

§ If you click on the button with the up arrow, PlanMaker will jump to the previous position. If, for example,
you selected "Error value" in the menu, the previous cell with an error value will be displayed.

§ If you click on the button with the down arrow, PlanMaker will jump to the next position, for example, to
the next cell with an error value.

You can thus determine the purpose of the search via the menu that opens after clicking on the red dot. This
menu has the following items:

Menu item Explanation

Formula Jump to cells that contain a formula

Array formula Jump to cells that contain an array formula

Constant Jump to cells that contain a fixed value

Error value Jump to cells that contain an error value (see Error values)

Faulty cell Jump to cells that have been imported incorrectly – for example, cells using an Excel
arithmetic function that PlanMaker doesn't support.

Comment Jump to cells that contain a comment

External reference Jump to cells that contain an external reference to another document

Conditional formatting Jump to cells that use conditional formatting

Input validation Jump to cells that use input validation

Search all worksheets If this option is enabled, PlanMaker searches all worksheets instead of just the current
one.
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Objects
You can insert different types of objects into your documents – such as charts, pictures, text frames, drawings,
etc.

In the following chapter, you will learn everything you need to know about the general use of objects:

§ Objects – basic procedures 

Here, you will learn about basic functions such as inserting, selecting and editing objects. You will also
learn about more unusual options, such as how to hide objects, group them, etc. The other settings that you
will find in the dialog box Object properties will also be explained in a separate section.

There will then be a detailed presentation of the individual types of objects:

§ Text frames 

§ Pictures

§ OLE objects

§ Drawings

§ QR codes/Barcodes

§ Charts (see chapter Charts)

§ Forms (see Form objects in detail)

Objects – basic procedures
In these sections, you will find basic functions for working with objects:

§ Inserting objects 

§ Selecting objects

§ Object mode

§ Changing position and size of objects

§ Rotating and flipping objects

§ Changing the order of objects

§ Duplicating objects

§ Changing the names of objects

Other less frequently used features for working with objects will be covered in the following sections:

§ Aligning and distributing objects 

§ Grouping objects
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§ Hiding objects

§ Changing the AutoShape of objects

§ Combining shapes

§ Editing shapes retroactively

§ Rotation of the inner text

§ Vertical alignment of the inner text

§ Changing text area for the inner text

§ Showing the contents of a cell in objects

The options of the dialog box Object properties will then be explained:

§ Changing object properties via the dialog box

Inserting objects

To insert a picture, for example, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture frame is now inserted.

You can then move or resize the frame:

To move it, click on the frame with the mouse, and then drag it to the desired position (while still holding
down the mouse button).

To adjust its size, drag one of the round handles surrounding the frame.

The process for inserting other types of objects is similar.

Note: As soon as you have inserted an object, an additional contextual ribbon tab Object (or picture, chart,
etc.) will appear on the far right and will enable you to conveniently edit the object properties via the
corresponding buttons.

For information on the different types of objects and how to adjust their properties, see Text frames, Pictures,
Charts, etc.

Selecting objects

If you want to edit an object, you must first select it. For most types of objects, it is sufficient to simply click on
the desired object. A frame will then appear around the object to indicate that it is now selected.
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Note: This does not work with text frames and other objects that have transparent fills. To select such an
object, click on its border or switch to object mode (see next section), where all types of objects can be easily
selected by clicking on them.

Once an object has been selected, you can only edit it and can no longer enter anything in the table cells. If you
want to edit table cells again, simply click on the desired cell with the mouse. This will deselect the object.

Object mode

Object mode provides the easiest way to work with objects.

Normally, you work with PlanMaker in edit mode. In this mode, you can enter data or calculations in table
cells, edit them, format them, etc.

If you switch to object mode, you will no longer be able to edit table cells. However, this mode offers many
functions that make working with objects easier. In object mode, for example, you can select all types of
objects with a click of the mouse.

Note: As long as you are in object mode, you only have functions for creating and editing objects. You can
no longer edit cells, and most of the commands are unavailable.

Switching between edit mode and object mode

There are several ways to switch between edit mode and object mode:

§ Choose the ribbon command View | Object mode  to access object mode. Choose the command again to
return to edit mode. 

§ Click on the icon  in the Quick access toolbar to switch between edit and object mode.

§ You can also right-click anywhere in the document. This will open a context menu in which you can choose
the command Object mode or Exit object mode. 

§ The quickest method is to hover over any free position within the document and double-click on it with the
right mouse button to switch between edit and object mode.

§ You can also return to edit mode from object mode at any time by double-clicking anywhere in the text
where no object is located.

Selecting objects in object mode

In object mode, you can select any type of object simply by clicking on it with the mouse.

This is especially useful for objects with transparent fills (for example, text frames) because such objects can
only be selected in edit mode by a targeted mouse click on the margin of the object. In object mode, however,
you can simply click on such objects anywhere to select them.
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To select several objects at once, use the mouse to draw a frame around the desired objects. Alternatively, you
can click successively on several objects while holding down the Shift keyñ to select them together.

Tip: Use the ribbon command Home | Select all  to select all objects.

Jumping from object to object

In object mode, you can also "jump back and forth" between objects. Use the following buttons:

Key Function

Tab Select next object

Shift+Tab Select previous object

Changing position and size of objects

To change the position or size of an object, proceed as follows:

Changing the position of objects

To change the position of an object, click on it to select it. You can now either drag it with the mouse to the
desired position or move it with the arrow keys on the keyboard.

You will also find such a handle  on all objects for moving the object with the mouse. This makes it easier
for you to handle small objects.

Note: By default, objects are anchored to the cell beneath their upper left corner. You can move objects as
desired, but when an object is dropped at its new position, it will be automatically anchored again to the cell
beneath its upper left corner.

This means that an object will move down if additional rows are inserted above it and move up if rows above
are deleted. The same happens if you change the height of rows above the object, for example.

If necessary, you can change this behavior by right-clicking on the object's frame to open the context menu and
selecting the last entry Properties, whereupon a corresponding dialog box appears. Switch to the Format tab
and change the option for Position. If, for example, you choose Independent of cell position and size, the
object will no longer move down when you insert or delete cells above it. For more information, see Object
properties, Format tab.

Changing the size of objects

The size of an object can be changed as follows:
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§ Dragging the handles on the selection frame 

Click on the object to select it. The object will then be surrounded by a blue selection frame which also
contains some round "handles". When you drag one of these handles with the mouse, the size of the object is
changed accordingly.

§ Using the dialog box 

You can also resize objects via the dialog box. Right-click on the object to open the context menu and select
the last entry Properties. On the Format tab, these settings can be specified exactly in numeric values. For
more information on this dialog box, see Object properties, Format tab.

§ Via the ribbon tab 

If you have selected an object, you will also find input fields for the Width and Height in the group Resize
on the far right of the object-specific ribbon tab. Type the desired values here or increase/reduce the values
with the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

For OLE objects, an additional option named Keep scaling is available. If it is enabled, any changes made
to the object's size within its source application will automatically affect the object in PlanMaker. If it is
disabled, the object will always remain the same size in PlanMaker. (Note: Not all OLE source applications
support this feature.)

Preventing changes to the position and size of objects

By locking an object, you can prevent it from being moved or resized with the mouse or the arrow keys on the
keyboard.

Select the object, right-click on it to access the context menu and then select the last entry Properties to open
the dialog box. On the Properties tab, enable the option Locked.

Now the object can no longer be moved with the mouse, and it cannot be resized by dragging its boundary lines.
The object also cannot be moved with the arrow keys of the keyboard. The position and size can only be
changed by entering values in the dialog box.

If you disable the option Locked again, the position and size of the object can also be changed with the mouse.

Rotating and flipping objects

Note: Only drawings and pictures can be rotated and flipped; this is not possible for other types of objects.

When you select an object that can be rotated, an additional green handle will appear on one of its borders. If
you drag this handle with the mouse, the object will rotate.

Tip: If you hold down the Shift keyñ, the rotation occurs at exactly 22.5° angles.
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Furthermore, there are the following ways in which you can also flip (mirror) drawings and pictures in addition
to rotating them:

§ You can use the Rotate object button  on the object-specific ribbon tab. 

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

§ You can do so via the context menu (right-click on the object) by selecting the entry Rotate or flip.

§ You can also set the desired rotation angle manually in the dialog box. Right-click on the object to open the
context menu and select the last entry Properties. In the dialog box, switch to the Format tab and enter the
angle in the Rotation section. In the Flip section, you can flip the object vertically or horizontally.

Changing the order of objects

If several objects overlap, you can determine the display order of these objects (which object is in the
foreground, which is in the background, etc.).

To do so, proceed as follows:

1. Right-click on the desired object.

2. Choose the command Order from the context menu. The program opens a submenu with the following
commands:

Bring to front: This option brings the object in front of all other objects.

Send to back: This option sends the object behind all other objects.

Bring forward one level: This option brings the object forward by one level.

Send backward one level: This option sends the object back by one level.

Tip: You can also execute these commands on the object-specific ribbon tab on the far right via the Bring to
front and Send to back buttons (in the group Position).
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Duplicating objects

To obtain a duplicate of an object, you can copy it to the clipboard in the usual way and then paste it back from
there.

Alternatively, you can also use the Duplicate button  on the object-specific ribbon tab. This command
immediately creates a copy of the selected object.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

Tip: Duplicating an object is even faster with the mouse: If you drag an object while holding down the Ctrl
key, you immediately obtain a duplicate of that object.

Changing the names of objects

Every object in a document must have a unique name.

Normally, you do not have to worry about these names as they are automatically assigned by PlanMaker: If you
insert a rectangle into an empty document, it is automatically called "Rectangle1". If you insert a picture, it is
called "Picture1", the next picture is called "Picture2", etc.

Tip: The name of the currently selected object is displayed on the left in the status bar.

However, you can change the names of objects at any time. If, for example, you have created a form that
contains a list for entering the place of residence, you would naturally name this list "residence". To do so,
right-click on the list to access the context menu and select the last entry Properties to open the dialog box.
Switch to the Properties tab and change the entry in the Name field.

Remember that names must be unique. If you attempt to assign a name to an object that is already in use for
another object, PlanMaker will reject it and display an error message.

Note: Newly inserted "Tables in worksheets" are also given a unique name, which can be changed via the
Table properties. For more information, see Formatting tables in worksheets.

Aligning and distributing objects

To align or evenly distribute two or more objects, select them and click on the Align objects  button on the
object-specific ribbon tab.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

In the displayed dropdown menu of Align objects, select the desired alignment or distribution:
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§ Align left: This option aligns objects to the left edge of the object placed furthest left. 

§ Align center: This option aligns the objects horizontally centered to each other.

§ Align right: This option aligns the objects to the right edge of the object placed furthest right.

§ Align top: This option aligns the objects to the top edge of the top object.

§ Align middle: This option aligns the objects vertically centered to each other.

§ Align bottom: This option aligns the objects to the bottom edge of the bottom object.

§ Distribute horizontally: This option distributes objects evenly between the left edge of the object furthest
left and the right edge of the object furthest right.

§ Distribute vertically: This option distributes objects evenly between the top edge of the top object and the
bottom edge of the bottom object.

The last two commands only work if at least three objects are selected.

Tip: You will also find the commands for aligning and distributing objects in the context menu by right-
clicking on the selected objects and selecting the entry Align or distribute.

Grouping objects

When you group several objects, you combine them into a unit that can be selected and manipulated like a
single object.

In practice, this means the following:

If you click on an object that belongs to a group, the entire group is selected. You can then move the group, and
all objects of the group will also be moved.

Once the group is selected, clicking subsequently on a single object of the group will enable you to edit that
object separately. It can then be moved, rotated, enlarged/reduced, provided with text or even deleted within the
grouping.

To group objects, proceed as follows:

1. Select the objects to be grouped. To do so, click on the objects successively while holding down the Shift
keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Click on the Group icon  (in the Objects group) on the object-specific ribbon tab. Alternatively: Right-
click on the selected objects and choose Group in the context menu.

Ungrouping objects

To ungroup objects, proceed as follows:
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1. Select the group by clicking (once) on one of the objects in it.

2. Click on the Group icon  again or choose the command Ungroup via the context menu.

Hiding objects

If necessary, you can hide an object so that it will not appear on the screen and/or on a printout.

Select the desired object and right-click to open the context menu. Select the last entry Properties to open the
dialog box, switch to the Properties tab and proceed as follows:

§ If you disable the option Visible, the object will no longer be displayed on the screen. 

§ If you disable the option Printable, the object will no longer appear in the printout.

Tip: Show hidden objects anyway

If you have inadvertently made an object invisible, you can always choose the ribbon command File |
Properties and enable the option Show hidden objects on the Options tab. Now all hidden objects are
displayed again. Thus, you can now select the object and enable the option Visible to make it visible again.

Changing the AutoShape of objects

Objects can be replaced afterwards with another shape using the ribbon command Change AutoShape ,
while retaining the existing formatting.

Tip: For more options for changing the shape of objects, see Combining shapes and Editing shapes
retroactively.

Replacing the shape of drawings and text frames

To replace the shape of drawings (AutoShapes, lines, curves, TextArt objects) or text frames with another
shape, proceed as follows:

1. Select the desired object.

2. Click on the Change AutoShape button  (not available in SoftMaker FreeOffice) on the contextual
ribbon tab Object | group Edit.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the last entry
Properties. In the dialog box, switch to the "AutoShapes" tab.

3. Select the desired new shape in the list.

The contours of the object will then change to the selected shape.
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Replacing the shape of pictures

To replace the shape of pictures with another shape, proceed as follows:

1. Select the desired object.

2. Click on the small arrow of the Cropping icon  on the contextual ribbon tab Picture | group Size and
select the entry Change shape in the dropdown menu that appears.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the entry
Change shape there.

3. Select the desired new shape from the list.

The contours of the picture frame will then change to the selected shape.

Tip: The command Photo frame  (not available in SoftMaker FreeOffice) on the contextual ribbon tab
Picture | group Format provides another method of changing the shape of pictures. Here, you can choose from

different variants. Some of these variants display handles  that enable you to further adjust certain parameters
of the shape by dragging them. You can also use the small square  in the center to display the shadow with a
varying offset.

Combining shapes

FreeOffice: The Combine objects feature is not included in SoftMaker FreeOffice.

Note: This feature is only available for drawings and text frames; it is not possible for other types of objects.

In PlanMaker, you can combine two or more shapes into one overall shape using the command Combine

objects , and different variants of the merge can be selected. This allows you to quickly create individual
drawing objects.

Important: The new overall shape always assumes the formatting of the first selected object.

Proceed as follows:

1. Select two or more objects (drawings/text frames) that you want to combine.

To do so, click on the objects successively while holding down the Shift keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Choose the command Combine objects  (in the group Edit) on the contextual ribbon tab Object.

Alternatively, you will find the command in the context menu after right-clicking on the selected objects.

3. In the dropdown menu, select the desired variant for combining the objects (see below).
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Variants of the command "Combine objects"

As mentioned at the start, the first selected object is the reference object whose formatting will be applied to the
new overall shape when each variant of the command Combine objects is chosen. This is the fill color, for
example, in the following illustrations.

The following variants are available:

§ Union 

This option creates a new common shape with a consistent outer contour of all selected shapes:

§ Combine 

The non-overlapping parts of the shapes are preserved, while the overlapping areas become transparent:

§ Fragment 

New separate shapes are formed along the intersecting lines of overlapping shapes. These can then be moved
individually – as shown on the far right in the following figure:

§ Intersect 

This is the counterpart to Combine. Only the overlapping area is preserved, and the non-overlapping areas
disappear:
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§ Subtract 

The overlapping areas are removed from the first selected shape, and the following selected shapes
themselves disappear:

You can move the new shape like a "normal" object, resize it, add text to it, etc. There are also black corners or
vertices that allow you to customize the contours of the shape. For more information, see the next section
Editing shapes retroactively).

Editing shapes retroactively

There are several methods of retroactively adjusting the shape of objects:

§ Drawings/text frames can be given a different AutoShape via the ribbon command Change AutoShape 
(in the group Edit). For more information, see Changing the AutoShape of objects. 

§ You can also use the command Combine objects  (in the group Edit) to combine two or more shapes
into one overall shape. For more information, see Combining shapes.

§ Additional handles  are displayed for some types of AutoShapes. If you drag one of these handles, a
parameter controlling the shape of the object is changed. For stars, for example, the length of the points can
be changed, and for rounded rectangles, the rounding of the corners can be changed.

For pictures whose shape has been changed via the ribbon command Photo frame  (in the group
Format), these handles also appear for some variants.

In this section, the command Edit points  is used to describe a very individual method of customizing
certain objects (drawings, text frames or pictures) to your liking – by editing points of the object via the "Bezier
tools". Technically, you use this command to convert an AutoShape into a curve.

FreeOffice: The Edit points feature is not included in SoftMaker FreeOffice.

To do so, proceed as follows:

1. Select the object and choose the command Edit points  on the contextual ribbon tab Object | group Edit.

Tip: For pictures, you will find the command only via the context menu. (Right-click on the object.)

After switching to "Bezier Mode" via the command Edit points, you will see small black corners or vertices
on the object's contour line (Note: Bezier mode remains constantly for the object once enabled).

2. Drag the black points via the mouse to change the shape.
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3. Optional: For shapes with curves, a blue line (tangent) with a small square (handle) also appears when you
left-click on one of the black points. Use the mouse to take hold of the blue square in order to change the
angle of inclination and length of the curve. See also the next section "Other options via the context menu".

Note: If you ensure that you are positioned exactly on the points (or the line segments, see below) with the
mouse, the mouse cursor will then change to crosshairs .

Other options via the context menu

You will find additional editing options in the context menu by right-clicking on one of the small black points
or on a line segment of the object.

For points, you can choose between the following options in the context menu:

§ Auto point 

The angle and length of the tangent are set to a default value for automatic smoothing. No tangent for
adjusting the angle and length appears accordingly for this option.

§ Straight point

A blue tangent appears. Both tangent halves are firmly connected, by angle and length. If one handle is
moved, the other handle changes analogously in terms of angle and length.

§ Smooth point

A blue tangent appears. Only the angle of the two tangent halves is connected, but not the length. If one
handle is moved, the other handle changes analogously in terms of angle. The length (and thus the gradient
of the curve) can be set independently.

§ Corner point

A blue tangent appears. Both tangent halves can be moved independently, both by angle and length.

§ Delete point

This option removes the selected point from the contour line.

For line segments, the context menu provides the following options:

§ Straight segment

The selected line segment between two points is straightened.

§ Curved segment

The selected line segment between two points becomes a curved line.

§ Add point

This option adds another editing point to the selected line segment.

§ Open curve/Close curve

You use Open curve to remove the line segment between two points. The option Close curve closes an
open shape and inserts a new line segment between the open ends.
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The entry Curve properties opens a dialog box where you can edit the properties of the created shape (fill, line
color, etc.) as with any other object. For more information, see Changing object properties via the dialog box.
Many of these options can also be found directly on the contextual ribbon tab Object (or Picture).

Rotation of the inner text

The ribbon command Object | group Inner Text | Text rotation is only available for objects with inner text.
You can thus use this command with Text frames and also with AutoShapes to which text has been added. For
more information, see the relevant sections.

Vertical alignment of the inner text

The ribbon command Object | group Inner Text | Vertical alignment is only available for objects with inner
text. You can thus use this command with Text frames and also with AutoShapes to which text has been added.
For more information, see the relevant sections.

Changing text area for the inner text

FreeOffice: The Change text area feature is not included in SoftMaker FreeOffice.

For Text frames and also for AutoShapes to which text has been added, you can resize the text area for the
inner text in PlanMaker.

To do so, proceed as follows:

1. Click on the frame of the object to select it.

2. Choose the command Change text area  on the contextual ribbon tab Object | group Inner text (or via
the context menu by right-clicking on the text frame).

Note: For drawings (AutoShapes, curves, etc.), you must first add text to the shape so that you can use the commands for the inner
text.

3. The frame of the inner text is now selected and some round navy "handles" appear. Drag one of these
handles via the mouse to resize the text area.

When your adjustments are complete, choose the command Change text area again or simply click anywhere
in the document.
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Showing the contents of a cell in objects

A link to a cell can be made in PlanMaker for Text frames, AutoShapes and also certain chart elements (chart
title, axis title). This enables you to transfer the contents of a cell – for example, the result of a calculation – to
an object for illustration purposes.

Note: This only works if there is no text in the object. Thus, delete existing text from the object beforehand.

The cell contents are displayed dynamically. So if the linked cell is overwritten with new data, the
corresponding content will also change in the object.

Proceed as follows:

1. Click on the frame of an object to select it.

(For chart elements, proceed differently. For more information, see chapter Chart title, Axis title)

2. Choose the command Add/edit link  on the contextual ribbon tab Object | group Inner text.

Alternatively: Right-click on the frame for the context menu, select Link to a cell.

3. A dialog box opens. Now click directly in the document on the cell whose content is to be displayed in the
selected object. Alternatively, you can type the cell address into the input field of the dialog box (for
example, "=Table1!A1").

Tip: It is also possible to link to cells on another worksheet in the document.

4. Click on Add.

The cell content of the selected cell is now displayed in the object. If the object is selected, you will see the cell
address that is linked to the object in the Edit toolbar.

If you want to change the font or alignment of the displayed text, select the object and use the commands on the
ribbon tab Home | group Character/Alignment or on the ribbon tab Object | group Inner Text.
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Changing object properties via the dialog box

The properties of an object include, for example, its size, fill color, borders, etc. These properties can be edited
centrally using the dialog box Object properties.

Note: Many object properties can also be conveniently edited directly via the icons of the contextual ribbon tab
Object (or Picture, Chart, etc.). Information about these ribbon tabs can be found in the respective section of
the corresponding object. However, some other options can only be set via the dialog box.

To change the properties of an object via the dialog box, right-click on the object frame to open the context
menu and select the last entry Properties. A corresponding dialog box appears.

Tip: For most types of objects, double-clicking on the object provides a quick alternative way to open this
dialog box.

The dialog box has several tabs that you can switch between by clicking on one of the tab headers at the top.

You will find detailed information on each tab and the options it contains on the following pages.

Object properties, Format tab

You can use the Format tab to make settings with respect to the format of the object, such as resizing it.

Available options:

§ Size and Scaling sections 

You can resize the object here. To do so, enter the desired Width and Height. Alternatively, you can change
an object's size by specifying the width as a percentage of the original width in Horz. scaling and the height
as a percentage of the original height in Vert. scaling.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

There is an additional option named Keep scaling for OLE objects. If it is enabled, any changes made to the
object's size within its source application will automatically affect the object in PlanMaker. If it is disabled,
the object will always remain the same size in PlanMaker. (Note: Not all OLE source applications support
this feature.)

§ Position section 

Here, you can choose to what extent the object's position and size are dependent on the table cells it covers.

Depends on cell position and size: The object behaves as if it were anchored to the cell covered by the top
left corner of the object. Thus, if you insert new rows above this cell, the object will be pushed down
accordingly.
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Furthermore, the object's size depends on the height and width of the cells it covers. If, for example, you
increase the width of these cells, the object will grow accordingly.

Depends only on cell position: The object also behaves here as if it were anchored to the cell covered by
the top left corner of the object. The object moves when you insert rows above it, but the size of the object
does not change when you resize the cells it covers.

Independent of cell position and size: The object always retains its original position and size, regardless of
the cells it covers.

§ Rotation section 

This option is only available for drawings and pictures.

Here, you can rotate the object. To do so, enter the angle at which you want to rotate the object clockwise.

§ Flip section 

This option is only available for drawings and pictures.

Here, you can flip the object vertically or horizontally.

Object properties, Fill tab

Note: This tab is only available for certain types of objects. For pictures, changes to the fill affect only the
transparent parts of the picture.

You can use the Fill tab to specify with what the object should be filled.

First, select the desired type of fill in the dropdown list Fill type. You can then make various settings for each
fill type.

The following fill types and settings are available:

Tip: You can also apply some of these options directly on the object-specific ribbon tab via the command
Fill color in the group Format.

§ No fill 

If you select the first fill type in the list, the object is not filled and thus remains transparent.

§ Solid color 

This fill type fills the object with a uniform color shade. Select the desired color in the list Colors.

Tip: Color lists only offer a few standard colors, but you can always compose your own colors. To do so,
click on More colors and then proceed as described in Document properties, Colors tab.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency). If, for example, you set the
transparency value to 25, the fill will have 25% transparency.
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§ Pattern 

This fill type fills the object with a pattern. In the list Patterns, select the type of pattern and then set the
desired color for the foreground and background.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency).

§ Picture 

This fill type fills the object with a picture file. You can use the Open button to determine the picture file
which you want to use for the fill. The most recently used picture files are displayed in the list Pictures and
can be selected there by clicking on them with the mouse.

Additional options:

Rotate with object: If you enable this option, the picture will also be rotated whenever you rotate the object
to be filled.

Mirror type: This option allows you to mirror the picture horizontally or vertically.

Transparency: If desired, you can use this option to change the transparency of the fill. You can enter any
value between 0% (no transparency) and 100% (full transparency).

Tile as texture: If this option is enabled, the picture is repeated in the object like a tile pattern.

You can then use the settings in the Tile options section to change the size and position of the tiles: X scale
and Y scale change the size (in percent), while X offset and Y offset change the position. The option
Alignment can be used to determine to which edge of the object the tiles should be aligned.

If the option Tile as texture is disabled, only Offsets (relative to the edges of the object) can be set for the
picture.

Save: You can use this button to export the currently selected picture, that is, to save a copy of it under any
name on your hard disk.

§ Linear gradient, Rectangular gradient, etc. 

The bottom five fill types are different types of color gradients. First, select the desired type of gradient in
the dropdown list Fill type and then select one of the subtypes in the list Variants.

In the Options section, you can specify the appearance of the gradient even more precisely:

X offset and Y offset enable you to move the center of the gradient. The Angle option allows you to set the
angle of rotation.

Tip: You can also change these settings by using the mouse to move or rotate the cross-hair displayed in
the Sample field.

If you enable the option Double gradient, for example, a black-white gradient will become a black-white-
black gradient.

In the Colors section, you can change the colors for the gradient as follows:

To change a color, first click on one of the small triangles below the bar representing the gradient. The left
triangle stands for the initial color, while the right triangle stands for the final color:
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Then select the desired color from the dropdown list Color below.

You can use the option Transparency to change the transparency of the selected color if desired. You can
enter any value between 0% (no transparency) and 100% (full transparency).

Additional colors can be added to the gradient by double-clicking on the desired position in the bar and
selecting a color. In the same way, namely by double-clicking on the triangle, additional colors can also be
deleted from the gradient.

Object properties, Lines tab

Note: This tab is only available for certain types of objects.

Use the Lines tab to specify the type of lines to use for the object. For drawings, this applies to the lines used to
draw the object; for all other objects, it applies to the lines that border the object.

Available options:

Tip: Many of these options can also be found directly on the object-specific ribbon tab in the command
group Format.

§ Variants 

Here, you can select the desired line style.

The entries in this list are merely default variants. If required, you can specify the appearance of the lines
more precisely via the options of the dialog box.

§ Color 

This option lets you specify the color of the lines.

§ Dashed 

Here, you can specify whether solid or dashed lines should be used.

§ Thickness 

Here, you can specify the exact thickness of the lines (in points).

§ Transparency 

If desired, you can use the option Transparency to change the transparency of the lines. You can enter any
value between 0% (no transparency) and 100% (full transparency).

§ Start point and End point (only available for lines, curves and connectors) 

Here, you can specify whether an icon should be drawn at the start point or end point of the line. If, for
example, you select an arrow icon for the end point, the line will look like an arrow. If necessary, you can
also change the Width and the Height of the icon.
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Object properties, Shadow tab

Note: This tab is only available for certain types of objects.

Use the Shadow tab to add a shadow to the object.

Available options:

Tip: You can also apply many of these options directly on the object-specific ribbon tab via the command
AutoShape effects in the group Format.

§ Variants 

Here, you can select the desired type of shadow.

The entries in this list are only default variants; the other options in the dialog box allow you to specify the
appearance of the shadow even more precisely if necessary.

§ Scaling 

Here, you can change the size of the shadow (relative to the size of the object).

§ Offset 

Here, you can change the position of the shadow (relative to the object).

§ Perspective 

Here, you can change the Skew angle of the shadow.

For certain variants of the "Perspective Shadows" type, the Horizon can also be changed, which distorts the
shadow in perspective. If Horizon is a positive value, the shadow is in front of the object; if it is negative,
the shadow is behind the object.

§ Color 

Here, you can change the color of the shadow.

§ Blur 

If you enter a value greater than zero here, a blur effect is added to the shadow. The larger the value, the
softer the edges of the shadow are drawn.

§ Transparency 

Here, you can change the transparency of the shadow. You can enter any value between 0% (no
transparency) and 100% (full transparency). If, for example, you set the transparency value to 25, the
shadow will have 25% transparency.
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Object properties, 3D tab

Note: This tab is only available for text frames and drawings.

Use the 3D tab to add a three-dimensional effect to the object.

Select the desired type of 3D effect in the Variants section. The entries in this list are only default variants; the
other options on the 3D tab allow you to specify the appearance of the effect even more precisely if required.

In the preview field Sample, you can follow the result of your adjustments and finally confirm with OK if you
want to apply the settings.

Object properties, Effects tab

Note: This tab is only available for certain types of objects.

On the Effects tab, you can add various effects to the object.

The following effects and options are available:

§ Reflection 

If you enable the option Use reflection effect, the object is displayed as if it was located on a reflective
surface. The following variations are possible:

Visible part of object: This option specifies how much of the object should be visible in the reflection (in
percent).

Starting transparency: The reflection is softly faded out downwards. This value determines how
transparent the reflection should be at the top (in percent).

Y offset: This option moves the reflection upwards or downwards.

§ Soft edges

If you enable the option Use soft edges effect, the borders of the object will be given a blur effect. The
following variations are possible:

Width: This option specifies the width of the blur effect.

§ Glow 

If you enable the option Use glow effect, the borders of the object will be surrounded by a glow effect. The
following variations are possible:

Width: This option specifies the width of the glow effect.

Color: This option specifies the color of the glow effect.
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Object properties, Properties tab

On the Properties tab, you can change the general settings for an object.

Available options:

§ Name 

PlanMaker automatically assigns a unique name to every object in a document. For example, rectangles are
called rectangle1, ...2, ...3, etc. If desired, you can enter another name here.

Tip: The name of the currently selected object is displayed on the left in the status bar.

For more information on using names for objects, see Changing the names of objects.

§ Visible 

This option is enabled by default. It causes the object to be displayed on the screen. (For more information,
see also Hiding objects.)

If you disable this option, the object becomes invisible.

§ Printable 

This option is enabled by default. It causes the object to appear in the printout when you print the worksheet.
(For more information, see also Hiding objects).

§ Locked 

This option is enabled by default. It means that the size, position and all other properties of the object can no
longer be changed if you enable sheet protection. For more information, see also Sheet protection.

§ Text locked 

This option is only available for text frames and drawings that contain text.

This option is enabled by default. It prevents the text contained in this object from being edited when you
enable sheet protection. For more information, see also Sheet protection.

§ Link 

Here, you can enter a hyperlink – to a website, for example. To do so, click on the Select button, select the
type of link and specify the desired target. The target is opened when the user clicks on the object.

In the Jump target field, you can also specify the target position in the document to be opened.

In the case of pictures, the File name of the picture is displayed on this tab, while some information about the
picture that was used (resolution, color depth, etc.) is displayed at the top right.

Object properties, AutoShapes tab

Note: This tab is only available for pictures, text frames and AutoShape drawings.
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On the AutoShapes tab, you can assign an AutoShape to the object. Thus you can turn a rectangle into a speech
balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.

Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon tab
Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.

Additional tabs

There are additional tabs with more options for some object types. For information on these tabs, see the
section on the relevant object.

Changing the default settings for objects

You can change the default settings for objects (drawings, pictures, etc.) at any time. This is particularly
relevant for drawings (AutoShapes and lines). For certain other objects, there are restrictions on applying the
default settings.

If, for example, you don't like the default line thickness for drawings, simply set it to a different value. You can
also alter other default settings – for example, the default fill for drawings as well as the settings for shadows
and 3D effects.

Note: Changes to the default settings for objects only affect objects that you insert afterwards. Existing
objects remain untouched.

To change the default settings for objects, use the Set as default button in the dialog box Object properties.

For example, the default line thickness for drawings can be changed as follows:

1. Insert a new drawing (or click on an existing drawing).

2. Right-click on the object to access the context menu and select the last entry Properties to open the dialog
box.

3. Make the desired settings. To change the default setting for the line thickness, for example, switch to the
Lines tab and simply set the desired line thickness.

4. Important: Click on the Set as default button and not on OK.

5. The program displays another dialog box in which you can also limit which default settings should be
changed if necessary. As a rule, there is no need to change anything in this dialog box.

6. If you confirm with OK, the settings currently made in the dialog box will be set as the default settings for
new drawings.
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7. Confirm again with OK to exit the dialog box completely.

All drawings that you insert from now on will use the line thickness set in this way by default.

Note: The default settings for objects can be set separately for each document.

This concludes the general description of objects. The following sections present the various types of objects in
detail:

§ Text frames 

§ Pictures

§ OLE objects

§ Drawings

§ Charts (see chapter Charts)

§ Forms (see Form objects in detail)
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Text frames
You can use text frames to insert text boxes into a document. You can enter, edit and format text as desired in a
text frame.

Note: Text frames, by the way, are just AutoShapes (in this case, simple rectangles) to which text has been
added.

In this section, you will learn everything you need to know about working with text frames. The information
covers the following topics:

§ Inserting text frames 

§ Changing text frame properties via the ribbon tab

§ Changing text frame properties via the dialog box

See the following pages for more information.

Inserting text frames

To insert a text frame, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Text frame .

2. The text frame is now inserted.

You can then move or resize the text frame:

Important: Click with the mouse on the border of the text frame in order to move it. While still holding the
mouse button down, drag the text frame to the desired position.

To adjust its size, drag one of the round handles surrounding the frame.

The text frame is now created, and you can start entering text in it immediately.

When you have finished entering text, click on any cell to leave the frame. You can now edit worksheet cells
again. Conversely, you move from the body text back to the text frame by clicking into the frame.

Changing text frame properties via the ribbon tab

Numerous properties of text frames can be changed directly via the buttons of the contextual ribbon tab Object.
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The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a text frame by clicking on its border. It contains the
following buttons (from left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates (not included in SoftMaker FreeOffice): This option allows you to apply various
predefined color formats to the text field.

§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit borders for the text field or
the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape (not included in SoftMaker FreeOffice): This option allows you to assign a different
AutoShape to the text frame (formatting is retained). For more information, see Changing the AutoShape of
objects.

§ Edit points (not included in SoftMaker FreeOffice): This option allows you to give the text frame an
individual shape with the "Bezier tools". For more information, see Editing shapes retroactively.

§ Combine objects (not included in SoftMaker FreeOffice): This option allows you to combine two or more
shapes from different variants into one overall shape. For more information, see Combining shapes.

§ Text rotation: This option allows you to rotate the inner text by the specified angle.

§ Vertical alignment: This option determines how the inner text should be aligned between the top and bottom
edges of the frame.
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§ Change text area (not included in SoftMaker FreeOffice): This option allows you to adjust the size of the
inner text area. For more information, see Changing the text area.

§ Add/edit link: This option allows you to show the content of the selected cell in a text frame. For more
information, see Showing the content of a cell in objects.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option is not available for text frames. 

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.

Changing text frame properties via the dialog box

To edit the properties of a text frame via the dialog box, first select it. To do so, click on the border surrounding
the text frame or simply click on it in object mode (View | Object mode). Then right-click to open the context
menu and select Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: If you are using object mode, you can also access this dialog box instantly by double-clicking on the
text frame.

The following settings can be made in the dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the text frame. For more information, see
Object properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.



296Objects

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

In the case of text frames, there are two additional tabs with further options:

Inner text tab

You can use this tab to change settings for the text in the text frame.

Note: An AutoShape must contain text in order to be treated as a text frame. Thus, select the AutoShape and
type something in it, and then the Inner text tab will also be available.

Available options:

§ Inner margins section 

Here, you can change the margins between the text frame and the text it contains. If you enable the option
Automatic, PlanMaker will automatically determine suitable margins.

§ Overlapping objects section 

This setting determines what should happen if the text frame overlaps with another frame.

If the default setting Ignore object is enabled, PlanMaker will do nothing. In the area of overlap, the
contents of both frames will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, PlanMaker will automatically wrap the text in this
frame so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the frame:

Option Explanation

Top The text is aligned to the top edge of the frame. (This is the default setting.)

Centered The text is centered between the top and bottom edges of the frame.

Bottom The text is aligned to the bottom edge of the frame.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the frame and ends exactly at the bottom edge.
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§ Data link section 

For text frames (and for AutoShapes), you can create a link to a cell. This will display the contents of this
cell in the object. For more information, see also Showing the contents of a cell in objects.

AutoShapes tab

A text frame is actually an AutoShape that has been filled with text. AutoShapes are predefined shapes (such as
rectangles, ellipses, arrows, speech bubbles, etc.).

By default, a simple rectangle is used as an AutoShape for text frames. However, you can assign a different
AutoShape to the text frame at any time. Simply select the desired shape from the AutoShapes tab.

For more information on AutoShapes, see Drawings.
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Pictures
In this section, you will learn everything you need to know about working with pictures. The information covers
the following topics:

§ Inserting pictures 

§ Scanning pictures

§ Inserting pictures from the gallery/camera (Android and iOS)

§ Compressing pictures

§ Changing picture properties via the ribbon tab

§ Changing picture properties via the dialog box

See the following pages for more information.

Inserting pictures

To insert a picture, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture is now inserted.

If you want, you can then move or resize the picture:

To move it, click on the picture with the mouse, and then drag it to the desired position (while still holding
down the mouse button).

To adjust its size, drag one of the round handles surrounding the picture.

Options of the dialog box

The options in the above dialog box mean the following:

§ Save within document 

If the option is enabled, PlanMaker saves a copy of the picture in the document and uses this copy instead of
the original.

Note: If this option is enabled, the file size of the document may increase significantly.

If it is disabled, however, PlanMaker saves only a reference to the original picture file in the document.
Changes to the original picture file are thus always available in an updated form in PlanMaker.
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Tip: You can see the location of the original picture file in the picture properties. Right-click on the picture to open the context menu, and select
Picture: Properties. In the dialog box, switch to the Properties tab and take a look under File name.

Note: If the file path of the picture file changes, however, it will no longer be displayed in the document.

§ Copy to document's folder 

If the option is enabled, PlanMaker creates a copy of the picture file in the folder in which the document is
located and saves a reference to this copy instead of to the original.

This option is available only if the document has already been saved.

Scanning pictures

FreeOffice: Scanning pictures directly into a document is not included in SoftMaker FreeOffice.

Note: Scanning pictures directly into a document is possible only with the Windows version of PlanMaker.

With PlanMaker for Windows, you can scan originals directly into a document. You must have connected a
scanner to your computer and installed the corresponding software.

To scan something into the current document, proceed as follows:

1. Turn on the scanner and insert the original that is to be scanned.

2. On the ribbon tab Insert | group Objects | Picture frame , click on the arrow of the icon and select the
entry From scanner from the dropdown menu.

PlanMaker now enables your scanner's software. Make the desired settings (see scanner manual) and start the
scanning process. When this is complete, the scanned result will appear as a picture in the PlanMaker
document.

Selecting another source

If several scanners are connected to your PC, you can use the command Insert | Picture frame  | Select
source to decide from which of these sources you want to scan when you use the command Insert | Picture

frame  | From scanner.

Inserting pictures from the gallery/camera (Android and iOS)

Note: This function is available only in the Android and iOS version.

In the Android/iOS version, you can also insert pictures via the Gallery or Camera application on your device.

To do so, proceed as follows:
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Inserting a picture from the gallery

1. Position the text cursor where you want to insert the picture.

2. Choose the command Insert | group Objects | Picture frame  | From gallery.

3. Your Android/iOS device automatically opens its Gallery app. Select the desired picture by tapping on it.

The picture is now inserted.

Inserting a picture from the camera

1. Position the text cursor where you want to insert the picture.

2. Choose the command Insert | group Objects | Picture frame  | From camera.

3. Your Android device/iOS automatically opens its Camera app. Take a picture.

The picture is now inserted.

Compressing pictures

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the command Compress pictures  to reduce the memory size of images in PlanMaker. In this
way, you reduce the file size of the document and save capacity on your device or when sharing the document.

You can use the command effectively if your document contains pictures that were embedded in the document
when you inserted them using the option Save within document (see Inserting pictures).

Note: Pictures that were instead saved in the document as a reference to an external picture file are not affected
by compression. However, when executing the command, you have the option of subsequently embedding these
pictures in the document and compressing them here at the same time.

Proceed as follows:

1. In your document, select one or more pictures that you want to compress. An additional ribbon tab Picture
appears at the top right of the ribbon.

Tip: If you want to compress all pictures of the document, just choose the ribbon command File | group
File management | Compress all pictures and continue with step 2.a.

2. Choose the ribbon command Picture | group Adjust | Compress pictures .

2.a If your selection contains only pictures that have been saved in the document, the dialog box "Compress
pictures" opens immediately.

2.b If your selection contains pictures that have not been saved in the document, a message appears before
the dialog box opens, asking whether you want to embed these pictures now (see description below).



301Objects

3. In the Resolution section of the dialog box, choose between the predefined qualities or enter a custom
resolution.

In the Options section, you will find two more settings (see description below).

4. Confirm with OK.

After saving the document, you will notice a change in the file size.

Other options

§ Delete cropped areas of the pictures 

If you have cropped an image in your document using the command Pictures | Cropping and you do not
need the truncated remainder, enable this option. Once you press OK, the cropped image area will be
deleted and only the crop will be retained.

§ Embed and compress external pictures

This option allows you to embed and compress pictures in the document that you did not insert using the
option Save in document, but which are only saved in the document as a reference to the original external
file.

To explain this option, the following cases may occur:

a. You have selected only pictures that were not saved in the document. After choosing the command
Compress pictures, a message appears asking if you want to subsequently embed the pictures. If you click
on Yes, this option is already preselected in the following dialog box.

b. If pictures are selected that have already been saved in the document, this message also appears. If you
click on Yes (or also No), this option is freely selectable in the following dialog box.

c. If you have selected only pictures that have already been saved in the document, this message does not
appear. This option is not selectable in the dialog box.

Changing picture properties via the ribbon tab

Numerous properties of pictures can be changed directly via the buttons of the contextual ribbon tab Picture.

The contextual ribbon tab "Picture", left section



302Objects

The contextual ribbon tab "Picture", right section

This ribbon tab appears automatically when you select a picture. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the picture. Drag these handles with the mouse to crop the picture accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the picture. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the picture – for example, other color
modes (grayscale, black/white, etc.) and variations where the image was colored. For more information, see
also the next section ("Picture tab").

§ Compress pictures: Reduce the memory size of images in your document. For more information, see also
Compressing pictures.

§ Change source (not available in SoftMaker FreeOffice): Replace the picture with another one (formatting is
retained).
This corresponds to the File button in the dialog box. For more information, see the next section ("Picture
tab").

§ Reset: Reset the image-specific changes made to the picture, such as brightness, shading, rotate object, etc.,
to their default values. The non-image-specific settings are not reset, for example, line thickness and photo
frame.

§ Photo frame (not available in SoftMaker FreeOffice): This option allows you to apply a photo frame effect to
a picture.

§ AutoShape effects (not available in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.
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§ Rotate object: This option allows you to rotate a picture in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option allows you to create an immediate copy of the selected picture.

§ Width, Height: These options change the size of the picture. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties. You open the dialog box by double-clicking on the picture. For more information, see the next
section.

Changing picture properties via the dialog box

The properties of an object can be edited centrally via the Object properties dialog box. An object's properties
include, for example, its size, margins and numerous other settings options.

To edit the properties of a picture, right-click on the picture to open the context menu and select the entry
Picture: Properties, which opens the corresponding dialog box.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the ribbon tab
Picture.

Tip: You can also open this dialog box by double-clicking on the picture.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the picture and rotate it. For more
information, see Object properties, Format tab. 

§ Fill: This option allows you to change the fill. It is only visible for pictures with transparent areas. For more
information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply 3D effects. For more information, see Object properties, 3D tab.
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§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. It also displays information about the picture
you are using. For more information, see Object properties, Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the picture. For more information,
see Object properties, AutoShapes tab.

For pictures, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that are specific to pictures:

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Picture |
group Adjust.

§ Variants 

This list offers some predefined variations of the picture – for example, different color modes (grayscale,
black & white, etc.) as well as colored variants of the image.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

Tip: You will also find these variants via the command Recolor picture directly on the contextual ribbon tab Picture.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with the following additional options:

If you enable the option Mix with color and select a color below, the picture will be colored accordingly.

The options in the Cropping section can be used to crop the picture. This is useful if you only need part of
the picture. If, for example, the upper quarter of the picture is to be truncated, first select Use relative
values and enter the number "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture will not be truncated, but will be extended
with a frame.

Tip: You will also find a corresponding command Cropping directly on the contextual ribbon tab Picture. For more information,
see the previous section Changing picture properties via the ribbon tab.

§ Transparency section 

Here, you can make settings for the transparency of the picture:

Use picture settings: PlanMaker reads from the picture file which parts of the picture have been marked as
transparent and displays the picture accordingly. Note: Only pictures in GIF or PNG format contain such
transparency information.

No transparency: The picture will not be displayed transparently, even if it is a picture file with
transparency information.
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Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.

The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but they do
not affect the appearance of the picture in the document.

Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

§ File button 

You can use this button to replace the picture with another one and the formatting will be retained.

Tip: This corresponds to the command Change source on the contextual ribbon tab Picture.

§ Export button 

This option is available only for pictures that are saved in the document. You can use this button to export
the picture, that is, to save a copy of it on your hard disk under any name. The dialog box "Save as" appears
for this purpose.

If you enable the option Create a link to file here, PlanMaker also replaces the picture saved in the
document with a reference to the destination file. Thus, the picture is no longer saved within the document.

§ Compress picture button (not available in SoftMaker FreeOffice) 

This button allows you to reduce the memory size of pictures in your document.

Tip: This corresponds to the command Compress pictures on the contextual ribbon tab Picture. For more information on this
command, see Compressing pictures.
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OLE objects

Note: The use of OLE objects is only possible with the Windows version of PlanMaker.

With PlanMaker for Windows, you can embed objects created with other applications (drawings, pictures, etc.)
in your document.

Example: You can use the ribbon command Insert | OLE object frame (click directly on the icon itself) to
start the Windows Paint program from PlanMaker and draw something in it. If you exit Paint, the drawing will
appear in the PlanMaker document. It is now embedded in the document.

Advantage: You only have to double-click the drawing in the PlanMaker document and Paint will then be
restarted automatically. If you now edit the drawing in it and exit Paint again, your changes will be imported by
PlanMaker.

For this to work, the application that you choose must support OLE. OLE stands for Object Linking and
Embedding. The object that is imported from the other application into PlanMaker is called an OLE object.

In this section, you will learn everything you need to know about OLE objects. The information covers the
following topics:

§ Inserting OLE objects 

§ Editing OLE objects

§ Editing links to OLE objects

§ Changing OLE object properties via the ribbon tab

§ Changing OLE object properties via the dialog box

§ Using the SoftMaker Equation Editor

See the following pages for more information.

Inserting OLE objects

Note: The use of OLE objects is only possible with the Windows version of PlanMaker.

By choosing the ribbon command Insert | OLE object frame  (click directly on the icon itself), you can
embed an object that you have created with another application into a PlanMaker document. After embedding
such an object, you can still edit it with the application that you originally used to create it.

The command opens a dialog box with a list of all applications that can provide OLE objects. The entries which
are displayed here depend on the OLE-enabled programs that are installed on your system.
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If you select "Paintbrush Picture", for example, a window from Window’s Paint program (called Paintbrush in
some versions of Windows) will open. Create a picture in it and then exit Paint. The picture is now embedded
in your document. It can be edited again at any time – simply double-click on the picture in the document.

To insert an OLE object into a document, proceed as follows:

1. Choose the ribbon command Insert | group Objects | OLE object frame . To do so, click directly on the
icon itself.

2. A dialog box appears. From the list Object Type, select the source application from which you want
PlanMaker to receive the OLE object.

3. When you confirm with OK, PlanMaker will start the application that corresponds to the selected object
type.

4. Create the object in the application.

5. Exit the application.

6. The application may now ask if you want to update the object in the PlanMaker document. Confirm this with
"Yes".

7. The OLE object created in the other application is now created in the PlanMaker document.

You can then move or resize the object:

To move it, click on the object and then drag it to the desired position (while still holding the mouse button
down).

To adjust its size, drag one of the round handles surrounding the object.

Tip: If you click on the icon's arrow under Insert | OLE object frame instead of on the icon itself, you will
find a small selection of useful applications for quick access: TextMaker object and Presentations object. For
other applications, select More to access the dialog box described above.

Creating an OLE object from a file

If you don't want to create a new OLE object, but want to embed an existing file from another application as an
OLE object, you still choose the ribbon command Insert | OLE object frame, but you select the option Create
from File in this case.

The appearance of the dialog box changes: Instead of the list Object Type, the File input field is displayed.
Here, enter the full file name or click on the Browse button to open a dialog box that will enable you to search
your hard disk for the file.

If you specify a file and confirm with OK, the file will be inserted as an OLE object.

In doing so, Windows checks the file name extension to see if it is associated with a program that can be started
and it responds accordingly. If the file name extension is not registered, only an icon will appear for the
embedded file. If, on the other hand, Windows can associate the name extension with an OLE-enabled program,
the content of the embedded file will be displayed.
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Creating a link to the original file

For the option Create from File in the aforementioned dialog box, you can also select whether the file to be
inserted should be embedded or linked. If you leave the option Link disabled, PlanMaker will insert a copy of
the file into the document as an OLE object and save this copy in the document – thus the object will be
embedded in the usual way.

If, on the other hand, you enable the option Link, PlanMaker will insert the OLE object in the form of a link to
the original file. This does not change anything in terms of use. If you subsequently change the original file of
the OLE object with another program and reopen the PlanMaker document, however, the OLE object will have
also changed accordingly – the OLE object will thus be linked to the original file.

Editing OLE objects

Existing OLE objects can be edited as follows:

Select the OLE object and click on the OLE object icon  on the contextual ribbon tab OLE object. Select
Edit from the dropdown menu.

Tip: Alternatively, simply double-click on the OLE object to edit it. The object will be opened immediately
in the associated application, where it can be edited.

Another alternative: You can also use the context menu to edit an OLE object.

Proceed as follows:

1. Click on the OLE object to select it.

2. Right-click on the OLE object to open the context menu and select the menu item with the object name (for
example, Bitmap object). Selecting this menu item opens a submenu containing all OLE commands that are
available for this object. There is a command Edit for editing the object. Choose this command.

3. The source application associated with the OLE object will now start. Make the desired changes.

To return to PlanMaker, simply exit the object's source application. When exiting some applications, you will
be asked if you want to update the object in the PlanMaker document. Answer "Yes" – your changes will be
discarded otherwise.

Editing links to OLE objects

If you have created an OLE object from a file and enabled the option Link, you can edit this link to the source
file. To do so, right-click on the OLE object to open the context menu and choose the command Link.

Alternatively, simply click on the Edit link icon  on the contextual ribbon tab OLE object.
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The program will display a dialog box which lists all links in the current document. When you select a link, the
file name and type of the associated source file are displayed in the lower part of the dialog box.

The buttons of the dialog box allow you to perform the following actions:

Button Function

Update now This button updates the OLE object. Use this button if the source file has been changed by
another program and the changes are not visible in the PlanMaker document.

Open source This button starts the application associated with the OLE object and lets you edit the object in
it. Tip: Double-clicking on the object has the same effect.

Change source This button lets you select a different file as the source for the OLE object.

Break link/
Remove

This severs the link to the source file. The object is then embedded permanently in the
PlanMaker document. Changes to the source file no longer have any effect on the document.
However, the object can still be edited by double-clicking on it.

Update:
Automatic or
Manual

If you have selected the option Automatic, changes that you make to the source file using the
Open Source button are always updated automatically for the OLE object. If Manual is
selected, changes to the source file are not updated for the OLE object until you click on the
Update Now button

Changing OLE object properties via the ribbon tab

Numerous properties of OLE objects can be changed directly via the buttons of the contextual ribbon tab OLE
object.

The contextual ribbon tab "OLE object", left section

The contextual ribbon tab "OLE object", right section

This ribbon tab appears automatically when you select an OLE object. It contains the following buttons (from
left to right):
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§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ OLE object: You can Edit, Open or permanently Convert the selected object here.

§ Edit link: If you have created an OLE object from a file and enabled the option Link, you can edit this link to
the source file. For more information, see Editing links to OLE objects.

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the object. Drag these handles with the mouse to crop the object accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the object. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the object – for example, other color
modes (grayscale, black/white, etc.) and variations where the object was colored. For more information, see
also the next section ("Picture tab").

§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab. However, this
function is not supported by all OLE applications. 

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing OLE object properties via the dialog box

The properties of an object can be edited centrally using the Object properties dialog box. An object's
properties include, for example, its size, margins and numerous other settings options.

To edit the properties of an OLE object, first click on it to select it. Then open the dialog box by clicking on the
group arrow  in the bottom right corner of any command group on the contextual ribbon tab OLE object.

Alternatively: Right-click on the OLE object to open the context menu and select the entry OLE object
properties.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the OLE object. For more information, see
Object properties, Format tab. 

§ Fill: This option allows you to change the fill. However, this function is not supported by all OLE
applications. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the object. For more information,
see Object properties, AutoShapes tab. 

In the case of OLE objects, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that affect the graphical representation of the OLE object.

Note: Depending on the type of OLE object, some of these options may not have a function.

Available options:

§ Variants 

This list offers some predefined variations – for example, different color modes (grayscale, black & white,
etc.) as well as colored variants of the object.
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Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the object will be colored accordingly.

The options in the Cropping section can be used to crop the object. This is useful if you only need a section
of the object. If, for example, you want the upper quarter of the object to be truncated, first select Use
relative values and enter "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the object will not be truncated, but will be extended
with a frame instead.

Using the SoftMaker Equation Editor

FreeOffice: The SoftMaker Equation Editor is not included in SoftMaker FreeOffice.

Note: The SoftMaker Equation Editor is available only for Windows and is not included in all versions of
PlanMaker.

The SoftMaker Equation Editor allows you to graphically display mathematical and technical equations.

PlanMaker communicates with the Equation Editor via OLE, as described in the previous sections. In order to
add a graphical representation of an equation to your document, insert an OLE object that uses the Equation
Editor as the source application.

To do so, proceed as follows:

1. In PlanMaker, choose the ribbon command Insert | OLE object frame. To do so, click directly on the icon
itself.

2. In the list Object Type of the dialog box, select SoftMaker Equation Editor.

3. Confirm with OK to start the Equation Editor.

Tip: You can insert an equation even faster via the ribbon command Insert | Equation Editor object .

4. Create the desired equation.

5. When the equation is complete, simply exit the Equation Editor.

The equation is now embedded in the PlanMaker document as an OLE object.
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You can subsequently edit objects created with the Equation Editor at any time by double-clicking on them.
The Equation Editor is then restarted and opens the equation. Make the desired changes and then simply exit
the Equation Editor again.

You can also change the properties of the Equation Editor object by right-clicking on the Equation Editor
object, opening the context menu, and choosing the command OLE object properties.

Information from the creators of the Equation Editor

The SoftMaker Equation Editor is a special version of the MathType program from Design Science. If you frequently use equations in your documents,
you might find that MathType itself is even better suited to your needs than the SoftMaker Equation Editor. While just as easy to use as the Equation
Editor, MathType has a number of additional functions that can help you to become more productive and create more complex equations.

MathType is available in English, German and other languages. For information about how to purchase MathType, contact your software vendor or
Design Science directly.

Design Science, Inc.
140 Pine Avenue, 4th Floor
Long Beach, CA 90802
USA

Phone (USA): +1 (562) 432-2920 (for international customers)
+1 (800) 827-0685 (for customers within the USA and Canada)

Fax (USA): +1 (562) 432-2857

E-mail (English): sales@dessci.com
Website: www.dessci.com
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Drawings
PlanMaker provides several tools for creating drawings. You can insert the following types of drawing objects
into your documents:

§ Lines and curves (lines, arrows, connectors, curves) 

§ AutoShapes (various types of predefined shapes)

§ TextArt objects (lettering with effects)

In this section, you will learn everything you need to know about working with drawings. The information
covers the following topics:

§ Inserting drawings 

§ Adding text to AutoShapes

§ Changing drawing properties via the ribbon tab

§ Changing drawing properties via the dialog box

See the following pages for more information.

Inserting drawings

To insert a drawing, for example, a rectangle, proceed as follows:

1. Choose the ribbon command Insert | group Objects | AutoShape . Select the desired AutoShape – a
rectangle in this case.

2. Hold down the left mouse button and draw a frame of the desired size in the document.

3. The rectangle is now inserted.

You can then move or resize the rectangle:

To move the rectangle, click on it and (while still holding the mouse button down) drag it to the desired
position.

To adjust its size, drag one of the round handles surrounding the rectangle.

The application of drawings differs somewhat depending on the drawing tool used. The following is a list of all
available drawing objects and information on how to handle them:

Note: You can adjust the shape of drawings retroactively at any time. For more information, see Editing
shapes retroactively.
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AutoShape

You can insert AutoShapes using the AutoShape  tool. These are predefined shapes for various purposes –
standard shapes such as rectangles, but also symbols for flowcharts, stars, speech bubbles and many more.

As soon as you have selected an AutoShape, simply drag a frame of the desired size in the document while
holding down the left mouse button. If you want, you can then move the AutoShape with the mouse or resize it
by dragging one of the round handles at its corners.

Note: Additional handles  are displayed in some types of AutoShapes when they are selected. If you drag one
of these handles, a parameter controlling the shape of the object is changed. For stars, for example, the length of
the points can be changed, and for rounded rectangles, the rounding of the corners can be changed.

Tip: You can even enter text in an AutoShape – just like you can in a text frame. For more information, see
Adding text to AutoShapes.

Lines and curves

Use the Lines tool  on the ribbon tab Insert to draw lines and curves.

When you click on this icon, a list of available line and curve tools opens. Select the desired tool and then use it
as follows:

§ Lines 

You can use the tools at the top of the list to draw simple lines and arrows. After clicking on the desired
tool, simply draw a line in the document while holding down the mouse button.

Tip: If you hold down the Shift keyñ, the line is limited to 45° angles.

Note: Arrows are nothing more than ordinary lines for which an arrowhead was selected in the object
properties (Lines tab) by selecting the option Start point and/or End point.

§ Connectors (straight, elbow and curved) 

You can use these tools to drag connectors between two objects. The difference between the three types of
connectors can be seen in the following figure:

To do so, select one of these tools, and then drag the mouse cursor from one object to another while holding
down the mouse button. When you move the mouse cursor over an object, small blue rectangles will appear
at various points on the object. These show where the line can "dock" to the object. You can influence the

course of curved and angled connectors by dragging the diamond handle  via the mouse.
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Tip: You can change the type of connectors retroactively at any time. Right-click on the line to open the
context menu and choose between a straight, elbow or curved connector. Also available in the context menu:
The option Create new connector causes the shortest connection between two objects.

§ Curves 

The tools at the bottom of the list are used to draw curves:

You can use the Curve tool  to draw Bezier curves.

To do so, click on the starting point and then on any number of other positions. The curve "follows" your
mouse clicks automatically.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

You can use the Freehand form tool  to draw curves in the same manner as if you were using a pencil.

To draw freehand, move the mouse to the desired starting point, press and hold the left mouse button and
then start drawing as if using a pencil. Alternatively, you can release the mouse button and click on
another location where a straight line will be drawn.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

Note: The small black points on the contour line of curves enable you to further adjust the shape. Use the
mouse to drag such a point to another position. Further options can be found in the context menu by right-
clicking on the curve. For more information, see Editing shapes retroactively.

TextArt

You can insert TextArt objects using the TextArt object tool  on the ribbon tab Insert. TextArt objects are
used to create text effects.

If you enable this tool, a dialog box appears. Enter your text in the dialog box and then click on Variants to
select one of the predefined effects to be applied to the text. Then confirm with OK.

For information on the other options for TextArt objects, see Text tab.

Adding text to AutoShapes

You can add text to an AutoShape if desired. This text is then displayed within the AutoShape – exactly as it
would be in a text frame.

To do so, proceed as follows:

1. Select the desired AutoShape.

2. Right-click on it to open its context menu.

3. Choose the command Add text.
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The cursor flashes in the AutoShape. Thus, you can now type text inside the AutoShape.

Tip: There is another faster way to add text to an AutoShape: Select the AutoShape and just start typing.

You can use the commands of the ribbon tab Home | group Character and group Alignment to format the text
according to your needs..

When you have finished adding text, click anywhere outside the object. If you want to edit the text again later,
select the AutoShape again and choose the command Edit text from the context menu.

Note: By the way, the text frames presented at the beginning of this chapter are nothing more than AutoShapes
(simple rectangles in this case) to which text has been added. Thus, all information in Text frames applies
equally to AutoShapes to which text has been added.

Changing drawing properties via the ribbon tab

Numerous properties of drawings can be changed directly via the buttons of the contextual ribbon tab Object.

The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a drawing. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates (not included in SoftMaker FreeOffice): This option allows you to apply various
predefined color formats to the drawing.
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§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit border lines for the drawing
or the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape (not included in SoftMaker FreeOffice): This option allows you to assign a different
AutoShape to the drawing (formatting is retained). For more information, see Changing the AutoShape of
objects.

§ Edit points (not included in SoftMaker FreeOffice): This option allows you to give the drawing an individual
shape with the "Bezier tools". For more information, see Editing shapes retroactively.

§ Combine objects (not included in SoftMaker FreeOffice): This option allows you to combine two or more
shapes from different variants into one overall shape. For more information, see Combining shapes.

§ Command group Inner text: The commands of this group are only possible for shapes to which text has been
added. For more information, see Adding text to AutoShapes.

Text rotation: This option allows you to rotate the inner text by the specified angle.

Vertical alignment: This option enables you to determine how the inner text should be aligned between the
top and bottom edges of the frame.

Change text area (not included in SoftMaker FreeOffice): This option allows you to adjust the size of the
inner text area. For more information, see Changing the text area.

Add/edit link: This option allows you to show the content of the selected cell in an AutoShape. For more
information, see Showing the content of a cell in objects.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects. 

§ Rotate object: This option allows you to rotate a drawing in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing drawing properties via the dialog box

To edit the properties of a drawing via the dialog box, first select it by clicking on it. Then right-click to open
the context menu and select the last entry Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: This dialog box can also be opened by double-clicking on the drawing.

The following settings can be made in the dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the drawing. For more information, see
Object properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: Here, you can change the line style of the lines used to draw the object. For more information, see
Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

Furthermore, some types of drawings have additional tabs with additional options. (For more information, see
the following pages.)

AutoShapes tab (available only for AutoShapes)

This tab appears for drawing objects only for AutoShapes.

On the AutoShapes tab, you can assign a different AutoShape to the object. Thus you can turn a rectangle into
a speech balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.
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Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon
tab Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.

Inner text tab (available only for AutoShapes with text)

This tab appears only for AutoShapes to which text has been added (see Add text to AutoShapes) and for Text
frames.

You can use this tab to change settings for the text in the text frame.

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Object |
group Inner text.

Available options:

§ Inner margins section 

Here, you can change the inner margins for the text. If you enable the option Automatic, PlanMaker will
automatically determine suitable margins.

§ Overlapping objects section 

This setting determines what should happen if the object overlaps with another object.

If the default setting Ignore object is enabled, PlanMaker will do nothing. In the area of overlap, the
contents of both objects will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, PlanMaker will automatically wrap the text in this
object so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the
drawing:

Option Explanation

Top The text is aligned to the top edge of the object. (This is the default setting.)

Centered The text is centered between the top and bottom edges.

Bottom The text is aligned to the bottom edge of the object.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the object and ends exactly at the bottom edge.

§ Data link section 
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For AutoShapes, you can create a link to a cell. This will display the contents of this cell in the object. For
more information, see also Showing the contents of a cell in objects.

Note: The option is available in the dialog box only when you add text to an AutoShape (so that the "Inner
text" tab is displayed) and then remove the text from the AutoShape (so that a link can be added).

Text tab (available only for TextArt objects)

This tab appears only for TextArt objects. You can use this tab to select the desired TextArt effect as well as to
enter and format the text to be displayed.

Available options:

§ Text 

Here, you can type the text to be displayed.

§ Variants 

In this list, you can select the effect with which the text should be displayed.

§ Font section 

Here you can change the font and enable/disable the text styles Bold and Italic.

If you enable the option Same height, all letters (including lowercase letters) will be stretched to a uniform
height.

§ Spacing section 

The Characters option changes the spacing between characters. If values are less than 100%, the characters
are closer together. For values greater than 100%, the characters are further apart.

The option Lines changes the line spacing. This setting only affects text that consists of multiple lines.

§ Alignment section 

Here, you can change the alignment of the text. This setting only affects text that consists of multiple lines.

§ Vertical text 

If you enable this option, the letters of the text will be rotated by 90 degrees.

Transformation tab (available only for TextArt objects)

This tab appears only for TextArt objects.

You can use this tab to specify the type of shaping effect to be applied to the text. To do so, click on the desired
type of transformation.
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QR codes/Barcodes

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the ribbon command Insert | QR code/barcode frame  in PlanMaker to generate your own QR
barcodes or some common types of linear barcodes and insert them into the current document. The resulting
object corresponds to a picture frame.

Linear barcodes contain a series of lines with different widths, which you know from everyday items (food,
books, tickets, etc.).

QR codes, on the other hand, are primarily used to encode URLs that can be accessed by scanning them. In
practice, you can use this format, for example, to issue invoices including a QR code to your customers. After
scanning the code, the customer will be taken directly to the web page you have defined.

All types of codes that you create in PlanMaker can be scanned with a standard scanner app directly from the
screen or from the printout of the document. Use the scanner that is integrated into your smartphone, for
example.

To create and insert a QR code/barcode, proceed as follows:

1. Choose the ribbon command Insert | group Objects | QR code/Barcode frame .

2. This will then open a dialog box in which you can select under Type whether you want to generate a QR
code or one of the available linear barcodes. For explanations of the different types, see "Options of the
dialog box" below.

3. Enter the desired URL, text, or number in the field below. Or tap with the mouse directly on a cell that
contains the desired data for creating the code.

Note: For the types Barcode EAN-13 and Barcode EAN-8, you can only enter numbers. They must have
exactly 12 or 7 digits.

4. Click on Insert. The QR code or barcode is now inserted as a picture frame.

You can then move or resize the picture frame:

To move it, click on the picture frame with the mouse, and then drag it (while still holding down the mouse
button) to the desired position.

To adjust its size, drag one of the round handles surrounding the picture frame.

Options of the dialog box

After choosing the ribbon command QR code/barcode frame , you can select from the following types of
codes in the dialog box:
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§ QR code 

A QR code is a two-dimensional code that can accommodate large amounts of data. You can enter all
numbers and characters here, and there is no limit on the length of the entry.

§ Barcode128

Code128 is an alphanumeric bar code with high data density. You can use numbers and characters of the
ASCII code here, and there is no limit on the length of the entry.

The option Text can only be selected for this type. If it is enabled, the entered text is displayed below the
barcode. If the option is disabled, the display of the text is suppressed.

§ Barcode EAN-13

An EAN-13 code is a numeric barcode. 12 digits must be entered, while the 13th digit is a check digit that is
automatically generated and added at the end.

§ Barcode EAN-8

An EAN-8 code is a numeric barcode. 7 digits must be entered, while the 8th digit is a check digit that is
automatically generated and added at the end.

Changing properties of QR code/barcode objects

An inserted QR code/barcode is actually nothing more than a picture frame. To change the properties, right-
click on the object and select Picture:Properties in the context menu. In the dialog box that appears, switch to
the QR code/Barcode tab, where you can change the type of barcode and the data for a URL, text or number.

You can use the Export button to save a copy of the barcode picture in PNG format on the hard disk. The
dialog box "Save as" appears for this purpose.

All other options of the dialog box (or on the contextual ribbon tab Picture) correspond to a large extent to the
properties of picture frames as described in the Pictures section.
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Charts
You can use charts to graphically display the numeric values of a worksheet and thus present the "raw
numbers" more clearly.

In this chapter, you will learn everything you need to know about charts. The following topics are covered:

§ Inserting charts 

First, you will learn how to create a chart: Select the cells containing the data to be displayed, choose the
ribbon command Insert | Chart frame and select a chart type.

§ Editing charts 

This section contains all the information you need to edit charts. You will learn how to change the chart type
and the arrangement of the data series, how to work with the individual chart elements (data series, axes,
legend, etc.) and how to change the general chart properties.

§ Updating charts 

A chart always retrieves the values to be displayed from the cells that were selected when the chart was
created. If values in these cells change, the chart will be updated immediately. If desired, however, you can
disable this automatic updating.

§ Moving charts to another worksheet 

The ribbon command Chart | Chart location enables you to move a chart to another worksheet or even
create a separate chart worksheet for it. This chart worksheet contains only the full-sized chart without any
cells.
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§ Saving charts as pictures 

The ribbon command Chart | Save chart as a picture enables you to save an image of a chart in a picture
file.

Inserting charts

The ribbon command Insert | group Objects | Chart frame  enables you to insert new charts into the
document.

To do so, proceed as follows:

1. Select the cells containing the values to be displayed in a chart.

Tip: If you select row and/or column headings, they will be used automatically to label the axes and the
legend.

2. Choose the ribbon command Insert | group Objects | Chart frame  to open the dialog box. (Click on the
icon itself.)

Alternatively, you can click on the small arrow of the icon to list a dropdown menu with various chart types
that you can insert directly by clicking on them. If you choose More here, the dialog box will be shown
again.

3. In the dialog box, you can specify which type of chart you want to insert. To do so, select the required
Chart type and Subtype.

For more information about chart types, see Changing the chart type.

4. Confirm with OK.

5. The chart is now inserted.

You can then move or resize the chart:

To move the chart, click on it and (with the left mouse button still held down) drag it to the desired position.

To resize it, drag one of the round handles surrounding the chart.

Editing charts
You will learn how to edit charts in the next sections. The information covers the following topics:

§ Changing the chart type 

Use the ribbon command Chart | Chart type to determine the form in which the data will be represented in
the chart – for example, as bars, lines or in the form of a pie chart, etc.
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§ Changing the arrangement of data series 

On the ribbon tab Chart, you can specify whether you want to evaluate the data series to be displayed as
Series in columns or Series in rows.

§ Showing/hiding chart elements 

A chart contains various elements, such as data series, axes, a legend, etc. You can use the ribbon command
Chart | Add chart element to show or hide certain elements of the chart if necessary.

§ Editing chart elements 

You can select the elements of a chart by clicking on them and then edit them. You will learn how to do this
in this section.

§ Changing chart properties via the dialog box 

In addition to the properties of individual chart elements, there are also common chart properties that you
can change. These include various layout options, the chart type, settings for the data series, etc. You can
change these options on the contextual ribbon tab Chart (see below) or in the Properties dialog box
(accessible via the context menu).

For basic information on working with objects, see Objects.

Using the ribbon tab "Chart"

When you select a chart, the contextual ribbon tab Chart appears automatically.

The contextual ribbon tab "Chart", left section

The contextual ribbon tab "Chart", right section

This ribbon tab contains icons for the most important functions for editing charts:

§ New object: This option allows you to insert a new object into the document, and different object types are
available. 

§ Chart type/Chart subtype: This option allows you to select a chart type. (A subtype is only available for some
chart types.) For more information, see Changing the chart type.

§ Series in columns/rows: This option allows you to specify whether the data to be displayed should be
evaluated column by column or row by row. For more information, see Changing the arrangement of data
series.
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§ Chart colors: This option allows you to change the color scheme of the chart.

§ Add element: This option allows you to show or hide chart elements such as axis titles, gridlines, legends,
etc. For more information, see Showing/hiding chart elements.

§ List of all chart elements contained in the chart. If you click on an element in the list, it will be selected in the
chart – if you select an element in the chart, it will be displayed in the list.

§ Edit properties: You click on this option to edit the selected chart element and the corresponding dialog box
opens. For more information, see Editing chart elements.

§ Fill color, Line color, Line style, Line thickness: You can use these options to change the fill and border lines of
the selected chart elements. For more information, see Editing chart elements.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Chart location: For more information, see Moving charts to another worksheet.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option allows you to create an immediate copy of the selected chart.

§ Save chart as a picture: This option allows you to save an image of a chart as a picture file. For more
information, see Saving charts as pictures.

§ Width, Height: These options change the size of the chart. For more information, see Changing position and
size of objects.

Using the dialog box

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box that you open via the context menu (entry Chart: Properties).

Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner of any
command group of the ribbon tab Chart.

All options of the dialog box are explained in Changing chart properties via the dialog box.

Changing the chart type

The chart type determines how data will be displayed in a chart – for example, as columns, bars, lines, etc.

To change the chart type, proceed as follows:
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Directly via the icons of the command group "Type"

Many chart types can be used directly via the icons of the command group Type on the contextual ribbon tab
Chart:

1. Select the chart by clicking on it.

2. Click on the Chart type icon  on the ribbon tab Chart | group Type.

3. Select the desired Chart type from the dropdown menu (see below for explanations of the different chart
types). You may use the icon below it to select a Chart subtype (only available for certain chart types).

Additional options via the dialog box of the command group "Type"

You will find some more options via the dialog box of the command group Type on the contextual ribbon tab
Chart. Here, you can also survey the possible appearance of the chart in a preview.

1. Select the chart by clicking on it.

2. On the ribbon tab Chart | group Type, click on the group arrow  in the bottom right corner.

3. In the dialog box, switch to the ribbon tab Chart type.

4. Select the desired Chart type and Subtype.

Tip: A small preview of the currently selected chart will be shown in the right half of the dialog box. You
can enable or disable this preview at any time using the >> button or the << button.

The following chart types are available:

   Column chart

Column charts are a good way to compare values. Each value is represented by a correspondingly high
column.

   Bar chart

Bar charts correspond to column charts; however, the values are displayed horizontally rather than vertically.

   Line chart

Line charts display values as points and/or connecting lines.
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   Area chart

Area charts are line charts where the space between the X axis and the individual lines is filled with color.

   XY scatter chart

XY scatter charts display values as points and/or lines. Unlike line charts, the data area must contain both the
X and Y coordinates of the data points.

   Bubble chart

Bubble charts display values as filled circles ("bubbles"). Bubble charts are usually based on data series
containing three values: X coordinate, Y coordinate, and bubble size.

   Radar chart

Radar charts display values in a web. The zero point is in the center of the web.

   Surface chart

Surface charts display values as a three-dimensional shape. Areas plotted in the same color indicate that they
contain similar values.

The values to be displayed should have the following structure:

(Z values determine the height.)

   Pie chart

Pie charts are well suited to displaying the percentage of individual values of the total value. The size of each
"pie slice" shows the ratio of the value to the total and to the other values.
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Tip: You can highlight values by extracting the related slice of the pie from the pie. Select the slice of the pie
and extract it via the mouse.

   Doughnut chart

Doughnut charts, like pie charts, show the percentage of individual values of the total value. Unlike pie charts,
however, they can display any number of data series (rings) and not just a single series.

       Cylinder, Cone and Pyramid charts

Cylinder, Cone and Pyramid charts correspond to column and bar charts. However, they use cylinders, cones
or pyramids instead of columns/bars to display the values.

   Stock chart

Stock charts (also known as general high-low charts) are suitable for displaying the development of stock
prices, among other things. They enable the highest price, lowest price and closing price to be seen at a glance,
for example.

The following subtypes are available:

§ Stock chart (High, Low, Close) 

This type of chart displays the following values: highest price, lowest price, closing price.

It requires 3 data series in the above order.

An example of the possible structure of the data (with the date added in column A):

§ Stock chart (Open, High, Low, Close) 

This type of chart displays the following values: opening price, highest price, lowest price, closing price.

It requires 4 data series in the above order.

§ Stock chart (Volume, High, Low, Close) 

This type of chart displays the following values: trading volume, highest price, lowest price, closing price.

It requires 4 data series in the above order.
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The trading volume is displayed as an additional column with its own value axis.

§ Stock chart (Volume, Open, High, Low, Close) 

This type of chart displays the following values: trading volume, opening price, highest price, lowest price,
closing price.

It requires 5 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

   Box plot chart

Box plots (or box and whisker plots) are useful for data analysis in statistics. Detailed explanations relating to
the application of box plots would go beyond the scope of this manual. You can find further information on
them via your preferred Internet search engine.

There are two subtypes: Horizontal and Vertical.

Depending on the number of data series passed to the chart, different variants of box plots will be rendered:

Note: You can display any type of value in a box plot. The following lists show examples only.

§ 3-point box plot 

This box plot displays, for example, the following values:

Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)

This box plot requires exactly 3 data series in the above order.

§ 5-point box plot 

This box plot displays, for example, the following values:

Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)

This box plot requires exactly 5 data series in the above order.

§ 7-point box plot 

This box plot displays, for example, the following values:

Minimum (as a single marker)
Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)
Maximum (as a single marker)

This box plot requires exactly 7 data series in the above order.
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Changing the arrangement of data series

You can use the two icons  Series in columns and  Series in rows on the contextual ribbon tab Chart |
group Data to determine whether the data to be displayed should be evaluated column by column or row by
row:

§ By columns 

The first icon is selected by default, thus the data will be evaluated column by column. The values in the
first column will be the first data series, the values in the second column will be the second data series, etc.

§ By rows 

If you click on the second icon, the data will be evaluated row by row. The assignment of the rows/columns
in the worksheet to the X axis/Y axis in the chart is thus reversed.

Alternatively, you will also find this setting in the dialog box of the ribbon tab Chart | group Data (click on the
group arrow ) and switch to the Data source tab.

Showing/hiding chart elements

Certain elements of the chart can be shown or hidden if necessary. Some of them are shown automatically when
you create the chart, for example, the axes and the legend.

Tip: See Editing chart elements for an illustration of the most important chart elements.

The following elements can be shown/hidden:

§ Axes and axis titles 

§ Chart title

§ Data_labels

§ Error bars

§ Gridlines

§ Legend

§ Lines

§ Trendline

§ Up/down bars

For more information, see the following sections.
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Showing/hiding axes and axis titles

The horizontal X axis of a chart is also known as the category axis.

The vertical Y axis of a chart is also known as the value axis.

The Z axis of a chart is also known as the series axis. It is only available for certain three-dimensional chart
types.

Note: The X axis and Y axis are shown automatically when the chart is created.

To show or hide an axis, proceed as follows:

Via the "Add chart element" icon

You can use the Add chart element icon  on the contextual ribbon tab Chart to show or hide the X axis
and/or Y axis (the Z axis only in the dialog box, see below).

To do so, select the chart and use the ribbon command Add chart element  to select the entry Axis. In the
following submenu, you can use the entry Primary horizontal to show or hide the X axis and Primary vertical
to show or hide the Y axis.

The entry More takes you to a dialog box with additional options (see below).

Axis title: To add, change or remove axis titles, proceed as follows:

§ Adding axis title 

If you want to add an axis title to the axis, choose the ribbon command Add chart element and then select
the entry Axis title. Primary horizontal shows an axis title for the X axis, while Primary vertical shows it
for the Y axis.

The entry More also takes you to the dialog box here (see below).

§ Changing an axis title 

To rename an axis, double-click on the axis title and switch to the Text tab in the following dialog box.
Enter the desired text here.

§ Removing an axis title 

To remove an axis title, hide it again via the command Add chart element or select it directly in the chart
and press the Del key.

Via the dialog box

For additional axis options (for example, the Z axis or secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.
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2. Use the ribbon command Chart | Add chart element  to choose the entry Axis (or Axis title) and select
More in the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. Switch to the Elements tab.

Axes: The checkbox in front of each axis can be used to enable/disable the display of the relevant axis.

Axis title: To the right of the axis, you can give it a name. This will then be displayed below/next to the
axis.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

Editing axes and axis titles

For more information on editing the properties of axes, see Category axis (X axis), Value axis (Y axis) and
Series axis (Z axis).

For information on editing the properties of the axis title, see Axis title.

Showing/hiding chart titles

You can show or hide a chart title for the chart. The title will then be displayed above the chart.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Chart title. In
the following submenu, select Above chart to add a chart title. If you select None, the chart title will be
removed.

If you select More, you will be taken to the dialog box (see below) where you can rename the chart title.

Alternatively: Double-click on the chart title and you can then rename the title on the Text tab.

To remove a chart title, select it and press the Del key.

Via the dialog box

To show or hide the chart title via the dialog box, proceed as follows:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Chart title and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. On the Elements tab, you will find an input field for the Chart title at the top. Type the desired title here.
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To delete the chart title, simply remove the text from this input field.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

For information on editing the properties of the chart title, see Chart title.

Showing/hiding data labels

The data points of a chart can be labeled. This allows you to display the exact value of the data points in the
chart.

To show or hide data labels, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Data labels.
In the following submenu, you can choose between different options for positioning the data label (left,
centered, above, etc.). A check mark in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

Tip: To remove a single label, select it and press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options for data labeling, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Data labels and select More
in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Data labels tab and make the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Data labels" tab.
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Showing/hiding error bars

Note: This chart element is only available for certain two-dimensional chart types, such as column, bar and
line charts.

You can draw error bars for the data points of a data series. Error bars display the possible/tolerable error of
the values in the form of a line with a short dash at the end.

To show or hide error bars, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Error bars.
In the following submenu, you can choose from a predefined selection for displaying the values. A check mark
in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

Additional options for error bars can be found via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Error bars and select More in
the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Error bar tab and select the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Error bar" tab.

Showing/hiding gridlines

Showing gridlines in a chart can improve the legibility of its values. Gridlines are a network of lines that extend
across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.
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You can enable gridlines separately for each axis.

To show or hide gridlines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Gridlines. In
the following submenu, you can enable or disable horizontal (for the Y axis) and vertical (for the X axis) major
gridlines and minor gridlines for the primary axis. A check mark in front of them indicates the gridlines which
are currently enabled.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options (for example, gridlines for secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Gridlines and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. Switch to the Elements tab and enable the option Major grid and/or Minor grid for the desired axes.

For more information on editing gridlines, see Gridlines.

Showing/hiding the legend

If desired, you can show (or hide) a legend in the chart. A legend is a small box that shows which data series
are displayed in which color/pattern.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Legend. In
the following submenu, you can specify where to position the legend. A check mark in front of it indicates the
option which is currently enabled.

You can hide the legend by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:
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1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Legend and select More in the
following submenu to open the dialog box.

Alternatively: Select the legend and right-click to open the context menu and select the entry Legend:
Properties.

3. On the Legend tab, specify where the legend should be positioned. If you select the option Custom, the
legend can be moved to any position (using the mouse). If you select the option None, the legend will not be
displayed.

Tip: If you choose the entry Chart: Properties via the context menu, the main dialog box for charts
opens. You will find the option Legend here also on the Elements tab.

For more information on editing the properties of a legend, see Legend.

Showing/hiding lines

Note: This option can only be used for line charts and area charts.

You can use the options for lines, for example, to illustrate the spacing between the individual data series in a
line chart.

The following types of lines are available:

§ Drop lines are lines displayed from the data points to the horizontal axis. 

§ High-low lines are lines displayed between the highest and lowest data points (for two or more data series). 

To show/hide drop lines or high-low lines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Lines. In the
following submenu, you can choose between Drop lines and High-low lines. A check mark in front of it
indicates the option which is currently enabled.

You can hide the lines by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Lines and select More in the
following submenu to open the dialog box.
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Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Options tab and enable the desired settings.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.

Showing/hiding the trendline

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Other limitation: They are not available for stacked chart types.

If desired, you can add trendlines to the data series of a chart.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

To show/hide trendlines, proceed as follows:

Via the "Add chart element" icon

Select the desired data series to which you want to add a trendline.

Use the ribbon command Chart | Add chart element  to choose the entry Add trendline. In the following
submenu, select one of the predefined trendline types.

The entry Remove all removes all trendlines (select the chart for this purpose). To remove individual
trendlines, select the desired trendline and then choose Remove all or simply press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

You will find more trendline types and additional options via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Add trendline and select
More in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Add trendline.

3. Switch to the Trend tab and enable the desired settings.

For more information on the options of the dialog box, see Trendlines.
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Showing/hiding up/down bars

Note: This option can only be used for line charts.

You can use the option Up/down bars to display bars between the first and last data series, for example, in a
line chart with two or more data series.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element   to choose the entry Up/down
bars. In the following submenu, select the same entry.

You can use the entry None to remove the up/down bars.

The entry More takes you to the dialog box (see below) where you can also set the spacing between the bars.

Via the dialog box

Choose the path via the dialog box to make further settings:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Up/down bars and select
More in the following submenu to open the dialog box.

Alternatively: Select any data series and right-click to open the context menu and select the entry Series:
Properties.

3. Switch to the Options tab and enable the checkbox in front of Show up/down bars with gap. In the input
field below, you can set the gap between the bars.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.
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Editing chart elements

Charts consist of several components. In addition to the data series themselves, for example, there are axes, a
legend, etc. These individual components of a chart are called the chart elements.

The following figure shows the most important chart elements:

Series 1, Series 2, etc. represent the chart's data series.

Three-dimensional chart types contain some additional chart elements (floor, walls, etc.), which will also be
described on the following pages.

Each of these chart elements can be selected at the click of a mouse and then edited.

Selecting chart elements

To select a chart element, first click on the chart itself to select it and then click on the desired chart element.
To select a data series, for example, click on any value within this series.

Note: To select a single value within a data series, first click on the data series and then click on the desired
single value.

Tip: Alternatively, you can select chart elements by expanding the list of elements on the ribbon tab Chart |
group Chart elements and selecting the desired element from it. Here, you can always see which chart
element is currently selected.
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Changing the position and size of chart elements

The position and size of some chart elements (for example, the legend) can be changed. To move an element,
select it and then drag it to the desired position. To change its size, drag one of the handles surrounding the
element.

Changing the fill and borders of chart elements

The fill color and border lines of chart elements can be applied directly with the buttons of the command group
Chart elements on the ribbon tab Chart. To do so, select a chart element and make the desired adjustments
using the buttons Fill color, Line color, Line style and Line thickness.

Note: In the case of the buttons Fill color and Line color, the last color that you used will be applied again when you click directly on the
icon itself. By clicking on the icon's arrow, you open the color palette.

Only for the Fill color button: If you click on the icon's arrow, you can use the entry More Fills to also apply more complex fills. For
more information, see Object properties, Fill tab. By clicking on the entry More colors, you reach a dialog box with color definitions,
which you use according to the descriptions of the section Document properties, Colors tab.

You will also find fill and border settings via the dialog box of the chart elements (see next paragraph). You can
also change other properties here, depending on the type of chart element.

Changing properties of chart elements

In addition to changing the properties of the chart itself, as described later in Changing chart properties via the
dialog box, you can also edit the properties of individual chart elements.

To change the properties of a chart's legend, for example, proceed as follows:

1. Select the chart by clicking on it.

2. Right-click on the legend to open its context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen
and hold your finger there for about a second.

3. In the context menu, choose the command Legend: Properties (not the command Chart: Properties).

A dialog box will now appear in which you can make the desired settings.

Tip: Alternatively, you open the dialog box via the ribbon command Edit properties .

Even faster: Open the dialog box by double-clicking on the desired element.
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The properties that you can change in this dialog box depend on the type of chart element for which you opened
it. The following sections provide more information about all available chart elements and their respective
properties:

§ Chart area 

§ Plot area

§ Walls (three-dimensional charts only)

§ Floor (three-dimensional charts only)

§ Corners (three-dimensional charts only)

§ Data series and data points

§ Trendlines

§ Category axis (X axis)

§ Value axis (Y axis)

§ Series axis (Z axis)

§ Axis title

§ Chart title

§ Gridlines

§ Legend

Chart area

The chart area is the entire area of a chart frame.

Edit properties: To change the properties of the chart area, select it, right-click it to open the context menu and
choose the command Chart area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the chart area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the entire chart. Auto gives the chart a thin gray standard line as a border.
None removes the border. The option Custom lets you customize the line style.

If you enable the option Shadow, the chart frame will also be highlighted with a shadow. The Adjust button
opens additional settings for the appearance of the shadow effect.
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§ Fill section 

Here, you can change the fill of the chart area. Auto gives the chart area a white fill area. The fill will be
transparent if you use the option None. You can use the option Color to customize the color for the fill.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

Here, you can change the text formatting for all chart elements.

To do so, select the desired font, font size, alignment, etc.

Important: Changes will affect all chart elements, even if they were previously formatted in a different font.

Plot area

The plot area of a chart is the area where the data series, axes and gridlines are drawn.

Edit properties: To change the properties of the plot area, select it, right-click it to open the context menu and
choose the command Plot area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the plot area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the plot area. To do so, use the option Custom to select the desired line style.
The option None removes the border.

§ Fill section 

Here, you can change the fill of the plot area. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Walls (three-dimensional charts only)

 Walls are the back walls of charts that use a three-dimensional chart type.

Edit properties: To change the properties of the walls, select one of the walls, right-click it to open the context
menu and choose the command Walls: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the walls.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the walls. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the walls. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Floor (three-dimensional charts only)

Floors are only present in three-dimensional chart types.

Edit properties: To change the properties of the floor, select it, right-click it to open the context menu and
choose the command Floor: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the floor.

You can make the following settings:
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Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the floor. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the floor. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Corners (three-dimensional charts only)

Corners are only present in three-dimensional chart types.

Edit properties: To change the properties of the corners, select one of them, right-click it to open the context
menu and choose the command Corners: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements.

You can make the following settings:

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Data series and data points

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, pie segments, etc., depending on the chart type selected.

A data series is the graphical representation of a column or row of cell values on which the chart is based. Each
data series, in turn, consists of multiple data points, thus the individual cell values.
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Edit properties: To change the properties of data series or single data points, proceed as follows:

§ If you click on any of the data points of a data series, the entire data series will be selected. You can now
edit the properties of this data series by right-clicking on it to open the context menu and then choosing the
command Series: Properties. 

§ If you click on the same data point once again, only this single data point will be selected. The command in
the context menu is then called Point: Properties.

Tip: Alternatively, you can choose these commands via the Edit properties icon  on the ribbon tab
Chart | group Chart elements after you have selected the data series (or the data point).

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section (or Line section) 

Here, you can change the line style used to draw the graph. To do so, use the option Custom to select the
desired line style. The option None removes the line.

If you enable the option Shadow, the graph will also be highlighted with a shadow. You can use the Adjust
button to make other settings for the appearance of the shadow effect. (For some chart types, the option
Smooth line appears here instead, which enables you to give the graph a smoother gradient.)

§ Fill section 

Here, you can change the fill of the data series/data points. Auto gives the fill area a standard color. The fill
will be transparent if you use the option None. You can use the option Color to customize the color for the
fill. The color for negative values can be assigned a different color for certain chart types.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

§ Marker section (available only for certain chart types) 

Some chart types (for example, certain types of line charts) draw markers for each data point. Here, you can
customize the appearance of such markers.

3D format tab

Note: The options on this tab are available only for certain chart types.

Use this tab to add a light effect or bevels to the data points to be displayed.

§ Material 

Here, you can select the material that should be simulated to display the data points.
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§ Light 

Here, you can select the type of light that should be simulated.

§ Angle 

Here, you can change the angle of the light source.

Tip: The above effects usually look better if you also use the following option to add bevels to the data
points.

§ Bevels section 

Here, you can add a bevel effect to the graphical representation of the data points. If you apply these options
to a bar chart, for example, the edges of the bars will be rounded. The larger the value, the rounder the edges
will be displayed.

Data labels tab

Use this tab to add labels to the selected data points. This is useful, for example, if you want to have the exact
values displayed for each data point.

§ Display section 

Here, you can specify the type of label to be displayed. The default option is Don't show, thus no label is
displayed. If, for example, you select the option Show value, the value of the relevant data point will be
displayed, while the option Show data point will display its name, etc.

§ Display legend key in label 

If you enable this option, the legend keys of the relevant data points will be displayed before the labels. The
legend key is a small square in the same color as the data point.

§ Placement section 

Here, you specify where the label should be placed (relative to the respective data point).

Note: If you label data points, you can also click on these labels in the chart. Thus, you can change their
properties by selecting a different font or changing the text you want to display, for example.

The following program response also applies here: Clicking once selects all labels of a data series, while
clicking again selects a single label.

Error bar Y tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to add error bars to the data points of the selected data series. Error bars display the
possible/tolerable error of the values in the form of a line with a short dash at the end.
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Chart with "Plus" and "Minus" error bars

To add error bars, select the desired type of error bar in the Display section: Plus only displays a positive error
bar, Minus only displays a negative error bar, Plus and minus displays both error bars.

The option Show as lets you determine the appearance of the error bars: with or without short dashes at the
ends.

In the Value section, you can change the length of the indicator line. If, for example, you select the option
Fixed, the line will always have the specified length, while if you select the option Percent, the length will
correspond to the specified percentage of the respective Y value, etc.

Error bar X tab

Note: This tab is only available for XY scatter charts and bubble charts.

This tab is identical to the Error bar Y tab (see above), except that it displays error bars for the X values instead
of the Y values.

Helper lines tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to display various guides in the chart. If, for example, you enable the option Average, a
dashed line indicating the average value of the selected data series will be displayed in the chart.

You can enable guides for Average, Minimum/maximum, Standard deviation, and Linear approximation
(linear trend).

Tip: You can use the ribbon command Chart | Add chart element  | Add trendline to show other types of
trendlines in the chart if necessary. For more information, see Trendlines.

Options tab

This tab shows different settings for displaying the data series/data points, depending on the chart type, for
greater clarification of the results.

For a line chart, for example, you will find the following settings:
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Note: For other chart types, you will find different settings on the Options tab.

§ Displaying drop lines 

If you enable this option, lines will be drawn from the data points to the horizontal axis.

§ Displaying high-low lines 

If you enable this option, lines will be displayed between the highest and lowest data points (for two or more
data series).

§ Up/down bars with gap 

You can use this option to display bars between the first and last data series, for example, in a line chart with
two or more data series. In the input field below, you can also set the gap between the bars.

For the above options, you can choose between different settings of the display in the section Empty cells are
... in case individual data points are missing.

If you select the option Vary color for each data point, the data points will be automatically colored with
different colors (not available if there are multiple data series).

Tip: You can also format these chart elements, if enabled, by selecting them and right-clicking to open the
context menu where you choose the relevant entry (Drop lines, High-low lines, Up/down bars):
Properties.

Trendlines

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Furthermore, they should not be stacked.

If desired, you can have a trendline shown for each data series of the chart. For more information, see
Showing/hiding the trendline.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

Edit properties: To change the properties of a trendline, select it, right-click it to open the context menu and
choose the command Trendline: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the trendline.

You can make the following settings:
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Format tab

§ Line section 

Here, you can change the appearance of the trendline. Auto uses a thick black standard line. None removes
the line. The option Custom lets you customize the line style.

Trendline tab

§ Type section 

Here, you can select the type of trendline to be displayed. In addition to linear trendlines (i.e. simple best-fit
lines), trendlines such as exponential or polynomial trendlines can also be displayed.

The available types of trendlines are based on the following formulas:

Linear: y = ax + b

Polynomial: y = b + c1x + c2x
2 + c3x

3 + ... + c6x
6

Exponential: y = cebx   (e = Euler's number)

Logarithmic: y = c ln(x) + b

Potential: y = cxb

Moving average: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n

§ Based on series 

Here, you can specify the data series for which the trendline is to be displayed.

§ Forecast section 

Here, you can extend the trendline beyond the existing data points.

If, for example, there are 3 data points (for example, the sales results for the 1st, 2nd and 3rd year), you can
enter a 1 for Forward. The line is then extended by an additional period (1 data point), thus displaying a
forecast for sales in the 4th year.

§ Crossing point 

Here, you can force the trendline to intersect the Y axis at a specific Y coordinate. This option is available
only for certain types of trendlines.

§ Show formula in chart 

If this option is enabled, the formula used to calculate the trendline will be displayed in the chart.

§ Show correlation in chart 

If this option is enabled, the correlation coefficient R2 of the data series will be displayed in the chart.
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§ Name section 

Here, you can change the name of the trendline if desired. This name is displayed in the legend. To do so,
select the option Custom and enter the desired name.

Category axis (X axis)

The X axis of a chart is also called the category axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the category axis, select it, right-click it to open the context menu
and choose the command Category axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

Note: If the category axis contains date values, other settings appear here that are similar to the scaling
options of the value axis (Y axis). For more information, see the descriptions in the next section Value axis
(Y axis), "Scale tab".

§ Axis ends... section 

This option allows you to determine where to end the visible part of the axis: In categories or Between
categories.
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Explanation: The first, second, third, etc., data point of all data series is called the category of a chart.

§ Number of categories between... section 

By default, PlanMaker makes a tick mark on the axis for each category and labels it. You can change these
intervals via the following options:

The option Tick marks determines which categories are marked with a tick mark. Enter 1, and a tick mark
is set for every category. Enter 2, and a tick mark is set for every second category, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark is labeled. Enter 2,
and every second tick mark is labeled, etc.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis): At low end (where the category axis begins), At high end (where the category axis ends) or at the
specified category number.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. The order of the categories is also reversed
accordingly; the chart thus starts with the last category and ends with the first category.

Font tab

Use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Value axis (Y axis)

The Y axis of a chart is also called the value axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the value axis, select it, right-click it to open the context menu and
choose the command Value axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.
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§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether axis labels should be displayed and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Lowest value and Highest value sections 

These options determine where the visible part of the axis should begin and where it should end. Select
either the option Auto, which results in PlanMaker automatically determining the most appropriate values,
or select Custom and enter the desired value yourself.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis):

If Auto is selected, PlanMaker automatically determines the most appropriate value, and if Maximum value
is selected, the X axis is positioned at the end of the Y axis. You specify your own Y value if you select
Custom value.

§ Major step value section 

Here, you can set the interval for the tick marks and labels on the axis. If you select the option Auto,
PlanMaker automatically determines the most appropriate values.

§ Minor step value section 

Here, you can set the interval between minor tick marks on the axis. If you select the option Auto,
PlanMaker automatically determines the most appropriate values.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. In a column chart, for example, the columns are
no longer drawn from bottom to top, but from top to bottom.

§ Logarithmic scale 

If this option is enabled, the axis will use a logarithmic scale (for example, 10, 100, 1000, etc.) rather than a
linear scale.

Font tab

You can use this tab to change the formatting of the axis labels.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Series axis (Z axis)

The Z axis of a chart is also called the series axis. It is only available for certain three-dimensional chart types.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the series axis, select it, right-click it to open the context menu and
choose the command Series Axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Number of series between... section 

By default, PlanMaker makes a tick mark on the axis for each data series and labels it. You can change these
intervals via the following options:

The option Tick marks determines which data series are marked with a tick mark. Enter 1, and a tick mark
will be set for every data series. Enter 2, and a tick mark will be set for every second data series, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark will be labeled.
Enter 2, and every second tick mark will be labeled, etc.
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§ Invert axis direction 

If this option is enabled, the direction of the axis will be reversed. The order of the data series will also be
reversed accordingly; the chart will thus start with the last series and end with the first series.

Font tab

You can use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Axis title

You can name each axis. This will then be displayed below/next to the axis. For more information, see
Showing/hiding axes and axis titles.

Edit properties: To change the properties of the axis title, select it, right-click it to open the context menu and
choose the command (Category/Value) axis title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the axis title. To do so, use the option Custom to select
the desired line style. The option None removes the border.

If you enable the option Shadow, the axis title will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the axis title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Text tab

Here, enter the desired axis title. If you delete the text completely from the input field, the axis title, as a chart
element, will be removed. Alternatively, you can also use a link to cell content as text for the axis title.
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Font tab

On this tab, you can change the formatting of the axis title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Chart title

Here, you can enter a title for the chart. This is then displayed above the chart. For more information, see
Showing/hiding chart titles.

Edit properties: To change the properties of the chart title, select it, right-click it to open the context menu and
choose the command Chart title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the chart title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the chart title. To do so, use the option Custom to
select the desired line style. The option None removes the border.

If you enable the option Shadow, you can also highlight the chart title with a shadow.

§ Fill section 

Here, you can change the fill of the chart title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Text tab

Here, enter the desired title of the chart. If you delete the text completely from the input field, the chart title, as
a chart element, will be removed. Alternatively, you can also use a link to cell content as text for the chart title.

Font tab

On this tab, you can change the formatting of the chart title.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Gridlines

You can show gridlines to make the values in a chart easier to read. (For more information, see Showing/hiding
gridlines.)

Gridlines are a network of lines that extend across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

Edit properties: To change the properties of the major grid of the value axis, for example, select one of its
gridlines, right-click it to open the context menu and choose the command Value axis major gridlines:
Properties.

Tip: Alternatively, you can chose this command via the Edit properties icon  on the ribbon tab Chart.

You can make the following settings:

Format tab

Tip: The appearance of the lines can also be conveniently adjusted directly via the buttons of the ribbon tab
Chart | group Chart elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the gridlines. Auto uses thin gray standard lines. None
removes the lines. The option Custom lets you customize the line style.

Changing the scale of gridlines

To change the distances between the gridlines, select the corresponding axis, choose its properties and make the
desired changes on the Scale tab.

Legend

If desired, you can show a legend in the chart. For more information, see Showing/hiding the legend.

A legend is a small box that shows which data series are displayed in which color/pattern.
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Edit properties: To change the properties of the legend, select it, right-click it to open the context menu and
choose the command Legend: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the legend.

Note: If you only want to edit a single legend entry (you can also apply a formatting to it that differs from that of the legend as a whole),
then click again in the area of the desired legend entry after selecting the legend. You can now choose the command Legend entry:
Properties via the context menu.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style of the legend's border. To do so, use the option Custom to select the
desired line style. The option None removes the border.

If you enable the option Shadow, the legend will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the legend. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

You can use this tab to change the character format (font, font size, text styles, etc.) of the legend.

Legend tab

Here, you can specify where the legend should be displayed.

If you select the option Custom, the legend can be moved to any position (using the mouse).

If you select None, the legend will be hidden.
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Changing chart properties via the dialog box

The previous sections discussed how to edit the properties of specific chart elements. This section discusses the
properties of the chart itself.

To change the properties of a chart, click to select the chart and right-click to open the context menu. Select the
entry Chart: Properties.

Tip: Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner
of any command group of the ribbon tab Chart.

The settings that can be made here are described on the following pages.

Chart properties, Format tab

On the Format tab, you can change the size and positioning of the chart.

For more information, see Object properties, Format tab.

Chart properties, Properties tab

On the Properties tab, you can change the general settings of the chart.

For more information, see Object properties, Properties tab.

Chart properties, Chart type tab

On the Chart type tab, you can change the chart type:

First, select the desired Chart type on the left and then the desired Subtype on the right. For more information
on the available chart types, see Changing the chart type.

Color palette: You can change the color scheme of the chart here.

Reset all settings in chart: This option restores any changes you made to the properties of the chart back to
their original state.

On the right side of the dialog box, a Preview shows the result of your customizations. If necessary, use the

button  to open the preview.
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Chart properties, Data source tab

On the Data source tab, you can make settings for the data source area on which the chart is based:

§ Data source area 

Here, you can specify the cell range that contains the data on which the chart is based. By default, the cell
range you selected when creating the chart is used. You usually don't have to change anything here.

§ Data series are in section 

Here, you can specify whether the selected data source area should be displayed by columns or by rows in
the chart. For more information, see Changing the arrangement of data series.

§ Data source area contains section 

Here, you can specify the types of data which the data source area contains.

Tip: If the top row of the data source area contains headings for the data listed below, enable the option
Names. PlanMaker will automatically label the data series in the chart with the corresponding headings.

§ Include hidden cells 

If the data source area contains cells that have been hidden (see Showing and hiding rows/columns)), they
are usually not displayed in the chart. Enable this option if you want hidden cells to be displayed as well.

Chart properties, Series tab

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, etc., depending on the chart type selected.

The Series tab allows you to make settings for each data series of a chart.

In the Series list, first select the series whose settings you want to change. Then make the desired settings:

§ Series 

The Series list contains a list of all data series currently included in the chart.

You can use the arrow buttons to the right of the list to change the order of the data series.

Use the Add and Delete buttons to add or remove data series.

§ Data sources section 

Here, you can specify which data should represent the selected data series.

The fields in this section are filled automatically (using the cell range you selected before inserting the
chart). You usually don't have to change them.

The following fields can be found here:
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Name: Here, you can specify the name of the data series. This may be a cell reference to a cell that contains
the name or simply a fixed text. This field can also be left empty, whereupon the data series receives an
automatically generated name ("Series 1", "Series 2", etc.).

Y values: Here, you can determine the cell range from which the data series should obtain the Y values for
the data points.

Explanation: For most chart types, the Y values are the values that should be displayed in the chart. For example, the Y values
determine the height of the columns in a column chart.

X values: This is similar to to the option Y values, whereby you can determine from which cell range the X
values for the data series should originate.

Explanation: For most chart types, the X values are irrelevant and are set to "Auto" (i.e. automatic) because they are only used to
label the category axis (X axis). XY scatter charts and bubble charts are the exception, however, as the X and Y values determine
the coordinates of the data points in these charts.

Bubble sizes: For bubble charts, there is a third parameter in addition to X and Y values: the size of the
bubbles for each data point. To do so, enter a cell reference to the cells that contain these values. If this field
is left empty, all bubbles will have the same size.

§ Display this series as section 

Here, you can specify how the selected data series is displayed in the chart. If, for example, you have
selected a column chart as the chart type, but want a particular series to appear as a line chart, you select the
option Lines for this data series.

§ Use secondary axis for this series 

If you enable this option, a secondary value axis (Y axis) will be added to the chart for this data series.
Secondary value axes can have a different scale to primary value axes.

Explanation: It is useful to represent specific data series on a secondary axis if these data series require an axis with a completely
different scale because they contain significantly larger values than the other data series.

Chart properties, Elements tab

On the Elements tab, you can show/hide and label the various chart elements:

§ Chart title 

Here, you can enter a title for the chart. The title will then be displayed above the chart.

Tip: The icon  means that you can also use a link to cell content as text. Click in the corresponding cell or
type the cell address in the input field.

§ Primary axes section 

Here, you can make settings for the primary axes:

You can use the checkbox in front of each axis to enable/disable the display of this axis.

To the right of the checkbox, you can give the axis a name. This will then be displayed below/next to the
axis as an axis title.

The Major grid and Minor grid options determine whether gridlines should be displayed in the background
of the chart. These grids make it easier to read the values. For more information, see Gridlines.
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§ Secondary axes section 

If the chart has secondary axes, you can configure them here, similar to the primary axes (see above).

§ Legend 

Here, you can specify the position of the legend. A legend is a small box that shows which data series are
displayed in which color/pattern. For more information, see Legend.

Chart properties, 3D view tab

Note: This tab is only available for three-dimensional chart types.

On the 3D view tab, you can change the 3D effect for the chart (for three-dimensional chart types).

§ Rotation angle and Elevation angle 

Here, you can set the viewing angle (in degrees) from which the viewer sees the chart. Rotation angle
rotates the chart around the vertical axis, while Elevation angle rotates the chart around the horizontal axis.

§ Perspective 

If this option is enabled, the chart will be distorted in perspective. You can also specify the amount of
distortion (from 0 to 100%).

§ Height  and Depth 

Here, you can change the height and depth of the chart (as a percentage of its original size).

Chart properties, Radar tab

Note: This tab is only available for radar charts.

On the Radar tab, you can make additional settings for displaying the chart (for radar charts).

§ Starting angle 

This option allows you to rotate the chart by the specified angle.

§ Orientation 

This option specifies whether the values should be arranged clockwise or counterclockwise.

§ Round radar chart 

If this option is enabled, pie segments are drawn between the axes instead of lines.
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§ Polar coordinates 

If this option is enabled, polar coordinates are used instead of Cartesian coordinates. The polar coordinates
are only available if Round radar chart is enabled.

If Angle between axes is set to x, an axis will be plotted every x degrees.

If Angle between axis descriptions is set to x, an axis label will be plotted every x degrees.

§ Limit plot area to radar 

If this option is enabled, only the area inside the radar will be filled. If it is disabled, the entire rectangle
surrounding the radar will also be filled.

Updating charts
A chart always retrieves the values to be displayed from the cells that were selected when the chart was created.
If values in these cells change, the chart is automatically updated and immediately shows the changed values.

Disabling automatic update

If desired, you can disable this automatic updating. To do so, choose the ribbon command File | group File
management | Properties, switch to the Calculate tab and disable the option Update automatically in the
Charts section.

If this option is disabled, the charts in the current document will only be updated when you initiate this
manually via the ribbon command Formula | group Update | Update data | Update charts.

Moving charts to another worksheet
When you create a new chart, it will always be inserted as an object in the current worksheet. However, you can
change the position of a chart at any time:

To move a chart within the current worksheet, simply click on it and drag it to the desired position with the
mouse:

If, on the other hand, you want to move the chart to a different worksheet, proceed as follows:

1. Click to select the relevant chart.

2. Choose the command Chart location  on the contextual ribbon tab Chart | group Position.

3. In the dialog box that opens, make the desired choice (see below) and confirm with OK.

The chart is moved accordingly.
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Available options:

§ As new sheet 

If you select this option, the chart will be moved to its own chart sheet. To do so, PlanMaker removes the
chart from the current sheet, creates a new chart sheet for it and inserts the chart into it.

A "chart sheet" is a special type of worksheet that only contains the full-sized chart and does not contain any
worksheet cells. It also only provides commands for editing charts.

§ As object in ... 

If, on the other hand, you select this option, the chart will appear as usual as an object in the selected
worksheet.

Saving charts as pictures
You can save an image of a chart as a picture file at any time. This makes it easier to share the chart with others
or to insert it into a web page or any other document.

To do so, proceed as follows:

1. Click to select the desired chart.

2. Choose the ribbon command Save chart as a picture  on the contextual ribbon tab Chart | group
Export.

3. In the Save as type list, select the desired picture format.
Tip: The PNG format is always a good choice here since it offers good and completely lossless compression.

4. Enter the file name under which you want to save the picture and confirm with OK.

5. Another dialog box appears. Select the desired resolution for the picture or manually enter your own values
for the width and height. Then confirm with OK.

PlanMaker now creates a corresponding picture file with an image of the chart.
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Forms

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects. This means that you
cannot create new forms with it, but you can still use existing forms.

You can insert form objects into your tables to create forms.

The following types of form objects are available:

§ Checkboxes for enabling 

§ Radio buttons for selecting from among multiple alternatives

§ Dropdowns for selecting from an expandable list

§ Listboxes for selecting from a list

§ Pushbuttons for clicking on

§ Spinners for increasing/decreasing values via a mouse click

§ Scrollbars for increasing/decreasing values via a mouse click
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§ Labels for static descriptions

§ Groupboxes for visually grouping related items

Form objects always have a Result cell. This is the cell which holds the value that the form object returns. You
can specify which cell this is for each individual form object.

If, for example, you insert a listbox with several entries in it, 1 is displayed in the result cell when you click on
the first entry, 2 when you click on the second entry, etc.

This chapter contains detailed information on working with forms. It consists of the following sections:

§ Working with form objects 

The first section covers general information on working with form objects. You will learn how to insert, edit
and evaluate form objects.

§ Form objects in detail 

The second section contains detailed information on each individual type of form object.

§ Options of the contextual ribbon tab "Object" 

The last section explains the commands of the contextual ribbon tab Objects. This always appears
automatically when you select a form object.

Working with form objects
In the following sections, you will find general information on working with form objects:

§ Inserting form objects 

§ Editing form objects

§ Using and evaluating form objects

§ Form objects and Excel macros and scripts

In Form objects in detail, we will then cover the individual types of form objects in detail.

Inserting form objects

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects. This means that you
cannot create new forms with it, but you can still use existing forms.

Inserting form objects is not much different from inserting other types of objects. For more information, see
Objects.

To insert a form object, proceed as follows:
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1. Choose the ribbon command Insert | Form object  (in the group Objects).

2. Select the desired type of object from the dropdown menu.

The object is now inserted.

At the same time, the program automatically displays a contextual ribbon tab Object where you can apply
general settings for objects (see Options of the contextual ribbon tab "Object").

For more information on the individual types of form objects, see Form objects in detail.

Editing form objects

Editing form objects is not much different from working with other types of objects. For more information, see
Objects.

There is, however, one important difference:

Important: Form objects cannot be selected by left-clicking on them with the mouse. To select a form
object, right-click on it. 

Alternatively, you can also use the ribbon command View | Object mode  to switch to Object mode in
which form objects can also be selected by left-clicking on them.

Once you have selected a form object, you can edit it like any other type of object – for example, move it with
the mouse, resize it, etc.

By right-clicking with the mouse on the form object, you can modify its properties with the entry Form object:
Properties in the context menu.

For more information on the properties of form objects, see Form objects in detail.

Using and evaluating form objects

Using form objects is very much like using control elements in dialog boxes. For example, check marks can by
set or removed by clicking on them. A listbox entry can be selected by clicking on it, etc.

Evaluating form objects

Form objects are evaluated via the result cell of the object. This is the cell which holds the value that the form
object returns.

The location of the result cell can be determined individually for each form object: To do so, select the form
object, right-click to open the context menu and select Form object: Properties. In the dialog box, switch to
the Form object tab and enter the desired cell address in the Result cell field.
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For example: You have assigned the result cell D4 to a list. If you click on the first entry in the list, 1 will be
displayed in D4. If you click on the fifth entry, 5 will be displayed, etc.

The relationship between a form object and its result cell is also two-way: If you manually enter 3 in the result
cell, the third entry will be automatically selected in the list.

Form objects and Excel macros and scripts

Microsoft Excel files can contain macros and VBA scripts that can be applied to form objects. This is not
possible in PlanMaker, but:

Important: If you open an Excel file in PlanMaker and it has macros or scripts, you won't be able to run
them; however, they will remain in the file. Thus, if you open and edit such an Excel file in PlanMaker and
then save it, the macros and scripts will not be lost.

Form objects in detail

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects. This means that you
cannot create new forms with it, but you can still use existing forms.

In this section, the individual types of form objects are described in detail.

The following objects are covered:

§ Checkboxes 

§ Radio buttons

§ Dropdown lists

§ Listboxes

§ Pushbuttons

§ Spinners

§ Scrollbars

§ Labels and groupboxes
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Checkboxes

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Checkbox to insert a checkbox.

Checkboxes can be used in Forms for Yes/No entries. If the box is checked, it stands for Yes; if it is unchecked,
it means No.

Using checkboxes

Simply click on the box to give it a check mark – in other words: to check it. If you click on it again, the check
mark is removed.

Changing the properties of checkboxes

To change the properties of a checkbox, select it (for example, by right-clicking on it) and choose Form
object: Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the checkbox itself:

§ Text 

Here, you can enter the text that is to be displayed to the right of the checkbox.

§ Value section 

Here, you can specify whether or not the checkbox should be checked. This corresponds to checking the
checkbox directly in the document.
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§ Result cell 

Here, you specify to which cell the result of the checkbox should be returned.

One of the following values will appear in this cell:

TRUE if the checkbox is enabled.

FALSE if the checkbox is disabled.

The error value #N/A if the state of the checkbox is undetermined.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the checkbox is drawn with a 3D effect.

Radio buttons

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Radio button to insert a radio button.

Radio buttons can be used in forms to select one of several options.

Using groupboxes to combine radio buttons

Important: Radio buttons must always be used in groups of at least two radio buttons.

To ensure that PlanMaker knows which radio buttons belong to a group, enclose them within a groupbox.

First, insert the related radio buttons into the document (for example, one below the other) and then use the
ribbon command Insert | group Objects | Form object | Groupbox to drag a groupbox around them.

Using radio buttons

Click on one of the related radio buttons to select it. Only one radio button within a group can be selected at a
time.
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Changing the properties of radio buttons

To change the properties of a radio button, select it (for example, by right-clicking on it) and choose Form
object: Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the checkbox itself:

§ Text 

Here, you can enter the text that is to be displayed in the radio button.

§ Value section 

Here, you can specify whether or not the radio button should be checked. This corresponds to checking radio
button directly in the document.

§ Result cell 

Here, you specify to which cell the result of the radio button should be returned.

As mentioned previously, radio buttons must always be used in groups of at least two. The result cell then
displays which of the radio buttons in the group is selected. When the first is selected, 1 is displayed, when
the second is selected, 2 is displayed, etc.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the radio button is drawn with a 3D effect.
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Dropdown lists

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Dropdown to insert a dropdown list.

You encounter dropdown lists in many dialog boxes. When you expand it, a list of available options is shown.
Such lists are ideal for forms because they reduce the required amount of typing when filling in forms and
prevent typing errors.

Using dropdown lists

Click on the arrow to the right of the list to open the list. You can now select an entry by clicking on it.

Changing the properties of dropdown lists

To change the properties of a dropdown list, select it (for example, by right-clicking on it) and choose Form
object: Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the dropdown list itself:

§ Lines (max.) 

Here, you can specify the maximum number of entries that the list should display when it is expanded.

§ List area 

Here, you specify the cell range that contains the entries to be displayed in the dropdown list.
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If, for example, you fill the cells F5 to F7 with the values "dog", "cat" and "mouse" and enter F5:F7 in the
list area, those three values will appear in the list.

§ Result cell 

Here, you specify to which cell the result of the dropdown list should be returned.

The result cell displays which of the list entries is selected. When the first entry is selected, 1 appears. When
the second entry is selected, 2 appears, etc.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the dropdown list is drawn with a 3D effect.

Listboxes

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Listbox to insert a listbox.

You encounter listboxes in many dialog boxes. They display several entries from which the user can choose by
clicking on them. Such lists are ideal for forms because they reduce the required amount of typing when filling
in forms and prevent typing errors.

Changing the properties of listboxes

To change the properties of a listbox, select it (for example, by right-clicking on it) and choose Form object:
Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.
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Form object tab

On this tab, you can make settings for the list itself:

§ Selection type 

You should always use the option Single here.

The other options Multi and Extended allow multiple items to be selected in the list, however, no result is
then output in the result cell. They are only provided for compatibility with Excel.

§ List area 

Here, you specify the cell range that contains the entries to be displayed in the list.

If, for example, you fill the cells F5 to F7 with the values "dog", "cat" and "mouse" and enter F5:F7 in the
list area, those three values will appear in the list.

§ Result cell 

Here, you specify to which cell the result of the list should be returned.

The result cell displays which of the list entries is selected. When the first entry is selected, 1 appears. When
the second entry is selected, 2 appears, etc.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the list will be drawn with a 3D effect.

Pushbuttons

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Pushbutton to insert a pushbutton.

Note: In PlanMaker, pushbuttons cannot be used to run macros or VBA scripts; they are merely provided for
compatibility with Excel.

Changing the properties of pushbuttons

To change the properties of a pushbutton, select it (for example, by right-clicking on it) and choose Form
object: Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.
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The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the pushbutton itself:

§ Text 

Here, you can specify the text that should appear on the button.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

Spinners

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Spinner to insert a spinner.

Spinners allow you to increment or decrement a value via a mouse click. Clicking on the up arrow increments
the value in the result cell, while clicking on the down arrow decrements it.

Changing the properties of spinners

To change the properties of a spinner, select it (for example, by right-clicking on it) and choose Form object:
Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.
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Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the spinner itself:

§ Parameters section 

Here, you can specify the following parameters:

Current value: The current value (corresponding to the value in the result cell)

Minimum value: The lowest value allowed

Maximum value: The highest value allowed

Incremental change: The value that will be added/subtracted to the current value when you click on one of
the two arrows

§ Result cell 

Here, you specify to which cell the resulting value should be returned.

§ 3D effect 

If you enable this option, the spinner is drawn with a 3D effect.

Scrollbars

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

You can use the ribbon command Insert | group Objects | Form object | Scrollbar to insert a scrollbar.

Scrollbars can be used to increase or decrease values via a mouse click. Clicking on the upward pointing arrow
increments the value by the specified incremental value, while clicking on the downward pointing arrow
decrements it.

Furthermore, you can make larger changes by moving the slider on the scrollbar with the mouse.

Changing the properties of scrollbars

To change the properties of a scrollbar, select it (for example, by right-clicking on it) and select Form object:
Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.
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The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the scrollbar itself:

§ Parameters section 

Here, you can specify the following parameters:

Current value: The current value (corresponding to the value in the result cell)

Minimum value: The lowest value allowed

Maximum value: The highest value allowed

Incremental change: The value that will be added/subtracted to the current value when you click on one of
the two arrows in the scrollbar

Page change: The value that will be added/subtracted when you click on somewhere between the scrollbar's
slider and one of the arrow buttons

§ Result cell 

Here, you specify to which cell the resulting value should be returned.

§ 3D effect 

If you enable this option, the scrollbar is drawn with a 3D effect.

Labels and groupboxes

FreeOffice: SoftMaker FreeOffice does not support the insertion of form objects.

In addition to the form objects described above, there are two types of form objects that cannot be filled in and
are only intended for applying labels:

§ Labels 

Labels: Here, you can enter any labels that should be displayed in the form.

§ Groupboxes 

Groupboxes are rectangles that can be labeled in the top left corner. They can be used for the visual
grouping of related parts of a form.
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To insert a label or a groupbox, choose the ribbon command Insert | group Objects | Form object | Label or
Group box.

The corresponding form object is then inserted. Now move it with the mouse to the desired position. You can
also resize it by dragging one of the round handles that surround the object.

Changing the properties of labels and groupboxes

To change the properties of a label or group field, select it (for example, by right-clicking on it) and choose
Form object: Properties in the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the text that you want the label or group field to display:

§ Text section 

Here, you can enter the text to be displayed.

§ Appearance section 

Here, you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

This option is only available for groupboxes. If you enable this option, the groupbox is drawn with a 3D
effect.

Options of the contextual ribbon tab "Object"
If you click to select a form object, the contextual ribbon tab Object appears automatically.
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However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.
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Language tools
PlanMaker has a powerful spell check. This enables you to have the spelling of text checked and corrected.
Automatic hyphenation is also available.

This chapter provides information on working with this tool. It consists of the following sections:

§ Setting the language 

You can choose the ribbon command File | Options  (Language tab) to set the language for the spell
check and hyphenation.

§ Spell check 

The spell check checks a document's text for typos and suggests corrections in the event of errors.

§ Hyphenation 

Automatic hyphenation hyphenates long words at the end of lines. By default, it is active only in text frames,
but you can also activate hyphenation for multi-line text in worksheet cells.

§ Auto correction 

With Auto correction, you can have PlanMaker automatically correct typical careless mistakes when
entering text – for example, if you often type "yuo" instead of "you". In addition, you will find many other
useful auto correct functions here.

§ SmartText 

You can use SmartText to define abbreviations for frequently used phrases – for example, "sd" for "sales
department".

§ Research 

Only available in SoftMaker Office Professional and NX Universal: Look up terms on online research
platforms (Wikipedia, Oxford dictionary, Cambridge dictionary, etc.) directly from the document.

§ Read aloud 

Only included in SoftMaker Office Professional and NX Universal: Have the content of your PlanMaker
document read aloud to you.

Setting the language
If you have installed more than one language, you can change the language for the spell check and hyphenation
at any time.

To do so, proceed as follows:
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1. Choose the ribbon command File | Options .

Alternatively: Choose the ribbon command Review | Spell check  | Settings.

2. Switch to the Language tab.

3. Select the desired language from the list "Language".

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

The spell check checks a document's text for typos and suggests corrections in the event of errors.

This section describes the different spell check tools in detail. The information covers the following topics:

§ Manual spell check 

The manual spell check lets you check and correct possible spelling errors of the current worksheet.

§ Checking the spelling as you type 

The Check spelling as you type function immediately checks each word you type. When a typing error is
detected, the program displays a dialog box that lets you correct the word.

§ Editing user dictionaries 

When you teach the spell check new words, they are added to your user dictionary. You can edit this
dictionary at any time, for example, to delete incorrect entries.

For more information on these topics in the above order, see the following pages.

Note: The spell check relies on the dictionaries having been installed and enabled. For more information, see
Installing dictionaries.
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Manual spell check

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

Note: Cells containing calculations are skipped by the spell check.

You choose the ribbon command Review | Spell check  to start the subsequent spell check. (Tip: You can
also choose this command with the F7 key.)

This checks the current worksheet word for word for spelling errors. If the spell check encounters an unfamiliar
word, it stops and displays the word in a dialog box.

You can then choose to correct the word, add it to the dictionary or simply ignore the supposed error. The list
under Change to will also contain some suggestions for the correct spelling of the word (if any are found).

Use the buttons in the dialog box to specify what to do with the unfamiliar word:

Button Explanation

Change This option lets you correct the misspelled word. Before you use this button, type the correct
spelling in the Change to input field or select one of the suggested words from the list.

Change all This option works like the Change button, but it changes all further instances of the word in the
entire document.

Ignore This option instructs PlanMaker to ignore this spelling error and continue with the spell check.

Ignore all This option instructs PlanMaker to ignore all further instances of this word.
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Note: PlanMaker only remembers the list of ignored words temporarily. When you exit
PlanMaker, it forgets it. If you want PlanMaker to learn words permanently, use the command
Add instead.

Add This option instructs PlanMaker to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that PlanMaker does not yet know. PlanMaker
remembers these words permanently, even after a restart.

If you want to exit the spell check before it reaches the end of the worksheet, click on Close.

Checking the spelling as you type

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

If the option Check spelling as you type is enabled, the spelling is checked as the text is typed, and the spell
check dialog box will open automatically when an unknown word is typed.

Note: If you enter a calculation into a cell, its spelling will not be checked. This would not make sense with
calculation formulas.

To enable this on-the-fly spell checking, choose the command File | Options , switch to the Language tab
and enable the option Check spelling as you type.

Every time you type a word, PlanMaker now quickly looks up that word in its dictionaries. As long as you type
words that the spell check knows, nothing visible happens. If you type an unknown word, however, the spell
check displays a dialog box.

This dialog box is similar to the dialog box for the manual spell check presented in the previous section. You
can read there about how to use this dialog box.

You will notice that there is also a SmartText button in the dialog box, which can be used to create a
SmartText entry from the word. You will learn more about this feature in the SmartText section.

Editing user dictionaries

When you teach the spell check new words, they are added to your user dictionary. You can edit this dictionary
at any time, for example, to delete incorrect entries.

To do so, click on the small arrow of the icon on the ribbon tab Review | Spell check  and select Edit user
dictionaries from the dropdown menu. The program displays a dialog box with the following buttons and
options:
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§ Language 

There is a separate user dictionary for each language. You can select the user dictionary to be edited from
the dropdown list Language.

Note: Note that there are two entries for each German in this list: "German (Germany)" stands for the new
spelling and "German (Germany, old)" for the old spelling. The same applies to "German (Austria)" and
"German (Switzerland)".

§ Entries 

This list contains all words that have been added to your user dictionary (for the selected language).

§ "Close" button 

This option closes the dialog box.

§ "Add" button 

This button enables you to manually add a word to your user dictionary. To do so, type the desired word into
the dialog box that appears after you press this button.

Words added in this way are treated exactly the same as words that were added using the Add button in the
spell check.

§ "Change" button 

Use this button to edit the word that is currently selected in the list. This is useful for misspelled words that
you have added to your user dictionary accidentally. By clicking on the button, you open a dialog box where
you can correct the spelling of the word.

§ "Delete" button 

This button deletes the word currently selected in the list from your user dictionary.

The spell check will therefore regard this word as misspelled again in the future.
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Hyphenation
Automatic hyphenation hyphenates long words at the end of lines. This works fully automatically as you type.

However, hyphenation is only available in the following cases:

§ Hyphenation in text frames 

In text frames, automatic hyphenation is enabled by default.

§ Hyphenation in table cells 

In table cells, automatic hyphenation is not enabled by default. For cells that contain multi-line text,
however, you can enable this if desired.

For more information, see the following pages.

Important: Of course, hyphenation only provides correct results if you have set the correct language in the

program settings. To set the language, choose the command File | Options , switch to the Language tab
and select the language from the dropdown list "Language".

Hyphenation in text frames

Whenever you enter text in a text frame, PlanMaker will automatically hyphenate it. This is performed fully
automatically in the background as you type.

All you have to do is to make sure that the correct language is set in PlanMaker's settings. For more
information, see Setting the language.

Setting the hyphenation frequency

If desired, you can specify how often you want the hyphenation function to separate words – or disable
hyphenation completely. This setting can be set separately for each paragraph in a text frame.

To do so, select the relevant paragraphs in the text frame, click on the group arrow  on the ribbon tab Home |
group Alignment and select the desired setting for Hyphenation in the dialog box.

Alternatively, you can open the dialog box by right-clicking in the text frame and selecting the entry
Paragraph from the context menu.

The following options are available:

Setting Result

None No hyphenation is performed.

Always Any amount of consecutive hyphenation is attempted. This is the default setting.
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Every 2 lines Hyphenation is attempted only in every second line.

Every 3 lines Hyphenation is attempted only in every third line.

If you select None, you completely disable hyphenation for the selected paragraphs, whereas if you select
Always, the program tries to hyphenate any line of a paragraph.

When do you use the other two options? It is not always a good idea to hyphenate at every point possible. For
text in narrow columns, for example, this may lead to words being split at the end of almost every line and thus
to a reduction in the document's legibility. Thus, you may want to use the option Every 2 lines or Every 3 lines
to instruct PlanMaker to attempt hyphenation only in every second or third line.

Hyphenation in table cells

Automatic hyphenation is not enabled by default in worksheet cells, but it can be enabled by the user. Of
course, hyphenation is then only performed in cells that contain multi-line text.

In order to obtain hyphenation in cells, two steps are required:

Step 1: Enabling hyphenation in cells

In order for hyphenation to be performed at all in cells, you must first enable hyphenation for cells, as it is
disabled by default. To enable it, proceed as follows:

1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Options tab.

3. Enable the option Hyphenation.

From now on, automatic hyphenation will also be performed in worksheet cells.

Note: This is a document option, thus you can enable or disable it individually for each document.

Step 2: Enabling the option Wrap text for cells

Hyphenations will only be performed in worksheet cells that have the option Wrap text enabled. This ensures
that long text will be automatically wrapped to multiple lines if it doesn't fit into a single line.

To enable the option Wrap text, proceed as follows:

1. Select the relevant cells.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Number.

Alternatively: Right-click to open the context menu and select the entry Cell.

3. Switch to the Alignment tab.

4. Enable the option Wrap text.

Automatic hyphenation will now be performed in these cells (if they contain multi-line text) where required.
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Auto correction

FreeOffice: Some auto correct functions are not included in SoftMaker FreeOffice.

You're bound to be familiar with making the same typos over and over again when writing. For example, you
want to write "you", but the text ends up as "yuo", which was not your intention. In such cases, PlanMaker
intervenes via Auto correction and corrects such common typos automatically.

The ribbon command Review | group Spelling | Auto correction  opens a dialog box in which you can
specify the settings for automatic correction.

Apart from the ability to avoid these accidental typos as in the example above, there are other useful auto
correction functions in the dialog box:

§ Capitalize first letter of sentences 

§ Correct capitalization of first TWo LEtters

§ Special replacements: For example, automatically create a smiley from the combination :-)

§ Automatically convert quotation marks to the typographically correct characters when typing

§ Format URLs as hyperlinks

§ Add superscript to ordinal numbers

Tip 1: Automatic correction is triggered as soon as a term is terminated with the space bar, the Enter key ¿
or with a punctuation mark.

Tip 2: If you want to undo an unwanted auto correction in your document, use the Undo command  or
press the key combination Ctrl+Z immediately after the auto correction.

The following pages contain detailed explanations about all auto correction functions.

Options tab

You can adjust the auto correction settings according to your needs.

Note: Auto correction is a global setting. Changes you make here will thus be applied to every document.

To do so, choose the ribbon command Review | group Spelling | Auto correction , and the following dialog
box will appear:
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On the Options tab, you will find the following auto correction functions:

"Auto correction" section

§ Automatically correct common typos (not included in SoftMaker FreeOffice) 

This option ensures that typical typing errors are corrected. If, for example, you type "thier", PlanMaker
automatically corrects this word to "their".

A list containing common typos is pre-installed for some languages. You will find this list on the Auto
correction tab, where you can delete existing pairs of terms or add new ones. For more information, see
Auto correction tab.

§ Capitalize first letter of sentences

Note: Enabling this option will only affect text frames and not table cells.
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If this option is enabled, PlanMaker automatically capitalizes the first letter of every sentence you type –
even if you accidentally enter a lowercase letter.

If, for example, you typed the sentence "this is a new sentence.", it would be corrected automatically to
"This is a new sentence.".

Exception list: For certain terms, however, it may be undesirable for this automatic correction to occur (for
example, after an abbreviation such as "max."). Switch to the First letter tab, where you can add terms that
should be excluded from this correction. For more information, see First letter tab.

§ Correct first TWo UPpercase LEtters

If this option is enabled, PlanMaker automatically corrects the case of words whose first two letters have
been capitalized inadvertently.

If, for example, you typed the word "HEnry", it would be corrected automatically to "Henry".

Exception list: If, however, you want to exclude certain expressions from this correction (for example,
"BSc"), then switch to the Initial caps tab. Here, you can add terms where two capital letters at the
beginning should not be corrected. For more information, see Initial Caps tab.

§ Expand SmartText entries (not included in SoftMaker FreeOffice)

As described in SmartText, you can create SmartText entries with PlanMaker (for example, "sd" for "sales
department").

If this option is enabled, your SmartText entries can be directly expanded as the text is entered. To do so,
simply type the abbreviation for the SmartText (for example, "sd") and then a space, Enter¿ or a punctuation
mark, and PlanMaker will automatically replace the abbreviation with the SmartText content.

If this option is disabled, however, SmartText entries can only be inserted via the dialog box of the ribbon
command Insert | group Text | SmartText.

Tip: The option "Expand SmartText entries" can also be enabled or disabled in this dialog box.

"Special replacements" section

PlanMaker can trigger some special characters automatically as soon as you type a certain combination of
characters in your text. For example, three dots in a row ("...") are converted to ellipsis points. Enable or disable
the desired options in this section.

Tip: On the ribbon tab Insert | group Text you can use the commands Character and Symbol to find other
common characters and symbols that you can insert manually into your text.

Smart quotes

Note: Enabling this option will only affect text frames and not table cells.

PlanMaker can automatically convert double quotes (") and single quotes (') as they are typed to ensure that
they are typographically correct for the selected language. Here, set the desired language or select "None" if
you want PlanMaker to leave your quotes marks unchanged.

If, for example, you type "Text" or 'Text', the relevant setting will produce the following results:

Setting "Text" 'Text'

Auto*
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None (no change) "Text" 'Text'

German „Text“ ‚Text‘

Swiss German »Text« ›Text‹

English “Text” ‘Text’

French** «Text» ‹Text›

Swedish ”Text” ’Text’

Polish „Text” ‚Text’

* A special position is assumed by the option Auto: If you select this option, PlanMaker automatically
determines the language and converts the quotes accordingly.

** For the single quote in the French setting, please note the following: the closing quote is first executed as an
apostrophe ('). If you press the single quote on the keyboard once again, it will be converted into the single
guillemet (›).

Tip: You can use the command Undo  (or the key combination Ctrl+Z) to convert smart quotes into
"neutral" quotes immediately after typing. The simple smart quote then becomes an apostrophe, while the
double smart quote becomes a normal double quote.

Automatically add spacing around punctuation marks (French only)

Note: Enabling this option will only affect text frames and not table cells.

Enable the option to automatically add spaces both before punctuation marks : ; ! ? as well as between quotes «
text » ‹ text ›. This option is only effective if French is the assigned language in the following setting:

§ In the dialog box of the command File | Options, Language tab: French 

"Formatting corrections" section

§ Format URLs as hyperlinks 

If this option is enabled, URLs (web page addresses) are automatically formatted as hyperlinks immediately
after entering them.

If, for example, you type "www.softmaker.de" in the text followed by a space, it will be converted
automatically into a clickable hyperlink and displayed accordingly (usually blue and underlined).

§ Superscript ordinal numbers

This option only supports the following languages: English, French, Italian, Portuguese and Spanish.

In these languages, superscripts are usually added to abbreviated ordinal numbers – for example 1st, 2nd, 3rd

in the English language.

If this option is enabled, superscripts are added automatically whenever you enter such a number. If, for
example, you type "2nd" in an English text and then press the space bar, it will be automatically reformatted
as "2nd" – the "nd" will be converted into a superscript.
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Note: This only works if one of the supported languages is set (thus English in our example). For
information on how to change this setting, see Setting the language.

Auto correction tab

FreeOffice: This auto correct function is not included in SoftMaker FreeOffice.

If the  Automatically correct common typos function is enabled on the Options tab, common typos can be
corrected automatically by PlanMaker.

On the Auto correction tab, you will find a list where you can enter typical typos and their corresponding
correct spelling. An extensive list is already provided for many languages.

You can add new word pairs to this list, or edit or delete existing word pairs.

Note: The list is automatically linked to the language that is set as the default language (see Setting the
language). However, you can also edit the lists for other languages independently at the top of the Auto
correction tab.

Add new word pairs to auto correction

1. On the Auto correction tab, click in the Replace: field and enter the term here as you typically misspell it.

2. Then click in the With: field and enter the correct spelling for this term here.

3. Click on the Add button.

Add further word pairs to this list in this way.

The newly added terms are now included in the auto correction list and the incorrect spelling will be
automatically corrected with the right spelling in future.

Edit existing word pairs

1. On the Auto correction tab, click on the word pair that you want to change in the lower list.

2. In the Replace: and With: fields, adjust the incorrect and correct spelling to your liking:

If you change something in the Replace: field (left side, for the wrong spelling), pressing the Add button
will add the new word pair to the auto correction list. The original word pair also remains in the list.

If you change something in the With: field (right side, for the correct spelling), pressing the Replace button
will overwrite the original word pair in the auto correction list.
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Delete word pairs

1. In the lower list on the Auto correction tab, click on the term that should no longer trigger an automatic
correction.

2. Click on the Delete button.

The term is deleted and will not be detected by auto correction in future.

First letter tab

If the Auto correction function Capitalize first letter of sentences is enabled on the Options tab, PlanMaker
automatically capitalizes the first letter at the beginning of a sentence – even if you have accidentally typed a
lowercase letter.

Here, on the First letter tab, you can set exceptions to this rule: 

This applies, for example, to abbreviations such as "amt.", "fig.", "p.m.", which end with a period and thus
indicate the end of a sentence without actually being one. Thus, there is no desire here for PlanMaker to
automatically capitalize the next word.

Enter the appropriate abbreviations in the exception list on the First letter tab. An extensive list is already
provided for many languages.

You can add new entries to this list or delete existing entries.

Note: The list is automatically linked to the language that is set as the default language (see Setting the
language). However, you can also edit the lists for other languages independently at the top of the Auto
correction tab.

Initial Caps tab

If the auto correction function Correct first Two UPpercase LEtters is enabled on the Options tab,
PlanMaker automatically corrects the case of words whose first two letters have been capitalized inadvertently.

Here, on the Initial caps tab, you can set exceptions to this rule:

This applies, for example, to terms such as "BSc", "DAdmin", "CDs", where it is not at all desirable for the
combination of two capital letters at the beginning of the word to be corrected.

Enter the appropriate terms in the exception list on the Initial caps tab. An extensive list is already provided for
many languages.

You can add new entries to this list or delete existing entries.



394Language tools

Note: The list is automatically linked to the language that is set as the default language (see Setting the
language). However, you can also edit the lists for other languages independently at the top of the Auto
correction tab.
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SmartText

FreeOffice: The SmartText feature is not included in SoftMaker FreeOffice.

PlanMaker's SmartText function can save you a lot of work: You can create SmartText entries for frequently
used phrases and then insert them instantly in the text.

For example, create a SmartText entry called "sd" with the content "sales department". You can now retrieve
this SmartText entry at any time: To do so, simply type "sd" in the document and then press the space bar, the
Enter key¿ or a punctuation mark. The abbreviation "sd" will be replaced immediately "sales department".

In this way, you can create your personal "computer steno" with PlanMaker and save a lot of time when typing.

In this section, you will learn about working with SmartText entries:

§ Creating SmartText entries 

New SmartText entries can be created in a dialog-box-controlled manner with the ribbon command Insert |
group Text | SmartText or via the spell check. Each SmartText entry must have a name (for example, "sd")
and the desired content (for example, "sales department").

§ Inserting SmartText entries 

If the option Expand SmartText entries is enabled in the program settings, SmartText entries can be
inserted very easily: To do so, type the name of the SmartText entry and then press the space bar, Enter
key¿ or a punctuation mark. The name will be immediately replaced by the content of the SmartText entry.

Alternatively, entries can be inserted manually with the ribbon command Insert | group Text | SmartText.

§ Editing SmartText entries 

Not only can you create new SmartText entries with the ribbon command Insert | group Text | SmartText,
but you can also edit, rename or delete existing ones.

For more information, see the following pages.

Creating SmartText entries

You can choose to create SmartText entries a) in a dialog-box-controlled manner or b) using Check spelling as
you type:

A) With the command Insert | SmartText

To create a SmartText entry with the name "sd" and the content "sales department", for example, proceed as
follows:

1. Choose the ribbon command Insert | group Text | SmartText .

2. Click on the New button to create a new SmartText entry.
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3. Give the SmartText entry a name ("sd" in our example).

The SmartText entry can be retrieved later by its name.

4. Confirm with OK.

5. Now, type the text for the SmartText entry in the large input field on the right (in our example: "sales
department").

6. Click on Save to save your new SmartText entry.

7. Exit the dialog box with Close.

The SmartText entry has now been created. You will find out how to insert it in the next section (Inserting
SmartText entries).

B) Via the option "Check spelling as you type"

If you have enabled Check spelling as you type, you can also create SmartText entries as follows:

1. In the dialog box of the ribbon command File | Options  (on the Language tab), make sure that the
option Check spelling as you type is enabled.

2. Type the two letters "sd" and press the space bar.

3. The on-the-fly spell check displays a dialog box indicating that the word "sd" is unknown.

4. Click on the SmartText button.

5. In the open dialog box, type "sales department" into the large input field on the right.

6. Confirm with OK.

The result is the same: The SmartText entry "sd" has now been created.

For more information on the option Check spelling as you type, see Checking the spelling as you type.

Inserting SmartText entries

You can now insert the SmartText entry created in the previous section at any time.

This is very simple: Type the name of the SmartText entry in a cell or in a text frame – "sd" in our example –
and then a space, a punctuation mark or the Enter key¿. PlanMaker will immediately replace "sd" with the
content of the SmartText entry: "sales department".

Note: If this does not work, the option Expand SmartText entries is disabled. Choose the ribbon command
Review | Auto correction and enable this option again in the dialog box (or in the dialog box of the
command Insert | group Text | SmartText).

Alternatively, you can access the defined SmartText entries via the dialog box by choosing the ribbon command
Insert | group Text | SmartText, selecting the desired SmartText entry on the left side of the dialog box, and
then clicking on the Insert button.
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Tip: Do not expand SmartText entries

If you do not want a defined SmartText entry to be inserted when you type in the text, then use the key
combination Alt+. (period) in the place directly behind the SmartText entry. In this case, the specified addition
is then suppressed.

Editing SmartText entries

By choosing the ribbon command Insert | group Text | SmartText , you can still edit the already created
SmartText entries via the dialog box:

§ Creating a new SmartText entry 

Click on the New button to create a new SmartText entry in the dialog box. For more information, see
Creating SmartText entries.

§ Deleting a SmartText entry 

To delete a SmartText entry, select it in the list SmartText entries on the left of the dialog box and then
click on the Delete button.

§ Renaming a SmartText entry 

To change the name of a SmartText entry, select it in the list on the left, and click on the Rename button.
The program displays a dialog box in which you can enter the new name.

§ Editing a SmartText entry 

To edit an entry, select it in the list on the left and then click in the large input field on the right of the dialog
box. You can now change the content of the SmartText entry.

When you have made the desired changes, click on the Save button.

§ Inserting a SmartText entry 

To insert a SmartText entry into the text, select it in the list on the left of the dialog box and click on the
Insert button. For more information, see also Inserting SmartText entries).

You can finally exit the dialog box with the Close button. If the enabled SmartText entry has been changed but
not yet saved, PlanMaker will ask automatically if it should save the changes.
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Research

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the Research function to look up the meaning of the terms you selected in PlanMaker directly in
online dictionaries and encyclopedias. PlanMaker suggests various online research platforms (Wikipedia,
Oxford dictionary, Cambridge dictionary, etc.) that you can open interactively for your search.

To do so, proceed as follows:

1. Select one or more terms in your document.

2. Choose the ribbon command Review | group Spelling | Research .

3. In the dropdown menu, click on the desired platform on which you want to look up your research term.

The selected online platform will then be opened directly with the results for your selected term.

Available categories

In the open dropdown menu of the Research icon , you can choose from the following categories:

§ Recently used 

The platforms most recently used by the research function are displayed here for quick access again (the last
3 searches).

§ English (depending on the selected language)

General reference books are displayed here in the language you selected in the settings (see "More" below).

§ German - English (depending on the selected languages)

If you have selected multiple languages in the settings (see "More" below), this category will appear with
translation platforms corresponding to the selected languages.

§ More

You use the entry More to open a dialog box with the settings. Here, you specify the languages for which
PlanMaker should suggest research platforms to you. Enable the desired language(s) by clicking on the
respective checkbox.

This results in the menu of the Research icon displaying the general reference books and translation
platforms for all languages you selected, insofar as they are available in these languages.
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Read aloud

This feature is only available in SoftMaker Office Professional and NX Universal and is only supported
for the Windows version. It is not available in the versions for Mac, Linux and Android/iOS.

The ribbon command Review | Speak lets all or part of the text in your PlanMaker document be read aloud to
you.

Set the desired language in your document beforehand (see Setting the language). This allows PlanMaker to
recognize which language should be used for reading aloud.

To have the content read aloud, please proceed as follows:

1. Select the cell range that you want PlanMaker to read aloud.

2. Choose the ribbon command Review | Speak , the Text-to-speech module will open.

3. If necessary, click on the Options button before playback to adjust the settings for the speech output. For
example, you can add the language pack required for a language in the dialog box if this language has not
yet been installed in the Windows language settings. For more information on this and the other options in
the dialog box, see the paragraph "Text-to-speech options" below.

4. Press the arrow button  to start. Adjust the Volume and Speed as needed by using the sliders.

The button  pauses the reading aloud. Press  again to continue.

The button  jumps to the previous cell and  jumps to the next cell.

The button  stops the reading aloud. If you now start again with , the reading aloud will resume at the
beginning of the selected cell range.

5. Click on Close to exit the Text-to-speech module.

Text-to-speech options

If you click on the Options button in the Text-to-speech module, the program opens a dialog box in which you
can make settings for the speech output.

The following options are available:

§ "Tables" section 

Here, you can choose between two methods of reading tables.

Speak cells by row: After the first cell has been read out, PlanMaker jumps to the cell to the right of it for
further reading. Once the last cell in the horizontal direction is reached, the program jumps to the next row
and continues there with the cell on the far left.



400Language tools

Speak cells by columns: After the first cell of the table is read out, PlanMaker jumps to the cell below it for
further reading. Once the last cell in the vertical direction is reached, the program jumps to the next column
and continues there with the top cell.

§ "Options" section

Spell numbers: With this option enabled, numbers are pronounced distinctly to make it easier to recognize
the occurrence of a number. This option is very useful for enumerations with numbers, for example.

Spell punctuation: Enable this option if you want the punctuation marks of the text (. ; , ? ! - "" etc.) to be
expressed as in dictation to make it easier to recognize them.

§ Language/Voices

There are different voices available for reading aloud. In the list Language, first select the language for
which the available voices are to be displayed. Then click on the desired voice for this language in the list
Voices below.

If necessary, click on the Add Installed Voices button to add more voices to the list.

§ New language packs

PlanMaker can only read aloud content in the languages that have been installed in the Windows language
settings. If the language required for reading aloud is missing here, you can access the Windows language
settings directly via the New language packs button. Add the missing language in the "Preferred languages"
section.
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Document management
PlanMaker has functions that make it easier for you to manage and access your documents faster:

§ Quick paths 

You can create quick paths in PlanMaker in order to quickly switch to frequently used folders when opening
or saving files.

§ Document summary 

Every document can have some additional info that you can display and edit using the Summary tab in the
dialog box of the ribbon command File | Properties. You can enter the title, subject and author of the
document, specify keywords for the file manager's search function and write a brief summary of the content.

§ File manager 

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

You can use the integrated file manager to easily access your documents. It allows you to see the names and
the document infos on the Summary tab for all documents at a glance. You can view, open, print or delete
documents at the touch of a button.

The Search function of the file manager not only lets you search for your documents by file name, but it
also allows you to search by topic, title, author, etc.

§ Backup copies (file versions) 

If desired, PlanMaker creates a backup copy of the document each time the document is saved. You can even
instruct the program to automatically take "snapshots" of the document at regular intervals while you're
working on it.

The following pages provide detailed information on these functions.

Quick paths
PlanMaker allows you to create up to twenty quick paths via which you can quickly switch to a specific folder
when opening or saving files.

A quick path is a symbolic specification, such as "Taxes", which represents a specific folder on the hard disk
(for example, the folder C:\Accounting\Taxes).

If you want to open a file from this folder, you must first choose the ribbon command File | Open and then
simply click on the Quick path button in the dialog box to select the created quick path. The dialog box then
switches immediately to the C:\Accounting\Taxes folder.

Quick paths are not only available in the dialog box of the command Open, but they are also in all other dialog
boxes that are used to open or save files.
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Creating quick paths

To create a new quick path, proceed as follows:

1. Open any file dialog box, for example, with the ribbon command File | Open. (Click directly on the icon
itself to open the file dialog box.)

2. Click on the Quick path button in the file dialog box.

3. A menu opens below the button. Choose the command Create new quick path from it.

4. Enter any name for the quick path in Name of quick path – for example, "Taxes".

5. Enter the desired folder under Path – for example, "C:\Accounting\Taxes".

Tip: Alternatively, click on the button with the three dots next to this input field. This opens a file dialog
box in which you can easily select the desired folder.

6. Confirm with OK.

PlanMaker now knows that the quick path "Taxes" should switch to the folder C:\Accounting\Taxes.

Opening quick paths

Quick paths are available in all file dialog boxes – for example in the dialog boxes of the ribbon commands File
| Open or Insert | Picture frame. (Click on the icon itself to open the file dialog boxes.)

To use a quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu of all the previously created quick paths opens. Select the desired quick path.

PlanMaker now switches to the folder specified for the quick path.

Editing and deleting quick paths

To edit or delete an existing quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu opens. Choose the command Change quick paths in it.

3. A dialog box appears. Select the desired quick path in it.

4. Click on Change to edit the name or path, or click on Delete to remove the quick path.
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Document summary

The ribbon command File | group File management | Properties  not only enables you to make document-
specific settings but also to enter some document info on the Summary tab.

You can enter additional information (such as subject, author, keywords, etc.) about a document here. To view
or edit such information, choose the command File | Properties and switch to the Summary tab.

Make the desired changes and confirm with OK.

Tip: You can use the file manager (see next section) to search for documents by their document info, for
example, to find all documents on a specific topic.

Automatic prompt for summary information when saving: You can have PlanMaker prompt you to fill in the
document summary whenever you save a new document.

To do so, choose the ribbon command File | Options , switch to the Files tab and enable the option Prompt
for summary information when saving. The dialog box for entering the document info on the summary tab
will now appear every time you save a new document for the first time.
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File manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

The file manager displays a list of documents from one or more folders and lets you open, print, delete or view
any document by clicking on it.

You start the file manager with the ribbon command File | File manager .

You can use the mouse to move or resize the file manager window at any time. You can also change the column
widths by dragging the separator lines between the column headings.

By clicking on one of the column headings, you can specify the column according to which the files are to be
sorted.

You can use the Search button to select a different folder and also use the Search function to start searching for
files. Furthermore, you can search for a specific title, subject, author, keyword, etc., within the Document
summary located on the Summary tab.

To perform an action with a file, select the file and then click on one of the buttons. The individual buttons
have the following functions:

§ Open 

If you click on this button, PlanMaker opens the selected file.

Tip: You can also double-click on a file name to open the file.

§ Search 

Click on this button to search for specific files or simply to select the folder you want to display in the file
manager. For more information on Searching with the file manager, see the next section.
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§ Output 

Use this button to output the selected file. When you click on the button, a menu opens with the following
functions (depending on the operating system):

E-mail: Send the document by e-mail

Print: Print the document

§ Delete 

If you click on this button, the selected file will be deleted (after confirmation).

§ Preview 

Click on this button to open a preview window where you can view the selected document without having to
open it.

To actually open this document, click on the Open button in the preview. To exit the preview window, click
on the Cancel button.

§ Rename 

If you click on this button, you can rename the selected file.

§ Close 

Clicking on this button will close the file manager.

Searching with the file manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

You can use the Search button in the file manager to have PlanMaker search for specific files or simply choose
the folder to be displayed in the file manager.
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You can search for files that meet the following criteria: file name, folder, file type and the document info (title,
subject, author, keywords) on the Summary tab.

Several search criteria can also be combined. If, for example, you specify a specific folder in the dialog box,
PlanMaker will display all documents in this folder. If you also enter a search term in the Title field, however,
PlanMaker will find only those documents that are both in the selected folder and contain the specified search
term in the Title field on the Summary tab.

With the dialog box shown above, you control the search function:

§ File name 

You can use this input field to search for specific files.

If you do not enter anything here (thus accept the default setting), the search function will find all
documents of the selected file type in the selected folder.

If you specify a unique filename like MyReport.pmdx, only documents with the exact same name will be
found.

If you specify an ambiguous file name like My*.pmdx, the search will find all PlanMaker documents whose
file name begins with "My".

§ File type 

You can use this list to select the type of the files to be targeted in the search. If, for example, you want to
search for files in Excel Format, select this format from the list File type.

§ Title, Subject, Author, etc. 

By entering content in these fields, the file manager will search the document info of your documents (see
Document summary).

If you fill in several fields, the file manager will search for documents that meet all of your specified
conditions. If, for example, you enter "court" in the Keywords field and "Smith" in the Author field, only
documents whose document info contain corresponding entries for both fields will be found.

You can also specify only part of the term for which you are searching. If, for example, you entered "court"
as the search term in the Keywords field, your search would return all documents that contained the word
"court" – thus terms like "courthouse", and "district court" would be found.

Case is of no significance for search terms. If the search term is entered as "court", the search will also find
documents whose keywords contain "Court".

§ Folders 

Here, you can select the folder in which the file manager should perform the search.

§ Include subfolders 

If this option is enabled, the file manager not only searches the selected folder but also all folders that are
subordinate to it.

§ New list button 

If you click on this button, you start a new search with the current settings.
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§ Add to list button 

Clicking on this button also starts a new search; however, any previous search results remain in the list
instead of being cleared from the list.
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Backup copies (file versions)

FreeOffice: These functions are not available in this form in SoftMaker FreeOffice. Only simple backups
can be made here, and this setting can be found on the Files tab.

If desired, PlanMaker creates a backup copy of the previous version of the document each time the document is
saved. You can even instruct the program to automatically take "snapshots" of the document at regular intervals
while you're working on it (similar to the common Auto-Recover function). You can also access these snapshot
versions later even if you have not saved the document manually using the command File | Save.

The settings for this can be found on the Backup tab in the dialog box of the command File | Options .
Select here whether and how file backups are to be created:

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is enabled, the command File | Versions  (in the group File management) is also
available, which allows you to easily return to a previous file version of the currently open document (see
below).

Use the Number of versions to keep field to specify the maximum number of versions of backups
(generations) to be kept per document.

§ Automatically created file versions ("snapshots")

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

In the dropdown field below, enter the maximum number of snapshots you want to save.

§ Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

§ "Clean up" button

This button provides two options for deleting file backups from the backup folder:

Delete orphaned file versions removes all PlanMaker backups for which the corresponding original
document no longer exists.

Delete file versions of all documents removes all PlanMaker backups.

How do I use the command "File | Versions"?

If you enable the creation of file backups (see above), all backups end up in a special Backup folder. This
folder is managed automatically by the program. We do not recommend that you manually move or rename the
files in this folder.
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To return to a previous version of a document, you don't need to be interested in this folder at all – as there is a
separate command for it: File | Versions.

You can use this command to revert to a previous version of a document as follows:

1. Open the desired document (if it is not already open).

2. Choose the ribbon command File | group File management | Versions . (Click directly on the icon itself
to open the version manager.)

Tip: You can proceed even faster by clicking on the icon's arrow for the dropdown menu instead of on the
icon itself. The available backups are listed here. Restore the desired version by clicking on the version
entry – this will open the version in a new document window.
However, the icon  to the right of it will open the version in the current document window. (Warning:
This will overwrite the currently open document with an older version.)

If you click on the small black arrow of the Versions icon and select the entry File versions in the menu that
appears, you will also reach the version manager, which will provide you with additional details for a better
overview. For more information, see the following steps 3. and 4.

3. Version manager: The program displays a dialog box that lists all available backups for the current
document. Use the dates and times to find and select the version that you want to restore. You can use the
Preview button to display a preview of the selected version.

The version manager list shows that a backup for the Test.pmdx file might be called
Test.pmdx.135.pmbak, for example. Thus, a sequential number and the extension .pmbak are always
appended to the file name (and an "s" is also inserted into the sequential number for snapshots).

4. If you click on the Restore button, the selected previous version of the document will be restored in the
current window.

Warning: The currently open document is now replaced by the selected previous version. So if you save
it now, you're overwriting the current version with an older version!

Alternatively, you can also click on the Open as copy button. This opens the selected file version in a new
document window (instead of replacing the document in the current window). This is useful if you want to
compare the current version with an older version.

What should I do if I lose the original file?

The aforementioned procedure only works if the original document is still available. What should you do if the
original file has been lost, for example, because it was accidentally deleted?

Even in this case, you can still access the backup copies of this document (unless they have been deleted as
well). Simply open the backup copy itself.

You can see where the backups are in the dialog box of File | Options . On the Backup tab, the file path is
displayed below in the Folder for file versions field. By default, this is a folder called Backup within the
SoftMaker folder.

When you open a backup from this folder in your file browser, PlanMaker immediately starts to open the file.
The procedure is as follows:
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1. In your file browser (for example, Windows Explorer), navigate to the Backup folder.

2. In this folder, search for files whose name starts with the name of the original file. A backup for the
Test.pmdx file might be called Test.pmdx.135.prbak, for example. Thus, a sequential number and the
extension .pmbak are always appended to the file name (and an "s" is also inserted into the sequential
number for snapshots).

Tip: The higher the sequential number in the file name, the more recent the file version.

3. In the file browser, double-click on the file version that you want to open.

4. PlanMaker detects that you are trying to open a backup and asks you what you would like to do now. It
displays a dialog box with the following options:

Open the backup file: This option opens the selected file version.

Invoke the version manager: This option opens the version manager like the command File | group File
management | Versions. This then offers all available earlier versions of the original document for
selection. For more information on using this command, see above.

Open the original file: This option opens the original file for this file backup. (Of course, this only works if the
original file still exists.)

5. Make your choice, and then click on OK.

Once again, please note that PlanMaker automatically creates and manages the files in the Backup folder.
Thus, you should not make any manual changes to these files, such as renaming or moving the files.

If you need more space on the disk, you can delete all files in this folder at any time, but then you will lose all
file backups as a result.
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Outlines
The Outliner allows you to create an outline for a worksheet. You can then easily decide via a mouse click
whether only the most important data or also detailed data should be displayed.

In order to outline a worksheet, you have to group the related detailed data. If, for example, a worksheet
contains sales figures for several years, with the monthly sales listed below each year, group each list of
monthly figures. From then on, you will be able to show or hide them via a mouse click – depending on whether
you only want to view the annual sales or also the monthly sales.

Outlines can also contain several levels – thus you can group data again within a group of data.

Outline pane

As soon as a worksheet contains grouped data, an Outline pane is displayed to the left of the document window.

Use this Outline pane to determine which detailed data should be displayed via a mouse click:

§ By clicking on the plus  and minus  signs in the Outline pane, you can show or hide any groups of
detailed data individually. 

§ Use the  buttons at the top of the Outline pane to specify that only detailed data from a certain level
should generally be displayed. If, for example, you click on the "2" button, only rows of the first and second
outline levels will be displayed.

Note: Worksheets can be outlined by row or by column. In a column outline, columns are grouped instead of
rows. In this case, the Outline pane is displayed above the worksheet.
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Using the command group "Outline"

You will find the commands for grouping cells on the ribbon tab Data | group Outliner.

This command group provides the most important icons for working with outlines:

§ Group the selected cells 

§ Ungroup the selected cells

§ Remove all groups

§ Show details (equivalent to clicking on the plus sign in the Outline pane)

§ Hide details (equivalent to clicking on the minus sign in the Outline pane)

The following pages contain detailed information on working with outlines.

Grouping cells
To create an outline, group the rows (or columns) that contain detailed data. You can then show or hide them
later via a mouse click as required.

To group cells, proceed as follows:

1. Select the rows (or columns) to be grouped.

2. Choose the ribbon command Data | group Outliner | Group .

The cells are now grouped.

Note: Ungrouped cells have an outline level of 1. When you group cells, their outline level is increased to 2.
You can even group a subset of cells within a group of cells, thus increasing their outline level to 3. Outlines
can contain up to 8 outline levels.

Ungrouping grouped cells

You can ungroup cells at any time.

Proceed as follows:

1. Select the rows (or columns) to be ungrouped.

2. Choose the ribbon command Data | group Outliner | Ungroup .
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The cells are no longer grouped – more precisely, their outline level is reduced by one level. This means that if
you ungroup cells with an outline level of 3, they will not be completely ungrouped, but their outline level will
be reduced to 2.

Completely removing the outline of cells

If you want to completely remove the outline of cells, proceed as follows:

1. Select the rows (or columns) whose outline you want to remove. Note: If you do not select any cells, the
outline of the entire worksheet will be removed.

2. Choose the ribbon command Data | group Outliner | Remove all groups .

The outline of the cells has now been completely removed, thus their outline level is reset to 1.

Showing/hiding grouped cells
If you have created an outline for a worksheet (as described in the previous section), you can show/hide
detailed data (thus grouped cells) at any time as required.

To show/hide grouped cells, use the Outline pane as follows:

§ A bar with a minus sign  is displayed next to grouped cells in the outline pane. To hide the grouped cells,
click on the minus sign. 

§ A plus sign  appears next to hidden cells in the Outline pane. To show the grouped cells, click on the plus
sign.

§ Use the  buttons at the top of the Outline pane to specify that only detailed data from a certain level
should generally be displayed. If, for example, you click on the "2" button, only rows of the first and second
outline levels will be displayed.

For rows, you can also use the commands Show details  and Hide details  on the ribbon tab Data | group
Outliner to show or hide the grouping (corresponds to the plus and minus signs in the Outline pane, see above).

Note: When you hide grouped cells, they are not only hidden on the screen but are also no longer considered
in charts.

Changing outline settings
You can change outline settings via the dialog box Outliner options. To open this dialog box, click on the group
arrow  in the bottom right corner of the ribbon tab Data | group Outliner.

Here, you can make the following settings for the structure of the current worksheet:
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§ Title below group rows 

This option basically only determines whether the plus and minus signs should be displayed above or below
the bar for grouped cells in the Outline pane.

Enable this option if you want the plus and minus signs to be located below the grouped cells. Disable it if
you want them to be above the grouped cells.

§ Title to the right of group columns 

This option corresponds to the above option; however, it refers to worksheets where columns have been
grouped rather than rows. You can use it to determine whether the plus and minus signs are located to the
left or right of the grouped cells.

§ Automatically show outline pane 

This option determines whether the Outline pane should be displayed automatically if the worksheet
contains grouped cells.

If this option is enabled, this pane will appear automatically as soon as the worksheet contains at least one
group of cells. If disabled, the Outline pane will not be displayed.

§ Protect outline 

If this option is enabled, the outline will be protected if sheet protection is enabled for the worksheet. For
more information, see Sheet protection.

If sheet protection is enabled, the current state of the outline will then be "frozen". Users will not be able to
show or hide grouped cells nor group or ungroup cells.
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Using hyperlinks
Choose the ribbon command Insert | group Links | Hyperlink to add a hyperlink to cell contents or complete
cells at any time. Hyperlinks are links to, for example, websites or other documents, which can then be opened
simply by clicking on the link.

If, for example, you link a cell to a web page, the web browser will automatically start when you click on this
link and will access this page in it.

By the way, the file path of another document is also allowed as a destination for hyperlinks. This is then
opened automatically when you click on the link.

Tip: It is also possible to use an e-mail address as a destination by placing "mailto:" in front of it.

Creating a hyperlink

To create a hyperlink, proceed as follows:

1. Select the cell or cell contents to which you want to attach a hyperlink.

2. Choose the ribbon command Insert | group Links | Hyperlink .

3. For URL or file name, specify the destination for the hyperlink: Enter the path and name of the Internet
resource or file to which you want the selected text to refer.

For links to web pages, "http://" and the address of the page should be entered – for example,
"http://www.example.com".

For links to an e-mail address, enter "mailto:" and the recipient's address – for example,
"mailto:xy@example.com".

For links to a file, the Browse button can be used.

4. Optional: In the Jump target field, you have the option of specifying a bookmark or a cell address in the
document to be opened (see below). However, this field is usually left empty.

5. Optional: In the Hyperlink text field, you can change the text for the cell you have just selected in the
document. If the cell is empty, PlanMaker automatically inserts the selected path and file name or Internet
address as text.

6. Confirm with OK.
Note: The Reset button allows you to undo all changes made in the open dialog box provided that you have not yet confirmed them with OK.

The hyperlink is now created. You recognize this by a change in the color of the text, which indicates the
presence of a link. (Provided that there is text in the cell.)

Tip: Links to URLs and e-mail addresses can be created faster and easier if the option Format URLs as
hyperlinks is enabled in the dialog box of the ribbon command Review | Auto correction. You can then
type the destination address (for example, "www.example.com" or "mailto:xy@example.com") directly into
the text and press the space bar. PlanMaker recognizes that you have entered a web address or e-mail address
and automatically formats it as a link. This setting is global and not document-specific.
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Tip: Alternatively, hyperlinks can also be inserted using the HYPERLINK function, which is much more
flexible to use.

Jumping to a specific bookmark or cell address

The aforementioned dialog box also gives you the option of specifying a jump target if necessary in the
document to be opened. For Jump target, enter the bookmark (for TextMaker or HTML documents) or the cell
address (for PlanMaker documents) to which you want to jump.

For example: If you set URL or file name to "Sales.pmdx" and enter "D42" under Jump target, the link will
open the file Sales.pmdx and jump to cell D42.

Using wildcards in links

Tip: In hyperlinks, you can use an asterisk (*) as a wildcard for the cell content.

Example:

If the cell is still empty, choose the ribbon command Insert | group Links | Hyperlink and enter http://* in the
URL or file name box. If you then enter e.g., www.example.com in that cell, the link will point to the Internet
address http://www.example.com.

This also works with other protocols – for example, mailto:* can be used to create a link to the e-mail address
in a cell.

Opening hyperlinks

To open a hyperlink, simply click on the cell or text containing the hyperlink with the mouse. PlanMaker then
opens the linked document.

Editing or removing a hyperlink

Existing hyperlinks can be edited as follows:

§ Changing destination 

To change the destination of a hyperlink, select the cell(s) or text passage with the link, and then choose the
ribbon command Insert | group Links | Hyperlink again. The program again displays the dialog box in
which you can edit the destination for the link.

To remove a hyperlink, proceed as follows:

§ Removing a hyperlink by deleting the link text/cell 

If you delete a text passage that contains a hyperlink, the link will also be removed. If a cell is deleted
completely, this also removes the hyperlink applied to the cell.

§ Removing only the hyperlink 

If you only want to remove the hyperlink from the cell, but retain the cell itself and its contents, select it and
choose the ribbon command Home | group Contents | Delete | Remove link.
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Outputting documents
This chapter provides information on how to output documents via PlanMaker.

The chapter contains the following sections:

§ Print preview 

The first section deals with the command File | Print preview. This displays the document on the screen
exactly as it will appear on the printout, thus saving unnecessary test prints.

§ Printing a document 

To actually print the current document on the printer, choose the command File | Print.

§ Exporting a document as a PDF file 

You can also export a document to a PDF file by choosing the command File | PDF export.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there.
All formatting and objects of the document are retained exactly as in the original file.

§ Sending a document by e-mail (not included in SoftMaker FreeOffice) 

Finally, documents can also be sent by e-mail. The command File | Send is responsible for this process.

See the following pages for more detailed information on these functions.

Print preview
The print preview displays a document on the screen exactly as it will look in the printout. This feature enables
you to avoid wasting paper on test prints.

To start the print preview, choose the ribbon command File | Print preview .

To exit it again, click on the Close button in the preview module or press the Esc key.

The icons of the print preview module

The print preview appears in a separate window. This print preview module has the following functions:

These buttons are used for scrolling between pages. The two outer buttons jump to the first/last page. The two
inner buttons scroll to the previous/next page.
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The input field in the middle lets you jump to a specific page. Type in the page number here and press the
Enter key¿.

The next three buttons have the following functions:

§ The left button corresponds to the ribbon command File | Page setup, with which you can define the page
format (paper size, orientation, headers and footers, etc.). For more information, see also Setting page
format. 

§ The middle button corresponds to the ribbon command File | Print, which you can use to print the
document. For more information, see also Printing a document.

§ The right button corresponds to the ribbon command File | PDF export with which you can create a PDF
file from the document. For more information, see also Exporting a document to a PDF file.

These controls can be used to change the zoom level. Enter the desired percentage value in the input field and
press the Enter key¿. Alternatively, use the three buttons to the right of the input field to switch to a predefined
zoom level:

§ Actual size of document (zoom level 100%) 

§ Fit page in window

§ Fit margins in window

To close the print preview window, click on the Close button.

Printing a document

To print the current document, choose the ribbon command File | Print .
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The program will display a dialog box in which the following settings can be made:

Printer

Here, select which of the installed printers should print the printout.

The Setup button opens a window for setting up and configuring the printer. For more information, see your
printer manual.

Linux users can also specify here the command to be used to initiate the printing process.

MacOS and iOS users select the printer including its setup via the Print button.

Print

Here, you can choose which parts of the document to print:

§ Whole document 

Print the entire document (all worksheets).
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§ Only selected cells 

Print only those cells that are currently selected in the current worksheet.

§ Current worksheet 

Print only the current worksheet.

§ Only selected worksheets 

Print only those worksheets that are currently selected in the worksheet register.

§ Only the following worksheets 

Print only the selected worksheets. To select them, use the list below this option. Click to set a check mark
in front of each worksheet that you want to print.

Ignore print range

If you enable this option, PlanMaker will ignore all print ranges defined in the document when printing.

Background information: You can define a print range for each worksheet in a document if required. When a
print range is defined, only those cells that are within this cell range will appear in printouts. The rest of the
sheet will be omitted.

You can temporarily disable this feature at any time by enabling this option.

For more information on print ranges, see Setting page format options.

Pages

Specify here the pages of the document to be printed:

§ All: Print all pages of the document. 

§ Pages: Print only the specified pages. To do so, enter the desired page numbers.

Some examples:

12 Print page 12 only

12-15 Print pages 12 to 15

12- Print page 12 and all of the following pages

-12 Print pages 1 to 12

You can also enter more than one such page number by separating them with commas:

2-5, 12 Print pages 2 to 5 and page 12

etc.

§ You can also use the option Pages to print to specify whether all selected pages or only the pages with a
even or odd page number should be printed. 
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§ For Pages per sheet, you can specify how many pages to print on a sheet of paper. PlanMaker usually prints
only one page per sheet. However, you can instruct the program to output four pages (scaled down
accordingly) per sheet at a time.

Options

This section of the dialog box contains additional printing options:

§ Copies 

Here, you can specify the number of copies of the document to be printed.

§ Collate copies 

This option specifies whether to sort the print output by page number when printing multiple copies of a
document.

If you enable this option and print multiple copies of a document with, for example, three pages, the pages
will be output in the following order: 1-2-3, 1-2-3, 1-2-3, and so on.

If it is not enabled, the order will be: 1-1-1..., 2-2-2..., 3-3-3...

Note: Some printers do not support this function.

§ Print to file 

This option redirects the print output to a file instead of a physical printer.

§ Drop pictures 

This option skips all pictures and drawings when printing (useful for fast test printouts).

§ Reverse order 

This option prints the pages from last to first.

§ Double-sided printing (Windows and Linux only) 

Instead of Single-sided printing only on the front of a page, you can set here for printing to also be
performed on the back of a page ("duplex printing"):

Double sided, long edge means that you can turn the pages like a book.

Double sided, short edge means that you scroll the pages upwards like a clipboard.

Note: Your printer must support duplex printing in order to be able to use this feature.

To start printing, click on OK.

Before actually printing a document, you can preview the printout via the command File | Print preview.
This feature enables you to avoid wasting paper on test prints.

Tip: Print comments applied to cells

If the comments applied to table cells via the ribbon command Insert | Comment are to appear in the printout,
perform the following two steps before printing:
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§ Open the dialog box "Page setup" by choosing the ribbon command File | group Print | Page setup. Switch
to the Options tab and enable "Print: Comments" there (see also Setting page format options). 

Note: This option can be set separately for each worksheet.

§ It is also necessary for you to permanently show the comments inserted in PlanMaker. To do so, use the
Comment visibility button on the ribbon tab Review | group Comments. This allows you to permanently
show all comments or single comments in your PlanMaker document (see also Using comments).

Only these displayed comments of a worksheet will be taken into account during PDF export.

Exporting a document as a PDF file
You can also export documents to a PDF file.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there (for
example, Adobe Reader). All formatting and objects (pictures, drawings, etc.) of the document are retained
exactly as in the original file.

To export a document to a PDF file, proceed as follows:

1. Choose the ribbon command File | PDF export .

2. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

3. Now another dialog box appears. Enter a file name under which you want to save the PDF file and confirm
with OK.

The PDF file will then be created. To view it, open the PDF file in a PDF viewer of your choice.

Tip: If no viewer application for PDF documents is installed on your device, simply search for "PDF viewer"
using your web browser. You will find numerous suitable programs, many of which are free.

In the dialog box of the above command, you can make the following settings for the PDF export:

General tab

On this tab, you can specify whether to output only parts of the document and make other settings. The options
are similar to the command File | Print described in Printing a document.

In addition, the following options are also available:

§ Create a bookmark for each worksheet 

If this option is enabled, PlanMaker automatically creates a bookmark in the PDF file for each worksheet
that your document contains.

Your PDF viewer will then display these bookmarks in a pane to the left of the document. You can use this
pane like an interactive table of contents: Just click on one of the bookmarks to instantly jump to the
corresponding worksheet in the PDF file.
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Tip: If your PDF viewer does not display this pane, search for a command for displaying bookmarks in it
and enable it.

§ Create tagged PDF 

If this option is enabled, information about the logical structure of the document will also be saved in the
PDF file.

This information ensures that your PDF files are accessible for the disabled and can also be used, for
example, with PDF viewers that reproduce or read aloud the document content in Braille.

§ Reset (see "Reset" button at the end of this section) 

Preferences tab

On the this tab, you can make settings for the output quality:

§ AutoShape options 

Here, you can set the resolution (i.e., number of pixels) in which AutoShapes and all other types of drawings
are exported. The higher the resolution, the larger the generated PDF file will be.

§ Picture options 

The option Compress to (not included in SoftMaker FreeOffice) sets the upper limit for the resolution of
the images (number of pixels) in the current PDF export. The value set here is the maximum value for all
images in the document, regardless of whether they have a higher or lower resolution. If the resolution of the
images in your document is lower than the set value anyway, their resolution will not change.

Note: The images in your PlanMaker document itself will not be compressed in the process, but you can achieve this with the
command Compress pictures.

With the options below, you can specify whether to save images with lossless compression or with lossy
JPEG compression. If you opt for JPEG compression, you can set the quality level of the compression.

Tip: Normally, you should choose lossless compression here because it ensures perfect image quality. If
your document contains a large number of images (especially photographs), however, the resulting PDF
file may be very large. In this case, we recommend that you use JPEG compression, which provides a
much higher compression ratio for photographs.

The option Use alpha channel for transparencies determines whether an alpha channel should be used to
represent transparency in pictures and drawings. Usually, they look best when this option is enabled.
However, some PDF viewers represent alpha channels incorrectly, thus you can also disable this option.

§ Other options 

Include PlanMaker document: This option saves a copy of your PlanMaker document inside the PDF file.
You can then open this PDF file directly in PlanMaker, whereupon the program will extract the original
PlanMaker document from the PDF file and display it.

Open the file in a PDF viewer after exporting: This option launches your PDF viewer automatically and
displays the PDF file after it has been created (provided that you have a PDF viewer installed on your
computer).

Use relative paths for file links: This option automatically converts the file path from hyperlinks (links) to
files into a relative path (rather than an absolute path). If, for example, you have inserted a link to the file C:
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\Documents\Lists\Test.txt and export the PDF document to the folder C:\Documents, this link will
be automatically converted into "Lists\Test.txt".

§ Font options 

The option Font embedding allows you to specify whether the fonts used in the document should be
embedded in the PDF file.

If font embedding is enabled, the resulting PDF file can be viewed in its original fonts on any computer –
even if the relevant computer does not have the fonts installed. If, on the other hand, the option is disabled,
the PDF file will be displayed with automatically selected replacement fonts.

The option Embed only used characters determines whether all characters of a font or only the characters
actually present in the document should be embedded when embedding fonts. The advantage of enabling this
option is that the resulting PDF file is smaller in size.

§ Archiving (not included in SoftMaker FreeOffice) 

This option enables you to select from various variants in the standard PDF/A to create standard-compliant
PDF files. This standardized format allows the long-term archiving of documents and is considered a
prerequisite when documents must be stored in a non-editable manner and in an identical format to the
original documents.

§ Reset (see "Reset" button at the end of this section) 

View tab

This tab contains advanced options for displaying the PDF file in a PDF viewer:

§ Navigation pane 

Use this option to specify what should be displayed in the navigation pane of the PDF viewer. (The
navigation pane is a bar displayed to the left of the PDF document.)

Available options:

Default: Use the PDF viewer's default setting.

Empty: Do not display anything in the navigation pane.

Bookmarks: Display the document's bookmarks in the navigation pane.

Page thumbnails: Display thumbnails of the document's pages in the navigation pane.

§ Zoom 

This option specifies the zoom level at which the PDF file should be displayed:

Default: Use the PDF viewer's default setting.

Full page: Select the zoom level at which the entire page fits in the window.

Fit width: Select the zoom level at which the page width fits in the window.

Fit height: Select the zoom level at which the page height fits in the window.

Custom: Set the zoom level to a custom value (in percent).

§ Page layout 

This option specifies the layout with which the pages should be displayed:
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Default: Use the PDF viewer's default setting.

Single pages: Display as single pages.

Two pages - odd pages left: Display as two facing pages (odd pages on the left).

Two pages - odd pages right: Display as two facing pages (odd pages on the right).

§ Additional options 

This section provides the following additional options:

Display document title: Display the document's title in the title bar of the PDF viewer (instead of its file
name). Tip: You can enter the title of a document on the Summary tab in the dialog box of the command
File | Properties.

Center viewer on screen: This option automatically centers the program window of the PDF viewer on the
screen when the PDF file is opened.

Full-screen mode: This option automatically switches the PDF viewer to full-screen mode when the PDF
file is opened.

Hide menu bar: This option hides the menu bar of the PDF viewer.

Hide toolbars: This option hides all toolbars of the PDF viewer.

Hide navigation pane controls: This option hides all controls of the navigation pane.

§ Reset (see "Reset" button at the end of this section) 

Protection tab

This tab provides options that enable you to encrypt the resulting PDF file and to use passwords to protect the
file from being opened or changed.

§ Encryption type 

Here, you can specify whether the PDF file should be encrypted. You can choose between 40 bit encryption
(low level of security) and 128 bit encryption (high level of security).

Note: The other options in this dialog box are not available until you have selected an encryption type.

§ Password to open the document 

If you enter a password here, the PDF viewer will ask for this password when users try to open the PDF file.
If an incorrect password is entered, the user cannot open the file.

If you leave this field empty, any user can open the file without having to enter a password.

§ Password to set permissions 

You can also restrict the permissions for the PDF file. To do so, enter a password to change the permissions.
Then use the options in the Permissions section of the dialog box to specify which permissions should be
granted to users.

Background information: Some PDF viewers have a command for changing the permissions. If a user
chooses this command, they can only continue if they enter the password that you have set here.
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§ Permissions 

Here, you can specify which permissions users should have with respect to the PDF file when they open it in
a PDF viewer. (This is only available if you have entered a password above for setting permissions.)

§ Reset ("Reset" button below) 

"Reset" button

All changes to the PDF export options are retained as global settings in PlanMaker and are thus applied to the
next export of a PDF document. You can restore the original default settings by clicking on the Reset button in
the lower left corner of the dialog box.

You can click on this button on any tab of the dialog box PDF Export, thereby resetting the options of all tabs
at once.

Tip: Ensure comments applied to cells are output in the PDF file

If the comments applied to table cells via the ribbon command Insert | Comment are to appear in the PDF
export, perform the following two steps before the PDF export:

§ Open the dialog box "Page setup" by choosing the ribbon command File | group Print | Page setup. Switch
to the Options tab and enable "Print: Comments" there (see also Setting page format options). 

Note: This option can be set separately for each worksheet.

§ It is also necessary that you permanently show the comments inserted in PlanMaker. To do so, use the
Comment visibility button on the ribbon tab Review | group Comments. This allows you to permanently
show all comments or single comments in your PlanMaker document (see also Using comments).

Only these displayed comments of a worksheet will be taken into account during PDF export.

Sending a document by e-mail

FreeOffice: Sending by e-mail or Share is not included in SoftMaker FreeOffice.

If you have a suitable e-mail program installed on your device, you can send documents by e-mail directly from
PlanMaker.

To do so, proceed as follows:

1. Create or open the document that is to be e-mailed.

2. In PlanMaker, choose the ribbon command File group | Document | Send .

Note for users of Android/iOS and Windows 10 or higher: Here you can use the command Share, which
enables sharing via different channels.

3. Select the format in which the document is to be sent.
Note: If you select the PlanMaker document format here, the recipient will receive an e-mail with the PlanMaker file as an attachment. In order to
open this attachment, the recipient must also have PlanMaker installed.
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PlanMaker now generates an e-mail with the file as an attachment and transfers it to your e-mail program.
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Protecting cells and documents
PlanMaker provides several options for protecting documents or specific document contents. For example, cells
can be protected from unintentional changes, or entire documents can be password-protected.

The following options are available:

§ Sheet protection 

You can use sheet protection to protect specific cells in the worksheet. If sheet protection is enabled, these
cells can no longer be changed and/or their content is hidden on screen or printouts.

§ Workbook protection 

Use workbook protection to prevent users from adding, deleting or showing/hiding worksheets.

§ Document protection 

Use document protection to password-protect the entire document against unauthorized reading or saving. If
read protection is enabled, PlanMaker will additionally encrypt the document.

See the following pages for more detailed information.

Sheet protection
Enable sheet protection for a worksheet to protect it from unwanted changes. When sheet protection is enabled,
all cells that are marked accordingly are protected in the current worksheet. Furthermore, many commands are
grayed out (are thus no longer selectable) and no objects can be inserted.

Before you enable sheet protection, however, you must first define which cells are to be protected and how
extensive the protection is to be.

Protecting cells involves two steps:

§ Step 1: Setting up protection settings for cells 

§ Step 2: Enabling sheet protection

For more information, see the following pages.

Step 1: Setting up protection settings for cells

To protect cells, you first define which cells are to be protected and how extensive the protection is to be.
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To do so, proceed as follows:

1. Select the cell(s) whose protection settings are to be changed.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Number to open the
dialog box.

Alternatively: Right-click to open the context menu and select the entry Cell.

3. Switch to the Protection tab.

4. Select the desired protection settings (see below).

5. Confirm with OK.

Tip: The options Protect cell and Hide formula can also be found directly on the ribbon tab Review | group
Protection (as options Cell protection and Hide formula here).

The individual protection settings in the dialog box of this command mean the following:

§ Protect cell 

This option protects cells against changes.

If sheet protection is enabled, neither the content nor formatting of cells can be changed.

Important: By default, this option is enabled for all cells in the worksheet. If you want certain cells to
still be editable if sheet protection is enabled, select those cells and disable the option Protect cell.

§ Hide formula 

This option only shows the result and does not display the formula used to calculate the cell content.

If sheet protection is enabled, the calculation contained in this cell cannot be determined.

§ Hide cell 

This option hides the cell content on screen.

If sheet protection is enabled, the cell becomes invisible. However, it still appears in the printout (see next
option).

§ Do not print cell 

This option hides the cell content in printouts.

If sheet protection is enabled, the cell will not appear when you print the document.

Step 2: Enabling sheet protection

The second step in protecting cells is to enable sheet protection for the current worksheet.
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This is because if you have changed the protection settings of cells (as described in the first step "Setting up
protection settings for cells"), this will have not yet affected the document.You must first enable Sheet
protection for these settings to take effect.

Note: Enabling sheet protection only affects the current worksheet.

To enable sheet protection for a worksheet, proceed as follows:

1. Choose the ribbon command Review | group Protection | Sheet protection .

2. If desired, you can now enter a password that the user must enter in order to disable sheet protection again.

If you do not want to assign a password, simply leave the input field blank.

3. Confirm with OK.

The sheet protection is now enabled; the protection settings of the cells now take effect.

You notice this, among other things, by the fact that you can only edit cells for which the option Protect cell
has not been enabled. These cells are displayed with a small green triangle in their lower right corner. This
allows you to see immediately which cells can still be changed when sheet protection is enabled.

Tip: If sheet protection is enabled, only editable cells can be accessed when moving around in the table with
the Tab key. Protected cells are skipped.

If sheet protection is enabled, there are also the following restrictions:

§ Most commands for editing the worksheet are unavailable. 

§ Position, size and all other properties of objects can no longer be changed (except for objects for which you
have disabled the Locked property).

§ Text in text frames can no longer be changed (except for objects for which you have disabled the Text
locked property).

§ New objects can no longer be inserted into the worksheet.

Disabling sheet protection

If you enabled sheet protection, you can remove it at any time. (You will recognize active sheet protection by
the fact that the icon has a dark color.)

To do so, choose the ribbon command Review | group Protection | Sheet protection  again.

The sheet protection is then disabled again.

The protection settings defined in the dialog box of the ribbon tab Home | group Number  are now ineffective
again. However, PlanMaker still remembers them. Thus, if you re-enable sheet protection, the same protection
settings will become active again.



431Protecting cells and documents

Tip: If you save a document with sheet protection enabled, sheet protection will be automatically re-enabled
the next time the document is opened. If sheet protection is still secured with a password, it can only be
disabled with the correct password. This allows you to protect documents against changes by unauthorized
persons.

Workbook protection
If you enable workbook protection in a document, you can no longer make any changes to the worksheet
register in it. Furthermore, the commands of the Insert | group Tables | Sheet button are no longer available.

The main effects of this are as follows:

§ Users can no longer add worksheets. 

§ Users can no longer copy, delete or rename worksheets.

§ Users can no longer show/hide worksheets.

Choose the command Review | group Protection | Workbook protection  to enable workbook protection.
You can also disable it again with the same command.

For more information, see the following pages.

Enabling workbook protection

To enable workbook protection for the current document, proceed as follows:

1. Choose the ribbon command Review | group Protection | Workbook protection .

2. If desired, you can now enter a password that must be entered by the user to disable workbook protection.

If you do not want to assign a password, simply leave the input field blank.

3. Confirm with OK.

Workbook protection is now enabled; it is no longer possible to insert, delete, show/hide worksheets, etc.

Furthermore, most of the options in the dialog box of the command File | Properties are no longer available.
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Disabling workbook protection

If workbook protection has been enabled in the current document, you can remove it at any time. (You will
recognize active workbook protection by the fact that the icon has a dark color.)

To do so, choose the ribbon command Review | group Protection | Workbook protection  again.

This disables workbook protection again. You can then insert, delete, show/hide worksheets, etc., again.

Tip: If you save a document with workbook protection enabled, workbook protection will be automatically
re-enabled the next time the document is opened. Furthermore, if the protection is secured with a password,
it can only be disabled with the correct password.

Document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

To protect a document, choose the ribbon command File | Properties, switch to the Protection tab in the
dialog box and select the type of document protection. Also enter the desired read and/or write password.

The following types of protection are available:

§ No protection (this is the default setting whereby the document is not protected) 

§ Write protection (the document can be opened, but saving is only possible with the password)

§ Read protection (the document can be opened only with the password)

§ Protection depending on password (a combination of read and write protection)

For more information on enabling and disabling document protection, see the following pages.

Enabling document protection

You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

Read protection also encrypts the document so that it cannot be viewed with programs other than PlanMaker.

To protect a document, proceed as follows:
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1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Protection tab.

3. Select the desired type of document protection (see below).

4. Unlike sheet protection and workbook protection, you must always assign a password for document
protection. Enter the read and/or write password (between 4 and 15 characters).

Important: If you forget a password, you can no longer open or save the document. It is thus advisable to
make a note of the password. Pay close attention to uppercase/lowercase!

5. Confirm with OK.

6. The program displays a dialog box in which you are required to verify the read and/or write password by re-
entering it.

7. Confirm with OK.

8. Exit the dialog box with OK.

9. Save the document in order for the changes to take effect.

From now on, anyone who attempts to open this document will be asked automatically for the password. If the
correct password is entered, the protection is temporarily overridden.

Types of document protection

You can choose between the following types of document protection in the above dialog box:

§ No protection 

The document is not protected. This is the default setting.

§ Write protection 

When the document is opened, the user is prompted to enter the write password. The document can only be
saved if the correct write password has been entered here.

However, it is still possible to open the document as read-only, even even if the user does not have the
password. However, it cannot be saved – not even under a different name.

§ Read protection 

If you try to open the document, you are prompted to enter the read password. If you enter an incorrect
password, you will not be able to open the document.

The document is saved in an encrypted form so that it cannot be viewed with programs other than
PlanMaker.

§ Protection depending on password 

Here, two dialog boxes prompting for a password appear in succession when the document is opened. The
first dialog box asks for the read password, while the second one asks for the write password.

If the user enters the read password, he is permitted to open the document but not to save it.

If he also enters the write password, he has full access and can thus save the document.

If he enters an incorrect password or nothing at all, access to the document is completely denied.
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Encryption method: "Most compatible" or "Most secure"?

For documents with Read protection or Protection depending on password, you can also select the desired
Encryption method.

Note: This setting primarily affects newly created documents. When you open an existing encrypted
document, the encryption method used in it is automatically determined and this option is set accordingly.

Choosing an encryption method is especially important for documents in Microsoft Excel file format (.xls and
.xlsx). Some old versions of Microsoft Office may not be able to open documents encrypted with the new
"Most secure" encryption method.

Available options:

§ Most compatible 

When you save the document, an old encryption method is used that can be read by all versions of Microsoft
Office. However, this method is less secure than the other method.

§ Most secure 

Here, a more modern and more secure encryption method is used. However, some old versions of Microsoft
Office may not be able to read documents encrypted with this method.

Detailed information about the currently selected encryption method is displayed at the bottom of the dialog
box.

Disabling document protection

When you succeed in opening a read-protected or write-protected document by entering the correct password,
protection is disabled – but only temporarily. If you close this document, the protection will be enabled again;
the next time you open it, the password prompt will appear again.

To permanently remove the protection on a document, proceed as follows:

1. Open the document.

2. Choose ribbon command File | group File management | Properties .

3. Switch to the Protection tab.

4. Select the option No protection.

5. Confirm with OK.

6. Save the document in order for the change to take effect.

Document protection is now permanently disabled.

The next time someone opens the document, no password prompt will appear. All users can now open and save
it.
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Working with other file formats
PlanMaker normally saves documents in its "in-house" file format called PlanMaker document. PlanMaker
documents can be recognized easily by the name extension .pmdx. If, for example, you save a document under
the name "Taxes", its complete file name will be Taxes.pmdx.

You can also instruct PlanMaker to save files in another file format. This is necessary, for example, if you want
to edit a PlanMaker document with another program. Conversely, you can also open documents in PlanMaker,
which have been created with other spreadsheet applications.

In this chapter, you will learn everything you need to know about working with other file formats. It is divided
into the following sections:

§ Saving and opening files in other file formats 

The first section explains how to save or open documents in a different file format: Simply choose the
ribbon command File | Save as or File | Open and select the desired format from the dropdown list of file
types.

§ Notes on the text format 

When you open or save text files, a dialog box appears with additional options. This section contains
information on these options.

§ Notes on the Excel format 

This section provides information on working with Microsoft Excel files. In this section, you will learn
everything you need to know about data exchange between PlanMaker and Excel.

§ Notes on the HTML format 

The last section deals with saving documents in HTML format.

See the following pages for more information.

Saving and opening files in other file formats
This section provides information on saving and opening documents in another file format.

Saving a document in another file format

To save the current document in another file format, choose the ribbon command File | Save as and open the
dropdown list Save as type. Select the desired format, enter a different file name if required and confirm
saving.
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Opening a document in another file format

To open a document in another file format, use the ribbon command File | Open (click directly on the icon
itself) to open the file dialog box, open the dropdown list of file types and select the format in which the file is
available. Then select the desired file, and confirm that you want to open it.

Supported file formats

In the dialog boxes for opening and saving documents, the list of file types includes the following file formats:

§ PlanMaker document 

The in-house format for PlanMaker documents in which you usually save documents (name
extension: .pmdx).

§ PlanMaker template 

Document template for PlanMaker documents (name extension: .pmvx). For more information, see
Document templates.

§ Microsoft Excel document 

You can also open and save documents in Microsoft Excel file format. The program supports .xls files
(Excel 5.0 to 2003) as well as .xlsx files (Excel 2007 or later).

For more information on working with Excel files, see Notes on the Excel format.

§ Microsoft Excel template 

Document template for Microsoft Excel documents.

§ PlanMaker 2012 document 

Documents are saved in the file format of PlanMaker 2012, an older version of PlanMaker (name
extension: .pmd).

§ TextMaker document (save only) 

This option saves the document in a file format that can be read by SoftMaker's word processor TextMaker.

§ HTML (save only) 

Documents are saved in HTML format. For more information, see Notes on the HTML format.

§ dBASE 

dBASE database file format with either a DOS, Windows or Unicode character set. Before opening/saving
the database, the program displays a dialog box in which you can select the character set.
Note: Most dBASE databases are stored in dBASE/DOS file format – not in dBASE/Windows file format.
Even Windows database programs usually use the DOS format.

Tip: In the preview window of the dialog box, you can click on the column header to specify the data type
for each column – that is, the format with which the cells of the column are to be displayed in PlanMaker.

§ SQLite database (not included in SoftMaker FreeOffice) 

The SQLite format is a fast, flexible and widely used SQL database that you can access locally (i.e. without
the usual database server). Several tables can also be created in a SQLite database.
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§ Text file/CSV file 

This is a plain text file format, for example, with the cell values separated by tabs or commas. For more
information, see Notes on the text format.

§ Text file/CSV file with additional settings 

As above, but before the file is saved, the program opens an additional dialog box in which you can make
advanced settings with respect to the file format (for example, specify separators). For more information, see
Notes on the text format.

Note: When opening a text file, the advanced settings always appear automatically.

Notes on the text format
As mentioned in the previous section, you can also open and save plain text files (including CSV files) with
PlanMaker:

§ To open a text file, use the ribbon command File | Open (click directly on the icon itself) to open the file
dialog box, simply select the desired file and confirm opening. 

§ To save a document as a text file, choose the ribbon command File | Save as, select Text file in the Save as
type list, enter the desired file name and confirm saving.

In both cases, the program displays a dialog box in which you can specify the format of the text file.

The dialog box provides the following options:

Options when saving text files

Note: To be able to make advanced settings for the file format (for example, set separators) via the dialog
box, select Text file/CSV file with additional options in the dropdown list Save as type when saving.

When you save a document as a text file, you can make the following additional settings in the dialog box:

§ Character set 

Here, you can specify which character set to use when the text file is saved.

Note: PlanMaker suggests a suitable character set automatically. Usually, there is no need to change this
setting.

§ Data format 

Here, you can set the format in which the cell contents are to be saved in the text file. The following options
are available:

Separators between fields: If you select this option, the cell contents will be separated by a certain
character (for example, a semicolon or a tab, see "Separator” below).
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Example:

Peter;Miller;24;Main Street

Elizabeth;Jones-Nightingdale;1733;University Drive

Fixed field widths: If you select this option, the cell contents will be distributed over columns with a fixed
width. Gaps will be filled with spaces.

Example:

Peter Miller 24 Main Street

Elizabeth Jones-Nightingdale 1733 University Drive

§ Decimal separator/Thousands separator 

Here, you can specify which character is used as the decimal separator/thousands separator for numbers for
the export of the text file.

Explanation: The Decimal separator is the character that is placed in a number with decimal places (for
example, the period in 17.50). The Thousands separator is the character that can be used to group long
digits (for example, the commas in 1,000,000). However, different characters are used for both separators
depending on the region.

If you would like to use other separators for the exported text file (e.g. 17.50 and 1,000,000), you can
specify them here.

Note: For the thousands separator, please note that you must have previously enabled the display of thousands separators via the
Number format so that these characters also appear in the text file after the export.

§ Separator 

Here, you can specify which character should be used to separate the individual cell contents from each
other (for example, semicolons or tabs). Thus, you set the separator here if you have chosen the option
"Separators between fields" above.

Note: Of course, the separator must not occur within cell contents, otherwise PlanMaker would make two
entries from a corresponding cell.

§ Text marker 

When saving, PlanMaker can enclose all cells that contain text within certain characters (for example,
quotation marks) if desired.

When opening a text file, you can specify here whether text components in the file are surrounded by such
text markers. These characters will then be removed when importing to PlanMaker.

If you want to do so, select the desired character from the list. Otherwise, select None.

If you select the option Auto (only when saving), a text marker will never be set. unless a line break or a
quotation mark already occurs in a cell.Additional quotation marks are then set as a text marker for these
cells.

§ Encoding of newlines 

Here, you can select the control characters to insert at the end of each line (to indicate the beginning of a
new line).

Note: PlanMaker suggests suitable control characters automatically. Usually, there is no need to change this
setting.
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Available options:

CR+LF: This is the recommended setting for Windows.

LF: This is the recommended setting for Linux and Mac.

CR: This control character was common on older Apple Mac systems (before macOS).

Options when opening text files

When you open a text file, most of the same options are available as when saving. Use these options as
described above to specify the format of the text file you want to open.

There are some additional options when opening files:

§ Date format 

If your text file contains date values, you can decide here whether the components of the date should be
positioned differently when importing. If the data in your text file is in the date format DD/MM/YYYY and
not in the usual MM/DD/YYYY format, you can specify this here.

Example:

You always use the date format that is commonly used in the United States, for example, "12/20/2022". In
your text file, however, the date values are in the UK format "20/12/2022". Thus, select the "DMY" option
to indicate which part of the date is in which position. After importing, the date will then be displayed in
PlanMaker in your region-specific format – i.e. "12/20/2022".

In this case, however, the data type for this column must be set from "Default" to "Date" in the preview
window of the dialog box (by clicking on the column header).

§ Number of header lines

If the first few lines of your text file contain headers (or lines with some explanatory text or similar), enter
the number of the lines here. PlanMaker will then refrain from distributing these lines over several columns
like the rest of the data and will store them unchanged in just one cell per line.

The default value is 0 (i.e., no header lines).

§ Decimal separator/Thousands separator

Here, you can specify which character is used as the decimal separator/thousands separator for numbers in
your text file.

Explanation: The Decimal separator is the character that is placed in a number with decimal places (for
example, the period in 17.50). The Thousands separator is the character that can be used to group long
digits (for example, the commas in 1,000,000). However, different characters are used for both separators
depending on the region.

If other separators (e.g., 17,50 and 1.000.000) are used in your text file rather than the usual separators in
your region, you can specify them here. After the import, the numbers in PlanMaker will then be displayed
with the specific separators of your region (as in the examples above).

Note: Ensure that you do not use the same characters for decimal separator/thousands separator and for
the separators mentioned below.
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§ Separators (several can be selected at the same time)

Here, you specify which character is used in your text file to separate the individual cell contents from each
other (for example, semicolons or tabs).

In order to facilitate the separation of text in more complex text files, you can select different separators at
the same time.

§ Change data type in the preview window

In the preview window, the data type for each column can be specified by clicking on the column header.
Here, you can determine the format in which the cells for the respective column should be displayed in
PlanMaker.

For example, change the data type of a column to text so that numbers with leading zeros (as in phone area
codes or zip codes) are retained.

For numbers surrounded by quotes and thus interpreted as text, set the desired number format.

§ Extended number scanning

As described above, you can specify the desired format using the column header in the preview window. If
you enable the option "Extended number scanning", such manual adjustment is no longer necessary in most
cases for certain number formats that are interpreted as text. PlanMaker then automatically detects numbers
or dates and converts them from text to an appropriate number format (right-aligned).

If the option is disabled, certain number formats may be displayed in text format (left-aligned). In this case,
you can manually set the desired number formats in the preview window using the column headers.

Notes on the Excel format
If you were using Microsoft Excel spreadsheets before PlanMaker, you will be pleased to know that PlanMaker
can open virtually any Excel file without any problems. Conversely, PlanMaker also allows you to save
documents in Excel format.

On the next pages, read what to consider when opening and saving Excel documents.

Opening and saving Excel files

As mentioned in the section Saving and opening files in other file formats, PlanMaker is able to open and save
documents in Microsoft Excel format.

This works smoothly in most cases. However, some arithmetic functions are either incompatible or are not
supported by PlanMaker or Excel.

This section provides help in resolving these issues:
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Warning message issued when opening an Excel file

When you open an Excel file containing arithmetic functions that are not compatible with PlanMaker, the
following warning message is displayed:

Then proceed as follows:

1. Choose the ribbon command View | Syntax highlighting  to enable syntax highlighting.

2. All cells containing formulas for which the conversion failed will be highlighted with a colored background.
These cells must be revised manually.

Compare its contents with the contents of the corresponding cell in the Excel document. Try to replace the
incompatible arithmetic functions with PlanMaker functions. For more information on all arithmetic
functions supported by PlanMaker, see Functions from A to Z.

3. When all cells are revised, disable syntax highlighting.

Save the document (in PlanMaker format) to finalize the changes.

Warning message issued when saving a document in Excel format

When you save a PlanMaker document in Excel format and the document contains formulas that are
incompatible with Excel, the following warning message will be displayed:

Then proceed as follows:

1. Choose the ribbon command View | Syntax highlighting  to enable syntax highlighting.

2. All cells containing formulas that are incompatible with Excel will be highlighted with a colored
background and must be revised manually. All arithmetic functions that are incompatible with Excel should
be replaced with Excel functions if possible. For more information, see the Help section for the respective
arithmetic function.
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3. When all cells are revised, disable syntax highlighting.

Save the document in Excel format again. If no further warning messages are displayed, all incompatibilities
have been eliminated.

Differences between PlanMaker and Excel

This section provides a list of the most significant differences between PlanMaker and Excel:

General differences

§ PlanMaker is unable to execute macros and VBA scripts stored in Excel documents. If you open an Excel
file that contains macros or scripts, they will be ignored. 

However, PlanMaker will not remove them – if the file is saved in Excel format, the macros and scripts will
remain functional.

Arithmetic functions

§ Some of PlanMaker's arithmetic functions are not supported by Excel (and vice versa). If you open or save
a document in Excel format, a warning message will be displayed if the file contains incompatible arithmetic
functions. For more information, see Opening and saving Excel files. 

Notes on the HTML format
PlanMaker documents can also be saved in HTML format.

To do so, proceed as follows:

1. Choose the ribbon command File | Save as.

2. Select the HTML format from the dropdown list Save as type.

3. For File name, enter the name under which the file is to be saved and confirm saving.

The document is now saved in HTML format.

All formatting not supported in HTML format will be automatically removed. This means the following:

§ Formatting that the HTML format does not recognize will not be saved. 

§ Furthermore, HTML files are not able to perform calculations on their own. Thus, when saving in HTML
format, PlanMaker calculates the entire worksheet and replaces all calculation formulas with their results.

Tip: After saving, open the document with your web browser to check its final appearance.
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Working with Arabic text
In this chapter, you will learn everything you need to know about editing Arabic text in your PlanMaker
documents. It is divided into the following sections:

§ Enabling extended support for Arabic text 

§ Changing the text direction in table cells

§ Changing the text direction in text frames

§ Changing the direction of worksheets

For more information, see the following pages.

Important: The functions described in this chapter are only available if you have enabled the option
Extended support for Arabic text in the program settings. For more information, see the next section. 

Enabling extended support for Arabic text
PlanMaker has "extended support for Arabic text", which provides some additional functions for editing text in
Arabic font.

To enable this option, proceed as follows:

1. Choose the ribbon command File | Options .

2. In the dialog box, switch to the General tab.

3. Enable the option Extended support for Arabic text.

Important: The functions described in this chapter are only available if this option is enabled.

Changing the text direction in table cells

If the option Extended support for Arabic text is enabled in Options , you can switch the text direction
between left-to-right and right-to-left in a table cell at any time.

Proceed as follows:

1. Right-click on the desired cell to open the context menu and select the entry Cell.



444Working with Arabic text

2. In the dialog box, switch to the Alignment tab.

3. Under Text direction, select the desired option: context-sensitive, left-to-right or right-to-left.

Tip: With the default setting Context-sensitive, PlanMaker automatically chooses the appropriate text
direction: When you enter text in Arabic into a cell, the text direction is set to right-to-left, otherwise, it is set to
left-to-right.

Changing the text direction in text frames
In text frames, you can switch the text direction for the current paragraph between left-to-right and right-to-left
at any time if the option Extended support for Arabic text is enabled in Options.

Proceed as follows:

1. Place the text cursor in the desired paragraph within the text frame.

2. Right-click to open the context menu and select the entry Paragraph.

3. Switch to the Paragraph tab.

4. Under Text direction, enable the option Right to left to change the direction to right-to-left.

To set the text direction to left-to-right, disable the option.

Tip: Using the keyboard

You can change the text direction of a paragraph in a text frame much faster with the following shortcut keys:

§ If you press Ctrl and the left Shift keyñ at the same time, the text direction is set to left-to-right. 

§ If you press Ctrl and the right Shift keyñ at the same time, the text direction is set to right-to-left.

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work. Alternatively, you can use the shortcut keys Ctrl+Shift+A (for left-to-right) and Ctrl+Shift+D (for right-
to-left).

Changing the direction of worksheets

If the option Extended support for Arabic text is enabled in Options , you can change the text direction of
a worksheet at any time.

To do so, proceed as follows:

1. Choose the ribbon command Insert | group Tables | Sheet | Properties in the desired worksheet.

Alternatively: Right-click on the worksheet in the worksheet register, and select Properties.
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2. Under Sheet direction, enable the option Right to left to change the direction to right-to-left.

The direction of the worksheet then changes accordingly.

Thus, if you change the direction of a worksheet to right-to-left, the column on the far right becomes the first
column (instead of the column on the far left).

This means that the table is mirrored horizontally, as shown in the following figure:

Left: Table with sheet direction set to left-to-right
Right: Table with sheet direction set to right-to-left

Note: The text direction of each individual table cell can still be defined individually, of course (as described in
Changing the text direction in table cells).
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Scripts (BasicMaker)

FreeOffice: BasicMaker is not included in SoftMaker FreeOffice.

Note: BasicMaker is only available for Windows and is not included in all versions of SoftMaker Office.

You can use the BasicMaker program to write and run scripts written in the programming language SoftMaker
Basic. SoftMaker Basic is based on Visual Basic for Applications (VBA), the programming language of
Microsoft Office.

Scripts can be used to automate workflows in the spreadsheet application PlanMaker and the word processing
application TextMaker.

Starting BasicMaker

To start BasicMaker or to run a BasicMaker script, use one of the following procedures:

§ Starting BasicMaker via the Start menu 

You can start BasicMaker by clicking on the Start menu (the Windows logo button) in the lower left corner
of the screen and choosing SoftMaker Office > BasicMaker.

§ Starting BasicMaker from within TextMaker/PlanMaker 

You can also start BasicMaker from within PlanMaker or TextMaker.

To do so, choose the ribbon command File | Edit script  in PlanMaker/TextMaker.

§ Running a script directly from within TextMaker/PlanMaker 

In PlanMaker/TextMaker, choose the ribbon command File | Run script  to run a script. A file dialog
appears. Select the script to be run, and confirm with OK.

All further information about BasicMaker and how to "program" PlanMaker and TextMaker can be found in the
help of BasicMaker, which can be accessed via the ? menu in BasicMaker.
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Working with multiple documents

Android/iOS: This function is not available for smartphones. For tablets, multiple documents can be opened
in the same program window.

You can have multiple documents open at any time – to compare them, edit them at the same time, exchange
data between them, etc.

You work with multiple documents as follows:

§ Opening multiple documents in the same program window 

You can open any number of documents at the same time in the current program window.

There are many ways to switch between these documents, including a bar that contains tabs for each
currently open document (displayed above the current document):

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

  

§ Opening files in a new program window 

You can also open documents in a new program window.

To do so, select the option New program window in the dialog box of the command File | New or of the
command File | Open when you create/open the document.

Note: To open the dialog box of the commands File | New or File | Open, click directly on their actual
icons and not on their small arrow.

The methods can be combined as desired. You can open as many program windows as you like and open any
number of documents as tabs in each of these windows. You can also open all documents in just one program
window. Alternatively, you can ensure that each document appears in its own program window. It is entirely
your choice.

In this chapter, you will learn everything you need to know about working with multiple documents at the same
time. For more information, see the following pages.
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Creating or opening a document
To create a new document or to open a document, proceed as follows:

§ To create a new document, choose the ribbon command File | New . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, the document templates used so
far will be displayed for quick access.

§ To open an existing document, use the ribbon command File | Open . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, you can choose from the most
recently opened files.

These two commands New and Open are described in detail in Basics.

Option "New program window"

The option New program window in the dialog box of these two commands has the following significance:
When it is enabled, the document appears in a new program window. If it is disabled, the document will be
opened with a new tab in the existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

Switching between open documents

Android/iOS: This function is not available for smartphones. For tablets, you can switch between document
tabs within the same program window.

If you have multiple documents open at the same time, you can switch to a specific document and thus make it
the active document:

§ Ribbon interface: "Windows" icon 

In the ribbon, you will find an icon called Windows  on the ribbon tab View. If you click on it, a list of
all open documents appears. Click on the desired document.

§ Classic menu interface: "Window" menu item 

For classic menus, you will find a list of all currently open documents in the Window menu. Select the entry
for the document to which you want to switch.
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§ Toolbars interface (Android/iOS only): "Window" menu item 

You will find a list of all currently open documents for tablets via the hamburger menu  in the Window
menu. Select the entry for the document to which you want to switch.

§ Mouse: Clicking on a document tab 

Above the document, you will find a bar with document tabs for all currently open documents. Click on the
tab for the document to which you want to switch.

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

 

§ Mouse: Clicking into the program window containing the document 

Of course, if you have documents open in multiple program windows (see previous section), you can also
simply click into the program window with the desired document to make this document the active
document.

§ Keyboard: Ctrl+F6 

You can also use the keyboard to switch between the currently open documents: Ctrl+F6 switches to the
next document and Ctrl+Shift+F6 switches to the previous one.

Mac: On a Mac, you have to use the key combinations Cmd+F6 or Cmd+Shift+F6 to switch between
documents.

Arranging documents on the screen

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

Android/iOS: This function is not available for smartphones. For tablets, document tabs can be moved
within the program window.

 If you have multiple documents open, you can arrange them as follows:

§ The document tabs (the tabs in the bar above the document) can be moved within the bar and thus arranged
in any order. 

You can even drag a document tab out of the program window with the mouse in order to have a separate
program window for this document.

Alternatively, you can drag a document tab from one program window to another. The document will then
be integrated into the tab bar of the other program window.
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§ If documents are open in different program windows, you can move the individual program windows
manually and resize them, of course – just as you can with all types of program windows.

§ If you choose the ribbon command View | Windows  | View side by side (in the classic menus interface:
Window > View side by side), you can display the current document side by side with another open
document on the screen. If more than two documents are currently open, the program first asks which of
them is to be used in the other window.
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Closing a document

Android/iOS: Not all of the listed methods are available in these versions.

If you want to stop working on a document, you can close it at any time. If the document has been modified
since it was last saved, the program automatically asks you if you want to save the document first.

To close a file, you have the following options:

In the ribbon interface

The ribbon tab File contains a Close icon  which closes the current document.

Tip: Use the ribbon command View | Windows  | Close all to close all currently open documents at once.

In the classic menu interface

Choose the menu command File > Close to close the current document.

Tip: Use the menu command Window > Close all to close all currently open documents at once.

In the toolbars interface (Android/iOS only)

In the group File , choose the command Close .

Tip: For tablets, you can close all currently open documents at once via the hamburger menu  by choosing
the menu command Window > Close all.

Tabs for documents

FreeOffice: Document tabs are not included in SoftMaker FreeOffice.

Above the document, you will find a bar with document tabs for all currently open documents. If you click on
one of these tabs with the middle mouse button, the corresponding document is closed.

Alternatively, left-click on the x icon displayed on the far right of each tab to close it.

Furthermore: If you right-click on a tab, a small menu appears with commands for closing the current document
(Close tab) or all other open documents (Close all other tabs).

Via the keyboard

You can also use the shortcut key Ctrl+F4 or alternatively Ctrl+W to close the current document.
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Mac: On a Mac, you have to use the key combination Cmd+F4 or Cmd+W for this purpose.
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Customizing PlanMaker
PlanMaker lets you determine a variety of program settings so that you can customize the program to suit your
personal work style.

In this chapter, you will learn everything you need to know about it. It is divided into the following sections:

§ Changing PlanMaker settings 

You can use the ribbon command File | Options to change the program settings. These settings apply to the
program as a whole and thus to all documents.

§ Changing document properties 

The document properties, on the other hand, are settings that only affect the current document and are also
saved in this document. They can be changed with the command File | Properties.

§ Changing worksheet properties 

Ultimately, the worksheet properties are settings that can be set differently for each worksheet in a
document. They can be changed with the ribbon command Insert | group Tables | Sheet | Properties.

§ Customizing the document display 

This section describes how to customize the appearance of the document on the screen. Most of the required
commands can be found on the ribbon tab View.

§ Customizing the ribbon 

Only for "Ribbon": This section is relevant only for users who have selected in the settings that they want
to operate the program with the "ribbon".

Here, you will learn how to configure and customize the ribbon.

§ Customizing toolbars 

Only for "Classic menus with toolbars": This section is relevant only for users who have selected in the
settings that they would prefer to operate the program with "Classic menus with toolbars".

Here, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the menu
command View > Toolbars and how to customize them to your liking with Tools > Customize.

§ Creating user-defined icons 

You can create user-defined icons at any time and add them to the ribbon or to a toolbar. Such icons can be
used to start any program.

§ Customizing shortcut keys 

You can also customize the shortcut keys for choosing frequently used commands. The ribbon command
File | Customize is responsible for this purpose.

§ Editing lists for automatic filling 

In the dialog box of the ribbon command Home | group Contents | Fill | Series, you can create your own
lists for the Fill function.
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§ Installing dictionaries 

In this section, you will learn how to install dictionaries for the spell check.

For more information on these topics, see the following pages.

Changing PlanMaker settings

General settings can be changed with the ribbon command File | Options . These settings apply to all
documents.

The options in the dialog box of this command are distributed by topic across multiple tabs. If you click on the
Files tab header, for example, you can make settings for opening and saving files.

The following pages contain detailed information on all available settings.

Settings, View tab

On the View tab in the dialog box of the ribbon command File | Options , you can make some settings for
the appearance of spreadsheets on the screen:

Markers

Here, you can change the appearance of the small triangles that are displayed in cells that contain a comment or
are protected.

§ Color of comment markers 

Here, you can change the color of the small triangle that is displayed inside cells that contain a comment.

§ Color of protection markers 

Here, you can change the color of the small triangle that is displayed in all cells that are not protected when
sheet protection is enabled.

§ Size 

This option allows you to change the size of these markers.

Snapping

FreeOffice: The Snapping features are not included in SoftMaker FreeOffice.

Here, you can configure the available aids for positioning objects (text frames, picture frames, etc.) with your
mouse:
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§ Snap to cells 

This option is disabled by default. Thus, you can move objects freely with the mouse.

If you enable this option and try to change the position of an object with your mouse, however, the object
jumps from one table cell to the next.

Enabling or disabling this function temporarily: If the option Snap to cells is enabled, you can temporarily
disable it at any time by pressing and holding down the Alt key while moving an object with the mouse. The
reverse is also possible: If the option is disabled, it can be temporarily enabled with the Alt key while
moving.

§ Snap to other objects 

When this option is enabled, the software automatically creates "magic" guides for the edges of each object
in the current worksheet. These guides make it a lot easier to position objects perfectly aligned and evenly
distributed.

These "magic" guides are usually invisible. They only become visible when you drag an object near such a
guide with the mouse. As soon as the guide appears, the object automatically snaps to it. Something similar
happens when you resize an object with your mouse.

Some examples of such guides:

If you drag an object to a position where it is roughly left-aligned with another object, a guide will
automatically appear representing the left edge of the other object. If you let your object snap to it, it will
be exactly left-aligned with the existing object.

The same applies to the right edge of objects.

If you drag an object to a position where it is roughly centered with another object, a guide will
automatically appear representing the center of the object. If you let your object snap to it, it will be
aligned exactly centered with the other object.

If you drag an object to a position below two other objects, you will also see a horizontal guide at the
position where this third object would have exactly the same relative distance as the other two objects.
(The three objects would then be distributed evenly.)

All of this works in both directions (horizontally and vertically) – for example, a magic guide is generated
for the top and bottom edges of each object.

Tip: If you hold down the Alt key while moving the object, you can temporarily disable the option Snap to
other objects that is generally enabled.

§ Snap tolerance 

Here, you can change the tolerance for the option Snap to other objects. The higher the set value, the
quicker a moving object will snap to one of the "magical" guides for existing objects.

The default value is a distance of 8 pixels.

Paint grid behind cells

When you enable this option, the gray gridlines displayed between the table cells are painted in the background
of the cells (and no longer in the foreground). As a result, the gridlines will no longer be visible for cell ranges
that have a colored background.
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Cell marker

Here, you can change the color and line width of the cell frame (the dark frame that indicates the currently
active cell in a worksheet).

Worksheet tabs

The worksheet register at the bottom of the document window displays tabs for each worksheet in the current
document.

This option allows you to change the font size used to display the worksheet name on these tabs.

Highlight (only available in SoftMaker Office NX Home and NX Universal)

Highlight current column and row: If you enable this option, the column and row for the currently selected
cell are highlighted in color. This gives you a better idea of where the selected cell is currently located on the
worksheet.

Note: The highlighting only appears if a single cell is selected and not if several cells are selected.

You can change the color of the highlighting by using the dropdown below.

Settings, General tab

On the General tab in the dialog box of the ribbon command File | Options , you can make general settings:

Maximum number of undo steps

Here, you can set how many actions can be undone with the command Undo  (in the Quick access toolbar).
You can increase this number up to a maximum of 999 undo operations.

Note: On devices with little main memory, it is not recommended to increase this value.

For information on the command Undo, see Undoing changes.

"User info" button

Here, you can enter your name, address and other contact information. To insert this information in documents,
use the USERFIELD function.

Furthermore, the data typed in the "Name" field will appear when comments are added.
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Enable dictation support

Mac only: If you enable this option, you can make better use of the macOS dictation feature in PlanMaker.
However, you must expect the program to run more slowly as a result.

Extended support for Asian fonts

Note: Enabling this option only affects the font selection in text frames. In table cells, only one font can be
selected at a time.

If this option is enabled – for text in text frames only – three lists for selecting font, font size, font style and
language appear on the Font tab in the dialog box of the command group Home | Character :

§ For Latin scripts (for example, German, English) 
§ For East Asian scripts (Chinese, Japanese, Korean) 
§ For complex scripts (for example, Arabic)

Thus, you can make the settings for each type of script separately.

If, for example, you set the font to "Arial" for Latin scripts and the font to "SimHei" for Asian scripts, all Latin
scripts that you type will automatically appear in Arial, and all Asian scripts will appear in SimHei.

PlanMaker recognizes automatically whether the characters entered are Latin, Asian or complex (for example,
Arabic) scripts.

Extended support for Arabic text

If you enable this option, some additional features will become available for editing text in Arabic script. For
more information, see Working with Arabic text.

Select whole words when selecting

Windows, Mac and Linux only: If this option is enabled, PlanMaker automatically extends any selection that
you make with the mouse to whole words. If it is not enabled, the selection is extended on a character-by-
character basis.

Add or remove spaces when pasting

If this option is enabled, spaces before and after words are automatically added or removed when you delete,
cut, or paste words from the clipboard.

If, for example, you select the word "is" in the sentence "This is a test" and cut it with the command Cut,
PlanMaker automatically deletes the space behind "is" that is now superfluous.

If you now insert the word "is" before another word using the command Paste, PlanMaker automatically inserts
a space after "is".
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Middle mouse button

Mac and Linux only: Here, you can specify what should happen when you click somewhere using the middle
mouse button. Available options:

§ No function: The middle mouse button doesn't have any function. 

§ Paste selected content: If you click in the document with the middle mouse button, a copy of the currently
selected content is inserted at this point (for example, the currently selected text).

Apply character formatting to entire words

Enabling this option has the following effect:

If the text cursor is inside a word and you change the character formatting (for example, select a different font
or enable bold), this will affect the entire word.

This allows you to quickly change the formatting of a single word without first having to select it.

Use the Insert key to toggle overwrite mode

This option is enabled by default and allows you to use the Ins key on your keyboard to switch between insert
mode and overwrite mode (see also Status bar).

If you remove the check mark in front of the option, this typical function of the Ins key will be disabled when
working in PlanMaker. This prevents accidental switching to overwrite mode.

Insert frames and drawings immediately

This option determines what should happen if you insert a frame or a drawing into a document (text frame,
picture frame, AutoShape, etc.) – for example, with the ribbon command Insert | Text frame:

§ Always: The corresponding object is inserted immediately. Its position and size are fixed without further
action. 

(Of course, you can always change the object's position after insertion by simply dragging it to the desired
location with the mouse. You can also resize it by dragging one of the round handles that surround the
object.)

§ Never: Before the object is actually inserted, the mouse cursor changes to a crosshair. In order to proceed,
drag a rectangle in the document to specify the desired position and size. The object will then be inserted
exactly according to your specifications. 

§ Auto: This is a smart combination of the two aforementioned options that is already preset in PlanMaker for
each specific object type. Objects such as charts or picture frames are inserted directly (as with Always), for
example, while objects such as AutoShapes or text frames are inserted via the mouse cursor (as with Never).
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"Auto correction" button

PlanMaker can automatically correct common typos and also provides other useful auto correction functions. If
you click on the Auto correction button, the program opens an additional dialog box in which you can make
the appropriate settings.

Tip: The ribbon command Review | group Spelling | Auto correction  can also be used to open the auto
correction dialog box.

For more information on this topic, see Auto correction.

Use left Alt for shortcut keys

Mac only: This option determines which function the left Alt key on your keyboard should have:

§ Off: The left Alt key does the same as the right Alt key: It inserts icons into the text. 

Alt+E, for example, returns a euro sign €.

§ On: The left Alt key can be used to open menus in the classic menu. 
Note: This only works if you use the program with the classic menu interface instead of the ribbon interface.

Here, Alt+E no longer returns a euro sign, but opens the Edit menu instead.

Show warning when loading OLE objects

For Mac, Linux and Android/iOS: If this option is enabled, the program displays a warning that OLE objects
cannot be displayed when you open a document containing such objects. (OLE objects can only be displayed on
Windows.)

Settings, Edit tab

On the Edit tab in the dialog box of the ribbon command File | Options , you can change settings for editing
worksheet cells:

After input, move selection ...

This option determines the direction in which the cell frame (the dark frame that indicates the current cell on
the screen) moves when you type something in the cell and press the Enter key¿.

Height of the input field

Here, you can set whether the single-line input field for formulas in the Edit toolbar should expand so that you
can see the complete content even for long formulas. For more information, see Edit toolbar.
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In-cell editing

This option is enabled by default. This means that you can edit the contents of a cell directly in the worksheet
after pressing the F2 key. If you disable this option, the cell contents can only be edited in the Edit toolbar
(displayed above the spreadsheet) after pressing F2.

Automatic percent input

This option determines how PlanMaker reacts when you type numbers into cells that contain percentages or are
formatted with the "Percent" number format. If enabled, a percent sign is automatically added to your input.

Autocomplete cells

While you type text in a cell with this option enabled, PlanMaker automatically makes suggestions from the
existing text entries found in the cells above and below this cell.

Example: You have entered the values "New York", "Rio", and "Tokyo" in a column. If you now go to the cell
below these entries and type the letter "N", the program will automatically suggest "New York". If you type the
letter "T", "Tokyo" will be suggested, etc.

To accept the suggestion, press the Enter key¿. To reject it, simply continue typing or press the Del key.

If you do not want PlanMaker to make suggestions while you are typing, you can always disable this option.

Left arrow key never exits cell editing

Use this option to specify what should happen when you navigate to a cell, type in a value and press the left
arrow key ß:

§ On: The text cursor is moved to the left (within your input). 

§ Off: The cell frame is moved to the left. This means that the value you enter is accepted, and the cell to the
left of the current cell is made the active cell.

Warning if a formula contains errors

If you enter a formula that contains an error (for example, a closing parenthesis is missing), PlanMaker issues
an error message when you press Enter¿. If you do not want that to happen, disable this option.

Note: Regardless of this option, incorrect formulas are generally replaced by the text #NULL! when you save
the document.
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Formula tooltip

If this option is enabled and you enter an arithmetic function in a cell, a tooltip providing information about the
required function parameters appears below the cell.

Expand tables automatically

As described in the section Tables in worksheets, the ribbon command Insert | Table enables you to create
"Tables in worksheets".

This option has the following effect on such tables:

§ On: When you enter something in one of the cells directly to the right of the table, the table is automatically
expanded by another column. The same applies to rows: When you type something in a cell directly below
the table, another row is added automatically. 

§ Off: The table is not expanded automatically.

Number separators

Here, you can set which characters to use as the decimal separator and thousands separator for numbers.

Explanation: The decimal separator is the character that is placed in a number with decimal places (for
example, the period in 17.50). The thousands separator is the character that can be used to group long digits
(for example, the commas in 1,000,000).

§ If you select System default, PlanMaker automatically determines the decimal separator and thousands
separator from your current system settings. (This is the default setting.) 

§ If you switch to Custom, PlanMaker lets you specify a custom decimal separator and thousands separator.

Warning: If you specify custom settings that are incorrect, calculations may return invalid or wrong
results!

Calculation in status bar

If you select several cells, their sum is automatically displayed in the status bar per "Online calculation".
However, you can also specify other calculation methods here. You can even select several calculation options,
the results of which are then displayed next to each other in the status bar. (In SoftMaker FreeOffice, you can
only display one calculation option and not multiple calculation options next to each other.)

Tip: You can also set the options for "Calculation in status bar" directly in the status bar itself. To do so, click
in the status bar – at the point where the result of the calculation is displayed.

Settings, Appearance tab

On the Appearance tab in the dialog box of the ribbon command File | Options , you can make settings that
affect the appearance of the PlanMaker user interface:
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Dialog language

Here, you can select the language in which the user interface (ribbon, menus, dialog boxes, etc.) is to be
displayed.

"User interface" button

If you click on the User interface button, the program displays a dialog box in which you can select the type of
user interface that the SoftMaker Office applications should use:

§ Ribbon (top row) 

If you select one of the styles from the top row, the programs use a "ribbon" as the user interface. The only
difference between the individual styles is in the color scheme used: colorful, light grey or dark.

§ Classic menus with toolbars (bottom row) 

If you select one of the styles from the bottom row, the programs will use classic menus with toolbars. You
can also choose between different color schemes here.

Android/iOS: If you are using these versions, select the user interface via the dropdown list. Here, you
have an additional option: Toolbars. For more information, see User interface on Android/iOS. The options
Quick access toolbar and Touch mode can be found separately elsewhere on this Appearance tab and work
as described below.

Furthermore, the following settings can also be made for the user interface:

§ Quick access toolbar (only in the ribbon interface) 

This option determines where the Quick access toolbar, which contains icons for some of the most
frequently used commands, should be displayed: to the left of the document tabs – or in a separate toolbar
directly below the ribbon.

§ Touch mode 

If you enable this option, all icons in the ribbon user interface or menu interface and toolbars will be slightly
enlarged. This is useful when operating the software with your finger (for example, on a tablet).

Tip: Alternatively, you can also enable/disable touch mode with the following commands:

Ribbon user interface: Here, you choose the command Touch mode  in the Quick access toolbar.

Classic menu interface: Here, you choose the command View > Touch mode.

§ Update dark and light design automatically from the system 

If you enable this option, the style of the user interface (light or dark) will be based on the color settings of
your operating system. Thus, if you operate your device in dark mode, the SoftMaker Office applications
will automatically switch to this mode also.

(This option is not available in the Linux version.)

"User interface size" button

This button opens a dialog box that allows you to reduce or enlarge the user interface (menu, toolbars, dialog
boxes, etc.).
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If you select a lower setting here, all user interface elements will be reduced, which will allow you to see more
elements at a time. A higher setting, on the other hand, increases legibility.

Use the mouse (or your finger) to drag the Size of dialog elements slider to gradually change the size of the
user interface.

The Sample field acts as a small tool to help you find a suitable setting: It gives you a preview of how a
checkbox in a dialog box or even in the Quick access bar will look after you have applied your changes.

Note: Inappropriate settings may cause the user interface to be far too small or too large, especially on
devices with a relatively low resolution. If this happens, you can always click on the Reset to default button
in the lower left of this dialog box to return to the default settings.

The option Touch mode only enlarges the icons (see also description above). Incidentally, you will also find
this function directly in the Quick access bar.

Document scaling (DPI)

You can scale the document higher or lower for a larger/smaller view. To do so, select Custom and enter the
desired value.

Show full path in title bar

Enable this option if you want the title bar to display not only the name of the document but also its file path.
(Not available in the Android/iOS version.)

Show status bar in ribbon mode

This applies only to the ribbon interface: You can enable/disable the display of the status bar here. To change
this for the classic menu interface, see Showing and hiding toolbars.

Show fonts in font list

If this option is enabled, PlanMaker displays all font names in the respective font in font lists (for example, in
the font list of the command group Home | Character in the ribbon or in the Formatting toolbar in the classic
menu interface). This lets you see the actual appearance of each font at a glance.

Show tooltips

This option lets you specify whether or not tooltips should be displayed. These are short info texts that are
displayed next to the mouse cursor when you hover over a screen element (for example, a button in the ribbon
or in the Standard toolbar for the classic menu interface).

Beep on errors

If this option is enabled, PlanMaker emits a beep for error or warning messages.

Use system file dialogs

This option controls the type of dialog boxes that appear when you use commands for opening and saving files.
The options are:
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§ Disabled: PlanMaker uses its own file dialogs. 

§ Enabled: The default file dialogs of the operating system appear, which you know from the majority of
applications.

The former are easier to use; the latter offer more options.

Note for users of the iOS version: The system file dialogs are always used automatically here.

Note for users of Linux: You must be running the Gnome desktop environment so that this function is available. (This automatically
means you have the Gtk libraries installed).

Live preview

FreeOffice: The live preview is not included in SoftMaker FreeOffice.

Here, you can enable/disable a live preview for the dropdown lists that are located, for example, in the
command group Home | Character.

If this is enabled, for example, you can select text, open the font list in the command group Home | Character
and then hover over the fonts in it. The document immediately shows how the selected text would look "live" in
the corresponding font.

To actually apply the font, simply click on it. To discard the change, click anywhere outside the font list or
press the Esc key.

Smooth edges of screen fonts

If this option is enabled, PlanMaker uses a technology called "anti-aliasing" to smooth the edges of fonts and
improve their appearance on the screen.

Different options are available depending on the operating system.

Workspace color

This option allows you to change the background color of document windows (this option is especially useful
for TextMaker and Presentations, but also suitable for PlanMaker, for example, for print previews).

Measurement

Mac, Linux, Android/iOS only: Here, you can specify the units of measure which PlanMaker should use by
default: Metric (centimeter) or U.S. (inch).

(On Windows, this option is not required because the program automatically uses the setting that was selected
in the options "Region and Language" of the Windows Control Panel.)

Tip: You can always override this setting and enter a value into dialog boxes in another unit of measure by
typing one of the following unit of measures after the value:

Unit Explanation

cm Centimeter
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in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

If, for example, you type "5.08 cm" for the left margin, PlanMaker sets it to 2 inches (5.08 cm).

Desktop mode

Android/iOS only: If you are using a tablet, you should enable this option so that PlanMaker is displayed in an
optimized manner on tablet devices. If you are using the application on your smartphone, leave this option
disabled.

Settings, Language tab

On the Language tab in the dialog box of the ribbon command File | Options , you can make settings for
PlanMaker's spell check and hyphenation:

Language

Here, you can select the language to be used for the spell check and hyphenation. To do so, open the dropdown
list and select the desired language from the available options.

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check

Here, you can make the following settings for the spell-check:

§ Check spelling as you type 

If you enable this option, PlanMaker will check the spelling of text as you type. As soon as you make a
mistake, a dialog box will appear to facilitate a correction. For more information, see Checking the spelling
as you type.

Note: If this option is disabled, you don't have to do without a spell check – you can always start it manually
with the ribbon command Review | Spell check. For more information, see Manual spell check.

§ Beep on errors 

This option determines whether PlanMaker should beep when Check spelling as you type encounters an
unknown word.
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§ Ignore words that start with a number 

If you enable this option, the spell check ignores all words that start with a number (for example, "1980s").

§ Manage dictionaries 

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included
in SoftMaker Office. Only Hunspell dictionaries can be used here.

As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries.
They are available free of charge for installation. Most of them were created by private users or non-profit
organizations.

The Manage dictionaries button allows you to install dictionaries and also specify which of these
dictionaries should be used for a language. For more information, see Installing dictionaries.

Settings, Files tab

On the Files tab in the dialog box of the ribbon command File | Options , you can make settings for opening
and saving files:

Template folder

Here, you can specify the folder in which the templates for PlanMaker documents are stored.

The dialog box that appears when you choose the ribbon command File | New to let you select a document
template displays all templates that are in this folder.

Note: Normally, this setting should not be changed. Change it only in the event that you have actually moved
the template folder to another place.

Default file format

Here, you can select the file format in which PlanMaker should save newly created documents by default.

If you create a new document with the ribbon command File | New and then save it for the first time, the Save
dialog box always suggests the file format set here as default.

You can choose between several versions of both the PlanMaker format and Microsoft Excel format.

Important: Note that the Excel format does not know all of PlanMaker's features. If you save a PlanMaker
document in Excel format, certain formatting options and other features may be lost. We thus recommend
that you use the default setting "PlanMaker" here.

Saving section

In the Saving section, you can make settings for saving documents:
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§ Prompt for summary information when saving 

If you enable this option, a dialog box will appear automatically the first time you save a new document to
enable you to enter some additional information about it. For more information, see Document summary.

Opening section

In the Opening section, you can make settings for opening documents:

§ Recently used files in File menu 

If you click on the small arrow on the ribbon command File | Open , PlanMaker displays a list of the most
recently opened files. If you select one of these entries, the corresponding file will be opened immediately.
Here, you can specify the number of files to be displayed in the list.

SoftMaker FreeOffice only: Backup section

SoftMaker FreeOffice does not contain a "Backup" tab and its settings, which are described in the next section.
Instead, you have to choose either No backup or Simple backup in the dropdown list on the "Files" tab.

§ No backup 

If you select this option, no backups will be created when documents are saved. (This option is not
recommended.)

§ Simple backup 

This makes one backup per document. It contains the previous version of the document. It has the name
extension .bak and is in the same folder as the document itself.

SoftMaker FreeOffice has also the following option for the Opening section above.

§ Auto recovery: Save state every ... minutes 

If this option is enabled, PlanMaker automatically makes a temporary backup copy of every opendocument
on a periodic basis. You can enter a period of 1 to 100 minutes.

Note: These temporary backup copies work completely independently of the Simple backup/No backup
option described above.

When you exit PlanMaker in the normal manner, these temporary backup copies are automatically deleted.
However, if it is not terminated correctly (for example, due to a crash), PlanMaker will detect this the next
time the program is started. It then opens (after prompting) the temporary backup copies of all documents
that were open when the crash occurred and contained unsaved changes.

You can then check each of the restored documents to determine if any of the most recently made
changeshave actually been lost, and then save them.
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Settings, Backup tab

FreeOffice: This tab is not included in SoftMaker FreeOffice. However, simple backups can be made here.
This setting can be found on the Files tab.

On the Backup tab in the dialog box of the ribbon command File | Options , you can make settings for
creating backup copies:

"When you save a file manually..." section

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is enabled, the command File | Versions  (in the group File management) is also
available, which allows you to easily return to a previous file version of the currently open document.

§ Number of versions to keep 

Here, you specify the maximum number of versions of backups (generations) to be kept per document.

"Automatically created file versions (snapshots)" section

§ Save unsaved changes every ... minutes 

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

§ Number of snapshots to keep

In this dropdown field, you specify the maximum number of snapshots you want to keep.

Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

"Clean up" button

This button provides two options for deleting file backups from the backup folder:

§ Delete orphaned file versions

This option removes all PlanMaker backups for which the corresponding original document no longer exists.

§ Delete file versions of all documents

This option removes all backups from PlanMaker.

For more information on using file backups, see Backup copies (file versions).
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Settings, System tab

On the System tab in the dialog box of the ribbon command File | Options , you can make the following
system settings:

Smooth edges of pictures

If this option is enabled, PlanMaker uses anti-aliasing to smooth edges and lines in pictures. Advantage: The
display quality of scaled pictures is improved. Disadvantage: This procedure consumes some CPU time when
displaying pictures, of course.

Enable OpenGL AutoShapes

If this option is enabled, PlanMaker uses the OpenGL graphics engine to display AutoShapes optimally. If you
disable this option, 3D effects used for AutoShapes may no longer be displayed correctly. Thus, you should
usually leave this option enabled.

Check for updates

Windows, Mac and Linux only: Here, you can specify how often you want the software to check whether
there are updates for SoftMaker Office. Updates provide bug fixes and feature improvements.

Note: Checking for updates only works if your device can access the Internet.

You can also disable the automatic update check (not recommended) by selecting Never from the dropdown
list. Checking for updates can then only be done manually – by clicking on the Check now button.

Tip: Subscribe to our free newsletter at www.softmaker.com to automatically receive an e-mail whenever
updates are available. The newsletter will also provide you with other useful information and special offers
with respect to SoftMaker Office on a regular basis.

Android/iOS: For applications installed from the Google Play/Apple App Store, your device will automatically
notify you of updates (unless disabled in the settings of the respective store).

Associate file types

Windows only: This button opens a dialog box where you can associate certain file types with PlanMaker. This
will make PlanMaker the default application for the corresponding file types.

If, for example, you link the file type "Microsoft Excel documents" with PlanMaker , files of this type will
always be opened in PlanMaker when you double-click on such a file in Windows Explorer.

Show a message during program launch when PlanMaker is not the default program

Windows only: The aforementioned button enables you to set PlanMaker as the default program for opening
certain file types. Over time, another application may assume the role as the default program for opening such
file types.

http://www.softmaker.com/
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If this option is enabled, a message will then appear the next time you open this file type in PlanMaker asking
whether you want to set PlanMaker as the default program again. If this option is disabled, the message will no
longer be displayed.

Show/hide keyboard automatically

Android/iOS only: If this option is enabled, the on-screen keyboard opens automatically when you can type
something (for example, if you double-tap on a cell or tap into an input field in a dialog box).

Change keyboard layout automatically

Android/iOS only: If this option is enabled, the layout of the on-screen keyboard will automatically adapt to
the current situation. If, for example, you type into an input field in a dialog box which only accepts numbers,
the keyboard will automatically be switched to numeric mode.

Furthermore, when you enter values into table cells, PlanMaker will note the current mode of the keyboard if
this option is enabled. If it is disabled, the keyboard will be reset to its standard mode (alpha-numeric) each
time you enter data in a new cell.

Enable OpenGL engine

Linux only: If this option is enabled, the program uses the OpenGL graphics engine. This speeds up the screen
display. Thus, this option should usually be enabled.

Note: On systems with a very outdated or faulty OpenGL installation, display errors may occur within the
application. This depends on your individual system configuration and especially on the graphics driver you are
using. In this case, disable this option and restart the application.

Furthermore: If the program detects problems with the installed OpenGL engine at startup, it will automatically
disable this option.

Use SHM extensions

Linux only: This option is only available if the option Use OpenGL engine is disabled (not recommended).

If the SHM extensions are enabled, the program uses shared memory (if available), which can speed up the
responsiveness of the display.

Use XIM

Linux only: If this option is enabled, PlanMaker supports the composition of accented characters (à, ô, é etc.)
using "XIM".

On a German keyboard, for example, the character "ô" can be created by first pressing the ^ key and then the O
key.

If you disable this option, you can no longer compose characters in this way.

Note: On some systems, disabling this option improves the responsiveness of the display when you are typing
text quickly.
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Show hidden files and folders

Mac, Linux only: If this option is enabled, hidden files and folders are also displayed in file dialogs (for
example, those of the ribbon command File | Open).

Lock files for exclusive write access

Mac, Linux only: If this option is enabled, some distributions of macOS and Linux can prevent a PlanMaker
file from being changed by different programs at the same time. If the option is disabled, different programs can
access a file at the same time.

User-defined font paths

Mac, Linux, Android/iOS only: Here, you can specify paths for additional fonts that PlanMaker should use.
To do so, enter the subdirectory in which the font files are located. If you want to enter multiple directories,
separate them with a colon.

PlanMaker can then use these fonts in addition to the fonts available in your system.

Note: Changes to this setting only become effective after the program is restarted.

Mouse wheel

Mac, Linux only: If your mouse has a mouse wheel, you can set the scrolling increment for a turn of the wheel
either by page (one complete page) or by a certain number of lines.

External applications

Mac, Linux only: This button opens a dialog box where you can specify the external programs that start
automatically for specific events. When a PDF file is created, for example, the application specified in the PDF
viewer field will be launched to display the result.

Note: You don't have to fill in these fields. For all fields that you leave empty, your system's default application
will be automatically used for this action. Make changes to this dialog box only if you want an application other
than the default application to be used. To do so, simply enter the file name of the corresponding executable file
(including the entire file path, if necessary).

Settings, Fonts tab

On the Fonts tab in the dialog box of the ribbon command File | Options , you can specify which fonts are
to be displayed in font lists (for example, the font list on the ribbon command Home | group Character).

The tab presents a list of all fonts installed on your system. To enable or disable a font in the list, click on the
checkbox in front of its name. All fonts for which you have removed the check mark are no longer displayed in
font lists.
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Background information: The fonts installed on your system by default include several fonts that you will
probably never need – for example, fonts that only contain scripts for foreign languages that you don't use. If
you like, you can hide such fonts as described above.

Windows: Use font filtering of the operating system

Windows users will also find the option Use font filtering of the operating system on this tab. If this option is
enabled, Windows will automatically hide in font lists all fonts that only contain scripts for foreign languages
(for example, Asian/Arabic fonts).

Mac: Load only fonts relevant for installed keyboard layouts

MacOS users will also find an option on this tab called Load only fonts relevant for installed keyboard
layouts.

Explanation:

On macOS, there are numerous fonts installed on the system with foreign language characters that you usually
do not need (for example, Asian/Arabic fonts).

If this option is enabled, such fonts are automatically hidden in the font lists. These fonts will continue to
appear in the font lists only if you use appropriate keyboards for Asian/Arabic fonts or enable font support. For
more information, see Settings, General tab.

If you disable this option, all system fonts are always available in the font lists.

"Manage" button

In the dialog box of the ribbon command File | Options , you will find the Manage button on each tab. You
can use it to save the settings of the program and, for example, transfer them to a new version.

For more information, see the following pages.
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Exporting/importing settings
You can save your individual settings that you have configured in the SoftMaker Office applications. In the first
step, export the settings data – for example, before you install a new version. Then, in the second step, import
this data into the newly installed version.

For both steps, use the Manage button in the dialog box of the command File | Options .

For information on which settings you can export/import exactly, see below.

Note: Export and import of settings data is only possible as of version 2021.

What reasons could there be to export/import settings?

The following reasons could be considered for exporting/importing your settings:

§ You want to apply the settings of the old version to a new version of SoftMaker Office that you are
installing on the same computer. 

§ You have also installed the current version of SoftMaker Office on another computer and want to use the
same settings there.

§ You want to apply the settings of an old version of SoftMaker Office to another computer on which you
have installed the new version of SoftMaker Office.

Which files are backed up?

For the export, PlanMaker accesses the settings files (...config.ini, ...tools.dat, etc.) that are stored on your
device in the SoftMaker > Settings folder. Depending on the operating system, these files are located in
the following directory:

§ Windows: In the SoftMaker\Settings folder in your Documents folder. 

§ macOS: In the SoftMaker/Settings folder in your Documents folder.

§ Linux: In the SoftMaker/Settings folder in your Home folder.

§ Android: In the SoftMaker/Settings folder on your SD card.

§ iOS: In the SoftMaker/Settings folder in your App folder.

Note: The above information is for illustrative purposes only and you usually do not need to do anything
here. PlanMaker will automatically replace these files for you if you perform the steps described below for
exporting/importing the settings.
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Step 1: Export the settings

To export settings, choose the command File | Options , and the "Options" dialog box will open. Here, click
on the Manage button located at the bottom left of each tab of this dialog box.

This will open another dialog box "Manage settings for Office". Here, select which settings you want to save
from the following options:

Tip: You can also just export all of them, but you will have to ensure when subsequently importing that you
only select the options you really want.

§ Configuration files 

This option saves all the settings you have made in the dialog box of the command File | Options. Some of
these settings are also located directly on the ribbon tabs (or in the toolbars).

§ Customized ribbon/toolbars

If you have changed the arrangement on the ribbon, in the Quick access toolbar or in toolbars (see section
Customizing the ribbon), you can save your individual arrangement with this option.

Please note for the import of the settings from an old to a new version of SoftMaker Office: If this option is enabled, command
icons that have been newly added in the more recent version will not be displayed there. Thus, if you would prefer the new icons to
be displayed instead of keeping your old arrangement, you should disable this option. Alternatively, you can import your old
arrangement anyway and look for the new symbols relevant to you afterwards using the command File | Customize (see section
Customizing icons and groups in the ribbon).

§ Keyboard shortcuts

This option allows you to apply shortcut keys that you have assigned yourself (see Customizing shortcut
keys).

§ User dictionaries

This option allows you to save the words that you have added to your user dictionaries (see section Editing
user dictionaries).

§ Other (SmartText, Labels, ...)

Enable this option if you want to apply all other settings that can be saved in SoftMaker Office (for example,
SmartText).

When you finally click on the Export button, a zip file will be created with the options selected above. Save
this file to any location that you can easily access for subsequent import.

Note: The settings of all SoftMaker Office applications are exported (TextMaker, PlanMaker, Presentations,
BasicMaker). The same applies to the import in the following step. In the iOS version, the export/import
must be performed separately for each application.

Step 2: Import the settings

To transfer the settings to another installation of the program, choose the command File | Options there. In the
dialog box "Options", click on the Manage button.
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In the following dialog box "Manage settings for Office", insert a check mark in front of the settings you want
to import. (Details of the options are described above in step 1.)

Now click on the Import button, and select the zip file that you created in step 1. The imported settings will
take effect in the current PlanMaker application when you restart the program.

"Reset" button

The Reset button resets all program settings back to their delivery state.

Note: This action resets the settings for all SoftMaker Office applications (TextMaker, PlanMaker,
Presentations, BasicMaker) of this version. For iOS users, the reset applies to each application separately.



476Customizing PlanMaker

Changing document properties

You can use the ribbon command File | group File management | Properties  to change settings that only
affect the current document and are saved with it. These settings are called document properties.

The available document properties are distributed by topic across multiple tabs. If you click on the Summary
tab, for example, you can edit the document info.

The following pages provide detailed explanations of all available document properties.

Document properties, Summary tab

On the Summary tab in the dialog box of the ribbon command File | Properties , you can enter some
additional info for the current document.

This can include explanatory information about the current document (subject, author, keywords, etc.) that the
file manager can use in searches.

For more information, see Document summary.

Document properties, Colors tab

On the Colors tab in the dialog box of the ribbon command File | Properties , you can edit the color palette
of the current document.

When you open a color list – for example, the color list for the font color – you see only a small selection of the
up to 16 million colors available. This selection is called the color palette of the document.

You can modify this color palette at any time. You can add new colors and change colors that you have added.
However, the first 24 colors in the palette are default colors that cannot be changed.

Important: Changes to the color palette are saved in the document. This means that you can create a separate
color palette for each document.

Adding a color

To add a color to the palette of the current document, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.
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Tip: Alternatively, this color palette can be accessed via any button that contains a color list (for example,
font color). To do so, select the entry Define color... in the color list (the last entry).

2. Set the desired color. For more information, see "Working with the color controls" section below.

3. Click on the New button.

4. Give the new color whatever name you like and confirm with OK.

5. Exit the dialog box with OK.

PlanMaker now adds the new color to the document's color palette. From now on, the color will be available in
all dialog boxes where a color can be selected.

Changing a color

Note: You can only change colors that you have added. The first 24 colors in the color palette are default
colors that cannot be changed.

To change a color, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Alternatively: You can also select the entry Define color... in any color list (for example, font color) to open
this dialog box.

2. Select the color to be changed from the Color palette list.

3. Make the desired changes. For more information, see "Working with the color controls" section below.

4. Click on Change.

The color has now been changed for the current document.

Renaming a color

You can change the name of self-defined colors at any time. To do so, open the color dialog, select a color from
the dropdown list Color palette and click on the Rename button.

Working with the color controls

The controls in the above dialog box let you set colors in many ways. All these ways lead to the same result –
just select your preferred method:

§ Using the color field and luminance slider 

The easiest way to set colors is to use the large color field and the luminance slider to its right. The color
field presents all available hues in all available saturations, while the luminance slider next to it provides a
means of varying the luminance.

To set a color, first click on the desired color in the large color field. Then click on the desired luminance in
the luminance slider.



478Customizing PlanMaker

§ Using the hue, saturation and luminance controls 

Alternatively, you can set colors with the controls labeled Hue, Sat (saturation) and Lum (luminance).
Values between 0 and 240 are allowed.

§ Using the Red, Green and Blue controls 

Colors can also be set via their red, green and blue components. The controls labeled Red, Green and Blue
are provided for this purpose. Values between 0 and 255 are allowed.

§ Typing the hex code for a color 

You can also specify a color by typing its hex code in the input field with the hash (pound) sign #.

Such hex codes are common in the HTML code of web pages, for example. The hex code consists of 3 two-
digit hexadecimal values for the colors red, green and blue (RRGGBB). For example, 00FF00 represents
pure green.

Document properties, Statistics tab

On the Statistics tab in the dialog box of the ribbon command File | Properties , you can retrieve statistical
information about the current document:

§ The Cells section displays how many cells are filled and how many of them contain text, numbers, formulas
or comments. 

§ The General section displays the number of worksheets and the number of pages.

§ The Objects section displays the number of objects (charts, pictures, etc.) in the current documents.

§ The Actions section displays when the document was created, last saved and last printed.

Document properties, Options tab

On the Options tab in the dialog box of the ribbon command File | Properties , you can make general
settings for the current document:

"Text frames" section

§ Tab width 

This option determines the tab width for text entered in text frames.
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"Cell contents" section

§ Syntax highlighting 

If this option is enabled, cells will be colored according to their content. This corresponds to the ribbon
command View | Syntax highlighting. For more information, see Syntax highlighting.

§ Show formulas 

If this option is enabled, cells containing a calculation will display the formula instead of the result. This
corresponds to the ribbon command View | Show formulas. For more information, see Showing formulas.

§ Protection indicator 

If this option is enabled, a small green triangle will be displayed in all unprotected cells when sheet
protection is enabled. This makes it easier to see which cells may still be edited. For more information, see
also Sheet protection.

§ Hyphenation 

If this option is enabled, automatic hyphenation is performed in all cells where the option Wrap text has
been enabled in the dialog box of the command group Home | Alignment . For more information, see also
Hyphenation.

"Comments" section

§ Show indicators 

If this option is enabled, a small red triangle is displayed in all cells that contain a comment (inserted with
the command Insert | Comment). For more information, see also Using comments.

§ Always show comments 

Normally, comments are displayed only when you hover with your mouse over a cell that contains a
comment. If you enable this option, all comments in the current document will be displayed permanently.

"Decimal point after input" section

§ Move by ... decimals 

If this option is enabled, numbers entered in cells will be shifted by the specified number of decimal places.

This is useful if, for example, many numbers with two decimal places have to be entered. If you set the
number of digits to the value 2 and enter the number 42, this will automatically be converted to 0.42; the
input 234 will be converted to 2.34, and so on.

"Window" section

§ Vertical scrollbar 

If this option is enabled, a vertical scrollbar is displayed in the document window.

§ Horizontal scrollbar 

If this option is enabled, a horizontal scrollbar is displayed in the document window.
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§ Sheet tabs 

If this option is enabled, the worksheet register with tabs for each worksheet is displayed below the
document. These tabs can be used for switching between worksheets and creating/managing worksheets.

"Objects" section

§ Guidelines for text frames 

If this option is enabled, non-printing gray lines are displayed around text frames. These lines make it easier
to determine and change the position/size of text frames.

§ Show hidden objects 

As described in the section Hiding objects, you can hide inserted objects on the screen, that is, make them
invisible.

If you enable the option Show hidden objects, however, hidden objects that have the Visible property
disabled will also become visible on the screen.

Default currency

Use this option to change the default currency of the current document.

Note: This option should be set to System default by default. This will ensure that PlanMaker uses the
default currency from your system's country settings.

If you select a different currency, this will have the following effect:

Whenever PlanMaker automatically applies the Currency number format to a cell (for example, because it uses
an arithmetic function that returns a monetary value), the currency set here will be used instead of the system's
default currency.

Compatibility button

Here, you can make internal settings for compatibility with documents created in older versions of PlanMaker
or in Microsoft Excel. These options are set automatically when the document is opened and should not
normally be changed.

Document properties, Calculate tab

On the Calculate tab in the dialog box of the ribbon command File | Properties , you can change settings
for the calculations in the current document:

"Recalculation" section

Here, you can determine whether the calculations in the current worksheet should be updated automatically
when you make changes to the worksheet contents:



481Customizing PlanMaker

§ Recalc automatically 

If this option is enabled, all calculations are updated automatically when the content of a cell is changed.

This is the default setting. It ensures that all calculations always provide up-to-date results.

§ Recalc only before ... 

If this option is enabled, calculations will be automatically updated only when saving or printing the
document, or when copying (or cutting) cells. If all three options are disabled, calculations will no longer be
updated automatically.

However, you can have the calculations updated manually at any time: To do so, choose the ribbon
command Formula | group Update| Recalculate or press the F9 key.

For more information, see also Updating sheets.

"External references" section

Here, you can make settings for external cell references. These are references that refer to cells in other
workbooks. For more information, see External cell references.

Available options:

§ Update data on opening 

Here, you can specify whether all external cell references in a document should be updated (once) when the
document is opened:

Always: When the document is opened, update its external references automatically.

Never: When the document is opened, do not update its external references.

Ask user: When the document is opened, ask the user if external references should be updated.

§ Save external data in document 

If this option is enabled, PlanMaker saves a copy of all values returned by external cell references in the
document. If the file for an external reference is missing when the external reference is updated, the value
last stored will still be displayed.

If you disable this option, an error value will be displayed instead if you update an external reference and the
associated file cannot be accessed.

"Rounding" section

Enabling these options increases the accuracy of calculations. Since computers use a different numeral system
than humans, some calculations may lead to very small rounding errors in very rare cases. This issue is not
PlanMaker-specific but affects practically all computer applications.

However, PlanMaker has two options for eliminating these rounding errors as much as possible:

§ If the option Round final result is enabled, PlanMaker automatically rounds the final result of each
calculation to 15 decimal places. 

§ If Round intermediate results is enabled, PlanMaker also rounds any intermediate result within a
calculation to 15 places.
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The first option already significantly reduces the probability of obtaining a rounding error, while the
second option makes this even less likely. The disadvantage of both options, however, is that the
recalculation of worksheets takes a little longer.

A classic example of this rounding problem:

If both options are disabled, the formula (0.1+0.2-0.3)=0 returns FALSE, although TRUE would be the
correct result. If both options are enabled, the calculation returns the correct result.

§ A third option is Precision as displayed: If you enable this option, all numbers are applied exactly as they
are displayed after rounding to decimal places. This means that the values that are entered are truncated to
the decimal places set in the cell options for the number format. 

An example for illustrative purposes:

You have the sum of 2.3 + 2.4. The exact result is 4.7. However, you choose not to display the decimal
places after the decimal point. You thus set the decimal places in the cell options to 0. The table now
shows 2 + 2.

Without enabling the option Precision as displayed: You obtain the result 5 (because the values 2.3 + 2.4
still exist in the background and are rounded to 5). You can also continue to calculate with the exact
result 4.7.

By enabling the option Precision as displayed: You obtain the result 4 (because only the values 2 + 2
exist, exactly as they are displayed in the cell). However, the exact result 4.7 has been lost for further
calculation.

Note on the option Precision as displayed: If decimal numbers are longer than the decimal places that you
set for the number format in the cell options, the original, more accurate values are permanently lost. You
should thus be sure that you want to use this option in your calculation.

"Charts" section

Like calculations, charts are automatically updated by default when the content of any cell is changed.

If you don't want this, disable the option Update automatically in the Charts section.

Charts must then be updated manually if necessary. To do so, choose the ribbon command Formula | group
Update | Update data | Update charts.

"Iterations" section

This option only affects cells that contain a circular reference. If, for example, cell A1 contains the formula
=A1+A2, this is called a circular reference because the calculation in cell A1 refers to cell A1 itself.

If the option Use iterations is enabled, such calculations are repeated each time the worksheet is recalculated
until either the number of Maximum iterations is reached or the result of the calculation differs from the
previous result by less than the Maximum change.

Normally, tables should not contain circular references, thus this option is disabled by default.

Note: Unless you actually use circular references in calculations on purpose (for example, to determine
values using an iteration method), this option should not be enabled, since it significantly increases the time
required to recalculate the worksheet.
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Document properties, Protection tab

On the Protection tab in the dialog box of the ribbon command File | Properties , you can provide
document protection to the current document.

You can ensure that opening or saving a protected document is only possible after entering the correct
password. Documents with read protection are also encrypted, so that they cannot be viewed with programs
other than PlanMaker.

For information on this topic, see Document protection.

Document properties, Fonts tab

A list of all fonts used in the current document is displayed on the Fonts tab in the dialog box of the ribbon

command File | Properties .

The list is divided into fonts that are available on the current device and fonts that are not available (i.e., not
installed).
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Changing worksheet properties
You can use the ribbon command Insert | group Tables | Sheet  | Properties  to define settings that will
only affect the current worksheet.

If a document consists of several worksheets, you can change these settings separately for each sheet. To do so,
switch to the desired worksheet and then choose the above command.

Tip: You will also find the command in the context menu by right-clicking on the worksheet register.

The program displays a dialog box with the following options:

§ Row header 

If this option is enabled, row headers (buttons labeled 1, 2, 3, etc., to the left of the table) are displayed in
the worksheet.

§ Column header 

If this option is enabled, column headers (buttons labeled A, B, C, etc., above the table) are displayed in the
worksheet.

Tip: You can also use the ribbon command View | Row and column headers  to enable/disable the row
and column headers together.

§ Page breaks 

This option determines whether dark gray lines indicating the location of page breaks for the printout are
displayed in the worksheet. (For more information, also see Adjusting page breaks manually.)

Tip: This option can also be found directly on the ribbon tab View as Show page breaks.

§ Show zero values 

A cell contains a zero value when it contains either the number 0 (zero) or a calculation that returns zero.

If this option is enabled, the number "0" will be displayed in such cells as usual. If you disable it, nothing
will be displayed there.

Tip: This option can also be found directly on the ribbon tab View as Show zero values.

§ Gridlines 

This option determines whether gridlines are displayed between cells on-screen. You can also change the
color of these lines as desired.

Tip: This option can also be found directly on the ribbon tab View as Show sheet grid.

Gridlines do not appear in printouts by default. To include gridlines in a printout, choose the ribbon
command File | group Print | Page setup, switch to the Options tab and enable the option Grid.

§ Sheet tab 

The worksheet register at the bottom of the document window displays tabs for each worksheet in the
current document.

With this option, you can change the color of the tab for the current worksheet.
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§ Background 

If you enable the option Alternating shade, alternating shading is applied to the rows of the worksheet: Odd
lines are shaded as specified with the Shading 1 button, while even lines are shaded as specified with the
Shading 2 button.

§ Sheet direction 

For worksheets in Arabic script, you can change the direction of the worksheet to right-to-left here.

Doing this will reverse the horizontal direction of the worksheet – thus cell A1 will now be in the top right
corner rather than in the top left corner.

For more information, see also Working with Arabic text.
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Customizing the document display
In this section, you will learn how to customize the appearance of the worksheet on the screen. The required
commands can be found on the ribbon tab View.

This section covers the following topics:

§ Zoom level 

The ribbon commands View | Actual size and View | Set zoom in the command group Zoom allow you to
set the zoom level of the worksheet.

§ Full screen view (not included in SoftMaker FreeOffice) 

The ribbon command View | Full screen in the command group Windows maximizes the program window
and hides most parts of the user interface so that as much of the document as possible can be seen.

§ Dark document (only available in SoftMaker NX Home and NX Universal) 

Choose the command Dark document in the Quick access toolbar for a dark display of the document.

For more information, see the following pages.

Zoom level

With the commands of the ribbon tab View in the group Zoom, you can select the zoom level for the current
document, among other things.

The command group "Zoom" on the ribbon tab View

§ The command Actual size always sets the document to a zoom level of 100%. 

§ The command Fit to selection automatically selects the zoom level at which the currently selected cells fit
exactly into the main window.

§ For an exact selection of the desired zoom, choose the command Set zoom. The program displays a dialog
box with the following options:

Zoom level Explanation

Fit to selection This option automatically selects the appropriate zoom level, see above.
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Previous zoom level This option restores the previous zoom level.

50%, 75%, etc. This option sets the zoom level to the desired level.

Alternatively, you can enter any zoom level in the input field above the list (50% to 400%).

Using the zoom slider

You can also use the zoom slider in the bottom right corner of the screen to change the zoom level:

To change the zoom level, either drag the slider with your mouse or click on the plus or minus icon.

If you click on the percentage to the right of the zoom slider, you open the dialog box of the aforementioned
command View | group Zoom | Set zoom.

Tip: Also note the key combination Ctrl+middle mouse wheel for continuous zooming.

Full screen view

FreeOffice: The full screen view is not included in SoftMaker FreeOffice.

With the ribbon command View | group Windows | Full screen , you can switch to the full screen view in
which the program uses the entire screen to display the document. PlanMaker enlarges its program window to
the full screen size. (In the classic menu interface, all other toolbars are then hidden.)

To exit this view mode, press the Esc key or choose the ribbon command View | Full screen again.

Using the toolbar of the full screen view

When you enable full screen mode, an additional mini toolbar appears on the screen.

The mini toolbar "Full screen mode"

The icons in this toolbar have the following functions (from left to right):

§ Show/hide ribbon 

§ Show/hide pivot table sidebar

§ Enable/disable "Drag sheet" mode

If you enable "Drag sheet" mode, you can scroll through your document using the mouse. Simply click into
the document and drag the mouse cursor in the desired direction (with the mouse button still held down).

Note: Clicking on cells and selecting text or objects is no longer possible in this mode.

To exit "Drag sheet" mode, click on this icon again.
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§ Clicking on the Close button exits full screen mode. 
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Dark document mode

This feature is only available in SoftMaker Office NX Home and NX Universal.

You can use the ribbon command Dark document  in the Quick access toolbar to switch the worksheets
from their usual white to a dark display.

Note: If this button is not available, click on the  icon on the far right of the Quick access toolbar. Select
Add/remove buttons and enable Dark document.

If you click on this command once, the worksheets will be displayed in dark mode. If you click on this
command again, the worksheets will be displayed in white again.

Switching this display has no effect on the printout of the document.
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Customizing the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section you will learn how to configure the ribbon and add additional icons.

The "Ribbon" and the Quick access toolbar (below)

The information covers the following topics:

§ Showing and hiding the ribbon 

§ Customizing icons and groups in the ribbon

§ Changing the position of the Quick access toolbar

§ Customizing icons on the Quick access toolbar

For more information, see the following pages.
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Showing and hiding the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The ribbon is usually fully visible:

The "Ribbon" and the Quick access toolbar (below)

However, you can hide the ribbon at any time by minimizing it. This is useful if you want to have as much
screen space as possible to display the document.

Proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Also possible: Right-click anywhere on the ribbon.

2. A menu opens. There, you will find the option Minimized ribbon, which can be enabled or disabled by
clicking on it (a check mark appears in front of the option if it is currently enabled).

After you enable this option, the ribbon will be minimized. Only the ribbon tabs and the quick access toolbar
can then be seen.

Tip: Alternatively, you can use the icon  in the upper right corner of the program window next to the ?
icon to minimize the ribbon. If you click on the icon again, the ribbon is restored to its full size.

In addition, you can use the key combination Ctrl+F1 (Mac: Cmd+F1) to enable/disable minimization of the
ribbon.

Working with a minimized ribbon

You work with a minimized ribbon as follows:

§ When you click on one of the ribbon tabs of the minimized ribbon, the ribbon becomes completely visible
again temporarily and displays the corresponding ribbon tab. As soon as you trigger a command (for
example, click on the icon for a command), however, the ribbon will be automatically minimized again. 

§ If you double-click on one of the ribbon tabs, the ribbon will be permanently visible again, thus removing
the minimization. 
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§ As mentioned above as a tip, you can also use the icon  in the upper right corner of the program window
to enable/disable the minimization of the ribbon.

Customizing icons and groups in the ribbon

FreeOffice: These Customize options are not included in SoftMaker FreeOffice.

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The command Customize ribbon  allows you to customize the ribbon to a certain extent. The main purpose
of this command is to add additional icons, command groups or even complete ribbon tabs to the ribbon.

Important: The icons in the predefined command groups on the ribbon cannot be changed. This means that
you cannot add, remove, or change the order of icons in the existing command groups. Additional icons can
only be inserted in new command groups at the end of a ribbon tab (or optionally in a completely new ribbon
tab).

To customize the ribbon, proceed as follows:

1. Choose the command Customize ribbon under File | group Settings | Customize  to open the dialog box.
Alternatively: Right-click anywhere on the ribbon with the mouse button.

Tip: The dialog box can be opened even faster by double-clicking on any empty area of the ribbon.

2. Use one of the procedures described below to edit the ribbon tabs.

Basic structure of the dialog box

The dialog box of the command Customize ribbon contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected ribbon tab 

The right list displays the icons contained in the currently selected ribbon tab.

You define the ribbon tab to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:
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Adding an icon

Note: You can only add icons to command groups that you have added yourself (or to completely new ribbon
tabs). You cannot insert an icon into the predefined groups.

To add an icon to a specific ribbon tab, perform the following steps in the dialog box of the command File |
group Settings | Customize | Customize ribbon:

1. In the dropdown list Customize (top right), select the ribbon tab to which you want to add an icon.

The right list now displays all icons that are currently on the selected ribbon tab.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the ribbon tab. If you have not yet created a new group here, the program
automatically creates a new command group for the icon at the end of the ribbon tab.

Removing an icon

Note: You can only remove icons that you added to the ribbon yourself. You cannot delete any of the
predefined icons.

To remove one of the icons you added from a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be removed.

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the ribbon tab.

Moving an icon

Note: You can only move icons that you added to the ribbon yourself. You cannot change the position of any
of the predefined icons.

To move an icon in a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the ribbon tab.

Note: If you want to move an icon to a different ribbon tab, you must first remove it from its current ribbon
tab and then add it to the other ribbon tab.
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Adding a new command group

Note: New command groups can only be added after the default command groups. You cannot insert a user-
defined group between the predefined command groups.

To add a new command group (a new section) to a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Click on the New group button (displayed below the right list).

The new command group is now created (at the end of the ribbon tab).

Renaming a command group

Note: Only user-defined command groups can be renamed. You cannot rename any of the predefined
command groups.

To rename a user-defined command group in a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the Rename button (displayed below the right list).

4. Type in the new name and confirm it.

The command group will now be renamed accordingly.

Removing a command group

Note: Only user-defined command groups can be removed. You cannot delete any of the predefined
command groups.

To remove a user-defined command group from a ribbon tab, follow these steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the button . (Any icons must have been removed from the group.)

Even faster: Simply double-click on the command group in the right list.

The command group is now removed from the ribbon tab.

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.
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Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

"Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the ribbon tabs (right side)

Above and below the list on the right side of the dialog box, there are buttons for managing the ribbon tabs.
Some of these buttons have already been mentioned in this section. To ensure that users understand them better,
all buttons and their functions are clearly listed again below.

Above the list on the right:

§ New 

This button creates a new, empty ribbon tab. You can then customize this ribbon tab by adding icons and
command groups.

§ Rename

Use this button to rename the ribbon tab selected in the dropdown list Customize (only available for user-
defined ribbon tabs).

§ Reset

This button resets the ribbon tab selected in the dropdown list Customize back to its delivery state.

§ Delete

This button deletes the ribbon tab selected in the dropdown list Customize (only available for user-defined
ribbon tabs).

Below the list on the right:

§ New group 

This button adds a new command group to the ribbon tab selected in the dropdown list Customize.

§ Rename

Use this button to rename a command group (only available for user-defined command groups). First, select
the desired command group in the list on the right of the dialog box.

§ Reset all

This button resets all ribbon tabs back to their delivery state.

The Close button closes the dialog box and all changes are applied.
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Changing the position of the Quick access toolbar

FreeOffice: Customizing the Quick access toolbar is not included in SoftMaker FreeOffice.

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

The Quick access toolbar can either share the space with the document tabs – or it is located in its own toolbar.
To change this, proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Alternatively, right-click anywhere on the ribbon.

2. The program opens a menu that contains one of the following two commands:

Show Quick access toolbar as separate toolbar: By default, the Quick access toolbar is displayed in the
toolbar that also contains the document tabs. When you choose this command, the Quick access toolbar
moves to its own toolbar instead.

Show Quick access toolbar beside the document tabs: This command does exactly the opposite: If the
Quick access toolbar is currently displayed as a separate toolbar, choosing this command will cause the
Quick access toolbar to be moved back to the toolbar that also contains the document tabs.

Tip: You can also click on the double arrow button  directly in the Quick access toolbar itself. There, you
can use the entry Position to find the corresponding options for displaying the Quick access toolbar: Beside the
document tabs or Below the ribbon.

Customizing icons on the Quick access toolbar

FreeOffice: Customizing the Quick access toolbar is not included in SoftMaker FreeOffice.
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"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

If desired, you can customize the icons on the Quick access toolbar at any time, for example, you can add,
remove and reposition icons.

To do so, choose File | group Settings | Customize  | Customize Quick access toolbar (or click on the icon
 in the Quick access toolbar and select Customize there). In the following dialog box, you can edit the Quick

access toolbar according to the descriptions in Customizing toolbar icons – except for the passage "Managing
toolbars".

Tip: Alternatively, you can simply drag a command from the dialog box into the Quick access toolbar with
the mouse. Even quicker (without opening the dialog box): Hold down the Alt key and drag a command icon
directly from the ribbon to the Quick access toolbar. To remove it, drag the icon back into the ribbon while
holding down the Alt key.
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Customizing toolbars

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Tip: You can switch the user interface between Ribbon and Classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the
menu command View > Toolbars and how to customize them with Tools > Customize.

A toolbar (here: the Standard toolbar)

The following topics are covered:

§ Showing and hiding toolbars 

§ Positioning toolbars on the screen

§ Managing toolbars (creating, deleting, renaming, resetting toolbars)

§ Customizing toolbar icons (adding, removing, moving icons)

§ Using the toolbar menu (for extra quick access to the above functions)

For more information, see the following pages.

Showing and hiding toolbars

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can enable or disable the available toolbars at any time to make them visible or to hide them.

To do so, proceed as follows:

1. Choose the menu command View > Toolbars.

Alternatively, click on the double arrow  at the end of a toolbar and select Toolbars.

2. Click on the checkbox in front of the desired toolbar to enable or disable it. When the toolbar is enabled, a
check mark appears in the box.
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3. Exit the dialog box with Close.

The corresponding toolbar has now been enabled or disabled.

Tip: There is a faster way to do this: If you right-click on any toolbar, a list of all available toolbars is
displayed. If you click on one of these menu items, the corresponding bar will be enabled or disabled.

Visible in mode...

Some toolbars are visible only in particular situations. The Picture toolbar, for example, appears only when you
select a picture.

This is due to the option Visible in mode, which determines when a toolbar should be visible. Some examples:

Option Explanation

All modes The selected toolbar is always visible (unless it has been disabled). Example: the Standard toolbar

Edit mode The bar is only visible in normal editing mode but not in object mode. For more information, see
also Object mode. Example: the Formatting toolbar

Object The bar is only visible in object mode but not in normal editing mode. For more information, see
also Object mode. Example: the Object toolbar

Chart The bar only appears if a chart is selected in the document.
Example: the Chart toolbar

Outline The bar only appears if the current worksheet contains an outline (see also Outlines). Example: the
Outline toolbar

Picture The bar only appears if a picture is selected in the document.
Example: the Picture toolbar

Table The bar only appears if you are in a cell of a newly inserted table (see also Tables in worksheets).

AutoShape The bar only appears if a drawing or text frame is selected in the document.

To change this setting for one of the toolbars, choose the menu command View > Toolbars, select the toolbar
in the list Toolbars and select the desired option for Visible in mode.

Note: Changing this setting in the default toolbars (Standard toolbar, Formatting toolbar, etc.) is usually not
recommended. This option is primarily intended for user-defined toolbars.
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Positioning toolbars on the screen

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can position each toolbar as desired on the screen. To do so, use one of the following procedures:

Changing the position with the command View > Toolbars

You can change the position of a toolbar at any time with the menu command View > Toolbars. To do so,
proceed as follows:

1. Choose the menu command View > Toolbars.

2. Select the desired toolbar by clicking on it in the list.

3. Select the desired position for the toolbar in the list Position.

Note: If you select the option Floating, the toolbar icons are displayed in a window that can be freely moved or
resized just like an application window.

Changing the position with the toolbar menu

Each toolbar has a button with a double arrow  at its right edge. Select the entry Position for the desired
toolbar. The following submenu provides a dropdown list of possible positions for the toolbar.

Note: If you have selected the option Floating, you can also use this button  to integrate the toolbar back into
a desired fixed position via the entry Position entry.

For more information on the toolbar menu options, see Using the toolbar menu.

Changing the position with the mouse

Some toolbars can also be repositioned with the mouse. To do so, proceed as follows:

1. Position the mouse cursor over an empty area of the toolbar.

2. Press the left mouse button and hold it down.

3. While still holding the mouse button down, drag the toolbar to the desired position.

4. Release the mouse button to place the toolbar in the new position.

Note: By default, most toolbars are locked to prevent unintentional movement with the mouse. However, you
can release this lock at any time: To do so, choose the menu command View > Toolbars, select the toolbar
and disable the option Locked. From now on, this bar can also be moved with the mouse.
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By the way, a positioning aid is enabled while dragging a toolbar: If you drag the toolbar near one of the edges
of the program window, it automatically jumps to the corresponding edge. If, for example, you release the bar at
the top edge, this corresponds to selecting the Top position in the dialog box of the menu command View >
Toolbars.

Managing toolbars

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can create new toolbars at any time and delete or rename existing toolbars, etc. To do so, use the buttons in
the dialog box of the menu command View > Toolbars.

Creating new toolbars

The program lets you create your own toolbars at any time.

If, for example, you frequently need to use commands of the Window menu that are not present in the Standard
toolbar, it might be worth your while to create your own toolbar for them.

You create a new toolbar as follows:

1. Click on the New button (in the dialog box of the menu command View > Toolbars).

2. The program displays a dialog box in which you enter a name for the new toolbar – for example, "My
toolbar". Then confirm with OK.

3. The new toolbar has been created. Close the dialog box or click on the Customize button to add icons to the
toolbar. For more information, see Customizing toolbar icons.

Customizing toolbar icons

You can edit the icons on toolbars with the Customize button. For more information, see the next section.

Deleting toolbars

The Delete button allows you to delete a user-defined toolbar as follows:

1. Select the toolbar to be deleted from the list.

2. Click on the Delete button.

Note: You can only delete user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be removed.

However, you can disable a default toolbar at any time if you don't need it by removing the check mark in front
of it. For more information, see Showing and hiding toolbars.
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Renaming toolbars

The Rename button can be used to rename a user-defined toolbar as follows:

1. Select the desired toolbar from the list.

2. Click on the Rename button.

3. Type in the new name and confirm it with OK.

Note: You can only rename user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be renamed.

Resetting toolbars

You can undo any changes you have made to one of the default toolbars by clicking on the Reset button:

1. Select the desired toolbar from the list.

2. Click on the Reset button.

The toolbar now contains the default icons again. In addition, the default settings for the options Visible in
mode and Position are restored.

Note: This command only applies to the default toolbars (Standard toolbar, Formatting toolbar, etc.) but not to
user-defined toolbars.

Resetting all toolbars

To reset all toolbars at once, click on the Reset all button.

Note: This command only resets the default toolbars. User-defined toolbars remain unchanged.

Customizing toolbar icons

FreeOffice: These Customize options are not included in SoftMaker FreeOffice.

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

The menu command Tools > Customize allows you to customize the icons as desired on a toolbar. You can add
icons and remove or reposition existing icons, among other things.

Proceed as follows:

1. Choose the menu command Tools > Customize to open the dialog box. Alternatively: Click on the button

 at the end of a toolbar and select the entry Customize here.
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Even faster: Double-click on an empty area in any toolbar.

2. Use one of the procedures described below to add, remove or reposition icons.

Basic structure of the dialog box

The dialog box of the menu command Tools > Customize contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected toolbar 

The right list displays the icons contained in the currently selected toolbar.

You define the toolbar to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:

Adding an icon

To add an icon to a specific toolbar, perform the following steps in the dialog box of the command Tools >
Customize:

1. In the dropdown list Customize (top right), select the toolbar to which you want to add an icon.

The right list now displays all icons that are currently in the selected toolbar.

Optional: In the right list, select the icon behind which the new icon is to be inserted.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the toolbar.

Tip: Alternatively, you can add an icon to any toolbar as follows: Choose the command Tools > Customize.
Then simply drag the icon out of the dialog box with the mouse and drop it at the desired position in the
toolbar. (Do this in the toolbar itself and not in the dialog box!) Of course, this procedure only works when
the toolbar is currently visible on the screen.

Removing an icon

To remove an icon from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize (top right).

2. In the right list below it, select the icon to be removed.



504Customizing PlanMaker

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the toolbar.

Tip: Alternatively, you can remove an icon from a toolbar as follows: Choose the command Tools >
Customize. Then simply drag the icon out of the toolbar with your mouse and drop it somewhere outside the
toolbar, for example, in the document. (Do this in the toolbar itself and not in the dialog box!)

Moving an icon

To move a toolbar icon to a different position, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the toolbar.

Note: If you want to move an icon to a different toolbar, you must first remove it from its current toolbar and
then add it to the other toolbar.

Tip 1: Alternatively, you can also move an icon as follows: Choose the command Tools > Customize. Then
drag the icon directly in the toolbar to the desired position (in the toolbar itself and not in the dialog box!).
This method also allows you to move an icon directly from one toolbar to another.

Tip 2: Moving icons works even if this dialog box is not open: When you hold down the Alt key, you can
move a toolbar icon by clicking on it and then dragging it to the desired position (while still holding down
the mouse button).

Inserting a separator

To insert a separator in front of an icon in a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list, select the icon in front of which the separator is to be inserted.

3. Click on the New separator button (displayed below the right list).

The separator is now inserted.

Tip: Alternatively, you can proceed as follows: Choose the command Tools > Customize. To insert a
separator to the left of an icon in any toolbar, simply drag the icon slightly to the right (in the toolbar itself
and not in the dialog box!).

Removing a separator

To remove a separator from a toolbar, perform the following steps in the dialog box:
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1. Select the desired toolbar in the dropdown list Customize.

2. In the right list below it, select the separator to be removed.

3. Click on the button .

Even faster: Simply double-click on the separator.

The separator is now removed from the toolbar.

Tip: Alternatively, you can also use the following procedure: Choose the command Tools > Customize. If
you now drag the icon that is to the immediate right of the separator a little bit to the left, the separator will
be removed. (Do this in the toolbar itself and not in the dialog box!)

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.

Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

"Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the toolbars

The dialog box of the command Tools > Customize also has buttons for managing toolbars:

§ New 

This button creates a new, empty toolbar.

§ Rename 

Use this button to rename the toolbar selected in the dropdown list Customize (only available for user-
defined toolbars).

§ Reset 

This button resets the toolbar selected in the dropdown list Customize back to its delivery state.

§ Delete 

This button deletes the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset all (displayed below the right list) 

This button resets all default toolbars back to their delivery state.
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Further options for managing and configuring toolbars are available in the dialog box of the menu command
View > Toolbars. For more information, see Managing toolbars.

Using the toolbar menu

Only for "Classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Some toolbars end on the right with a double arrow , as shown in the following figure:

If you click on this double arrow, the toolbar menu will open for this toolbar.

This menu gives you quick access to all toolbar-related commands described in the previous sections. The
toolbar menu contains the following commands:

§ Add/remove buttons 

This command displays a list of all icons available for a toolbar. If you click on one of the entries, the
corresponding icon in the bar will immediately be enabled or disabled.

(Note: This command is only meant for quickly enabling or disabling icons. For information on customizing
the icons in a toolbar, see Customizing toolbar icons.)

§ Position 

You can use this command to change the position of a toolbar. The available options include top, bottom,
left, right or floating (in a little window that can be moved and resized with the mouse).

§ Toolbars 

This option chooses the menu command View > Toolbars that allows you to enable or disable, configure
and manage toolbars.

For more information, see Customizing toolbars.

§ Customize 

This option chooses the menu command Tools > Customize that allows you to edit the icons on a toolbar
(add, remove, reposition icons).

For more information, see Customizing toolbar icons.

§ Reset this toolbar 

This option resets the toolbar. The bar then displays its default icons again. In addition, all settings made for
the bar are discarded.
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Creating user-defined icons

FreeOffice: These Customize options are not included in SoftMaker FreeOffice.

You can create user-defined icons at any time and then add them to the ribbon or a toolbar. Such icons can be
used to start other desired programs.

To create a user-defined icon – for example, an icon to start the Windows Editor – proceed as follows:

1. Choose the following command in the ribbon or menu:

Ribbon: File | group Settings | Customize  | Customize ribbon

Menu: Tools > Customize

2. In the dropdown list Categories, select the User category.

3. Select one of the icons from the list Commands.

The first three icons are pre-assigned (as examples) to the Windows Calculator, the Windows Character
Map and the Windows Control Panel. Select the fourth icon, for example.

4. Click on the Edit button displayed below the list. Another dialog box appears.

5. Enter a short description of the program to be started in the Description field – for example, "Notepad".

6. Enter the complete path and file name for the program to be started in the Command line field, for example,
C:\Windows\notepad.exe.

7. Optional: If you want the program to display an icon other than its default icon, enter the path and file name
of the desired icon file in the Icon file field.

Note that icons in toolbars are slightly smaller than the usual Windows icons.

As soon as you confirm with OK, the user-defined icon is created.

If you now want to add the user-defined icon to the ribbon or toolbar, proceed as described in the following
sections:

§ Ribbon: Customizing icons and groups in the ribbon 

§ Toolbars: Customizing toolbar icons 

Customizing shortcut keys

FreeOffice: Customizing shortcut keys is not included in SoftMaker FreeOffice.
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Commands that are frequently used in a program can also be chosen via shortcut keys. For example, the
command for saving the current document can be chosen very quickly by pressing the key combination Ctrl+S.

The predefined shortcut keys can be customized at any time in the dialog box of the ribbon command File |
Customize | Customize ribbon. You can assign a shortcut key to any command and change or remove existing
shortcut keys.

To do so, proceed as follows:

Adding shortcut keys

To assign a shortcut key to a command, perform the following steps:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command to which you want to assign a shortcut key.

The left list shows all commands available in the program. (You can use the option Categories to filter this
list by a specific category and perform a search using the Quick search field.)

The right list displays only the icons that are in the currently selected ribbon tab or toolbar.

4. Once you have selected the desired command, click into the Press new shortcut key field and press the
intended key combination (starting with Ctrl or Alt).

Tip: If you make a typing mistake, you can always press the Backspace keyÕ to delete the shortcut key you
entered.

5. Do not forget: Click on Add to assign this shortcut to the command now.

6. Exit the dialog box with Close.

From now on, you can execute the selected command with the specified shortcut key.

Editing shortcut keys (removing, changing, etc.)

You can also edit existing shortcut keys for commands (for example, delete or change them) at any time.
Proceed as follows:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.
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3. In the left or right list, select the command whose shortcut keys you want to edit.

4. In the Shortcut keys section, perform one of the following actions:

Remove shortcut keys: The list Current shortcut keys displays all shortcut keys currently assigned to the
selected command. To remove a shortcut key, select it from the list and click on Remove.

Change shortcut keys: To change the shortcut key for a command, first remove it (as described above) and
then assign it a new shortcut key (as described at the beginning of this section).

Reset shortcut keys: To reset all shortcut keys for the entire program to their default values, click on the
Reset all shortcut keys button and confirm the confirmation prompt. Any changes you have made to
shortcut keys will then be discarded.

Display a list of all shortcut keys: When you click on the Export button, a table listing all currently assigned
shortcut keys is displayed. The buttons next to the table allow you to copy it to the clipboard, for example.

5. Exit the dialog box with Close.

Available shortcut keys

Note that some of the key combinations that are possible on your keyboard are not allowed for shortcut keys.

As a rule, you should use alphabetic keys, numeric keys or function keys for shortcut keys. You can combine
them with Ctrl, Alt and/or the Shift keyñ.

You can easily check whether the desired key combination is allowed. Click in the Press new shortcut key
field in the dialog box described above, and then enter the key combination. If it does not appear in the field, it
is not allowed.

Some examples of valid shortcut keys include:

§ Ctrl+A 

§ Alt+A (However, key combinations with the Alt key are not recommended – Alt+A, for example, is
responsible for opening the View menu!)

§ Ctrl+Alt+A

§ Ctrl+Shift+A

§ Ctrl+Alt+Shift+A

§ Ctrl+F2

§ etc.

Note: Letters on their own are not allowed, of course. Thus, you can't use A or Shift+A as shortcut keys.

Shortcut key already assigned: If you press a shortcut key that is already assigned, the current assignment will be
shown just below the input field. You should then press the Backspace keyÕ to delete your shortcut key and
try a different shortcut key. Otherwise, you will overwrite the existing assignment of this shortcut key.

Two-part shortcut keys: You can also use two-part shortcut keys (according to the WordStar standard) – for
example, Ctrl+K+X. However, only shortcut keys according to the scheme "Ctrl + letter + letter" are allowed
here.
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Editing lists for automatic filling
As described in Filling cells automatically, you can use the command Home | Fill to fill a cell range with a
fixed value or a sequence of values.

If you choose the entry Series from the ribbon command Home | group Contents | Fill , a dialog box opens.
Here, you can use the Edit lists button to also create your own lists for the Fill function.

If, for example, you create a list with the content "Red", "Green" and "Blue", and then subsequently start a fill
operation from a cell that contains the text "Red", PlanMaker will continue the series and fill with Green, Blue,
Red, Green, Blue, etc.

Note: You can also add your own Edit lists button to a ribbon tab if required. To do so, choose the ribbon
command File | Customize | Customize ribbon to open the dialog box for customizing the user interface,
and search there for the command "Edit lists". Then proceed as described in Customizing icons and groups in
the ribbon.

You will also find the command directly via the "Hamburger menu" : Tools > Edit lists

The dialog box of the command Edit lists provides buttons with the following functions:

§ "New" button: create a new list 

§ "Edit" button: edit the list created

§ "Delete" button: delete the list created

§ "Import" button: create a list from the currently selected cells

See the following paragraphs for more information.

Creating a new AutoFill list ("New" button)

To create a new AutoFill list for the Fill function, proceed as follows:

1. Choose the command Edit lists.

2. Click on the New button in the following dialog box.

3. Another dialog box appears. Enter the desired list entries in it. Please note that each line may only contain
one entry. Press the Enter key¿ after each entry to start a new line.

4. Then click on the OK button.

The new list has now been created.

Editing an AutoFill list ("Edit" button)

To edit a list you have created for the Fill function, proceed as follows:

1. Choose the command Edit lists.
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2. In the following dialog box, select the list to be edited by clicking on it with the mouse.

Note: The predefined sample lists cannot be edited.

3. Click on the Edit button.

4. Another dialog box appears with the list entries. Edit them as desired. Please note that each line may only
contain one entry. Press the Enter key¿ after each entry to start a new line.

5. Then click on the OK button.

The list has now been changed accordingly.

Deleting an AutoFill list ("Delete" button)

To delete a list you have created for the Fill function, proceed as follows:

1. Choose the command Edit lists.

2. In the following dialog box, select the list to be deleted by clicking on it with the mouse.

Note: The predefined sample lists cannot be deleted.

3. Click on the Delete button.

The list has now been removed.

Importing an AutoFill list from cells ("Import" button)

If a PlanMaker document contains a cell range whose contents you want to save as an AutoFill list, proceed as
follows:

1. Select the desired cells.

2. Choose the command Edit lists.

3. In the following dialog box, click on the Import button.

PlanMaker reads the contents of the selected cells and creates a new AutoFill list from them. Each selected cell
becomes a list entry.

If you have selected multiple rows and columns, PlanMaker creates multiple lists accordingly. Before this, a
query appears as to whether you want to import the data row by row or column by column. Choose Row by
row if you want each row to become a list, or Column by column if you want each column to become a list.
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Installing dictionaries

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. They
are available free of charge for installation.

You can install dictionaries for the spell check and also specify which of these dictionaries should be used for a
language. For information on how to install these dictionaries, see the following sections:

§ Installing additional dictionaries 

In this section, you will learn how to add more dictionaries that are not currently installed.

Note: This is particularly important for the Android and iOS versions, since most dictionaries are already
pre-installed in SoftMaker Office for Windows, Mac and Linux.

§ Choosing a different dictionary for a language 

If you have multiple dictionaries installed for a language (for example, one from SoftMaker and one from
Hunspell), you can also specify which of these dictionaries to use. Read this section for details.

For more information on these topics, see the following pages.

Installing additional dictionaries

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

SoftMaker Office comes with premium dictionaries for numerous languages. In addition to SoftMaker
dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. These dictionaries are available
as free downloads. Most of them were created by private users or non-profit organizations.

Hunspell dictionaries are available for numerous languages. If there is no SoftMaker dictionary for a language,
you will certainly find a Hunspell dictionary for it.

In this section, you will learn how to install dictionaries that are not currently installed:

Windows, Mac and Linux

When you install SoftMaker Office for Windows, Mac or Linux, all relevant dictionaries are already
integrated automatically – so there is usually no need to subsequently install additional dictionaries.

Note, however, that you can choose between different dictionaries here (Hunspell, SoftMaker) by clicking on
Switch for the respective dictionary. For more information, see the next section Choosing a different dictionary
for a language.
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Android and iOS

The situation is different with SoftMaker Office for Android and iOS: Here, dictionaries are not automatically
integrated and must be subsequently installed for a language as needed.

Proceed as follows:

1. Launch any of the apps (TextMaker, PlanMaker or Presentations) on your Android/iOS device.

2. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

3. Click on the Manage dictionaries button.

4. The program displays the dialog box "Dictionaries" with a list of all available languages. To download a
dictionary for a language, select it from the list and press the Install button.

The dictionary is now installed and will be available from now on in any SoftMaker Office application.

Note: In addition to Hunspell dictionaries (with Hunspell added at the end), the above list also includes in-
house SoftMaker dictionaries (nothing added to the end) for many languages. If both dictionaries are
installed for a language, you can select which dictionary to use by clicking on the Switch button. For more
information, see the next section.

Ask to install dictionaries when necessary

This option in the dialog box "Dictionaries" is also particularly important for the Android and iOS versions, as
dictionaries are not pre-installed in these versions.

When enabled, the option has the following effect: If you enter text in your document in a language for which a
dictionary is not yet installed, the program will automatically ask you whether you want to install the dictionary
now.

Note: Of course, the automatic prompting by the program only occurs if the Spell check is enabled.

Choosing a different dictionary for a language

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

If you have multiple dictionaries installed for a language (for example, a SoftMaker dictionary and a Hunspell
dictionary), you can always choose which of these dictionaries to use for the language. Proceed as follows:

1. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

2. Click on the Manage dictionaries button.

The program displays the dialog box "Dictionaries" with a list of all installed languages/dictionaries.
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3. Navigate to the desired Language in this list. The dictionaries of a language can appear in the list with the
following additions:

No addition: SoftMaker Office's in-house dictionary for this language.

Hunspell: Free Hunspell dictionary for this language.

4. Now specify which of these dictionaries should be used for the desired language. Here, the icons to the left
of a dictionary have the following meaning:

Blue icon: The dictionary is already installed and switched on.

Gray icon: The dictionary is already installed and is not switched on.

No icon: The dictionary is not yet installed.

A blue icon thus indicates the currently active dictionary for the respective language. If you want to change
the active dictionary, select another dictionary for this language from the list and click on the Switch button.

(If the dictionary is not installed yet, click on the Install button beforehand.)

5. Confirm your changes by pressing OK.

From now on, the spell check will use the selected dictionary for the specified language.

Show only installed dictionaries

Enable this option if only the installed dictionaries should be displayed in the list.

Ask to install dictionaries when necessary

For more information on this option, see the descriptions in the previous section Installing additional
dictionaries.
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Formulas and functions
This chapter provides instructions on working with formulas, including comprehensive descriptions of
PlanMaker's arithmetic functions:

The chapter consists of the following sections:

§ Formula basics 

The first section provides basic information on formulas.

§ Entering formulas 

This section provides information on entering formulas in cells.

§ Relative versus absolute cell references 

This section explains the difference between relative cell references (like =A1) and absolute cell references
(like =$A$1) in formulas.

§ External cell references 

The next section is about external cell references in formulas. These are cell references that refer to cells in
other workbooks.

§ Error values 

If a formula results in an error, an error value is displayed instead of the result. This section provides
information on error values.

§ Working with arrays 

This section provides instructions on working with arrays and array formulas.

§ Working with database functions 

This section provides information on database functions such as DCount, DSum, etc.

§ Functions from A to Z 

This section contains comprehensive descriptions of PlanMaker's arithmetic functions.

Tip: A short introduction to working with formulas can also be found in The PlanMaker tour.



516Formulas and functions

Formula basics
If you want to perform a calculation in PlanMaker, first place the cell frame on the cell in which you want the
result to appear. Then type the desired calculation into this cell.

Important When you enter a formula, you must always type an equal sign = first, as PlanMaker will
consider your input as text or a numerical value otherwise.

Formulas can be composed of the following components:

§ Fixed values (for example, a number or text) 
§ Cell references (for example, A1 or D2:D3)
§ Arrays (see also Working with arrays)
§ Arithmetic operators (for example, + or -, see also Operators in formulas)
§ Arithmetic functions (for example, SUM)

The result of a calculation can represent both a final value and an intermediate result because any cell that
contains the result of one calculation can be reused in another cell.

For example, a valid formula can look as follows:

= 67 + (A3 * sum(B1:C5))

Operators in formulas

Formulas can contain any of the operators listed below.

Please note that operators follow a strict order of precedence, which defines the evaluation order of expressions
containing operators: Operators with higher precedence are evaluated before operators with lower precedence.

Parentheses can be used to override the order of precedence and force parts of a formula to be evaluated before
other parts.

For example, 1+2*2 returns 5, since multiplication has precedence over addition and is thus calculated first. If
the formula (1+2)*2 is used instead, the result will be 6, since the parentheses override the order of precedence.

Operators listed in order of precedence (highest first):

1st Space Intersection (see also INTERSECTION function)

2nd % Percentage

3rd + Positive sign (not addition!)

– Negative sign (negation)* (not subtraction!)

4th ^ Exponentiation*

5th x Multiplication
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/ Division

6th + Addition

– Subtraction

7th & Concatenation (For example, "Plan" & "Maker" returns "PlanMaker")

8th = Is equal to

<> Is not equal to

< Is less than

> Is greater than

<= Is less than or equal to

>= Is greater than or equal to

Note: To ensure compatibility with Microsoft Excel, the order of precedence for the exponentiation operator (^) and the negation operator (-) is
reversed but mathematically incorrect. For example, the correct mathematical order (first exponentiation, then sign) for the formula -2^2 would lead to
the mathematically correct result -4. However, the actual result in PlanMaker (and in Excel) is 4.

Entering formulas
There are several ways to enter a calculation formula in a cell. These can be combined as desired.

Tip: A short introduction to entering formulas is also provided in The PlanMaker tour.

Entering formulas manually

You can easily enter formulas manually in the desired worksheet cell.

Important: When you enter formulas directly in a worksheet cell, you must always type the equal sign (=)
first, so PlanMaker knows that this will be followed by a formula and not text.

When you have entered the formula, press the Enter key¿ to confirm your entry – or Esc to cancel it.

Alternatively, you can enter data via the following buttons of the Edit toolbar:

§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To edit a formula later, navigate to the cell containing the formula and press the F2 key. Alternatively, double-
click on the cell.
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Using the mouse to enter formulas

When entering a formula, you can use the mouse to paste cell ranges or single cells into the formula. Simply
drag a rectangle in the worksheet or click on the desired cell.

An example:

You want to enter the formula =SUM(B2:D4) in a cell. You can do so as follows:

1. Enter =SUM(

2. Select cells B2 to D4 with the mouse. To do so, hold down the left mouse button and drag a rectangle that
starts in cell B2 and ends in cell D4.

3. When you release the mouse button, the cell address is automatically pasted into the formula. The formula
now displays: =SUM(B2:D4

4. Enter the closing parenthesis ) and press the Enter key¿ to complete the formula.

The cell will now contain the formula =SUM(B2:D4).

The command Formula | Function

If you want to use arithmetic functions in formulas, you can simply enter them.

Alternatively, you can choose the ribbon command Formula | Function . This allows you to conveniently
select formulas with the mouse.

The dialog box for this command has the following components:
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§ Formula field 

Here, you can edit the formula that is entered in the cell.

§ Category 

In this list, you can select the types of calculation functions to be displayed in the Function list.

In the Named ranges category at the end of the list, you can access your existing named cell ranges to insert
them into formulas. For more information, see Using named ranges.

§ Function 

This list displays all functions of the selected category. To copy a function to the Formula input field,
double-click on it.

Tip: If you select a function, a short description of it is automatically displayed in the lower part of the
dialog box. You can also open a help page for each function by clicking on it and then pressing the F1
key.

§ Operator 

The most important arithmetic operators are displayed here. If you click on an operator, it will be inserted
into the Formula input field.

§ Insert button 

Click on this button to insert the contents of the Formula input field into the current cell and close the
dialog box.

§ Close button 

This button closes the dialog box without inserting the formula.

Relative versus absolute cell references
Cell references in calculations can be entered either as relative cell references (like =A1) or as absolute cell
references (like =$A$1).

This section explains the difference between relative and absolute cell addressing:

Relative cell references

When you type the address of another cell in a formula, PlanMaker always interprets that cell reference as a
relative cell reference.

An example: You enter the following formula in cell B3:

=B1+B2

PlanMaker does not interpret this as "Add B1 and B2", but rather as "Add the values in the two cells that are
directly above cell B3".
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You will notice this when you copy or move cell B3 to C3. PlanMaker then adapts the formula immediately:

=C1+C2

Absolute cell references

If you want to prevent the formula from being adapted automatically, you must type the cell reference as
absolute by placing a dollar sign ($) in front of the column number and/or row number. You have the option of
classifying complete cell addresses as absolute (for example, $B$1) or just one component of it (for example,
$B1 or B$1).

An absolute cell reference always refers to the original cell address, regardless of where you subsequently move
the cell with the formula.

For example: =$B$1 + $B$2

If you enter this formula in cell B3 and move this cell to C3, PlanMaker will still refer to cells B1 and B2.

Tip: Using the F4 key to change cell addressing

When you enter a cell reference in a formula, you can then use the F4 key to switch between relative and
absolute addressing.

If, for example, you have typed =A4 in a cell,

=$A$4 will be displayed if you press F4 once,

=$A4 will be displayed if you press F4 again,

=A$4 will be displayed if you press F4 again.

If you press F4 once again, the old entry =A4 will be displayed again.

External cell references
In calculations, you can also use cell references that refer to cells located in different PlanMaker or Excel
documents. Such references are called external cell references.

In this section, you will learn everything you need to know about them. The following topics are covered:

§ Entering external cell references 

§ Updating and managing external cell references

For more information, see the following pages.
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Entering external cell references

Cell references that refer to cells in a different document have to be entered in calculations as follows:

='C:\My Folder\[My Workbook.pmdx]Sheet1'!A1

This example returns a reference to cell A1 in the worksheet "Sheet1" in the PlanMaker document "My
Workbook.pmdx" in the folder "C:\My Folder".

As you can see, external cell references always consist of the following components:

§ Quotation mark 

External cell references should always start with a quotation mark. You can use either single quotation
marks (') or double quotation marks (").

§ Folder 

Next, enter the entire path to the folder where the external file is located. For example: C:\My folder\

Tip: If the external file is in the same folder as your document, you can omit the path.

§ File name in square brackets 

You then have the file name enclosed within square brackets. Only PlanMaker and Excel files are allowed.

§ Sheet name 

The next component is the name of the worksheet in which the desired cell is located.

§ Quotation mark 

You then have to enter another quotation mark.

§ Exclamation mark 

Next, you type an exclamation mark.

§ Cell reference 

The last component is the address of the cell(s) to which you want to refer. Of course, cell ranges are also
permitted.

To complete your input, press the Enter key¿. PlanMaker will then read the content of the cell from the
specified file.

For information on updating and managing external cell references, see the next section.

Notes

§ If PlanMaker is unable to find the specified file, it will display a dialog box in which you can select the file
after you press the Enter key. 
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Tip: If you don't want to type in the entire path and file name manually, you can use the following trick:
In the cell reference, simply enter [x.pmdx] as the path and file name – for example, =[x.pmdx]
Sheet1!A1. Thus, you can intentionally trigger the appearance of the file dialog box after pressing Enter
and conveniently select the file from the dialog box.

§ If PlanMaker is unable to find the specified worksheet, it will display a dialog box in which you can select
the worksheet after you press the Enter key. 

§ The path to the external file is usually saved absolutely. If the external document is in the same folder as
your workbook (or a subfolder of it), however, PlanMaker stores only the relative path. 

In practice, this means that if your document and the external file are located in the same folder, references
to this external file will stay intact even if you move both files to a different folder.

Tip: Quickly insert a reference via "Paste special"

If you want to avail of an alternative way to create external references without having to type in anything
manually, proceed as follows:

1. Open the document that contains the cell to which you want to refer.

2. Copy this cell to the clipboard.

3. Switch back to the current document.

4. Navigate to the cell where you want the reference to be inserted.

5. Click on the arrow of the Paste icon  (on the ribbon tab Home |  group Edit) and choose the command
Paste special from the dropdown menu.

Alternatively: Right-click to open the context menu and select Paste special or simply use Ctrl+Alt+V.

6. In the following dialog box, click on the Paste reference button.

PlanMaker now creates an external reference to this cell.

Updating and managing external cell references

Choose the ribbon command Data | group Edit | External references  to update and manage the external
references in a document.

The command opens a dialog box that lists all the files to which there are external references.

The buttons in this dialog box enable you to perform the following actions:

§ Update 

This option updates only those external cell references that refer to the file currently selected in the list. For
more information, see "Notes on updating external cell references" below.
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§ Update all 

This option updates all external references in the entire document.

Tip: Alternatively, you can trigger Update all via the ribbon command Formula | group Update |
Update data | Update external references.

§ Open 

This option opens the external file currently selected in the list.

§ Change 

This option lets you choose a different file for the external file currently selected in the list. All references to
this file will then be adapted accordingly in your document.

§ Previous 

This option jumps to the previous cell that contains a reference to the file selected in the list.

§ Next 

This option jumps to the next cell that contains a reference to the file selected in the list.

Click on the Close button to exit the dialog box.

Notes on updating external cell references

Important: The values returned by external cell references are not updated automatically each time the
worksheet is recalculated.

External cell references are updated only in the following cases:

§ When you open a document, all external cell references it contains are updated automatically (once). 

You can disable this automatic update – see the options described below.

§ You can then manually update the external references at any time: 

To do so, choose the ribbon command Data | group Edit | External references  and use the Update or
Update all button in the dialog box as described above.

Alternatively: Use the ribbon command Formula | group Update | Update data | Update external
references, which does the same as the Update all button.

Options for updating external cell references

For updating external cell references, the document properties offer the following options.

To change these options, choose the ribbon command File | group File management | Properties  and
switch to the Calculate tab.

In the section External references, you will find the following options:
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§ Update data on opening 

Here, you can specify whether all external cell references in a document should be updated (once) when the
document is opened:

Always: When the document is opened, update its external references automatically.

Never: When the document is opened, do not update its external references.

Ask user: When the document is opened, ask the user if external references should be updated.

§ Save external data in document 

If this option is enabled, PlanMaker saves a copy of all values returned by external cell references in the
document. If the file for an external reference is missing when the external reference is updated, the value
last saved will still be displayed.

If you disable this option, an error value will be displayed instead if you update an external reference and the
associated file cannot be accessed.

Note: The above options are document properties rather than global settings. This means that you can set
them individually for each document.

Error values
If an error occurs in a calculation, it returns an error value as the result.

An example: A division is to be performed in a cell by the content of another cell. This other cell now takes a
value of 0. PlanMaker cannot perform this division by zero, which is not allowed in mathematics. The error
value #DIV/0! will now be displayed in the cell, which indicates that a division by zero is being performed.

The following error values exist:

Error value Explanation

#REF! Invalid cell reference. This is displayed when the formula contains a cell reference that is invalid or
nonexistent after deleting cells (e.g., with the ribbon command Home | group Cells | Delete).

#DIV/0! Division by zero. This is displayed when a formula contains a division by zero (which is never
permitted in mathematics).

#NULL! Invalid formula. This is displayed for misspelled or unknown function names, among other things, if
open parentheses are not closed, or if a function is called with too many or too few arguments.

#NAME? Reference with an invalid name. This displayed when a cell reference refers to a sheet name or range
name that does not exist.

#N/A "Not available". This is displayed when a cell contains a #N/A error value or a reference to a cell with
a #N/A error value. For more information, see NA (error value #N/A).
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#VALUE! Invalid value. This is displayed when a function is used with an inappropriate parameter type (for
example, if a number is passed to a function that is expecting a text string).

#NUM! Invalid number. This is displayed when a function is used with a value that is outside the range of
values permitted for the function (for example, SQRT(-2)).

Tip: To test if a cell returns an error value, use the functions ISERROR and ISERR.

Tip: You can also use the formula auditing from the command group Traces on the ribbon tab Formula to
find and analyze cells that contain an error value. For more information, see Analyzing sheets. (This feature
is not included in SoftMaker FreeOffice.)
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Working with arrays
PlanMaker lets you enter arrays (also known as matrices) in spreadsheets and perform calculations with them.
An array A is a rectangular number scheme in the following form:

The entries a11 to amn are called the elements of the array. They are divided into m rows and n columns. This is

why it is called an m x n array.

Entering arrays into corresponding cell ranges

To enter an array in PlanMaker, simply distribute the array's rows and columns over the worksheet's rows and
columns.

For example, the following array ...

... has to be entered as follows:

As you can see, each (rectangular) cell range can also be considered an array – and vice versa. Thus, for
arithmetic functions that expect an array as an argument, you can always specify a cell range that contains the
elements of the array.

Entering array formulas

PlanMaker provides array functions with which you can perform calculations with arrays – for example, find
the inverse of an array. A formula containing an array function is called an array formula.
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In contrast to "ordinary" formulas, array formulas only return an entire array of values rather than a single
value. For this reason, such array formulas have to be entered in a different manner. Let's take a look at an
example of this:

You want to determine the inverse of the 3x3 matrix shown above. To do so, proceed as follows:

1. Select a cell range for the resulting array

Before entering an array formula, you have to select the cell range where the resulting array should be
placed. The inverse of an array always has exactly as many rows and columns as the initial array. Thus, you
have to select a range of 3x3 cells – for example, cells E10:G12.

2. Enter the array formula

Now enter the desired array formula. In our example, this would be the formula =MINVERSE(E6:G8).

3. Ctrl+Shift+Enter

Important: To complete the formula, press the key combination Ctrl+Shift+¿ rather than the Enter
key¿.

The cells E10:G12 now contain the resulting array, i.e., the inverse of the array in E6:G8:

Notes:

§ If you have selected a cell range larger than the resulting array, the error value #N/A ("not available") will
be displayed in the superfluous cells. Important: If the selected cell range is too small, parts of the array will
not be displayed. 

§ To edit an existing array formula: Select all cells of the resulting array, edit the formula and press
Ctrl+Shift+¿. If you just press the Enter key¿ instead, PlanMaker will issue a warning and ask you if you
want to overwrite the array.

§ Tip: To select all cells covered by an array formula, click on one of these cells and then press Ctrl+7.

Entering arrays with constants

If desired, arrays can be entered as constants instead of cell references. For this purpose, enclose the array
within curly braces { }. Separate columns via commas and rows via semicolons.
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For the array already used as an example above...

... you could also enter the following in PlanMaker:

={1,2,3;3,-1,1;2,2,4}

Notes:

§ The notation described above is only permitted for fixed values; formulas and cell references are not
allowed. 

§ Of course, you can also enter vectors in the above notation. For a row vector such as a = (1, 2, 3), enter
{1.2.3}; for a corresponding column vector, enter {1;2;3}.

Working with database functions
PlanMaker provides database functions that allow you to query and evaluate a cell range that is structured like a
database.

All database functions expect the following syntax:

FUNCTION_NAME(DatabaseArea, Column, SearchCriteriaArea)

For example, the DSUM function returns the sum of all cells in the DatabaseArea cell range that are in the
specified Column and match the conditions defined in the SearchCriteriaArea cell range.

To use the database functions, proceed as follows:

Creating a database area

A database area is any cell range containing the data to be evaluated. It has to be structured as follows:

§ Its first row must contain labels for the database columns (e.g., Amount, Price, etc.). 

§ The data has to be arranged row by row (one row for each record).

The rows of the database area represent what is called a record in database applications, with the cells being the
fields of the database.

Creating a search criteria area

The search criteria area is a cell range containing conditions that the database records have to match.

The search criteria area has to be structured as follows:
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§ Important: The search criteria area has to be located above the database area. The criteria area must not
overlap the database area. 

§ The first row must also contain column labels. If, for example, you want to define criteria for the columns
that you have assigned the labels Amount and Price in the database area, you must also enter Amount and
Price here.

§ The conditions to be met must be entered below the labels. You can enter either single values or
comparisons like ">42" or "<10".

§ If multiple conditions have been entered in the same row, the conditions in column 1 and column 2 and
column 3, etc., must be met.

§ If multiple rows with conditions have been entered, the conditions in row 1 or row 2 or row 3, etc., must be
met.

Using database functions

After you have filled in the database area and search criteria area, you can use the database functions.

Here are some examples. Let's say you've created the following worksheet:

For example, the following calculations can be performed here:

DCOUNT(A11:C16, , A2:A3) returns 2. This formula counts the number of records matching the condition
Color = blue.

DCOUNT(A11:C16, , A6:B7) returns 3. This formula counts the number of records matching the condition
(Amount > 25 and Amount < 75).

DCOUNT(A11:C16, , A6:C8) returns 4. This formula counts the number of records matching the condition
(Amount > 25 and Amount < 75) or (Color = red).
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DSUM(A11:C16, "Amount", A2:A3) returns 150. This formula calculates the sum of the values in the
"Amount" column for all records matching the condition Color = blue.

DSUM(A11:C16, 1, A2:A3) returns 150. This is the same as above, except that the column was specified by its
relative number instead of its label.

Functions from A to Z
The following pages contain an alphabetical list of PlanMaker's arithmetic functions, including comprehensive
descriptions of each function.

ABS (absolute value)

Syntax:

ABS(Number)

Description:

This returns the absolute value of a number, i.e., removes its sign.

Example:

ABS(42) returns 42

ABS(0) returns 0

ABS(-42) returns 42

See also:

SIGN, NEG

ACOS (arccosine)

Syntax:

ACOS(Number)
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Description:

The ACOS function (arccosine) is the inverse function of the COS function: It returns the inverse cosine of a
number – that is, the angle whose cosine is the Number.

Number must be within the range from -1 to 1 (including -1 and 1).

The result is expressed in radians.

Example:

ACOS(1) returns 0

ACOS(COS(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

COS, ASIN, ATAN

ACOSH (inverse hyperbolic cosine)

Syntax:

ACOSH(Number)

Description:

The ACOSH function (inverse hyperbolic cosine) is the inverse function of the COSH function: It returns the
inverse hyperbolic cosine of a number – that is, the value whose hyperbolic cosine is the Number.

Example:

ACOSH(1.1) returns 0.44357

ACOSH(COSH(0.1234)) returns 0.1234

See also:

COSH
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ACOT (arccotangent)

Syntax:

ACOT(Number)

Description:

The ACOT function (arccotangent) is the inverse function of the COT function: It returns the inverse cotangent
of a number – that is, the angle whose cotangent is the Number.

The result is expressed in radians.

Example:

ACOT(1) returns 0.7854 (45°)

ACOT(COT(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

COT

ACOTH (inverse hyperbolic cotangent)

Syntax:

ACOTH(Number)

Description:

The ACOTH function (inverse hyperbolic cotangent) is the inverse function of the COTH function: It returns
the inverse hyperbolic cotangent of a number – that is, the value whose COTH is the Number.
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Example:

ACOTH(2) returns 0.54931

ACOTH(COTH(0.1234)) returns 0.1234

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

COTH

ADDRESS (cell address as text)

Syntax:

ADDRESS(Row, Column [, Abs] [, Mode] [, SheetName])

Description:

This returns a text string containing the address of a cell.

For Row and Column, the row number and column number of the cell must be specified.

The optional argument Abs specifies whether to deliver an absolute or relative address:

1 or omitted: Absolute row and column

2: Absolute row, relative column

3: Relative row, absolute column

4: Relative row and column

The optional argument Mode specifies the format in which the cell address is to be output:

TRUE or omitted: Normal cell address (for example, A1)

FALSE: Cell address in R1C1 format (an alternative type of cell addressing, supported by Microsoft Excel
only)

The optional argument SheetName lets you specify a worksheet name. If it is specified, it is placed in front of
the resulting cell reference. In other words:

If it is not specified, only the cell address will be returned.

If it is specified, SheetName!Address will be returned (see example).
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Example:

ADDRESS(1, 5) returns $E$1

ADDRESS(1, 5, 4) returns E1

ADDRESS(1, 5, 4, , "MySheet1") returns MySheet1!E1

See also:

INDIRECT, OFFSET, COLUMN, ROW

AND (logical AND function)

Syntax:

AND(Value1 [, Value2, Value3 ...])

Description:

This returns the logical value TRUE if all of the given arguments are TRUE, otherwise it returns FALSE.

You can use it to check, for example, whether several conditions all  apply.

Example:

AND(TRUE, TRUE) returns TRUE

AND(TRUE, FALSE) returns FALSE

AND(FALSE, FALSE) returns FALSE

AND(A1>0, A1<1) returns TRUE if A1 is greater than zero and less than one.

See also:

OR, XOR, NOT
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AREAS (number of areas)

Syntax:

AREAS(reference)

Description:

This determines how many cell ranges the specified cell reference contains.

Example:

AREAS(A1:B2) returns 1

AREAS((A1:B2, E5:G7)) returns 2

See also:

INDEX, COLUMNS, ROWS

ASIN (arcsine)

Syntax:

ASIN(Number)

Description:

The ASIN function (arcsine) is the inverse function of the SIN function: It returns the inverse sine of a number
– that is, the angle whose sine is the Number.

Number must be within the range from -1 to 1 (including -1 and 1).

The result is expressed in radians.

Example:

ASIN(1) returns 1.5708... (corresponds to PI()/2, thus 90°)

ASIN(SIN(0.1234)) returns 0.1234
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Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

SIN, ACOS, ATAN

ASINH (inverse hyperbolic sine)

Syntax:

ASINH(Number)

Description:

The ASINH function (inverse hyperbolic sine) is the inverse function of the SINH function: It returns the
inverse hyperbolic sine of a number – that is, the value whose SINH is the Number.

Example:

ASINH(1.1) returns 0.9503

ASINH(SINH(0.1234)) returns 0.1234

See also:

SINH

ATAN (arctangent)

Syntax:

ATAN(number)

Description:

The ATAN function (arctangent) is the inverse function of the TAN function: It returns the inverse tangent of a
number – that is, the angle whose tangent is the Number.
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The result is expressed in radians.

Example:

ATAN(1) returns 0.7854 (45°)

ATAN(TAN(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

ATAN2, TAN, ACOS, ASIN

ATAN2 (arctangent 2)

Syntax:

ATAN2(x, y)

Description:

This returns the arctangent of the given coordinates, i.e., the angle between the x axis and a line from the origin
(0, 0) to a point with the coordinates (x, y).

The x and y coordinates of this point must be given as arguments.

The result is expressed in radians.

Example:

ATAN2(1, 1) returns 0.7854 (45°)

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

ATAN, TAN
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ATANH (inverse hyperbolic tangent)

Syntax:

ATANH(Number)

Description:

The ATANH function (inverse hyperbolic tangent) is the inverse function of the TANH function: It returns the
inverse hyperbolic tangent of a number – that is, the value whose TANH is the Number.

Number must be within the range from -1 to 1 (excluding -1 and 1).

Example:

ATANH(0.5) returns 0.54931

ATANH(TANH(0.1234)) returns 0.1234

See also:

TANH

AVEDEV (average deviation)

Syntax:

AVEDEV(Number1 [, Number2, Number3 ...])

Description:

This returns the average deviation of the given numbers from their mean.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

AVEDEV(2, 2, 2, 2) returns 0

AVEDEV(2, 2, 2, 3) returns 0.375
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See also:

DEVSQ, STDEV.S/STDEV, VAR.S/VAR

AVERAGE (arithmetic mean)

Syntax:

AVERAGE(Number1 [, Number2, Number3 ...])

Description:

This returns the arithmetic mean of the given numbers.

This is calculated by dividing their sum by their number.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

AVERAGE(1, 2, 6) equals (1+2+6) / 3, which is 3.

If the cells A1:A4 contain the values 0, 1, 2 and the logical value TRUE, the following applies:

AVERAGE(A1:A4) equals (0+1+2) / 3, which is 1. The cell with the logical value is not considered here – not
even when determining the number of values.

AVERAGE(A1:A4, TRUE) equals (0+1+2+1) / 4, which is 1. Since the entered value TRUE is evaluated as 1,
FALSE is evaluated as 0 accordingly.

See also:

AVERAGEA, GEOMEAN, HARMEAN, TRIMMEAN, MEDIAN

AVERAGEA (arithmetic mean)

Syntax:

AVERAGEA(Value1 [, Value2, Value3 ...])
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Description:

The AVERAGEA function is almost identical to the AVERAGE function (see note). It returns the arithmetic
mean of the given values.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

Note:

Unlike the AVERAGE function, AVERAGEA also evaluates logical values and text: FALSE is evaluated as 0,
while TRUE is evaluated as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Example:

AVERAGEA(1, 2, 6) equals (1+2+6) / 3, which is 3.

If the cells A1:A4 contain the values 0, 1, 4 and the logical value TRUE, the following applies:

AVERAGEA(A1:A4) equals (0+1+4+1) / 4, which is 1.5. The logical value TRUE is interpreted as 1 here.

For comparison:

AVERAGE(A1:A4) equals (0+1+4) / 3, which is 1.66667. The logical value is ignored here.

See also:

AVERAGE

AVERAGEIF (average if condition is true)

Syntax:

AVERAGEIF(Range, Criterion [, AverageRange])

Description:

This returns the arithmetic mean of those values in a cell range that fulfill the specified criterion.

Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

Use numbers or text (like "42" or "screws") to obtain the average of all cells that contain that value.

Use conditions (like ">10" or "<=5") to obtain the average of all cells that match the specified condition.

Note: Criteria always have to be enclosed within double quotation marks (").
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AverageRange (optional) lets you specify the cell range that contains the values to be used for calculating the
average. If AverageRange is omitted, the values in Range will be used.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced with their current result as a fixed
value.

If you want to use this function, you should not save your document in the "Microsoft Excel 97-2003 (.xls)" file
format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

The cells A1:A5 contain the values 1, 2, 3, 2, 1.

Then the following applies:

AVERAGEIF(A1:A5, "2") returns 2

AVERAGEIF(A1:A5, ">=2") returns (2+3+2)/3, which is 2.33333

See also:

AVERAGE, AVERAGEIFS, SUMIF, SUMIFS, COUNTIF, COUNTIFS

AVERAGEIFS (average if conditions are true)

Syntax:

AVERAGEIFS(AverageRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This returns the arithmetic mean of those values in a cell range that fulfill all of the specified criteria.

This function is similar to the AVERAGEIF function, but it allows you to specify multiple search ranges
(including one criterion for each range).

Note: The order of the parameters is different here: In AVERAGEIF, AverageRange is the last parameter –
while it is the first parameter in AVERAGEIFS.

AverageRange is the cell range that contains the values whose average is to be calculated.
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Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as AverageRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:

Use numbers or text (like "42" or "screws") to obtain the average of all cells that contain that value.

Use conditions (like ">10" or "<=5") to obtain the average of all cells that match the specified condition.

Note: Criteria always have to be enclosed within double quotation marks (").

Unlike the AVERAGEIF function, AVERAGEIFS allows you to specify multiple search ranges (including one
criterion for each range). If you do so, only occurrences where all criteria are fulfilled are included in the
calculation of the average.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced with their current result as a fixed
value.

If you want to use this function, you should not save your document in the "Microsoft Excel 97-2003 (.xls)" file
format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

AVERAGEIFS(A1:A10, C1:C10, ">1", C1:C10, "<2")

This formula returns the average of only those cells in the cell range A1:A10 where the corresponding cell in
the range C1:C10 is greater than 1 and less than 2.

See also:

AVERAGE, AVERAGEIF, SUMIF, SUMIFS, COUNTIF, COUNTIFS

B (compatibility function)

Syntax:

B(n, p, k1 [, k2])

where:

n is the number of independent trial runs.

p is the probability of success for each trial run (0 to 100%). The value must be > 0 and < 1.
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k1 is the lower limit for the number of successes.

k2 (optional) is the upper limit for the number of successes.

Description:

This returns the probability of obtaining exactly k1 successes or between k1 and k2 successes in a binomial
experiment with n independent trials.

Note:

This function was retained only for compatibility with PlanMaker 97. We recommend that you use the
following Excel-compatible function instead:

B(n, p, k1) equals BINOMDIST(k1, n, p, FALSE) or BINOM.DIST(k1, n, p, FALSE)

B(n, p, k1, k2) equals BINOM.DIST.RANGE(n, p, k1, k2)

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

In Excel 2013, a function identical to the B function was introduced: BINOM.DIST.RANGE. PlanMaker also
supports this function. However, please bear in mind that older versions of Excel (and PlanMaker) do not know
this function.

See also:

BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST

BASE (convert decimal number into another base)

Syntax:

BASE(Number, Base [, Digits])

Description:

This converts the given decimal number (base 10) to a number with a different base – for example, a binary
number (base 2) or a hexadecimal number (base 16).

Note: Please note that the result of this function is a text string and not a number.

Number is the number to be converted. Only positive numbers are allowed.
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Base is the base into which the number is to be converted. Only integers between 2 and 36 are allowed.

The optional argument Digits lets you specify the minimum number of places to be displayed. If omitted,
PlanMaker automatically determines the required number of places. Digits must be a positive integer.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

BASE(42, 2) returns 101010 (decimal number 42 displayed as a binary number)

BASE(42, 2, 8) returns 00101010 (ditto, with the minimum places set to 8)

See also:

DECIMAL, DEC2BIN, DEC2HEX, DEC2OCT

BESSELI (modified Bessel function In(x))

Syntax:

BESSELI(x, n)

Description:

This returns the modified Bessel function In(x).

x is the value to be evaluated.

n is the order of the Bessel function. n 
automatically truncates the decimal places.

See also:

BESSELJ, BESSELK, BESSELY
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BESSELJ (Bessel function Jn(x))

Syntax:

BESSELJ(x, n)

Description:

This returns the Bessel function Jn(x).

x is the value to be evaluated.

n is the order of the Bessel function. n 
automatically truncates the decimal places.

See also:

BESSELI, BESSELK, BESSELY

BESSELK (modified Bessel function Kn(x))

Syntax:

BESSELK(x, n)

Description:

This returns the modified Bessel function Kn(x).

x is the value to be evaluated.

n is the order of the Bessel function. n 
automatically truncates the decimal places.

See also:

BESSELI, BESSELJ, BESSELY
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BESSELY (Bessel function Yn(x))

Syntax:

BESSELY(x, n)

Description:

This returns the Bessel function Yn(x) (also known as the Weber function or the Neumann function).

x is the value to be evaluated.

n is the order of the Bessel function. n 
automatically truncates the decimal places.

See also:

BESSELI, BESSELJ, BESSELK

BETADIST (beta distribution)

Note: BETADIST is supplemented by the new function BETA.DIST with additional functionality, which is
available in newer versions of Microsoft Excel (2010 or later).

Syntax:

BETADIST(X, Alpha, Beta [, A, B])

Description:

This returns the beta cumulative distribution function.

X is the value whose probability is to be calculated.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) determine the limits of the interval for X. If they are omitted, A is set to 0 and B is set to 1
(thus leading to a normal distribution).

X must be in the range A to B.
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See also:

BETA.DIST, BETA.INV/BETAINV

BETA.DIST (beta distribution)

Syntax:

BETA.DIST(X, Alpha, Beta, Cumulative [, A, B])

Description:

This returns the (cumulative) beta distribution function.

X is the value whose probability is to be calculated.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the beta distribution is calculated. By entering the value FALSE, the probability density
function of the beta distribution is calculated.

A and B (optional) determine the limits of the interval for X. If they are omitted, A is set to 0 and B is set to 1
(thus leading to a normal distribution).

X must be in the range A to B.

Note:

The BETA.DIST function supplements the previous BETADIST function with the additional argument
Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

The inverse function is BETA.INV

See also:

BETADIST, BETA.INV/BETAINV
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BETAINV (percentiles of the beta distribution)

Note: BETAINV is supplemented by the new identical function BETA.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

BETAINV(Probability, Alpha, Beta [, A, B])

Description:

This returns percentiles of a beta distribution.

Probability 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) determine the limits of the interval. If they are omitted, A is set to 0 and B is set to 1 (thus
leading to a normal distribution).

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

BETA.INV, BETA.DIST/BETADIST

BETA.INV (percentiles of the beta distribution)

Syntax:

BETA.INV(Probability, Alpha, Beta [, A, B])

Description:

This returns percentiles of a beta distribution.

Probability 
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Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) determine the limits of the interval. If they are omitted, A is set to 0 and B is set to 1 (thus
leading to a normal distribution).

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

BETA.INV is the inverse function of BETA.DIST

See also:

BETAINV, BETA.DIST/BETADIST

BIN2DEC (binary number to decimal number)

Syntax:

BIN2DEC(Number)

Description:

This converts the given binary number (base 2) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

Number must not contain more than 32 places, thus the permissible value range is:

Number 

Example:

BIN2DEC("101010") returns 42

BIN2DEC("00101010") also returns 42
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BIN2DEC("11111111111111111111111111010110") returns -42

See also:

DEC2BIN, BIN2HEX, BIN2OCT, DECIMAL

BIN2HEX (binary number to hexadecimal number)

Syntax:

BIN2HEX(Number [, Digits])

Description:

This converts the given binary number (base 2) to a hexadecimal number (base 16).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

Number must not contain more than 32 places, thus the permissible value range is:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

BIN2HEX("101010") returns 2A

BIN2HEX("00101010") also returns 2A

BIN2HEX("101010", 1) returns the #NUM! error value, as this number can only be represented with at least 2
digits

BIN2HEX("11111111111111111111111111010110") returns FFFFFFD6 (negative value)
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See also:

HEX2BIN, BIN2DEC, BIN2OCT

BIN2OCT (binary number to octal number)

Syntax:

BIN2OCT(Number [, Digits])

Description:

This converts the given binary number (base 2) to an octal number (base 8).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

Number must not contain more than 32 places, thus the permissible value range is:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

BIN2OCT("101010") returns 52

BIN2OCT("00101010") also returns 52

BIN2OCT("101010", 1) returns the #NUM! error value, as this number can only be represented with at least 2
digits

BIN2OCT("11111111111111111111111111010110") returns 37777777726 (negative value)

See also:

OCT2BIN, BIN2DEC, BIN2HEX
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BINOMDIST (binomial distribution)

Note: BINOMDIST is supplemented by the new identical function BINOM.DIST and the completely new
function BINOM.DIST.RANGE, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

BINOMDIST(k, n, p, Cumulative)

Description:

This returns the binomial distribution function.

The binomial distribution can be used to determine the probability of obtaining k successes in an experiment
with n independent trials with only two possible outcomes (success or failure) with a fixed probability of p for
each trial.

For example, you can use this function to determine the probability of obtaining "heads" exactly 4 times if you
toss a coin 10 times.

k is the number of successes, thus 4 here. It must be within the range 0 to n.

n is the number of independent trial runs, thus 10 here.

n and k should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

p is the probability of the success of each trial run, for example, the probability of obtaining "heads" here, i.e.,
50%.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned. BINOMDIST thus determines the probability of having
exactly k successes.

TRUE: The cumulative distribution function is returned. BINOMDIST thus determines the probability that
there are at most k successes.

Example:

Let's take the above example:

When you toss a coin 10 times (n=10), what is the probability of it landing on "heads" (p=50%) exactly 4
times?

BINOMDIST(4, 10, 50%, FALSE) returns 0.20508 =20.5%

What is the probability of it landing on "heads" 4 times at most?

Instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):



553Formulas and functions

BINOMDIST(4, 10, 50%, TRUE) returns 0.37695 =37.7%

See also:

BINOM.DIST/BINOM.DIST.RANGE, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.DIST (binomial distribution)

Syntax:

BINOM.DIST(k, n, p, Cumulative)

Description:

This returns the probabilities of a binomially distributed random variable.

The binomial distribution can be used to determine the probability of obtaining k successes in an experiment
with n independent trials with only two possible outcomes (success or failure) with a fixed probability of p for
each trial.

For example, you can use this function to determine the probability of obtaining "heads" exactly 4 times if you
toss a coin 10 times.

k is the number of successes, thus 4 here. It must be within the range 0 to n.

n is the number of independent trial runs, thus 10 here.

n and k should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

p is the probability of a success for each trial run, for example, the probability of obtaining "heads" here, i.e.,
50%.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned. Thus, BINOM.DIST determines the probability that there
are exactly k successes.

TRUE: The cumulative distribution function is returned. BINOM.DIST thus determines the probability that
there are at most k successes.

Example:

Let's take the above example:

When you toss a coin 10 times (n=10), what is the probability of it landing on "heads" (p=50%) exactly 4
times?

BINOM.DIST(4, 10, 50%, FALSE) returns 0.20508 =20.5%



554Formulas and functions

What is the probability of it landing on "heads" 4 times at most?

Instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

BINOM.DIST(4, 10, 50%, TRUE) returns 0.37695 =37.7%

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

BINOMDIST/BINOM.DIST.RANGE, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.DIST.RANGE (binomial distribution)

Syntax:

BINOM.DIST.RANGE(n, p, k1 [,k2])

Description:

This returns the probability of success of a number of trials using a binomial distribution.

n 

p is the probability of the success of each trial run. It must be within the range 0 to 1. (0 corresponds to 0% ; 1
corresponds to 100%)

k1 is the number of successes. It must be within the range 0 to n.

k2 is optional and returns the probability that the number of successes will fall between k1 and k2. k2 must be
within the range k1 to n.

n and k1,k2 should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

Additional info:

If the optional argument k2 is omitted, the probability of the exact number of successes is calculated.

Example:

When you toss a coin 10 times (n=10), what is the probability of it landing on "heads" (p=50%) exactly 4
times?

BINOM.DIST.RANGE(10, 50%, 4) returns 0.20508 =20.5%
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What is the probability of it landing on "heads" between 4 and 8 times?

BINOM.DIST.RANGE(10, 50%, 4, 8) returns 0.81738 =81.7%

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

BINOMDIST/BINOM.DIST, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.INV (binomial distribution)

Syntax:

BINOM.INV(n, p, Alpha)

Description:

This returns the smallest value for which the cumulative binomial distribution is greater than or equal to the
criterion value Alpha.

You thus calculate the maximum number of times a certain event with probability p may occur when
performing a sample with n repetitions before its cumulative probabilities assume a value greater than or equal
to the error probability Alpha.

This function is applicable for binomial distributions only (see also BINOM.DIST/BINOMDIST function);
thus, they must be independent draws where only two outcomes are possible: success (event occurs) or failure
(event does not occur).

n is the number of independent trial runs.

p is the probability of the success of each trial run. The values must be within the range 0 to 1.

Alpha is the probability of error that must not be exceeded. The values must be within the range 0 to 1.

Example:

You know from previous deliveries that 7% of a certain electronic component is usually defective. To check
this statement, you carry out a sample of 100 components for a new delivery. What is the maximum number of
them that can be defective if the probability of error is not to exceed 1%?

BINOM.INV(100, 7%, 1%) returns 2
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

CRITBINOM, BINOM.DIST/BINOM.DIST.RANGE/BINOMDIST

CEILING (round up to a multiple of base)

Syntax:

CEILING(Number, Base)

Description:

This rounds Number up (away from zero) to the nearest multiple of Base.

Positive numbers are rounded to the nearest multiple of Base that is larger than Number.

Negative numbers are rounded to the nearest multiple of Base that is smaller than Number.

Number and Base must have the same sign, otherwise the function returns a #NUM! error value.

Example:

CEILING(42.5, 1) returns 43

CEILING(-42.5, -1) returns -43

CEILING(21, 5) returns 25

CEILING(12.3456, 0.01) returns 12.35

See also:

FLOOR, MROUND, ROUND, TRUNC
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CELL (information about a cell)

Syntax:

CELL(Type [, Reference])

Description:

This returns various types of information about a cell.

Type specifies the type of information to return. Type can be one of the following text strings:

Type Explanation

"address" This returns the address of the cell (as a text string).

"width" (This is not supported and thus returns a #N/A error value.)

"filename" This returns the full path and filename of the document that contains the cell.

"color" This returns 1 if the cell uses the number format option Negative numbers in red, or 0 if not.

"format" (This is not supported and thus returns a #N/A error value.)

"contents" This returns the value stored in the cell.

"parentheses" (This is not supported and thus returns a #N/A error value.)

"prefix" This returns one of the following text strings:

' if the cell contains left-aligned text

^ if the cell contains centered text

" if the cell contains right-aligned text

\ if the cell contains fill-aligned text

"" if the cell contains anything else

"protect" This returns 1 if the cell is protected, or 0 if not.

"col" This returns the column number of the cell (as a number).

"type" This returns one of the following text strings:

b (for blank) if the cell is empty

l (for label) if the cell contains text

v (for value) if the cell contains anything else
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"row" This returns the row number of the cell.

Reference (optional) is the address of the cell to be evaluated.

If Reference is a range of cells, only the top left cell will be evaluated.

If Reference is omitted, the current cell will be evaluated. (Excel behaves differently, see the note below.)

Compatibility notes:

This function is not fully identical to Microsoft Excel's CELL function. The following restrictions apply:

1. Some types of information are not supported by PlanMaker (see the table above).

2. If the parameter Reference is omitted, PlanMaker evaluates the current cell, whereas Excel evaluates the cell
that was last changed.

Example:

=CELL("row", B5) returns the row number of cell B5, i.e., 5.

See also:

FILENAME, COLUMN, ROW

CHAR (character from ANSI code)

Syntax:

CHAR(Number)

Description:

This returns a single character with the specified ANSI code.

Number must be at least 10.

Example:

CHAR(65) returns A

CHAR(32) returns a blank

CHAR(CODE("X") returns X



559Formulas and functions

See also:

CODE

CHIDIST (chi-square distribution)

Note: CHIDIST is supplemented by the new identical function CHISQ.DIST.RT, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CHIDIST(X, DegreesFreedom)

Description:

This returns the right-tailed probability of the chi-square distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
expected; if this is not the case, PlanMaker automatically truncates the decimal places.

See also:

CHISQ.DIST.RT, CHISQ.INV.RT/CHIINV, CHISQ.TEST/CHITEST

CHIINV (percentiles of the chi-square distribution)

Note: CHIINV is supplemented by the new identical function CHISQ.INV.RT, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CHIINV(Probability, DegreesFreedom)

Description:

This returns the inverse of the right-tailed probability of the chi-square distribution function (i.e., percentiles
of this distribution).
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Probability is the probability to be evaluated. The values must be within the range 0 to 1.

DegreesFreedom 
expected; if this is not the case, PlanMaker automatically truncates the decimal places.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

CHISQ.INV.RT, CHISQ.TEST/CHITEST, CHISQ.DIST.RT/CHIDIST

CHISQ.DIST.RT (chi-square distribution)

Syntax:

CHISQ.DIST.RT(X, DegreesFreedom)

Description:

This returns the right-tailed probability of the chi-square distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
expected; if this is not the case, PlanMaker automatically truncates the decimal places.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

CHIDIST, CHISQ.INV.RT/CHIINV, CHISQ.TEST/CHITEST
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CHISQ.INV.RT (percentiles of the chi-square distribution)

Syntax:

CHISQ.INV.RT(Probability, DegreesFreedom)

Description:

This returns the inverse of the right-tailed probability of the chi-square distribution function (i.e., percentiles
of this distribution).

Probability is the probability to be evaluated. The values must be within the range 0 to 1.

DegreesFreedom 
expected; if this is not the case, PlanMaker automatically truncates the decimal places.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

CHIINV, CHISQ.TEST/CHITEST, CHISQ.DIST.RT/CHIDIST

CHISQ.TEST (chi-square test for independence)

Syntax:

CHISQ.TEST(ObservedValues, ExpectedValues)

Description:

This returns the chi-square test for independence.

A chi-square test provides a general criterion for the conformity of a population with a sample.
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ObservedValues are the observed values to be tested against the expected values. ExpectedValues are the
expected values.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

CHITEST, CHISQ.INV.RT/CHIINV, CHISQ.DIST.RT/CHIDIST

CHITEST (chi-square test for independence)

Note: CHITEST is supplemented by the new identical function CHISQ.TEST, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CHITEST(ObservedValues, ExpectedValues)

Description:

This returns the test statistics of a chi-square test for independence.

A chi-square test provides a general criterion for the conformity of a population with a sample.

ObservedValues are the observed values to be tested against the expected values. ExpectedValues are the
expected values.

See also:

CHISQ.TEST, CHISQ.INV.RT/CHIINV, CHISQ.DIST.RT/CHIDIST

CHOICE (x>0, x=0, x<0?)

Syntax:

CHOICE(Number, IfGreater [, IfZero, IfLess])
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Description:

This returns one of the following values:

IfGreater, if Number is greater than zero.

IfZero, if Number equals zero.

IfLess, if Number is less than zero.

The last two arguments are optional.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

CHOICE(42, "Greater", "Zero", "Less") returns Greater

CHOICE(0, "Greater", "Zero", "Less") returns Zero

CHOICE(-42, "Greater", "Zero", "Less") returns Less

See also:

IF

CHOOSE (choose value from list)

Syntax:

CHOOSE(Index, Value1 [, Value2, Value3 ...])

Description:

This returns the value with the specified Index from a list of values.

Index specifies the position in the list of arguments. If Index is 1, the first value will be returned, if Index is 2,
the second value will be returned, etc.

If Index is smaller than 1 or greater than the total number of values, the function returns a #VALUE! error
value.
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Example:

CHOOSE(2, "One", "Two", "Three") returns Two

See also:

SWITCH, INDEX, VLOOKUP, HLOOKUP

CLEAN (remove non-printable characters)

Syntax:

CLEAN(Text)

Description:

This removes all non-printable characters (characters with an ANSI code below 32) from the specified text
string.

See also:

TRIM

CODE (ANSI code of a character)

Syntax:

CODE(Text)

Description:

This returns the ANSI code of the first character in the specified text string.

Example:

CODE("A") returns 65

CODE("Arthur") also returns 65

CODE(CHAR(123)) returns 123
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CODE("") returns 0

See also:

CHAR

COLUMN (column number of cells)

Syntax:

COLUMN([Reference])

Description:

This returns the column number(s) of a cell or cell range:

If Reference is a single cell, the column number of this cell is returned.

If Reference is a range of cells, their column numbers are returned as a horizontal array. Note: In this case, the
formula has to be entered as an array formula (see Working with arrays).

If Reference is omitted, the column number of the cell that contains this function is returned.

Example:

COLUMN(D2) returns 4

COLUMN(D2:F4) returns {4,5,6}

COLUMN() returns 3 when you use this function in cell C5

See also:

COLUMNS, ROW, CELL, ADDRESS, OFFSET, INDIRECT

COLUMNS (number of columns in a range)

Syntax:

COLUMNS(Range)



566Formulas and functions

Description:

This returns the number of columns in the specified cell range.

Example:

COLUMNS(A1:D5) returns 4

See also:

ROWS, COLUMN, AREAS

COMBIN (combinations)

Syntax:

COMBIN(n, k)

Description:

This returns the number of combinations of size k in a population of size n.

In plain language: n items are available in total. From these, a subset of exactly k items is to be drawn. This
function calculates how many different subsets there can be.

n is the total number of items. n must be > k.

k is the number of items in each combination. k must be > 0 and < n.

n and k should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

Example:

Let's consider a lottery in which 6 balls are drawn from 49 different numbered balls.

How many combinations are possible?

COMBIN(49, 6) returns 13983816

Thus, there are 13,983,816 possible combinations.

See also:

PERMUT, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST
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COMPLEX (create complex number)

Syntax:

COMPLEX(Real, Imag [, Suffix])

Description:

This creates a complex number in the form x+yi or x+yj from the specified Real and Imag.

With Suffix (optional), you can determine which letter should be used for the imaginary unit: either "i" or
"j" (lowercase!). If Suffix is not specified, "i" is automatically used.

Tip:

To enter complex numbers in cells, you do not actually need the COMPLEX function, but can also simply type
in the value. For example, the complex number 2+4i can be entered either as =COMPLEX(2, 4) or simply as
2+4i.

The same applies for formulas – except for the fact that complex numbers have to be enclosed within double
quotation marks ("). For example, instead of typing =IMPOWER(COMPLEX(2, 4)), you could also type
=IMPOWER("2+4i").

Example:

COMPLEX(2, 4) returns 2+4i

COMPLEX(2, 4, "i") also returns 2+4i

COMPLEX(2, 4, "j") returns 2+4j

See also:

IMAGINARY, IMREAL

CONCAT (concatenate strings from list)

Syntax:

CONCAT(String1 [, String2, String3 ...])
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Description:

This combines two or more text strings into one text string. Unlike the CONCATENATE function, you can use
CONCAT to select complete cell ranges and do not have to specify individual cells.

Example:

CONCAT("Good ", "Morning") returns Good Morning

CONCAT(2, " slices", " of ", "bread") returns 2 slices of bread

There is no difference so far to the CONCATENATE function. The advantage of CONCAT can be explained
using the following example:

The function CONCATENATE(A2, B2, C2, D2, E2) returns MrPeterSmithMiami33133

The function CONCAT(A2:E2) also returns MrPeterSmithMiami33133

Conclusion: The new CONCAT function saves you from having to enter each cell individually.

For separators between the strings, however, you would have to enter the cells individually again and separate
them with " ": CONCAT(A2, " ", B2, " ", C2, " ", D2, " ", E2).

In this case, the new function TEXTJOIN does a better job.

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

See also:

TEXTJOIN, CONCATENATE

CONCATENATE (concatenate text strings)

Note: CONCATENATE is supplemented by the new function CONCAT with additional functionality, which
is available in newer versions of Microsoft Excel (2019 or later).

Syntax:

CONCATENATE(String1 [, String2, String3 ...])
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Description:

This combines two or more text strings into one text string.

Additional info:

The & operator does exactly the same: CONCATENATE("Text1", "Text2") is equivalent to "Text1" &
"Text2".

Example:

CONCATENATE("Good ", "Morning") returns Good Morning

CONCATENATE(2, " slices", " of ", "bread") returns 2 slices of bread

See also:

CONCAT, TEXTJOIN

CONFIDENCE (confidence interval)

Note: CONFIDENCE is supplemented by the new identical function CONFIDENCE.NORM, which is
available in newer versions of Microsoft Excel (2010 or later).

Syntax:

CONFIDENCE(Alpha, Sigma, n)

Description:

This returns a value that allows you to determine the 1-alpha confidence interval for the population mean of a
distribution.

The 1-alpha confidence interval is a range of values around the sample mean x covering the interval from (x -
CONFIDENCE) to (x + CONFIDENCE). The probability that this interval contains the population mean is 1-
Alpha.

Alpha is the significance level for computing the confidence level. The values must be within the range 0 to 1.

If, for example, Alpha is 5%, the probability that the population mean is outside the confidence interval is 5%.
The probability that it is inside is 1-Alpha, i.e., 95%. Thus, 1-alpha is also called the "confidence level".

Sigma is the population standard deviation. It must be > 0.

n is the size of the sample. It must be > 0.
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Example:

The average weight of 1000 piglets is to be determined in a pig farm. For this purpose, a sample (with
replacement) of the size n=65 is taken. The average weight determined is 30 kg. The standard deviation is 1.6
kg.

The 95% confidence interval (alpha is thus 0.05 here) is now to be determined. Thus, you would calculate as
follows:

CONFIDENCE(0.05, 1.6, 65) returns 0.38897 (kg)

The average weight of the population (of all 1000 piglets) is thus with a probability of 95% between 30-
0.38897 kg and 30+0.38897 kg.

See also:

CONFIDENCE.NORM

CONFIDENCE.NORM (confidence interval)

Syntax:

CONFIDENCE.NORM(Alpha, Sigma, n)

Description:

This returns a value that allows you to determine the 1-alpha confidence interval for the population mean of a
distribution.

The 1-alpha confidence interval is a range of values around the sample mean x covering the interval from (x -
CONFIDENCE) to (x + CONFIDENCE). The probability that this interval contains the population mean is 1-
Alpha.

Alpha is the significance level for computing the confidence level. The values must be within the range 0 to 1.

If, for example, Alpha is 5%, the probability that the population mean is outside the confidence interval is 5%.
The probability that it is inside is 1-Alpha, i.e., 95%. Thus, 1-alpha is also called the "confidence level".

Sigma is the population standard deviation. It must be > 0.

n is the size of the sample. It must be > 0.

Example:

The average weight of 1000 piglets is to be determined in a pig farm. For this purpose, a sample (with
replacement) of the size n=65 is taken. The average weight determined is 30 kg. The standard deviation is 1.6
kg.
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The 95% confidence interval (alpha is thus 0.05 here) is now to be determined. Thus, you would calculate as
follows:

CONFIDENCE.NORM(0.05, 1.6, 65) returns 0.38897 (kg)

The average weight of the population (of all 1000 piglets) is thus with a probability of 95% between 30-
0.38897 kg and 30+0.38897 kg.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

CONFIDENCE

CONVERT (unit conversion)

Syntax:

CONVERT(Number, From, To)

Description:

This converts a Number from one unit to another.

From and To are codes that represent the source unit and target unit (see table below).

Both units have to be in the same category. For example, you can convert meters into miles but not into
minutes, of course.

An error value #N/A is displayed if a) From and To are not from the same category or b) one of the two unit
codes was specified incorrectly.

Note: Unit codes are case-sensitive!

The following unit codes are available:

Mass Code

Gram g

Slug (unit of mass) sg

Pound* (avoirdupois) lbm

u (atom mass) u

Ounce (avoirdupois) ozm
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* Does not correspond to the pound still partly used in
German-speaking countries (½ kilo)

Distance Code

Meter m

Statute mile mi

Nautical mile Nmi

Inch in

Foot ft

Yard yd

Ångström ang

Pica Pica

Light year ly

Parsec (parallax second) parsec

Time Code

Second sec

Minute mn

Hour hr

Day day

Year* yr

Fortnight** ftn

* Based on a year with 365.25 days

** This unit is not supported by Microsoft Excel.

Liquid measure Code

Liter l (lowercase "L")

Teaspoon tsp

Tablespoon tbs

Fluid ounce oz

Cup cup

Pint (U.S.) pt

Pint (U.K.) uk_pt

Quart qt
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Gallon gal

Force Code

Newton N

Dyne dyn

Pound-force lbf

Power Code

Watt W

HP (Horsepower) HP

Magnetism Code

Tesla D

Gauss ga

Energy Code

Joule J

Erg e

Thermodynamic calorie c

IT calorie cal

Electron volt eV

Horsepower-hour HPh

Watt-hour Wh

Foot-pound force flb

BTU (British Thermal Unit) BTU

Pressure Code

Pascal Pa

Atmosphere atm

mm of Mercury mmHg

Temperature Code

Degree Fahrenheit F
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Degree Celsius C

Degree Kelvin K

Furthermore, prefixes can be added to metric units, "mg", for instance, stands for milligrams.

Please pay close attention to capitalization here also!

The following prefixes are available:

Prefix (and factor) Code

Exa (10^18) E

Peta (10^15) P

Tera (10^12) D

Giga (10^9) G

Mega (10^6) M

Kilo (1000) k

Hecto (100) h

Deka (10) e

Deci (0.1) d

Centi (0.01) c

Milli (0.001) m

Micro (10^-6) u

Nano (10^-9) n

Pico (10^-12) p

Femto (10^-15) f

Atto (10^-18) a

Example:

CONVERT(1, "day", "sec") returns 86400 (days -> seconds)

CONVERT(1, "mi", "km") returns 1.60934 (miles -> kilometers)

CONVERT(100, "kW", "HP") returns 134.10201 (100 kW -> HP)

CONVERT(1, "aparsec", "cm") returns 3.08568 (Attoparsec -> cm)
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CORREL (correlation coefficient)

Syntax:

CORREL(Range1, Range2)

Description:

This returns the correlation coefficient of two data sets.

The correlation coefficient is a measure of the relationship between two data sets.

Range1 and Range2 are cell references to the two data sets. Empty cells, text and logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4, the following applies:

CORREL(A1:A3, B1:B3) returns 0.99718

See also:

FISHER, FISHERINV, COVARIANCE.P/COVARIANCE.S/COVAR

COS (cosine)

Syntax:

COS(Number)

Description:

This returns the cosine of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.
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Example:

COS(PI()) returns -1

COS(RADIANS(180)) returns -1

See also:

ACOS, SIN, TAN

COSH (hyperbolic cosine)

Syntax:

COSH(Number)

Description:

The function COSH returns the hyperbolic cosine of a number.

Example:

COSH(0.1) returns 1.005

See also:

ACOSH, SINH, TANH

COT (cotangent)

Syntax:

COT(Number)

Description:

This returns the cotangent of an angle.

The angle must be specified in radians.
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Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

COT(PI()/4) returns 1

COT(RADIANS(45)) returns 1

See also:

TAN, ACOT

COTH (hyperbolic cotangent)

Syntax:

COTH(Number)

Description:

The COTH function returns the hyperbolic cotangent of a number.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

COTH(0.45) returns 2.37024

See also:

ACOTH, TANH
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COUNT (number of cells filled with numbers)

Syntax:

COUNT(Range1 [, Range2, Range3 ...])

Description:

This determines how many cells in one or more ranges are filled with numbers. This function only counts cells
with numbers (including dates) and text representing a number.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNT(A1:A4) returns 1

For comparison: COUNTA(A1:A4) returns 3

Additional info:

The function COUNTA works in a similar manner, but it counts cells with any content

See also:

COUNTA, COUNTBLANK, COUNTP, FREQUENCY, ISBLANK, ISNUMBER, COUNTIF, COUNTIFS

COUNTA (number of cells filled)

Syntax:

COUNTA(Range1 [, Range2, Range3 ...])

Description:

This determines the number of cells containing any kind of value (thus, cells that are not empty).

The cells may contain any numbers, text strings, logical values or error values.

Example:

If cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:
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COUNTA(A1:A4) returns 3

For comparison: COUNT(A1:A4) returns 1

Additional info:

The COUNT function works in a similar manner, but it only counts cells with numbers.

See also:

COUNT, ISBLANK

COUNTBLANK (number of empty cells)

Syntax:

COUNTBLANK(range)

Description:

This determines how many cells in a range are empty.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNTBLANK(A1:A4) returns 1

See also:

ISBLANK, COUNT

COUNTIF (count if condition is true)

Syntax:

COUNTIF(Range, Criterion)

Description:

This counts those cells in a cell range that fulfill the specified criterion.
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Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

On the one hand, you can simply specify a value here (for example, "42" or "screws"). In this case, all items
that correspond to this value are counted.

Tip: To count all non-empty cells, specify "*" as the criterion. For example, COUNTIF(D2:D4, "*") counts all
cells in the specified range that are not empty.

Furthermore, you can also use conditions like ">10" or "<=5". All items that match the specified condition are
counted here.

Note: Criteria always have to be enclosed within double quotation marks (").

Example:

The cells A1:A5 contain the values 1, 2, 3, 2, 1.

Then the following applies:

COUNTIF(A1:A5, "2") returns 2

COUNTIF(A1:A5, ">=2") returns 3

Tip: A modification of the formula is required if a cell reference is entered for the search criterion instead of a
constant. Here's an example:

Cells A1 to A5 contain the above example values. In addition, cell C1 contains the value 2.
You now want to find out how many values in the range A1:A5 are greater than the value in cell C1.

Then the formula is COUNTIF(A1:A5, ">"&C1) and returns 1

See also:

COUNT, AVERAGEIF, AVERAGEIFS, SUMIF, SUMIFS, COUNTIFS

COUNTIFS (count if conditions are true)

Syntax:

COUNTIFS(Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This applies criteria to the cells in the specified cell ranges and counts how often all of these criteria are
fulfilled.

This function is similar to the COUNTIF function, but it allows you to specify multiple search ranges
(including one criterion for each range).
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Range1 is the first cell range to be checked for the specified criterion. Please note that all of the cell ranges
specified must have the same dimensions.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:

On the one hand, you can simply specify a value here (for example, "42" or "screws"). In this case, the
condition is considered to be fulfilled if the cell contains this value.

Furthermore, you can also use conditions like ">10" or "<=5". Here, the condition is considered to be fulfilled
if the cell content matches this condition.

Note: Criteria always have to be enclosed within double quotation marks (").

Unlike the COUNTIF function, COUNTIFS allows you to specify multiple search ranges (including one
criterion for each range). If you do so, the function counts only occurrences where all criteria are fulfilled. See
examples below.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced with their current result as a fixed
value.

If you want to use this function, you should not save your document in the "Microsoft Excel 97-2003 (.xls)" file
format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

COUNTIFS(C1:C10, ">1", C1:C10, "<2")

This formula counts how many cells in the cell range C1:C10 are greater than 1 and less than 2.

COUNTIFS(A1:D4, "tuna", G10:K14, ">500")

This formula counts how often the following conditions are met: The cell in A1:D4 contains "tuna" and the
corresponding cell in G10:K14 contains a value greater than 500.

Tip: A modification of the formula is required if a cell reference is entered for the search criterion instead of a
constant. Here's an example:

The cells A1:A5 contain the values 1, 2, 3, 4, 5. In addition, cell C1 contains the value 2.
You now want to find out how many values in the range A1:A5 are greater than the value in cell C1.

Then the formula is COUNTIF(A1:A5, ">"&C1) and returns 3

See also:

COUNT, AVERAGEIF, AVERAGEIFS, SUMIF, SUMIFS, COUNTIF
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COUNTP (PlanMaker 97 compatibility function)

Syntax:

COUNTP(Range1 [, Range2, Range3 ...])

Description:

This determines how many cells in one or more ranges are filled with numbers or logical values.

Note:

This function was retained only for compatibility with PlanMaker 97. If possible, use the Excel-compatible
functions COUNT and COUNTA instead of this function.

The difference between these three functions is as follows:

COUNTA counts all cells that are not empty (regardless of their content).

COUNT counts all cells that contain numbers.

COUNTP counts all cells that contain numbers or logical values.

Example:

Let's assume that cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNTA(A1:A4) returns 3

COUNT(A1:A4) returns 1

COUNTP(A1:A4) returns 2

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

COUNT, COUNTA
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COVAR (population covariance)

Note: COVAR is supplemented by the new identical function COVARIANCE.P (population covariance) and
the completely new function COVARIANCE.S (sample covariance), which are available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

COVAR(Range1, Range2)

Description:

This returns the population covariance of two data sets.

The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain integers. Empty cells, text and
logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4, the following applies:

COVAR(A1:A3, B1:B3) returns 2.55556

See also:

COVARIANCE.P/COVARIANCE.S, FISHER, FISHERINV, CORREL

COVARIANCE.P (population covariance)

Syntax:

COVARIANCE.P(Range1, Range2)

Description:

This returns the population covariance of two data sets.
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The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain integers. Empty cells, text and
logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4, the following applies:

COVARIANCE.P(A1:A3, B1:B3) returns 2.55556

Note:

The COVARIANCE.P and COVARIANCE.S functions supplement the previous COVAR function, whereby
COVARIANCE.P returns the population covariance just like COVAR and COVARIANCE.S returns the
sample covariance.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

COVARIANCE.S/COVAR, FISHER, FISHERINV, CORREL

COVARIANCE.S (sample covariance)

Syntax:

COVARIANCE.S(Range1, Range2)

Description:

This returns the sample covariance of two data sets.

The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain integers. Empty cells, text and
logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.
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Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4, the following applies:

COVARIANCE.S(A1:A3, B1:B3) returns 3.83333

Note:

The COVARIANCE.S and COVARIANCE.P functions supplement the previous COVAR function, whereby
COVARIANCE.S returns the sample covariance and COVARIANCE.P returns the population covariance just
like COVAR.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

COVARIANCE.P/COVAR, FISHER, FISHERINV, CORREL

CREATEDATE (date the document was created)

Syntax:

CREATEDATE()

Description:

This returns the date/time the current document was created.

Example:

If a document was created on 31st of July, 2018 at 4:03 PM, the following applies:

CREATEDATE() returns 07/31/18 4:03 PM

Tip: By selecting a suitable date format in the dialog box of the ribbon tab Home | group Number , you can
determine whether only the date, only the time or both should be displayed.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.
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See also:

NOW, TODAY

CRITBINOM (binomial distribution)

Note: CRITBINOM is supplemented by the new identical function BINOM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CRITBINOM(n, p, Alpha)

Description:

This returns the smallest value for which the cumulative binomial distribution is greater than or equal to the
criterion value Alpha.

You thus calculate the maximum number of times a certain event with probability p may occur when
performing a sample with n repetitions before its cumulative probabilities assume a value greater than or equal
to the error probability Alpha.

This function is applicable for binomial distributions only (see also BINOM.DIST/BINOMDIST function);
thus, they must be independent draws where only two outcomes are possible: success (event occurs) or failure
(event does not occur).

n is the number of independent trial runs.

p is the probability of the success of each trial run. The values must be within the range 0 to 1.

Alpha is the probability of error that must not be exceeded. The values must be within the range 0 to 1.

Example:

You know from previous deliveries that 7% of a certain electronic component is usually defective. To check
this statement, you carry out a sample of 100 components for a new delivery. What is the maximum number of
them that can be defective if the probability of error is not to exceed 1%?

CRITBINOM(100, 7%, 1%) returns 2

See also:

BINOM.INV, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST
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CUMIPMT (cumulative interest)

Syntax:

CUMIPMT(Rate, NPer, PV, P1, P2, Type)

Description:

This returns the cumulative interest payments between period P1 and period P2. This function is applicable to
loans with periodic constant payments and a fixed interest rate.

You can use this function, for example, to calculate how large the interest portion of the annuities is in the
specified periods for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period)

NPer is the total number of payment periods.

PV is the present value (initial amount)

P1 and P2 define the time interval to be evaluated. P1 is the first period, while P2 is the last period. (The
periods are numbered consecutively, starting with 1.)

Type is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly, at the end of each month

Duration: 6 years

What is the interest portion of payments in periods (months) 24 to 36 in total?

CUMIPMT(10%/12, 6*12, 100000, 24, 36, 0) returns -7219.88.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Thus, in the above formula, the annual interest rate was divided by 12 to get the monthly interest rate and the
number of payment periods was multiplied by 12.
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Additional info:

The CUMPRINC function is the counterpart of CUMIPMT: It returns the total of the principal components.

See also:

CUMPRINC, PPMT, IPMT, PMT

CUMPRINC (cumulative principal)

Syntax:

CUMPRINC(Rate, NPer, PV, P1, P2, Type)

Description:

This returns the cumulative principal payments between period P1 and period P2. This function is applicable to
loans with periodic constant payments and a fixed interest rate.

You can use this function, for example, to calculate how large the principal portion of the annuity is in the
specified periods for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period)

NPer is the total number of payment periods.

PV is the present value (initial amount)

P1 and P2 define the time interval to be evaluated. P1 is the first period, while P2 is the last period. (The
periods are numbered consecutively, starting with 1.)

Type is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly, at the end of each month
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Duration: 6 years

What is the principal portion of payments in periods (months) 24 to 36 in total?

CUMPRINC(10%/12, 6*12, 100000, 24, 36, 0) returns -16863.71.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Thus, in the above formula, the annual interest rate was divided by 12 to get the monthly interest rate and the
number of payment periods was multiplied by 12.

Additional info:

The CUMIPMT function is the counterpart of CUMPRINC: It returns the total of the interest components.

See also:

CUMIPMT, PPMT, IPMT, PMT

CURRENCY (format number as currency)

Syntax:

CURRENCY(Number [, n])

Description:

This converts a number into a text string. The resulting text string contains the number rounded to n decimal
places and formatted as a currency.

PlanMaker determines the currency to be displayed from your computer's country settings. For example, a
dollar sign $ is displayed for users in the U.S., while a euro sign € is displayed for users in Germany, etc.

Number is the number to be converted.

The optional argument n determines the desired number of decimal places. If n is omitted, Number is rounded
to 2 decimal places.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of a hundred (see last example).

Note:

Note that the result of this function is a text string. To round a number without converting it into a text string,
use one of the rounding functions (for example, ROUND) instead.

To display a number only rounded and formatted as currency, you can also change its number format using the
commands of the ribbon tab Home | group Number.
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Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

CURRENCY(123.456) returns the text string $123.46

CURRENCY(123.456, 2) returns the text string $123.46

CURRENCY(123.456, -2) returns the text string $100

DATE (create a date value)

Syntax:

DATE(Year, Month, Day)

Description:

This returns a date created from the specified Year, Month and Day.

Example:

DATE(2018, 9, 25) returns 43368

However, PlanMaker automatically formats this date value in the number format "Date/Time", thus the cell
displays: 09/25/2018.

See also:

DATEVALUE, TIME, TIMEVALUE

DATEDIF (date difference)

Syntax:

DATEDIF(StartDate, EndDate, Mode)
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Description:

This returns the number of days, months or years between two dates.

StartDate and EndDate are the two dates to be evaluated. StartDate must be less (i.e., earlier) than EndDate.

Mode determines how and in which unit the difference between the StartDate and the EndDate should be
calculated:

"y" Number of years between StartDate and EndDate

"m" Number of months between StartDate and EndDate

"d" Number of days between StartDate and EndDate

"ym" Number of months, excluding years (as if StartDate and EndDate were in the same year)

"yd" Number of days, excluding years (as if StartDate and EndDate were in the same year)

"md" Number of days, excluding month and years (as if StartDate and EndDate were in the same month and year)

Note:

This function is an undocumented Excel function. Although it still exists in Microsoft Excel, it has been
removed from Excel's help file and thus seems to be no longer officially supported.

Example:

To calculate the age of a person, enter their date of birth in cell A1 (e.g., 4/3/1970). In A2, enter the current date
(e.g., 6/8/2012).

Calculate the person's age as follows:

Age in years:
DATEDIF(A1, A2, "y") returns 42 (years)

Age in months:
DATEDIF(A1, A2, "m") returns 506 (months)

Age in days:
DATEDIF(A1, A2, "d") returns 15407 (days)

Age in years, months and days:
DATEDIF(A1, A2, "y") returns 42 (years)
DATEDIF(A1, A2, "ym") returns 2 (months)
DATEDIF(A1, A2, "md") returns 5 (days)
(The person's age is thus 42 years, 2 months and 5 days.)

See also:

NOW, NETWORKDAYS, DAYS/DAYSP
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DATEVALUE (convert text into date value)

Syntax:

DATEVALUE(Text)

Description:

This converts a text string representing a date to a serial date value.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert text representing a date
to a serial date value if necessary.

Example:

DATEVALUE("09/25/2018") returns 43368.

If you now use the options of the ribbon tab Home | group Number  to format this in one of the date/time
formats (for example M/D/YYYY), the cell will display the date behind this value: the 9/25/2018.

See also:

TIMEVALUE, DATE, TIME

DAVERAGE (database function)

Syntax:

DAVERAGE(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the average of those values in a column of a database area that match the conditions specified in
the search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).
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Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

AVERAGE, DPRODUCT, DSUM

DAY (day of a date)

Syntax:

DAY(Date)

Description:

This returns the day of a date.

Example:

DAY("09/25/2018") returns 25

DAY("17th August") returns 17

If cell A1 contains the date value 9/25/2018: DAY(A1) returns 25

See also:

WEEKDAY, ISOWEEKNUM, ISOWEEEK, WEEKNUM, MONTH, YEAR

DAYS (days between two dates)

Syntax:

DAYS(EndDate, StartDate)

Description:

This returns the number of days between two dates.
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Please note the order of the parameters: The end date has to be specified first and then the start date.

Note:

This function was revised in PlanMaker 2016: The order of its two parameters was reversed.

Background info: The DAYS function has been available in PlanMaker for a long time. Excel did not have this
function until Excel 2013 when a function with the same name was added. This also works exactly like the
DAYS function in PlanMaker – but the order of the parameters in Excel is the other way around: first the end
date and then the start date. In order to be compatible with Excel, this order was adjusted accordingly in
PlanMaker 2016.

The previous version of the function was renamed to DAYSP. Thus, the functions DAYS and DAYSP are
identical, and only the order of their parameters differs:

DAYS(EndDate, StartDate) equals

DAYSP(StartDate, EndDate)

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

DAYS("01/14/2018", "01/01/2018") returns 13

If cell A1 contains the date value 01/14/2018 and cell A2 contains the date value 01/01/2018:

DAYS(A1, A2) returns 13

See also:

DAYSP, DATEDIF, NETWORKDAYS, DAYS360, TIMEDIFF

DAYS360 (days between two dates)

Syntax:

DAYS360(StartDate, EndDate [, Method])

Description:

This returns the number of days between two dates – based on a year with 360 days (12 months with 30 days
each) and ignoring leap years.

StartDate and EndDate are the two dates to be evaluated.
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Method (optional) is a logical value that lets you specify how dates occurring on the 31st of a month should be
evaluated:

FALSE or omitted: The U.S. (NASD) method is used: If StartDate is the 31st of a month, the 30th of the same
month will be used instead. If EndDate is the 31st of a month, the 1st of the following month will be used
instead. Exception: If StartDate and EndDate are the 31st of a month, the 30th of the same month will be used
instead (for both dates).

TRUE: The European method is used: If StartDate or EndDate is the 31st of a month, the 30th of the same
month will be used.

Note:

Thus, if you do not want to calculate according to the U.S. (NASD) method, the Method argument must be
specified as TRUE.

Example:

DAYS360("01/01/2018", "02/01/2018", TRUE) returns 30

DAYS360("02/01/2018", "03/01/2018", TRUE) returns 30

DAYS360("01/01/2012", "01/01/2013", TRUE) returns 360

See also:

DATEDIF, NETWORKDAYS, DAYS/DAYSP, TIMEDIFF

DAYSP (compatibility function)

Syntax:

DAYSP(StartDate, EndDate)

Description:

Compatibility function for older PlanMaker documents.

This function has been replaced by the DAYS function. (Please note that the order of the parameters is
reversed.)

See the notes below.
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Note:

DAYSP is merely a compatibility function. When you open a document created with PlanMaker 2012 or
earlier, all occurrences of the DAYS function are automatically converted into DAYSP. Reason: In PlanMaker
2016, the order of the parameters for the DAYS function was reversed.

For new documents, we recommend that you use the DAYS function (compatible with Excel 2013), which is
identical – except for the order of its parameters:

DAYS(EndDate, StartDate) equals

DAYSP(StartDate, EndDate)

For more information, see DAYS.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

DAYSP("01/01/2018", "01/14/2018") returns 13

If cell A1 contains the date value 01/01/2018 and cell A2 contains the date value 01/14/2018:

DAYSP(A1, A2) returns 13

See also:

DAYS, DATEDIF, NETWORKDAYS, DAYS360, TIMEDIFF

DAYSPERMONTH (days per month)

Syntax:

DAYSPERMONTH(Date)

Description:

This returns the number of days in the specified month.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.
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Example:

DAYSPERMONTH("09/25/2018") returns 30 (days)

DAYSPERMONTH("10/25/2018") returns 31 (days)

If cell A1 contains the date value 09/25/2018: DAYSPERMONTH(A1) returns 30 (days)

See also:

DAYSPERYEAR, YEAR, DAYS/DAYSP, DAYS360

DAYSPERYEAR (days per year)

Syntax:

DAYSPERYEAR(Date)

Description:

This returns the number of days in the specified year.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

DAYSPERYEAR("01/01/2012") returns 366 (2012 was a leap year)

DAYSPERYEAR("01/01/2013") returns 365 (2013 was not a leap year)

If cell A1 contains the date value 1/1/2012, then DAYSPERYEAR(A1) returns 366

See also:

YEAR, DAYSPERMONTH, DAYS/DAYSP, DAYS360
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DB (fixed-declining balance depreciation)

Syntax:

DB(Cost, Salvage, Life, Per [, Months])

Description:

This returns the depreciation of an asset for the specified period, using the fixed-declining balance method.

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Months (optional) = Number of months in the first year (12 if omitted)

Example:

In the case of a machine purchased for €200,000 that is used for 6 years and then has a salvage value of
€10,000, the following annual depreciation amount must be applied for the first year, broken down into 7
months:

DB(200000, 10000, 6, 1, 7) returns €45,850

See also:

DDB, SYD, SLN

DCOUNT (database function)

Syntax:

DCOUNT(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the number of cells in a database area that match the conditions specified in the search criteria
area.

Only cells containing numbers (including dates) are counted, while cells with text or logical values are ignored.
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For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

If the argument Column is not empty, the function only considers cells from the corresponding column. You
can specify Column by its relative column number or by its column label within double quotation marks (e.g.,
"Amount", "Price", etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

DCOUNTA

DCOUNTA (database function)

Syntax:

DCOUNTA(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the number of cells in a database area that match the conditions specified in the search criteria
area.

Unlike the DCOUNT function, DCOUNTA not only counts cells containing numbers but also counts cells with
text or logical values.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

If the argument Column is not empty, the function only considers cells from the corresponding column. You
can specify Column by its relative column number or by its column label within double quotation marks (e.g.,
"Amount", "Price", etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

DCOUNT
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DDB (double-declining balance depreciation)

Syntax:

DDB(Cost, Salvage, Life, Per [, Factor])

Description:

This returns the depreciation of an asset for the specified period, using the double-declining balance method (or
a variable-declining balance method if Factor is specified).

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Factor (optional) = Rate at which the balance declines (2 if omitted)

Example:

In the case of a machine purchased for €200,000 that is used for 10 years and then has a salvage value of
€10,000, the following annual depreciation amount must be applied for the first year:

DDB(200000, 10000, 10, 1) returns €40,000

For the second year:

DDB(200000, 10000, 10, 2) returns €32,000,

etc.

See also:

DB, SYD, SLN

DEC2BIN (decimal number to binary number)

Syntax:

DEC2BIN(Number [, Digits])
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Description:

This converts the given decimal number (base 10) to a binary number (base 2).

Note: Please note that the result of this function is a text string and not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2BIN(42) returns 101010

DEC2BIN(42, 8) returns 00101010

DEC2BIN(42, 4) returns the #NUM! error value because the number 42 cannot be represented with fewer than
6 binary digits

DEC2BIN(-42) returns 11111111111111111111111111010110

See also:

BIN2DEC, DEC2HEX, DEC2OCT, BASE

DEC2HEX (decimal number to hexadecimal number)

Syntax:

DEC2HEX(Number [, Digits])
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Description:

This converts the given decimal number (base 10) to a hexadecimal number (base 16).

Note: Please note that the result of this function is a text string and not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2HEX(42) returns 2A

DEC2HEX(42, 8) returns 0000002A

DEC2HEX(42, 1) returns the #NUM! error value because the number 42 cannot be represented with fewer than
2 hexadecimal digits

DEC2HEX(-42) returns FFFFFFD6

See also:

HEX2DEC, DEC2BIN, DEC2OCT, BASE

DEC2OCT (decimal number to octal number)

Syntax:

DEC2OCT(Number [, Digits])
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Description:

This converts the given decimal number (base 10) to an octal number (base 8).

Note: Please note that the result of this function is a text string and not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2OCT(42) returns 52

DEC2OCT(42, 8) returns 00000052

DEC2OCT(42, 1) returns the #NUM! error value because the number 42 cannot be represented with fewer than
2 octal digits

DEC2OCT(-42) returns 37777777726

See also:

OCT2DEC, DEC2BIN, DEC2HEX, BASE

DECIBEL (decibel value of two quantities)

Syntax:

DECIBEL(P2 [, P1])
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Description:

This returns the decibel value (dB) for the ratio of two quantities.

The calculation is based on the following formula:

DECIBEL(P2, P1) = 10 * LOG10(P2/P1)

Note the order of the two parameters: The dividend P2 of the quotient has to be specified first and then the
divisor P1 – not vice versa.

P2 and P1 have to be numbers. Their quotient has to be greater than zero.

The parameter P1 is optional. If it is omitted, PlanMaker sets it to 1 (one) automatically.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

DECIBEL(1000, 10) returns 20

DECIMAL (convert number from any base into decimal)

Syntax:

DECIMAL(Number, Base)

Description:

This converts a number from any base to decimal (base 10) – for example, a binary number (base 2) or a
hexadecimal number (base 16).

Number is the number to be converted.

Base is the base of the number. Only integers between 2 and 36 are allowed.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

DECIMAL("00101010", 2) returns 42
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DECIMAL("FF", 16) returns 255

See also:

BASE, BIN2DEC, HEX2DEC, OCT2DEC

DECIMALS (fractional part of a number)

Syntax:

DECIMALS(Number)

Description:

This returns the fractional part of the given number (i.e., the digits to the right of the decimal point).

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

DECIMALS(5.779) returns 0.779

Additional info:

To obtain the places before the decimal point, use the TRUNC function.

See also:

TRUNC

DEGREES (convert radians to degrees)

Syntax:

DEGREES(number)
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Description:

This converts radians into degrees.

The following conversion formula is used:

DEGREES(x) = x * 180 / PI()

Example:

DEGREES(PI()) returns 180

See also:

RADIANS

DELTA (test for equality)

Syntax:

DELTA(Number1, Number2)

Description:

This tests if two values are equal. If they are, 1 is returned, otherwise 0 is returned.

Number1 and Number2 must be numbers, otherwise a #VALUE! error value is returned.

However, text strings that are returned when using the TEXT function or some conversion functions, for
example, are also permitted. The text strings may only contain numeric values.

Example:

DELTA(1, 2) returns 0

DELTA(2, 2) returns 1

DELTA(2, "2") returns 1

DELTA("Text", "Text") returns the #VALUE! error value

See also:

EXACT
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DEVSQ (average square deviation)

Syntax:

DEVSQ(Number1 [, Number2, Number3 ...])

Description:

This returns the sum of squares of deviations of the specified numbers from their sample mean.

Empty cells, text strings and logical values are ignored.

Example:

DEVSQ(2, 2, 2, 3) returns 0.75

See also:

AVEDEV, STDEV.S/STDEV, SUM, VAR.S/VAR

DGET (database function)

Syntax:

DGET(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the exact value from a column of a database area that matches the conditions specified in the
search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).
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Note:

If more than one value matches the specified criteria, the function returns a #NUM! error value.

DMAX (database function)

Syntax:

DMAX(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the largest of those values in a column of a database area that match the conditions specified in the
search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

MAX, DMIN

DMIN (database function)

Syntax:

DMIN(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the smallest of those values in a column of a database area that match the conditions specified in
the search criteria area.



609Formulas and functions

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

MIN, DMAX

DOLLARDE (convert to dollar price decimal)

Syntax:

DOLLARDE(Value, Divisor)

Description:

This converts a dollar price expressed as a fraction into a decimal dollar price.

(In the USA, it is common practice for some types of financial transactions to represent monetary amounts as
fractions – for example, 27 4/8 instead of 27.50.)

Value is the number to be converted.

Divisor is the denominator of the fraction. It must be greater than or equal to 1. Divisor should be an integer.
Digits to the right of the decimal point are ignored.

Example:

DOLLARDE(27.4, 8) converts the fraction 27 4/8 into the decimal value 27.5.

See also:

DOLLARFR
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DOLLARFR (convert to dollar price fraction)

Syntax:

DOLLARFR(Value, Divisor)

Description:

This converts a decimal dollar price into a dollar price expressed as a fraction.

(In the USA, it is common practice for some types of financial transactions to represent monetary amounts as
fractions – for example, 27 4/8 instead of 27.50.)

Value is the number to be converted.

Divisor is the denominator of the fraction. It must be greater than or equal to 1. Divisor should be an integer.
Digits to the right of the decimal point are ignored.

Example:

DOLLARFR(27.5, 8) returns 27.4 (since 27.5 equals the fraction 27 4/8)

See also:

DOLLARDE

DPRODUCT (database function)

Syntax:

DPRODUCT(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the product of those values in a column of a database area that match the conditions specified in
the search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).



611Formulas and functions

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

PRODUCT, DAVERAGE, DSUM

DSTDEV (database function)

Syntax:

DSTDEV(DatabaseArea, Column, SearchCriteriaArea)

Description:

This estimates the standard deviation of a population based on a sample, using those values in a column of a
database area that match the conditions specified in the search criteria area.

The function assumes that the determined values represent a sample from the population. On this basis, the
standard deviation is estimated.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

STDEV.S/STDEV, DSTDEVP
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DSTDEVP (database function)

Syntax:

DSTDEVP(DatabaseArea, Column, SearchCriteriaArea)

Description:

This calculates the standard deviation of a population based on the entire population using those values in a
column of a database area that match the conditions specified in the search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

STDEV.P/STDEVP, DSTDEV

DSUM (database function)

Syntax:

DSUM(DatabaseArea, Column, SearchCriteriaArea)

Description:

This returns the sum of those values in a column of a database area that match the conditions specified in the
search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).
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Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

SUM, DAVERAGE

DVAR (database function)

Syntax:

DVAR(DatabaseArea, Column, SearchCriteriaArea)

Description:

This estimates the variance of a population based on a sample, using those values in a column of a database
area that match the conditions specified in the search criteria area.

The function assumes that the determined values represent a sample from the population. On this basis, the
variance is estimated.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

VAR.S/VAR, DVARP
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DVARP (database function)

Syntax:

DVARP(DatabaseArea, Column, SearchCriteriaArea)

Description:

This calculates the variance of a population based on the entire population, using those values in a column of a
database area that match the conditions specified in the search criteria area.

For more information on the use of database functions, see Working with database functions.

DatabaseArea is the cell range that contains the database. The first row of DatabaseArea must contain labels
for the database columns (for example, Amount, Price, etc.).

Column is the desired column of the database area from which data is to be returned. You can specify Column
by its relative column number or by its column label within double quotation marks (e.g., "Amount", "Price",
etc.).

SearchCriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
SearchCriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

VAR.P/VARP, DVAR

EDATE (date before/after n months)

Syntax:

EDATE(StartDate, m)

Description:

This returns the date that is m months before/after StartDate. This enables you to determine appointments that
fall on the same day of another month.

m is the number of months.

If m is positive, the program calculates a date that is m months after the StartDate.

If m is negative, the program calculates a date that is m months before the StartDate.
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m should be an integer. If this is not the case, PlanMaker automatically removes the decimal places.

Example:

EDATE("03/30/2018", 1) returns 04/30/2018

EDATE("03/31/2018", 1) also returns 04/30/2018 because April only has 30 days.

See also:

EOMONTH

EFFECT (effective interest rate)

Syntax:

EFFECT(NomRate, NPerYear)

Description:

This returns the effective annual interest rate, given the nominal annual interest rate and the number of
compounding periods per year.

NomRate is the nominal annual interest rate.

NPerYear is the number of compounding periods per year (must be at least 1).

Note:

This function does not calculate the effective annual interest rate according to the regulations of some countries
(for example, PAngV in Germany). It does not take into account any fees, commission, etc., but merely adds
compound interest to the nominal interest rate over the year.

Example:

To calculate the effective annual interest rate of an investment with a nominal annual interest rate of 5%,
compounded quarterly: How high is the annual percentage rate of charge?

EFFECT(5%, 4) returns approx. 5.09%

See also:

NOMINAL



616Formulas and functions

EOMONTH (end of month in n months)

Syntax:

EOMONTH(StartDate, m)

Description:

This returns the last day of the month that is m months before/after StartDate.

The argument StartDate must be a valid date value, as the function will return the #VALUE! error value
otherwise.

m is the number of months.

If m is zero, the last day of the same month will be returned.

If m is positive, the program calculates a date that is m months after the StartDate.

If m is negative, the program calculates a date that is m months before the StartDate.

m should be an integer. If this is not the case, PlanMaker automatically removes the decimal places.

Example:

EOMONTH("09/25/2018", 0) returns 09/30/2018

EOMONTH("09/25/2018", 1) returns 10/31/2018

EOMONTH("09/25/2018", -1) returns 08/31/2018

If cell A1 contains the date value 9/25/2018, then EOMONTH(A1, 0) returns 9/30/2018

See also:

EDATE

ERF (Gaussian error function)

Syntax:

ERF(LowerLimit [, UpperLimit])
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Description:

This returns the Gaussian error function.

LowerLimit and UpperLimit (optional) determine the limits of the interval whose integral surface is to be
calculated. If UpperLimit is omitted, the integral surface between zero and LowerLimit will be calculated.

See also:

ERFC

ERFC (complement to Gaussian error function)

Syntax:

ERFC(LowerLimit)

Description:

This returns the complement to the Gaussian error function.

For LowerLimit

See also:

ERF

ERROR.TYPE (error type)

Syntax:

ERROR.TYPE(Cell)

Description:

This function can be used to query the type of error value in a cell.

As an argument, the function expects the address of the cell to be checked.

The function returns the following results:
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Error value in cell Result

No error value #N/A

#NULL! 1

#DIV/0! 2

#VALUE! 3

#REF! 4

#NAME? 5

#NUM! 6

#N/A 7

For more information on error values, see Error values.

Example:

Cell A1 contains 1/0 and cell A2 contains 1/1.

Then the following applies:

ERROR.TYPE(A1) returns 2 (thus #DIV/0!)

ERROR.TYPE(A2) returns #N/A (thus no error)

The following formula returns the text "Error!" if any error occurs in cell A1, otherwise the value in A1 is
returned.

IF(ISNA(ERROR.TYPE(A1)), A1, "Error!")

See also:

ISERR, ISERROR, ISNA, NA(), IFERROR, IFNA, TYPE, section Error values

EUROCONVERT (convert EU currencies)

Syntax:

EUROCONVERT(Number, From, To)
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Description:

This function can convert the old currencies of all EU member states that have joined the monetary union, i.e.,
have introduced the single currency euro.

You can use this function to perform the following types of conversions:

a) Convert an amount from one of these currencies into euros, e.g., German Deutsche Mark (DM) into euros.

b) Convert an amount from euros into one of these currencies, e.g., euros into DM.

c) Convert an amount from one of these currencies into another by first converting it into euros and then into
the other currency (a method called "triangulation"), e.g., Spanish pesetas -> euros -> DM. Note: This method
can lead to rounding errors of up to 0.01.

Number is the amount to be converted.

From and To are codes representing the source and target currency (see table below). Use either PM codes or
ISO codes.

Note: Microsoft Excel only supports ISO codes for this function. If you want your calculations to be Excel-
compatible, ensure that you only use ISO codes (right column) for the currency codes.

The codes are not case-sensitive.

Country PM code ISO code

All euro countries (euro) € EUR

Belgium (franc) BF BEF

Germany (mark) DM DEM

Estonia (kroon) kr EEK

Finland (markka) mk FIM

France (franc) F FRF

Greece (drachma) Dr GRD

Ireland (pound) IR£ IEP

Italy (lira) L ITL

Latvia (lats) Ls LVL

Lithuania (litas) Lt LTL

Luxembourg (franc) LF LUF

Malta (lira) Lm MTL

Netherlands (guilder) fl NLG

Austria (schilling) öS ATS

Portugal (escudo) esc PTE

Slovakia (koruna) Sk SKK
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Slovenia (tolar) SIT SIT

Spain (peseta) pts ESP

Example:

EUROCONVERT(100, "DM", "€") converts 100 DM (German marks) into euros. The result is €51.13.

EUROCONVERT(100, "DEM", "EUR") does the same, but uses ISO codes. The result is of course identical:
51.13 (euros).

EUROCONVERT(100, "DEM", "ATS") returns 703.55 (Austrian schillings).

EVEN (round up to next even number)

Syntax:

EVEN(Number)

Description:

This rounds Number up to the nearest even integer.

Example:

EVEN(42) returns 42

EVEN(43) returns 44

EVEN(-43) returns -44

See also:

ODD, ROUNDUP, ROUND, MROUND, FIXED, INT, TRUNC, CEILING, FLOOR

EXACT (compare texts)

Syntax:

EXACT(Text1, Text2)
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Description:

This returns TRUE if Text1 and Text2 are exactly the same.

This function is case-sensitive.

Example:

EXACT("aaa", "aaa") returns TRUE

EXACT("aaa", "Aaa") returns FALSE

EXACT(UPPER("aaa"), UPPER("Aaa")) returns TRUE

See also:

FIND, SEARCH, DELTA

EXP (power of e)

Syntax:

EXP(Number)

Description:

This returns e raised to the power of Number.

The constant e (2.71828...) is the base of the natural logarithm (LN).

Example:

EXP(5) returns 148.4132

EXP(LN(0.1234)) returns 0.1234

Additional info:

The inverse function is LN (natural logarithm).

See also:

LN, LOG, LOG10, POWER
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EXPONDIST (exponential distribution)

Note: EXPONDIST is supplemented by the new identical function EXPON.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

EXPONDIST(x, Lambda, Cumulative)

Description:

This returns the probabilities of an exponentially distributed random number.

An exponential distribution can be used to model time intervals like the time between phone calls or the time
customers have to wait at a counter.

If, for example, it is known that a customer arrives at a bank counter every three minutes on average, you can
use this function to calculate the probability that a customer will arrive after two minutes at the latest.

x is the value whose probability is to be calculated. x 

Lambda (l) is the average number of successes per time interval. Lambda must be > 0.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

See also:

EXPON.DIST, POISSON.DIST/POISSON, WEIBULL.DIST/WEIBULL

EXPON.DIST (exponential distribution)

Syntax:

EXPON.DIST(x, Lambda, Cumulative)

Description:

This returns the probabilities of an exponentially distributed random number.
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An exponential distribution can be used to model time intervals like the time between phone calls or the time
customers have to wait at a counter.

If, for example, it is known that a customer arrives at a bank counter every three minutes on average, you can
use this function to calculate the probability that a customer will arrive after two minutes at the latest.

x is the value whose probability is to be calculated. x 

Lambda (l) is the average number of successes per time interval. Lambda must be > 0.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

EXPONDIST, POISSON.DIST/POISSON, WEIBULL.DIST/WEIBULL

FACT (factorial)

Syntax:

FACT(Number)

Description:

This returns the factorial of the specified Number.

The factorial of a number is the product of all positive integers in the range from 1 to the specified number.

Example:

FACT(9) equals 1*2*3*4*5*6*7*8*9, which is 362880.

See also:

FACTDOUBLE, MULTINOMIAL, POLYNOMIAL
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FACTDOUBLE (double factorial)

Syntax:

FACTDOUBLE(Number)

Description:

This returns the double factorial of a Number.

The double factorial is calculated as follows:

If Number is even, its double factorial is 2*4*6*...*Number.

If Number is odd, its double factorial is 1*3*5*...*Number.

Example:

FACTDOUBLE(10) equals 2*4*6*8*10, which is 3840

FACTDOUBLE(11) equals 1*3*5*7*9*11, which is 10395

See also:

FACT

FALSE (logical value FALSE)

Syntax:

FALSE()

Description:

This returns the logical value FALSE.

See also:

TRUE
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FDIST (F distribution)

Note: FDIST is supplemented by the new identical function F.DIST.RT, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

FDIST(X, DegreesFreedom1, DegreesFreedom2)

Description:

This returns the right-tailed F probability distribution function.

X is the value whose probability is to be calculated. X 

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

automatically truncates the decimal places.

See also:

F.DIST.RT, F.INV.RT/FINV, F.TEST/FTEST

F.DIST.RT (F distribution)

Syntax:

F.DIST.RT(X, DegreesFreedom1, DegreesFreedom2)

Description:

This returns the right-tailed F probability distribution function.

X is the value whose probability is to be calculated. X 

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

automatically truncates the decimal places.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

FDIST, F.INV.RT/FINV, F.TEST/FTEST

FILENAME (file name of the document)

Syntax:

FILENAME([IncludePath])

Description:

This returns the file name of the current document.

IncludePath (optional) determines if the path (drive and folder) should be included:

FALSE or omitted: don't include path

TRUE: include path

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

If you save a document as Balance.pmdx in folder C:\Documents:

FILENAME() returns Balance.pmdx

FILENAME(TRUE) returns C:\Documents\Balance.pmdx

See also:

USERFIELD, SHEET, SHEETNAME, CELL



627Formulas and functions

FIND (search for text in a text string)

Syntax:

FIND(SearchText, TextString [, StartPos])

Description:

This returns the position of SearchText within the TextString.

StartPos (optional) lets you specify the position in the text string, from which the search should start. If
omitted, the search starts at the first character.

The FIND function is case-sensitive. To perform a non-case-sensitive search, use the SEARCH function
instead.

Example:

FIND("a", "Banana") returns 2

FIND("A", "Banana") returns the #VALUE! error value, since the text string does not contain an uppercase
"A".

FIND("a", "Banana", 3) returns 4

FIND("x", "Banana") returns the #VALUE! error value, since "x" does not occur in "Banana".

For example, if the word "banana" is in cell B5, you can enter the formula as follows:

FIND("a", B5) returns 2

See also:

SEARCH, REPLACE, SUBSTITUTE, EXACT, MID

FINV (percentiles of the F distribution)

Note: FINV is supplemented by the new identical function F.INV.RT, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

FINV(Probability, DegreesFreedom1, DegreesFreedom2)
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Description:

This returns the inverse of the right-tailed F probability distribution function (i.e., percentiles of this
distribution).

Probability is the given probability from the F distribution. The values must be within the range 0 to 1.

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

automatically truncates the decimal places.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

F.INV.RT, F.TEST/FTEST, F.DIST.RT/FDIST

F.INV.RT (percentiles of the F distribution)

Syntax:

F.INV.RT(Probability, DegreesFreedom1, DegreesFreedom2)

Description:

This returns the inverse of the right-tailed F probability distribution function (i.e., percentiles of this
distribution).

Probability is the given probability from the F distribution. The values must be within the range 0 to 1.

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

automatically truncates the decimal places.
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Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

FINV, F.TEST/FTEST, F.DIST.RT/FDIST

FISHER (Fisher transformation)

Syntax:

FISHER(Number)

Description:

This returns the Fisher transformation for the given number.

Number must be within the range from -1 to 1 (excluding -1 and 1).

Additional info:

The inverse function is FISHERINV

See also:

FISHERINV, CORREL, COVARIANCE.P/COVARIANCE.S/COVAR

FISHERINV (inverse of the Fisher transformation)

Syntax:

FISHERINV(Number)
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Description:

This returns the inverse of the Fisher transformation for the given number.

Additional info:

This function is the inverse of the FISHER transformation.

See also:

FISHER, CORREL, COVARIANCE.P/COVARIANCE.S/COVAR

FIXED (format number as text with fixed decimals)

Syntax:

FIXED(Number [, n] [, NoThousandsSep])

Description:

This converts a number into a text string. The resulting text string contains the number rounded to n decimal
places with thousands separators.

Number is the number to be converted.

n (optional) is the desired number of decimal places. If n is omitted, Number is rounded to 2 decimal places.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of a hundred (see last example).

The optional logical value NoThousandsSep lets you specify if the resulting text string should contain
thousands separators:

FALSE or omitted: Add thousands separators

TRUE: Do not add thousands separators

Note:

Note that the result of this function is a text string. To round a number without converting it to a text string, use
one of the rounding functions (see below).

To only display a number as rounded without actually rounding it, you can also use the commands of the ribbon
tab Home | group Number.
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Example:

FIXED(1234.5678, 2) returns the text string 1,234.57

FIXED(1234.5678, 2, TRUE) returns the text string 1234.57 (without thousands separators)

FIXED(1234.5678, -2) returns the text string 1,200

See also:

ROUND, ROUNDDOWN, ROUNDUP, TRUNC, TEXT, INT

FLOOR (round down to a multiple of base)

Syntax:

FLOOR(Number, Base)

Description:

This rounds Number down (towards zero) to the nearest multiple of Base.

Positive numbers are rounded to the nearest multiple of Base that is smaller than Number.

Negative numbers are rounded to the nearest multiple of Base that is larger than Number.

Number and Base must have the same sign, otherwise the function returns a #NUM! error value.

Example:

FLOOR(42.5, 1) returns 42

FLOOR(-42.5, -1) returns -42

FLOOR(21, 5) returns 20

FLOOR(12.3456, 0.01) returns 12.34

See also:

CEILING, ROUNDDOWN, ROUNDUP, ROUND, MROUND, TRUNC
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FORECAST (forecast using linear regression)

Syntax:

FORECAST(x, y_values, x_values)

Description:

This returns the y coordinate for the given x coordinate on a best-fit line based on the given values.

A best-fit line is the result of a linear regression, a statistical technique that adapts a line (called "trendline" or
"best-fit line") to a set of data points (for example, the results of a series of measurements).

The FORECAST function allows you to predict what value y (the dependent variable) will have approximately
for a certain value x (the independent variable).

This function can be used to predict, for example, the resistance of a temperature-dependent resistor at a
specific temperature after having measured the resistance at several other temperatures.

x is the value x for which a prediction is to be made.

For the arguments y_values and x_values, you usually specify a cell range.

y_values are the dependent variables (the resistance in the above example).

x_values are the independent variables (the temperature in the above example).

Note:

Note that this function first expects the y_values and then the x_values as second and third arguments – not the
other way around.

Additional info:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-dependent resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures that were measured (the independent variables): 8, 20, 25, 28

Cells B1:B4 contain the resistances that were measured (the dependent variables): 261, 508, 608, 680

The resistance which will be delivered at 15°C can be estimated using the following formula:

FORECAST(15, B1:B4, A1:A4) returns 405.21805

At 15°, a resistance of 405.21805 (Ohm) would thus be expected.
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Additional info:

INTERCEPT(y_values, x_values) equals FORECAST(0, y_values, x_values).

See also:

INTERCEPT, SLOPE, SKEW, STEYX, TREND

FORMULATEXT (display formula contained in cell)

Syntax:

FORMULATEXT(Cell)

Description:

This displays the formula that is in the specified cell.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

If cell A1 contains the formula =SUM(D2:D4), then FORMULATEXT(A1) will return the text
"=SUM(D2:D4)".

See also:

ISFORMULA

FREQUENCY (frequency)

Syntax:

FREQUENCY(Values, Bins)
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Description:

This returns a frequency distribution for the given set of values. You can use this function to determine how
many values from a data set are within certain intervals.

The result of this function is a vertical array (see notes below).

Values is a cell range or an array containing the values to be evaluated. Blank cells and text strings are ignored.

Bins constitute a cell range or an array containing the intervals to be evaluated. If, for example, Bins is the
array {10; 15; 42}, the function returns an array with the following values:

4. The number of values that are > 42.

Both Values and Bins have to be vertical arrays, as they must not have more than one column.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Please note that the array returned by this function contains one element more than the number of values in
Bins.

See also:

COUNT

FTEST (F-test)

Note: FTEST is supplemented by the new identical function F.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

FTEST(Array1, Array2)

Description:

This returns the test statistics of an F-test.

An F-test can be used to check the consistency of the variances of two samples.
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Array1 and Array2 are the two arrays (samples) to be evaluated.

They both have to consist of at least 2 values; otherwise the function returns a #DIV/0! error value (division by
zero).

If the variance of Array1 or Array2 is 0, the function returns a #DIV/0! error value.

See also:

F.TEST, F.INV.RT/FINV, F.DIST.RT/FDIST

F.TEST (F-test)

Syntax:

F.TEST(Array1, Array2)

Description:

This returns the test statistics of an F-test.

An F-test can be used to check the consistency of the variances of two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

They both have to consist of at least 2 values; otherwise the function returns a #DIV/0! error value (division by
zero).

If the variance of Array1 or Array2 is 0, the function returns a #DIV/0! error value.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

FTEST, F.INV.RT/FINV, F.DIST.RT/FDIST

FV (future value)

Syntax:

FV(Rate, NPer, Pmt [, PV] [, Type])
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Description:

This returns the future value of an investment based on periodic constant payments and a fixed interest rate.

You can use this function to calculate the future value (terminal value) of a loan, for example.

The function expects the following arguments:

Rate is the interest rate (per payment period)

NPer is the total number of payment periods.

Pmt is the annuity (payment made for each period).

PV (optional) is the present value. If the argument PV is omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

FV(6.5%/12, 10, -1000) returns 10,247.30

See also:

PV, PPMT, PMT, RATE, IPMT, FVSCHEDULE, NPER

FVSCHEDULE (future value)

Syntax:

FVSCHEDULE(PV, Rates)

Description:

This returns the future value of an initial principal after applying a series of variable compound interest rates.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

You can use this function to calculate the future value (terminal value) of a loan, for example.

The function expects the following arguments:

PV is the present value (initial amount)
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Rates is a cell range or an array that contains the different interest rates per period (in their actual order,
namely, rate for the first year, rate for the second year, etc.).

Example:

You have an investment of €10,000 that pays 5% interest in the first year, 5.2% in the second year, 5.5% in the
third year and 5.9% in the fourth year. To calculate the future value of this investment, you enter the four
interest rates (in the correct order) in cells A1 to A4, for example, and then apply the following formula:

FVSCHEDULE(10000, A1:A4) returns €12341.09

The different interest rates can also be specified directly using the following form:

FVSCHEDULE(10000, {5%, 5.2%, 5.5%, 5.9%})

See also:

FV

GAMMA (gamma function)

Syntax:

GAMMA(Number)

Description:

This calculates the gamma function for the given number.

Number must be > 0.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

GAMMALN, GAMMA.DIST/GAMMADIST, GAMMA.INV/GAMMAINV
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GAMMADIST (gamma distribution)

Note: GAMMADIST is supplemented by the new identical function GAMMA.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

GAMMADIST(X, Alpha, Beta, Cumulative)

Description:

This returns the probabilities of a gamma distributed random number.

X is the value whose probability is to be calculated. X 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

See also:

GAMMA.DIST, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GAMMA.DIST (gamma distribution)

Syntax:

GAMMA.DIST(X, Alpha, Beta, Cumulative)

Description:

This returns the probabilities of a gamma distributed random number.

X is the value whose probability is to be calculated. X 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.
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TRUE: The cumulative distribution function is returned.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

The inverse function is GAMMA.INV

See also:

GAMMADIST, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GAMMAINV (percentiles of the gamma distribution)

Note: GAMMAINV is supplemented by the new identical function GAMMA.INV, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

GAMMAINV(Probability, Alpha, Beta)

Description:

This returns the percentiles of the gamma distribution.

Probability is the given probability from the gamma distribution. The values must be within the range 0 to 1.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

GAMMA.INV, GAMMA.DIST/GAMMADIST, GAMMA, GAMMALN
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GAMMA.INV (percentiles of the gamma distribution)

Syntax:

GAMMA.INV(Probability, Alpha, Beta)

Description:

This returns the percentiles of the gamma distribution.

Probability is the given probability from the gamma distribution. The values must be within the range 0 to 1.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

Additional info:

GAMMA.INV is the inverse function of GAMMA.DIST

See also:

GAMMAINV, GAMMA.DIST/GAMMADIST, GAMMA, GAMMALN

GAMMALN (logarithm of the gamma function)

Syntax:

GAMMALN(Number)

Description:

This returns the natural logarithm of the gamma function.

Number must be > 0.
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See also:

GAMMA, GAMMA.DIST/GAMMADIST, GAMMA.INV/GAMMAINV

GAUSS (standard normal distribution)

Syntax:

GAUSS(x)

Description:

This returns the integral of the PHI function (density function of a standard normal distribution) minus 0.5.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

We thus recommend that you use the NORMSDIST function instead, since it is compatible with all versions of
Excel:

GAUSS(x) equals NORMSDIST(x) - 0.5

See also:

PHI, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

GCD (greatest common divisor)

Syntax:

GCD(Number1 [, Number2, Number3 ...])

Description:

This returns the GCD (greatest common divisor) of the specified integers. The GCD is the largest integer that
will divide all of the given integers without a remainder.

You can specify numbers or cell references as arguments.

All given values Number1, Number2, etc., have to be greater than zero. Furthermore, only integers should be
used. If this is not the case, PlanMaker automatically truncates the decimal places.
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Example:

GCD(25, 100, 250) returns 25

GCD(25, 105, 250) returns 5

If A1:A3 contains the values 4, 8 and 6, the following applies:

GCD(A1:A3) returns 2

See also:

LCM

GEOMEAN (geometric mean)

Syntax:

GEOMEAN(Number1 [, Number2, Number3...])

Description:

Returns the geometric mean of the specified numbers.

The geometric mean is the n-th root of the product of the given values (n is the total number of values).

All given values Number1, Number2, etc., have to be greater than zero. The values can be single values, cell
ranges or an array.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

GEOMEAN(1, 2, 6) returns 2.28943

See also:

HARMEAN, TRIMMEAN, AVERAGE
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GESTEP (number greater or equal to threshold value?)

Syntax:

GESTEP(Number, Step)

Description:

This returns 1 if Number Step, otherwise it returns 0.

Example:

GESTEP(41, 42) returns 0

GESTEP(42, 42) returns 1

GESTEP(42.1, 42) returns 1

See also:

DELTA

GETPIVOTDATA

Syntax:

GETPIVOTDATA(ValueField, PivotRange [, Field1, Label1, Field2, Label2,...])

Description:

This returns the values of an existing pivot table by retrieving certain fields from the pivot table structure.

Value field: This is the name of the field that you have placed in the Values area of the pivot table and whose
data you want to retrieve. The argument must be specified within double quotation marks.

PivotRange: The referenced pivot table. Just address any cell of the pivot table target range to specify it. The
argument is specified without quotation marks.

Field1, Label1, Field2, Label2,...: You can narrow the output of the values by retrieving a specific field in
conjunction with an item from this field. You can add several combinations. The argument must be specified
within double quotation marks.

ValueField and PivotRange are required as arguments, while Fields/Labels are optional.
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Additional info:

For the PivotRange, you can also enter a Named range, but you first have to assign a name to the cell range of
the pivot table report. To do so, select a cell in the pivot table report (you do not have to select the entire range)
and follow the description in the Naming cell ranges section.

You cannot use the name automatically generated by PlanMaker (e.g., "Pivot table 1") as the Named range.
Only names that have been created via the ribbon command Formula | group Named areas | Edit names can
be actually assigned as names for the PivotRange.

Example:

Here is some sample data from the Pivot tables section. Assuming your pivot table report is in cell range
F1:G12 and the "Amount" field is in the Values area, the "Employee" and "Order" fields are in the Row labels
area:

GETPIVOTDATA("AMOUNT", F1) returns 200, since the grand total for all values of Amount is displayed.

GETPIVOTDATA("AMOUNT", F1, "Employee", "Anna") returns 123, since the result of Amount is restricted
to the Employee field containing the item Anna.

GETPIVOTDATA("AMOUNT", F1, "Employee", "Anna", "Order", "Coffee") returns 75, since the result of
Amount is restricted to the field Employee/item Anna in combination with the field Order/item Coffee.

GROWTH (values of an exponential regression)

Syntax:

GROWTH(y_values [, x_values] [, New_x_values] [, Constant])
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Description:

This returns the values of an exponential regression.

Exponential regression is a statistical technique that adapts an exponential curve to a set of data points (for
example, the results of a series of measurements).

The GROWTH function returns an array with the y values of a best-fit exponential curve based on the given y
values and x values.

To clarify, the function expects the following arguments:

y_values: Here, you specify the existing y coordinates, that is, the dependent values. y_values can be either a
cell reference or an array. All values must be positive, otherwise a #NUM! error value is returned.

x_values: Here, you have the option of specifying the x coordinates, that is, the independent values. x_values
also can be either a cell reference or an array. If x_values are omitted, the function automatically uses the
values 1, 2, 3, ... (according to the number of existing y_values).

New_x_values (optional) are the x values for which you want to determine the corresponding y values on the
curve. If omitted, the values in x_values will be used. If required, however, you can specify other x coordinates
with New_x_values. New_x_values can also be either a cell reference or an array.

Constant (optional) is a logical value that lets you specify if the constant b should be set to 1 (one):

TRUE or omitted: b is automatically calculated from the available data.

FALSE: b is forced to equal 1 (one), the m values are adjusted accordingly.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

See also:

LINEST, LOGEST, TREND

HARMEAN (harmonic mean)

Syntax:

HARMEAN(Number1 [, Number2, Number3 ...])

Description:

This returns the harmonic mean of the given numbers.

This is defined as the reciprocal value of the arithmetic mean of the reciprocal values of the individual values.
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All given values Number1, Number2, etc., have to be greater than zero. The values can be single values, cell
ranges or an array.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

HARMEAN(1, 2, 6) returns 1.8

See also:

GEOMEAN, TRIMMEAN, AVERAGE

HEX2BIN (hexadecimal number to binary number)

Syntax:

HEX2BIN(Number [, Digits])

Description:

This converts the given hexadecimal number (base 16) to a binary number (base 2).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.
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Example:

HEX2BIN("2A") returns 101010

HEX2BIN("2A", 8) returns 00101010

HEX2BIN("2A", 2) returns the #NUM! error value because this number cannot be represented with fewer than
5 binary digits

HEX2BIN("FFFFFFD6") returns 11111111111111111111111111010110 (negative value)

See also:

BIN2HEX, HEX2DEC, HEX2OCT

HEX2DEC (hexadecimal number to decimal number)

Syntax:

HEX2DEC(Number)

Description:

This converts the given hexadecimal number (base 16) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation to:

Number 

Example:

HEX2DEC("2A") returns 42

HEX2DEC("FFFFFFD6") returns -42

See also:

DEC2HEX, HEX2BIN, HEX2OCT, DECIMAL
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HEX2OCT (hexadecimal number to octal number)

Syntax:

HEX2OCT(Number [, Digits])

Description:

This converts the given hexadecimal number (base 16) to an octal number (base 8).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

HEX2OCT("2A") returns 52

HEX2OCT("2A", 4) returns 0052

HEX2OCT("2A", 1) returns the #NUM! error value because this number cannot be represented with fewer than
2 octal digits

HEX2OCT("FFFFFFD6") returns 37777777726 (negative value)

See also:

OCT2HEX, HEX2BIN, HEX2DEC
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HLOOKUP (look up row-wise)

Syntax:

HLOOKUP(Crit, Range, n [, Sorted])

Description:

This function searches in the first row of Range for the first occurrence of Crit. If found, the function returns
the content of the cell located in the same column and n-th row of Range.

Note: HLOOKUP can only search horizontally. To search vertically, use VLOOKUP instead.

Crit is the value for which the search is performed. The search is case-insensitive.

Range is the cell range or array to be evaluated. Its first row should contain the values to be scanned. These can
be text strings, numbers or logical values.

n is the relative row number in Range from which a value will be returned if Crit is found.

If n is less than 1, a #VALUE! error value is returned. If n is greater than the total number of rows in Range, a
#REF! error value is returned.

Sorted is a logical value that you use to specify whether the values in the first row of Range are sorted:

If Sorted is TRUE or omitted, values in the first column of Range have to be sorted in ascending order.

If Sorted is FALSE, the order of the values in the first column is irrelevant.

Important: If you do not explicitly set Sorted to FALSE, these values must be in sorted order!

Note:

If Sorted is set to TRUE and VLOOKUP does not find a value that exactly matches Crit, the next smaller
value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the
#N/A error value.

Example:

You sell flowers at different unit prices – depending on the amount of flowers the customer buys. To do so, you
have created a table with a discount scale:
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You can now use the HLOOKUP function to determine the price for a specific type of flower depending on the
number of pieces.

Use the following arguments:

For Crit, enter the name of the flower type (i.e., "roses", "carnations" or "tulips").

For Range, you enter the cell range that contains the names of the flower types in the first row and the prices
below – B1:D4 here.

For n, you enter the number of pieces plus one, as the first row (n=1) contains the names of the flowers rather
than the prices.

Examples:

HLOOKUP("Roses", B1:D4, 2, FALSE) returns the price for one rose, i.e., €5.50.

HLOOKUP("Roses", B1:D4, 4, FALSE) returns the price for three roses, i.e., €4.95.

HLOOKUP("Carnations", B1:D4, 4, FALSE) returns the price for three carnations, i.e., €4,50.

HLOOKUP("Carnations", B1:D4, 5, FALSE) returns the #REF error value because n is greater than the row
number of Range.

HLOOKUP("Petunias", B1:D4, 4, FALSE) returns the #N/A error value because "Petunias" does not appear in
the first row of Range.

See also:

VLOOKUP, LOOKUP, INDEX, MATCH, TRUE

HOLIDAY (dates of movable Christian holidays)

Syntax:

HOLIDAY(Year, Type)

Description:

This returns the date of the movable Christian holidays in the specified year.
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Year is the desired year (as an integer).

Type is an integer that determines the holiday for which the date should be returned:

0: Good Friday

1: Easter Sunday

2: Easter Monday

3: Ascension Day

4: Whit Sunday (Pentecost)

5: Whit Monday

6: (Feast of) Corpus Christi

7: Ash Wednesday

8: Repentance Day (Germany)

9: 1st Sunday of Advent

Example:

HOLIDAY(2014, 1) returns 04/20/2014 (Easter Sunday in 2014)

HOLIDAY(YEAR(TODAY()), 5) returns the date of Whit Monday in the current year

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

WORKDAY, NETWORKDAYS

HOUR (hour)

Syntax:

HOUR(Time)

Description:

This returns the hour of a time value.



652Formulas and functions

Example:

HOUR("12:34:56 AM") returns 12

HOUR("09/25/2018 10:30:56") returns 10

If cell A1 contains a date with the time 10:30:56, then HOUR(A1) returns 10

See also:

MINUTE, SECOND, MILLISECONDS

HYPERLINK (hyperlink)

Syntax:

HYPERLINK(TargetAddress [, Text])

Description:

This displays a hyperlink (a link) to the specified target address in the cell. The displayed text is either the
target address or the text specified in the optional parameter Text.

For example, you can use this function to insert a hyperlink to a web page in a cell. If the user clicks on it, their
web browser starts automatically and presents this page.

Furthermore, you can insert links to another PlanMaker document, which is automatically opened when you
click on this link. See examples below.

TargetAddress is the address to which the link should point. You can use a fixed text string, a calculation, or a
reference to the cell that contains the target address. See examples below.

Text (optional) is the text to be displayed in the cell. If it is omitted, the target address will be displayed
instead.

Example:

=HYPERLINK("http://www.softmaker.com")

The above hyperlink opens the web page www.softmaker.com in the web browser.

=HYPERLINK("http://www.softmaker.com", "Our Homepage")

Ditto, but instead of the target address, the text "Our Homepage" is displayed as the link text.

=HYPERLINK("http://www.softmaker.com#MyAnchor")
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The above link opens the web page www.softmaker.com in the browser and jumps to the anchor (target) named
"MyAnchor". Alternatively, you could also use the syntax =HYPERLINK("[http://www.softmaker.com]
MyAnchor") in this case.

=HYPERLINK("C:\My Folder\Filename.pmdx")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker.

Note: Not only can you open PlanMaker files with this function, but also any kind of document (provided that it
is associated with an application that will open it).

=HYPERLINK("[C:\My Folder\Filename.pmdx]Sheet1!A5")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker and jumps to the cell A5 in the
worksheet "Sheet1". Note: The entire file path and name must be enclosed within square brackets. Directly after
the file name, add the name of the worksheet, an exclamation mark and the address of the target cell.

=HYPERLINK("[C:\My Folder\Filename.pmdx]Sheet1!MyRange")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker and jumps to the top left corner of the
named range "MyRange" on the worksheet "Sheet1".

=HYPERLINK(E1, E2)

The above link opens the target address entered in cell E1. The content of cell E2 is displayed as a link text.

See also:

Links can also be created using the alternative method described in Using hyperlinks. However, the
HYPERLINK function is more flexible.

HYPGEOMDIST (hypergeometric distribution)

Note: HYPGEOMDIST is supplemented by the new function HYPGEOM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

HYPGEOMDIST(k, n, K, N)

Description:

This returns the probabilities of a hypergeometrically distributed random variable.

The hypergeometric distribution can be used to calculate the probability of, for example, obtaining k red balls
when randomly drawing n balls (without replacement) from an urn containing N balls of which K are red.

k is the number of successes in the sample (success = drawing a red ball).

n is the size of the sample (the number of balls to be drawn)
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K is the total number of successes in the population (the total number of red balls).

N is the size of the population (the total number of balls).

All of these values should be integers. If this is not the case, PlanMaker automatically truncates the decimal
places.

Example:

An urn contains a total of 10 balls (N=10) of which 2 are red (K=2). To determine the probability of obtaining
exactly 1 red ball (k=1) when drawing 5 balls (n=5), use the following calculation:

HYPGEOMDIST(1, 5, 2, 10) returns 0.55556

See also:

HYPGEOM.DIST, NEGBINOM.DIST/NEGBINOMDIST

HYPGEOM.DIST (hypergeometric distribution)

Syntax:

HYPGEOM.DIST(k, n, K, N, Cumulative)

Description:

This returns the (cumulative) probabilities of a hypergeometrically distributed random variable.

The hypergeometric distribution can be used to calculate the probability of, for example, obtaining k red balls
when randomly drawing n balls (without replacement) from an urn containing N balls of which K are red.

k is the number of successes in the sample (success = drawing a red ball).

n is the size of the sample (the number of balls to be drawn)

K is the total number of successes in the population (the total number of red balls).

N is the size of the population (the total number of balls).

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the hypergeometric distribution is calculated. By entering the value FALSE, the
probability density function of the hypergeometric distribution is calculated.

All of these values should be integers. If this is not the case, PlanMaker automatically truncates the decimal
places.
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Example:

An urn contains a total of 10 balls (N=10) of which 2 are red (K=2). To determine the probability of obtaining
exactly or at most 1 red ball (k=1) when drawing 5 balls (n=5), use the following calculation:

HYPGEOM.DIST(1, 5, 2, 10, FALSE) returns 0.55556

HYPGEOM.DIST(1, 5, 2, 10, TRUE) returns 0.77778

The probability of obtaining exactly 1 red ball is 55.6% (density function). The probability of obtaining at most
1 red ball is 77.8% (cumulative distribution function).

Note:

The HYPGEOM.DIST function supplements the previous HYPGEOMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

HYPGEOMDIST, NEGBINOM.DIST/NEGBINOMDIST

IF (if-then-else condition)

Syntax:

IF(Condition, IfTrue [, IfFalse])

Description:

This function returns IfTrue if the specified Condition is TRUE, otherwise it returns IfFalse (if given).

Condition can be any kind of value or expression that returns TRUE or FALSE.

IfTrue and IfFalse can be any kind of value or expression (including formulas).

Example:

The formula IF(A1<5, "Order!", "Stock ok") returns the text string "Order!" if A1<5. If this is not the case (A1
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See also:

CHOICE, IFERROR

IFEMPTY (return a value if cell is empty)

Syntax:

IFEMPTY(Cell, Value)

Description:

This normally returns the content of the Cell. If this cell is empty, however, the defined Value is returned
instead.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

IFEMPTY(A1, "Cell is empty!") returns the content of cell A1 as long as it is not empty. For an empty cell,
however, the entered text string "Cell is empty!" is returned instead.

See also:

ISBLANK, IFERROR, IFNA

IFERROR (return a value if error)

Syntax:

IFERROR(Value, ValueIfError)

Description:

This normally returns Value. If Value contains any type of error value, however, the defined ValueIfError is
returned instead.
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Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced with their current result as a fixed
value.

If you want to use this function, you should not save your document in the "Microsoft Excel 97-2003 (.xls)" file
format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

IFERROR(A1, "Error!") returns the value in cell A1, as long as A1 doesn't contain an error value. If there is an
error value in this cell, however, the text string "Error!" is returned instead.

See also:

IFNA, ISERR, ISERROR, ISNA, ERROR.TYPE, section Error values

IFNA (return defined value for #N/A)

Syntax:

IFNA(Cell, Value)

Description:

This normally returns the content of the Cell. If this cell is #N/A, however, the defined Value is returned
instead.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

IFNA(A1, "not found!") returns the value in cell A1 as long as it doesn't contain the #N/A error value. If it does
contain the #N/A error value, however, the text string "not found!" is returned instead.

See also:

IFERROR, ISERR, ISERROR, ISNA, ERROR.TYPE, section Error values
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IFS (first condition met)

Syntax:

IF(Condition1, Value1 [, Condition2, Value2 ...])

Description:

This function can test multiple conditions and returns the value of the first condition that is fulfilled. IFS allows
shorter formulas than with a nested formula construction using the similar IF function.

Condition1 is the first tested condition and can be any expression.

Value1 is the result if Condition1 is fulfilled.

Condition2, Value2 (optional) is the second tested condition, etc.

As soon as the first fulfilled Condition is found, its corresponding Value is displayed as the result.

Note:

If none of the conditions are fulfilled, the #N/A error is returned.

Instead, you can use the condition TRUE at the end of the formula to specify a default value as the result, which
is returned if none of the conditions are fulfilled (see example 2 below).

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

Example 1:

You have entered a sales volume in cell A1 and want to distribute a bonus according to the sales volume using
the following distribution key:

Sales above 50000 = 2000 bonus; sales above 25000 = 1000 bonus; sales above 10000 = 500 bonus

The formula IFS(A1>50000, 2000, A1>25000, 1000, A1>10000, 500) then returns, for example:

A sales volume of 70000 in cell A1 results in 2000 as a bonus.

A sales volume of 30000 in cell A1 results in 1000 as a bonus.

A sales volume of 20000 in cell A1 results in 500 as a bonus.

If cell A1 contains a sales volume of 9000, the formula returns the result #N/A, since none of the conditions are
fulfilled. Of course, you could also set a condition for this scenario. Alternatively, you can specify instead the
default value which the formula generally returns if none of the conditions are fulfilled (see Example 2).
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Example 2:

You have the same initial situation as in example 1. At the end of the formula, use the condition TRUE to
specify a default value that appears if none of the conditions are fulfilled:

IFS(A1>50000, 2000, A1>25000, 1000, A1>10000, 500, TRUE, "check")

If, for example, cell A1 contains a sales volume of 9000 or -1000, the result is "check".

See also:

IF, SWITCH, VLOOKUP

IMABS (absolute value of a complex number)

Syntax:

IMABS(ComplexNumber)

Description:

This returns the absolute value (modulus) of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMABS("2+4i") returns 4.47214

See also:

COMPLEX, IMARGUMENT, IMEXP, IMCONJUGATE

IMAGINARY (imaginary coefficient of a complex number)

Syntax:

IMAGINARY(ComplexNumber)
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Description:

This returns the imaginary coefficient of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMAGINARY("2+4i") returns 4

See also:

COMPLEX, IMREAL

IMARGUMENT (angle of a complex number)

Syntax:

IMARGUMENT(ComplexNumber)

Description:

This returns the angle (in radians) from the real axis to the representation of a complex number in polar
coordinates.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMARGUMENT("2+4i") returns 1.10715

See also:

COMPLEX, IMABS, IMEXP, IMCONJUGATE
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IMCONJUGATE (conjugate a complex number)

Syntax:

IMCONJUGATE(ComplexNumber)

Description:

This returns the complex conjugate of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMCONJUGATE("2+4i") returns 2-4i

See also:

COMPLEX, IMABS, IMARGUMENT, IMEXP

IMCOS (cosine of a complex number)

Syntax:

IMCOS(ComplexNumber)

Description:

This returns the cosine of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMCOS("2+4i") returns -11.3642347064011 - 24.8146514856342i

See also:

COMPLEX, IMSIN
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IMDIV (division of complex numbers)

Syntax:

IMDIV(ComplexNumber1, ComplexNumber2)

Description:

This returns the quotient of two complex numbers, i.e., divides ComplexNumber1 by ComplexNumber2.

The arguments must be complex numbers in x+yi or x+yj format. Tip: Complex numbers can be created with
the COMPLEX function.

Example:

IMDIV("4+12i", "2+4i") returns 2.8+0.4i

See also:

COMPLEX, IMPRODUCT, IMSUB, IMSUM

IMEXP (exponential of a complex number)

Syntax:

IMEXP(ComplexNumber)

Description:

This returns the exponential of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMEXP("2+4i") returns -4.82980938326939 - 5.59205609364098i

See also:

COMPLEX, IMABS, IMARGUMENT, IMCONJUGATE, IMLN
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IMLN (natural logarithm of a complex number)

Syntax:

IMLN(ComplexNumber)

Description:

This returns the natural logarithm (base e) of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLN("2+4i") returns 1.497866136777 + 1.10714871779409i

See also:

COMPLEX, IMEXP, IMLOG10, IMLOG2

IMLOG10 (base-10 logarithm of a complex number)

Syntax:

IMLOG10(ComplexNumber)

Description:

This returns the base-10 logarithm of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLOG10("2+4i") returns 0.650514997831991 + 0.480828578784234i

See also:

COMPLEX, IMLN, IMLOG2
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IMLOG2 (base-2 logarithm of a complex number)

Syntax:

IMLOG2(ComplexNumber)

Description:

This returns the base-2 logarithm of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLOG2("2+4i") returns 2.16096404744368 + 1.59727796468811i

See also:

COMPLEX, IMLN, IMLOG10

IMNEG (negative value of a complex number)

Syntax:

IMNEG(ComplexNumber)

Description:

This returns the negative of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMNEG("2+4i") returns -2-4i
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Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Tip: As an alternative to IMNEG(A1), you can also use the following formula:

COMPLEX(-IMREAL(A1), -IMAGINARY(A1))

See also:

COMPLEX

IMPOWER (power of a complex number)

Syntax:

IMPOWER(ComplexNumber, Exponent)

Description:

This returns a supplied complex number raised to a given power.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMPOWER("2+4i", 2) returns -12+16i

See also:

COMPLEX, IMSQRT

IMPRODUCT (product of complex numbers)

Syntax:

IMPRODUCT(ComplexNum1 [, ComplexNum2, ComplexNum3 ...])
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Description:

Returns the product of the given complex numbers.

The arguments must be complex numbers in x+yi or x+yj format. Tip: Complex numbers can be created with
the COMPLEX function.

Example:

IMPRODUCT("2+4i", "1+2i") returns -6+8i

See also:

COMPLEX, IMDIV, IMSUB, IMSUM

IMREAL (real coefficient of a complex number)

Syntax:

IMREAL(ComplexNumber)

Description:

This returns the real coefficient of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMREAL("2+4i") returns 2

See also:

COMPLEX, IMAGINARY
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IMSIN (sine of a complex number)

Syntax:

IMSIN(ComplexNumber)

Description:

This returns the sine of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMSIN("2+4i") returns 24.8313058489464 - 11.3566127112182i

See also:

COMPLEX, IMCOS

IMSQRT (square root of a complex number)

Syntax:

IMSQRT(ComplexNumber)

Description:

This returns the square root of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMSQRT("2+4i") returns 1.79890743994787 + 1.11178594050284i

See also:

COMPLEX, IMPOWER
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IMSUB (difference of complex numbers)

Syntax:

IMSUB(ComplexNumber1, ComplexNumber2)

Description:

This returns the difference of two complex numbers, i.e., subtracts ComplexNumber2 from
ComplexNumber1.

The arguments must be complex numbers in x+yi or x+yj format. Tip: Complex numbers can be created with
the COMPLEX function.

Example:

IMSUB("2+4i", "1+2i") returns 1+2i

See also:

COMPLEX, IMDIV, IMPRODUKT, IMSUM

IMSUM (sum of complex numbers)

Syntax:

IMSUM(ComplexNum1 [, ComplexNum2, ComplexNum3 ...])

Description:

This returns the sum of the given complex numbers.

The arguments must be complex numbers in x+yi or x+yj format. Tip: Complex numbers can be created with
the COMPLEX function.

Example:

IMSUM("2+4i", "1+2i") returns 3+6i
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See also:

COMPLEX, IMDIV, IMPRODUKT, IMSUB

INDEX (cell in a particular row/column of a range)

Syntax:

INDEX(Range, Row, Column [, PartRange])

Description:

This returns a reference to the cell at the intersection of the specified Row and Column of the Range.

The desired cell range is to be specified for Range.

You use Row and Column to determine the row and column of the Range in which the cell to be returned is
located (starting from the top left corner of the Range).

If Row or Column refers to a cell outside the range, a #REF! error value is returned.

The optional argument PartRange is just a placeholder (for compatibility with Microsoft Excel). It can be
specified, but PlanMaker will not evaluate it.

Compatibility notes:

This function is not fully compatible with the Excel function of the same name. The following restrictions
apply:

The argument Range does not support multiple selections (nonadjacent ranges).

The argument PartRange is not evaluated.

Example:

INDEX(B2:D4, 2, 2) returns a reference to cell C3

See also:

MATCH, VLOOKUP, HLOOKUP, LOOKUP, AREAS, CHOOSE
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INDIRECT (create reference from text)

Syntax:

INDIRECT(Text [, Mode])

Description:

This returns a cell reference from the specified text.

For example, the specified Text can contain a fixed cell address (e.g., "C1") or variable references that are
combined from the contents of one or more cells.

The optional logical value Mode specifies the format of the given cell address:

TRUE or omitted: Normal cell address in A1 notation (columns are labeled alphabetically and rows
numerically)

FALSE: Cell address in the R1C1 notation (columns and rows are labeled numerically; an alternative type of
cell addressing supported only by Microsoft Excel)

Examples:

If cell C1 contains the text Flower
INDIRECT("C1") returns a reference to cell C1 and the result: Flower

If cell C1 contains the text E5
and cell E5 the text Flower
INDIRECT(C1) returns a reference to cell E5 and the result: Flower

If cell C1 contains the text E
and cell C2 the text 5
and cell E5 the text Flower
INDIRECT(C1&C2) returns a reference to cell E5 and the result: Flower

If cell E5 contains the text Flower
INDIRECT("E"&5") returns a reference to cell E5 and the result: Flower

If cell C1 contains the text 5
and E5 the text Flower
INDIRECT("E"&C1) returns a reference to cell E5 and the result: Flower

See also:

ADDRESS, OFFSET, COLUMN, ROW
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INT (round down to nearest integer)

Syntax:

INT(Number)

Description:

This rounds Number down to the nearest integer.

Note:

When applying this function to negative numbers, note the difference between this function and other rounding
functions such as ROUNDDOWN:

ROUNDDOWN(-1.234, 0) returns -1, because here the amount of the number is rounded down to the nearest
integer.

INT(-1.234) results in -2, since here the negative number itself is rounded down to the nearest integer.

Example:

INT(5.9) returns 5

INT(-5.1) returns -6

See also:

TRUNC, ROUNDDOWN, ROUNDUP, ROUND, MROUND, FIXED, EVEN, ODD, CEILING, FLOOR

INTERCEPT (intercept point of a regression line)

Syntax:

INTERCEPT(y_values, x_values)

Description:

This returns the y coordinate of the point where a best-fit line based on the given values intersects the y axis.

A best-fit line is the result of a linear regression. This is a statistical technique that adapts a line (called
"trendline" or "best-fit line") to a set of data points (for example, the results of a series of measurements).
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You can use the INTERCEPT function to predict what y (the dependent variable) will be approximately if x
(the independent variable) is zero.

This function can be used to predict, for example, the resistance of a temperature-dependent resistor at 0° after
having measured the resistance at several other temperatures.

For the arguments y_values and x_values, you usually specify a cell range.

y_values are the dependent variables (the resistance in the above example).

x_values are the independent variables (the temperature in the above example).

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Additional info:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-dependent resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures that were measured (the independent variables): 8, 20, 25, 28

Cells B1:B4 contain the resistances that were measured (the dependent variables): 261, 508, 608, 680

The resistance which will be delivered at 0°C can be estimated using the following formula:

INTERCEPT(B1:B4, A1:A4) returns 93.69817

At 0°, a resistance of 93.69817 (Ohm) would thus be expected.

Additional info:

INTERCEPT(y_values, x_values) equals FORECAST(0, y_values, x_values).

See also:

FORECAST, SKEW, SLOPE, STEYX, PEARSON

INTERSECTION (intersection of two ranges)

Syntax:

INTERSECTION(Range1, Range2)
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Description:

This returns a reference to the intersection of Range1 and Range2 (i.e. the cell range where Range1 and
Range2 overlap).

Additional info:

Alternatively, you can use the spacebar operator to obtain the intersection of two ranges. Example:

SUM(INTERSECTION(A1:D4, C3:E6))

is identical to:

SUM(A1:D4 C3:E6).

Compatibility notes:

This function does not exist in Microsoft Excel. When you save a document in Excel format, all occurrences of
this function will be automatically replaced by spacebar operators (see additional info above).

Example:

INTERSECTION(A1:D4, C3:E6) returns a reference to the range C3:D4

IPMT (interest payment)

Syntax:

IPMT(Rate, Per, NPer, PV [, FV] [, Type])

Description:

This returns the interest portion of the payment in the specified period, based on an investment with periodic
constant payments and a fixed interest rate.

You can use this function, for example, to calculate how large the interest portion of the annuity is in a
particular period for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period)

Per is the payment period to be considered.

NPer is the total number of payment periods.
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PV is the present value (initial amount)

FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly

Duration: 6 years

What is the interest portion of the payment (annuity) in month 32?

IPMT(10%/12, 32, 6*12, 100000) returns -534

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Thus, in the above formula, the annual interest rate was divided by 12 to get the monthly interest rate and the
number of payment periods was multiplied by 12.

Additional info:

The PPMT function is the counterpart to IPMT: It returns the principle component of the payment in this
period.

The PMT function, on the other hand, returns the total amount of the payment (annuity) per period, that is, the
sum of the principal portion and the interest portion.

See also:

PV, ISPMT, PPMT, CUMPRINC, CUMIPMT, PMT, RATE, FV, NPER

IRR (internal rate of return)

Syntax:

IRR(Values [, Guess])
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Description:

This returns an estimate of the internal rate of return for a series of cash flows. In contrast to the MIRR
function, no finance or reinvestment rates are taken into account.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, and income as positive values. The cash flows may vary in size, but they must occur at equal
time intervals (e.g., monthly or annually).

The function expects the following arguments:

For Values, you specify a cell range or array in which the cash flows were entered. There must be at least one
payment and one income.

Guess (optional) lets you specify an estimate for the result (see note below).

Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try specifying a different value for Guess.

See also:

MIRR, XIRR, RATE, NPV

ISBLANK (is empty?)

Syntax:

ISBLANK(Cell)

Description:

This returns TRUE if the given cell is empty.

Example:

If A1 contains any value and C7 is empty, the following applies:

ISBLANK(A1) returns FALSE

ISBLANK(C7) returns TRUE
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See also:

ISNA, IFEMPTY, COUNT, COUNTA

ISERR (is an error value other than #N/A?)

Syntax:

ISERR(Cell)

Description:

Unlike the ISERROR function, ISERR only returns TRUE if the given cell returns an error value other than
#N/A.

Example:

ISERR(A1) returns TRUE if A1 contains an error value other than #NA.

ISERR(A1) returns FALSE if A1 does not return an error or if the NA() function is entered there.

See also:

ISERROR, ISNA, NA(), ERRORTYPE, IFERROR, section Error values

ISERROR (is an error value?)

Syntax:

ISERROR(Cell)

Description:

This returns TRUE if the given cell contains any kind of error value.

Example:

ISERROR(A1) returns TRUE if A1 contains any kind of error value.
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See also:

ISERR, ISNA, NA(), ERRORTYPE, ISREF, IFERROR, section Error values

ISEVEN (is an even number?)

Syntax:

ISEVEN(Number)

Description:

This returns TRUE if the specified Number is even. Otherwise, FALSE is returned.

Note:

Number should be an integer. If this is not the case, PlanMaker automatically removes the decimal places and
checks if the remaining number is even.

Example:

ISEVEN(2) returns TRUE

ISEVEN(2.75) returns TRUE

ISEVEN(3) returns FALSE

ISEVEN(3.75) returns FALSE

See also:

ISODD

ISFORMULA (is a formula?)

Syntax:

ISFORMULA(Cell)
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Description:

This returns TRUE if the given cell contains a formula.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

If A1 contains a formula and C7 contains a fixed number or plain text, the following applies:

ISFORMULA(A1) returns TRUE

ISFORMULA(C7) returns FALSE

See also:

ISREF, FORMULATEXT

ISLOGICAL (is a logical value?)

Syntax:

ISLOGICAL(Cell)

Description:

This returns TRUE if the given cell contains a logical value (i.e., TRUE or FALSE).

Example:

If A1 contains TRUE and C7 contains a text string, the following applies:

ISLOGICAL(A1) returns TRUE

ISLOGICAL(C7) returns FALSE

See also:

ISTEXT, ISNUMBER, ISREF, ISNONTEXT
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ISNA (is not available?)

Syntax:

ISNA(Cell)

Description:

This returns TRUE if the given cell contains a #N/A error value.

Cells contain a #N/A error value if they contain the formula =NA() or a calculation resulting in a #N/A error.

For more information on the usage of #N/A error values, see the description of the NA (error value #N/A)
function.

Example:

The function NA() was entered in cell A1 to indicate that a value that is absolutely necessary for another
calculation is not yet available here.

Cell C7 performs a calculation with cell A1, for example, A1*2. Since cell A1 returns the error value #N/A,
however, the result of this calculation is also the error value #N/A.

Thus, the following applies:

ISNA(A1) returns TRUE

ISNA(C7) also returns TRUE

See also:

NA(), ERROR.TYPE, ISERR, ISERROR, IFERROR, IFNA, section Error values

ISNONTEXT (is no text?)

Syntax:

ISNONTEXT(Cell)

Description:

This returns TRUE if the given cell does not contain text.
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Example:

If A1 contains a fixed string or a calculation that returns a string, while C7 contains a number, the following
applies:

ISNONTEXT(A1) returns FALSE

ISNONTEXT(C7) returns TRUE

Additional info:

ISTEXT is the counterpart of this function: It returns TRUE if the cell contains a text string.

See also:

ISTEXT, ISLOGICAL, ISNUMBER

ISNUMBER (is numeric?)

Syntax:

ISNUMBER(Cell)

Description:

This returns TRUE if the given cell contains a number.

Dates are also considered as numbers, whereas logical values (TRUE and FALSE) are not.

Example:

If the cells A1 to A4 contain the values:

"Text", 42, 09/25/2018 and TRUE

Then the following applies:

ISNUMBER(A1) returns FALSE

ISNUMBER(A2) returns TRUE

ISNUMBER(A3) returns TRUE

ISNUMBER(A4) returns FALSE

See also:

ISNUMBERP, ISLOGICAL, ISTEXT, ISNONTEXT, ISREF, COUNT



681Formulas and functions

ISNUMBERP (PlanMaker 97 compatibility function)

Syntax:

ISNUMBERP(Cell)

Description:

This returns TRUE if the given cell contains a number or a logical value.

Dates are also considered as numbers.

Note:

This function was retained only for compatibility with PlanMaker 97. If possible, use the Excel-compatible
function ISNUMBER (without "P") instead of this function.

The difference:

ISNUMBERP treats logical values as numbers, whereas ISNUMBER does not.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

If the cells A1 to A4 contain the values:

"Text", 42, 09/25/2018 and TRUE

Then the following applies:

ISNUMBERP(A1) returns FALSE

ISNUMBERP(A2) returns TRUE

ISNUMBERP(A3) returns TRUE

ISNUMBERP(A4) returns TRUE (!)

For comparison: ISNUMBER(A4) returns FALSE

See also:

ISNUMBER
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ISODD (is an odd number?)

Syntax:

ISODD(Number)

Description:

This returns TRUE if the specified Number is odd. Otherwise, FALSE is returned.

Note:

Number should be an integer. If this is not the case, PlanMaker automatically removes the decimal places and
checks if the remaining number is odd.

Example:

ISODD(1) returns TRUE

ISODD(1.75) returns TRUE

ISODD(2) returns FALSE

ISODD(2.75) returns FALSE

See also:

ISEVEN

ISOWEEK (ISO week number)

Syntax:

ISOWEEK(Date [, ReturnYear])

Description:

This returns the ISO week number of a date (i.e. the week number according to the ISO 8601 standard).

Unlike the WEEKNUM function, this function does not use the calculation method commonly used in the USA
and many other parts of the world. On the contrary, it is based on the ISO standard 8601, which is binding in
Germany, Austria and Switzerland, among other countries. It specifies the following:
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1. Weeks always start on a Monday (not Sunday).

2. The first week of a year is defined as the week that includes January 4th.

Note:

This may lead to situations where December 29th, 30th and 31st are considered part of the first week of the
next year – or where January 1st, 2nd and 3rd are considered part of the last week of the previous year.

For this reason, the ISOWEEK function has an additional parameter named ReturnYear, which has the
following effect:

If set to 0 or omitted, the function returns the week number.

If set to 1, the function instead returns the year to which the date belongs (according to the ISO 8601 standard).
See examples below.

Example:

ISOWEEK("01/01/2020") returns 1.

ISOWEEK("01/01/2017") returns 52 (since this day was a Sunday).

ISOWEEK("01/01/2017", 1) accordingly returns 2016 – not 2017.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Tip: As an alternative to this function, you can use the Excel-compatible ISOWEEKNUM function. It returns
exactly the same results, but it does not have the optional parameter for displaying the year.

See also:

ISOWEEKNUM, WEEKNUM, YEAR, MONTH, DAY, WEEKDAY

ISOWEEKNUM (ISO week number)

Syntax:

ISOWEEKNUM(Date)

Description:

This returns the ISO week number of a date (i.e., the week number according to the ISO 8601 standard).
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Unlike the WEEKNUM function, this function does not use the calculation method commonly used in the USA
and many other parts of the world. On the contrary, it is based on the ISO standard 8601, which is binding in
Germany, Austria and Switzerland, among other countries. It specifies the following:

1. Weeks always start on a Monday (not Sunday).

2. The first week of a year is defined as the week that includes January 4th.

Note:

This may lead to situations where December 29th, 30th and 31st are considered part of the first week of the
next year – or where January 1st, 2nd and 3rd are considered part of the last week of the previous year. See
examples below.

Tip: For this reason, PlanMaker provides an alternative (not Excel-compatible) function called ISOWEEK. This
returns exactly the same results, but it can also return the year to which the date belongs (according to the ISO
8601 standard).

Example:

ISOWEEKNUM("01/01/2020") returns 1.

ISOWEEKNUM("01/01/2017") returns 52 (since this day was a Sunday).

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

ISOWEEK, WEEKNUM, YEAR, MONTH, DAY, WEEKDAY

ISPMT (interest payment)

Syntax:

ISPMT(Rate, Per, NPer, PV)

Description:

This returns the interest paid in the specified period for an investment with equal installments.

The function expects the following arguments:

Rate is the interest rate (per payment period)

Per is the payment period to be considered



685Formulas and functions

NPer is the total number of payment periods

PV is the present value (initial amount)

See also:

PPMT, PMT, IPMT

ISREF (is a valid reference?)

Syntax:

ISREF(Value)

Description:

This returns TRUE if the specified value is a valid cell reference.

Example:

ISREF(A1) returns TRUE

ISREF($A$1) returns TRUE

ISREF(A1:C7) returns TRUE

ISREF("any text") returns FALSE

ISREF(FirstQuarter) returns FALSE until you assign the name "FirstQuarter" to a cell range – from then on,
this calculation will also return TRUE.

See also:

ISFORMULA, ISERROR, ISLOGICAL, ISNUMBER, ISTEXT

ISTEXT (is text?)

Syntax:

ISTEXT(Cell)
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Description:

This returns TRUE if the given cell contains text.

Example:

If A1 contains a fixed string or a calculation that returns a string, while C7 contains a number, the following
applies:

ISTEXT(A1) returns TRUE

ISTEXT(C7) returns FALSE

Additional info:

ISNONTEXT is the counterpart of this function: It returns TRUE if there is no text string in the cell.

See also:

ISNONTEXT, ISLOGICAL, ISNUMBER, ISREF

KURT (kurtosis)

Syntax:

KURT(Number1, Number2, Number3, Number4 [, Number5 ...])

or

KURT(Range1 [, Range2, Range3 ...])

Description:

This returns the kurtosis of a probability distribution.

The kurtosis is a measure of the "peakedness" of a distribution compared to a normal distribution.

For a steeper curved ("narrow-peaked") distribution, the kurtosis is a positive value, while for a flatter curved
("broad-peaked") distribution, it is a negative value.

If the kurtosis approaches zero, the distribution has a good approximation to a normal distribution (see
NORM.DIST/NORMDIST function).

Number1, Number2, Number3, etc., are the values to be evaluated. Empty cells, text and logical values are
ignored.

At least four values have to be specified; otherwise, the function returns a #DIV/0! error value (division by
zero).
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Note:

This function does not accept value pairs (x value and y value) as arguments, but only the values of the
distribution. If the same values appear multiple times, they must be repeated in the argument list accordingly
(see example).

Example:

You measured the height of several test persons and obtained the following results: 1 x 1.60m, 2 x 1.65m, 4 x
1.70m, 2 x 1.75m and 1x1.80m.

To calculate the kurtosis of this distribution, the following formula can be used:

KURT(1.60, 1.65, 1.65, 1.70, 1.70, 1.70, 1.70, 1.75, 1.75, 1.80) returns 0.08036.

See also:

SKEW, NORM.DIST/NORMDIST

LARGE (k-th largest number)

Syntax:

LARGE(Range, k)

Description:

This returns the k-th largest value in a data set. If k=1, the largest value will be returned, if k=2, the second
largest value will be returned, etc.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k determines which number to return.

k must not be smaller than 1 or greater than the total number of values in Range. Otherwise, the function
returns a #NUM! error value.

Example:

If A1:A5 contains the values 4, 2, 6, 5 and 9, the following applies:

LARGE(A1:A5, 1) returns 9

LARGE(A1:A5, 2) returns 6

LARGE(A1:A5, 3) returns 5

etc.
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See also:

SMALL, MAX, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, RANK.EQ/RANK.AVG/RANK

LASTPRINTED (date last printed)

Syntax:

LASTPRINTED()

Description:

This returns the date on which the current document was last printed.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

LASTSAVED

LASTSAVED (date last saved)

Syntax:

LASTSAVED()

Description:

This returns the date on which the current document was last saved.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.
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See also:

LASTPRINTED

LCM (least common multiple)

Syntax:

LCM(Number1 [, Number2, Number3 ...])

Description:

This returns the LCM (least common multiple) of a set of numbers. The LCM is the smallest positive integer
that is a multiple of the arguments.

You can specify numbers or cell references as arguments.

All given values Number1, Number2
not the case, PlanMaker automatically truncates the decimal places.

Example:

LCM(5, 10, 15) returns 30

If A1:A3 contains the values 4, 8 and 6, the following applies:

LCM(A1:A3) returns 24

See also:

GCD

LEFT (left part of a text string)

Syntax:

LEFT(TextString [, n])

Description:

This returns the first n characters of a TextString.
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If n is omitted, the function only returns the first character.

Example:

LEFT("peanut", 3) returns pea

LEFT("peanut") returns p

See also:

RIGHT, MID, REPLACE, LEN

LEN (length)

Syntax:

LEN(Value)

Description:

This returns the number of characters in a text string.

If the specified value is a number, a date or a logical value, it will be converted to a string automatically.

Note: For dates, the serial date number is converted to a string and not the formatted date itself (see last
example).

Example:

LEN("Text") returns 4

LEN(42) returns 2

LEN(-42) returns 3

LEN(42.5) returns 4

LEN(42.50) also returns 4 (the superfluous zero is automatically removed!)

LEN(TRUE) returns 4

Please note when specifying dates: If cell A1 contains the date 09/25/2014 in any format, the following applies:

LEN(A1) returns 5

Reason: Date values are always stored as numbers in a spreadsheet – the date 09/25/2014, for example, as
41907. Thus, the result of the calculation is unexpected but completely correct – because:

LEN(41907) also returns 5
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See also:

LEFT, RIGHT, MID

LINEST (statistics of a linear regression)

Syntax:

LINEST(y_values [, x_values] [, Constant] [, Stats])

Description:

This returns statistics of a linear regression.

Linear regression is a statistical technique that adapts a line (called "trendline" or "best-fit line") to a set of data
points (for example, the results of a series of measurements).

The equation for this trendline is as follows:

y = m*x + b

The LINEST function calculates a trendline from the given y values and x values, and then returns an array in
the form {m,b}. The coefficient m is the slope of the trendline, and the constant b is the y-intercept point (the
point where the trendline intersects the y axis).

If there are several ranges with x values, the equation is as follows:

y = (m1*x1) + (m2*x2) + ... + (mn*xn) + b

In this case, LINEST returns an array in the form {mn , mn-1 , ... , m2 , m1 , b}.

If the optional argument Stats is used, several statistics of the regression (standard error, coefficient of
determination, etc.) are added to the resulting array.

The LINEST function expects the following arguments:

y_values: Here, you specify the existing y coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.

x_values: Here, you have the option of specifying the x coordinates, that is, the independent values. x_values
can also be either a cell reference or an array. If x_values are omitted, the function automatically uses the
values 1, 2, 3, ... (according to the number of existing y_values).

Constant (optional) is a logical value that lets you specify if the constant b (the y-intercept point) should be set
to zero:

TRUE or omitted: b is automatically calculated from the available data.

FALSE: b is set to zero. This forces the trendline to run through the zero point. The m coefficient(s) are
adjusted accordingly.
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Stats (optional) is a logical value that lets you specify if additional regression statistics should be returned:

FALSE or omitted: Do not return additional statistics.

TRUE: Return additional statistics. In this case, the function returns an array that not only includes m and b, but
also the following values:

{mn , mn-1 , ... , m2 , m1 , b ; smn , smn-1 , ... , sm2 , sm1 , sb ; R2 , sey ; F. df ; ssreg , ssresid}

A graphical representation of this array would look as follows:

The above abbreviations represent the following values:

Abbreviation Explanation

sm1, sm2, etc. Standard error for the coefficients m1, m2, etc.

sb Standard error for constant b

R2 Square of the Pearson product moment correlation coefficient

sey Standard error for y

F F statistic

df Degrees of freedom

ssreg Regression sum of squares

ssresid Residual sum of squares

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Additional info:

The linear regression is performed with this function using the least squares method.
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Example:

LINEST({4; 5; 6}) returns the matrix {1.3}. This indicates that the coefficient m equals 1 and the constant b
equals 3. (Since the x values were not specified, the LINEST function automatically uses the values 1, 2, 3, ...)

See also:

LOGEST, TREND, GROWTH

LN (natural logarithm)

Syntax:

LN(Number)

Description:

This returns the natural logarithm (base e) of Number.

Number must be > 0.

Example:

LN(0.7) returns -0.3567

LN(EXP(1.234)) returns 1.234

Additional info:

The inverse function is EXP

See also:

EXP, LOG, LOG10, POWER

LOG (logarithm)

Syntax:

LOG(Number [, Base])
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Description:

This returns the logarithm of Number to the specified base.

Number must be > 0.

If Base is omitted, base 10 is used.

Example:

LOG(100) equals log10 (100) and returns 2

LOG(10 ^ 0.1234) returns 0.1234

LOG(8, 2) equals log2 (8) and returns 3

See also:

LOG10, LN, EXP, POWER

LOG10 (base-10 logarithm)

Syntax:

LOG10(Number)

Description:

This returns the base-10 logarithm of Number.

Number must be > 0.

Example:

LOG10(100) returns 2

LOG10(10 ^ 0.1234) returns 0.1234

See also:

LOG, LN, EXP
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LOGEST (statistics of an exponential regression)

Syntax:

LOGEST(y_values [, x_values] [, Constant] [, Stats])

Description:

This returns statistics of an exponential regression.

Exponential regression is a statistical technique that adapts an exponential curve to a set of data points (for
example, the results of a series of measurements).

The equation for this exponential curve is as follows:

y = b*m^x

If more than one range of x values is given, the equation is:

y = b * (m1^x1) * (m2^x2) * ... * (mn^xn)

The LOGEST function calculates this exponential line from the given y values and x values, and then returns an
array in the form {mn , mn-1 , ... , m2 , m1 , b}.

If the optional argument Stats is used, several statistics of the regression (standard error, coefficient of
determination, etc.) are added to the resulting array.

The LOGEST function expects the following arguments:

y_values: Here, you specify the existing y coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.

x_values: Here, you have the option of specifying the x coordinates, that is, the independent values. x_values
also can be either a cell reference or an array. If x_values are omitted, the function automatically uses the
values 1, 2, 3, ... (according to the number of existing y_values).

Constant (optional) is a logical value that lets you specify if the constant b should be set to 1 (one):

TRUE or omitted: b is automatically calculated from the available data.

FALSE: b is forced to equal 1 (one). The m coefficients are adjusted accordingly.

Stats (optional) is a logical value that lets you specify if additional regression statistics should be returned:

FALSE or omitted: Do not return additional statistics.

TRUE: Return additional statistics. In this case, the function returns an array that not only includes m and b, but
also the following values:

{mn , mn-1 , ... , m2 , m1 , b ; smn , smn-1 , ... , sm2 , sm1 , sb ; R2 , sey ; F. df ; ssreg , ssresid}

A graphical representation of this array would look as follows:
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The above abbreviations represent the following values:

Abbreviation Explanation

sm1, sm2, etc. Standard error for the coefficients m1, m2, etc.

sb Standard error for constant b

R2 Square of the Pearson product moment correlation coefficient

sey Standard error for y

F F statistic

df Degrees of freedom

ssreg Regression sum of squares

ssresid Residual sum of squares

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

See also:

LINEST, TREND, GROWTH

LOGINV (percentiles of the log-normal distribution)

Note: LOGINV is supplemented by the new identical function LOGNORM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).
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Syntax:

LOGINV(Probability, Mean, StdDev)

Description:

This returns the inverse of the log-normal distribution function (i.e., percentiles of this distribution).

Probability is the given probability from the log-normal distribution. The values must be within the range 0 to
1.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). This must be > 0.

See also:

LOGNORM.INV, LN, LOGNORM.DIST/LOGNORMDIST, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST

LOGNORMDIST (log-normal distribution)

Note: LOGNORMDIST is supplemented by the new function LOGNORM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

LOGNORMDIST(x, Mean, StdDev)

Description:

This returns the probabilities of a cumulative log-normally distributed random number.

You can use this function to view probability distributions in which the natural logarithm is normally
distributed rather than the random variable itself.

x is the value to be evaluated. x must be > 0.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). It must be > 0.

See also:

LOGNORM.DIST, LN, LOGNORM.INV/LOGINV, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST
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LOGNORM.DIST (log-normal distribution)

Syntax:

LOGNORM.DIST(x, Mean, StdDev, Cumulative)

Description:

This returns the probabilities of a (cumulative) log-normally distributed random number.

You can use this function to view probability distributions in which the natural logarithm is normally
distributed rather than the random variable itself.

x is the value to be evaluated. x must be > 0.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). StdDev must be > 0.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative normal
distribution function is calculated. By entering the value FALSE, the normal probability density function is
calculated.

Note:

The LOGNORM.DIST function supplements the previous LOGNORMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

The inverse function is LOGNORM.INV

See also:

LOGNORMDIST, LN, LOGNORM.INV/LOGINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST
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LOGNORM.INV (percentiles of the log-normal distribution)

Syntax:

LOGNORM.INV(Probability, Mean, StdDev)

Description:

This returns the inverse of the log-normal distribution function (i.e., percentiles of this distribution).

Probability is the given probability from the log-normal distribution. The values must be within the range 0 to
1.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). This must be > 0.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

LOGNORM.INV is the inverse function of LOGNORM.DIST

See also:

LOGINV, LN, LOGNORM.DIST/LOGNORMDIST, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST

LOOKUP (search cell range)

Annotation:

The LOOKUP function searches a cell range for a search criterion (for example, a number or a text string) and
then returns the contents of another cell with the corresponding position.

Important: The data to be searched must be available in sorted order. Tip: There are two alternatives to this
function that can also search unsorted data and are more flexible in general: VLOOKUP and HLOOKUP

The LOOKUP function can be used in two different ways:
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Usage with two one-dimensional ranges: Here, two vectors (i.e., one-dimensional ranges) are specified for
the function: Lookup Vector and ResultVector. If the function finds the search criterion in the Lookup Vector,
it returns the cell with the same position in the Result Vector as the result.

Usage with one two-dimensional range: Here, a two-dimensional range is specified for the function. If it finds
the search criterion in the first row (or column) of this range, it returns the cell with the same position in the last
row (or column) of this range as the result.

Usage with two one-dimensional ranges

Syntax:

LOOKUP(Crit, LookupVector, ResultVector)

Description:

This variant of LOOKUP scans LookupVector for the specified value in Crit. If found, the function returns the
content of the cell located in the same row (or column) of the ResultVector.

Crit is the value for which the search is performed. The search is case-insensitive.

LookupVector is the cell range or array to be evaluated. This can contain text strings, numbers or logical
values. It must be a vector, which means that LookupVector is a range of either only one row or one column.

Important: The data in LookupVector must be sorted in ascending order. Otherwise, this function may return
incorrect results. If the values are not sorted, use VLOOKUP or HLOOKUP instead of LOOKUP.

ResultVector is the cell range or array from which the result of the function is to be returned. It also has to be a
vector. In addition, its size and orientation (horizontal or vertical) must be identical to LookupVector.

Note:

If LOOKUP does not find a value that exactly matches Crit, the next smaller value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the
#N/A error value.

Example:

In the following table ...

... LOOKUP returns the following results:
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LOOKUP(1, A1:A3, B1:B3) returns Result_1

LOOKUP(2, A1:A3, B1:B3) returns Result_2

LOOKUP(3, A1:A3, B1:B3) returns Result_3

LOOKUP(2.5, A1:A3, B1:B3) returns Result_2 (because it is the next smallest value)

LOOKUP(10, A1:A3, B1:B3) returns Result_3 (because it is the next smallest value)

LOOKUP(0, A1:A3, B1:B3) returns #N/A

See also:

VLOOKUP, HLOOKUP, INDEX, MATCH

Usage with one two-dimensional range

Syntax:

LOOKUP(Crit, Range)

Description:

This variant of LOOKUP scans the first column (or row) of Range for the specified value in Crit. If found, the
function returns the content of the cell located in the same row in the last column of Range.

Alternatively, this function can also search the range column by column. The search direction is determined by
the dimensions of Range:

If Range contains more columns than rows, the function searches the first row and returns the value from the
last row.

If Range contains more rows than columns or is square, the function searches the first column and returns the
value from the last column.

Crit is the value for which the search is performed. The search is case-insensitive.

Range is the cell range or array on which the search is to be performed. In the first row (or column), it must
contain the values for which the search is performed and, in the last row (or column), the results to be returned.
These can be text strings, numbers or logical values. The range must be two-dimensional, that is, it must have at
least two rows and two columns.

Important: The scanned data in the first row (or column) must be sorted in ascending order. Otherwise, this
function may return incorrect results. If the values are not sorted, use VLOOKUP or HLOOKUP instead of
LOOKUP.

Note:

If LOOKUP does not find a value that exactly matches Crit, the next smaller value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the
#N/A error value.
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Example:

In the following table ...

... LOOKUP returns the following results:

LOOKUP(1, A1:B3) returns Result_1

LOOKUP(2, A1:B3) returns Result_2

LOOKUP(3, A1:B3) returns Result_3

LOOKUP(2.5, A1:B3) returns Result_2 (because it is the next smallest value)

LOOKUP(10, A1:B3) returns Result_3 (because it is the next smallest value)

LOOKUP(0, A1:B3) returns #N/A

See also:

VLOOKUP, HLOOKUP, INDEX, MATCH

LOWER (convert text to lowercase)

Syntax:

LOWER(Text string)

Description:

This converts all characters in a text string to lowercase letters.

Example:

LOWER("PlanMaker") returns planmaker

See also:

UPPER, PROPER
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MATCH (relative position in a range)

Syntax:

MATCH(Crit, Vector [, Mode])

Description:

This returns the relative position of Crit in Vector. If, for example, Crit is the fifth element of Vector, the
function returns 5.

Crit is the value for which the search is performed. This can be any kind of value or a cell reference.

Vector is the cell range or array to be evaluated. This can contain either text strings, numbers or logical values.
Vector must be a vector, which is an array or a cell range of either only one row or one column.

Mode specifies the type of search to be performed:

1 or omitted: Find the largest value that is equal to or smaller than Crit. Important: In this mode, the elements
in Vector have to be sorted in ascending order. Otherwise, the function may return incorrect results.

0: Find the first value that is equal to Crit. In this mode, the elements in Vector do not have to be in sorted
order.

-1: Find the smallest value that is equal to or larger than Crit. Important: In this mode, the elements in Vector
have to be sorted in descending order. Otherwise, the function may return incorrect results.

Tip: If you use Mode 0 and you search for a text string, wildcard characters can be used in Crit: A question
mark (?) stands for any single character, and an asterisk (*) stands for any sequence of characters.

Example:

MATCH("b", {"a";"b";"c";"d"}, 0) returns 2 because "b" is the second element of the given vector.

See also:

INDEX, LOOKUP, VLOOKUP, HLOOKUP

MAX (maximum)

Syntax:

MAX(Number1 [, Number2, Number3 ...])
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Description:

This returns the largest value within the given numbers.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

MAX(5, 7, 4, 9) returns 9

If the cells A1:A3 contain the values -1, -2 and TRUE, the following applies:

MAX(A1:A3) returns -1 (the logical value TRUE is ignored)

MAX(A1:A3, TRUE) returns 1 (the entered value TRUE is evaluated as 1)

MAX(A1:A3, FALSE) returns 0 (the entered value FALSE is evaluated as 0)

See also:

MAXA, MIN, LARGE

MAXA (maximum)

Syntax:

MAXA(Number1 [, Number2, Number3 ...])

Description:

The MAXA function is almost identical to the MAX function (see note). Thus, it returns the largest value
within the given numbers.

Number1, Number2, etc., are the values to be evaluated.

Note:

Unlike MAX, MAXA also evaluates logical values and text: FALSE is evaluated as 0, while TRUE is evaluated
as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.
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Example:

MAXA(5, 7, 4, 9) returns 9

If the cells A1:A3 contain the values -1, -2 and TRUE, the following applies:

MAXA(A1:A3) returns 1 (since TRUE = 1)

MAX(A1:A3), on the other hand, results in -1 (because the logical value TRUE is ignored in the MAX
function)

See also:

MAX

MAXIFS (conditional maximum)

Syntax:

MAXIFS(MaxRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This function determines the largest value in a range that is evaluated according to one or more conditions.

MaxRange is the value range whose largest value is to be determined.

Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as MaxRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included.

Range2, Criterion2, etc., (optional) are further cell ranges that can be checked for a condition.

Note:

The search criterion can be a number, a text string or an expression, for example, "42", "screws", "03/12/2020",
"TRUE", ">10" and should always be enclosed within double quotation marks (").

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

Example:

You have the following table with people of different ages:
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MAXIFS(B2:B8, C2:C8, "M") returns 53 for the oldest man.

MAXIFS(B2:B8, C2:C8, "F", D2:D8, "Miami") returns 42 for the oldest woman from Miami.

MAXIFS(B2:B8, B2:B8, "<30") returns 27 for the oldest person under 30.

See also:

MINIFS, MAX, SUMIFS, AVERAGEIFS

MDETERM (matrix determinant)

Syntax:

MDETERM(Array)

Description:

This returns the determinant of a square matrix.

Array is a cell range or array containing the matrix to be evaluated. It must contain numeric values only and be
square, i.e., have the same number of rows and columns.

Example:

MDETERM({9,8,8; 2,4,6; 1,2,1}) returns -40

See also:

Section Working with arrays, MINVERSE, MMULT, MSOLVE, TRANSPOSE
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MEDIAN (Median)

Syntax:

MEDIAN(Number1 [, Number2, Number3 ...])

Description:

This returns the median of the given set of numbers.

The median is the number in the middle of a set of numbers. Half of the numbers are smaller than the median,
while the other half are larger.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Note:

If the total number of values is odd, MEDIAN returns the number in the middle of the set of numbers.

If the total number of values is even, MEDIAN returns the average of the two numbers in the middle (see
second example).

Example:

MEDIAN(1, 2, 3, 4, 5) returns 3

MEDIAN(1, 2, 3, 4, 5, 1000) returns 3.5

See also:

AVERAGE, MODE.SNGL/MODE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE

MID (part of a text string)

Syntax:

MID(TextString, Start, Count)

Description:

This returns a part of a TextString.
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The section starts at Start and is Count characters long.

Example:

MID("peanut", 2, 3) returns ean

MID("peanut", 2, 5) returns eanut

MID("peanut", 2, 100) also returns eanut

MID("peanut", 100, 100) returns an empty text string

See also:

LEFT, RIGHT, REPLACE, FIND, SEARCH, LEN

MILLISECONDS (milliseconds)

Syntax:

MILLISECONDS(Time)

Description:

This returns the milliseconds of a time value.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Example:

MILLISECONDS("12:34:56.555") returns 555

MILLISECONDS("09/25/2018 12:34:56.555") returns 555

If cell A1 contains a date with the time 12:34:56,555, then MILLISECONDS(A1) returns 555

See also:

HOUR, MINUTE, SECOND
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MIN (minimum)

Syntax:

MIN(Number1 [, Number2, Number3 ...])

Description:

This returns the smallest value within the given numbers.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated.

If this function refers to empty cells, they are ignored. Likewise, cells that contain text strings or logical values,
but these can be entered directly into the list of arguments and thus taken into account.

Example:

MIN(5, 7, 4, 9) returns 4

If the cells A1:A3 contain the values 5, 2 and TRUE, the following applies:

MIN(A1:A3) returns 2 (the logical value TRUE is ignored)

MIN(A1:A3, TRUE) returns 1 (the entered value TRUE is evaluated as 1)

MIN(A1:A3, FALSE) returns 0 (the entered value FALSE is evaluated as 0)

See also:

MINA, MAX, SMALL

MINA (minimum)

Syntax:

MINA(Number1 [, Number2, Number3 ...])

Description:

The MINA function is almost identical to the MIN function (see note). It thus returns the smallest value within
the given numbers.

Number1, Number2, etc., are the values to be evaluated.
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Note:

Unlike MIN, MINA also evaluates logical values and text: FALSE is evaluated as 0, while TRUE is evaluated
as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Example:

MINA(5, 7, 4, 9) returns 4

If the cells A1:A3 contain the values 5, 2 and TRUE, the following applies:

MINA(A1:A3) returns 1 (since TRUE = 1)

MIN(A1:A3), on the other hand, results in 2 (because the logical value TRUE is ignored in the MIN function)

See also:

MIN

MINIFS (conditional minimum)

Syntax:

MINIFS(MinRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This function determines the smallest value in a range that is evaluated according to one or more conditions.

MinRange is the value range whose smallest value is to be determined.

Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as MinRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included.

Range2, Criterion2, etc., (optional) are further cell ranges that can be checked for a condition.

Note:

The search criterion can be a number, a text string or an expression, for example, "42", "screws", "03/12/2020",
"TRUE", ">10" and should always be enclosed within double quotation marks (").
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Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

Example:

You have the following table with people of different ages:

MINIFS(B2:B8, C2:C8, "M") returns 27 for the youngest man.

MINIFS(B2:B8, C2:C8, "F", D2:D8, "Miami") returns 26 for the youngest woman from Miami.

MINIFS(B2:B8, B2:B8, ">30") returns 42 for the youngest person over 30.

See also:

MAXIFS, MIN, SUMIFS, AVERAGEIFS

MINUTE (minute)

Syntax:

MINUTE(Time)

Description:

This returns the minutes of a time value.

Example:

MINUTE("12:34:56 AM") returns 34

MINUTE("09/25/2018 10:30:56 AM") returns 30
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If cell A1 contains a date with the time 10:30:56, then MINUTE(A1) returns 30

See also:

HOUR, SECOND, MILLISECONDS

MINVERSE (inverse matrix)

Syntax:

MINVERSE(Array)

Description:

This returns the inverse of a square matrix.

The inverse A-1 of matrix A is the matrix by which A must be multiplied to obtain the identity matrix 1.

Array is a cell range or array containing the matrix to be evaluated. It must contain numeric values only and be
square, i.e., have the same number of rows and columns.

Additional info:

Matrices whose determinant is zero (singular matrices) cannot be inverted. In this case, the MINVERSE
function returns a #NUM! error value.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

MINVERSE({9,8,8;2,4,6;1,2,1}) returns:

{0.2,-0.2,-0.4;-0.1,-0.025,0.95;0,0.25,-0.5}

See also:

Section Working with arrays, MDETERM, MMULT, MSOLVE, TRANSPOSE
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MIRR (modified internal rate of return)

Syntax:

MIRR(Values, FinanceRate, ReinvestRate)

Description:

This returns the modified internal rate of return for a series of cash flows. Unlike the IRR function, MIRR
considers the finance rate (for investments) and the reinvest rate (for reinvestments).

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, and income as positive values. The cash flows may vary in size, but they must occur at equal
time intervals (e.g., monthly or annually).

The function expects the following arguments:

For Values, you specify a cell range or array in which the cash flows were entered. There must be at least one
payment and one income.

FinanceRate is the interest rate paid for investments.

ReinvestRate is the interest rate received for reinvestments.

See also:

IRR, NPV, XIRR, RATE

MMULT (product of matrices)

Syntax:

MMULT(Array1, Array2)

Description:

This returns the product of two matrices.

Array1 and Array2 are cell ranges or arrays that contain the matrices to be evaluated. They must contain
numeric values only.

Please note: The number of columns in Array1 must equal the number of rows in Array2, as multiplication is
not possible otherwise.
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Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

MMULT({1,2;3,4}, {5,6;7,8}) returns {19,22;43,50}

See also:

Section Working with arrays, MDETERM, MINVERSE, MSOLVE, TRANSPOSE

MOD (remainder of a division, Excel method)

Syntax:

MOD(x, y)

Description:

This returns the remainder of the division of x by y according to the "Excel method".

Important: This function returns incorrect results in some cases (see additional info below)!

Example:

MOD(5, 3) returns 2

MOD(5, 0) returns the #DIV/0! error value

MOD(5, -3) returns -1 (which is incorrect – see additional info below!)

Additional info:

Microsoft Excel returns incorrect results when you use the MOD function with a negative numerator or
denominator.

PlanMaker also returns incorrect results in this case (for compatibility reasons), but it offers an additional
function named MODP that returns correct results.

The following table shows the differences between MOD and MODP (the results highlighted in green color are
incorrect):
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Compatibility notes:

Note: The MODP function is not supported by Microsoft Excel. If you save a document in Excel format, all
calculations that use this function will be replaced by their last result as a fixed value.

See also:

MODP, QUOTIENT

MODE (most frequently occurring value)

Note: MODE is supplemented by the new identical function MODE.SNGL, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

MODE(Number1 [, Number2, Number3 ...])

Description:

This returns the mode of a data set.

The mode is the value that occurs most frequently in a set of numbers.

Number1, Number2, etc., are the numbers to be evaluated.

If the given numbers contain more than one mode, their smallest mode will be returned.

If the given numbers do not contain any value occurring more than once, a #N/A error value will be returned.

Example:

MODE(1, 2, 4, 4, 4, 2, 1) returns 4

MODE(1, 2, 4, 4, 2, 1) returns 1 (if there are multiple modes, the smallest one is returned)
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MODE(1, 4, 2) returns #N/A because no value occurs more than once.

See also:

MODE.SNGL, MEDIAN, NORM.DIST/NORMDIST

MODE.SNGL (most frequently occurring value)

Syntax:

MODE.SNGL(Number1 [, Number2, Number3 ...])

Description:

This returns the mode of a data set.

The mode is the value that occurs most frequently in a set of numbers.

Number1, Number2, etc., are the numbers to be evaluated.

If the given numbers contain more than one mode, their smallest mode will be returned.

If the given numbers do not contain any value occurring more than once, a #N/A error value will be returned.

Example:

MODE.SNGL(1, 2, 4, 4, 4, 2, 1) returns 4

MODE.SNGL(1, 2, 4, 4, 2, 1) returns 1 (if there are multiple modes, the smallest one is returned)

MODE.SNGL(1, 4, 2) returns #N/A because no value occurs more than once.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

MODE, MEDIAN, NORM.DIST/NORMDIST
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MODP (remainder of a division, PlanMaker method)

Syntax:

MODP(x, y)

Description:

This returns the remainder of the division of x by y according to the "PlanMaker method" (see additional info
below).

Example:

MODP(5, 3) returns 2

MODP(5, 0) returns the #DIV/0! error value

MODP(5, -3) returns 2 (see additional info below)

Additional info:

Microsoft Excel returns incorrect results when you use the MOD function with a negative numerator or
denominator.

If you want to obtain correct results, you should use the RESTP function described here instead of REST.

The following table shows the differences between MOD and MODP (the results highlighted in green color are
incorrect):

Compatibility notes:

Note: The MODP function is not supported by Microsoft Excel. If you save a document in Excel format, all
calculations that use this function will be replaced by their last result as a fixed value.
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See also:

MOD, QUOTIENT

MONTH (month of a date)

Syntax:

MONTH(Date)

Description:

This returns the month of a date.

Example:

MONTH("09/25/2018") returns 9

MONTH("August 17") returns 8

If cell A1 contains the date value 9/25/2018 then MONTH(A1) returns 9

See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, YEAR, DAY, WEEKDAY

MROUND (round to a multiple of base)

Syntax:

MROUND(Number, Base)

Description:

This rounds Number to the nearest multiple of Base.

Base must be > 0.

If the remainder of the division of Number by Base is smaller than half the value of Base, MROUND rounds
down. If it is greater than or equal to half the value of Base, MROUND rounds up (see examples below).
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Example:

MROUND(1234.5678, 1) returns 1235

MROUND(1234.5678, 0.01) returns 1234.57

MROUND(22, 5) returns 20

MROUND(23, 5) returns 25

MROUND(22.5, 5) returns 25

See also:

FLOOR, CEILING, ROUNDDOWN, ROUNDUP, ROUND, TRUNC, INT

MSOLVE (solution of matrix equation Ax=B)

Syntax:

MSOLVE(ArrayA, VectorB)

Description:

This returns the solution to a linear system of equations by solving the matrix equation Ax=B.

ArrayA is the cell range or array that contains matrix A. It must contain numeric values only and be square,
i.e., have the same number of rows and columns.

The determinant of this matrix must not be zero, as the equation cannot be solved otherwise.

VectorB is the cell range or array that contains vector B. VectorB must be a vector, which is an array or cell
range of just one column.

The result of this function is a solution vector.

Please note: The MSOLVE function only calculates correctly if the vector with the solutions is arranged as a
column. To arrange the vector with the solutions in a row, you must also use the TRANSPOSE function with
the following syntax:

TRANSPOSE(MSOLVE(ArrayA, VectorB))

Additional info:

The result of this function is calculated using singular value decomposition. When applied to larger matrices
(more than 10-20 rows), significant rounding errors may occur.
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Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

To solve the following linear system of equations:

2x + 3y = 4
2x + 2y = 8

... use the following formula:

MSOLVE({2,3;2,2}, {4,8})

This results in the vector {8;-4}, which means that x=8 and y=-4.

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

Section Working with arrays, MDETERM, MINVERSE, MMULT, TRANSPOSE

MULTINOMIAL (multinomial coefficient)

Syntax:

MULTINOMIAL(Number1 [, Number2, Number3 ...])

Description:

This returns the multinomial coefficient ("polynomial coefficient") of a set of numbers.

All given values Number1, Number2

Example:

MULTINOMIAL(1, 2, 3, 4, 5) returns 37837800

Note:

The MULTINOMIAL and POLYNOMIAL functions are completely identical.
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See also:

POLYNOMIAL, FACT

N (convert value into number)

Syntax:

N(Value)

Description:

This converts a value into a number.

The specified value must be a number, a date value or a logical value, otherwise N returns zero.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert values into numbers if
necessary.

Example:

N("Text") returns 0

N("42") returns 0

N(42) returns 42

N(TRUE) returns 1

If cell A1 contains the date 09/25/2014, the following applies:

N(A1) returns 41907 (the serial number of that date)

See also:

T, VALUE, TEXT
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NA (error value #N/A)

Syntax:

NA()

Description:

This returns the error value #N/A ("not available").

Entering =NA() in a cell indicates that the value in this cell is currently not available. Use this function in a cell
that is empty but which must be filled later in order to obtain correct results in calculations performed with this
cell. As a result, all calculations that refer to this cell will also return a #N/A error value (instead of an incorrect
result).

In this way, you can prevent calculations from being performed with empty cells, although these cells would
have to be filled with values for a correct result to be returned.

Additional info:

Instead of entering =NA() in a cell, you can also type #N/A, which will lead to the same result.

Example:

You would like to calculate your annual sales using the sum of the four quarterly results. These are entered in
cells A1 to A4; the annual sales could thus be calculated using the formula SUM(A1:A4).

There is only one problem: The result for the fourth quarter is not yet available, so cell A4 is empty. Thus, the
annual sales may not yet be calculated.

However, PlanMaker persists in calculating the sum from A1 to A4 – even if one of the values is missing. The
result: an apparently miserable annual result and irate shareholders.

It is much better practice to enter NA() in cell A4 rather than leave it empty. This marks the cell as "not
available". This means that the SUM formula no longer has an incorrect numerical value as a result, but the
error value #N/A. This indicates that one of the quarterly results is not yet available, i.e., the annual sales
cannot yet be calculated. Result: No irate shareholders.

See also:

ISNA, ISERR, ISERROR, ERRORTYPE, section Error values
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NEG (negative value)

Syntax:

NEG(Number)

Description:

This inverts the sign of a Number.

Example:

NEG(42) returns -42

NEG(-42) returns 42

NEG(0) returns 0

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Instead of using NEG, you can simply multiply the value by -1: NEG(x) equals (-1) * x.

See also:

ABS, SIGN

NEGBINOM.DIST (negative binomial distribution)

Syntax:

NEGBINOM.DIST(k, r, p, Cumulative)

Description:

This returns the negative binomial distribution (also known as Pascal distribution).

The negative binomial distribution can be used to calculate the probability of obtaining k failures before the r-
th success in a random experiment with independent trials and only two possible outcomes (success or failure)
with a fixed probability of p for each trial.
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k 

r 

k and r should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

p is the probability of success for each trial run. It must be within the range 0 to 1.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the negative binomial distribution is calculated. By entering the value FALSE, the
probability density function of the negative binomial distribution is calculated.

Example:

An urn contains 1 red ball and 5 black balls. What is the probability (with the balls being returned) of drawing
exactly or at most 10 black balls (failures) before the 2nd red ball (success) is drawn?

NEGBINOM.DIST(10, 2, 1/6, FALSE) returns 0.04935

NEGBINOM.DIST(10, 2, 1/6, TRUE) returns 0.61867

The probability of having to draw exactly 10 black balls is 4.9% (probability density function). The probability
of having to draw at most 10 black balls is 61.9% (cumulative distribution function).

Note:

The NEGBINOM.DIST function supplements the previous NEGBINOMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

NEGBINOMDIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, HYPGEOM.DIST/HYPGEOMDIST

NEGBINOMDIST (negative binomial distribution)

Note: NEGBINOMDIST is supplemented by the new function NEGBINOM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

NEGBINOMDIST(k, r, p)
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Description:

This returns the negative binomial distribution (also known as Pascal distribution).

The negative binomial distribution can be used to calculate the probability of obtaining k failures before the r-
th success in a random experiment with independent trials and only two possible outcomes (success or failure)
with a fixed probability of p for each trial.

k 

r 

k and r should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

p is the probability of success for each trial run. It must be within the range 0 to 1.

Example:

An urn contains 1 red ball and 5 black balls. What is the probability (with the balls being returned) of drawing
exactly 10 black balls (failures) before the 2nd red ball (success) is drawn?

NEGBINOMDIST(10, 2, 1/6) returns 0.04935.

See also:

NEGBINOM.DIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, HYPGEOM.DIST/HYPGEOMDIST

NETWORKDAYS (number of workdays)

Syntax:

NETWORKDAYS(StartDate, EndDate [, Holidays])

Description:

This returns the number of workdays between StartDate and EndDate.

This function counts workdays only, and Saturdays and Sundays are skipped. You also have the option of
specifying a list of holidays to be skipped as well (see Holidays parameter).

StartDate and EndDate are the first and the last day of the time interval to be evaluated.

Holidays (optional) is a cell range or an array containing a list of dates to be skipped (e.g., holidays).

Example:

NETWORKDAYS("01/01/2010", "01/31/2010") returns 22.
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January 2010 thus had 22 work days (not including public holidays).

If you want to include the holidays on 1/1/2010 and 1/6/2010 (in most European countries), you can enter these
two dates in cells A1 and A2, for example, and then write them as follows:

NETWORKDAYS("01/01/2010, "01/31/2010", A1:A2)

The result is 20, as these holidays both fell on weekdays in 2010, so 2 days are to be deducted.

See also:

WORKDAY, DAYS/DAYSP, DAYS360, DATEDIF, HOLIDAY

NOMINAL (nominal interest rate)

Syntax:

NOMINAL(EffRate, NPerYear)

Description:

This returns the nominal annual interest rate based on the effective annual interest rate and the number of
compounding periods per year.

EffRate is the effective annual interest rate.

NPerYear is the number of compounding periods per year (must be at least 1).

Example:

An investment with an effective annual interest rate of 5% is compounded quarterly. How high is the nominal
annual interest rate?

NOMINAL(5%, 4) returns approx. 4.91%

See also:

EFFECT

NORMDIST (normal distribution)

Note: NORMDIST is supplemented by the new identical function NORM.DIST, which is available in newer
versions of Microsoft Excel (2010 or later).
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Syntax:

NORMDIST(x, Mean, StdDev, Cumulative)

Description:

This returns the normal distribution (also known as Gaussian distribution).

The normal distribution is one of the most important distributions in statistics, since many random variables are
normally distributed or are at least approximately normally distributed.

x is the value to be evaluated.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x).

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

     

Left: density function ("bell curve"), right: distribution function

Additional info:

The reverse function to this function is NORMINV

See also:

NORM.DIST, NORM.INV/NORMINV, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORM.DIST (normal distribution)

Syntax:

NORM.DIST(x, Mean, StdDev, Cumulative)
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Description:

This returns the normal distribution (also known as Gaussian distribution).

The normal distribution is one of the most important distributions in statistics, since many random variables are
normally distributed or are at least approximately normally distributed.

x is the value to be evaluated.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x).

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

     

Left: density function ("bell curve"), right: distribution function

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

The reverse function to this function is NORM.INV

See also:

NORMDIST, NORM.INV/NORMINV, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORMINV (percentiles of the normal distribution)

Note: NORMINV is supplemented by the new identical function NORM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).
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Syntax:

NORMINV(Probability, Mean, StdDev)

Description:

This returns the inverse of the normal cumulative distribution function NORMDIST.

Probability is the given probability from the distribution. The values must be within the range 0 to 1.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution. This must be > 0.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

NORM.INV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORM.INV (percentiles of the normal distribution)

Syntax:

NORM.INV(Probability, Mean, StdDev)

Description:

This returns the inverse of the normal cumulative distribution function NORM.DIST.

Probability is the given probability from the distribution. The values must be within the range 0 to 1.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution. This must be > 0.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORMSDIST (standard normal distribution)

Note: NORMSDIST is supplemented by the new function NORM.S.DIST with additional functionality,
which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

NORMSDIST(x)

Description:

This returns the standard normal cumulative distribution function.

The standard normal distribution is a normal distribution (see NORM.DIST/NORMDIST function) with a mean
of zero and a standard deviation of 1.

x is the value whose probability is to be calculated.

Additional info:

The cumulative distribution function is returned.

The inverse function is NORMSINV

See also:

NORM.S.DIST, NORM.INV/NORMINV, NORM.S.INV/NORMSINV, STANDARDIZE, GAUSS,
LOGNORM.INV/LOGINV, LOGNORM.DIST/LOGNORMDIST
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NORM.S.DIST (standard normal distribution)

Syntax:

NORM.S.DIST(x, cumulative)

Description:

This returns the standard normal (cumulative) distribution function.

The standard normal distribution is a normal distribution (see NORM.DIST/NORMDIST function) with a mean
of zero and a standard deviation of 1.

x is the value to be evaluated.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the standard normal distribution is calculated. By entering the value FALSE, the
probability density function of the standard normal distribution is calculated.

Note:

The NORM.S.DIST function supplements the previous NORMSDIST function with the additional argument
Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

Additional info:

The inverse function is NORM.S.INV

See also:

NORMSDIST, NORM.INV/NORMINV, NORM.S.INV/NORMSINV, STANDARDIZE, GAUSS,
LOGNORM.INV/LOGINV, LOGNORM.DIST/LOGNORMDIST

NORMSINV (percentiles of the standard distribution)

Note: NORMSINV is supplemented by the new identical function NORM.S.INV, which is available in
newer versions of Microsoft Excel (2010 or later).
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Syntax:

NORMSINV(Probability)

Description:

This returns the inverse of the standard normal cumulative distribution function NORMSDIST.

Probability is the given probability from the distribution. The values must be within the range 0 to 1.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

See also:

NORM.S.INV, NORM.INV/NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

NORM.S.INV (percentiles of the standard distribution)

Syntax:

NORM.S.INV(Probability)

Description:

This returns the inverse of the standard normal cumulative distribution function NORM.S.DIST.

Probability is the given probability from the distribution. The values must be within the range 0 to 1.

Note:

The result of this function is calculated using an iteration method. If, after 100 iterations, PlanMaker does not
find a result that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and cancels the
approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.
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See also:

NORMSINV, NORM.INV/NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

NOT (logical NOT function)

Syntax:

NOT(Value)

Description:

This performs a logical negation. TRUE becomes FALSE and FALSE becomes TRUE.

Value must be a logical value or a calculation that returns a logical value.

Example:

NOT(TRUE) returns FALSE

NOT(FALSE) returns TRUE

NOT(A1=0) returns TRUE if A1 contains a value other than zero.

See also:

OR, AND, XOR

NOW (current date and time)

Syntax:

NOW()

Description:

This returns the current date and time.

The displayed value is dynamic, so it is automatically updated when the document is opened.
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Note:

The result is a number – like all dates in a spreadsheet. PlanMaker automatically formats it in time format so
that it will be displayed as a time.

However, the result also contains the date. Thus, if you format the cell using the dialog box of the ribbon tab
Home | group Number , for example, in the number format MM/DD/YYYY hh:mm, the current date and
time will be displayed.

See also:

TODAY, CREATEDATE

NPER (number of periods)

Syntax:

NPER(Rate, Pmt, PV [, FV] [, Type])

Description:

This returns the number of payment periods of an investment based on periodic constant payments and a fixed
interest rate.

You can use this function, for example, to calculate how many periodic payments (annuities) must be made for
a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period)

Pmt is the annuity (payment made for each period).

PV is the present value (initial amount)

FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.



735Formulas and functions

See also:

PV, PPMT, PMT, RATE, IPMT, FV

NPV (net present value)

Syntax:

NPV(Rate, Value1 [, Value2, Value3 ...])

Description:

This returns the net present value of an investment based on regular cash flows and a fixed interest rate.

The function expects the following arguments:

Rate is the interest rate (per payment period).

Value1, Value2, etc., are the cash flows. You can specify either single values or a cell range. Important: All
cash flows have to occur at the end of each period.

The cash flows may vary in size and consist of incomes (positive values) and payments (negative values).
However, they must occur at regular intervals (at the end of each period) and be entered in their actual order,
namely, cash flow for the first period, cash flow for the second period, etc.

A zero has to be entered for periods where no cash flow occurred.

Differences to the PV function:

1. Cash flows of different amounts are possible for NPV, while they have to be constant amounts for PV.

2. For NPV, cash flows must occur at the end of each period; for PV, they can also be made at the start of the
period.

Example:

NPV(6.5%, 4000, 5000) returns 8164.16

See also:

PV, XNPV, IRR
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NUMBERVALUE (convert text into a number, locale)

Syntax:

NUMBERVALUE(Text [, DecimalSeparator] [, GroupSeparator])

Description:

This converts a text string into a number. The arguments DecimalSeparator and GroupSeparator allow you
to format the text string in a locale-independent manner.

Text is the value that you want to convert into a number.

DecimalSeparator (optional) specifies which character is currently used to separate the decimal places in the
text string.

GroupSeparator (optional) specifies which character is currently used in the text string to form groups of
1000s.

The result is returned as a default format: without a group separator and the zeros after the decimal separator
are truncated.

Notes:

The following rules apply when using the NUMBERVALUE function:

§ If the arguments DecimalSeparator and GroupSeparator are not specified, the text string is returned
according to the current locale. 

§ If only the DecimalSeparator is specified, the GroupSeparator is returned according to the current locale.

§ If several characters are specified in DecimalSeparator or GroupSeparator, only the first one is used.

§ If both arguments DecimalSeparator and GroupSeparator are specified and they are the same, this results
in the #VALUE! error value.

§ An empty Text string returns 0 as the result.

§ Space characters within the Text string are ignored.

§ Multiple decimal separators in the Text string result in the #VALUE! error value.

§ If the decimal separator appears before the group separator in the Text string, this results in the #VALUE!
error value.

§ If the Text string cannot be understood as a number, this returns the #VALUE! error value.

§ The % sign at the end of the Text string is treated as a percentage (i.e., the number is divided by 100).
Multiple % signs cause the number to be divided several times by 100.
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Example:

NUMBERVALUE("42") returns 42

NUMBERVALUE("42.44") returns 42.44

NUMBERVALUE("42,44") returns 4244

NUMBERVALUE("42,44",",") returns 42.44

NUMBERVALUE("42,44",",",".") returns 42.44

NUMBERVALUE("42,000.44") returns 42000.44

NUMBERVALUE("42.000,44") returns #VALUE!

NUMBERVALUE("42.000,44",",",".") returns 42000.44

NUMBERVALUE("42,000.44",",",".") returns #VALUE!

NUMBERVALUE("42 0 0 0",",",".") returns 42000

NUMBERVALUE("42%") returns 0.42

NUMBERVALUE("42%%") returns 0.0042

Tip: Number value with unit of measure

If, for example, cell A1 contains the value "42,44 mm" and you want to obtain the value "42.44 mm" in cell B1
using the NUMBERVALUE function, this is not possible because the function expects a string that is
recognizable as a number. In this case, proceed as follows:

1. Enter the value "42,44" (without mm) in cell A1, and use the formula NUMBERVALUE(A1,",",".") for cell
B1 for converting according to the examples above.

2. Then format cell B1 with the custom number format @" mm" (For more information, see also Working with
custom number formats).

3. You will get the value "42.44 mm" in cell B1 as a result.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

VALUE
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OCT2BIN (octal number to binary number)

Syntax:

OCT2BIN(Number [, Digits])

Description:

This converts the given octal number (base 8) to a binary number (base 2).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in octal notation):

Number 

This corresponds in decimal notation to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

OCT2BIN("52") returns 101010

OCT2BIN("52", 8) returns 00101010

OCT2BIN("52", 2) returns the #NUM! error value because this number cannot be represented with fewer than 6
binary digits

OCT2BIN("37777777726") returns 11111111111111111111111111010110 (negative value)

See also:

BIN2OCT, OCT2DEC, OCT2HEX
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OCT2DEC (octal number to decimal number)

Syntax:

OCT2DEC(Number)

Description:

This converts the given octal number (base 8) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in octal notation):

Number 

This corresponds in decimal notation to:

Number 

Example:

OCT2DEC("52") returns 42

OCT2DEC("0052") also returns 42

OCT2DEC("37777777726") returns -42

See also:

DEC2OCT, OCT2BIN, OCT2HEX, DECIMAL

OCT2HEX (octal number to hexadecimal number)

Syntax:

OCT2HEX(Number [, Digits])

Description:

This converts the given octal number (base 8) to a hexadecimal number (base 16).
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Number is the number to be converted.

Negative numbers must be represented in the 32-bit two's complement (see last example).

The permissible value range for Number is (in octal notation):

Number 

This corresponds in decimal notation to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
automatically determines the required number of places.

Digits must be greater than zero. Digits should be an integer. If this is not the case, PlanMaker automatically
truncates the decimal places.

If Digits are less than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

OCT2HEX("52") returns 2A

OCT2HEX("0052") also returns 2A

OCT2HEX("52", 1) returns the #NUM! error value because this number cannot be represented with fewer than
2 hexadecimal digits

OCT2HEX("37777777726") returns FFFFFFD6 (negative value)

See also:

HEX2OCT, OCT2BIN, OCT2DEC

ODD (round up to next odd number)

Syntax:

ODD(Number)

Description:

This rounds Number up (away from zero) to the nearest odd integer.
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Example:

ODD(41) returns 41

ODD(42) returns 43

ODD(-42) returns -43

See also:

EVEN, ROUNDDOWN, ROUNDUP, ROUND, MROUND

OFFSET (shifted reference)

Syntax:

OFFSET(Reference, Rows, Columns [, Height] [, Width])

Description:

This returns a cell reference shifted by the specified number of rows and columns from the original cell
reference. There is also the option of changing the size of the Reference.

Note: This does not physically move worksheet cells nor move the selection. The function only returns a shifted
cell reference.

Reference is the original cell reference. You can specify either a single cell or a cell range (in the notation Start
cell:End cell).

For Rows, specify the number of rows by which Reference is to be shifted. Positive values shift downwards,
while negative values shift upwards.

For Columns, specify the number of columns by which Reference is to be shifted. Positive values shift to the
right, while negative values shift to the left.

Height (optional) changes the height of Reference to the specified number of rows. Height must be a positive
value.

Width (optional) changes the width of Reference to the specified number of columns. Width must be a
positive value.

Example:

OFFSET(A1, 2, 0) returns a reference to A3

OFFSET(A1:C3, 1, 1) returns a reference to B2:D4

OFFSET(A1:C3, 1, 1, 5, 3) returns a reference to B2:D6
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SUM(OFFSET(A1:C3, 1, 1, 5, 3)) returns the sum of the values in B2:D6

See also:

ADDRESS, INDIRECT, COLUMN, ROW

OR (logical OR function)

Syntax:

OR(Value1 [, Value2, Value3 ...])

Description:

This returns the logical value TRUE if at least one of the given arguments is TRUE, otherwise it returns
FALSE.

You can use this function to verify that at least one of multiple conditions is fulfilled.

Example:

OR(TRUE, TRUE) returns TRUE

OR(TRUE, FALSE) returns TRUE

OR(FALSE, FALSE) returns FALSE

OR(A1=0, A1>10) returns TRUE if A1 is either zero or greater than ten.

See also:

XOR, AND, NOT

PEARSON (Pearson correlation coefficient)

Syntax:

PEARSON(Range1, Range2)

Description:

This returns the Pearson correlation coefficient r of two data sets.
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This coefficient is a measure of the strength of the linear relationship between two data sets.

The result of the PEARSON function is within the range -1 to 1: 1 indicates a perfect linear relationship. -1
indicates a perfect inverse linear relationship (the values in Range2 decrease as the values in Range1 increase).

Range1 and Range2 are cell references to the two data sets. The ranges should contain numbers. Empty cells,
text and logical values are ignored.

Range1 and Range2 must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 1, 2, 3 and B1:B3 contains 2, 3, 4, the following applies:

PEARSON(A1:A3, B1:B3) returns 1

If A1:A3 contains the values 1, 2, 3 and B1:B3 contains 4, 3, 2, the following applies:

PEARSON(A1:A3, B1:B3) returns -1

See also:

RSQ, SLOPE, INTERCEPT

PERCENTILE (percentiles of a data set)

Note: PERCENTILE is supplemented by the new identical function PERCENTILE.INC and the completely
new function PERCENTILE.EXC, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

PERCENTILE(Range, k)

Description:

This returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the desired percentage. This must be within the range from 0 to 1 (inclusive) with 0=0% and 1=100%.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTILE(A1:A9, 0.75) returns 7
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See also:

PERCENTILE.INC/PERCENTILE.EXC, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK

PERCENTILE.EXC (percentiles of a data set)

Syntax:

PERCENTILE.EXC(Range, k)

Description:

This returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the desired percentage. This must be within the range from 0 to 1 (exclusive) with 0=0% and 1=100%.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTILE.EXC(A1:A9, 0.75) returns 7.5

Note:

The PERCENTILE.EXC and PERCENTILE.INC functions supplement the previous PERCENTILE function.

PERCENTILE.INC returns the same result as PERCENTILE (values 0 to 1 inclusive).

PERCENTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK
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PERCENTILE.INC (percentiles of a data set)

Syntax:

PERCENTILE.INC(Range, k)

Description:

This returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the desired percentage. This must be within the range from 0 to 1 (inclusive) with 0=0% and 1=100%.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTILE.INC(A1:A9, 0.75) returns 7

Note:

The PERCENTILE.INC and PERCENTILE.EXC functions supplement the previous PERCENTILE function.

PERCENTILE.INC returns the same result as PERCENTILE (values 0 to 1 inclusive).

PERCENTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK
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PERCENTRANK (percent rank in a data set)

Note: PERCENTRANK is supplemented by the new identical function PERCENTRANK.INC and the
completely new function PERCENTRANK.EXC, which are available in newer versions of Microsoft Excel
(2010 or later).

Syntax:

PERCENTRANK(Range, Number [, Digits])

Description:

This returns the percentile rank (between 0 and 1 inclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank is to be determined. If Number is not included in the given values,
interpolation will be used.

The optional argument Digits lets you specify to how many decimal places the result should be calculated. For
this purpose, enter the desired number of decimal places. If omitted, 3 digits will be used.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTRANK(A1:A9, 5) returns 0.5(50%) middle of the given values; median

PERCENTRANK(A1:A9, 1) returns 0 (0%) minimum value

PERCENTRANK(A1:A9, 9) returns 1 (100%) maximum value

See also:

PERCENTRANK.INC/PERCENTRANK.EXC, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
QUARTILE.EXC/QUARTILE.INC/QUARTILE, RANK.EQ/RANK.AVG/RANK

PERCENTRANK.EXC (percent rank in a data set)

Syntax:

PERCENTRANK.EXC(Range, Number [, Digits])
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Description:

This returns the percentile rank (between 0 and 1 exclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank is to be determined. If Number is not included in the given values,
interpolation will be used.

The optional argument Digits lets you specify to how many decimal places the result should be calculated. For
this purpose, enter the desired number of decimal places. If omitted, 3 digits will be used.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTRANK.EXC(A1:A9, 5) returns 0.5 (50%) middle of the given values; median

PERCENTRANK.EXC(A1:A9, 1) returns 0.1 (10%) minimum value

PERCENTRANK.EXC(A1:A9, 9) returns 0.9 (90%) maximum value

Note:

The PERCENTRANK.EXC and PERCENTRANK.INC functions supplement the previous PERCENTRANK
function.

PERCENTRANK.INC returns the same result as PERCENTRANK (values 0 to 1 inclusive).

PERCENTRANK.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
RANK.EQ/RANK.AVG/RANK

PERCENTRANK.INC (percent rank in a data set)

Syntax:

PERCENTRANK.INC(Range, Number [, Digits])
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Description:

This returns the percentile rank (between 0 and 1 inclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank is to be determined. If Number is not included in the given values,
interpolation will be used.

The optional argument Digits lets you specify to how many decimal places the result should be calculated. For
this purpose, enter the desired number of decimal places. If omitted, 3 digits will be used.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

PERCENTRANK.INC(A1:A9, 5) returns 0.5 (50%) middle of the given values; median

PERCENTRANK.INC(A1:A9, 1) returns 0 (0%) minimum value

PERCENTRANK.INC(A1:A9, 9) returns 1 (100%) maximum value

Note:

The PERCENTRANK.INC and PERCENTRANK.EXC functions supplement the previous PERCENTRANK
function.

PERCENTRANK.INC returns the same result as PERCENTRANK (values 0 to 1 inclusive).

PERCENTRANK.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
RANK.EQ/RANK.AVG/RANK

PERIOD (duration of fixed-interest investments)

Syntax:

PERIOD(Rate, PV, FV)
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Description:

This returns the duration (i.e., the number of periods) required to obtain a specific future value with a fixed-
interest investment.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

The function expects the following arguments:

Rate is the interest rate (per payment period)

PV is the present value (initial amount)

FV is the future value

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Tip: You can perform calculations with the PERIOD function using Excel-compatible functions as follows:

PERIOD(Rate, PV, FV) is equivalent to NPER(Rate, 0, PV, -FV)

Note the minus sign in front of FV!

Example:

You would like to obtain a payout of €5000 with a fixed-interest investment of €3000. The annual interest rate
is 6%. How many periods (years) are required in this case?

PERIOD(6%, 3000, 5000) returns 8.76669 periods (i.e., years)

See also:

RRI

PERMUT (permutations)

Syntax:

PERMUT(n, k)

Description:

This returns the number of permutations of size k in a population of size n.
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n is the total number of items. n must be > k.

k is the number of items in each combination. k must be > 0 and < n.

n and k should be integers. If this is not the case, PlanMaker automatically truncates the decimal places.

Additional info:

Permutations are similar to combinations (see COMBIN function), except that the order of the objects is
important for permutations.

With PERMUT, for example, you can calculate how many possibilities there are for the first 3 places in a race
with 10 participants. With COMBIN, on the other hand, you can determine how many possibilities there are
when drawing 6 balls from 49.

The difference: While the order of the lottery numbers drawn can be changed at will (you could, for example,
sort them in ascending order afterwards), the runners would naturally protest if you suddenly rearranged 1st-3rd
places according to the first letters of their surnames.

The order plays a role in the permutations but not in the combinations.

Example:

Let's take a closer look at the example with the runners. You want to know how many permutations there are
for the first 3 places in a race with 10 runners. The formula for this is as follows:

PERMUT(10, 3)

Result: There are 720 possible variations.

See also:

COMBIN

PHI (standard normal distribution)

Syntax:

PHI(x)

Description:

This returns the density function of the standard normal distribution.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.
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We thus recommend that you use the NORMDIST function instead, as it is compatible with all versions of
Excel:

PHI(x) equals NORMDIST(x, 0, 1, FALSE)

See also:

NORM.DIST/NORMDIST, GAUSS

PI (constant value of pi)

Syntax:

PI()

Description:

This returns the mathematical constant p (pi), which expresses the ratio of a circle's circumference (2rp) to its
diameter (2r).

Example:

PI() returns 3.14159265...

PMT (payment)

Syntax:

PMT(Rate, NPer, PV [, FV] [, Type])

Description:

This returns the payment (principal plus interest) in the given period, applicable to loans with periodic constant
payments and a fixed interest rate.

You can use this function, for example, to calculate how large the (constant) payments are per period. These
payments ("annuities") always consist of a principal component (see PPMT function) and an interest
component (see IPMT function).

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.
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The function expects the following arguments:

Rate is the interest rate (per payment period)

NPer is the total number of payment periods.

PV is the present value (initial amount)

FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

PMT(6.5%, 10, 1000) returns -139.10

See also:

PV, ISPMT, PPMT, CUMPRINC, CUMIPMT, RATE, IPMT, FV, NPER

POISSON (Poisson distribution)

Note: POISSON is supplemented by the new identical function POISSON.DIST, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

POISSON(x, Lambda, Cumulative)

Description:

This returns the probabilities of a Poisson distributed random variable.

The Poisson distribution describes the occurrence of independent, similar events within a given period (for
example, the arrival of customers at a counter or the occurrence of incoming phone calls).

It is particularly suitable for probability distributions where there are a large number of results from a sample,
and there is a low probability that the event in question will occur. Here, the Poisson distribution can simulate
the binomial distribution (with Lambda = n*p). In contrast to the binomial distribution, however, Poisson
requires only one parameter (apart from x): the expected value Lambda (see example).

x is the value whose probability is to be calculated. x x should be an integer. If this is
not the case, PlanMaker automatically truncates the decimal places.
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Lambda (l) is the expected value (mean value) for x. Lambda 

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

In a multi-story building, an average of 4 light bulbs become defective per week.

To determine the probability that just 3 light bulbs become defective in one week:

If you wanted to calculate this with the binomial distribution (function BINOM.DIST/BINOMDIST), you
would have to write the following:

BINOMDIST(3, 100000, 4/100000, FALSE) returns 0.195368768

If you use the Poisson distribution, however, you can do so without the parameters n and p and simply write the
following:

POISSON(3, 4, FALSE) returns 0,195366815

As expected, the two results are very similar (as described above).

Another example: What is the probability of a maximum of 3 light bulbs becoming defective?

Instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

POISSON(3, 4, TRUE) returns 0.43347

See also:

POISSON.DIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, EXPON.DIST/EXPONDIST

POISSON.DIST (Poisson distribution)

Syntax:

POISSON.DIST(x, Lambda, Cumulative)

Description:

This returns the probabilities of a Poisson distributed random variable.

The Poisson distribution describes the occurrence of independent, similar events within a given period (for
example, the arrival of customers at a counter or the occurrence of incoming phone calls).
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It is particularly suitable for probability distributions where there are a large number of results from a sample,
and there is a low probability that the event in question will occur. Here, the Poisson distribution can simulate
the binomial distribution (with Lambda = n*p). In contrast to the binomial distribution, however, Poisson
requires only one parameter (apart from x): the expected value Lambda (see example).

x is the value whose probability is to be calculated. x x should be an integer. If this is
not the case, PlanMaker automatically truncates the decimal places.

Lambda (l) is the expected value (mean value) for x. Lambda 

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

In a multi-story building, an average of 4 light bulbs become defective per week.

To determine the probability that just 3 light bulbs become defective in one week:

If you wanted to calculate this with the binomial distribution (function BINOM.DIST/BINOMDIST), you
would have to write the following:

BINOM.DIST(3, 100000, 4/100000, FALSE) returns 0.195368768

If you use the Poisson distribution, however, you can do so without the parameters n and p and simply write the
following:

POISSON.DIST(3, 4, FALSE) returns 0,195366815

As expected, the two results are very similar (as described above).

Another example: What is the probability of a maximum of 3 light bulbs becoming defective?

Instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

POISSON.DIST(3, 4, TRUE) returns 0.43347

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

POISSON, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, EXPON.DIST/EXPONDIST
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POLYNOMIAL (polynomial coefficient)

Syntax:

POLYNOMIAL(Number1 [, Number2, Number3 ...])

Description:

This returns the polynomial coefficient ("multinomial coefficient") of a set of numbers.

All given values Number1, Number2

Example:

POLYNOMIAL(1, 2, 3, 4, 5) returns 37837800

Note:

The POLYNOMIAL and MULTINOMIAL functions are completely identical.

See also:

MULTINOMIAL, FACT

POWER (power)

Syntax:

POWER(x, y)

Description:

This returns x raised to the power of y.

x is the base.

y is the exponent.

Additional info:

The ^ operator does exactly the same:
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POWER(x, y) is equivalent to x^y.

Example:

POWER(2, 4) is equivalent to 2^4, which is 16

See also:

LOG, LN, EXP, SERIESSUM, SQRT, ROOTN, section Operators in formulas

PPMT (payment on the principal)

Syntax:

PPMT(Rate, Per, NPer, PV [, FV] [, Type])

Description:

This returns the principal portion in the given period of an investment based on periodic constant payments and
a fixed interest rate.

You can use this function, for example, to calculate how large the principal portion of the annuity is in a
particular period for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period)

Per is the payment period to be considered.

NPer is the total number of payment periods.

PV is the present value (initial amount)

FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:
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Annual interest rate: 10%

Payments: monthly

Duration: 6 years

What is the principal portion in the 32nd period (i.e., the 32nd month)?

PPMT(10%/12, 32, 6*12, 100000) returns -1.318.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Thus, in the above formula, the annual interest rate was divided by 12 to get the monthly interest rate and the
number of payment periods was multiplied by 12.

Additional info:

The IPMT function is the counterpart to PPMT: It returns the interest component of the payment in this period.

The PMT function, on the other hand, returns the total amount of the payment (annuity) per period, that is, the
sum of the principal portion and the interest portion.

See also:

PV, ISPMT, CUMPRINC, CUMIPMT, PMT, RATE, IPMT, FV, NPER

PROB (probability)

Syntax:

PROB(Values, Probabilities, k1 [, k2])

Description:

This returns the probability that a value is within the specified interval of values when the individual
probabilities for each value are given.

In simple terms: This function sums up the respective Probabilities of the Values in this interval.

Values are the given values.

Probabilities are the probabilities associated with these values.

All Probabilities have to be within the range 0 (0%) to 1 (100%). Their sum has to be 1.

Values and Probabilities must have the same number of values, otherwise the function returns a #N/A error
value.

k1 and k2 determine the interval of values whose cumulative probabilities you want to calculate. If k2 is
omitted, only the probability of k1 will be returned.
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Example:

Cells A1:A3 contain the values 1, 2, 3. Cells B1:B3 contain the probabilities associated with these values: 17%,
33%, 50%.

To calculate the probability that a value is between 2 and 3:

PROB(A1:A3, B1:B3, 2, 3) returns 33% + 50% = 83%

PRODUCT (product)

Syntax:

PRODUCT(Number1 [, Number2, Number3 ...])

Description:

This returns the product of the specified numbers. Number1, Number2, etc., are the numbers to be multiplied.

Additional info:

When you use this function with cell references or arrays, text strings and logical values are ignored. However,
the situation is different if you specify fixed values: Here, text strings containing numbers are counted.
Furthermore, the logical value TRUE is treated as 1 and FALSE as 0. See examples below.

Example:

PRODUCT(2, 3, 4) equals 2*3*4, which is 24

When cells A1 to A3 are filled with the values 2, 3 and 4, the following applies:

PRODUCT(A1:A3) equals 2*3*4, which is 24

Note:

PRODUCT(2, "5", TRUE) equals 2*5*1, thus 10

However: If cells A1 to A3 are filled with 2, "5" and TRUE, the formula PRODUCT(A1:A3) returns a different
result: It returns 2, as strings and logical values are only considered if they are specified as fixed values.

See also:

SUM
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PROPER (convert text to upper/lower case)

Syntax:

PROPER(Text)

Description:

This converts all characters in a text string as follows: The first letter of each word is converted into an
uppercase letter, all other letters are converted into lowercase letters.

Example:

PROPER("good morning") returns Good Morning

PROPER("Good Morning") returns Good Morning

PROPER("GoOd MoRnInG") returns Good Morning

See also:

UPPER, LOWER

PV (present value)

Syntax:

PV(Rate, NPer, Pmt [, FV] [, Type])

Description:

This returns the present value of an investment based on periodic constant payments and a fixed interest rate.

The function expects the following arguments:

Rate is the interest rate (per payment period)

NPer is the total number of payment periods.

Pmt is the annuity (payment made for each period).

FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.
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Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

PV(6.5%/12, 12*10, 650) equals -57244.52

This formula calculates the present value of a loan with an interest rate of 6.5% (per year, thus the division by
12), a term of 10 years (=12*10 months) and an annuity of €650 (per month).

See also:

PPMT, NPV, PMT, RATE, IPMT, FV, NPER

QUARTILE (quartiles of a data set)

Note: QUARTILE is supplemented by the new identical function QUARTILE.INC and the completely new
function QUARTILE.EXC, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

QUARTILE(Range, n)

Description:

This returns one of the quartiles of a data set, based on a percentile range from 0 to 1 (inclusive).

Range is a range with numeric data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile is to be returned. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, the function will return a #NUM! error value.
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Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

QUARTILE(A1:A9, 3) is equivalent to PERCENTILE(A1:A9, 0.75) and returns 7

See also:

QUARTILE.INC/QUARTILE.EXC, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUARTILE.EXC (quartiles of a data set)

Syntax:

QUARTILE.EXC(Range, n)

Description:

This returns one of the quartiles of a data set, based on a percentile range from 0 to 1 (exclusive).

Range is a range with numeric data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile is to be returned. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, the function will return a #NUM! error value.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

QUARTILE.EXC(A1:A9, 3) is equivalent to PERCENTILE.EXC(A1:A9, 0.75) and returns 7.5

Note:

The QUARTILE.EXC and QUARTILE.INC functions supplement the previous QUARTILE function.

QUARTILE.INC returns the same result as QUARTILE (values 0 to 1 inclusive).
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QUARTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUARTILE.INC (quartiles of a data set)

Syntax:

QUARTILE.INC(Range, n)

Description:

This returns one of the quartiles of a data set, based on a percentile range from 0 to 1 (inclusive).

Range is a range with numeric data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile is to be returned. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, the function will return a #NUM! error value.

Example:

If the cells A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9, the following applies:

QUARTILE.INC(A1:A9, 3) is equivalent to PERCENTILE.INC(A1:A9, 0.75) and returns 7

Note:

The QUARTILE.INC and QUARTILE.EXC functions supplement the previous QUARTILE function.

QUARTILE.INC returns the same result as QUARTILE (values 0 to 1 inclusive).
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QUARTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUOTIENT (quotient of a division)

Syntax:

QUOTIENT(x, y)

Description:

This returns the integer part of the division of x by y.

Example:

QUOTIENT(6, 4) returns 1

See also:

MOD, MODP

RADIANS (convert degrees to radians)

Syntax:

RADIANS(Number)

Description:

This converts degrees to radians.

The following conversion formula is used:
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RADIANS(x) = x * PI() / 180

Example:

RADIANS(180) returns 3.14159... (the value of the number Pi)

See also:

DEGREES

RAND (random value)

Syntax:

RAND()

Description:

A new random number will be generated each time the document is recalculated.

Tip: By choosing the ribbon command Formula | group Update | Update data | Update calculations, you can
manually recalculate a document.

Example:

INT() returns a random number.

The following formula returns a random integer between 1 and 6, thus simulating the roll of a dice.

INT(RAND()*6+1)

Tip: However, this is easier with RANDBETWEEN(16, 6).

See also:

RANDBETWEEN
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RANDBETWEEN (random value)

Syntax:

RANDBETWEEN(LowerLimit, UpperLimit)

Description:

This returns a random integer x in the range LowerLimit x UpperLimit.

A new random number will be generated each time the document is recalculated.

Tip: By choosing the ribbon command Formula | group Update | Update data | Update calculations, you can
manually recalculate a document.

Example:

RANDBETWEEN(1, 6) returns a random integer between 1 and 6, thus simulating the roll of a dice.

See also:

RAND

RANK (rank in a data set)

Note: RANK is supplemented by the new identical function RANK.EQ and the completely new function
RANK.AVG, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

RANK(Number, Range [, Ascending])

Description:

This returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is
2, etc. If there are duplicate values in the list, they are given the higher rank.

Number is the number whose rank is to be determined. If Number does not occur in Range, the function
returns a #N/A error value.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.
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Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).

Example:

If the cells A1:A6 contain the values 3, 2, 7, 5, 9, 7, the following applies:

RANK(9, A1:A6) returns 1

RANK(9, A1:A6, TRUE) returns 6

RANK(5, A1:A6) returns 4

RANK(7, A1:A6) returns 2

See also:

RANK.EQ/RANK.AVG, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RANK.AVG (rank in a data set)

Syntax:

RANK.AVG(Number, Range [, Ascending])

Description:

This returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is
2, etc. If there are duplicate values in the list, they are given the average rank.

Number is the number whose rank is to be determined. If Number does not occur in Range, the function
returns a #N/A error value.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.

Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).

Example:

If the cells A1:A6 contain the values 3, 2, 7, 5, 9, 7, the following applies:
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RANK.AVG(9, A1:A6) returns 1

RANK.AVG(9, A1:A6, TRUE) returns 6

RANK.AVG(5, A1:A6) returns 4

RANK.AVG(7, A1:A6) returns 2.5

Note:

The RANK.AVG and RANK.EQ functions supplement the previous RANK function.

RANK.EQ returns the same result as RANK (higher rank for duplicate values in the list).

The RANK.AVG (average rank for duplicate values in the list) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

RANK/RANK.EQ, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RANK.EQ (rank in a data set)

Syntax:

RANK.EQ(Number, Range [, Ascending])

Description:

This returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is
2, etc. If there are duplicate values in the list, they are given the higher rank.

Number is the number whose rank is to be determined. If Number does not occur in Range, the function
returns a #N/A error value.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.

Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).
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Example:

If the cells A1:A6 contain the values 3, 2, 7, 5, 9, 7, the following applies:

RANK.EQ(9, A1:A6) returns 1

RANK.EQ(9, A1:A6, TRUE) returns 6

RANK.EQ(5, A1:A6) returns 4

RANK.EQ(7, A1:A6) returns 2

Note:

The RANK.EQ and RANK.AVG functions supplement the previous RANK function.

RANK.EQ returns the same result as RANK (higher rank for duplicate values in the list).

The RANK.AVG (average rank for duplicate values in the list) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

RANK/RANK.AVG, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RATE (interest rate per period)

Syntax:

RATE(NPer, Pmt, PV [, FV] [, Type] [, Guess])

Description:

This returns an estimate for the interest portion of the payment per period, based on an investment with periodic
constant payments and a fixed interest rate.

The function expects the following arguments:

NPer is the total number of payment periods.

Pmt is the annuity (payment made for each period).

PV is the present value (initial amount)
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FV (optional) is the future value (the total value after the last payment). If the argument FV is omitted, it will
be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Guess (optional) lets you specify an estimate of how high the interest rate is likely to be (see note below).

Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try specifying a different value for Guess.

Example:

RATE(12*10, -650, 60000) returns 0.455087%

This formula calculates the interest rate for a loan of €60,000 with a term of 10 years (12*10 months) and a
payment of €650.00 (per month) using an iterative search technique.

The result is the interest rate per month. To obtain the annual interest rate, it must thus be multiplied by 12.

See also:

PV, PPMT, PMT, XIRR, IPMT, RRI, FV, NPER, IRR, MIRR

REPLACE (replace text in a text string)

Syntax:

REPLACE(Text, Start, Count, NewText)

Description:

This replaces a specific part of a text string with other text.

Text is the original text string.

Start is the position of the first character to be replaced.

Count is the number of characters to be replaced.

NewText is the replacement text.
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Example:

REPLACE("aaaaaa", 3, 2, "bb") returns aabbaa

REPLACE("aaaaaa", 3, 4, "bb") returns aabb

REPLACE("cccccc", 3, 2, "dddddddd") returns ccddcc

REPLACE("cccccc", 3, 4, "dddddddd") returns ccdddd

REPLACE("cccccc", 3, 6, "dddddddd") returns ccdddddd

See also:

FIND, SEARCH, MID, SUBSTITUTE, LEFT, RIGHT, REPT

REPT (repeat text string)

Syntax:

REPT(Text, n)

Description:

This repeats the specified text string n times.

You use the argument n to specify the number of repetitions. n should be an integer. If this is not the case,
PlanMaker automatically truncates the decimal places.

Example:

REPT("Text", 3) returns TextTextText

See also:

REPLACE, SUBSTITUTE

RIGHT (right part of a text string)

Syntax:

RIGHT(TextString [, n])



771Formulas and functions

Description:

This returns the last n characters of a TextString.

If n is omitted, the function only returns the last character.

Example:

RIGHT("peanut", 3) returns nut

RIGHT("peanut") returns t

See also:

LEFT, MID, REPLACE, LEN

ROMAN (Roman numeral)

Syntax:

ROMAN(Number [, Format])

Description:

This converts an Arabic numeral into a Roman numeral (as a text string).

Number 

Number should be an integer. If this is not the case, PlanMaker automatically removes all decimal places and
converts the remaining number into a Roman numeral.

If Number equals zero, an empty text string will be returned.

If the optional argument Format is used, PlanMaker tries to create a shorter form of the Roman numeral.
Format can be any integer from 0 (do not shorten) to 4 (shorten as much as possible).

Example:

ROMAN(1999) returns MCMXCIX

ROMAN(1999, 0) also returns MCMXCIX

ROMAN(1999, 1) returns MLMIL

ROMAN(1999, 2) returns MXMIX

ROMAN(1999, 3) returns MVMIV

ROMAN(1999, 4) returns MIM
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ROOTN (n-th root)

Syntax:

ROOTN(Number [, n])

Description:

This returns the n-th root of a number. If n is omitted, the function returns the square root (n=2).

n should be an integer. If this is not the case, PlanMaker automatically truncates the decimal places.

If n is even, Number 

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Tip: Alternatively, you can calculate the n-th root of a number using the following Excel-compatible function:

ROOTN(Number, n) equals POWER(Number, 1/n)

Example:

ROOTN(25) returns 5

ROOTN(-25) returns the #NUM! error value

ROOTN(125, 3) returns 5

ROOTN(-125, 3) returns -5

See also:

SQRT, POWER

ROUND (round to n digits)

Syntax:

ROUND(Number, n)
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Description:

This rounds Number to n decimal places.

n is the desired number of decimal places.

If n is omitted, Number is rounded to the nearest integer.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of a hundred (see last example).

Example:

ROUND(1.234, 2) returns 1.23

ROUND(1.235, 2) returns 1.24

ROUND(444.222, 0) returns 444

ROUND(444.222, -2) returns 400

See also:

ROUNDDOWN, ROUNDUP, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR

ROUNDDOWN (round down to n digits)

Syntax:

ROUNDDOWN(Number, n)

Description:

This rounds a number down (towards zero) to n decimal places.

n is the desired number of decimal places.

If n is omitted, Number is rounded down to the nearest integer.

If n is a negative value, Number is rounded down to the left of the decimal point. For example, if n is -2,
Number is rounded to the nearest multiple of a hundred (see second last example).

Note:

Negative numbers are rounded up rather than rounded down (see last example). This is not mathematically
correct, but it is implemented exactly as in Microsoft Excel for compatibility reasons.
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Example:

ROUNDDOWN(1.234, 2) returns 1.23

ROUNDDOWN(1.235, 2) returns 1.23

ROUNDDOWN(888.999, 0) returns 888

ROUNDDOWN(888.999, -2) returns 800

ROUNDDOWN(-7.8, 0) returns -7

See also:

ROUNDUP, ROUND, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR

ROUNDUP (round up to n digits)

Syntax:

ROUNDUP(Number, n)

Description:

This rounds a Number up to n decimal places.

n is the desired number of decimal places.

If n is omitted, Number is rounded up to the nearest integer.

If n is a negative value, Number is rounded up to the left of the decimal point. For example, if n is -2, Number
is rounded up to the nearest multiple of a hundred (see second last example).

Note:

Negative numbers are rounded down rather than rounded up (see last example). This is not mathematically
correct, but it is implemented exactly as in Microsoft Excel for compatibility reasons.

Example:

ROUNDUP(1.234, 2) returns 1.24

ROUNDUP(1.235, 2) returns 1.24

ROUNDUP(444.222, 0) returns 445

ROUNDUP(444.222, -2) returns 500

ROUNDUP(-7.3, 0) returns -8
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See also:

ROUNDDOWN, ROUND, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR

ROW (row number of cells)

Syntax:

ROW([Reference])

Description:

This returns the row number(s) of a cell or cell range:

If Reference is a single cell, the row number of this cell is returned.

If Reference is a range of cells, their row numbers are returned as a vertical array. Note: In this case, the
formula has to be entered as an array formula (see Working with arrays).

If Reference is omitted, the row number of the cell that contains this function is returned.

Example:

ROW(D2) returns 2

ROW(D2:F4) returns {2;3;4}

ROW() returns 5 when you use this function in cell A5

See also:

COLUMN, ROWS, CELL, ADDRESS, INDIRECT, OFFSET

ROWS (number of rows in a range)

Syntax:

ROWS(Range)

Description:

This returns the number of rows in the specified cell range.
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Example:

ROWS(A1:D5) returns 5

See also:

ROW, COLUMNS, AREAS

RRI (interest for fixed-interest investments)

Syntax:

RRI(Per, PV, FV)

Description:

This returns the interest rate required to obtain a specific future value after a specific period.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

The function expects the following arguments:

Per is the number of periods. If, for example, the annual interest rate is considered, a period is one year.

PV is the present value (initial amount)

FV is the future value

Example:

You would like to obtain $5000 with a fixed-interest investment of $3000 after 10 years. How high does the
annual interest rate have to be?

RRI(10, 3000, 5000) returns 0.05241 (i.e., about 5.24%).

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

In older versions of PlanMaker, this function was called PCF.

See also:

PERIOD, RATE
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RSQ (square of Pearson)

Syntax:

RSQ(Range1, Range2)

Description:

This returns the determination coefficient of two data sets.

This coefficient is a measure of the strength of the linear relationship between data sets. The closer it is to 1, the
greater the correlation.

Range1 and Range2 are cell references to the two data sets. They must contain numbers. Empty cells, text and
logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4, the following applies:

RSQ(A1:A3, B1:B3) returns 0.99436

Additional info:

RSQ is the square of PEARSON (Pearson's correlation coefficient).

See also:

PEARSON

SEARCH (search for text in a text string)

Syntax:

SEARCH(SearchText, TextString [, StartPos])

Description:

This returns the position of SearchText within the TextString.
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StartPos (optional) lets you specify the position in the text string, from which the search should start. If
omitted, the search starts at the first character.

The SEARCH function is not case-sensitive, i.e., it does not distinguish between uppercase and lowercase
letters. To perform a case-sensitive search, use the FIND function instead.

Example:

SEARCH("a", "Banana") returns 2

SEARCH("A", "Banana") returns 2

SEARCH("a", "Banana", 3) returns 4

SEARCH("x", "Banana") returns the #VALUE! error value, since "x" does not occur in "Banana".

For example, if the word "banana" is in cell B5, you can enter the formula as follows:

SEARCH("a", B5) returns 2

See also:

FIND, REPLACE, SUBSTITUTE, EXACT, MID

SECOND (second)

Syntax:

SECOND(Time)

Description:

This returns the seconds of a time value.

Example:

SECOND("12:34:56 AM") returns 56

SECOND("09/25/2018 10:30:36") returns 36

If cell A1 contains a date with the time 10:30:36, then SECOND(A1) returns 36

See also:

HOUR, MINUTE, MILLISECONDS
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SERIESSUM (sum of a power series)

Syntax:

SERIESSUM(x, n, m, Coefficients)

Description:

This returns a power series based on the following formula:

SERIESSUM(x,n,m,a) =

a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + a4*x^(n+3m) + ...

x is the base.

n is the exponent for the first element in the series.

m is the increment for n.

Coefficients are the coefficients by which the individual elements of the series are multiplied. Coefficients can
be either a cell reference or a single-column array.

The number of coefficients also determines the number of elements within the power series. If, for example, 10
coefficients are specified, the series will consist of 10 elements.

Example:

SERIESSUM(2, 2, 1, {1; 2; 3; 4; 5}) returns 516

See also:

POWER

SHEET (index of a worksheet)

Syntax:

SHEET([SheetName])

Description:

This returns the index of a worksheet in the current document. The first worksheet in a document returns 1, the
second sheet returns 2, etc.
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If the optional argument SheetName is given, the index of the worksheet with the specified name is returned.
Otherwise, the index of the current worksheet is returned.

Note:

The SHEET function replaces the (almost) identical SHEETNUMBER function

Background info: The SHEETNUMBER function was previously available in PlanMaker but not in Excel. In
Excel 2013, Microsoft introduced the same function – but with a different name: SHEET.

There is only one small difference: When the specified parameter is a cell reference, SHEET will return the
index of the worksheet that contains this reference. SHEETNUMBER, on the other hand, will read the content
of the referenced cell and return the index of the worksheet with this name.

Example:

For the third worksheet in a document, SHEET() returns 3.

SHEET("Expenses") returns the index of the worksheet named "Expenses".

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

SHEETNUMBER, SHEETNAME, SHEETS, FILENAME

SHEETNAME (name of a worksheet)

Syntax:

SHEETNAME([n])

Description:

This returns the name of a worksheet.

n is the number of the worksheet whose name you want to determine. The first worksheet in the workbook is
number 1, the second is number 2, etc. If n is omitted, the current worksheet is used.

Example:

A document contains four worksheets: "Spring", "Summer", "Autumn" and "Winter" (in that order). The cursor
is currently located in a cell of the third worksheet ("Autumn"). The following applies:
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SHEETNAME() returns Autumn

SHEETNAME(1) returns Spring

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

SHEET, SHEETS, FILENAME

SHEETNUMBER (compatibility function)

Syntax:

SHEETNUMBER([SheetName])

Description:

Compatibility function for older PlanMaker documents.

This function has been replaced by the (almost) identical SHEET function

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Tip: Instead of this function, use the Excel-2013-compatible function SHEET in future.

See also:

SHEET, SHEETS, SHEETNAME

SHEETS (number of worksheets)

Syntax:

SHEETS([Reference])
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Description:

This returns the number of referenced worksheets (both visible and hidden sheets).

If the optional argument Reference is not specified, the function returns the number of worksheets in the
current workbook.

Example:

A document contains 3 worksheets.

SHEET() returns 3.

SHEET(A1) returns 1 because of the reference to a cell in the current worksheet.

SHEET(Table1:Table2!A1) returns 2 because of the reference to cells in worksheet1 and worksheet2.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

See also:

SHEET, SHEETNAME

SIGN (sign of a number)

Syntax:

SIGN(Number)

Description:

This function returns the sign of a Number. The following values may be returned:

1 if Number is positive

-1 if Number is negative

0 if Number is zero

Example:

SIGN(-5) returns -1
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See also:

ABS, NEG

SIN (sine)

Syntax:

SIN(Number)

Description:

This returns the sine of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Example:

SIN(PI()/2) returns 1

SIN(RADIANS(90)) returns 1

See also:

ASIN, COS, TAN

SINH (hyperbolic sine)

Syntax:

SINH(Number)

Description:

This returns the hyperbolic sine of Number.
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Example:

SINH(0.45) returns 0.4653

See also:

ASINH, COSH, TANH

SKEW (skewness of a distribution)

Syntax:

SKEW(Number1, Number2, Number3 [, Number4 ...])

or

SKEW(Range1 [, Range2, Range3 ...])

Description:

This returns the skewness of the density function of a probability distribution.

The skewness is a measure of the asymmetry of a distribution.

If there are more values to the right of the arithmetic mean of the distribution, you have a "right-skewed"
distribution. SKEW returns a positive value here.

The opposite case is a "left-skewed" distribution. Here, SKEW returns a negative value.

As the SKEW approaches zero, the distribution becomes approximately symmetric.

Number1, Number2, Number3, etc., are the values to be evaluated. Empty cells, text and logical values are
ignored.

At least three values have to be specified, otherwise the function returns a #DIV/0! error value.

Note:

This function does not accept value pairs (x value and y value) as arguments, but only the values of the
distribution. If the same values appear multiple times, they must be repeated in the argument list accordingly
(see example).

Example:

You measured the height of several test persons and obtained the following results: 1 x 1.60m, 2 x 1.65m, 4 x
1.70m, 2 x 1.75m and 1x1.80m.

To calculate the skewness of this distribution, use the following formula:
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SKEW(1.60, 1.65, 1.65, 1.70, 1.70, 1.70, 1.70, 1.75, 1.75, 1.80) returns 4.66562E-15.

See also:

INTERCEPT, FORECAST, KURT, NORM.DIST/NORMDIST

SLN (straight-line depreciation)

Syntax:

SLN(Cost, Salvage, Life)

Description:

This returns the depreciation per period of an asset, using the straight-line depreciation method.

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Example:

Initial values: Initial cost = 6000, Salvage value = 3000, Life of asset = 5 years

SLN(6000, 3000, 5) returns 600 (per year)

See also:

SYD, DDB, DB

SLOPE (slope of a linear trend)

Syntax:

SLOPE(y_values, x_values)

Description:

This returns the slope of a best-fit line for the given values. The slope of a line is the value by which the y value
grows when the x value is increased by 1.
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A best-fit line is the result of a linear regression, a statistical technique that adapts a line (called "trendline" or
"best-fit line") to a set of data points (for example, the results of a series of measurements).

For the arguments y_values and x_values, you usually specify a cell range.

Y_values are the dependent variables.

X_values are the independent variables.

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Additional info:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-dependent resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures that were measured (the independent variables): 8, 20, 25, 28

Cells B1:B4 contain the resistances that were measured (the dependent variables): 261, 508, 608, 680

The following calculation returns the slope of a best-fit line based on these values:

SLOPE(B1:B4, A1:A4) returns 20.76799

See also:

INTERCEPT, FORECAST, PEARSON, STEYX

SMALL (k-th smallest number)

Syntax:

SMALL(Range, k)

Description:

This returns the k-th smallest value in a data set. If k=1, the smallest value will be returned, if k=2, the second
smallest value will be returned, etc.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k determines which number to return.
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k must not be smaller than 1 or greater than the total number of values in Range. Otherwise, the function
returns a #NUM! error value.

Example:

If A1:A5 contains the values 4, 2, 6, 5 and 9, the following applies:

SMALL(A1:A5, 1) returns 2

SMALL(A1:A5, 2) returns 4

SMALL(A1:A5, 3) returns 5

etc.

See also:

LARGE, MIN, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, RANK.EQ/RANK.AVG/RANK

SORTM (sort)

Syntax:

SORTM(Range, Key [, Mode] [, Columnwise] [, ColumnNumber])

Description:

This function sorts a cell range or an array according to one or more criteria and returns an array with the sorted
values.

Range is the cell range or array containing the data to be sorted. You can specify a one-dimensional or two-
dimensional cell range or an array for this purpose.

Key determines by which rows the cell range or array should be sorted. To do so, specify a two-row cell range
or a two-row array with the following contents:

The first row must contain the numbers of the rows by which you want to sort. If, for example, you enter {1,3}
for the sort key, the cell range will be sorted by the first and by the third row of Range.

The second row (optional) can contain logical values that specify the sort order:

FALSE or omitted: Ascending order

TRUE: Descending order

If, for example, you use {1,3; true,false} as the sort key, the cell range will be sorted by the first row in
descending order and by the third row in ascending order.
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Mode (optional) is a logical value that lets you specify if PlanMaker should distinguish between uppercase and
lowercase letters:

FALSE or omitted: Ignore case of letters

TRUE: Distinguish between uppercase and lowercase letters, i.e., sort terms where the first letter is lowercase
before terms that begin with the same uppercase letter.

Columnwise (optional) is a logical value that lets you specify if the data should be sorted row-wise or column-
wise:

FALSE or omitted: Sort row-wise

TRUE: Sort column-wise

If you use the optional argument ColumnNumber, the function only returns a specific column (or row – if
sorted column-wise) instead of the entire data:

If omitted, all columns are returned.

If set to n, only the n-th column is returned.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

SORTM({4;2;3}, {1}) returns {2;3;4}

SORTM({4;2;3}, {1;TRUE}) returns {4;3;2}

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

SORTV, section Sorting cells

SORTV (sort)

Syntax:

SORTV(Range [, Descending] [, Mode] [, Data])
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Description:

This returns a vector that contains the values of the given one-dimensional cell range in sorted order.

Unlike the SORTM function, SORTV is only applicable to one-dimensional cell ranges (vectors). These are
areas that comprise either only one row or only one column.

Range is the one-dimensional cell range or array that contains the data to be sorted.

Descending (optional) lets you specify the sort order:

FALSE or omitted: Ascending order

TRUE: Descending order

Mode (optional) is a logical value that lets you specify if PlanMaker should distinguish between uppercase and
lowercase letters:

FALSE or omitted: Ignore case of letters

TRUE: Distinguish between uppercase and lowercase letters, i.e., sort terms where the first letter is lowercase
before terms that begin with the same uppercase letter.

If you use the optional argument Data, the function returns the data from Data as the result rather than the data
from Range. Data must be of exactly the same size as Range.

This is useful if, for example, you create a worksheet that contains a column with the names of athletes and a
column with their scores next to it. If you enter the column with their scores as the Range here, but the column
with their names as the Data, you will obtain a list of names sorted by scores.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

SORTV({4;2;3}) returns {2;3;4}

SORTV({4;2;3}, TRUE) returns {4;3;2}

SORTV({4,2,3}) returns {2,3,4}

Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

SORTM, section Sorting cells
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SQRT (square root)

Syntax:

SQRT(Number)

Description:

This returns the square root of a Number.

Example:

SQRT(25) returns 5

SQRT(-25) returns the #NUM! error value

See also:

ROOTN, SQRTPI, POWER

SQRTPI (square root of x*Pi)

Syntax:

SQRTPI(Number)

Description:

This returns the square root of (Number * pi).

Example:

SQRTPI(42) equals SQRT(42*PI()), which is 11.48681381

See also:

PI, SQRT, ROOTN
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STANDARDIZE (standardized value)

Syntax:

STANDARDIZE(x, Mean, StdDev)

Description:

This returns the standardized value of x based on a distribution defined by its mean and standard deviation.

x is the value to be standardized.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution.

Example:

STANDARDIZE(5, 4, 1.25) returns 0.8

See also:

AVERAGE, STDEV.S/STDEV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

STDEV (standard deviation of a sample)

Note: STDEV is supplemented by the new identical function STDEV.S, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

STDEV(Number1, Number2 [, Number3 ...])

Description:

This estimates the standard deviation of a population based on a sample.

The standard deviation indicates the average amount by which the specified values deviate from the mean.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).
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If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The standard deviation is calculated using the "unbiased" or "n-1" method.

Example:

STDEV(2, 2, 3, 4, 1) returns 1.14018

See also:

STDEV.S, STDEVA, STDEV.P/STDEVP, VAR.P/VARP, VAR.S/VAR, AVEDEV, STANDARDIZE,
DEVSQ

STDEVA (standard deviation of a sample)

Syntax:

STDEVA(Number1, Number2 [, Number3 ...])

Description:

The STDEVA function is almost identical to the STDEV function (see note). It thus provides an estimate of the
standard deviation of the population based on a sample.

The standard deviation indicates the average amount by which the specified values deviate from the mean.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).

Note:

Unlike the STDEV function, STDEVA also evaluates logical values and text: FALSE is evaluated as 0, while
TRUE is evaluated as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Additional info:

The standard deviation is calculated using the "unbiased" or "n-1" method.



793Formulas and functions

Example:

STDEVA(2, 2, 3, 4, 1) returns 1.14018

See also:

STDEV.S/STDEV, STDEVPA

STDEVP (standard deviation of entire population)

Note: STDEVP is supplemented by the new identical function STDEV.P, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

STDEVP(Number1, Number2 [, Number3 ...])

Description:

This returns the standard deviation of an entire population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the standard deviation of a
sample, use the STDEV.S/STDEV function instead. This returns an estimate of the standard deviation.

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEVP(2, 2, 3, 4, 1) returns 1.0198

See also:

STDEV.P, STDEVPA, STDEV.S/STDEV, VAR.P/VARP, VAR.S/VAR
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STDEV.P (standard deviation of entire population)

Syntax:

STDEV.P(Number1, Number2 [, Number3 ...])

Description:

This returns the standard deviation of an entire population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the standard deviation of a
sample, use the STDEV.S/STDEV function instead. This returns an estimate of the standard deviation.

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEV.P(2, 2, 3, 4, 1) returns 1.0198

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

STDEVP, STDEVPA, STDEV.S/STDEV, VAR.P/VARP, VAR.S/VAR

STDEVPA (standard deviation of entire population)

Syntax:

STDEVPA(Number1, Number2 [, Number3 ...])
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Description:

The STDEVPA function is almost identical to the STDEVP function (see note). It returns the standard
deviation of an entire population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the standard deviation of a
sample, use the STDEVA function instead. This returns an estimate of the standard deviation.

Note:

Unlike the STDEVP function, STDEVPA also evaluates logical values and text: FALSE is evaluated as 0,
while TRUE is evaluated as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Additional info:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEVPA(2, 2, 3, 4, 1) returns 1.0198

See also:

STDEV.P/STDEVP

STDEV.S (standard deviation of a sample)

Syntax:

STDEV.S(Number1, Number2 [, Number3 ...])

Description:

This provides an estimate of the standard deviation of a population based on a sample.

The standard deviation indicates the average amount by which the specified values deviate from the mean.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.
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Additional info:

The standard deviation is calculated using the "unbiased" or "n-1" method.

Example:

STDEV.S(2, 2, 3, 4, 1) returns 1.14018

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

STDEV, STDEV.P/STDEVP, VAR.P/VARP, VAR.S/VAR

STEYX (standard error of a linear regression)

Syntax:

STEYX(y_values, x_values)

Description:

This returns the standard error of a linear regression.

The standard error is a measure of the reliability of a linear regression: the greater the standard error, the more
the estimated values deviate from the actual values.

For the arguments y_values and x_values, you usually specify a cell range.

Y_values are the dependent variables.

X_values are the independent variables.

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Additional info:

The linear regression is performed with this function using the least squares method.
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Example:

The resistance of a temperature-dependent resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures that were measured (the independent variables): 8, 20, 25, 28

Cells B1:B4 contain the resistances that were measured (the dependent variables): 261, 508, 608, 680

The following calculation returns the standard error predicted by linear regression based on these values:

STEYX(B1:B4, A1:A4) returns 4.97351

See also:

INTERCEPT, SLOPE, FORECAST

SUBSTITUTE (replace text in a text string)

Syntax:

SUBSTITUTE(Text, OldText, NewText [, n])

Description:

This replaces the OldText in a text string with the NewText.

Text is the original text string.

OldText is the text to be replaced. Note: This function is case-sensitive, thus it distinguishes between
uppercase and lowercase letters.

NewText is the replacement text.

The optional argument n specifies which occurrence of OldText should be replaced. If n is omitted, all
occurrences will be replaced.

Example:

SUBSTITUTE("aabbaabb", "aa", "xx") returns xxbbxxbb

SUBSTITUTE("aabbaabb", "aa", "xx", 2) returns aabbxxbb

SUBSTITUTE("aabbaabb", "AA", "xx") returns aabbaabb

See also:

FIND, SEARCH, REPLACE, REPT
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SUBTOTAL (calculations without hidden cells)

Syntax:

SUBTOTAL(FunctionID, Range1 [, Range2, Range3 ...])

Description:

This applies one of the arithmetic functions listed below to one or more cell ranges, ignoring all cells that are
currently hidden.

In detail: If you use the commands of the ribbon tab Data | group Filter to apply a filter to a cell range and then
perform arithmetic calculations on this range, cells that have been filtered out will still be included. If you use
the SUBTOTAL function, however, filtered cells will be ignored.

Range1, Range2, etc., are the cell ranges you want to evaluate.

FunctionID is a number between 1 and 11 that specifies which arithmetic function to apply:

Value Function Explanation

1: AVERAGE (arithmetic mean)

2: COUNT (number of cells filled with numbers)

3: COUNTA (number of cells filled)

4: MAX (maximum)

5: MIN (minimum)

6: PRODUCT (product)

7: STDEV (standard deviation of a sample)

8: STDEVP (standard deviation of entire population)

9: SUM (sum)

10: VAR (variance of a sample)

11: VARP (variance of entire population)

If, for example, you set FunctionID to 9, the SUBTOTAL function returns the sum of the specified cell
range(s) – but ignores all cells that have been hidden via the commands of the Sort button on the ribbon tab
Data | group Filter.

Ignoring manually hidden cells also:

There's a second variant of this function. In this case, all rows are ignored that have been hidden manually
(using, e.g., the ribbon command Home | group Cells | Visibility | Hide rows or the ribbon command Data |
group Outliner | Group).

To use this variant, simply set the FunctionID to a value between 101 and 111 instead of a value between 1 and
11, as shown in the following table:
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Value Function Explanation

101: AVERAGE (arithmetic mean)

102: COUNT (number of cells filled with numbers)

103: COUNTA (number of cells filled)

104: MAX (maximum)

105: MIN (minimum)

106: PRODUCT (product)

107: STDEV (standard deviation of a sample)

108: STDEVP (standard deviation of entire population)

109: SUM (sum)

110: VAR (variance of a sample)

111: VARP (variance of entire population)

If, for example, you set FunctionID to 109, SUBTOTAL returns the sum of the specified cell range(s) – but
ignores all cells that have been hidden via the commands of the ribbon tab Data | group Filter.

In addition, all rows will be ignored that were hidden manually via the ribbon command Home | group Cells |
Visibility | Hide rows or via the ribbon command Data | group Outliner | Group.

Please note: Only hidden rows will be ignored, while hidden columns will still be included in the calculations.

Example:

SUBTOTAL(9, A1:A10) returns the sum of the range A1:A10, but ignores all cells filtered out by the
commands of the ribbon tab Data | group Filter.

See also:

For more information on filters, see Filtering cells by their content.

SUM (Sum)

Syntax:

SUM(Number1 [, Number2, Number3 ...])

Description:

This returns the sum of the given numbers.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be summed.
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If you use this function with cell references (for example A1:A3), only numbers are considered, while text
strings and logical values occurring in the referenced cells are ignored.

However, the situation is different if you type fixed values directly into the formula: Here, numbers entered as a
text string (for example, "42") are included. Furthermore, the logical value TRUE is treated as 1 and FALSE as
0. See examples below.

Example:

SUM(1, 2, 3, 4) equals 1+2+3+4, which is 10

If the cells A1:A4 contain the values 1, 2, 3 and 4, the following applies:

SUM(A1:A4) equals 1+2+3+4, which is 10

Please note:

If the cells A1:A3 contain 1, "2" and TRUE:

SUM(A1:A3) returns 1, since the text string and the logical value are ignored.

They are counted only if they were typed as fixed values directly into the formula:

SUM(1, "2", TRUE) returns 1+2+1, which is 4

Additional info:

There are some special terms for the SUM formula, where PlanMaker automatically completes the formula with
additional functions. The following examples illustrate how it works:

If you enter SUM(A5:A), all values in column A are added, except A1:A4.

If you enter SUM(E2:2), all values in row 2 are added, except A2:D2.

If you enter SUM(A:A10), all values of A1:A10 are added.

If you enter SUM(2:E2), all values of A2:E2 are added.

Tip:

You can also use the AutoSum icon  on the ribbon tab Home | group Contents to quickly calculate the
sum of a specific cell range:

Select an empty cell just below a group of cells containing numbers and then click on the AutoSum icon. The
Sum function for the cell range above is now automatically inserted into the selected cell. You just have to
press the Enter key¿ to display the result.

Alternative method: Select a range of cells with numbers and then click on the AutoSum icon, which will insert
the sum of this cell range just below these cells.

You can also apply the AutoSum icon for several other arithmetic functions. To do so, click on the arrow to the
right of the icon. PlanMaker will open a dropdown list containing the available functions – for example, Count,
Product, Average, etc. Select the desired function from the list to apply it to a cell range using the methods just
described.

Note: The last selected function from the list will be applied again when you click directly on the AutoSum icon.
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See also:

PRODUCT, SUMPRODUCT, SUMIF, SUMIFS, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMIF (sum if condition is true)

Syntax:

SUMIF(Range, Criterion [, SumRange])

Description:

This returns the sum of those values in a cell range that fulfill the specified criterion.

Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

Use numbers or text (like "42" or "screws") to obtain the sum of all cells that contain the relevant value.

Use conditions (like ">10" or "<=5") to sum all cells that match the specified condition.

Note: Criteria always have to be enclosed within double quotation marks (").

SumRange (optional) lets you specify the cell range that contains the values to be summed. If SumRange is
omitted, the values in Range will be summed.

Example:

The cells A1:A5 contain the values 1, 2, 3, 2, 1.

Then the following applies:

SUMIF(A1:A5, "2") returns 2+2, which is 4

SUMIF(A1:A5, ">=2") returns 2+3+2, which is 7

You enter your daily income in a table as follows:



802Formulas and functions

How much is the sum of the sales if you only consider sales larger than €40?

SUMIF(D2:D5, ">40") results in €100.80

How many flowers of the type "roses" were sold?

SUMIF(C2:C5, "Roses", B2:B5) returns 18

In the above formula, the optional argument SumRange was used: A search was performed on the Range
C2:C5 (that is, the type), but the numbers to be added were taken from the SumRange B2:B5 (that is, the
number of pieces).

See also:

AVERAGEIF, AVERAGEIFS, SUM, SUMIFS, COUNTIF, COUNTIFS

SUMIFS (sum if conditions are true)

Syntax:

SUMIFS(SumRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This returns the sum of those values in a cell range that fulfill all of the specified criteria.

This function is similar to the SUMIF function, but it allows you to specify multiple search ranges (including
one criterion for each range).

Note: The order of the parameters is different here: In SUMIF, SumRange is the last parameter – while it is the
first parameter in SUMIFS.

SumRange is the cell range that contains the values to be summed.

Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as SumRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:

Use numbers or text (like "42" or "screws") to obtain the sum of all cells that contain this value.

Use conditions (like ">10" or "<=5") to sum all cells that match the specified condition.

Note: Criteria always have to be enclosed within double quotation marks (").

Unlike the SUMIF function, SUMIFS allows you to specify multiple search ranges (including one criterion for
each range). If you do so, only occurrences where all criteria are fulfilled are included in the calculation of the
sum.
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Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced with their current result as a fixed
value.

If you want to use this function, you should not save your document in the "Microsoft Excel 97-2003 (.xls)" file
format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

SUMIFS(A1:A10, C1:C10, ">1", C1:C10, "<2")

This formula returns the sum of only those cells in the cell range A1:A10 where the corresponding cell in the
range C1:C10 is greater than 1 and less than 2.

See also:

AVERAGEIF, AVERAGEIFS, SUM, SUMIF, ZÄHLENWENN, COUNTIFS

SUMPRODUCT (sum of products)

Syntax:

SUMPRODUCT(Range1 [, Range2, Range3 ...])

Description:

This multiplies the corresponding elements of two or more arrays and returns the sum of these products.

Range1, Range2, etc., are cell ranges or arrays that contain the values to be evaluated. As a rule, you must
specify the cell ranges which contain the values here.

All ranges must have the same number of rows and columns, otherwise the function returns a #N/A error value.

Empty cells and cells with non-numeric content (strings, logical values, etc.) are interpreted as zero.

Example:

You have created a document in which you enter your inventory.

The document contains two areas of equal size. In the first area, the quantities of the articles are entered. In the
second area, the corresponding unit prices are entered.
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In order to calculate the total value of all articles, the quantities of each item must be multiplied by their
respective unit price. Finally, the sum of these products must be calculated.

This entire calculation can be combined with the SUMPRODUCT function:

SUMPRODUCT(B4:C6, B11:C13) returns 12710.

Thus, there are currently articles with a total value of €12710 in your inventory.

See also:

SUM, SUMSQ, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMSQ (sum of squares)

Syntax:

SUMSQ(Number1 [, Number2, Number3 ...])

Description:

This returns the sum of the squares of the given numbers.

Example:

SUMSQ(1, 2, 3) equals 1^2 + 2^2 + 3^2, which is 14.
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See also:

SUM, SUMPRODUCT, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMX2MY2 (sum of x^2 - y^2)

Syntax:

SUMX2MY2(Range1, Range2)

Description:

This returns the sum of the difference of squares of corresponding values in two arrays.

The equation for this function is:

SUMX2MY2 = å(x^2 - y^2)

Range1 and Range2 are the arrays whose SumX2MY2 is to be calculated. As a rule, you must specify the cell
ranges which contain the values here.

Both ranges must have the same number of rows and columns, otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numeric value (text string or logical value) are
ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMX2MY2(A1:A3, B1:B3) here, this is equivalent to the following calculation:

(9^2) - (1^2) + (4^2) - (0^2) + (7^2) - (5^2)

The result is 120.

See also:

SUM, SUMPRODUCT, SUMX2PY2, SUMXMY2, SUMSQ
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SUMX2PY2 (sum of x^2 + y^2)

Syntax:

SUMX2PY2(Range1, Range2)

Description:

This returns the sum of the sum of squares of corresponding values in two arrays.

The equation for this function is:

SUMX2PY2 = å(x^2 + y^2)

Range1 and Range2 are the arrays whose sumX2PY2 is to be calculated. As a rule, you must specify the cell
ranges which contain the values here.

Both ranges must have the same number of rows and columns, otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numeric value (text string or logical value) are
ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMX2PY2(A1:A3, B1:B3) here, this is equivalent to the following calculation:

(9^2) + (1^2) + (4^2) + (0^2) + (7^2) + (5^2)

The result is 172.

See also:

SUM, SUMPRODUCT, SUMX2MY2, SUMXMY2, SUMSQ

SUMXMY2 (sum of (x - y)^2)

Syntax:

SUMXMY2(Range1, Range2)
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Description:

This returns the sum of squares of differences of corresponding values in two arrays.

The equation for this function is:

SUMXMY2 = å(x - y)^2

Range1 and Range2 are the arrays whose SumXMY2 is to be calculated. As a rule, you must specify the cell
ranges which contain the values here.

Both ranges must have the same number of rows and columns, otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numeric value (text string or logical value) are
ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMXMY2(A1:A3, B1:B3) here, this is equivalent to the following calculation:

(9-1)^2 + (4-0)^2 + (7-5)^2

The result is 84.

See also:

SUM, SUMPRODUCT, SUMX2MY2, SUMX2PY2, SUMSQ

SWITCH (categorize initial value)

Syntax:

SWITCH(Calculation, Result1, Value1 [, Result2, Value2 ...] [, DefaultValue])

Description:

This function checks an initial value and compares it to a series of defined values for the first match.

Calculation is the initial value and can be any expression.

Result1 is the first element to be compared with the initial value for Calculation.

Value1 is to be returned if Result1 matches the initial value for Calculation.

Result2; Value2 (optional) is the second compared element, etc.



808Formulas and functions

Once the first match is found, its assigned value is returned.

Note:

If no match is found, the #N/A error is returned.

However, you can set a DefaultValue instead at the end of the formula, which will be returned if no match is
found (see example 2 below).

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

Example 1:

If a specific number is found in cell A1, PlanMaker should output a name defined for this purpose. The
following key applies: 1 stands for Lisa, 2 stands for Peter, 3 stands for Anna.

The formula SWITCH(A1, 1, "Lisa", 2, "Peter", 3, "Anna"), for example, then returns the following:

If cell A1 contains the number 1 = Lisa

If cell A1 contains the number 2 = Peter

If cell A1 contains the number 3 = Anna

If cell A1 contains anything other than 1, 2, or 3, the formula returns the result #N/A because no match was
found. Alternatively, you can determine which default value the formula generally returns if no match is found
(see example 2).

Example 2:

You have the same initial situation as in example 1. At the end of the formula, set a default value that will be
returned if no match is found:

SWITCH(A1, 1, "Lisa", 2, "Peter", 3, "Anna", "no match")

If, for example, cell A1 contains 4, the result "no match" is returned.

See also:

IF, IFS, VLOOKUP, CHOOSE

SYD (sum-of-years’ digits depreciation)

Syntax:

SYD(Cost, Salvage, Life, Per)
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Description:

This returns the depreciation of an asset for the specified period, using the sum-of-years' digits method.

The function expects the following arguments:

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Note:

This function is only partially applicable to the tax law of some countries (for example, Germany)!

Example:

In the case of a machine purchased for €200,000 that is used for 10 years and then has a salvage value of
€10,000, the following annual depreciation amount must be applied for the first year:

SYD(200000, 10000, 10, 1) returns €34,545.45 (depreciation in year 1)

See also:

DBB, DB, SLN

T (convert value into text string)

Syntax:

T(Value)

Description:

This converts a value into a text string.

The specified value must be a text string, otherwise the function returns an empty text string.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert values into text strings if
necessary.
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Example:

T("Text") returns Text

T("42") returns 42

T(42) returns an empty text string

T(TRUE) returns an empty text string

See also:

N, VALUE, TEXT

TAN (tangent)

Syntax:

TAN(Number)

Description:

This returns the tangent of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Example:

TAN(PI()/4) returns 1

TAN(RADIANS(45)) returns 1

See also:

ATAN, ATAN2, COT, SIN, COS
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TANH (hyperbolic tangent)

Syntax:

TANH(Number)

Description:

This returns the hyperbolic tangent of a Number.

Example:

TANH(0.45) returns 0.4219

See also:

ATANH, COSH, SINH

TDIST (t-distribution)

Note: TDIST is supplemented by the new functions T.DIST.2T, T.DIST.RT and T.DIST with additional
functionalities, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

TDIST(X, DegreesFreedom, Tails)

Description:

This returns the probability of the Student's t-distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution
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See also:

T.DIST.2T/T.DIST.RT/T.DIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

T.DIST (t-distribution)

Syntax:

T.DIST(X, DegreesFreedom, Cumulative)

Description:

This returns the probability of the Student's t-distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the left-tailed Student's t-distribution is calculated. By entering the value FALSE, the
probability density function of the Student's t-distribution is calculated.

Note:

The T.DIST, T.DIST.2T and T.DIST.RT functions supplement the previous TDIST function, whereby T.DIST
has the additional argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

T.DIST.2T/T.DIST.RT/TDIST, T.INV/T.INV.2T/TINV, T.TEST/TTEST

T.DIST.2T (t-distribution two-tailed)

Syntax:

T.DIST.2T(X, DegreesFreedom)
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Description:

This returns the probability of the two-tailed Student's t-distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Note:

The T.DIST.2T function, T.DIST.RT and T.DIST functions supplement the previous TDIST function, whereby
T.DIST.2T returns the same result as TDIST with the argument Tails=2.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

T.DIST.RT/T.DIST/TDIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

T.DIST.RT (t-distribution right-tailed)

Syntax:

T.DIST.RT(X, DegreesFreedom)

Description:

This returns the probability of the right-tailed Student's t-distribution.

X is the value whose probability is to be calculated. X 

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Note:

The T.DIST.RT, T.DIST.2T and T.DIST functions supplement the previous TDIST function, whereby
T.DIST.RT returns the same result as TDIST with the argument Tails=1.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.
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See also:

T.DIST.2T/T.DIST/TDIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

TEXT (convert number into text string)

Syntax:

TEXT(Number, Format)

Description:

This converts a number into a text string in the specified number format.

Use the argument Format to specify the desired format. Enter a corresponding text string here. This must be
structured like a text string that you create when creating custom number formats in the dialog box of the ribbon
tab Home | group Number  (see Structure of a custom number format).

Additional info:

To change the format of numbers without having to convert them into a text string, choose the commands of the
ribbon tab Home | group Number and select the desired number format.

Example:

TEXT("9/25/2018", "MM/DD/YY") returns 09/25/18 (as a text string)

TEXT(2.715, "0.00 ""USD""") returns 2.72 USD (as a text string)

See also:

VALUE, T, N, FIXED

TEXTJOIN (concatenate strings with separators)

Syntax:

TEXTJOIN(Separator, IgnoreEmptyCells, String1 [, String2 ...])
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Description:

This combines two or more text strings into one text string. Unlike the CONCAT function, you can use
TEXTJOIN to specify separators between text strings. You can also specify whether empty cells should be
ignored.

Separator is the desired separator between text strings. If omitted, no separator is used.

IgnoreEmptyCells determines whether empty cells should be ignored. TRUE or omitted ignores empty cells,
while FALSE also concatenates empty cells.

String1, String2 etc., are the cells with text strings to be connected.

Example:

In the figure below, column G shows the result for the following formulas:

In row2, the formula is TEXTJOIN(",", TRUE, A2:E2)

In row3 (with an empty cell B3), the formula is TEXTJOIN(",", TRUE, A3:E3)

In row4 (with an empty cell B4), the formula is TEXTJOIN(",", FALSE, A4:E4)

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. The function is unknown in older versions.

See also:

CONCAT, CONCATENATE

TIME (create time)

Syntax:

TIME(Hour, Minute, Second)
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Description:

This returns a serial date value based on the specified Hour, Minute and Second.

Example:

TIME(0, 20, 0) returns 0.01389, the serial date value for the corresponding time.

However, PlanMaker automatically formats this date value in the number format "Date/Time", thus the cell
displays: 00:20:00.

See also:

TIMEVALUE, DATE, DATEVALUE

TIMEDIFF (time difference)

Syntax:

TIMEDIFF(StartTime, EndTime)

Description:

This returns the time elapsed between two time values.

A time must be specified for StartTime and EndTime.

You can also specify a date with a time (see last example), but in this case both StartTime and EndTime have
to include a date, otherwise a #VALUE! error value is returned.

Note:

Compared to simply subtracting time values, this function has the following advantage when EndTime is
smaller than StartTime:

An employee starts his shift, for example, at 10:00 pm and leaves at 6:00 am. If calculating his hours of work
by subtracting 10:00 pm from 6:00 am, the result would be -16 hours. If the TIMEDIFF function is used, the
correct result (8 hours) is returned.

Example:

TIMEDIFF("8:00 AM", "4:00 PM") returns 8:00

TIMEDIFF("10:00 PM", "6:00 AM") returns 8:00

TIMEDIFF("10/01/2018 10:00 PM", "10/02/2018 6:00 AM") returns 8:00
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Compatibility notes:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

See also:

TIME, TIMEVALUE, DAYS/DAYSP, DAYS360

TIMEVALUE (convert text into time)

Syntax:

TIMEVALUE(Text)

Description:

This converts a text string representing a date into a serial time value.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert times specified as text
into date/time values if necessary.

Example:

TIMEVALUE("10:30:00 am") returns 0.4375.

If you now format this using the options of the ribbon tab Home | group Number  in one of the date/time
formats (for example, h:mm), the cell will display the time behind this value: 10:30.

See also:

DATEVALUE, DATE, TIME

TINV (percentiles of the t-distribution)

Note: TINV is supplemented by the new identical function T.INV.2T and the completely new function
T.INV, which are available in newer versions of Microsoft Excel (2010 or later).
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Syntax:

TINV(Probability, DegreesFreedom)

Description:

This returns the inverse of the two-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. The values must be within the range 0 to 1.

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Please note: The result of this function is calculated using an iteration method. If, after 100 iterations,
PlanMaker does not find a result that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and cancels the approximation.

See also:

T.INV.2T/T.INV, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

T.INV (percentiles of the t-distribution left-tailed)

Syntax:

T.INV(Probability, DegreesFreedom)

Description:

This returns the inverse of the left-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. The values must be within the range 0 to 1.

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Please note: The result of this function is calculated using an iteration method. If, after 100 iterations,
PlanMaker does not find a result that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and cancels the approximation.

Note:

The T.INV and T.INV.2T functions supplement the previous TINV function.

T.INV.2T returns the same result as TINV (two-tailed percentiles).

T.INV (left-tailed percentiles) is completely new.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

TINV/T.INV.2T, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

T.INV.2T (percentiles of the t-distribution two-tailed)

Syntax:

T.INV.2T(Probability, DegreesFreedom)

Description:

This returns the inverse of the two-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. The values must be within the range 0 to 1.

DegreesFreedom 
not the case, PlanMaker automatically truncates the decimal places.

Please note: The result of this function is calculated using an iteration method. If, after 100 iterations,
PlanMaker does not find a result that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and cancels the approximation.

Note:

The T.INV.2T and T.INV functions supplement the previous TINV function.

T.INV.2T returns the same result as TINV (two-tailed percentiles).

T.INV (left-tailed percentiles) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

TINV/T.INV, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST
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TODAY (current date)

Syntax:

TODAY()

Description:

This returns the current system date (without time).

The displayed value is dynamic, so it is automatically updated when the document is opened.

Note:

The result is a number – like all dates in a spreadsheet. PlanMaker automatically formats it in the date format
MM.DD.YYYY so that it will be displayed as a date. You can use the options from the ribbon tab Home |
group Number  to adjust the displayed date format to your needs.

Example:

TODAY() results in 07/31/2018

See also:

NOW, CREATEDATE

TRANSPOSE (transpose matrix)

Syntax:

TRANSPOSE(Array)

Description:

This returns the transpose of a matrix, i.e., swaps its columns with its rows. When you transpose, for example, a
2x4 matrix, the result is a 4x2 matrix.

Array is a cell range or array containing the matrix to be evaluated.
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Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Please note that the range to be selected before entering the formula must have the correct dimensions. If the
matrix consists of x rows and y columns, the resulting range must have y rows and x columns.

Example:

TRANSPOSE({1,2,3;4,5,6}) returns {1,4;2,5;3,6}

See also:

Section Working with arrays, MDETERM, MINVERSE, MMULT, MSOLVE

TREND (values of a linear regression)

Syntax:

TREND(y_values [, x_values] [, New_x_values] [, Constant])

Description:

This returns the values of a linear regression.

Linear regression is a statistical technique that adapts a line (called "trendline" or "best-fit line") to a set of data
points (for example, the results of a series of measurements).

The TREND function returns an array with the y values of a trendline calculated from the given y values and x
values.

To clarify, the function expects the following arguments:

y_values: Here, you specify the existing y coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.

x_values: Here, you have the option of specifying the x coordinates, that is, the independent values. x_values
can also be either a cell reference or an array. If x_values are omitted, the function automatically uses the
values 1, 2, 3, ... (according to the number of existing y_values).

New_x_values (optional) are the x values for which you want to determine the corresponding y values on the
curve. If omitted, the values in x_values will be used. If required, however, you can specify other x coordinates
with New_x_values. New_x_values can also be either a cell reference or an array.

Constant (optional) is a logical value that lets you specify if the constant b (the y-intercept point) should be set
to zero:
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TRUE or omitted: b is automatically calculated from the available data.

FALSE: b is set to zero. This forces the trendline to run through the zero point. The m coefficient(s) are
adjusted accordingly.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Additional info:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-dependent resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures that were measured (the independent variables): 8, 20, 25, 28

Cells B1:B4 contain the resistances that were measured (the dependent variables): 261, 508, 608, 680

The following calculation returns an array with the y coordinates of a best-fit line calculated from these values:

TREND(B1:B4, A1:A4)

See also:

LINEST, LOGEST, GROWTH, FORECAST

TRIM (remove spaces from text)

Syntax:

TRIM(Text)

Description:

This removes all spaces at the beginning and end of the specified text string.

Example:

TRIM("    Text  ") returns text
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See also:

CLEAN

TRIMMEAN (mean without marginal values)

Syntax:

TRIMMEAN(Area, Percentage)

Description:

This returns the mean of the values in the middle of a data set (by excluding the specified percentage of extreme
values).

"Extreme values" are the smallest and largest values of a data set. These are often "outliers" (unusually low or
high values, for example, due to a measurement error).

Area is the cell range or array to evaluate.

Percentage is the percentage of values to be excluded.

If, for example, 100 values are given and Percentage is set to 10%, 10 values will be excluded: the 5 lowest
and the 5 highest.

Note: For symmetrical purposes, the number of excluded values will automatically be rounded down to a
multiple of 2. If, for example, 30 values are given and Percentage is set to 10%, only 2 values will be excluded
instead of 3.

Example:

Cells A1:A10 contain the following values: 43, 45, 42, 0, 44, 45, 42, 1234, 40, 41

As you can see, two values are exceptionally low/high (e.g., due to a measurement error): 0 and 1234. If you
used the AVERAGE function, you would thus obtain an unusable average:

AVERAGE(A1:A10) returns 159.2

If you use TRIMMEAN instead and, for example, exclude 20% of the top and bottom values – in this case,
these are conveniently exactly the two outliers among the 10 values – a useful average value is returned:

TRIMMEAN(A1:A10, 20%) returns 42.75

See also:

AVERAGE, GEOMEAN, HARMEAN
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TRUE (logical value TRUE)

Syntax:

TRUE()

Description:

This returns the logical value TRUE.

See also:

FALSE

TRUNC (truncate a number)

Syntax:

TRUNC(Number [, n])

Description:

This returns the given number truncated to n digits after the decimal point.

n is the desired number of decimal places.

If n is omitted, Number is truncated to an integer.

If n is a negative value, Number is truncated to the left of the decimal point (see last example). 

Example:

TRUNC(5.779) returns 5

TRUNC(5.779, 2) returns 5.77

TRUNC(1234, -2) returns 1200

Additional info:

To obtain the decimal places, use the DECIMALS function.
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See also:

ROUNDDOWN, ROUNDUP, DECIMALS, ROUND

TTEST (t-test)

Note: TTEST is supplemented by the new identical function T.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

TTEST(Array1, Array2, Tails, Type)

Description:

This returns the result of a Student's t-test.

A t-test can be used to check the consistency of the means of two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution

Type is the type of t-test:

1: dependent samples ("paired")

2: independent samples, equal variances ("homoscedastic")

3: independent samples, different variances ("heteroscedastic")

See also:

T.TEST, T.INV.2T/T.INV/TINV, T.DIST.2T/T.DIST.RT/T.DIST/TDIST
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T.TEST (t-test)

Syntax:

T.TEST(Array1, Array2, Tails, Type)

Description:

This returns the result of a Student's t-test.

A t-test can be used to check the consistency of the means of two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution

Type is the type of t-test:

1: dependent samples ("paired")

2: independent samples, equal variances ("homoscedastic")

3: independent samples, different variances ("heteroscedastic")

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

TTEST, T.INV.2T/T.INV/TINV, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

TYPE (type of a value)

Syntax:

TYPE(Value)
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Description:

This returns the type of the specified Value in the form of a number.

You can see which number stands for which type in the following table:

"Value" is a ... Result

Number or empty cell 1

Text string 2

Boolean 4

Error value 16

Array 64

Example:

TYPE(42) returns 1

If A1 contains the text string "Text", the following applies:

TYPE(A1) returns 2

See also:

ERRORTYPE

UPPER (convert text to uppercase)

Syntax:

UPPER(Text)

Description:

This converts all letters in a text string into uppercase letters.

Example:

UPPER("PlanMaker") returns PLANMAKER
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See also:

PROPER, LOWER

USERFIELD (output user info)

Syntax:

USERFIELD(FieldName)

Description:

This returns the content of one of the fields with your user information (name, address, etc.) entered in
PlanMaker's settings dialog.

Note: You can edit your user information by choosing the command File | Options , switching to the
General tab and clicking on the User info button.

FieldName is the name of the field to be returned (see table below).

It is not case-sensitive. Note, however, that FieldName must always be enclosed within double quotation marks
(") – as in USERFIELD("User.City").?

FieldName can be one of the following text strings:

User info field Field name

Title User.Title

Name User.Name

Initials User.Initials

Company User.Company

Department User.Department

Address 1 User.Address 1

Address 2 User.Address 2

State, ZIP User.ZIP

City User.City

Country User.Country

Phone 1 User.Phone 1

Phone 2 User.Phone 2

Phone 3 User.Phone 3
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Fax User.Fax

E-mail 1 User.E-mail 1

E-mail 2 User.E-mail 2

E-mail 3 User.E-mail 3

Web site User.Website

Compatibility note 1:

This function does not exist in Microsoft Excel. If you save a document in Excel format, all calculations using
this function will be replaced with their current result as a fixed value.

Compatibility note 2:

In PlanMaker 2016 and older, there were two sets of user data: "User (home)" and "User (business)". These
have been reduced to one set since PlanMaker 2018. When you open an old document that uses this function,
its parameters are automatically converted accordingly.

Example:

USERFIELD("User.Website") returns www.softmaker.com

VALUE (convert text into a number)

Syntax:

VALUE(Text)

Description:

This converts a text string into a number.

Text is the text string to be converted. It must contain the text representation of a number, otherwise a
#VALUE! error value is returned.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert text strings into numbers
if necessary.
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Example:

VALUE("42") returns 42

VALUE("42 USD") returns 42, since "USD" is a valid currency unit.

VALUE("42 screws") returns a #VALUE! error value.

VALUE("TRUE") returns 1

VALUE("09/25/2014") returns 41907, the serial date value for the date 09/25/2014.

See also:

NUMBERVALUE, TEXT, T, N

VAR (variance of a sample)

Note: VAR is supplemented by the new identical function VAR.S, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

VAR(Number1, Number2 [, Number3 ...])

Description:

This provides an estimate of the variance of a population based on a sample.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VAR(2, 2, 3, 4, 1) returns 1.3

See also:

VAR.S, VARA, VARPA, VAR.P/VARP, STDEV.S/STDEV, STDEV.P/STDEVP
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VARA (variance of a sample)

Syntax:

VARA(Number1, Number2 [, Number3 ...])

Description:

The VARA function is almost identical to the VAR function (see note). It thus provides an estimate of the
variance of a population based on a sample.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).

Note:

Unlike the VAR function, VARA also evaluates logical values and text: FALSE is evaluated as 0, while TRUE
is evaluated as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Additional info:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VARA(2, 2, 3, 4, 1) returns 1.3

See also:

VAR.S/VAR, VARPA

VARP (variance of entire population)

Note: VARP is supplemented by the new identical function VAR.P, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

VARP(Number1, Number2 [, Number3 ...])
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Description:

This returns the variance of an entire population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the variance of a sample, use the
VAR.S/VAR function instead. This returns an estimate of the variance.

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The variance is calculated using the "biased" or "n" method.

Example:

VARP(2, 2, 3, 4, 1) returns 1.04

See also:

VAR.P, VAR.S/VAR, STDEV.S/STDEV, STDEV.P/STDEVP

VAR.P (variance of entire population)

Syntax:

VAR.P(Number1, Number2 [, Number3 ...])

Description:

This returns the variance of an entire population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the variance of a sample, use the
VAR.S/VAR function instead. This returns an estimate of the variance.

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The variance is calculated using the "biased" or "n" method.



833Formulas and functions

Example:

VAR.P(2, 2, 3, 4, 1) returns 1.04

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

VARP, VAR.S/VAR, STDEV.S/STDEV, STDEV.P/STDEVP

VARPA (variance of entire population)

Syntax:

VARPA(Number1, Number2 [, Number3 ...])

Description:

The VARPA function is almost identical to the VARP function (see note). It returns the variance of an entire
population.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated. Please
note that all values of the entire population have to be specified. To calculate the variance of a sample, use the
VARA or VAR.S/VAR function instead. This returns an estimate of the variance.

Note:

Unlike the VARP function, VARPA also evaluates logical values and text: FALSE is evaluated as 0, while
TRUE is evaluated as 1. Text is evaluated as 0.

Empty cells, however, are also ignored here.

Example:

VARPA(2, 2, 3, 4, 1) returns 1.04

See also:

VAR.P/VARP, VAR.S/VAR, VARA
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VAR.S (variance of a sample)

Syntax:

VAR.S(Number1, Number2 [, Number3 ...])

Description:

This provides an estimate of the variance of a population based on a sample.

Number1, Number2, etc., are single values, cell ranges or arrays that contain the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, they are ignored. Likewise, cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus taken into account.

Additional info:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VAR.S(2, 2, 3, 4, 1) returns 1.3

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

VAR, VARA, VAR.P/VARP, VARPA, STDEV.S/STDEV, STDEV.P/STDEVP

VLOOKUP (look up column-wise)

Syntax:

VLOOKUP(Crit, Range, n [, Sorted])
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Description:

This function searches in the first column of Range for the first occurrence of Crit. If found, the function
returns the content of the cell located in the same row and n-th column of Range.

Note: VLOOKUP can only search vertically. To search horizontally, use HLOOKUP instead.

Crit is the value for which the search is performed (case-insensitive).

Range is the cell range or array to be evaluated. Its first column should contain the values to be scanned. These
can be text strings, numbers or logical values.

n is the relative column number in Range from which a value will be returned if Crit is found.

If n is less than 1, a #VALUE! error value is returned. If n is greater than the total number of columns in
Range, a #REF! error value is returned.

Sorted is a logical value that you use to specify whether the values in the first column of Range are sorted:

If Sorted is TRUE or omitted, values in the first column of Range have to be sorted in ascending order.

If Sorted is FALSE, the order of the values in the first column is irrelevant.

Important: If you do not explicitly set Sorted to FALSE, these values must be in sorted order!

Note:

If Sorted is set to TRUE and VLOOKUP does not find a value that exactly matches Crit, the next smaller
value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the
#N/A error value.

Example:

You sell flowers at different unit prices – depending on the amount of flowers the customer buys. To do so, you
have created a table with a discount scale:

You can now use the VLOOKUP function to determine the price for a specific type of flower depending on the
number of pieces.

Use the following arguments:

For Crit, you enter the name of the flower type (i.e., "roses", "carnations" or "tulips").
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For Range, you enter the cell range that contains the names of the flower types in the first column and the
prices to the right of them – A2:D4 here.

For n, you enter the number of pieces plus one, as the first column (n=1) contains the names of the flowers
rather than the prices.

Examples:

VLOOKUP("Roses", A2:D4, 2, FALSE) returns the unit price when purchasing one rose, i.e., €5.50.

VLOOKUP("Roses", A2:D4, 3, FALSE) returns the unit price when purchasing two roses, i.e., €5.10.

VLOOKUP("Roses", A2:D4, 4, FALSE) returns the unit price when purchasing three roses, i.e., €4.95.

VLOOKUP("Carnations", A2:D4, 4, FALSE) returns the unit price when purchasing three carnations, i.e.,
€4.50.

VLOOKUP("Carnations", A2:D4, 5, FALSE) returns the #REF error value because n is greater than the column
number of Range.

VLOOKUP("Petunias", A2:D4, 4, FALSE) returns the #N/A error value because "Petunias" does not appear in
the first column of Range.

See also:

HLOOKUP, LOOKUP, INDEX, MATCH, SWITCH, CHOOSE, IFS

WEEKDAY (weekday)

Syntax:

WEEKDAY(Date [, Mode])

Description:

This returns the day of the week of a date as a number (from 1 to 7 or from 0 to 6).

Mode (optional) lets you change the type of values to be returned:

1 or omitted: Numbers from 1 (Sunday) to 7 (Saturday) are returned.

2: Numbers from 1 (Monday) to 7 (Sunday) are returned.

3: Numbers from 0 (Monday) to 6 (Sunday) are returned.

Example:

WEEKDAY("09/25/1966") returns 1 (i.e., Sunday)

WEEKDAY("09/25/1966", 2) returns 7 (i.e., Sunday)
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See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, YEAR, MONTH, DAY

WEEKNUM (week number)

Syntax:

WEEKNUM(Date [, WeekStartsOn])

Description:

This returns the week number of a Date.

For this purpose, the calculation method commonly used in the USA and many other parts of the world is
applied: The first calendar week of the year is always the week that contains January 1st.

According to this method, the first calendar week cannot start in the previous year and does not include a full 7
days in most cases.

Note:

In Germany (and some other countries like Switzerland and Austria), a different method of calculation is
normally used; here, it is based on the ISO standard. See ISOWEEKNUM function (or see below
WeekStartsOn with value variant "21").

Important:

Also note that by default, this function considers Sunday as the start of the week – not Monday.

However, you can change this with the optional argument WeekStartsOn. WeekStartsOn lets you specify on
which day a week starts:

1 or omitted: Week starts on a Sunday.

2: Week starts on a Monday.

In addition, the following variants are also defined:

11: Week starts on a Monday.

12: Week starts on a Tuesday.

13: Week starts on a Wednesday.

14: Week starts on a Thursday.

15: Week starts on a Friday.

16: Week starts on a Saturday.

17: Week starts on a Sunday.
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21: Week starts on a Monday. Here, the first calendar week of the year is the week that contains January 4th, in
accordance with the ISO standard.

Compatibility notes:

Microsoft Excel supports the values 11-17 and 21 for the argument WeekStartsOn only in version 2010 or
later. In older versions, these values are not known.

Example:

On Sunday, January 5, 2020:

WEEKNUM("01/05/2020", 1) returns 2

WEEKNUM("01/05/2020", 2) returns 1

See also:

ISOWEEKNUM, ISOWEEK, YEAR, MONTH, DAY, WEEKDAY

WEIBULL (Weibull distribution)

Note: WEIBULL is supplemented by the new identical function WEIBULL.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

WEIBULL(x, Alpha, Beta, Cumulative)

Description:

This returns the probabilities of a Weibull distributed random variable.

The Weibull distribution is an extension of the exponential distribution (see function
EXPON.DIST/EXPONDIST) to events that are not purely random and do not exactly match the Poisson
distribution (see function POISSON.DIST/POISSON).

It is used especially for reliability analysis.

x is the value whose probability is to be calculated. x 

Alpha is a parameter of the distribution. Alpha determines the shape of the distribution curve. If Alpha = 1, the
Weibull distribution equals an exponential distribution with Lambda = 1/Beta.

Beta is another parameter of the distribution. Beta determines the scaling of the distribution curve, i.e., it
stretches or compresses the function graph.

Both parameters have to be greater than zero.
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You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

WEIBULL(42, 2, 100, TRUE) returns 0.16172

WEIBULL(42, 2, 100, FALSE) returns 0.00704

See also:

WEIBULL.DIST, EXPON.DIST/EXPONDIST, POISSON.DIST/POISSON

WEIBULL.DIST (Weibull distribution)

Syntax:

WEIBULL.DIST(x, Alpha, Beta, Cumulative)

Description:

This returns the probabilities of a Weibull distributed random variable.

The Weibull distribution is an extension of the exponential distribution (see function
EXPON.DIST/EXPONDIST) to events that are not purely random and do not exactly match the Poisson
distribution (see function POISSON.DIST/POISSON).

It is used especially for reliability analysis.

x is the value whose probability is to be calculated. x 

Alpha is a parameter of the distribution. Alpha determines the shape of the distribution curve. If Alpha = 1, the
Weibull distribution equals an exponential distribution with Lambda = 1/Beta.

Beta is another parameter of the distribution. Beta determines the scaling of the distribution curve, i.e., it
stretches or compresses the function graph.

Both parameters have to be greater than zero.

You use the logical value Cumulative to specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.
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Example:

WEIBULL.DIST(42, 2, 100, TRUE) returns 0.16172

WEIBULL.DIST(42, 2, 100, FALSE) returns 0.00704

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

WEIBULL, EXPON.DIST/EXPONDIST, POISSON.DIST/POISSON

WORKDAY (date after x workdays)

Syntax:

WORKDAY(StartDate, Days [, Holidays])

Description:

This determines the date that is x workdays before or after the StartDate.

This function counts workdays only, thus skipping Saturdays and Sundays. You also have the option of
specifying a list of holidays to be skipped as well (see Holidays parameter).

StartDate is the start date.

Days is the number of workdays. A positive value will return a date in the future, while a negative value will
return a date in the past.

Holidays (optional) is a cell range or an array containing a list of dates to be skipped (for example, holidays).
(This is usually done using a cell range or an array containing the corresponding date values.)

Example:

WORKDAY("10/1/2016", 9) returns 10/13/2016.

The date that comes 9 work days after 10/1/2016 is thus 10/13/2016.

However, 10/3/2016, for example, was a holiday in Germany. If you wanted to take this into account, you
would have to write:

WORKDAY("10/1/2016", 9, "10/3/2016") – which results in 10/14 instead of 10/13, since the holiday on 10/3
fell on a weekday and thus is skipped in the count.
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See also:

HOLIDAY, NETWORKDAYS

XIRR (internal rate of return)

Syntax:

XIRR(Values, Dates [, Guess])

Description:

This returns an estimate of the internal rate of return of an investment with irregular cash flows.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, and income as positive values. Payments may be made at any time. The date of each cash flow
has to be specified using the Dates argument.

The function expects the following arguments:

For Values, you specify a cell range or array in which the cash flows were entered. There must be at least one
payment and one income.

Dates is a cell range or array containing the dates for each cash flow specified in Values.

Guess (optional) lets you specify an estimate for the result (see note below).

Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try specifying a different value for Guess.

See also:

IRR, NPV, MIRR, XNPV, RATE

XNPV (net present value)

Syntax:

XNPV(Rate, Values, Dates)
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Description:

This returns the net present value of an investment with irregular cash flows.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, and income as positive values. Payments may be made at any time. The date of each cash flow
has to be specified using the Dates argument.

The function expects the following arguments:

Rate is the discount rate to apply to the cash flows.

For Values, you specify a cell range or array in which the cash flows were entered. There must be at least one
payment and one income.

Dates is a cell range or array containing the dates for each cash flow specified in Values.

See also:

NPV, XIRR

XOR (logical XOR function)

Syntax:

XOR(Value1 [, Value2, Value3 ...])

Description:

XOR ("exclusive or") returns the logical value TRUE if an odd number of the arguments are TRUE, otherwise
it returns FALSE.

This function is often used with only two arguments. Here, the following applies: If either one or the other
argument is TRUE, it returns TRUE. On the other hand, if both are TRUE or both are FALSE, it returns
FALSE.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. The function is unknown in older versions.

Example:

XOR(TRUE, TRUE) returns FALSE

XOR(TRUE, FALSE) returns TRUE

XOR(FALSE, TRUE) returns TRUE
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XOR(FALSE, FALSE) returns FALSE

See also:

OR, AND, NOT

YEAR (year of a date)

Syntax:

YEAR(Date)

Description:

This returns the year of a date.

Example:

YEAR("09/25/2018") returns 2018

If cell A1 contains the date value 9/25/2018: YEAR(A1) returns 2018

See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, MONTH, DAY, DAYSPERYEAR, WEEKDAY

ZTEST (z-test)

Note: ZTEST is supplemented by the new identical function Z.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

ZTEST(Area, x [, Sigma])

Description:

This returns the one-tailed probability of a z-test.

You can use this function to check the probability that a sample comes from a certain population.
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Area is a cell reference to the area against which x is to be tested. There should be at least 30 values.

x is the value to be tested.

Sigma (optional) is the standard deviation s of the population (if known). If omitted, PlanMaker automatically
uses the standard deviation of the given sample (i.e., the values in Area).

See also:

Z.TEST, STANDARDIZE, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

Z.TEST (z-test)

Syntax:

Z.TEST(Area, x [, Sigma])

Description:

This returns the one-tailed probability of a z-test.

You can use this function to check the probability that a sample comes from a certain population.

Area is a cell reference to the area against which x is to be tested. There should be at least 30 values.

x is the value to be tested.

Sigma (optional) is the standard deviation s of the population (if known). If omitted, PlanMaker automatically
uses the standard deviation of the given sample (i.e., the values in Area).

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. The function is unknown in older versions.

See also:

ZTEST, STANDARDIZE, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST
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Appendix
The appendix of the manual contains the following information:

§ Ribbon commands and corresponding menu commands 

In this section, you will find a table of all commands in the ribbon interface and the respective
corresponding menu command in the classic menu interface.

§ Shortcut keys 

This section contains tables with the most important shortcut keys that you can use in the program.

§ Command-line parameters 

Here, you will find an overview of parameters that can be used to directly trigger a specified program option
when you start PlanMaker.

Ribbon commands and corresponding menu commands
In this section, you will find a table of all commands in the ribbon interface and the respective corresponding
menu command in the classic menu interface.

Tip 1: You can switch the user interface between Ribbon and Classic menus at any time. To do so, choose
the command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

Tip 2: Use the "hamburger menu" (the icon  on the left in the Quick access toolbar) if you still want to
access the classic menu commands from the ribbon interface.

The subsequent table contains the following columns:

§ Left column: The left column lists all ribbon commands in the program, listed according to the order of
ribbon tabs and in the following format: Ribbon tab | Command group | Command 

§ Right column: The right column lists all corresponding classic menu commands in the program in the
following format: Menu > Command

Example: The ribbon command File | Document | Save can be found under File > Save in the classic menu
interface.

Another entry >> is also added for some commands if the command can only be found in the submenu of an
icon or in a dialog box.

Thus, here is the aforementioned table:



846Appendix

Ribbon Menu

File | File | New File > New

File | File | Open File > Open

File | File | Close File > Close

File | Document | Save File > Save

File | Document | Save as File > Save as

File | Document | Save all File > Save all

File | Document | PDF export File > Export as PDF

File | Document | Send File > Send

File | Print | Page setup File > Page setup

File | Print | Define print range File > Print range > Define print range

File | Print | Define print range >> Remove print range File > Print range > Remove print range

File | Print | Print preview File > Print preview

File | Print | Print File > Print

File | File management | Properties File > Properties

File | File management | Versions File > File versions

File | File management | File manager File > File manager

File | File management | Recalculate >> Recalculate
workbook

Tools > Recalculate

File | File management | Recalculate >> Recalculate sheet Shift+F9

File | File Management | Compress all pictures Object > Compress all pictures

File | Scripts | Edit script Tools > Edit script

File | Scripts | Run script Tools > Run script
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Ribbon Menu

File | Settings | Options Tools > Options

File | Settings | Customize >> Customize ribbon Tools > Customize

File | File | Exit (if no document is open) File > Exit

in the Quick access toolbar Edit > Undo

in the Quick access toolbar Edit > Redo

in the Quick access toolbar Edit > Repeat

in the Quick access toolbar View > Touch mode

in the Quick access toolbar View > Dark document mode

Home | Edit | Paste Edit > Paste

Home | Edit | Paste >> Paste special Edit > Paste special

Home | Edit | Cut Edit > Cut

Home | Edit | Copy Edit > Copy

Home | Edit | Format painter Format > Transfer formatting

Home | Character | Bold Toolbar: Formatting

Home | Character | Italic Toolbar: Formatting

Home | Character | Underline Toolbar: Formatting

Home | Character | Font color Toolbar: Formatting

Home | Character | Increase font size

Home | Character | Decrease font size

Home | Alignment | Align top

Home | Alignment | Cell orientation

Home | Alignment | Line wrap Toolbar: Formatting
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Ribbon Menu

Home | Alignment | Default alignment Toolbar: Formatting

Home | Alignment | Merge cells Toolbar: Formatting

Home | Number | Percent format

Home | Number | Currency format

Home | Number | Increase decimal places Toolbar: Formatting

Home | Number | Decrease decimal places Toolbar: Formatting

Home | Format | Shading Format > Shading

Home | Format | Borders Format > Borders

Home | Format | Conditional formatting Toolbar: Formatting

Home | Format | Conditional formatting >> New rule Format > Conditional formatting > New rule

Home | Format | Conditional formatting >> Manage rules Format > Conditional formatting > Manage rules

Home | Format | Conditional formatting >> Delete rules in
selected cells

Format > Conditional formatting > Delete rules in
selected cells

Home | Format | Cell styles

Home | Format | Cell styles >> Manage cell styles Format > Cell style

Home | Cells | Insert Worksheet > Insert cells

Home | Cells | Insert >> Insert copied cells Worksheet > Insert copied cells

Home | Cells | Insert >> Insert worksheet Worksheet > Worksheet > Insert

Home | Cells | Delete Worksheet > Delete cells

Home | Cells | Delete >> Delete worksheet Worksheet > Worksheet > Delete

Home | Cells | Visibility

Home | Cells | Visibility >> Hide rows Worksheet > Row > Hide

Home | Cells | Visibility >> Show rows Worksheet > Row > Show
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Ribbon Menu

Home | Cells | Visibility >> Hide columns Worksheet > Column > Hide

Home | Cells | Visibility >> Show columns Worksheet > Column > Show

Home | Cells | Visibility >> Hide sheet Worksheet > Worksheet > Hide

Home | Cells | Visibility >> Show sheet Worksheet > Worksheet > Show

Home | Contents | Sort and filter Toolbar: Standard

Home | Contents | Sort and filter >> Sort Worksheet > Sort

Home | Contents | Sort and filter >> Sort ascending Toolbar: Standard

Home | Contents | Sort and filter >> Sort descending Toolbar: Standard

Home | Contents | Sort and filter >> AutoFilter Worksheet > Filter > AutoFilter

Home | Contents | Sort and filter >> Show all Worksheet > Filter > Show all

Home | Contents | Sort and filter >> Reapply filter Worksheet > Filter > Reapply filter

Home | Contents | Sort and filter >> Special filter Worksheet > Filter > Special filter

Home | Contents | Autosum Toolbar: Standard

Home | Contents | Fill Edit > Fill

Home | Contents | Fill >> Down Edit > Fill > Down

Home | Contents | Fill >> Right Edit > Fill > Right

Home | Contents | Fill >> Up Edit > Fill > Up

Home | Contents | Fill >> Left Edit > Fill > Left

Home | Contents | Fill >> Series Edit > Fill > Series

Home | Contents | Delete Edit > Delete special

Home | Contents | Delete >> All Edit > Delete special > All

Home | Contents | Delete >> Formatting Edit > Delete special > Formatting
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Ribbon Menu

Home | Contents | Delete >> Contents Edit > Delete special > Contents

Home | Contents | Delete >> Comments Edit > Delete special > Comments

Home | Contents | Delete >> Conditional formatting Edit > Delete special > Conditional formatting

Home | Contents | Delete >> Input validation Edit > Delete special > Input validation

Home | Contents | Delete >> Reset character formatting Format > Standard

Home | Contents | Delete >> Remove link Format > Remove link

Home | Search | Search Edit > Search

Home | Search | Replace Edit > Replace

Home | Search | Search again Edit > Search again

Home | Search | Go to Edit > Go to

Home | Selection | Select all Edit > Select all

Insert | Tables | Table Worksheet > New table

Insert | Tables | Pivot table Worksheet > New pivot table

Insert | Tables | Sheet >> Insert Worksheet > Worksheet > Insert

Insert | Tables | Sheet >> Copy Worksheet > Worksheet > Copy

Insert | Tables | Sheet >> Move Worksheet > Worksheet > Move

Insert | Tables | Sheet >> Delete Worksheet > Worksheet > Delete

Insert | Tables | Sheet >> Rename Worksheet > Worksheet > Rename

Insert | Tables | Sheet >> Show Worksheet > Worksheet > Show

Insert | Tables | Sheet >> Hide Worksheet > Worksheet > Hide

Insert | Tables | Sheet >> Properties Worksheet > Worksheet > Properties

Insert | Objects | Picture frame Object > New picture frame
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Ribbon Menu

Insert | Objects | Picture frame >> From scanner File > Acquire

Insert | Objects | Picture frame >> Select source File > Select source

Insert | Objects | Text frame Object > New text frame

Insert | Objects | Chart frame Object > New chart frame

Insert | Objects | AutoShape Object > New drawing > AutoShape

Insert | Objects | Lines Object > New drawing > Line

Insert | Objects | TextArt object Object > New drawing > TextArt

Insert | Objects | QR code/Barcode frame Object > New QR code/Barcode frame

Insert | Objects | Equation Editor object Object > New OLE object frame >> SoftMaker
Equation Editor

Insert | Objects | Form object >> Checkbox Object > New form object > Checkbox

Insert | Objects | Form object >> Radio button Object > New form object > Radio button

Insert | Objects | Form object >> Dropdown Object > New form object > Dropdown

Insert | Objects | Form object >> Listbox Object > New form object > Listbox

Insert | Objects | Form object >> Pushbutton Object > New form object > Pushbutton

Insert | Objects | Form object >> Spinner Object > New form object > Spinner

Insert | Objects | Form object >> Scrollbar Object > New form object > Scrollbar

Insert | Objects | Form object >> Label Object > New form object > Label

Insert | Objects | Form object >> Groupbox Object > New form object > Groupbox

Insert | Objects | OLE object frame Object > New OLE object frame

Insert | Objects | OLE object frame >> TextMaker object Object > New OLE object frame >> TextMaker
Document

Insert | Objects | OLE object frame >> Presentations object Object > New OLE object frame >> Presentations
Slide
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Ribbon Menu

Insert | Links | Hyperlink Format > Link

Insert | Comments | Comment Insert > Comment

Insert | Text | Header / footer Insert > Header and footer

Insert | Text | SmartText Insert > SmartText

Insert | Text | Symbol Insert > Symbol

Insert | Text | Character

Layout | Page setup | Page margins File > Page setup

Layout | Page setup | Page orientation File > Page setup

Layout | Page setup | Page size File > Page setup

Layout | Page setup | Page break Insert > Page break

Layout | Page Setup | Header / footer Insert > Header and footer

Layout | Cells | Cell size: Row height Worksheet > Row > Height

Layout | Cells | Cell size: Column width Worksheet > Column > Width

Layout | Cells | Optimum height Worksheet > Row > Optimum height

Layout | Cells | Optimum width Worksheet > Column > Optimum width

Layout | Position | Bring to front Object > Order > Bring to front

Layout | Position | Bring to front >> Bring forward one level Object > Order > Bring forward one level

Layout | Position | Send to back Object > Order > Send to back

Layout | Position | Send to back >> Send backward one level Object > Order > Send backward one level

Layout | Position | Rotate object Object > Rotate or flip

Layout | Position | Align objects Object > Align or distribute

Layout | Objects | Group Object > Group
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Ribbon Menu

Layout | Objects | Duplicate Edit > Duplicate

Formula | Function | Function Insert > Function

Formula | Function | Autosum Toolbar: Standard

Formula | Function | Recently used Insert > Function >> Category

Formula | Function | Financial Insert > Function >> Category

Formula | Function | Logic Insert > Function >> Category

Formula | Function | Strings Insert > Function >> Category

Formula | Function | Date and time Insert > Function >> Category

Formula | Function | Statistics Insert > Function >> Category

Formula | Function | Mathematics Insert > Function >> Category

Formula | Function | More functions Insert > Function >> Category

Formula | Named areas | Edit names Worksheet > Names > Edit

Formula | Named areas | Create names Worksheet > Names > Import

Formula | Named areas | Apply names Worksheet > Names > Apply

Formula | Named areas | Export names Worksheet > Names > Insert list

Formula | Traces | Trace to error Tools > Formula auditing > Trace to error

Formula | Traces | Trace predecessors Tools > Formula auditing > Trace predecessors

Formula | Traces | Trace predecessors >> Select
predecessors

Tools > Formula auditing > Select predecessors

Formula | Traces | Trace successors Tools > Formula auditing > Trace successors

Formula | Traces | Trace successors >> Select successors Tools > Formula auditing > Select successors

Formula | Traces | Remove all traces Tools > Formula auditing > Remove all traces
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Ribbon Menu

Formula | Traces | Remove all traces >> Remove traces to
predecessors

Tools > Formula auditing > Remove traces to
predecessors

Formula | Traces | Remove all traces >> Remove traces to
successors

Tools > Formula auditing > Remove traces to
successors

Formula | Traces | Previous error Tools > Formula auditing > Go to previous error

Formula | Traces | Next error Tools > Formula auditing > Go to next error

Formula | Watch | Show watch list View > Watch window

Formula | Update | Update data >> Update charts Tools > Update charts

Formula | Update | Update data >> Update external
references

Tools > Update external references

Formula | Update | Update data >> Update pivot tables Tools > Refresh all pivot tables

Formula | Update | Recalculate >> Recalculate workbook Tools > Recalculate

Formula | Update | Recalculate >> Recalculate sheet Shift+F9

Data | Filter | Sort Worksheet > Sort

Data | Filter | Ascending Toolbar: Standard

Data | Filter | Descending Toolbar: Standard

Data | Filter | AutoFilter Worksheet > Filter > AutoFilter

Data | Filter | Special filter Worksheet > Filter > Special filter

Data | Filter | Show all Worksheet > Filter > Show all

Data | Filter | Reapply AutoFilter Worksheet > Filter > Reapply filter

Data | Edit | External references Worksheet > External references

Data | Edit | Transpose Worksheet > Transpose

Data | Edit | Text to columns Worksheet > Text to columns

Data | Edit | Remove empty rows Worksheet > Remove > Empty rows
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Ribbon Menu

Data | Edit | Remove empty rows >> Remove duplicate rows Worksheet > Remove > Duplicate rows

Data | Analyze | Pivot table Worksheet > New pivot table

Data | Analyze | Data consolidation Worksheet > Data consolidation

Data | Analyze | Scenario manager Tools > Scenarios

Data | Analyze | Goal seek Tools > Goal seek

Data | Outliner | Group Worksheet > Outliner > Group

Data | Outliner | Ungroup Worksheet > Outliner > Ungroup

Data | Outliner | Remove all groups Worksheet > Outliner > Clear outline

Data | Outliner | Show details Worksheet > Outliner > Show details

Data | Outliner | Hide details Worksheet > Outliner > Hide details

Data | Input validation | Input validation Format > Input validation

Data | Input validation | Previous invalid cell Tools > Formula auditing > Go to previous invalid
cell

Data | Input validation | Next invalid cell Tools > Formula auditing > Go to next invalid cell

Review | Spelling | Spell check Tools > Check spelling

Review | Spelling | Spell check >> Edit user dictionaries Tools > Edit user dictionaries

Review | Spelling | Research Toolbar: Standard

Review | Spelling | Auto correction Tools > Auto correction

Review | Comments | Add Tools > Comments > Insert comment

Review | Comments | Edit Tools > Comments > Edit comment

Review | Comments | Delete Next > Comments > Delete comments

Review | Comments | Previous comment Tools > Comments > Previous comment

Review | Comments | Next comment Tools > Comments > Next comment
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Ribbon Menu

Review | Comments | Comment visibility >> Show all
comments

Tools > Comments > Show all comments

Review | Comments | Comment visibility >> Show this
comment

Tools > Comments > Show this comment

Review | Comments | Comment visibility >> Restore
comment positions

Tools > Comments > Restore comment positions

Review | Protection | Cell protection Format > Cell >> Protection tab: Protect cell

Review | Protection | Hide formula Format > Cell >> Protection tab: Hide formula

Review | Protection | Sheet protection Tools > Sheet protection

Review | Protection | Workbook protection Tools > Workbook protection

Review | Speech | Speak Tools > Text to speech

Review | Input validation | Input validation Format > Input validation

Review | Input validation | Mark invalid data Tools > Formula auditing > Mark invalid data

Review | Input validation | Remove marks Tools > Formula auditing > Remove invalid data
marks

Review | Input validation | Previous invalid cell Tools > Formula auditing > Go to previous invalid
cell

Review | Input validation | Next invalid cell Tools > Formula auditing > Go to next invalid cell

View | Mode | Object mode View > Object mode

View | View | Row and column headers View > Row & column headers

View | View | Show formulas View > Show formulas

View | View | Syntax highlighting View > Syntax highlighting

View | View | Show zero values Worksheet > Worksheet > Properties >> Show zero
values

View | View | Show sheet grid Worksheet > Worksheet > Properties >> Gridlines

View | View | Show page breaks Worksheet > Worksheet > Properties >> Page
breaks
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Ribbon Menu

View | View | Page break preview View > Page break preview

View | Zoom | Set zoom View > Zoom level

View | Zoom | Actual size View > Actual size

View | Zoom | Fit to selection View > Zoom level >> Fit to selection

View | Windows | Freeze cells View > Freeze

View | Windows | Pivot table sidebar View > Pivot table sidebar

View | Windows | Pivot table sidebar >> Show at left View > Pivot table sidebar > Show at left

View | Windows | Pivot table sidebar >> Show at right View > Pivot table sidebar > Show at right

View | Windows | Full screen View > Full screen

View | Windows | Windows Window >

View | Windows | Windows >> View side by side Window > View side by side

View | Windows | Windows >> Close all Window > Close all

Table | Table | Range Worksheet > Table > Table range

Table | Table | Properties Worksheet > Table > Table settings

Table | Table | Summarize as pivot Worksheet > Table > Create pivot table

Table | Table | Convert to range Worksheet > Table > Convert to range

Table | Table | Delete table Worksheet > Table > Delete table

Table | Selection | Select rows Worksheet > Table > Select > Select rows

Table | Selection | Select columns Worksheet > Table > Select > Select columns

Table | Selection | Select table Worksheet > Table > Select > Select table

Table | Edit | Insert above Worksheet > Table > Insert > Insert rows above

Table | Edit | Insert below Worksheet > Table > Insert > Insert rows below
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Ribbon Menu

Table | Edit | Delete rows Worksheet > Table > Delete > Delete rows

Table | Edit | Insert left Worksheet > Table > Insert > Insert columns at left

Table | Edit | Insert right Worksheet > Table > Insert > Insert columns at
right

Table | Edit | Delete columns Worksheet > Table > Delete > Delete columns

Table | Style | Table styles Toolbar: Table

Table | Style | Header row Worksheet > Table > Header row

Table | Style | Total row Worksheet > Table > Total row

Table | Style | First column Worksheet > Table > Table settings

Table | Style | Last column Worksheet > Table > Table settings

Table | Style | Banded rows Worksheet > Table > Table settings

Table | Style | Banded columns Worksheet > Table > Table settings

Object | Insert | New object Toolbar: Standard

Object | Format | AutoShape templates Toolbar: AutoShape

Object | Format | AutoShape templates >> More Object > Properties

Object | Format | AutoShape effects Toolbar of the respective object

Object | Format | Fill color Toolbar of the respective object

Object | Format | Line color Toolbar of the respective object

Object | Format | Line style Toolbar of the respective object

Object | Format | Line thickness Toolbar of the respective object

Object | Format | Line endings Toolbar: AutoShape

Object | Edit | Change AutoShape Toolbar: AutoShape

Object | Edit | Edit points Toolbar: AutoShape
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Ribbon Menu

Object | Edit | Combine objects Via the context menu

Object | Inner text | Text rotation Toolbar: AutoShape

Object | Inner text | Vertical alignment Toolbar: AutoShape

Object | Inner text | Change text area Toolbar: AutoShape

Object | Inner text | Add/edit data link Object > Link to a cell

OLE object | OLE | OLE object Edit > OLE object

OLE object | OLE | Edit link Edit > Link

OLE object | Size | Cropping Toolbar: Picture

OLE object | Adjust | Recolor picture Toolbar: Picture

Picture | Adjust | Compress pictures Object > Compress selected pictures

Picture | Adjust | Change source Object > Properties >> Picture tab: File...

Picture | Adjust | Reset Toolbar: Picture

Picture | Format | Photo frame Toolbar: Picture

Chart | Type | Chart type Toolbar: Chart

Chart | Type | Chart subtype Toolbar: Chart

Chart | Data | Series in columns Object > Chart > Data in columns

Chart | Data | Series in rows Object > Chart > Data in rows

Chart | Design | Chart colors Toolbar: Chart

Chart | Chart elements | Add chart element Toolbar: Chart

Chart | Chart elements | Select chart element Toolbar: Chart

Chart | Chart elements | Edit properties Object > Chart > xy element: Properties

Chart | Chart elements | Fill color
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Ribbon Menu

Chart | Chart elements | Line color

Chart | Chart elements | Line style

Chart | Chart elements | Line thickness

Chart | Position | Chart location Object > Chart > Change chart location

Chart | Export | Save chart as a picture Object > Chart > Save as picture

not available Edit > Delete

Home | Number >> group arrow Format > Cell

Home | Character >> group arrow Format > Character

Home | Alignment >> group arrow Format > Paragraph

Via the context menu Format > Character style

not available Format > AutoFormat

Via the context menu of the worksheet register Worksheet > Worksheet > Show > Show all

Data | Outliner >> group arrow Worksheet > Outliner > Automatically show outline
pane

Data | Outliner >> group arrow Worksheet > Outliner > Options

Via the context menu Worksheet > Table > Select > Select column data

not available Tools > Edit lists
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Shortcut keys
The following pages contain tables with Planmaker's most important shortcut keys:

§ Shortcut keys in Windows and Linux versions 

§ Shortcut keys in Mac version

Tip: If you choose the ribbon command File | Customize , you can customize the default shortcut keys
and create new shortcut keys. For more information, see Customizing shortcut keys.

Shortcut keys in Windows and Linux versions

In the Windows and the Linux version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Ctrl+Z

Quick access toolbar: Redo Ctrl+Y

Quick access toolbar: Repeat last command Ctrl+Shift+Y

File | New Ctrl+N

File | Open Ctrl+O

File | Close Ctrl+W or Ctrl+F4

File | Save Ctrl+S

File | Print Ctrl+P

File | File manager F12

File | Exit Ctrl+Q or Alt+F4

Home | Paste Ctrl+V

Home | Paste Special Ctrl+Alt+V

Home | Cut Ctrl+X
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Command Shortcut key

Home | Copy Ctrl+C

Home | Format painter (copying step) Ctrl+Shift+C

Home | Format painter (pasting step) Ctrl+Shift+V

Home | group Character:

Open the "Character" dialog box Ctrl+2

Select font from the list Ctrl+D

Bold on/off Ctrl+B

Italics on/off Ctrl+I

Underline on/off Ctrl+U

Superscript Ctrl+Shift+Plus key (numeric keypad)

Subscript Ctrl+Shift+Minus key (numeric keypad)

Remove superscript or subscript Ctrl+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Home | group Alignment:

Open the "Cell" dialog box Ctrl+1

Alignment: Left Ctrl+L

Alignment: Centered Ctrl+E

Alignment: Right Ctrl+R

Alignment: Justified Ctrl+J

Line break for current cell Ctrl+Enter

Home | group Number:

Open the "Cell" dialog box Ctrl+1

Number format: Number Ctrl+Shift+1

Number format: Scientific Ctrl+Shift+2

Number format: Currency Ctrl+Shift+4

Number format: Percentage Ctrl+Shift+5
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Command Shortcut key

Home| group Cells:

Insert cells Ctrl+Plus

Delete cells Ctrl+Minus

Hide current row Ctrl+9

Show current row Ctrl+Shift+9

Hide current column Ctrl+8

Show current column Ctrl+Shift+8

Home | Search Ctrl+F

Home | Replace Ctrl+H

Home | Search again (or Replace again) F3

Home | Go to F5 or Ctrl+G

Go to the next error Ctrl+F3

Home| Select all Ctrl+A

Insert | Table Ctrl+T

Insert | Hyperlink Ctrl+K

Insert | Comment Shift+F2

Insert | Character | Em dash (—) Ctrl+Alt+Minus key (numeric keypad)

Insert | Character | Non-breaking space Ctrl+Shift+Space

Formula | Insert function F7

Formula | Update data:

Updating charts F8

Update calculations F9

Recalculate the current worksheet only Shift+F9

View | Full screen F6
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Other useful shortcut keys

Command Shortcut key

Display help content F1

Edit the content of the current cell F2

To the next open document Ctrl+F6

To the previous open document Ctrl+Shift+F6

Show/hide ribbon Ctrl+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

Move to the next worksheet
(for open dialog boxes: move to the next tab)

Ctrl+Tab

Move to the previous worksheet
(for open dialog boxes: move to the previous tab)

Ctrl+Shift+Tab

Select the next object (in object mode) Tab

Select the previous object (in object mode) Shift+Tab

Move to the next cell ß/à/á/â

Move to the next / previous cell horizontally Tab / Shift+Tab

Move to the next / previous cell vertically Enter / Shift+Enter

Move to the next filled cell Ctrl+ß/à/á/â

Move to the first cell in the current column Ctrl+PageUpá

Move to the last cell in the current column Ctrl+PageDownâ

Move to the first cell in the current row Home

Move to the last filled cell in the current row End

Move to the first cell in the worksheet (cell A1) Ctrl+Home

Move to the last filled cell in the worksheet Ctrl+End

Move to the next circular reference Shift+F5

Go to the next error Ctrl+F3
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Command Shortcut key

Copy cell above Ctrl+, (comma)

Copy value from cell above Ctrl+Shift+, (comma)

Enter an array formula Ctrl+Shift+¿

Select current array formula Ctrl+7

Select current conditional formatting Ctrl+6

Open a dropdown list with the contents of the cells
above or below a cell

Alt+Shift+â

Switch between AUTO and TEXT input mode
(see Status bar)

Ctrl+Shift+F4

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Ctrl+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).

Shortcut keys in Mac version

Note: For most shortcut keys with the Cmd key, you can also use the Ctrl key instead of the Cmd key. For
the shortcut key Cmd+S, for example, you can also press Ctrl+S.

In the Mac version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Cmd+Z

Quick access toolbar: Redo Cmd+Y

Quick access toolbar: Repeat last command Cmd+Shift+Y

File | New Cmd+N

File | Open Cmd+O
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Command Shortcut key

File | Close Cmd+W or Cmd+F4

File | Save Cmd+S

File | Print Cmd+P

File | File manager F12

File | Exit Cmd+Q or Alt+F4

Home | Paste Cmd+V

Home | Paste Special Cmd+Alt+V

Home | Cut Cmd+X

Home | Copy Cmd+C

Home | Format painter (copying step) Cmd+Shift+C

Home | Format painter (pasting step) Cmd+Shift+V

Home | group Character:

Open the "Character" dialog box Cmd+2

Select font from the list Cmd+D

Bold on/off Cmd+B

Italics on/off Cmd+I

Underline on/off Cmd+U

Superscript Cmd+Shift+Plus key (numeric keypad)

Subscript Cmd+Shift+Minus key (numeric keypad)

Remove superscript or subscript Cmd+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Home | group Alignment:

Open the "Cell" dialog box Cmd+1

Alignment: Left Cmd+L

Alignment: Centered Cmd+E

Alignment: Right Cmd+R
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Command Shortcut key

Alignment: Justified Cmd+J

Line break for current cell Cmd+Enter

Home | group Number:

Open the "Cell" dialog box Cmd+1

Number format: Number Cmd+Shift+1

Number format: Scientific Cmd+Shift+2

Number format: Currency Cmd+Shift+4

Number format: Percentage Cmd+Shift+5

Home| group Cells:

Insert cells Cmd+Plus

Delete cells Cmd+Minus

Hide current row Cmd+9

Show current row Cmd+Shift+9

Hide current column Cmd+8

Show current column Cmd+Shift+8

Home | Search Cmd+F

Home | Replace Cmd+H

Home | Search again (or Replace again) F3

Home | Go to Cmd+G or F5

Go to the next error Cmd+F3

Home| Select all Ctrl+A

Insert | Table Cmd+T

Insert | Hyperlink Cmd+K

Insert | Comment Shift+F2

Insert | Character | Em dash (—) Cmd+Alt+Minus key (numeric keypad)

Insert | Character | Non-breaking space Cmd+Shift+Space

Formula | Insert function F7
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Command Shortcut key

Formula | Update data:

Updating charts F8

Update calculations F9

Recalculate the current worksheet only Shift+F9

View | Full screen F6

Other useful shortcut keys

Command Shortcut key

Display help content F1

Edit the content of the current cell F2

To the next open document Cmd+F6

To the previous open document Cmd+Shift+F6

Expand or collapse the ribbon Cmd+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

Move to the next worksheet
(for open dialog boxes: move to the next tab)

Ctrl+Tab

Move to the previous worksheet
(for open dialog boxes: move to the previous tab)

Ctrl+Shift+Tab

Select the next object (in object mode) Tab

Select the previous object (in object mode) Shift+Tab

Move to the next cell ß/à/á/â

Move to the next / previous cell horizontally Tab / Shift+Tab

Move to the next / previous cell vertically Enter / Shift+Enter

Move to the next filled cell Cmd+ß/à/á/â

Move to the first cell in the current column Cmd+PageUpá

Move to the last cell in the current column Cmd+PageDownâ
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Command Shortcut key

Move to the first cell in the current row Home

Move to the last filled cell in the current row End

Move to the first cell in the worksheet (cell A1) Cmd+Home

Move to the last filled cell in the worksheet Cmd+End

Move to the next circular reference Shift+F5

Go to the next error Cmd+F3

Copy cell above Ctrl+, (comma)

Copy value from cell above Ctrl+Shift+, (comma)

Enter an array formula Cmd+Shift+¿

Select current array formula Cmd+7

Select current conditional formatting Cmd+6

Open a dropdown list with the contents of the cells
above or below a cell

Alt+Shift+â

Switch between AUTO and TEXT input mode
(see Status bar)

Cmd+Shift+F4

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Cmd+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).
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Command-line parameters

Note: The command-line parameters described here only work on Windows.

Command-line parameters allow you to specify that PlanMaker is started immediately with a specific program
option rather than with the usual default behavior. Example: You would like PlanMaker to switch to the dialog
box for selecting a document template directly upon startup.

To insert a command-line parameter, proceed as follows:

1. Create a new shortcut to PlanMaker on the desktop. Ideally, give the link a distinctive name in order to
distinguish it more clearly.

2. Choose the properties of the shortcut: Right-click on the link for the context menu and select the entry
Properties.

3. The following dialog box with the Shortcut tab will then appear:
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4. In the input field Target after the file path "...\PlanMaker.exe", enter the desired parameter from the
table below. In the figure, for example, this is the parameter -FN.

Important: There must be a space in front of the parameter and the parameter starts with a hyphen.

5. Confirm with OK.

When you open PlanMaker via this newly created link (double-click the link), the program will start directly
with the behavior of the parameter that was used.

Command-line parameters

Parameter Description

 -N PlanMaker starts without opening a new default document.

 -FO PlanMaker starts with an open dialog box for selecting a file.

 -FN PlanMaker starts with an open dialog box for selecting a document
template.

 -P"Path\FileName" PlanMaker starts and prints the specified file directly on the default
printer.

 -Q"PrinterName","Path\FileName"
Note: No space is inserted
within the parameter.

PlanMaker starts and prints the specified file directly on the specified
printer.
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#
#DIV/0!   524

#N/A   524, 617, 676, 679, 722

#NAME?   524

#NULL!   524

#NUM!   524

#REF!   524

#VALUE!   524

$
$ sign   519

%
% sign (operator)   516

3
3D effect (for objects)   289

3D view (for charts)   363

A
ABS (absolute value)   530

Absolute cell references   519

Absolute value (ABS)   530

Accounting (number format)   194

ACOS (arccosine)   530

ACOSH (inverse hyperbolic cosine)   531

ACOT (arccotangent)   532

ACOTH (inverse hyperbolic cotangent)   532

Actual size (view)   486

Add or remove spaces when pasting   456

Add spacing around punctuation marks (French)   388

Add/edit text  
for AutoShapes   316
for text frames   316

Addition (operator)   516

ADDRESS (cell address as text)   533

After input, move selection...   459

Align (object)  
align and distribute objects   275
snap to cells   454
to other objects with guides   454

Alignment  
of cell contents   207
of text in text frames   293, 295

All caps   214

Analyze sheets   109

AND (logical AND function)   534

Android/iOS  
context menu   36
input mode   34
select   69
share a document   426
unlock commands   34
unlock locked commands   22
user interface   34

Annuity  
see PMT   751

ANSI code of a character (CODE)   564

Anti-aliasing   461

Arabic scripts   443, 456

Arccosine (ACOS)   530

Arccotangent (ACOT)   532

Arcsine (ASIN)   535

Arctangent  
ATAN   536
ATAN2   537

Area chart   327

AREAS (number of areas)   535

Array functions  
MDETERM (determinant)   706
MINVERSE (inverse)   712
MMULT (product)   713
MSOLVE (solution of matrix equation)   719
TRANSPOSE (transpose matrix)   820
working with arrays   526

Asian scripts   456

ASIN (arcsine)   535

ASINH (inverse hyperbolic sine)   536

Associate file types   469

ATAN (arctangent)   536

ATAN2 (arctangent)   537

ATANH (inverse hyperbolic tangent)   538

Auto correction   388, 456

Auto input mode   39

Autocomplete cells   63, 459

AutoFill   82

AutoFilter   101

AutoFit cell sizes   190

AutoFormat   235

Automatic percent input   459

Automatically recalc (worksheets)   116, 480

Auto-Recover   466, 468

AutoShape  
add/edit text   316
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AutoShape  
AutoShape effects   317
AutoShape templates   317
change on ribbon tab Object   317
change on the ribbon tab Object   277
change text area   282
change via the dialog box   290, 319
drawing   314

AutoSum   799

AutoText   395

AVEDEV (average deviation)   538

Average  
arithmetic mean (AVERAGE)   539
arithmetic mean (AVERAGEA)   539
if condition is true (AVERAGEIF)   540
if conditions are true (AVERAGEIFS)   541

AVERAGE (arithmetic mean)   539

Average deviation (AVEDEV)   538

Average square deviation (DEVSQ)   607

AVERAGEA (arithmetic mean)   539

AVERAGEIF (average if condition is true)   540

AVERAGEIFS (average if conditions are true)   541

Axes (in charts)   333, 352, 353, 355, 357

Axis title (in charts)   333, 356

B
B (compatibility function)   542

Background color  
of cells   205
of text   216
of the program   461

Backup copies   408, 468

Backup folder   408, 468

BAK files   408

Banded rows and columns   140

Bar chart   327

Barcode, generate   322

BASE (decimal number to another base)   543

Base-10 logarithm (LOG10)   694

Based on (for cell styles)   229

Based on (for character styles)   226

BasicMaker   446

Beep on errors (for spell check)   465

Beep on errors (for warning messages)   461

BESSELI (modified Bessel function In(x))   544

BESSELJ (Bessel function Jn(x))   545

BESSELK (modified Bessel function Kn(x))   545

BESSELY (Bessel function Yn(x))   546

Beta distribution  

BETA.DIST   547
BETA.INV   548
BETADIST   546
BETAINV   548

BETA.DIST (beta distribution)   547

BETA.INV (percentiles of the beta distribution)   548

BETADIST (beta distribution)   546

BETAINV (percentiles of the beta distribution)   548

BIN2DEC (binary to decimal)   549

BIN2HEX (binary to hexadecimal)   550

BIN2OCT (binary to octal)   551

Binary to decimal (BIN2DEC)   549

Binary to hexadecimal (BIN2HEX)   550

Binary to octal (BIN2OCT)   551

Binomial distribution  
BINOM.DIST   553
BINOM.DIST.RANGE   554
BINOM.INV   555
BINOMDIST   552
CRITBINOM   586
NEGBINOM.DIST   723
NEGBINOMDIST   724

Bold (font)   214

Boolean (number format)   194

Borders  
of cells   203
of objects   287

Box and whisker plot   327

Boxplot chart   327

Bring forward one level (object)   274

Bring to front (object)   274

Bubble chart   327

C
Calculation in status bar   459

Calculations  
iterative   480
update   116, 480

Capitalize first letter of sentences   388

Category axis (in charts)   333, 352

CEILING (round up to a multiple of base)   556

Cell  
alignment   207
borders   203
change size   190
delete   71
do not display (protection)   428
do not print (protection)   428
enter data   63
fill automatically   82, 510
insert   74
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Cell  
merge   207
number format   192, 194, 197
protect   211, 428
select   67
shading   205

CELL (information about a cell)   557

Cell address as text (ADDRESS)   533

Cell contents  
copy   76
cut   76
delete   76
paste   76

Cell formatting, transfer   250

Cell frame   44, 454

Cell marker   454

Cell protection   428

Cell references  
absolute/relative   519
paste from clipboard   78
show cell contents in objects   283
to dynamic tables   143

Cell references, external   520
Enter   521
manage   522
update   522

Cell styles   228, 229
apply   228
based on   229
create   229
default style "Normal"   231
delete   231
edit   231
rename   231
shortcut keys   229

Centered   207

Change shape   277

Change text area  
of AutoShapes   282
of text frames   282

CHAR (character from ANSI code)   558

Character format   211
all caps   214
background color   216
bold   214
character pitch   218
font   213
font color   216
font size   213
italic   214
kerning   218
letter spacing   218
small caps   214

strikethrough   214
superscripts and subscripts   217
text styles   214
underline   214

Character formatting   211
apply to entire words   456
change   211
reset   219, 225

Character pitch   218

Character styles   223
apply   224
based on   226
create   223
default style "Normal"   226
delete   224
edit   224
rename   224
shortcut keys   223, 224

Chart (dialog box)   360

Chart (ribbon tab)   325

Chart area   343

Chart title   334, 357, 362

Charts   324
add/delete data series   361
change arrangement of data series   332, 361
change chart location   364
change chart type   327
change properties   360
data in columns   332
data in rows   332
edit   325
insert   325
save as picture   365
select chart elements   341
update   364, 480

Check for updates   469

Checkboxes (form object)   370

CHIDIST (chi-square distribution)   559

CHIINV (percentiles of the chi-square distribution)  
559

CHISQ.DIST.RT (chi-square distribution)   560

CHISQ.INV.RT (percentiles of the chi-square
distribution)   561

CHISQ.TEST (chi-square test for independence)   561

CHITEST (chi-square test for independence)   562

CHOICE (x>0, x=0, x<0?)   562

CHOOSE (choose value from list)   563

Circles, draw   314

Circular reference   39, 480

Classic menus with toolbars   22, 461
list of all ribbon commands and menu commands  
845
user interface   33
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CLEAN (remove non-printable characters)   564

Close (File)   451

Close document   451

CODE (ANSI code of a character)   564

Color  
of cells   205
of objects   285
of text   216

Color gradient (for objects)   285

Column  
change width   190
delete   71
insert   74
optimum width   190
select   67
show/hide   191

COLUMN (function: column number of cells)   565

Column chart   327

Column header  
change column width   190
print   253
show/hide   484
use for selection   67

COLUMNS (function: number of columns in a range)  
565

COMBIN (combinations)   566

Combine (object shapes)   278

Combine shapes   278

Command-line parameters   870

Commands, repeat   66

Comments   118
always show   118, 478
delete   118
edit   118
insert   118
show in PDF export   422
show in the printout   253

Complex numbers  
absolute value (IMABS)   659
angle (IMARGUMENT)   660
conjugate (IMCONJUGATE)   661
cosine (IMCOS)   661
create complex number (COMPLEX)   567
difference (IMSUB)   668
division (IMDIV)   662
exponential (IMEXP)   662
imaginary coefficient (IMAGINARY)   659
logarithm, base 10 (IMLOG10 )   663
logarithm, base 2 (IMLOG2 )   664
negative value (IMNEG)   664
power (IMPOWER)   665
product (IMPRODUCT)   665
real coefficient (IMREAL)   666

sine (IMSIN)   667
square root (IMSQRT)   667
sum (IMSUM)   668

Complex scripts   456

Compress pictures   300

CONCAT (concatenate strings from list)   567

CONCATENATE (concatenate text strings)   568

Concatenation (operator)   516

Concatenation of text strings (functions)  
CONCAT   567
CONCATENATE   568
TEXTJOIN   814

Condition  
CHOICE   562
IF   655
IFS   658

Conditional formatting   236
delete rules in selected cells   243
manage rules   241
new rule   236
types of conditions   238

Cone chart   327

CONFIDENCE (confidence interval)   569

Confidence interval  
CONFIDENCE   569
CONFIDENCE.NORM   570

CONFIDENCE.NORM (confidence interval)   570

Connectors, draw   314

Consolidate data   126

Context menu   36

CONVERT (unit conversion)   571

Convert EU currencies (EUROCONVERT)   618

Copy  
cell contents   76
formula   76
insert copied cells   75
object   76
text   76

Corners (in charts)   346

Correct first TWo UPpercase LEtters   388

CORREL (correlation coefficient)   575

Correlation coefficient  
CORREL   575
PEARSON   742

COS (cosine)   575

COSH (hyperbolic cosine)   576

Cosine (COS)   575

COT (cotangent)   576

Cotangent (COT)   576

COTH (hyperbolic cotangent)   577

Count  
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Count  
COUNT   578
COUNTA   578
COUNTBLANK   579
COUNTIF   579
COUNTIFS   580

COUNT (number of cells filled with numbers)   578

COUNTA (number of cells filled)   578

COUNTBLANK (number of empty cells)   579

COUNTIF (count if condition is true)   579

COUNTIFS (count if conditions are true)   580

COUNTP (PlanMaker 97 compatibility function)   582

COVAR (population covariance)   583

Covariance  
COVAR (population)   583
COVARIANCE.P (population)   583
COVARIANCE.S (sample)   584

COVARIANCE.P (population covariance)   583

COVARIANCE.S (sample covariance)   584

Create complex number (COMPLEX)   567

Create new document   448

CREATEDATE (date the document was created)   585

Creation date   257

CRITBINOM (binomial distribution)   586

Cropping (of pictures)   301, 303

CSV file format   435, 437

CUMIPMT (cumulative interest)   587

CUMPRINC (cumulative principal)   588

CURRENCY (format number as currency)   589

Currency (number format)   194

Current date (dynamic)  
with time: NOW function   733
without time: TODAY function   820

Current date (static)  
insert date via shortcut key   63
insert time via shortcut key   63

Curves, draw   314

Custom number formats   194, 197, 198

Customize  
create user-defined icons   507
customize shortcut keys   507
customize toolbars   502
ribbon   492

Cut  
cell contents   76
formula   76
object   76
text   76

Cylinder chart   327

D
Dark mode  

for the user interface   461
for worksheets   489

Data consolidation   126, 127, 130, 132

Data labels (in charts)   335, 346

Data points (in charts)   346

Data series (in charts)   361
add   361
delete   361
edit   346

Data series, fill automatically   82, 510

Data source area, change  
for charts   361
for pivot tables   180

Data validation   115, 244

Database functions   528
DAVERAGE   592
DCOUNT   598
DCOUNTA   599
DGET   607
DMAX   608
DMIN   608
DPRODUCT   610
DSTDEV   611
DSTDEVP   612
DSUM   612
DVAR   613
DVARP   614

Date  
create a date value (DATE function)   590
current (static), insert via shortcut key   63
enter in cell   63
updated, with time: NOW function   733
updated, without time: TODAY function   820

DATE (create a date value)   590

Date before/after n months (EDATE)   614

Date difference (DATEDIF)   590

Date filter (AutoFilter)   101

Date last changed   257

Date the document was created (CREATEDATE)   585

Date/time (number format)   194

DATEDIF (date difference)   590

DATEVALUE (convert text into date value)   592

DAVERAGE (database function)   592

DAY (day of a date)   593

DAYS (days between two dates)   593

DAYS360 (days between two dates)   594

DAYSP (compatibility function)   595

DAYSPERMONTH (days per month)   596
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DAYSPERYEAR (days per year)   597

DB (fixed-declining balance depreciation)   598

dBASE file format   435

DCOUNT (database function)   598

DCOUNTA (database function)   599

DDB (double-declining balance depreciation)   600

DEC2BIN (decimal to binary)   600

DEC2HEX (decimal to hexadecimal)   601

DEC2OCT (decimal to octal)   602

DECIBEL (decibel value of two quantities)   603

DECIMAL (convert number from any base into
decimal)   604

Decimal number to another base (BASE)   543

Decimal places, increase/decrease   192

Decimal places, increase/decrease   192

Decimal point after input   478

Decimal separator, change   459

Decimal to binary (DEC2BIN)   600

Decimal to hexadecimal (DEZ2HEX)   601

Decimal to octal (DEC2OCT)   602

DECIMALS (fractional part of a number)   605

Default cell style "Normal"   231

Default character style "Normal"   226

Default currency   478

Default file format when saving   466

Default language for spell check   381, 465

Default number format   194

Default program to open   469

Default template (document template)  
"Normal"   46, 234
change   46
switch   234

Default unit of measure   461

Defined names   90, 93
apply names to existing formulas   94
assign names   91
create a list of all named ranges   93

DEGREES (convert radians to degrees)   605

Degrees to radians (RADIANS)   763

Delete   44
cell content   70
cells   70, 71
columns/rows   71
duplicate rows   72
empty rows   72
object   76
text   76

Delete special (cell content)   70

DELTA (test for equality)   606

Depreciation  

double-declining balance (DDB)   600
fixed-declining balance (DB)   598
straight-line (SLN)   785
sum-of-years’ digits (SYD)   808

Design Science   312

Desktop mode (Android/iOS)   461

Determinant of a matrix (MDETERM)   706

DEVSQ (average square deviation)   607

DGET (database function)   607

Dialog language   461

Dictionaries for spell check  
edit user dictionaries   384
export/import user dictionaries   473
install   512

Display formula contained in cell (FORMULATEXT)  
633

Distance to edge   251

Distribute (object)   275

Division (operator)   516

DMAX (database function)   608

DMIN (database function)   608

Document management   401

Document properties   476
Calculate tab   480
Colors tab   476
Fonts tab   483
Options tab   478
Protection tab   483
Statistics tab   478
Summary tab   403, 476

Document protection   432

Document statistics   478

Document summary  
enter   403
prompt for summary information when saving   466

Document tabs   38, 447

Document templates   233
apply   233
change template folder   466
create   233
default template "Normal"   234
edit   234

Document, print   50, 418

Document, save   50

Documents, view side by side   449

Dollar (number format)   192

DOLLARDE (convert to dollar price decimal)   609

DOLLARFR (convert to dollar price fraction)   610

Doughnut chart   327

DPRODUCT (database function)   610

Drag and drop   76
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Drawing object (dialog box)   319

Drawing object (ribbon tab)   317

Drawings   314
change properties   317, 319
combine   278
edit retroactively   280
insert   314
rotate   273

Dropdown lists (form object)   373

DSTDEV (database function)   611

DSTDEVP (database function)   612

DSUM (database function)   612

Duplicate (objects)   275

Duplicates  
remove duplicate rows   72
show duplicate values   238

DVAR (database function)   613

DVARP (database function)   614

Dynamic tables   134

E
EDATE (date before/after n months)   614

Edit chart elements   341
axis title   356
chart area   343
chart title   357, 362
corners   346
data labels   346
data series   346
error bars   346
floor   345
gridlines   358
legend   358
lines   346
plot area   344
trendline   350
up/down bars   346
walls   345
X axis   352
Y axis   353
Z axis   355

Edit color palette   476

Edit lists (for filling)   82, 510

Edit mode and object mode   271

Edit points (of objects)   280

Edit script   446

Edit shapes retroactively   280

Edit toolbar   37

EFFECT (effective interest rate)   615

Effective interest rate (EFFECT)   615

Effects (for objects)   289

Ellipses, draw   314

Ellipsis ("...")   186

E-mail a document   426

Empty rows, delete   72

En dashes, different widths   186

Enable OpenGL engine (Linux only)   469

Enable OpenGL for AutoShapes   469

Encryption   432

Enter data in cells   63

EOMONTH (end of month in n months)   616

Equality (DELTA)   606

Equation Editor   312

ERF (Gaussian error function)   616

ERFC (complement to Gaussian error function)   617

Error bar (in charts)   336, 346

Error function  
ERF   616
ERFC (complement)   617

Error type (ERROR.TYPE)   617

Error values in calculations   115, 524, 676

ERROR.TYPE (error type)   617

Euro (number format)   192

EUROCONVERT (convert EU currencies)   618

EVEN (round up to next even number)   620

EXACT (compare texts)   620

Excel file format   369, 435, 440, 442

Exit (file)   51

EXP (power of e)   621

Expand the input field   37

EXPON.DIST (exponential distribution)   622

EXPONDIST (exponential distribution)   622

Exponential distribution  
EXPON.DIST   622
EXPONDIST   622

Exponential regression  
statistics (LOGEST)   695
values (GROWTH)   644

Exponentiation (operator)   516

Export (other file format)   435

Export/Import of the settings   473

Extended support  
for Arabic text   443, 456
for Asian fonts   456

External cell references   520
enter   521
manage   522
update   522
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F
F distribution  

F.DIST.RT   625
F.INV.RT   628
FDIST   625
FINV   627

F.DIST.RT (F distribution)   625

F.INV.RT (percentiles of the F distribution)   628

F.TEST (F-test)   635

FACT (factorial)   623

FACTDOUBLE (double factorial)   624

FALSE (logical value FALSE)   624

FDIST (F distribution)   625

Fields (in headers/footers)   257

File  
export as PDF   422
send by e-mail   426

File formats   435

File manager   404

File path, show in title bar   461

File properties   476
Calculate tab   480
Colors tab   476
Fonts tab   483
Options tab   478
Protection tab   432, 483
Statistics tab   478
Summary tab   403, 476

File type   435

File versions   408, 468

File: Close   451

File: Exit   51

File: New   46, 233

File: Open   48, 435

File: Page setup   251, 253, 257

File: Print   50, 418

File: Print preview   417

File: Properties   476

File: Save   50

File: Save all   50

File: Save as   50, 435

FILENAME (file name of the document)   626

Fill  
of objects   285

Fill cells (automatically)   82, 510

Filling  
of cells   205

Filter   101

AutoFilter   101
special filter   106
SUBTOTAL (function)   798

FIND (search for text in a text string)   627

FINV (percentiles of the F distribution)   627

First column (highlight)   140

First column, freeze   184

FISHER (Fisher transformation)   629

FISHERINV (inverse of the Fisher transformation)   629

FIXED (format number as text with fixed decimals)  
630

Flip (objects)   273

Floor (in charts)   345

FLOOR (round down to a multiple of base)   631

Folder for file versions   408, 468

Font   213
bold   214
italic   214
underline   214

Font color   216

Font lists, hide fonts   471

Font size   213

Footers   257

FORECAST (forecast using linear regression)   632

Form object (ribbon tab)   379

Form objects   367
edit   368
evaluate   368

Form objects, insert   367
checkboxes   370
dropdown lists   373
groupboxes   378
labels   378
listboxes   374
pushbuttons   375
radio buttons   371
scrollbars   377
spinners   376

Format painter   250

Format URLs as hyperlinks   388

Formatting toolbar   33

Forms   366

Formula auditing   112, 113, 115

Formulas and functions from A to Z   515

FORMULATEXT (display formula contained in cell)  
633

Fractile (see PERCENTILE)   743, 744, 745

Fraction (number format)   194

Freehand, draw   314

Freeze cells   184

Freeze rows/columns   184



880Index

FREQUENCY (frequency)   633

F-test  
F.TEST   635
FTEST   634

Full screen mode (view)   487

Functions   515
functions from A to Z   530
insert   517

Future value  
FV   635
FVSCHEDULE   636

FV (future value)   635

FVSCHEDULE (future value)   636

G
GAMMA (gamma function)   637

Gamma distribution  
GAMMA.DIST   638
GAMMA.INV   640
GAMMADIST   638
GAMMAINV   639

Gamma function  
GAMMA   637
GAMMALN   640

GAMMA.DIST (gamma distribution)   638

GAMMA.INV (percentiles of the gamma distribution)  
640

GAMMADIST (gamma distribution)   638

GAMMAINV (percentiles of the gamma distribution)  
639

GAMMALN (logarithm of the gamma function)   640

GAUSS (standard normal distribution)   641

Gaussian distribution (NORM.DIST)   727

Gaussian distribution (NORMDIST)   726

Gaussian error function  
ERF   616
ERFC complement   617

GCD (greatest common divisor)   641

GEOMEAN (geometric mean)   642

Geometric mean (GEOMEAN)   642

GESTEP (number greater or equal to threshold value?)  
643

GETPIVOTDATA   643

Glow effect (for objects)   289

Go to   267

Goal seek   120

Greatest common divisor (GCD)   641

Gridlines between worksheet cells  
paint behind cells   454
print   253

show   484

Gridlines in charts   336, 358

Group  
cells (outliner)   412
in pivot tables   176
objects   276
show/hide cells   413

Groupboxes (form object)   378

GROWTH (values of an exponential regression)   644

Guidelines for text frames, show   478

Guides for objects   454

H
Hamburger menu   29, 31

HARMEAN (harmonic mean)   645

Harmonic mean (HARMEAN)   645

Header row in tables   140

Headers and footers   257

Height of a row, change   190

Help content, display (F1 key)   861, 865

HEX2BIN (hexadecimal to binary)   646

HEX2DEZ (hexadecimal to decimal)   647

HEX2OCT (hexadecimal to octal)   648

Hexadecimal to binary (HEX2BIN)   646

Hexadecimal to decimal (HEX2DEZ)   647

Hexadecimal to octal (HEX2OCT)   648

Hide  
cell contents (protection)   428
formulas (protection)   428
objects   277, 290
rows/columns   191

Hide cells  
manually   191
using an outliner   411

Hide formula (protection)   428

High-low chart   327

HLOOKUP (look up row-wise)   649

HOLIDAY (dates of movable Christian holidays)   650

Horizontal alignment  
of cell contents   207
of text in AutoShapes   221
of text in text frames   221

HOUR (hour)   651

HTML format   442

Hunspell dictionaries   465, 512

Hyperbolic cosine (COSH)   576

Hyperbolic cotangent (COTH)   577

Hyperbolic sine (SINH)   783

Hyperbolic tangent (TANH)   811
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Hypergeometric distribution  
HYPGEOM.DIST   654
HYPGEOMDIST   653

HYPERLINK (function: hyperlink)   652

Hyperlinks (links)   388, 415
applied to cells   415
for objects   290
for OLE objects   308
format URLs as hyperlinks   388
HYPERLINK function   652

HYPGEOM.DIST (hypergeometric distribution)   654

HYPGEOMDIST (hypergeometric distribution)   653

Hyphen  
non-breaking hyphen   186
soft hyphen   186

Hyphenation   386
in cells   387
in text frames   386
set language   381

I
IF (if-then-else condition)   655

IFEMPTY (return a defined value if cell is empty)   656

IFERROR (return a value if error)   656

IFNA (return defined value for #N/A)   657

IFS (first condition met)   658

Ignore words that start with a number   465

IMABS (absolute value of a complex number)   659

Images  
copy to document’s folder   298
insert   298
save within document   298

IMAGINARY (imaginary coefficient of a complex
number)   659

IMARGUMENT (angle of a complex number)   660

IMCONJUGATE (conjugate a complex number)   661

IMCOS (cosine of a complex number)   661

IMDIV (division of complex numbers)   662

IMEXP (exponential of a complex number)   662

IMLN (natural logarithm of a complex number)   663

IMLOG10 (base-10 logarithm of a complex number)  
663

IMLOG2 (base-2 logarithm of a complex number)   664

IMNEG (negative value of a complex number)   664

Import (other file format)   435

Import/Export of the settings   473

IMPOWER (power of a complex number)   665

IMPRODUCT (product of complex numbers)   665

IMREAL (real coefficient of a complex number)   666

IMSIN (sine of a complex number)   667

IMSQRT (square root of a complex number)   667

IMSUB (difference of complex numbers)   668

IMSUM (sum of complex numbers)   668

In-cell editing   459

Indents (for text frames)   220

INDEX (cell in a particular row/column)   669

INDIRECT (create reference from text)   670

Information about a cell (CELL)   557

Inner margins  
of cells   207
of text frames   293, 295
of text in AutoShapes   320

Input field, expand   37

Input method (Android)   34

Input validation   115, 244, 245, 249

Insert  
cells   74
characters   186
charts   325
columns   74
comments   118
copied cells   75
drawings   314
Equation Editor objects   312
form objects   367
functions   517
headers and footers   257
objects   270
OLE objects   306
page break   261
pictures   298
rows   74
SmartText entries   395
special characters   186
text frames   293

Insert characters   186

Insert frames and drawings immediately   456

Insert mode / overwrite mode   39
disable   456

Insert special characters   186

Installation   26
Android   28
iOS   28
Linux   28
macOS   27
Windows   26

INT (round down to nearest integer)   671

INTERCEPT (intercept point of a regression line)   671

Interest payment  
CUMIPMT (cumulative)   587
IPMT   673
ISPMT   684
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Interest rate  
PCF   776
per period (RATE)   768
RRI   776

Internal rate of return  
IRR   674
MIRR   713
XIRR   841

Intersection  
INTERSECTION (function: intersection of two
ranges)   672
operator   516

Inverse hyperbolic cosine (ACOSH)   531

Inverse hyperbolic cotangent (ACOTH)   532

Inverse hyperbolic sine (ASINH)   536

Inverse hyperbolic tangent (ATANH)   538

Inverse matrix (MINVERSE)   712

iOS/Android  
context menu   36
input mode   34
select   69
share a document   426
unlock commands   34
unlock locked commands   22
user interface   34

IPMT (interest payment)   673

IRR (internal rate of return)   674

ISBLANK (is empty?)   675

ISERR (is an error value other than #N/A?)   524, 676

ISERROR (is an error value?)   524, 676

ISEVEN (is an even number?)   677

ISFORMULA (is a formula?)   677

ISLOGICAL (is a logical value?)   678

ISNA (is not available?)   679

ISNONTEXT (is no text?)   679

ISNUMBER (is numeric?)   680

ISNUMBERP (PlanMaker 97 compatibility function)  
681

ISODD (is an odd number?)   682

ISOWEEK (ISO week number)   682

ISOWEEKNUM (ISO week number)   683

ISPMT (interest payment)   684

ISREF (is a valid reference?)   685

ISTEXT (is text?)   685

Italic (font)   214

Iterations for calculations   480

J
Jump target (hyperlink)   415

Justification (in cells)   207

Justification (in text frames)   293, 295

K
Keep aspect ratio   284

Keep scaling   284

Kerning   218

KURT (kurtosis)   686

Kurtosis (KURT)   686

L
Labels (form object)   378

Landscape format   251

Language  
for spell check and hyphenation   381
for user interface   461

LARGE (k-th largest number)   687

Last column (highlight)   140

LASTPRINTED (date last printed)   688

LASTSAVED (date last saved)   688

LCM (least common multiple)   689

Least common multiple (LCM)   689

LEFT (function: left part of a text string)   689

Left align   207

Left arrow key never exits cell editing   459

Legend (in charts)   337, 358

LEN (length)   690

Letter spacing   218

Line chart   327

Line spacing (for text frames)   220

Linear regression  
FORECAST   632
INTERCEPT   671
show trend in charts   350
statistics (LINEST)   691
values (TREND)   821

Lines  
as borders of objects   287
drawing   314

Lines (in charts)   338, 346

LINEST (statistics of a linear regression)   691

Link to cell content, show in object   283

Links (hyperlinks)  
applied to cells   415
for objects   290
format URLs as hyperlinks   388
HYPERLINK function   652

Links (OLE objects)  
edit   308
update   308
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Listboxes (form object)   374

Live preview   461

LN (natural logarithm)   693

Locking objects   290

LOG (logarithm)   693

LOG10 (base-10 logarithm)   694

Logarithm  
any base (LOG)   693
base 10 (LOG10)   694
natural (LN)   693

LOGEST (statistics of an exponential regression)   695

LOGINV (percentiles of the log-normal distribution)  
696

LOGNORM.DIST (log-normal distribution)   698

LOGNORM.INV (percentiles of the log-normal
distribution)   699

Log-normal distribution  
LOGINV   696
LOGNORM.DIST   698
LOGNORM.INV   699
LOGNORMDIST   697

LOGNORMDIST (log-normal distribution)   697

LOOKUP (search cell range)   699

LOWER (convert text to lowercase)   702

Lowercase  
LOWER   702
PROPER   759

M
Macros   369, 442

Mail the document   426

Manage (button in the settings)   472

Manual (PlanMaker)   24

Margins  
inner margins of AutoShapes   320
inner margins of cells   207
inner margins of text frames   293, 295
page margins   251

Mark invalid data   249

MATCH (relative position in a range)   703

MathType   312

Matrix equation (MSOLVE)   719

MAX (maximum)   703

MAXA (maximum)   704

MAXIFS (conditional maximum)   705

Maximum number of undo steps   456

MDETERM (matrix determinant)   706

Mean  
geometric (GEOMEAN)   642
harmonic (HARMEAN)   645

without marginal values (TRIMMEAN)   823

MEDIAN   707

Menu bar   33

Menus with toolbars or ribbon?   29, 461

Merge cells   207

MID (part of a text string)   707

Middle mouse button   456

MILLISECONDS (milliseconds)   708

MIN (minimum)   709

MINA (minimum)   709

MINIFS (conditional minimum)   710

MINUTE (minute)   711

MINVERSE (inverse matrix)   712

MIRR (modified internal rate of return)   713

Mirror (objects)   273

MMULT (product of matrices)   713

MOD (remainder of a division, Excel method)   714

MODE (most frequently occurring value)   715

MODE.SNGL (most frequently occurring value)   716

Modified internal rate of return (MIRR)   713

MODP (remainder of a division, PlanMaker method)  
717

Modulo  
MOD (Excel method)   714
MODP (PlanMaker method)   717

MONTH (month of a date)   718

Move by ... decimals   478

MROUND (round to a multiple of base)   718

MSOLVE (solution of matrix equation Ax=B)   719

Multinomial coefficient  
MULTINOMIAL   720
POLYNOMIAL   755

Multiplication (operator)   516

N
N (convert value into number)   721

NA (error value #N/A)   722

Name of a worksheet (SHEETNAME)   780

Names (for cell ranges)   90, 93
apply to existing formulas   94
assign   91
create from selection   92
edit   91
insert list   93

Names (of objects)   275

Names (of tables)   140, 143, 275

NEG (negative value)   723

Negative binomial distribution  
NEGBINOM.DIST   723
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Negative binomial distribution  
NEGBINOMDIST   724

Negative value (NEG)   723

Net present value  
NPV   735
XNPV   841

NETWORKDAYS (number of workdays)   725

Neumann function (BESSELY)   546

New (File)   46, 233

New pivot table, create   147

New program window   448

New table (create tables in worksheets)   134, 135, 136

NOMINAL (nominal interest rate)   726

Non-breaking hyphen   186

Non-breaking space   186

Non-printable characters, remove (CLEAN)   564

NORM.DIST (normal distribution)   727

NORM.INV (percentiles of the normal distribution)  
729

NORM.S.DIST (standard normal distribution)   731

NORM.S.INV (percentiles of the standard distribution)  
732

Normal  
cell style   231
character style   226

Normal distribution  
NORM.DIST   727
NORM.INV   729
NORMDIST   726
NORMINV   728

Normal distribution, logarithmic  
LOGINV   696
LOGNORM.DIST   698
LOGNORM.INV   699
LOGNORMDIST   697

Normal.pmvx   46, 234

NORMDIST (normal distribution)   726

NORMINV (percentiles of the normal distribution)  
728

NORMSDIST (standard normal distribution)   730

NORMSINV (percentiles of the standard distribution)  
731

NOT (logical NOT function)   733

NOW (current date and time)   733

NPER (number of periods)   734

NPV (net present value)   735

Number (number format)   194

Number filter (AutoFilter)   101

Number format   192, 194, 197, 198

Number of periods (NPER)   734

Number of worksheets (SHEETS)   781

Number separators   459

Number series, fill automatically   82, 510

Numbers, enter   63

NUMBERVALUE (convert text into a number)   736

O
Object  

copy   76
cut   76
delete   76
insert   270
paste   76
select   270

Object (dialog box)   284

Object mode and edit mode   271

Object properties  
change default settings   291
for charts   360
for checkboxes   370
for drawings   317, 319
for dropdown lists   373
for groupboxes   379
for labels   379
for listboxes   374
for OLE objects   309, 311
for pictures   303
for pushbuttons   375
for radio buttons   372
for scrollbars   377
for spinners   376
for text frames   293, 295
general properties   284

Objects   269
align and distribute   275
change order   274
change position   272, 284
change properties   284
combine   278
distribute   275
duplicate   275
edit retroactively   280
group   276
guides for alignment   454
hide   277
resize   272, 284
rotate   284
rotate or flip   273
show hidden objects   277, 478
show linked cell contents   283
show text frame guidelines   478
ungroup   276

OCT2BIN (octal to binary)   738
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OCT2DEC (octal to decimal)   739

OCT2HEX (octal to hexadecimal)   739

Octal to binary (OCT2BIN)   738

Octal to decimal (OCT2DEC)   739

Octal to hexadecimal (OCT2HEX)   739

ODD (round up to next odd number)   740

OFFSET (shifted reference)   741

OLE object (dialog box)   311

OLE object (ribbon tab)   309

OLE objects   306
change properties   309, 311
edit   308
edit links   308
Equation Editor   312
insert   306
update links   308
warning when loading   456

Open (File)   48, 234, 435

Operators in formulas   516

Optimum height   190

Optimum width   190

OR (logical OR function)   742

Order (of objects)   274

Ordinal numbers, add superscript (auto correction)   388

Orientation  
of printed pages   251

Other file formats   435

Outline pane   411, 413

Outlines   411
automatically show outline pane   413
change settings   413
group   412
options   413
protect   413
remove all groups   412
show/hide grouped cells   413
ungroup   412

Overlapping objects   295, 320

Overwrite mode / insert mode   39
disable   456

P
Page break preview   261

Page breaks  
adjust manually   261
show/hide   484

Page setup   251
copy to other worksheets   88
headers and footers   257
number of pages   257

page format   251
page margins   251
page number   253, 257
page orientation   251
page size   251
print options   253

Paper size   251

Paper trays   251

Paragraph format (for text frames)   219
indents   220
line spacing   220
spacing above/below   222
text alignment   221

Pascal distribution  
NEGBINOM.DIST   723
NEGBINOMDIST   724

Paste copied content   76

Paste reference   78, 521

Paste special   78

Payment (PMT)   751

PCF (interest rate)   776

PDF export   422

PDF/A, create   422

Peakedness of a distribution (KURT)   686

PEARSON (Pearson correlation coefficient)   742

Percent sign (operator)   516

Percentage (number format)   192, 194

PERCENTILE (percentiles of a data set)   743

PERCENTILE.EXC (percentiles of a data set)   744

PERCENTILE.INC (percentiles of a data set)   745

PERCENTRANK (percent rank in a data set)   746

PERCENTRANK.EXC (percent rank in a data set)   746

PERCENTRANK.INC (percent rank in a data set)   747

PERIOD (duration of fixed-interest investments)   748

PERMUT   749

PHI (standard normal distribution)   750

Photo frames   277, 301

PI (constant value of pi)   751

Picture (dialog box)   303

Picture (ribbon tab)   301

Pictures   298
change properties   303
change source   301
compress   300
copy to document’s folder   298
export   303
from scanner   299
insert   298
insert from the gallery/camera (Android/iOS)   299
recolor   301, 303
rotate or flip   273
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Pictures   298
save within document   298
select source   299

Pie chart   327

Pinned files   48

Pinned templates   46

Pivot tables   145
change the source data area   180
column labels   151
copy   181
create from existing data   148
create from external data   150
create from tables in worksheets   147
custom name for fields   157, 158, 162, 167
custom name for pivot table   170
defer layout update   173
delete   181
field list: areas section   158
field list: configure the pivot table   161
field list: exercises   152
field list: fields section   157
field list: further options   160
field list: initial screen   151
field settings   162
fields: move and remove   158
filter   174
filter labels/filter values   174
form (field settings)   162
GETPIVOTDATA   643
group   176
layout (pivot table settings)   170
modify pivot table areas   180
move   181
number format   167
outline form   162
pivot table settings   170
pivot table sidebar   151
refresh when opening the file   170, 180
report filter   151, 174
row labels   151
save source data with file   170
sort A-Z (fields in the field list)   157
sort A-Z or Z-A (fields in the pivot report)   174
sort by fill lists (fields in the pivot report)   170, 174
styles for pivot tables   170
subtotals   162
tabular form   162
update   180
value settings   167
values area   151

Plain text file format   435, 437

PlanMaker  
basics   42
customize   453
set as default program   469

settings   454
user interface   29

PlanMaker basics   42

PlanMaker file format   435

PlanMaker manual   24

PlanMaker Tour   52

Plot area (in charts)   344

PMBAK files   408

PMD file format   435

PMDX file format   435

PMT (payment)   751

Poisson distribution  
POISSON   752
POISSON.DIST   753

Polynomial coefficient  
MULTINOMIAL   720
POLYNOMIAL   755

Portrait format   251

Position (of objects)   272, 284

Position of a value in a range (MATCH)   703

Power (POWER function)   755

PPMT (payment on the principal)   756

Precision as displayed   480

Present value (PV)   759

Preview (of a document)   48

Primary axes (in charts)   362

Principal  
CUMPRINC (cumulative)   588
PPMT   756

Print a document   50, 418

Print date   257

Print order   253

Print preview   417

Print range  
define print range   253
remove print range   253

Print time   257

Printable (object property)   290

PROB (probability)   757

PRODUCT (product)   758

Product of matrices (MMULT)   713

Prompt for summary information when saving   466

PROPER (convert text to upper/lower case)   759

Properties (document)   476
Calculate tab   480
Colors tab   476
Fonts tab   483
Options tab   478
Protection tab   432, 483
Statistics tab   478
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Properties (document)   476
Summary tab   403, 476

Properties (object)  
for charts   360
for checkboxes   370
for drawings   317, 319
for dropdown lists   373
for groupboxes   379
for labels   379
for listboxes   374
for OLE objects   309, 311
for pictures   303
for pushbuttons   375
for radio buttons   372
for scrollbars   377
for spinners   376
for text frames   293, 295

Properties (objects in general)  
change default settings   291
general properties   284

Properties (worksheet)   484

Protect   428
cell protection   428
document protection   432
outline   413
sheet protection   428
workbook protection   431

Protection indicator   478

Pushbuttons (form object)   375

PV (present value)   759

Pyramid chart   327

Q
QR code, generate   322

QUARTILE (quartiles of a data set)   760

QUARTILE.EXC (quartiles of a data set)   761

QUARTILE.INC (quartiles of a data set)   762

Quick access toolbar   31
change position   461, 496
customize icons   496

Quick paths   401

Quotes, smart   388

QUOTIENT (quotient of a division)   763

R
Radar chart   327, 363

RADIANS (convert degrees to radians)   763

Radians to degrees (DEGREES)   605

Radio buttons (form object)   371

RAND (random value)   764

RANDBETWEEN (random value)   765

Rank  
PERCENTRANK   746
PERCENTRANK.EXC   746
PERCENTRANK.INC   747
RANK   765
RANK.AVG   766
RANK.EQ   767

RANK (rank in a data set)   765

RANK.AVG (rank in a data set)   766

RANK.EQ (rank in a data set)   767

RATE (interest rate per period)   768

Rate of return  
IRR   674
MIRR   713
XIRR   841

Read aloud   399

Recalc only before ...   116, 480

Recalculate  
all worksheets   116, 480
current worksheet   116

Rectangles, draw   314

Redo   66

Redo (changes)   66

References, external   520

Reflection effect (for objects)   289

Refresh data for pivot table   180

Regression, exponential  
statistics (LOGEST)   695
values (GROWTH)   644

Regression, linear  
FORECAST   632
INTERCEPT   671
show trend in charts   350
statistics (LINEST)   691
values (TREND)   821

Relative cell references   519

Remove duplicate rows   72

Remove empty rows   72

Remove spaces (TRIM)   822

Repeat commands   66

Repeat search   265

Repeated columns   253

Repeated rows   253

REPLACE (replace text in a text string)   769

Replace (ribbon command Home | Search)   264, 265

Replace again (ribbon command Home | Search)   265

Replace text in a text string  
REPLACE   769
SUBSTITUTE   797

REPT (repeat text string n times)   770
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Research via the Internet   398

Reset  
character formatting   219, 225
PDF export options   422
picture settings   301
ribbon   492
SoftMaker Office settings   473
toolbars   501

Revert to previous version (file)   408

Ribbon   22, 31
create user-defined icons   507
customize   490
customize groups   492
customize icons   492
list of all ribbon commands and menu commands  
845
manage   492
reset   492
show/hide   491
user interface   31, 461, 490

Ribbon or menus with toolbars?   29, 461

RIGHT (right part of a text string)   770

Right align   207

ROMAN (Roman numeral)   771

Root  
n-th root (ROOTN)   772
square root (SQRT)   790
square root of complex number (IMSQRT)   667
square root of x*Pi (SQRTPI)   790

ROOTN (n-th root)   772

Rotate  
axis labels   352, 353, 355, 357
cell contents   207
drawings   284
objects   273, 284
pictures   284
text in AutoShapes   320
text in text frames   293, 295

Rotate or flip (objects)   273

Round  
CEILING   556
EVEN   620
FIXED   630
FLOOR   631
INT   671
MROUND   718
ODD   740
ROUND   772
ROUNDDOWN   773
ROUNDUP   774
TRUNC   824

ROUND (round to n digits)   772

ROUNDDOWN (round down to n digits)   773

Rounding  
display numbers rounded (per number format)   192
final result   480
intermediate results   480
precision as displayed   480

ROUNDUP (round up to n digits)   774

Row  
change height   190
delete   71, 72
insert   74
optimum height   190
select   67
show/hide   191

Row & column headers   484

ROW (function: row number of cells)   775

Row header  
change row height   190
print   253
show/hide   484
use for selection   67

ROWS (function: number of rows)   775

RRI (interest rate)   776

RSQ (square of Pearson)   777

S
Save (File)   50

Save all (File)   50

Save as (File)   50, 435

Scale document   461

Scaling (of printed pages)   253

Scan pictures   299

Scenarios   122

Scientific (number format)   194

Scribble mode on iOS   34

Scripts   369, 442, 446

Scrollbars (form object)   377

Scrollbars, show/hide   478

Search (file manager)   405

Search (function)  
FIND (search for text in a text string)   627, 777
HLOOKUP   649
LOOKUP   699
SEARCH (search for text in a text string)   777
VLOOKUP   834

Search (ribbon command Home | Search)   263, 265
cell contents   263
search again   265

Search files (file manager)   405

SECOND (second)   778

Secondary axes (in charts)   361, 362



889Index

Select  
always select whole word   456
cells   67
in the Android/iOS version   69
objects   270

Select all   67, 271

Select chart elements   341

Select whole words when selecting   456

Send a document by e-mail   426

Send backward one level (object)   274

Send to back (object)   274

Series axis (in charts)   333, 355, 357

SERIESSUM (sum of a power series)   779

Set as default  
document template   46
object properties   291

Settings (PlanMaker)   453, 454
Appearance tab   461
Backup tab   468
Edit tab   459
Files tab   466
Fonts tab   471
General tab   456
Language tab   465
System tab   469
View tab   454

Settings (SoftMaker Office)  
export/import   473
reset   473

Shading (of cells)   205

Shadow (for objects)   288

Share a document (via Android/iOS and via Windows
10 and higher)   426

Sheet  
change properties   88
copy   88
delete   88
hide sheet   88
insert   87
move   88
protect   428
rename   88
show sheet   88
visibility   88

SHEET (index of a worksheet)   779

Sheet direction   444, 484

Sheet grid (gridlines), show   484

Sheet protection   428
disable   430
enable   429

Sheet register   39, 87
change color   484
display   478

font size   454

SHEETNAME (name of a worksheet)   780

SHEETNUMBER (compatibility function)   781

SHEETS (number of worksheets)   781

Shortcut keys  
[export/import   473
customize   507
for cell styles   229
for character styles   223, 224
for special characters   186
predefined shortcuts: Mac   861
predefined shortcuts: Windows/Linux   861
view list of all shortcut keys   507

Show cells   191

Show duplicate values   238

Show fonts in font list   461

Show formulas (ribbon tab View)   109

Show full path in title bar   461

Show hidden files and folders   469

Show hidden objects   277, 478

Show indicators (for comments)   478

Show tooltips  
for commands   461
for formulas   459

Show warning when loading OLE objects   456

Show watch list   111

Show/hide chart elements   332
axes (X, Y, Z)   333
axis title   333
chart title   334, 362
data labels   335
error bars   336
gridlines   336
legend   337
lines   338
trendline   339
up/down bars   340

Show/hide keyboard automatically   469

Sidebar for the pivot table   151

Sign (operator)   516

SIGN (sign of a number)   782

SIN (sine)   783

Sine (SIN)   783

SINH (hyperbolic sine)   783

Size  
of cells   190
of objects   272, 284

SKEW (skewness of a distribution)   784

SLN (straight-line depreciation)   785

SLOPE (slope of a linear trend)   785

SMALL (k-th smallest number)   786
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Small caps   214

Smart quotes   388

SmartText   395
export/import   473

SmartText entries  
create   395
edit   397
expand   388
insert   396
replace automatically   396

Smooth edges of pictures   469

Smooth edges of screen fonts   461

Snapshots (backup copies)   408, 468

Soft edges effect (for objects)   289

Soft hyphen   186

SoftMaker Basic   446

SoftMaker Equation Editor   312

SoftMaker support   23

Sort and filter   96, 101

SORTM (sort function)   787

SORTV (sort function)   788

Source data for charts   361

Source data for pivot tables   180

Source for picture files   299

Spaces, different widths   186

Speak   399

Special filter   106

Spell check   382
as you type   384, 465
edit user dictionaries   384
install additional dictionaries   512
manual   383
set language   381

Spinners (form object)   376

SQLite file format   435

SQRT (square root)   790

SQRTPI (square root of x*Pi)   790

Square of Pearson (RSQ)   777

Standard deviation  
entire population (STDEV.P)   794
entire population (STDEVP)   793
entire population (STDEVPA)   794
sample (STDEV)   791
sample (STDEV.S)   795
sample (STDEVA)   792

Standard error of a linear regression (STEYX)   796

Standard normal distribution  
GAUSS   641
NORM.S.DIST   731
NORM.S.INV   732
NORMSDIST   730

NORMSINV   731
PHI   750

Standard toolbar   33

STANDARDIZE (standardized value)   791

Start script   446

Statistics (of document)   478

Statistics of a regression  
LINEST (linear)   691
LOGEST (exponential)   695

Status bar   39
show/hide   461

STDEV (standard deviation of a sample)   791

STDEV.P (standard deviation of entire population)  
794

STDEV.S (standard deviation of a sample)   795

STDEVA (standard deviation of a sample)   792

STDEVP (standard deviation of entire population)   793

STDEVPA (standard deviation of entire population)  
794

STEYX (standard error of a linear regression)   796

Stock chart   327

Strikethrough   214

Student’s t-distribution  
T.DIST   812
T.DIST.2T (two-tailed)   812
T.DIST.RT (right-tailed)   813
T.INV (left-tailed)   818
T.INV.2T (two-tailed)   819
TDIST   811
TINV   817

Student’s t-test (T.TEST)   826

Student’s t-test (TTEST)   825

Styles  
cell styles   228
character styles   223
table styles   140

Subscripts   217

SUBSTITUTE (replace text in a text string)   797

SUBTOTAL (calculations without hidden cells)   798

Subtraction (operator)   516

SUM (Sum)   799

SUMIF (sum if condition is true)   801

SUMIFS (sum if conditions are true)   802

SUMPRODUCT (sum of products)   803

SUMSQ (sum of squares)   804

SUMX2MY2 (sum of x^2 - y^2)   805

SUMX2PY2 (sum of x^2 + y^2)   806

SUMXMY2 (sum of (x - y)^2)   806

Superscript of ordinal numbers (auto correction)   388

Superscripts   217
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Support   23

Surface chart   327

SWITCH (categorize initial value)   807

SYD (sum-of-years’ digits depreciation)   808

Syntax highlighting   110, 478
when opening Excel files   440

System requirements   24

T
T (convert value into text string)   809

T.DIST (t-distribution)   812

T.DIST.2T (t-distribution two-tailed)   812

T.DIST.RT (t-distribution right-tailed)   813

T.INV (percentiles of the t-distribution left-tailed)   818

T.INV.2T (percentiles of the t-distribution two-tailed)  
819

T.TEST (t-test)   826

Tab width (in text frames)   478

Table (ribbon tab)   136

Tables in worksheets   134
banded rows and columns   140
cell references   143
convert to range   137
create   135
delete rows/columns   138
delete table   137
expand automatically   138, 459
first column/last column, highlight   140
header row   140
insert rows/columns   138
name of table   143
names and identifiers   143
select rows/columns   138
select table   138
summarize as pivot table   136
table name   140
table properties   140
table range   138
table styles   140
total row   140, 142

Tablet mode (Android/iOS)   461

Tabs for documents   38, 447

Tabs, close   451

TAN (tangent)   810

Tangent (TAN)   810

TANH (hyperbolic tangent)   811

TDIST (t-distribution)   811

t-distribution  
T.DIST   812
T.DIST.2T (two-tailed)   812
T.DIST.RT (right-tailed)   813

T.INV (left-tailed)   818
T.INV.2T (two-tailed)   819
TDIST   811
TINV   817

Technical support   23

Template folder for document templates   466

Templates  
document templates   233, 435

Text  
copy   76
cut   76
delete   76
paste   76

TEXT (convert number into text string)   814

Text (number format)   194

Text (Object properties tab)   321

Text alignment horizontal (for objects)   221

Text alignment vertical (for objects)   282

Text direction   443, 444

Text filter (AutoFilter)   101

Text frames   293
add/edit text   316
change properties   293, 295
change text area   282
hyphenation   386
insert   293
paragraph format   219

Text input mode   39

Text rotation for text frames   282

Text strings  
compare (EXACT)   620
concatenate (CONCAT)   567
concatenate (CONCATENATE)   568
concatenate (TEXTJOIN)   814
convert into a number (NUMBERVALUE)   736
convert into a number (VALUE)   829
cut part (LEFT)   689
cut part (MID)   707
cut part (RIGHT)   770
repeat n times (REPT)   770

Text styles   214

Text to columns, split   95

Text, enter in cell   63

TextArt objects  
change properties   321
drawing   314
transformation   321

TEXTJOIN (concatenate strings with separators)   814

TextMaker file format   435

Thousands separator  
change   459
show   192
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Three-dimensional calculations   57, 90

Threshold value (GESTEP)   643

Time  
current (static), insert via shortcut key   63
enter in cell   63
updated, with date: NOW function   733

TIME (create time)   815

TIMEDIFF (time difference)   816

TIMEVALUE (convert text into time)   817

TINV (percentiles of the t-distribution)   817

Title (of charts)   362

Title bar   30

TODAY (current date)   820

Toolbars for Android/iOS  
customize   34
user interface   34, 461

Toolbars for classic menus  
create user-defined icons   507
customize   498, 502
delete   501
locked   500
manage   501
position   500
rename   501
reset   501
show/hide   498
user interface   33, 461, 498
visible in mode   498

Top row, freeze   184

Total row in tables   140, 142

Touch mode   461

Trace to error   112

Transformation (of TextArt objects)   321

Transparency (of pictures)   303

Transpose  
matrix (MTRANS)   820
swap columns and rows   78, 95

TRANSPOSE (transpose matrix)   820

TREND (values of a linear regression)   821

Trendline (in charts)   339, 350

TRIM (remove spaces from text)   822

TRIMMEAN (mean without marginal values)   823

TRUE (logical value TRUE)   824

TRUNC (truncate a number)   824

TTEST (t-test)   825

TYPE (type of a value)   826

U
Underline (font)   214

Undo (changes)   66

Ungroup  
cells (outliner)   412
objects   276

Unit conversion (CONVERT)   571

Unit of measure   461

Unpinned files   48

Unpinned templates   46

Up/down bars (in charts)   340, 346

Update  
charts   364, 480
external references   522
pivot tables   180
worksheet (calculations)   116, 480

Updates   469

UPPER (convert text to uppercase)   827

Uppercase  
character format option   214
PROPER (function)   759
UPPER (function)   827

Use left Alt for shortcut keys   456

Use SHM extensions   469

Use system file dialogs   461

Use XIM   469

User dictionaries  
edit   384
export/import   473

User info   456, 828

User info, output (USERFIELD)   828

User interface (ribbon or menus?)   29, 461

User interface on Android/iOS   34, 461

User interface size   461

USERFIELD (output user info)   828

V
VALUE (convert text into a number)   829

Value axis (in charts)   333, 353

VAR (variance of a sample)   830

VAR.P (variance of entire population)   832

VAR.S (variance of a sample)   834

VARA (variance of a sample)   831

Variance  
of a sample (VAR)   830
of a sample (VAR.S)   834
of a sample (VARA)   831
of entire population (VAR.P)   832
of entire population (VARP)   831
of entire population (VARPA)   833

VARP (variance of entire population)   831

VARPA (variance of entire population)   833

VBA scripts   369, 442, 446
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Version management   408, 468

Vertical alignment  
of cell contents   207
of text in AutoShapes   282, 320
of text in text frames   282, 293, 295

Vertical text   207

View  
edit mode   271
full screen   487
object mode   271
touch mode   461
windows   449
zoom level   486

View side by side (windows)   449

Visibility  
objects   290
rows/columns   191
worksheet   88

Visual Basic   446

VLOOKUP (look up column-wise)   834

W
Walls (in charts)   345

Warning if a formula contains errors   459

Watch window   111

Weber function (BESSELY)   546

Week number  
ISOWEEK   682
ISOWEEKNUM   683
WEEKNUM   837

WEEKDAY (weekday)   836

WEEKNUM (week number)   837

WEIBULL (Weibull distribution)   838

WEIBULL.DIST (Weibull distribution)   839

Whole word, select   456

Width of a column, change   190

Window  
close all   451
view side by side   449

Workbook   86

Workbook properties   476

Workbook protection   431
disable   432
enable   431

WORKDAY (date after x workdays)   840

Workdays  
count (NETWORKDAYS)   725
date after x workdays (WORKDAY)   840

Worksheet   86, 484
alternating shade   484

change properties   88, 484
change sheet direction   484
copy   88
delete   88
hide sheet   88
insert   87
move   87, 88
protect   428
rename   87, 88
select multiple   87
show sheet   88
visibility   88

Worksheet register   39, 87
change color   484
display   478
font size   454

Worksheets  
edit   61
format   188
protect   428, 432
select   67
update calculations   116, 480

Workspace color   461

Wrap text   207

X
X axis (in charts)   333, 352

XIRR (internal rate of return)   841

XLS file format   435

XLSX file format   435

XNPV (net present value)   841

XOR (logical XOR function)   842

XY scatter chart   327

Y
Y axis (in charts)   333, 353

YEAR (year of a date)   843

Z
Z axis (in charts)   333, 355, 357

Zero values, show/hide  
for number formats of cells   192
worksheet properties   484

Zoom level (view)   486

z-test  
Z.TEST   844
ZTEST   843
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